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What's New in SonarWiz 7
 
SonarWiz Version 7.09
 
•  New geodesy engine adding support for new coordinate systems and custom transformations
•  Support for multiple languages, update to Unicode
•  Allow picking targets from map view without opening waterfall
•  Add "Depth below seafloor" to SBP contact properties
•  Add the ability to display the RT Bathy Roll, Pitch, and Heave in the System Information window.
•  Kongsberg smoothed.bin support for AUV operations.
•  Add option to choose bit color resolution to Contact Geotiff export
•  Add option in NavInjector for Hugin RAW BIN files
•  Add support for REV I of KMALL format
•  Make S7K file reader skip over bad data without crashing or bailing out
•  Add GeoTiff export to contact window of actual image (and zoom), with reduced size
•  SS overlap method: Allow for 2 frequencies (CH1-2 & CH5-6) to support nadir fill systems
•  New combined bottom track and digitizer display for sidescan data
 
SonarWiz Version 7.08
 
•  Remote Start / Stop for Norbit program to Log s7k files
•  Add profile width option to Export Bathy XYZ using All Enabled Survey Files
•  Add directory structure and file offloading for Auto Import (Sidescan)
•  Add support for TIL side-scan data content
•  Add filters for Aggregate function
•  Add Playback and GoTo in Digitizing View
•  Increase import samples per channel to max 32k
•  Add Far Field Track as option in Copy Processing Results tool
•  Add Pitch to ZEdit
•  Add far field tracking to the Batch Bottom Tracker
•  Edit bathy data from Plan view with rectangle or polygonal selection
•  Add GeoTiff export to contact window of actual image and zoom
•  Implement support for Tides for Sub-bottom data
 
SonarWiz Version 7.07
 
•  New multiple reflector identification tool in SBP Analysis Window
•  Add semi-automatic acoustic reflector picking to SonarWiz
•  Replace Vertical Scroll Bar in the SBP Digitizer With A Zoom Scroll Bar
•  Add the ability to scale and offset a SonarWiz grid
•  Export bathy to LAS format
•  Add Yaw Support To Kongsberg M3 FLS Import
•  Add gain scalar and offset for SBP data
•  Add tool to split XTF files into data type
•  Add Support For SonarWiz in Amazon AWS
•  New JSF tool to convert Mark numbers from Message Type 80 into CSV contacts
•  Splitting bathymetry files
•  Ability to rename CSF files in a project
•  Add the ability to swap the IO pins for the SBP Analog Server trigger switch
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•  Add ability for Geoimage export tools to output 2.5 cm resolution
•  Option in Marine Sonic SDS File Type Specific Options to use Orientation Yaw instead of ping heading
•  New JSF tool to extract the RC constant to a XYZ file
•  Add support for new 8-bit M3 IMB format
•  Added preset NavInjectorPro templates for common export formats
 
SonarWiz Version 7.06
 
•  Add ability to look up coordinate systems by EPSG code
•  New Norbit S7K 7007 packet processing to increase resolution and preserve water column
•  Add ability to export mosaic at 0.025m resolution
•  New MBES Beam Performance Test Utility
•  New A-B Change Detection Utility
•  Add support for Forward Looking Sonar Kongsberg M3 data (IMB Files)
•  Improved 2D drawing performance
 
SonarWiz Version 7.05
 
•  New internal 3D viewer with support for massive point clouds
•  New Helm Display
•  Added SDF import support for MA-X page 3515
•  Added import support for HDF5 files
•  Added R2Sonic support to MBServer
•  Ability to export bathymetry profiles as a XYZ file from profile tool
•  Ability to export an image of bathymetry profile in the 3D Viewer
•  Import and Display Multi-Frequency SBES in Swath Editor with new features
•  Date and Time formats throughout program changed to ISO8601 format
•  Ability to select a set of bathy points to export
•  Added support for custom sidescan sonars with embedded IXSEA Nano heading sensor
•  Updated EdgeTech 4200 Server to Support New 4205 Tri-frequency System
•  Ability to Export SBP images with MBES seabed profile overlaid
•  Improve UI of Tide and SVP editors
•  Updated support for TIL files with added uncertainty import option
 
SonarWiz Version 7.04
 
•  Add directory monitor for automatic import and processing
•  Add automatic processing dialog for SSS files
•  CSF 3.0 Introduces compression into CSF format
•  Save Individual GeoTiffs For Each File, export top left corner on the integer map coordinates.
•  Automatic bottom-tracker - "Edge Detection"
•  SSS Roll and Pitch in Properties and Make Others Like This
•  Automated feature picking in sidescan waterfalls - "Artifact Detector" (beta)
•  Last offset applied in BT window auto-populates Batch Bottom Track window
•  Use grids in map correction tool
•  SS gain changes show in open digitzer windows
•  Batch Contact Import Template System Simplified
•  Add Area, Block and Mag Anomaly Fields to Contact Export
•  Batch Contact Import from XY File - Select Individual CSF Files to Import Contacts onto
•  Add KP values to Info at Cursor
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•  Add "Total Water Depth" (depth to seabed) as an option for annotation.
•  Add Speed over ground to SSS/SBP Offset Reports
•  Adjust displayed range setting not available in Properties window
•  Use windows locale for date format on all export options
•  Function to select all SSS HF/LF or SBP data in batch bottom track window
•  Display the file name in the top bar of the maximized SBP digitizing window
•  Support Aggregating SBP Data
•  In SBP digitizing view, zoom function moves to top left and not center
•  Ability to zoom time window in Navigation and Attitude Editor
•  Add ability to export bathymetry profiles as a XYZ file from C++ Profile tool
•  Add ability to export an image of bathymetry profile in the C++ viewer
•  Add ability to C++ 3D Viewer to load XYZ and XYZA files.
•  Improve color rendering of the cross-section in the C++ cross-section tool
•  3D PDF Report creates point cloud of X,Y,Amplitude instead of X,Y,Z when target image was selected from
bathy backscatter
•  Dynamic LOD/downsampling for point clouds in 3D viewer
•  Add more 2D projection types in Grid Editor
•  Automatically load the subset points into 2D and 3D view of Grid Editor
•  Add support for Kraken TIL File Import
•  Add support for QPS db format sidescan files
•  Add support for Kongsberg .kmall format
•  Add support for ED50 TM0
•  Add support for Applanix True Heave.
 
SonarWiz Version 7.03
 
•  Added support for IHO S-63 V 1.1+ charts
•  Added support for Innomar SES3 format
•  Convert any supported bathymetry file to GSF or HSX format
•  New patch test tool for bathymetry and LiDAR sensors
•  Enhancements to 3D Viewer
•  Dongle-Free License option for acquisition
•  New applied offsets and corrections report for sidescan files
•  New locate missing files and repair broken links tools to repair projects
•  Improved contact database importing and backup
•  Modify course smoothing settings after file import
 
SonarWiz Version 7.02
 
•  Shaded relief in bathymetry waterfall displays (and contacts images)
•  3D PDF contact reports
•  New import filter for LiDAR data
•  Import R2Sonic TruePix as Sidescan
•  Create Acoustic Color Images for multi-frequency data sets
•  Improved view controls in the 3D Viewer
•  New color legend
 
SonarWiz Version 7.01
 
•  Unified sidescan/bathy/backscatter waterfall
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•  Faster bathymetry drag and drop import and merge
•  Multiple EGN tables speed up signal processing
•  Enhanced color palette support
•  Automated vessel creation saves time
•  User specified tide and sound velocity
•  Enhanced LiDAR & SAS processing
•  Dongle-free license options
 
SonarWiz Version 7.00
 
•  Re-engineered backscatter processing for sidescan and sub-bottom data
•  Unified properties window, for controlling all objects in the project
•  Integrated 3D Viewer for real-time and post-processed data visualization
•  3D area and swath based editing boost productivity
•  New seabed characterization module for sidescan and bathy
•  Real-time support for new multi-beam echosounders
•  Support for Norbit LiDAR, Sonardyne Solstice SAS
•  More intuitive and powerful color management throughout
•  Revised network helm display with bathymetry and sidescan image coverage
•  Full support for swath bathymetry, updated Contact Manager and database
•  Directly supports most leading sensors and file formats eliminating conversions
•  64-bit optimized, multi-core, multi-threaded, Win 7-10, DirectX11+, supports all available RAM
•  Hundreds of enhancements, repairs and data format updates
•  Single beam sonars supported – NMEA-0183 compliant
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Welcome to SonarWiz 7
 
SonarWiz is the industry all-in-one solution for geophysical, hydrographic, pipeline, and archaeological
surveys, as well as for security and SAR. It features easy-to-use survey management tools, reliable data
acquisition, powerful post-processing, and flexible reporting tools.
 
Sidescan
 
View and analyze Sidescan data in real time with the industry’s most complete seafloor mapping solution.
Enjoy SonarWiz’s easy-to-use survey management tools, reliable data acquisition, powerful post-processing,
and flexible reporting options. Used by hundreds worldwide including NOAA, NAVO and USGS.
 
Sub-Bottom
 
Explore sediment layers in-depth with SonarWiz for Sub-Bottom Profilers with real-time data acquisition
and post-processing modules. The sub-bottom profiler package also includes navigation, fathometer and
magnetometer inputs so you get a broad perspective of a survey area.
 
Bathymetry
 
Collecting and processing bathymetry data is a breeze with the SonarWiz workflow and toolset. From the
helm display, with a Plan View, Coverage Map and directional indicators, to the automatic, whole survey gain
optimization – you can produce near seamless amplitude mosaics right off the boat with little effort.
 
Magnetometry
 
Help dive teams and recovery personnel locate underwater artifacts, treasures and pipelines you seek to find,
map, or recover with SonarWiz for Magnetometry. Magnetometry data for ferrous-object detection, co-recorded
with sidescan or sub-bottom data, provides a valuable new layer of information.
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System Requirements and Configurations
 
SonarWiz 7
 
Minimum System Requirements:
 
•  Windows7, Windows 10, or Windows 11  (64-bit version only) 
•  Pentium 4, 4GB RAM  (8 GB R/T PC)
•  2-GB storage space 
•  Graphics card must have full support for DirectX11
 
LICENSING NOTE: The SafenetSentinel (now GEMALTO) SuperPro license key (dongle) used to license
SonarWiz requires a physically available USB port to plug it in, whether this is on the PC running SonarWiz,
or on a networked PC supporting a network dongle license. You may run SonarWiz on a PC while logged in
directly on that PC, or when accessing the PC via Remote Desktop, as long as that instance of SonarWiz on
the PC is able to obtain licensing from a local or network dongle.
 
CTI-3D Viewer / Editor
 
If CTI3DViewer application is launched on a system that does not meet the minimum hardware requirements,
a diagnostic message with information on which exact requirement was violated will be shown ( Figure 1
below), and the application will exit.
 

 
If your graphics card is supported and you get this diagnostic message, please, try updating your graphics card
drivers.
 
Supported graphics cards:
 
•  GeForce GT 5200; GeForce 6800 GS and 6800 GT; GeForce 7600 and higher.
•  Quadro FX 1500;
•  ATI Radeon 9600; ATI Radeon 9800 series; ATI Radeon X700 XT and higher.
•  Intel GMA 4500MHD; Intel GMA X3100 (G31/G33/GM45/GS45 chipsets).
 
Unsupported graphics cards:
 
•  Intel GMA 900/950 (946GZ / Q965 / Q963 /940GML /945G /945GU / 945GT)
•  GeForce4 MX 4000; GeForce4 7300 GT.
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•  Overall, most built-in cards that do not support pixel and vertex shaders, and on-board graphics accelerators
are a gamble.
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System Configurations and Components
 
SonarWiz is available in two general configurations: SonarWiz for real-time data acquisition and processing,
and SonarWiz Office for data post processing and map production only.
 

Feature SonarWiz Office Sonar Wiz

Post-processing of mosaics X X

Post-processing of mosaics X X
File Import (XTF, QMP,

MST, 81S, JSF, SDF, etc.) X X

GeoTiff Mosaic Export X X
Basemap Support X X
Report Generator X X

Target Analysis and Reporting X X
Sidescan acquisition  X

Sub-bottom Acquisition (optional)  X
Bathymetry Acquisition (optional)  X

Real-time Mosaics  X
Fathometer Interface  X

Magnetometer Interface  X
Real-time Navigation Interface  X

XTF Data Recording  X
Left/Right Steering Indicator  X
Survey Line Management  X

 



Real Time Data Acquisition and Mapping

34

Real Time Data Acquisition and Mapping
 
In order to acquire and process sonar data in real time, the following SonarWiz components are required:
 
1.  The main SonarWiz software application. This program communicates with a SonarWiz server (see below),
obtains sonar data, and processes and displays it in a consistent manner, regardless of sonar hardware and
server being used.
 
2.   A SonarWiz server software module designed for the type of Sidescan or Sub-bottom sonar being used.
Several server modules may be installed on a single host computer, but only one is running at any given time.
The server module performs the following functions:
- Communicates with the sonar hardware
- Provides a control user interface specifically designed for that hardware
- Converts the acoustic data to a standard format
- Transfers sonar and other data (navigation) to the main SonarWiz application
 
3.  A CTI software licensing key (commonly called a “dongle”). This small hardware device plugs into any
available USB port depending on the type shipped by CTI. It contains the licenses for the various software
components and options that have been purchased from CTI. The licenses in the key can be updated in the
field by the user if new options are purchased from CTI. Instructions for doing this can be found in Updating
SonarWiz License Key.
 
4.  An analog data acquisition box (e.g. National Instruments 24-bit SB USB-4431 or SS/SB CTI 5-BNC 16-bit
analog interface box)) and appropriate software drivers. Note that this card is only required for analog sonar
devices.
 
These components are typically installed on a single PC as shown below:
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Post-Processing and Mapping Configuration
 
If you have purchased SonarWiz Office for the purpose of post-processing previously collected sonar data, the
only components required are:
 
1.  The main SonarWiz software application.
2.  A CTI software licensing key.
 
Both components are used on a single computer as shown below:
 



Remote Server Configuration

36

Remote Server Configuration
 
It is possible to run some servers remotely from the SonarWiz (Real-time) application, in which case the
computers must be connected by a reliable network. When run in this mode, the SonarWiz operator may not
be able to view the server user interface, and therefore, may have limited control over server functions.
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Software Installation
 
When you purchase SonarWiz you will receive a package containing the following
 
•  Software License Key (see Licensing Information)
•  Data Acquisition Card and cables (Optional)
•  DAQ card Driver CD (Optional)
 
For users with a current EMA the CTI support Website offers the latest versions of the SonarWiz for download.
 
To download the latest version of SonarWiz:
 
1.  Visit: https://chesapeaketech.com

 
2.  Navigate to the Support drop down, select Downloads | SonarWiz

 
3.  Select either SONARWIZ 7 or DOWNLOAD to start downloading the latest version of SonarWiz 7.

https://chesapeaketech.com
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By default, the software will be installed in this file path on your machine: C:\Program Files\Chesapeake
Technology, Inc\SonarWiz7
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Previously Installed Versions of SonarWiz
 
New versions of SonarWiz can be installed directly on to a PC that already has an existing version of
SonarWiz resident on the machine. The new version will install “overtop” of the older version, replacing out-of-
date module while still retaining user settings.
 
SonarWiz will not affect or uninstall any previous versions of SonarWiz on the PC.
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Installing Analog Data Acquisition Cards and Drivers
 
Instructions for installing and configuring the various analog data acquisition cards supplied with SonarWiz, as
well as other specialized hardware components, can be found in the SonarWiz Real-Time Servers PDF (in the
DOCS sub-folder of your SonarWiz Program Files folder) .
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Installing SonarWiz Server Modules
 
SonarWiz server modules are located under the main program directory ( C:\Program Files\Chesapeake
Technology, Inc\SonarWiz7 ) under the Servers directory.
 
For users holding a current Maintenance Agreement, server modules may be downloaded from the CTI
Support Website at https://chesapeaketech.com/
 
To install a new server:
 
1.) Navigate to the Real Time Servers page by using the Support drop down menu and selecting Downloads
| Real Time Servers...
 

2.) From the Real Time Servers page you can navigate to your desired server organized by manufacture, for
example, EdgeTech...
 

https://chesapeaketech.com/
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3.) Once downloaded, you will see an .exe installer in your downloads folder that needs to be run and installed
into the Chesapeake Technology Inc| SonarWiz 7 folder.
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4.) Once installed, the server will appear in the Sonar menu in the Data Acquisition tab. See Select Sonar
Interface for more information.
 

 
You will then need to configure the server to your equipments specifications. You can find more information
about the settings inside our real-time servers in the SonarWiz_Real-time_Servers PDF located in the DOCs
folder installed on your machine with a install of the software.
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Technical Support
 
Chesapeake has a simple philosophy when it comes to support – everyone who has access to support gets
everything we have to offer. We don’t have different tiers or ask people to pay more to have access to certain
services or information. We just want you to have the help and information you need to use our products to
their fullest capability.
 
Full customer support services are included for one year with the purchase price of any of our products. At the
end of the first year, and each subsequent year, customers may extend access to support by purchasing an
Extended Maintenance Agreement.
 
In addition, customers are encouraged to submit enhancement ideas and requests, which often find their way
into our next release to the benefit of all of our customers.
 
On-line Technical Support
 
To obtain access to our online support site features, our self-help knowledgebase, tutorials, videos, and other
training and support documents:
 
1.  Visit: https://chesapeaketech.com/
 
2. If you need technical support, use the Support drop down menu and select Submit a Support Request.
 

3. Select from one of the for options provided: Report a Bug, Suggest Improvement (Feature Request), or
Technical Support (General).
 

https://chesapeaketech.com/
https://chesapeaketech.com/
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Please complete the form with as much relevant information as possible so
that our support engineers can respond to you effectively. Note: If you do not

include a viable email on the form, you will not receive responses from our team.
Note that you can obtain information about your License Type, Version of SonarWiz,

and User ID by using the Help | My Support Info... button from SonarWiz.
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Telephone Support
 
Telephone support is available Monday through Friday during normal business hours, 0900 through 1700 (UTC
-8.00).
 
(650) 283-9667 (9:00-5:00 EASTERN)
(828) 395-3496 (9:00-5:00 PACIFIC)
 
Fax: 650 903-4500
 
Email Support
 
To start a problem ticket via email, contact:
 
support@chesapeaketech.com
 

 
 

 



Additional Resources

47

Additional Resources
 
Online Training Videos
 
Beginning and advanced training videos for SonarWiz are available from the CTI website:
 
https://chesapeaketech.com/videos/
 
Hands-On Training
 
We offer comprehensive training programs tailored to meet your specific needs. We can deliver on-demand,
hands-on training at your location. Or you can attend one of our pre-scheduled workshops offered up to four
times a year in locations throughout the world.
 
Scheduled Training Courses
 
We schedule comprehensive hands-on training courses twice a year at locations around the world. Recently,
we’ve offered courses in Seattle WA, Kobe Japan, London UK, San Diego CA and Jacksonville FL. We also
often schedule courses around major industry trade shows when we know many of our customers are likely to
be in the same place at the same time.
 
Our schedule training course typically lasts 3 days, and covers the both beginner and advanced topics,
although we adjust the content to suit the requirements of registered attendees.
 
Please see our Events page for a list of upcoming courses. If you would like to suggest a location for an
upcoming course, please contact us.
 
On-Site Training
 
We offer custom training designed to your specific requirements and equipment, delivered at your location.
This includes classroom elements as well as on-board, hands-on training at sea to ensure you have the
opportunity to use our software in your specific setting and circumstances.
 
See the course outlines above as a starting point for what we can deliver on site. Final content will be
customized based on the specific sonar equipment you’re using, where you’ll be operating and the types of
surveys you’ll be conducting, and the output you want to generate.
 
Please contact us so we can discuss your needs, when we might conduct the training, and costs.

https://chesapeaketech.com/videos/
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Licensing Information
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SonarWiz Software End User License Agreement
 
SONARWIZ SOFTWARE END USER LICENSE AGREEMENT PLEASE READ THIS END USER LICENSE
AGREEMENT (THE “AGREEMENT”) CAREFULLY. BY INSTALLING, DOWNLOADING, COPYING, OR
OTHERWISE USING THE SOFTWARE PRODUCT, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS
AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. IF YOU
DO NOT AGREE TO ABIDE BY ANY TERM OF THIS AGREEMENT, DO NOT INSTALL, DOWNLOAD, COPY,
OR USE THE SOFTWARE PRODUCT, AND PROMPTLY RETURN THE ENTIRE UNUSED SOFTWARE
PRODUCT TO CHESAPEAKE TECHNOLOGY, INC. (“CTI”) FOR A FULL REFUND.
 
LIMITED LICENSE
CTI grants you a non-exclusive right, during the term of this Agreement, to install and use the Software in
object code format on your single computer. If you wish to use the Software on more than one computer, you
may do so if you purchase from us additional licenses of the Software.
 
SOFTWARE COPY AND USE RESTRICTIONS
The rights to this Software are owned by CTI. These rights are protected by United States copyright laws and
international treaty provisions. You may make one (1) backup copy of the Software for your own internal use.
You may freely move the Software from one computer to another, but the Software will only operate where the
hardware lock is attached, or the dongle free electronic license is activated (SonarWiz version 7.1 and later).
 
As part of the licensing validation, this Software will transmit the license number to our License Manager
at start up time. Electronic licenses will require periodic connection to the internet to validate the license
credentials.
 
TERMINATION
This License Agreement is automatically terminated if you violate any of its terms or conditions. You may
terminate this Agreement at any time by emailing CTI. Upon any termination you agree to return the original
materials supplied with the Software, and any copies you have made, to CTI.
 
PROHIBITED ACTIVITIES
The Software contains trade secrets and in order to protect them you may not decompile, reverse engineer,
disassemble or otherwise reduce the Software to a human perceivable form. You may not modify, adapt,
translate, or create derivative works based upon the Software or any part thereof. You may not rent, lease,
sublicense, or otherwise transfer access to the Software to a third party without written permission from CTI.
You agree to abide by all applicable laws related to your use of the Software.
 
U.S GOVERNMENT RESTRICTED RIGHTS
This Software and accompanying documentation is provided with Restricted Rights. Use, duplication or
disclosure by the U.S. Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of The Rights
in Technical Data and Computer Software clause at DFARS 252.227-7013, as may be amended from time
to time. Contractor/ manufacturers are Chesapeake Technology, Inc. 1605 W. El Camino Real, Suite 100,
Mountain View, CA 94040.
 
LIMITED WARRANTY AND DISCLAIMER
The entire risk as to the performance and results obtained from the Software and accompanying manual
are assumed by you. You are advised to test the Software thoroughly before relying upon it. However, to the
original purchaser only, CTI warrants the (a) written documentation and the media on which the Software is
shipped will be free from defects in material and workmanship, under normal use, for a period of 90 days after
the original purchase date and (b) the downloadable installation of the Software will install as described in the
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installation instructions. If during this warranty period a defect occurs, CTI will replace the defective item free of
charge. Your sole and exclusive remedy in the event of a defect, and CTI’s sole obligation, is expressly limited
to replacement of the downloaded Software and/or manual as provided above.
 
EXCEPT FOR THE LIMITED WARRANTY SET FORTH ABOVE, THE SOFTWARE AND ACCOMPANYING
MANUAL ARE PROVIDED “AS-IS” AND CTI DISCLAIMS ALL OTHER WARRANTIES, WHETHER
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CTI DOES NOT WARRANT THAT
USE OF THE SOFTWARE WILL BE WITHOUT INTERRUPTION OR WILL BE ERROR-FREE. SOME
STATES AND COUNTRIES MAY NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE
ABOVE LIMITATION MAY NOT APPLY TO YOU. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH MAY VARY FROM STATE TO STATE OR
COUNTRY TO COUNTRY.
 
THE LIMITED WARRANTY DISCLAIMER SET FORTH ABOVE ARE EXCLUSIVE AND REPLACE ALL
OTHERS, ORAL OR WRITTEN, EXPRESSED OR IMPLIED. NO RESELLER, DISTRIBUTOR, AGENT, OR
EMPLOYEE OF CTI IS AUTHORIZED TO MAKE ANY MODIFICATION OR EXTENSION.
 
LIMITATION OF LIABILITY
IN NO EVENT WILL THE LICENSORS BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES, INCLUDING WITHOUT LIMITATION LOSSES FROM BUSINESS
INTERRUPTION OR FROM LOST PROFITS OR DATA, LOST SAVINGS ARISING OUT OF THE USE OR
INABILITY TO USE THIS SOFTWARE, EVEN IF SPECIFICALLY ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, OR FOR ANY OTHER CLAIMS BY ANY OTHER PARTY. IN NO EVENT SHALL THE ENTIRE
LIABILITY OF CTI AND ITS SUPPLIERS FOR DAMAGES OF ANY NATURE EXCEED THE AMOUNT PAID
BY YOU TO CTI FOR THE SOFTWARE CAUSING THE CLAIM, IF THE LIABILITY RESULTS THEREFROM.
 
This warranty gives you specific legal rights; you may have others which may vary from state to state, region or
country. Some states, regions or countries do not allow the exclusion of incidental or consequential damages,
or the limitation of how long an implied warranty lasts, so some of the above may not apply to you.
 
CUSTOMER SUPPORT
All customer support inquiries get attention as soon as they are received and analysis and resolution proceeds
as soon as enough information is available to do so. If files are necessary for analysis, then analysis does not
proceed until those files are received from the customer. Work which involves a software fix (broken feature)
is typically resolved within the week for the software release which occurs on Friday evening of that week.
Change requests are queued and have no delivery date guarantee. Change requests are considered in the
order in which they are logged by the customer and requests are integrated.
 
PRIVACY
CTI is committed to respecting your privacy and recognizes your need for appropriate protection and
management of any personal information you share with CTI (“Personal Information”). Personal Information
is any information that can be used to identify an individual. For example: a person's name, address, email
address, social security number, drivers' license number, mother’s maiden name, birthday, debit or credit card
number, job title, IP and MAC addresses are widely considered to be Personal Information if they can be linked
to other stored data such as a user name.
 
Personal Information collected from customers generally
CTI collects and stores the following Personal Information while doing business with customers and prospects:

•  Company Name
•  Company address
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•  Names of individuals within a company who communicate with CTI on matters relating to software
specifications, pricing, sales, and technical support.

•  Email addresses and phone numbers of said individuals.
 
Sometimes this data is collected manually during a telephone conversation or email exchange.
At other times it is collected automatically such as when a user submits a problem report on CTI’s technical
support website. If a customer chooses to give us a personal phone number or email address, we will also
store that in our database unless specifically requested not to.
 
This Personal Information is collected and stored to enable CTI to transact business with customers and
potential customers and to enable CTI to track problems and respond to customers in a timely manner.
 
Some of the Personal Information may be shared with authorized reseller partners of CTI in accordance with
their reseller agreements to facilitate renewals of extended maintenance agreements and to better support end
customers who purchase SonarWiz products and services via a reseller instead of directly from CTI.
 
Personal Information collected from Evaluation License Users
Each time the SonarWiz application runs under a time limited Evaluation License, CTI collects the following
Personal Information from the machine on which the software is running:

•  IP address
•  MAC address of the ethernet adapter
•  Cached or user entered evaluation license number

 
It is collected to monitor the usage of the Software during the evaluation period to ensure compliance with the
Evaluation License Agreement. It is stored on CTI’s server and used solely to ensure license compliance, and
to effectively terminate the license at the end of the evaluation period. It is not shared with any third party.
 
Personal Information collected from Dongle-Free License Users
When the SonarWiz application is activated on a PC under a “dongle-free” license (perpetual or time limited),
CTI collects Personal Information that uniquely identify the specific machine on which the software is running,
such as:

•  The MAC addresses of all installed ethernet adapters
•  The machine name
•  The volume ID and/or serial numbers of all installed hard drives

 
Periodically, when the SonarWiz application communicates with our server to authenticate the license,
pursuant to the terms described in EULA, CTI collects the IP address of the machine as well as some unique
machine identifiers such as machine name. It is collected when a license is activated on a PC in order to bind
the license to that specific PC.
 
During the periodical license authentication, CTI collects some machine identifiers and the IP address in order
to validate the license against the machine on which it is currently running. The Personal Information is stored
on our server and is used solely for the purpose of authenticating licenses and ensuring license compliance. It
is not shared with any third party.
 
Protection of Personal Information
CTI implements a variety of security measures to maintain the safety of your Personal Information. We store
the payment card information only long enough to enter it into the Converge – Virtual Merchant online payment
processing system and then shred any paper documents the same day. If a software maintenance agreement
is renewed directly by the customer online, the card number is not visible to us. Information such as end
user name, company name, telephone and email are entered in password protected databases such as our
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proprietary license database, Salesforce CRM and QuickBooks accounting system solely for our own internal
use. License information for hardware dongles or electronic license activation keys are encrypted and stored in
hidden files. Further details available upon request.
 
Storage of Personal Information
CTI will retain your Personal Information for as long as we are doing business with you. We will retain and use
your Personal Information as necessary to comply with our legal obligations, resolve disputes, and enforce
our agreements. Unless otherwise provided in our contract with our customer, if the business relationship
or contract terminates, we generally process Personal Information for no more than thirty (30) days after
termination and then remove it from our system.
 
When the Personal Information is credit card information, that information is handled one of two ways. If an
online renewal of a software through our websites, the information is entered directly by the customer and sent
electronically to the Visa or MasterCard processor and is not visible to or stored by CTI. If the card information
is provided in written or verbal form during a call to CTI, the information is entered into the Converge Virtual
Merchant card processing system and once payment is processed immediately deleted or shredded.
 
Particular rights regarding Personal Information
Individuals in certain jurisdictions, such as the European Union, have certain rights under the European Union
General Data Protection Regulation (“GDPR”) with respect to their Personal Information, such as rights to
access it; correct inaccurate information; object to its collection or use for certain purposes; erase it; restrict
its further processing; ask for a copy; withdraw their consent of processing; and file a complaint with the
appropriate supervisory authority. We will provide the foregoing access except where the burden or expense of
providing access would be disproportionate to the risks to the privacy of the individual in the case in question,
or where the rights of persons other than the individual would be violated. Individuals who wish to exercise
their legal rights under the GDPR should contact us as described below in the “CONTACTING US” section.
 
If you choose not to provide the Personal Information to CTI, or remove it from our system, you may be unable
to access some or all of our software’s features that involve our interaction with you.
 
Third parties
We will not distribute your Personal Information to any third party without your consent, other than as
reasonably necessary to provide, maintain and support CTI’s business operations, such as payment
processors, web hosting services, or data centers. These companies are authorized to use Personal
Information only as necessary to provide these services to CTI.
 
Merger/acquisition
If CTI is involved in a merger, acquisition, or sale of all or a portion of its assets, you will be notified via email
and/or a prominent notice on our site of any change in ownership or in uses of your Personal Information, as
well as any choices you may have regarding your Personal Information.
 
Changes to our Software Privacy Policy
If we decide to make a material change our Software Privacy Policy, you will be notified via email and/or post a
notice of those changes on our site prior to implementing that change.
 
Website Privacy Policy
Our Website Privacy Policy, which applies to any person accessing our website, is located here , or go to our
site at: http://www.chesapeaketech.com/about/privacy-policy/.
 
Contacting us
Chesapeake Technology, Inc.

http://www.chesapeaketech.com/about/privacy-policy/
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1605 W. El Camino, Suite 100
Mountain View, CA 94040 USA
Eileen Gann, President
etgann@chesapeaketech.com +1-650-967-2045
 
GENERAL TERMS
This is the only agreement between the user and CTI regarding the Software and it may be modified only
by a written agreement between those parties. This Agreement cannot be modified by purchase orders,
advertising or other representation by any dealer, company or person; any such representation will not bind
CTI. If one or more of the provisions in this Agreement are deemed void by a court of competent jurisdiction,
then the remaining provisions will continue in full force and effect and CTI and you agree to replace any
invalid provision with a valid provision which most closely approximates the intent and economic effect of the
invalid provision. If CTI’s performance is hindered due to weather, terrorism, telecommunications disruption,
or any other cause beyond CTI’s control, CTI will be excused from performing to the extent and as long as
its performance is so affected. This Agreement will be governed by the laws of the State of California, U.S.A.
without regard to its conflict of laws principles, and expressly excluding the United Nations Convention on
Contracts for the International Sale of Goods, with exclusive jurisdiction in Santa Clara County, California.
 
BY INSTALLING OR DOWNLOADING THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ
THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
 
__ I HAVE REVIEWED THE FOREGONG AGREEMENT. I ACKNOWLEDGE THAT (A) MY PERSONAL
INFORMATION WILL BE TRANSFERRED TO, AND PERHAPS FROM, CTI’S SERVERS LOCATED IN
THE UNITED STATES, (B) THE EUROPEAN UNION DOES NOT CONSIDER THE UNITED STATES TO
HAVE DATA PROTECTION STANDARDS EQUIVALENT TO THE EU, (C) ANY TRANSFER OF DATA
OVER THE INTERNET OR TELECOMMUNICATION NETWORKS POSES INHERENT RISKS, (D) SUCH
TRANSFER IS NECESSARY FOR ENTERING INTO AND PERFORMING MY CONTRACT WITH CTI, AND
(E) I EXPRESSLY CONSENT TO SUCH TRANSFER OF PERSONAL INFORMATION.
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Using a Dongle License
 

 
A Dongle is a small USB hardware key that you can plug into any PC. The portable design allows you to move
your SonarWiz licenses between machines without network connections, or additional license files.
 
The dongle contains the licenses for the various software components and options that have been purchased
from CTI. The licenses in the key can be updated in the field by the user if new options are purchased from
CTI. Instructions for doing this can be found in Updating SonarWiz License Key.
 
How to Connect a Dongle
 
If you are using a USB dongle key you will need to install the GEMALTO (dongle) drivers onto your computer.
The necessary drivers are currently installed along with SonarWiz.
 
Your USB dongle key will need to remain plugged into your computer in order to use SonarWiz.
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Lost or Stolen Dongle Policy
 
CTI has a firm and consistent policy regarding lost or stolen keys. If you can prove the key has been
destroyed (as in sending back the carcass) or if it has been stolen, have a police report that states this, CTI will
replace the software license for the cost of the key. Otherwise, the owner is responsible for the cost of a new
license.
 
Chesapeake Technology, Inc. (CTI) recommends insuring yourself against the loss of theft of a software
dongle.
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Updating Dongle License Key
 
If your Dongle is out of date or you have purchased new features, the Dongle must be updated with a DUK file
provided by CTI.
 
In order to update the Dongle with the new DUK file:
 
1.  When SonarWiz is installed the program Dongle Manager is also included.
2.  From the Windows Start Menu under programs, select the SonarWiz7 program group and left-click on
Dongle Manager to open the CTI Dongle Manager.
 

 
 
3.  Ensure the dongle is plugged into a USB port on the local machine.
4.  Click the Update Dongle button which will open a standard file selection dialog.
5.  Find the local copy of the .DUK file attachment that you received from CTI and press the Open button.
6.  The dongle will now be updated using the information contained in the .DUK file.
7.  Click the Done button to exit the program.
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Using a Network License
 
Please refer to the NetworkDongleReference.pdf located in your SonarWiz installation folder for more
information.
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Using a Node-Locked (Dongle-Free) License
 

 
SonarWiz V7.01 will now run without a dongle so long as the PC on which it is installed contains a valid
license. A license is created by CTI staff, and is activated by the user.
 
CTI License Manager
 
The standalone utility for managing licenses on a user PC is called CTI License Manager. This tool currently
allows you to:
 
•  Activate a license
•  Deactivate a license so that it can be moved to another PC
•  Update a license if it has been changed by CTI staff (e.g. EMA date extended)
 
Internet access is required for activation, and the license must be activated on the machine on which it will
be used. The activation process creates a license file that is uniquely tied to that specific PC. In addition,
Sonarwiz will periodically attempt to validate the license by contacting our database server. If, after repeated
attempts, our server cannot be reached because there is no internet connection, Sonarwiz will display a
reminder message.
 
A license can be activated many times on the same, or a different PC. However, multiple concurrent
activations of the same license is blocked by the system. In other words, if I activate a license on machine A,
and then wish to activate it on machine B, I first have to deactivate it on machine A. Deactivation of a license is
done by pressing the Deactivate button on CTI License Manager. Internet access is required for this.
 
Each new activation of a given license is called an installation. Thus, an active license is identified by its
license ID and its installation ID.
 
License Activation
 
1. The user is responsible for activating a license on their PC. This is done by running CTI License Manager
and pressing the Activate button.
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2. Enter the License ID and Key supplied by CTI
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Each new activation of a given license is called an installation. Thus, an active license is identified by its
license ID and its installation ID.
 
Deactivating a License
 
You would typically deactivate a license so that it can be moved to another machine.
 
Deactivation is done by using the Deactivate button in CTI License Manager. Doing this deletes the license file
on the current PC and flags that installation of the license as deactivated in our database.
 
Move a License
 
1. Deactivate on machine A
2. Activate on machine B
 
Note that in order to activate the license again, you will need the original license ID and key (password).
 
Refreshing (Updating) a License
 
You will need to refresh a license after it has been edited by CTI staff. For example, after an new
EMA expiry date has been set, or a new module has been purchased.
 
To refresh the license, simply presses the Refresh button in CTI License Manager. You do not need to
know the license ID or password.
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Extended Maintenance Agreement
 
CTI supports our EMA customers by providing preferred technical support via phone, fax, e-mail and our
customer support web site.
 
Your EMA provides you with:
 
•  Unlimited 24/7 downloads of all product upgrades produced within the year of coverage
•  Preferred technical support. Your questions/problems are answered and resolved ahead of non-EMA
subscribers
•  Login and Password to our support site which also includes tutorials, videos and other training documents
•  15% discount off our user group workshops
 
To check on the status of your EMA from SonarWiz:
 
Click Help | My Support Info ... to open the My Support Information dialog. The dialog shows you your
Dongle Serial number, User ID and EMA expiration date.
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SonarWiz Basics
 

The primary functions of SonarWiz are:
 
1.     Recording sonar and magnetometer data in Real-time;
2.     Re-playing prerecorded sonar data;
3.     Creating mosaics or maps from sonar and magnetometer data.
 
In addition, SonarWiz contains many tools for manipulating and exporting sonar data and for handling ancillary
data such as targets and digitized features. This section provides a brief overview of the user interface through
which these functions are provided.
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Screen Anatomy
 

The SonarWiz screen consists of a main window, menus, toolbars, and docking areas for optional windows.
The main window, known as the Map Window, is used for the display of georeferenced data. Basemap
images and survey lines may be added to the map display to provide visual reference. Digitized features and
targets can also be displayed on this map.
 

 
 

 
 

Main Display
The main display window provides an interactive 2D map view of all of the sonar data loaded into the
project along with any basemaps, features, contacts and map decorations selected for display.

Quick Access Toolbar

The quick access toolbar provides functions to create new projects, load existing projects and save
the current project. It also provides access to the project settings and the program settings.   Clicking
the large SonarWiz icon reveals a larger version of the menu with text descriptions of the icons, it also
displays a list of the recently opened projects. See Quick Access Toolbar for more information.
 

Command Ribbon
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The Command Ribbon is a collection of useful buttons and controls divided into 7 pages or tabs. The
tabs are organized by the task you are performing such as Data Acquisition or Post Processing. Most
of the functionality of SonarWiz can be accessed directly from the command ribbon. Note that some
tabs may not be present if you do not have the required license for those commands.

Mapping Toolbar

The Mapping Toolbar provides basic controls for manipulating the Map Display including pan and
zoom functions, selection tools and controls for plotting contacts and features on the map.

Project Explorer

The Project Explorer lists every object loaded into a SonarWiz project and groups them according to
object type. You can enable or disable objects here, and by right-clicking objects, access the object-
specific context menus that provide actions that you can perform on these objects.
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Properties Window

When an object is selected in the Project Explorer, the Properties Window displays detailed
information about the selected object. Many properties such as the color pallet of an object can be
manipulated directly in the dialog.

Connection Status Area

The connection status area of the Status Bar indicates the up or down status of real-time navigation
and sonar connections. It also provides a direct link to the CTI Support site and a refresh command to
redraw the screen

Output Message Log

The Output Message Log window displays ongoing status information generated by SonarWiz as it
runs. The complete log can be opened from the Tools Menu.

Cursor Information
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The Cursor Information section of the Status Bar indicates the geographic location of the cursor in the
map window, the same location in projected coordinates and when over a bathymetry surface, the
value of the surface.

Color Window

The Color Window controls the color palette display for global data types such as sidescan,
bathymetry and sub-bottom displays.
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Quick Access Toolbar
 

 
The Quick Access Toolbar is the “Starting Point” for most commands that a user would traditionally find under
the “File” menu of predominant Windows-based applications. Clicking on the SonarWiz icon opens the Quick
Access Toolbar to reveal the (enabled) main functions available.
 

 
 

The following table shows the default Quick Access Toolbar Command icons and links to the appropriate
section of the manual for more information
 

Command Description
Create
a new
project

Open an
existing
project
Save the
current
project
Modify the
current
project
settings
Access the
program
options
Exit the
program
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Recent Projects List
Open
recent
projects.

 
Note that the Quick Access Toolbar is customizable. For more information see Customize Quick Access
Toolbar
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Customize Quick Access Toolbar
 

 
The figure above shows that the New, Open, Save, Project Settings, Options and Exit buttons are active
(checked) within the Quick Access Toolbar. Left-clicking on an un-checked command will add it to the Quick
Access Toolbar whereas left-clicking on a checked command will remove that command from the Quick
Access Toolbar .
 
More Commands...
See More Commands below
 
Show Below the Ribbon
Puts the Quick Access Toolbar , which is normally above the ribbon and places it below the Ribbon.
 

   
 
Minimize the Ribbon 
Minimizes the Command Ribbon containing the Command Icons for each menu item
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More Commands...
The six commands listed in the first section of the customization dialog are the most common commands
available for inclusion in the toolbar but not the only
commands available.
 
Left-clicking on More Commands opens the Customize dialog.
 

 
Customize Dialog
 
The Customize dialog allows the user to choose almost any command function available in SonarWiz and
assign it to the Quick Access Toolbar.
 
To add a new command:
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1. Find the desired command by locating it within its Command list.
2. Left-click to select the Command list and then left-click (highlight) the desired command.
3. Once the command is highlighted left-click on Add >> and the command will now be available in the Quick
Access Toolbar.
 
To remove command:
 
1. Left-click on the unwanted command in the Active Commands area
2. left-click on Remove .
 
To change the order of the commands:
 
1. Within the Active Commands area, left-click on the command whose order is to be changed.
2. Once selected left-click on the up or down arrow to the right of the Active Commands area until the selected
command appears in its desired position.
 
Show Quick Access Toolbar Below the Ribbon
 
This check box is equivalent to left-clicking the “ Show Below the Ribbon ” option in the dialog in Figure 24 .
When selected the Quick Access Toolbar will appear blow the command ribbon.
 
Keyboard Shortcuts
Left-clicking the Customize button will open the Customize Keyboard dialog.
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To Customize A New Shortcut Key:
 
1.  Left-click the Command category in the “ Categories: ” window where the desired command is located
2.  Left-click the specific command desired changed in the “ Commands: ” window
3.  If any shortcut keys exits for the selected command it (they) will be shown in the “ Current Keys: ” window.
4.  Left-click inside the “ Press new shortcut key ” window and type the new shortcut key desired. Note that the
Shift , Control , and Alt keys must be held while typing the next key in the sequence in order for that sequence
to register.
5.  Once the key (sequence) desired is in the window then left-click the Assign button to finalize the new
keyboard shortcut.
 
Note that adding a new keyboard shortcut does not remove the existing shortcut; rather, it appends the new
one. In order to remove an existing shortcut see the next section.
 
To Remove An Existing Shortcut Key:
 
1.  Left-click the Command category in the “ Categories: ” window where the desired command is located
2.  Left-click the specific command desired changed in the “ Commands: ” window
3.  If any shortcut keys exits for the selected command it (they) will be shown in the “ Current Keys: ” window.
4.  Left-click the keyboard shortcut desired removed inside the in the “ Current Keys: ” and left-click the
Remove button to delete the currently selected keyboard shortcut.
 
To Revert to Factory Keyboard Shortcut Settings:
 
1.  Left-click the “ Reset All ” button
2.  SonarWiz will prompt the user to confirm the Reset command with the dialog in Figure 31 below.
3.  Note that ALL customized Keyboard shortcuts will be lost using this function.
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Adding Ribbon Functions to
the Quick Access Toolbar

 
Add a Ribbon command to the Quick Access Toolbar:
 
1.  Right-click any command in the Ribbon to open the Context Menu
 

 
2.  Select Add to Quick Access Toolbar

 
The command will be added to the Quick Access Toolbar as shown
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The Command Ribbon
 

Using the Ribbon
 
The Command Ribbon occupies the top portion of the SonarWiz user interface and contains buttons and
interactive controls that give access to most of the features of the program. The Ribbon is divided into groups
of related functionality called Menus or Tabs. Some tabs may or may not be available depending on your
SonarWiz license.
 

 
Note that the Ribbon interface looks different on narrow screens. Command Groups collapse down into a
single icon so that you have to click once to open the command group and then you can select the desired
icon. For example the same View Ribbon above looks like this on a narrow screen:

Active Tab

Only one tab on the Ribbon can be active at a time. This tab is highlighted to look like it has been
brought to the front. The Tabs in SonarWiz are organized into tasks such as Data Acquisition and Post
Processing. The idea is that all of the commands you would need to perform a task are easy to access
from the same menu. To make a Tab active click on it's name with the mouse.

Inactive (Hidden) Tab

Inactive or hidden tabs recede into the background of the user interface. Their commands are hidden
from view behind the active tab. To activate a hidden tab, lef-click on its name with the mouse.
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Command Group

Groups of related commands are collected into command groups. Each command group is
surrounded by a then border and given a small label beneath. Groups contain commands that are
closely related. Note that when the user interface is made too narrow to display the group horizontally,
the group will collapse into a single icon representing the group. You can access the commands in a
collapsed group by clicking once on the small icon to reveal a vertical list of the commands available in
that group.

Button Control

Commands in the ribbon are often simply buttons that can be left clicked.  If a button has a small
downward pointing arrow  this indicates that clicking the button will offer a menu of choices to
choose from.

Interactive Control

The Ribbon can also contain interactive controls such as the slider bars shown here to manipulate the
shaded relief settings dynamically.
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The Mapping Toolbar
 

The Mapping toolbar can be opened by clicking Post-Processing Views | Mapping Toolbar from the View
menu. The Mapping Toolbar allows you to interact with objects in the Main Window.

 

 
 

Select

Select items with the mouse.

Snapshot

Copy a snapshot of the current project to the clipboard.  (Ctrl + PrintScreen)

Pan Map

Pan the map display by dragging with the left mouse button down.

Rectangle Zoom

Draw a box around the area of interest to zoom into it.

Zoom In

Zoom In by 10% (PgDn)
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Zoom Out

Zoom Out by 10% (PgUp)

Fit View to Sonar

Adjust the view bounds so that it encompasses all of the sonar data loaded in the project.

Fit View to All

Adjust the view bounds so that it encompasses all data loaded in the project including maps,
magnetometer, sonar etc.

Swipe

Peel back the sonar data over a basemap by dragging the mouse from any of the 4 sides towards the
map center.

Measure on Map

Measure range and bearings by dragging left mouse button in map view.

Auto Ship Centering

Toggle the auto ship centering function.  When on this function always keeps the ship in the map
display.  When off, the view may be panned to other areas of the map.

Map Info

Allow the mouse to hover over a map item of interest and this tool will display a popup tooltip with
information on the underlying map object.

Redraw Now

Redraw all items in the map.
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Abort Redraw

Abort a lengthy redrawing process

Capture Contact

Select a contact capture cursor, then click on the map where you want to look for the contact.  The
waterfall view will open and the contact may be selected by a single left click.

Add Survey Line

Add survey line by drawing it with your mouse.

Insert Feature

Add line, polyline or polygon feature by drawing the feature with the mouse.  Right click to end the
digitizing session.

Previous View

Jump to the previous view location.

Next View

Jump to the next view location.

Color Window

Assists in mapping project data to their respective colors.
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Project Explorer
 

The Project Explorer is a dockable window that lists all of the objects loaded into or generated within a
SonarWiz project. The project explorer is the primary way users select and interact with their data in SonarWiz.
Like all windows in SonarWiz, the Project Explorer can be docked and moved around the user interface as
described in (See Docking Windows). By default, the Project Explorer is docked and visible on the left side of
the main SonarWiz screen.
 
To make the Project Explorer window visible:
 
1.  Select the View tab on the Ribbon Menu
2.  Select Post-Processing Views
3.  Select Project Explorer
 

 
The Project Explorer presents all project data in a hierarchical tree. Each data type is sorted into its
appropriate branch of the tree. Branches of the tree can be collapsed or expanded by clicking the small  or

 icons, respectively. The total number of files beneath each branch is indicated in parenthesis.
 
Enabling and Disabling Objects
 

The Project Explorer indicates that an object is enabled by showing a check mark icon  next to its name in
the tree. Most commands and operations in SonarWiz will only apply to enabled objects. If you wish to disable

an object, left-click the  icon until it shows an empty box .
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You can enable or disable an entire branch of the Project Explorer tree by clicking  next to the group

name until it shows a blank box . A special filled box icon  is used to indicate a mixture of selected and
unselected files.
 
Selecting Objects
 

 
In order to perform an action on an object you must first select it. Left click an object in the Project Explorer
to select it. The object name will be highlighted in the Project Explorer and the object will be selected in the
Main Map window as well. Likewise, if you select an object in the Map Window, it will be selected in the Project
Explorer. These operations are interchangeable.
 
You can select multiple objects in the Project Explorer in two ways:
 
1.     Hold down the SHIFT key and left-click on two files in the Project Explorer. SonarWiz will select all of the
files between the two clicked files.
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2.     Hold down the CTRL key and left-click on each file you want to select. SonarWiz will add each file you
click to the selected set.
 
Performing Actions on Selected Objects
 
The Project Explorer allows you to perform almost every command available in the program. To see a list of
actions available for a selected object, right-click the selected object or objects to open the Context Menu for
that object.
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When you open the context menu (right-click menu) for a single selected object in the Project Explorer, this is
equivalent to opening the context menu on a selected object in the Map View. The commands that are shown
act on only the selected file.
 
If instead, you want to perform actions that to all files of the same type, open the context menu for the group of
files by right-clicking on the branch name in the Project Explorer.
 
Note: Many of the functions found in the Sonar File Manager (F11 Dialog) and other Manager dialogs
throughout the program can now also be found in the Group-Level context menus.
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Zoom To
 
The Zoom To command will zoom and pan the main SonarWiz map window to center the selected object or
data set.
 
To Zoom To an object or data set:
 
1. Select Zoom To from the object context menu or Select the object and press the Z key short-cut.
 

 
2. SonarWiz will pan or zoom the display as necessary to center on the selected object.
 
Before the zoom, the sonar file is located in the southwest corner of the display.
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After the Zoom To command, the sonar file is centered in the window:
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Hide
 
The Hide command disables an object loaded into SonarWiz so that it is no longer visible in the project.
Hidden objects will not be processed, visualized or exported by most commands and will not be included in
the global color histograms. Hiding an object is the same as disabling (unchecking) an object in the Project
Explorer.
 
NOTE: Hidden objects are not removed from the project. To re-enable a hidden object, simply toggle the check
mark next to the object name in the Project Explorer.
 
To Hide (Disable) an object in a SonarWiz project select Hide from the object context menu or Toggle the
check box to the left of the object name:
 

Hidden (Disabled) Object

The empty check box indicates that this object is Hidden (disabled).

Visible (Enabled) Object

The check in the box indicates that this object is visible (enabled)
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Isolate
 
The Isolate command Hides all of the other objects of the same type loaded into SonarWiz so that the
selected object is the only one of this type visible in the project. Isolating an object is the same as disabling
(unchecking) all of the other objects in the project except the target object in the Project Explorer.
 
To Isolate an object in a SonarWiz project either select Isolate from the object context menu or toggle the
check box to the left of all objects except the selected object.
 
For example, to isolate the 1st sidescan file in this project:
 
Select Isolate from the context menu for the second file.
 

 
Which turns off (Hides) all of the sidescan files except the selected file:
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New SubGroup
 
The New Subgroup command is located on branch-level context menus in the Project Explorer. Subgroups
can be used to help organize a collection of datasets.
 
To Create a New Subgroup:
 
1. Select the New Subgroup... command from the Right-click context menu of the branch in the Project
Explorer.
 

 
2. Fill in the name of the new subgroup in the Create New Subgroup window that opens:
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3. The new Subgoup will be added to the selected branch
 

 
4. You can now drag-and-drop files into the subgroup.
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Rename SubGroup
 
The Rename Subgroup command is available from the Subgroup context menu of the Project Explorer. See
also creating a New Subgroup command.
 
To rename a subgroup:
 
1. Select Rename SubGroup from the subgroup context menu (Right-click menu).
 

 
2. Give the subgroup a new name in the Rename Group dialog
 

 
3. The subgroup will be renamed in the Project Explorer
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Remove SubGroup
 
The Remove SubGroup command is available from the SubGroup context menu of the Project Explorer. See
also creating a New Subgroup command.
 
To remove a subgroup:
 
1. Select Remove SubGroup from the subgroup context menu.
 

 
2. The SubGroup will be removed. Only the subgroup is removed, any datasets in the subgroup will be
returned to the main branch.
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Properties Window
 
Closely associated with the Project Explorer is the Properties Window. Whenever an object is selected in the
Project Explorer, the Properties Window will display the associated settings and properties of the selected
object.
 
Use the command View | Post-processing Views | Properties to enable the Properties window. The window
can be docked anywhere in the SonarWiz application, but is usually placed next to or below the Project
Explorer.
 

 

Tool bar

Tools are sometimes available in the Properties window directly. Shown here are the Save property
and Refresh property icons.

 

Tabs

Properties are organized into different pages depending on the number of properties needed for an
object.
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Table of values

Properties are listed as Name/Value pairs in tabular format. Read-only property values are grayed out,
properties that can be modified are in blue. Some properties have a check box or control embedded in
the table which you can interact with directly

Property sub-group

Withen a property table, properties can be grouped. Property groups are indicated by thick green
borders. The entire group can be collapsed by clicking the + or - icon in the upper left of the sub-group

Tool tip

When you click on a property, a tool tip will be displayed giving some indication of what the property is
used for.
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Display Property
 
The display and rendering of bathymetric and backscatter data in SonarWiz is controlled through the Display
tab of the Properties window
 

Display tab

Select the Display tab in the Property window to control the color and visibility of data

Viewer selection section

Choose to display the data in the 2D view (Main window) and or the 3D viewer (not all data sets can
be displayed in the 3D viewer in which case, this option will not be present)
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Depth Data section

The Depth data section (when present) controls how depth data will be displayed in the 2D and 3D
views (See Color Properties)

Backscatter Data section

The Backscatter Data section (when present) controls how backscatter data will be displayed in the 2D
and 3D views (See Color Properties)

Tool Tip

When a control is selected in the Properties window, a tool tip will display indicating the purpose of the
property.
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Color Properties
 
Color properties are found in the Display tab of the Properties window for many data types.
 

 

Use Global Color Group

The Use Global Color Group property determines whether the data set will be colored using the
global color palette for this data type or whether it will use a custom color setting. When checked, the
data set will follow the color palette settings in the Color window and it will be colored the same as
all other data sets of the same type. When unchecked, the user can override the color scale settings
using the color properties described below. 

Color Scale

 
The Color Scale property contains a drop-down list of color pallets to choose from. There are more
than 20 built-in pallets and you can add custom pallets of your own in the Color Scale Properties
dialog.
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Open up the Color Scale Properties dialog by clicking on the  icon to the right of the color pallet
drop-down.
 

Minimum and Maximum Color Value

The Color scale (pallet) will be stretched linearly between the Minimum and Maximum Color Values
set here. These values can be assigned automatically by SonarWiz when you change the Scale
Mode, or they can be manually entered by the user if the Scale mode is set to Manual.

Scale Mode

The scale mode determines how the Minimum and Maximum Color Values will be set, which in turn,
controls how the color pallet will be stretched to the data. There are three Scale modes to choose
from:
 
Manual In this mode, the user can set the

Minimum and Maximum Color
Value manually

Auto - This Data The Minimum and Maximum
Color Values will be set after
examining only the data from this
data set. A good stretch will be
picked that represents most of the
data properly.
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Auto - All Data In this mode, the Minimum and
Maximum Color Value are set
after examining all of the data
sets loaded into the project. The
values selected represent a good
fit to the loaded data. If all data
sets are set to this mode. They
will all have the same color stretch
assigned to them.

Invert Color Scale

A check box to invert or flip the color ramp

Bipolar Color Scale

When Bipolar Color Scale is active, color pallets are centered at zero and increase symmetrically
away from zero.

Smooth Color Scale

Color scales can display sharp boundaries between pallet values or they can gradually transition
between values (e.g., smoothed).



Color Scale Properties

102

Color Scale Properties
 
The Color Scale Properties dialog is used to control the mapping of colors to data. Most of the controls here
map directly to Color Properties but there are some additional features in this dialog that give you more control
over the color mapping.
 
To open the Color Scale Properties dialog:
 
1.  Use the View | Post-processing Views | Property command to open the Properties window
2.  Click the Display tab to show the Display properties
3.  In the Color Scale property, click the ellipses (...) icon to the right of the color scale drop-down.
 

Palette Options

The Palette Options group allows you to select a built-in color pallet or to create a new palette using
the Palette Editor. You can invert the palette with the Invert option, and you can smooth the palette
color transitions with the Smooth option.
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Mapping Range

The selected color palette will stretch between the minimum (Min) and maximum (Max) values shown
in the mapping range. How the min and max values are set is determined by the Scale Mode. There
are three Scale modes to choose from:
 

Mode Description
Manual In this mode, the user can set the

Minimum and Maximum Color
Value manually or use the Scale
to Best or Scale to Data buttons.

Auto - This Data The Minimum and Maximum
Color Values will be set after
examining only the data from this
data set. A good stretch will be
picked that represents most of the
data properly.

Auto - All Data In this mode, the Minimum and
Maximum Color Value are set
after examining all of the data
sets loaded into the project. The
values selected represent a good
fit to the loaded data. If all data
sets are set to this mode. They
will all have the same color stretch
assigned to them.

 
If the Scale mode is set to Manual, the Scale to Best and Scale to Data buttons become active.
 
Scale to Best will set the Min and Max values using the same algorithm as Auto - This Data
Scale to Data will set the Min and Max values to the limits of the data set including any outliers.
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Mapping

The mapping section of the Color Scale Properties shows visually how colors from the selected pallet
are mapped to the data in the project.
 
Histogram Controls
On the left-hand side is a histogram of the data values of the selected data type (for example,
bathymetry files). On the right hand side is the color bar that will be used by the program. The small
red rectangle with red arrow markers shows the mapping range. If the Scale mode is set to Manual,
you can move the end-points of the rectangle up or down the histogram to rescale how the colors from
the palette will be mapped to the data at hand.
 
Zoom
Sometimes the portion of the histogram you want to focus on is much smaller or larger than the

displayed range. In this case, you can use the  controls to zoom to the portion of the
histogram you want to see.
 
Bipolar Mode
Sub-bottom data types have the option to change the behavior of the range markers to bi-polar mode.
In bi-polar mode the minimum and maximum range marker move symmetrically about zero.
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Data Types and Global Color Groups
 
All data in SonarWiz is automatically assigned to a Data Type. There are currently 8 data types in use:
 

Data Type Description
Sidescan (Ch. 1
and 2)

The port and starboard channel of single-frequency sidescan
systems, or the low-frequency of dual-frequency sidescan systems.

Sidescan (Ch. 3
and 4)

The port and starboard channel of the high-frequency of dual-
frequency sidescan systems

Sub-bottom (Ch. 1) The normal channel for single-frequency sub-bottom profilers, or
the low-frequency of dual-frequency sub-bottom profilers.

Sub-bottom (Ch. 2) The high-frequency of dual-frequency sub-bottom profilers.
Backscatter The intensity values associated with bathymetric soundings/lidar

elevations
Bathymetry The depth values associated with bathymetric soundings/lidar

elevations
Density Statistical data representing counts or density

Standard Deviation Statistical data representing standard deviations
Forward Looking Forward Looking Sonar in the map view, waterfall displays, contact

images, exports
 
Each data type has an associated Global Color Group which is controlled using the Color Window. Any
changes you make to the Global Color Group in the Color Window will affect all of the other objects of the
same data type simultaneously.
 
To discover the data type of an object in SonarWiz:
 
1.  Select the object in the Project Explorer.
2.  Select the Display tab of the Properties Window
3.  Find the Datatype field (as shown below)
 



Data Types and Global Color Groups

106

 
 To disconnect an object from the Global Color Group:
 
1.  Select the object in the Project Explorer
2.  Select the Display tab of the Properties Window
3.  clear (uncheck) the Use Global Color Group check box
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With the Use Global Color Group property cleared, the Color Scale Properties for this object become active
and you can change the colors for this object independent of the settings in the Color Window.
 
To connect an object to its associated Global Color Group
 
1. Select the object in the Project Explorer
2. Select the Display tab of the Properties Window
3. Set check the Use Global Color Group check box
 

 
With the Use Global Color Group property set, the Color Scale Properties for this object become inactive and
the colors for this object will be set by the Color Window.
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Status Bar
 

 
The Status Bar, located at the bottom of the Main View, contains the following information:
 
CTI Support
A Hyperlink to the Chesapeake Technology Support Website.
 
Redraw
Redraws (refreshes) the Map Window
 
Real Time Status Icons
Active sensors are displayed. When connection to a particular sensor is lost then a red flashing X will appear
over the Sensor Status Icon
Left-clicking a sensor status icon open the associated sensor configuration dialog
 
Cursor Information
Displays the Latitude, Longitude, X and Y position of the cursor
If a basemap is loaded that contains height (Z) information then the value is shown in the Z field.
 
Configuring the Status Bar
The Status Bar may be configured by right-clicking on the bar itself opening the context pop-up menu shown
below .
Individual items (except Sensor Status Icons) may be turned on or off
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Color Window
The Color window can be opened by clicking Post-Processing Views | Color Window from the View menu.

It is also available by clicking the  icon on the Map Toolbar. The Color window controls the global color
mapping for data in SonarWiz.

 
 

Data Type Selection

Select the global palette to color. All data displayed in SonarWiz is initially assigned to one of 8 global
data types and each data type has a master color palette (See Color Properties for more information).
The following table describes what data types the master color palettes apply to.
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Data Type Description

Sidescan (ch. 1
and 2)

Low frequency sidescan in the map view, waterfall displays,
contact images, exports

Sidescan (ch. 3
and 4)

High frequency sidescan in the map view, waterfall displays,
contact images, exports

Sidescan (ch. 5
and 6)

Very high frequency sidescan, Gap fill data, Motion Tolerant
data in the map view, waterfall displays, contact images,
exports

Sub-bottom (ch.
1)

Low frequency sub-bottom in the map view, waterfall displays,
contact images, exports

Sub-bottom (ch.
2)

High frequency sub-bottom in the map view, waterfall
displays, contact images, exports

Backscatter Bathymetry backscatter point clouds and gridded amplitude
data (_AMP), waterfall displays, contact images

Bathymetry Bathymetry depth point clouds and gridded depth data
(_DEP), waterfall displays, contact images

Lidar Lidar point clouds, waterfall displays, and contact images
Standard
Deviation

Bathymetry statistical grids (_STD, _UNC)

Density Bathymetry density grids (_CNT)
Forward Looking Forward Looking Sonar in the map view, waterfall displays,

contact images, exports
Magnetometer
Raw

Raw Magnetometer data in the map view

Magnetometer
Residual

Residual Magnetometer data in the map view

 
Note that by default, all sidescan, subbottom and bathymetry data sets are set to use the global color
palette appropriate for their type. This allows the user to easily change all files of the same type by
making adjustments to the Color window. However, the user can override the coloring of any file by
unchecking the Use Global Color Group property in the Properties window and color the file using a
palette and histogram stretch unique to that file alone.
 

Histogram
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The histogram graph shows the frequency count of all of the enabled data of the selected data type
(for example, all of the sidescan files in the project). The histogram graph is colored according to the
selected color palette, showing how the colors will be mapped to the data.
 
The histogram trim controls (red box with arrows) are available only when the Scale mode is set to
Manual. The user can adjust the upper and lower limits of the box to graphically trim the histogram and
compress the color ramp to just the data in the window.

Histogram Zoom

Zoom the histogram. Useful when outlier values stretch the display of the histogram far outside the
bulk of the data.

Smooth Palette

If checked, SonarWiz will smooth the transition between colors in the color palette (useful for
continuously variable data). If left unchecked, SonarWiz will abruptly transition between colors as
specified in the palette definition (useful for categorical data). 

Invert Palette

Flip the palette.

Mapping Range

When the Scale Mode is set to Manual mode, set the upper and lower bounds of the histogram
window.

Scale Mode

The selected color palette will stretch between the minimum (Min) and maximum (Max) values shown
in the mapping range. How the min and max values are set is determined by the Scale Mode. There
are three Scale modes to choose from:
 

Mode Description
Manual In this mode, the user can set the

Minimum and Maximum Color
Value manually or use the Scale
to Best or Scale to Data buttons.

Auto - This Data The Minimum and Maximum
Color Values will be set after
examining only the data from this



Color Window

112

data set. A good stretch will be
picked that represents most of the
data properly.

Auto - All Data In this mode, the Minimum and
Maximum Color Value are set
after examining all of the data
sets loaded into the project. The
values selected represent a good
fit to the loaded data. If all data
sets are set to this mode. They
will all have the same color stretch
assigned to them.

 
If the Scale mode is set to Manual, the Scale to Best and Scale to Data buttons become active.

Color Bar

The color bar or legend shows how the colors of the palette are mapped to the data.

Bipolar Mode check

Normally, the color palette stretches from the data minimum value to the data maximum value. In
bipolar mode, the palette is centered at zero and stretches symmetrically away from zero. Bipolar
palettes are useful for plotting data that naturally oscillates about a fixed zero value such as full
envelope pressure data from sub-bottom profilers.

Palette Selection

Select from one of the built-in color palettes or any custom palettes that have been saved to the
program directory using the Palette Editor window.

Edit Palette button

Open the Palette Editor window
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Scale To Best button

When the Scale Mode is set to Manual mode, clicking this button will set the upper and lower bounds
of the histogram window to the middle 95% of the data.

Scale To Data button

When in Manual mode, clicking this button will set the upper and lower bounds of the histogram
window to the limits of the data.

Scale To Palette button

When in Manual mode, clicking this button will set the upper and lower bounds of the histogram
window to the limits of the palette. See the Palette Editor window for more information.
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Palette Editor
 

The Palette Editor allows you to customize the existing set of color pallets in SonarWiz and to save your
edited pallets with a new name for use in the future. The Palette Editor shows an example of the current color
palette on the left side of the dialog.
 
To open the Palette Editor:
 
1.  Use the command View | Post-processing Views | Properties to open the Properties window
2.  In the Project Explorer, select any sonar data set or grid
3.  In the Properties Window click the Display tab
4.  In the Color Scale property click the ellipses (...) icon to right of the color palette drop-down to open the
Color Scale Properties dialog
5.  Click the Edit Palette button
 
To create a new color palette:
 
1.  Select an existing color palette to modify from the Select palette drop down box.
2.  Enter the default minimum and maximum values for this palette.
3.  To add an additional color node. In the New depth/color mapping section, fill in a new depth value, select a
color for the node and then clicking Add. The new node should appear on the color bar represented by a small
triangle.
4.  To edit an existing node, Left-click the small triangle in the color bar representing the node you want to edit.
In the Edit selected depth/color mapping section, modify the depth and color settings.
5.  To delete an existing node, Left-click the small triangle in the color bar representing the node you want to
delete. In the Edit selected depth/color mapping section, click the Delete button.
6.  Repeat steps 3 through 5 until the color palette is finished.
7.  Save the modified color palette by clicking the Save As… button and give the new palette a unique name or
overwrite an existing SonarWiz color palette.
8.  Click OK to close the Palette Editor
 
Palette Editor Controls
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Color Bar

The Color Bar shows an example of the current palette. The color bar is divided into nodes that are
indicated by small triangles on the right of the color bar. Each node has an assigned depth value and
an assigned color. You can drag nodes with the mouse to change their depth.

Palette Options

Use the Select Palette drop down to load an existing palette which you can then modify. Set the
Minimum and Maximum value of the palette and indicate whether the palette is Bipolar.
 
Normal (non-bipolar) palettes are designed to stretch smoothly from the minimum value to the
maximum value. Most data sets are best colored by a normal palette. A bipolar palette is centered on
zero (0.0) and stretches symmetrically away from zero. Bipolar palettes are designed to color data that
oscillates from positive to negative values such as full envelope sub-bottom data.
 
Although the Color Palette editor asks for default depth values when building the palette, the color
palettes are always rescaled to the actual data according to settings in the Color Scale Properties. If
you want to keep the assigned colors of the pallet without rescaling (for example, to match a nautical
chart), set the Scale mode in the Color Scale Properties to Manual and set the Min and Max Mapping
range to match the Minimum depth and Maximum depth range of the color pallet as shown below
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Save Palette

Click the Save button to overwrite the existing palette with the current settings. Click the Save As...
button to create a new palette. The default set of color palettes in SonarWiz are located on your
computer at:

 
C:\ProgramData\Chesapeake Technology\SonarWiz 7\palettes

New Node

You can add a new node to the current color palette by entering its value and color in the New Value/
Color Mapping group. Click Add to add the node to the palette.

Edit Node

To edit an existing node, Select the node in the Color Bar with the mouse and then edit the value and/
or color in the Edit Selected Value/Color Mapping group. To remove a node, select the node in the
Color Bar and then click the Delete button.
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Output Message Log
 
The Output Message Log can be opened by clicking Post-Processing Views | Output Message Log from
the View menu. The Output Message Log window displays ongoing status information generated by SonarWiz
as it runs. It is especially useful for troubleshooting such as when a sonar file is not importing correctly. Watch
for any RED error messages, particularly those which may occur during individual file import operations!
 

 
 

Note that the output log is stored on disk. See Open Log File Folder for more information.
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Docking Windows
 
SonarWiz has a large number of windows/displays that can be attached (docked) to the main user interface or
may be allowed to float freely anywhere on the desktop (outside of the user interface).
 
Each Window has a right-click context sensitive dialog that is accessed by right-clicking on the top bar of the
individual window.
 

Each function within the context sensitive dialog is discussed below.
 
To Make Floating Window:
Left-click and dragging the top bar of the window to a free area on the User Interface or Desktop or Select
Floating in the right-click context sensitive menu
 
To Make a Docked Window:
Left-click and dragging the top bar of the window to a docking point within the User Interface; or Select
Docking in the right-click context sensitive menu
 
Docking Points
Docking Points are the small icons that appear when a window's top bar is being left-clicked and dragged.
Bringing the cursor over one of these docking points causes a shaded area to appear representing exactly
where the window will be docked if/when the left-mouse button is released.
 

 
 

Single Docking Points  point to the position of the main User Interface open to receive the current window
being left-clicked and dragged.
 

Multi-Docking Points offer up to five points where the current window being left-clicked and
dragged may be placed. The four primary docking points, at the top, right, bottom and left (12, 3, 6 and 9
o'clock positions), represent the four sides of the main User Interface whereas the center docking point
represents adding the window to a stacked and tabbed area – See Stackable Windows.
 
To Auto Hide a Docked Window;
 
1. The window or display must first be docked
2.  left-click on the vertical thumb-tack located beside the close window “X” at the top-right of the window or by
right-clicking on the top bar of the window and selecting Auto Hide.
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Auto Hiding a window means that when another section of the screen is made active (by a left or right-click for
example) the window will slide closed against the side to which it is docked.
 
A window that is Auto Hidden is indicated by its name at the extreme edge of the User Interface where the
Window is docked. Clicking on the name will make the window reappear.
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A Window that has Auto Hide enabled cannot be moved. Auto Hide must be turned off prior to dragging a
window to a new location.
 
To turn off Auto Hide either:
·       Left-click on the horizontal thumb-tack and Auto Hide will be disabled and the thumb-tack will return to its
original vertical position; or
·       Left-click on “ Auto Hide ” in the right-click context sensitive menu
 
To close a window:
Left-clicking the “X” at the right side of the top bar of the window or Deselect the window in the Toolbars or
Sensor Graphs in the Data Displays Command Group.
 
Adding a Window/Display
 
Windows and Displays are normally added using the Data Displays Command Group within the View Menu .
See the View Menu for a complete discussion on all windows and displays available and their functions.
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Example: Adding and Moving a Window (Dock and Free Floating)
 
1.     A display or window that is opened will automatically be placed where it was during its previous instance,
or if it is being opened for the first time it will go to a system default position. In the figure below the Output
Message Log opened in its last location which was at the bottom of the User Interface.
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2.     The user may move a window or display by left-clicking and holding the top bar of the window. A Window
that has Auto Hide Enabled cannot be moved. Auto Hide must be turned off prior to dragging a window to a
new location. (See the “ Turn off Auto Hide ” above).
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3.     Moving the cursor over a docking point and hovering (without releasing the button) causes the
corresponding Docking Area to become highlighted in blue.
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4.     Moving the cursor over a docking point and releasing will cause the window to dock in the associated
quadrant.
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5.     If the left mouse button is released when the cursor is not over a docking point then the window becomes
free-floating, anywhere on the PC Desktop.
 

 
 
Multiple Docked Windows
 
More than one window may be active and docked in one area. For example the image below shows a total
of four docked windows within the User Interface, some of which are stackable i.e. may be stacked on top of
other windows.
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Note: Not all windows may be stacked such as the Waterfall Display . When dragging a window, the Docking
Points will indicate where the window may be placed and whether or not stacking is allowed
 
Stackable Windows
 
Windows that are stackable may also be docked on-atop-the-other thus creating a tabbed pages with each
stacked window being represented by a tab.
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SonarWiz Menus
 
The SonarWiz Menus lists every object in a SonarWiz project and consequently, most of the functionality of the
program through either the Context Menus or the seven Ribbon Menus.
 
The various functions of SonarWiz are broken up into categories based on what items in SonarWiz they
address. The Context Menus are based in the Project Explorer or the Plan View and are used to perform
functions on selected items in the program. The Ribbon Menus are based in the Command Ribbon are used to
open the various menus and settings dialogs in SonarWiz.
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Context Menus
 
The Project Explorer lists every object in a SonarWiz project and consequently, most of the functionality of the
program can be accessed through the available Context Menus. The Context Menu Commands in the Project
Explorer are divided into five groups:
 

 

Project Level Commands

The Project Level Context Menu provides commands that apply to SonarWiz projects.
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Branch Level Commands

Branch Level Context Menus provide commands that are specific to the selected data type. The
commands found at the branch level include the opening of type-speciific displays, batch processing
commands and other settings that directly affect the selected data type. Including the creation of Sub-
Groups which can be used to organize large groups of related data sets.

SubGroup Commands

SubGroup Level context menus contain commands related to the subgroup itself or the collection of
datasets added to the subgroup.

Multiple Object Commands

Multiple Selected Object Context menus open when Right-clicking on a selection of multiple objects of
the same type. The commands presented will apply to all of the selected files.

Single Object Commands

Single Object Context Menus open when Right-clicking on a single object. The commands presented
will apply only to the selected object.
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Project Context Menu
 
The Project Context Menu is opened by right-clicking on the Project Name in the Project Explorer. The
Project Level Context Menu provides commands for working with the SonarWiz projects.
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Create New Project...
 
The Create New Project... command in the Project Context Menu opens the Create a New Project window.
See Create a New Project.... for more information.
 

This command can also executed by selecting the  icon in the Quick Access Toolbar.
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Open Existing Project...
 
The Open Existing Project... command in the Project Context Menu opens Windows Explorer and can be
used to navigate to and open a SonarWiz project by selecting the projects .MML file. See Open Existing
Project for more information.
 

This command can also executed by selecting the  icon in the Quick Access Toolbar.
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Configure Project Settings...
 
The Configure Project Settings... command in the Project Context Menu opens the SonarWiz project settings
menu and is used to examine or reconfigure the current SonarWiz project settings. See Configure an Existing
Project for more information.
 

This command can also executed by selecting the  icon in the Quick Access Toolbar.



Open Project Folder

136

Open Project Folder
 
The Open Project Folder command in the Project Context Menu opens the current project folder in Windows
Explorer. See SonarWiz Project Folder for more information.
 

This command can also executed by selecting the  icon in the Tools Menu.
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Save Project Settings
 
The Save Project Settings command in the Project Context Menu saves the current settings to your
project .MML file. See Configure an Existing Project for more information.
 

This command can also executed by selecting the  icon in the Quick Access Toolbar.
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Locate Project Files...
 
The Locate Project Files... command in the Project Context Menu opens the Change Project Path/ File
References window which is used to edit and replace the file paths for files in a SonarWiz project including
CSF's, contacts, and features. See Locate Project Files Tool for more information.
 

This command can also executed by selecting the  icon in the Tools Menu.
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Maps Branch Context Menu
 
The Maps Branch Context Menu is opened by right-clicking on the Maps branch in the Project Explorer. The
Maps Branch Context Menu provides commands for working with overlays and basemaps.
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Map Manager...
 
The Map Manager... command in the Maps Branch Context Menu opens the Map Manager window which is
used to list all loaded maps and overlays such that they can be enabled or disabled for map display. See Map
Manager for more information.
 

This command can also executed by selecting the  icon in the Maps Menu.
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Add Basemap...
 
The Add Basemap... command in the Maps Branch Context Menu opens Windows Explorer and is used to
import basemaps to display underneath the sonar mosaic. See Add a Basemap for more information.
 

This command can also executed by selecting the  icon in the Maps Menu.
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Add GeoImage...
 
The Add GeoImage... command in the Maps Branch Context Menu opens Windows Explorer and is used
to import geoimages (optimized basemaps) underneath the sonar mosaic. See Add a GeoImage for more
information.
 

This command can also executed by selecting the  icon in the Maps Menu.
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Add Overlay...
 
The Add Overlay... command in the Maps Branch Context Menu opens Windows Explorer and is used to
import an image or vector over the sonar mosaic. See Add a Overlay for more information.
 

This command can also executed by selecting the  icon in the Maps Menu.
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Add Legacy Shapefile...
 
The Add Legacy Shapefile... command in the Maps Branch Context Menu opens Windows Explorer and is
used to import a ESRI Shapefile over the sonar mosaic. See Add Legacy Shapefile for more information.
 

This command can also executed by selecting the  icon in the Maps Menu.
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Bathymetry Branch Context Menu
 
The Bathymetry Branch Context Menu is opened by right-clicking on the Bathymetry Files branch in the
Project Explorer. The Bathymetry Branch Context Menu provides commands for working with groups of
bathymetry and LiDAR data sets.
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Import... (Bathymetry)
 
The Import... command in the Bathymetry Branch Context Menu opens the bathymetry import window and is
used to import bathymetry or LiDAR data into the current project. See Import (Bathymetry and Lidar) for more
information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.
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Merge...
 
The Merge... command in the Bathymetry Branch Context Menu opens the Merge window and is used to
process bathymetry sounding data. See Merge for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.
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Filter...
 
The Filter... command in the Bathymetry Branch Context Menu opens the Filter window and is used to execute
filter operations on bathymetric data. See Filter for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.
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Process Backscatter...
 
The Process Backscatter... command in the Bathymetry Branch Context Menu opens the Backscatter
Processing window and is used to process bathymetric backscatter. See Process Backscatter for more
information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.
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Export Raw Bathy Values...
 
The Export Raw Bathy Values... command in the Bathymetry Branch Context Menu opens the Export
Bathymetry Raw Sonar Values window and is used to export unprocessed bathymetric ping data for
troubleshooting.
 
See Export Bathymetry Raw Sonar Values for more information.
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Tide and Sound Velocity Manager...
 
The Tide and Sound Velocity Manager... command in the Bathymetry Branch Context Menu opens the Tide
and Sound Velocity Manager which is used to to assign tide and sound velocity settings for each
bathymetry file in the project. See Tide and Sound Velocity Manager for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.
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Performance Utility...
 
The Performance Utility... command in the Bathymetry Branch Context Menu runs a beam performance test
which compares the accuracy and precision of a test line against a known-good bathymetric grid. See Beam
Performance Utility for more information.
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Properties... (Bathymetry)
 
The Properties... command in the Bathymetry Branch Context Menu opens the Project Properties window and
display metadata regarding the bathymetry data in your project.
 
See Properties (Bathymetry and Lidar Projects) for more information.



Monitor Bathymetry in Waterfall
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Monitor Bathymetry in Waterfall
 
The Monitor Bathymetry in Waterfall command in the Bathymetry Branch Context Menu opens the
Bathymetry Digitizing Window in real-time mode and is used to display acquired bathymetry data ping-by-ping
as it comes into SonarWiz. See Monitoring Bathymetry in Waterfall for more information.



Monitor Backscatter in Waterfall
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Monitor Backscatter in Waterfall
 
The Monitor Backscatter in Waterfall command in the Bathymetry Branch Context Menu opens the
Backscatter Digitizing Window in real-time mode and is used to display acquired backscatter data ping-by-ping
as it comes into SonarWiz. See Monitoring Backscatter in Waterfall for more information.



Add/ Import Existing Bathy Datasets...
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Add/ Import Existing Bathy Datasets...
 
The Add/ Import Existing Bathy Datasets... command in the Bathymetry Branch Context Menu opens
Windows Explorer and is used to bring in already imported .CDF files into your project.



New SubGroup... (Bathymetry)
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New SubGroup... (Bathymetry)
 
The New SubGroup... command in the Bathymetry Branch Context Menu creates a new SubGroup in the
Bathymetry branch of the Project Explorer.
 
See New SubGroup for more information.



Bathymetry Context Menu
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Bathymetry Context Menu
 
The Bathymetry File Context Menu is opened by right-clicking on the a Bathymetry data set in the Project
Explorer. The Bathymetry File Context Menu provides commands for working with single bathymetry and
LiDAR data sets.
 



Zoom To (Bathymetry)
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Zoom To (Bathymetry)
 
The Zoom To command in the Bathymetry Context Menu is used to zoom and pan the main SonarWiz map
window to center the selected bathymetry data set. See Zoom To for more information. This command can
also be executed by selecting the desired file and using hotkey Z.



Navigation and Attitude Editor...
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Navigation and Attitude Editor...
 
The Navigation and Attitude Editor... command in the Bathymetry Context Menu opens the Navigation and
Attitude Editor which is used to view, edit, and filter navigation and attitude data stored in bathymetry datasets.
See Navigation and Attitude Editor for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Swath Editor...
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Swath Editor...
 
The Swath Editor... command in the Bathymetry Context Menu opens the selected bathymetry file in the
Swath Editor which is used to edit soundings in various 2D and 3D windows. See Swath Editor for more
information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Digitize New Bathymetric Features...
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Digitize New Bathymetric Features...
 
The Digitizer New Bathymetric Features... command in the Bathymetry Context Menu opens the selected
file's bathymetry data in the Digitizing Window and is used to add, edit, and delete Contacts and Features
based on the elevation data of a bathymetric data set. See Digitize New Bathymetric Features for more
information. This command can also be executed by selecting the desired file and using hotkey ENTER.



Digitize New Backscatter Features...
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Digitize New Backscatter Features...
 
The Digitizer New Backscatter Features... command in the Bathymetry Context Menu opens the selected
file's backscatter data in the Digitizing Window and is used to add, edit, and delete Contacts and Features
based on the elevation data of a backscatter data set. See Digitize New Backscatter Features for more
information. This command can also be executed by selecting the desired file and using hotkey ENTER.



Settings... (Bathymetry)
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Settings... (Bathymetry)
 
The Settings... command in the Bathymetry Context Menu opens the Bathymetry Settings window and is used
to controls how new bathymetry files (including single beam and laser scanner) will compute sample elevations
and what, if any filters will be automatically applied. See Bathymetry Settings for more information.
 

This command can also executed by selecting the icon  in the Bathymetry Menu.



Merge...
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Merge...
 
The Merge... command in the Bathymetry Context Menu opens the Merge window and is used to process
bathymetry and LiDAR sounding data. See Merge for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Filter...
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Filter...
 
The Filter... command in the Bathymetry Context Menu opens the Filter window and is used to execute filter
operations on bathymetric or LiDAR data. See Filter for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Process Backscatter...
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Process Backscatter...
 
The Process Backscatter... command in the Bathymetry Context Menu opens the Backscatter Processing
window and is used to process bathymetric backscatter. See Process Backscatter for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Export Raw Bathy Values...
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Export Raw Bathy Values...
 
The Export Raw Bathy Values... command in the Bathymetry Context Menu opens the Export Bathymetry
Raw Sonar Values window and is used to export unprocessed bathymetric ping data for troubleshooting. See
Export Bathymetry Raw Sonar Values for more information.



Tide and Sound Velocity Manager...
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Tide and Sound Velocity Manager...
 
The Tide and Sound Velocity Manager... command in the Bathymetry Context Menu opens the Tide and
Sound Velocity Manager which is used to to assign tide and sound velocity settings for each
bathymetry file in the project. See Tide and Sound Velocity Manager for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Hide (Bathymetry)
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Hide (Bathymetry)
 
The Hide command in the Bathymetry Context Menu hides or toggles off the selected bathymetry file(s). See
Hide for more information.



Isolate (Bathymetry)
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Isolate (Bathymetry)
 
The Isolate command in the Bathymetry Context Menu hides or toggles off all other bathymetry files except
the one(s) selected. See Isolate for more information.



Replace Aux Data...
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Replace Aux Data...
 
The Replace Aux Data... command in the Bathymetry Context Menu opens the Import External Navigation
Files window. See Add/Import External Navigation for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Status...
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Status...
 
The Status... command in the Bathymetry Context Menu opens the Bathymetry Processing Status Report
window for the selected bathymetry file(s) and is used to indicate the success or failure of a merge process
to convert raw sonar soundings into bathymetric elevation. See Bathymetry File Processing Status Report for
more information.



Properties... (Bathymetry)
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Properties... (Bathymetry)
 
The Properties... command in the Bathymetry Context Menu opens the Project Properties window and display
metadata regarding the selected bathymetry data. See Properties (Bathymetry and Lidar Projects) for more
information.



Delete Selected Bathymetry File...
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Delete Selected Bathymetry File...
 
The Delete Selected Bathymetry File... command in the Bathymetry Context Menu removes the selected
bathymetry data set from the project. It also deletes the associated CDF files and other artifacts stored in the
Bathy folder of the SonarWiz project. Deleting the data set from SonarWiz only affects SonarWiz, it does not
affect the original source files in any way. This command can also be executed by selecting the desired file and
using hotkey DEL.
 



Split (Bathymetry)
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Split (Bathymetry)
 
The Split submenu in the Bathymetry Context Menu provides commands used to divide an existing
bathymetry dataset into two or more independent files which can then be treated differently. See Spliting Data
Sets for more information.



View Point Cloud in 3D Viewer...
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View Point Cloud in 3D Viewer...
 
The View Point Cloud in 3D Viewer... command in the Bathymetry Context Menu exports the selected
bathymetry data set as a point cloud into the External 3D Viewer. See View Point Cloud in 3D Viewer for more
information.



Lidar Branch Context Menu
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Lidar Branch Context Menu
 
The Lidar Branch Context Menu is opened by right-clicking on the Lidar Files branch in the Project Explorer.
The Lidar Branch Context Menu provides commands for working with groups of LiDAR data sets.
 



Import... (Lidar)
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Import... (Lidar)
 
The Import... command in the Lidar Branch Context Menu opens the Lidar import window and is used to
import LiDAR data into the current project. See Import Lidar for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Merge... (Lidar)
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Merge... (Lidar)
 
The Merge... command in the Lidar Branch Context Menu opens the Merge window and is used to process
Lidar sounding data. See Merge for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Filter... (Lidar)
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Filter... (Lidar)
 
The Filter... command in the Lidar Branch Context Menu opens the Filter window and is used to execute filter
operations on Lidar data. See Filter for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Export Raw Lidar Values...
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Export Raw Lidar Values...
 
The Export Raw Lidar Values... command in the Lidar Branch Context Menu opens the Export Lidar Raw
Sonar Values window and is used to export unprocessed Lidar ping data for troubleshooting.
 
See Export Bathymetry Raw Sonar Values for more information.



Properties... (Lidar)
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Properties... (Lidar)
 
The Properties... command in the Lidar Branch Context Menu opens the Project Properties window and
display metadata regarding the Lidar data in your project.
 
See Properties (Bathymetry and Lidar Projects) for more information.



Monitor Lidar in Waterfall
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Monitor Lidar in Waterfall
 
The Monitor Lidar in Waterfall command in the Lidar Branch Context Menu opens the Lidar Digitizing
Window in real-time mode and is used to display acquired Lidar data ping-by-ping as it comes into SonarWiz.
 
See Monitoring Bathymetry in Waterfall for more information.



Add/Import Existing Lidar Dataset

185

Add/Import Existing Lidar Dataset
 
The Add/ Import Existing Lidar Datasets... command in the Lidar Branch Context Menu opens Windows
Explorer and is used to bring in already imported Lidar _laser.CDF files into your project.



New SubGroup... (Lidar)
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New SubGroup... (Lidar)
 
The New SubGroup... command in the Lidar Branch Context Menu creates a new SubGroup in the Lidar
branch of the Project Explorer.
 
See New SubGroup for more information.



Lidar Context Menu
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Lidar Context Menu
 
The Lidar Context Menu is opened by right-clicking on the a Lidar data set in the Project Explorer. The Lidar
Context Menu provides commands for working with single LiDAR data sets.
 



Zoom To (Lidar)
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Zoom To (Lidar)
 
The Zoom To command in the Lidar Context Menu is used to zoom and pan the main SonarWiz map window
to center the selected Lidar data set. See Zoom To for more information. This command can also be executed
by selecting the desired file and using hotkey Z.



Digitize New Lidar Features...
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Digitize New Lidar Features...
 
The Digitizer New Lidar Features... command in the Lidar Context Menu opens the selected file's Lidar data
in the Digitizing Window and is used to add, edit, and delete Contacts and Features based on the elevation
data of a Lidar data set. See Digitize New Bathymetric Features for more information. This command can also
be executed by selecting the desired file and using hotkey ENTER.



Settings... (Lidar)
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Settings... (Lidar)
 
The Settings... command in the Lidar Context Menu opens the Lidar Settings window and is used to controls
how new Lidar files will compute sample elevations and what, if any filters will be automatically applied. See
Bathymetry Settings for more information.
 

This command can also executed by selecting the icon  in the Bathymetry Menu.



Merge... (Lidar)
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Merge... (Lidar)
 
The Merge... command in the Lidar Context Menu opens the Merge window and is used to process Lidar
sounding data. See Merge for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Filter... (Lidar)
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Filter... (Lidar)
 
The Filter... command in the Lidar Context Menu opens the Filter window and is used to execute filter
operations on Lidar data. See Filter for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Export Raw Lidar Values...
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Export Raw Lidar Values...
 
The Export Raw Lidar Values... command in the Lidar Context Menu opens the Export Lidar Raw Sonar
Values window and is used to export unprocessed Lidar ping data for troubleshooting.
 
See Export Bathymetry Raw Sonar Values for more information.



Hide (Lidar)

194

Hide (Lidar)
 
The Hide command in the Lidar Context Menu hides or toggles off the selected Lidar file(s). See Hide for more
information.



Isolate (Lidar)
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Isolate (Lidar)
 
The Isolate command in the Lidar Context Menu hides or toggles off all other Lidar files except the one(s)
selected. See Isolate for more information.



Status... (Lidar)
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Status... (Lidar)
 
The Status... command in the Lidar Context Menu opens the Lidar Processing Status Report window for the
selected Lidar file(s) and is used to indicate the success or failure of a merge process to convert raw sonar
soundings into Lidar elevation. See Bathymetry File Processing Status Report for more information.



Properties... (Lidar)
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Properties... (Lidar)
 
The Properties... command in the Lidar Context Menu opens the Project Properties window and display
metadata regarding the selected Lidar data. See Properties (Bathymetry and Lidar Projects) for more
information.



Delete Selected Lidar File...
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Delete Selected Lidar File...
 
The Delete Selected Lidar File... command in the Lidar Context Menu removes the selected Lidar data set
from the project. It also deletes the associated CDF files and other artifacts stored in the Bathy folder of the
SonarWiz project. Deleting the data set from SonarWiz only affects SonarWiz, it does not affect the original
source files in any way. This command can also be executed by selecting the desired file and using hotkey
DEL.
 



Split (Lidar)
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Split (Lidar)
 
The Split submenu in the Lidar Context Menu provides commands used to divide an existing Lidar dataset
into two or more independent files which can then be treated differently. See Spliting Data Sets for more
information.



View Point Cloud in 3D Viewer... (Lidar)
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View Point Cloud in 3D Viewer... (Lidar)
 
The View Point Cloud in 3D Viewer... command in the Lidar Context Menu exports the selected Lidar data
set as a point cloud into the External 3D Viewer. See View Point Cloud in 3D Viewer for more information.



Grids Branch Context Menu
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Grids Branch Context Menu
 
The Grids Branch Context Menu is opened by right-clicking on the Grid branch in the Project Explorer. The
Grid Branch Context Menu provides commands for importing grids, creating grids and reloading them.
 



Add/Import Grid Files...
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Add/Import Grid Files...
 
The Add/ Import Grid Files... command in the Grids Branch Context Menu opens Windows Explorer and is
used to import grid files into your project. See Adding / Importing Grids for more information.



Create New Grid...
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Create New Grid...
 
The Create New Grid... command in the Grids Branch Context Menu opens the Gridding Setup window and
is used to create a SonarWiz grid from existing point data and add it to the SonarWiz project. See Create New
Grid for more information.



Reload All Grids...
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Reload All Grids...
 
The Reload All Grids... command in the Grids Branch Context Menu forces SonarWiz to re-read grid data
from storage. This is useful if a 3rd party process has updated the grid values outside of SonarWiz control. The
command forces SonarWiz to read the grid again from storage resetting any cached values that might be in
place for speed optimizations.



New SubGroup... (Grids)
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New SubGroup... (Grids)
 
The New SubGroup... command in the Grids Branch Context Menu creates a new SubGroup in the Grids
branch of the Project Explorer. See New SubGroup for more information.



Grids Context Menu
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Grids Context Menu
 
The Grids Context Menu is opened by right-clicking on a grid in the Project Explorer. The Grid context menu
provides commands for working with individual grids.
 



Zoom To (Grids)
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Zoom To (Grids)
 
The Zoom To command in the Grids Context Menu is used to zoom and pan the main SonarWiz map window
to center the selected grid. See Zoom To for more information. This command can also be executed by
selecting the desired file and using hotkey Z.



Grid Editor...
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Grid Editor...
 
The Grid Editor... command in the Grids Context Menu opens the Area Editor in grid editor mode for the
selected grid file and is used to edit the underlying sounding data that supports the grid. See Grid Editor for
more information. This command can also be executed by selecting the desired file and using hotkey ENTER.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Reload Grid...
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Reload Grid...
 
The Reload Grid... command in the Grids Context Menu forces SonarWiz to re-read the selected grid data
from storage. This is useful if a 3rd party process has updated the grid values outside of SonarWiz control. The
command forces SonarWiz to read the grid again from storage resetting any cached values that might be in
place for speed optimizations.



Interpolate Grid...

210

Interpolate Grid...
 
The Interpolate Grid... command in the Grids Context Menu opens the Grid Interpolation window and is used
to smoothly fill small data gaps in grids. See Interpolate Grid for more information.



Invert Grid...
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Invert Grid...
 
The Invert Grid... command in the Grids Context Menu inverts the sign of the selected grid allowing you to
easily transform a depth grid (depths positive down) to an elevation grid (elevations positive up).



Contour Grid...
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Contour Grid...
 
The Contour Grid... command in the Grids Context Menu opens the Bathymetry Contouring window and is
used to generate equally spaced contour lines from any grid. See Contour Grid for more information.



Volume Calculator...
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Volume Calculator...
 
The Volume Calculator... command in the Grids Context Menu opens the Grid Difference and Volume
Calculator window and is used to calculate the difference or volume between two known surfaces or levels.
See Volume Calculator for more information.



Shaded Relief Image...
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Shaded Relief Image...
 
The Shaded Relief Image... command in the Grids Context Menu opens the Export Bathymetry Shaded Relief
Image window and is used to add a shaded relief effect to any image that overlays a bathymetry grid. See
Shaded Relief Image for more information.



Create Convex Hull...

215

Create Convex Hull...
 
The Create Convex Hull... command in the Grids Context Menu creates a convex hull polygon around the
selected grid and saves the polygon as a shape file in the Grid directory of the project. The created vector
polygon that represents the convex hull around the enabled bathymetry data.
 
SonarWiz will create the shapefile and open the Grids directory in Windows Explorer so that you can copy
access the shape file. You can add the shape file back into SonarWiz as an overlay using the Maps menu.
 
The following illustration shows a classification grid and the convex hull (shapefile added back into SonarWiz)
colored in blue...
 



Open in 3D Viewer... (Grids)
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Open in 3D Viewer... (Grids)
 
The Open in 3D Viewer... command in the Grids Context Menu opens the selected depth grid file in the
Chesapeake 3D Viewer application.
 
After a few moments, the grid will open in the external 3D viewer application like shown below...
 



Cross-section Report...
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Cross-section Report...
 
The Cross-section Report... command in the Grids Context Menu opens the Cross Section Report Settings
window and is used to create a cross-section report on the selected bathymetric grid. See Cross-section
Report for more information.



Export Grid As...
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Export Grid As...
 
The Export Grid As... command in the Grids Context Menu opens the Export Grid Files window and is used to
export the selected grid to another format. See Export Grid Files for more information.



Properties... (Grids)
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Properties... (Grids)
 
The Properties... command in the Grids Context Menu opens the Grid Properties Report and is used to
display metadata about the selected grid file. This dialog displays the grid name and grid type (See Color
Properties for more information); a summary of the grid dimensions and the minimum and maximum node
values.
 

 
 



Remove Selected Grid
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Remove Selected Grid
 
The Remove Selected Grid command in the Grids Context Menu removes (unloads) the selected grid from
the SonarWiz project. It does not delete the grid from the project grids directory. This command can also be
executed by selecting the desired file and using hotkey DEL.



Merge Grids...
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Merge Grids...
 
The Merge Grids... command in the Grid Context Menu opens the Grid Merge Setup window and is used to
merge two adjacent grids into one. This command will only appear if you select two or more grids in the Grid
Context Menu. See Grid Merge for more information.



Sidescan Branch Context Menu
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Sidescan Branch Context Menu
 
The Sidescan Branch Context Menu is opened by right-clicking on the Sidescan branch in the Project
Explorer. The Sidescan Branch Context Menu provides commands for working with groups of sidescan data
sets.
 



File Manger... (Sidescan)
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File Manger... (Sidescan)
 
The File Manager... command in the Sidescan Branch Context Menu opens the Sonar File Manager for your
project and provides access to commands that apply to Sidescan and Sub-bottom sonar data sets. See Sonar
File Manager for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Import... (Sidescan)
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Import... (Sidescan)
 
The Import... command in the Sidescan Branch Context Menu opens the Sidescan Import window and is used
to bring in raw sidescan data sets into SonarWiz. See Sidescan Import window for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Add CSF File(s)... (Sidescan)
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Add CSF File(s)... (Sidescan)
 
The Add CSF File(s)... command in the Sidescan Branch Context Menu opens Windows Explorer and is used
to bring in .CSF files into your project. See Add CSF Files Window for more information.



New SubGroup (Sidescan)
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New SubGroup (Sidescan)
 
The New SubGroup... command in the Sidescan Branch Context Menu creates a new SubGroup in the
Sidescan branch of the Project Explorer. See New SubGroup for more information.



Rescan Limits (Sidescan)
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Rescan Limits (Sidescan)
 

The Rescan Limits command in the Sidescan Branch Context Menu recalculates the map extent of the sonar
data displayed in the Map View.



Project Summary Report... (Sidescan)
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Project Summary Report... (Sidescan)
 

The Project Summary Report... command in the Sidescan Branch Context menu exports a excel
spreadsheet with an outline of the sidescan files in your project with various settings applied including position,
gain settings, and map adjustments. See Project Summary Report for more information.
 

This command can also executed in the  icon in the Post Processing Menu.



Coverage Report...
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Coverage Report...
 
The Coverage Report... command in the Sidescan Branch Context menu opens the Sonar Coverage Report
window for enabled sidescan files and is used to create a coverage map. See Coverage Report for more
information.
 

This command can also executed in the  icon in the Post Processing Menu.



Batch Image Export... (Sidescan)
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Batch Image Export... (Sidescan)
 
The Batch Image Export... command in the Sidescan Branch Context Menu opens the Batch Image Export
window and is used to capture and export the entire waterfall image of a sonar file as a bitmap, JPEG or Tiff
image. See Batch Image Export for more information.
 

This command can also executed in the  icon in the Post Processing Menu.



Set Cable Out... (Sidescan)
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Set Cable Out... (Sidescan)
 
The Set Cable Out... command in the Sidescan Branch Context Menu opens the Set Cable Out window and is
used to set a single cable out value for the entire file. See Set Cable Out for more information.



Offset Cable Out... (Sidescan)
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Offset Cable Out... (Sidescan)
 
The Offset Cable Out... command in the Sidescan Branch Context Menu opens the Offset Cable Out window
and is used to apply a static offset to existing cable out values in a sonar file. See Offset Cable Out for more
information.



Set Sensor Depth... (Sidescan)
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Set Sensor Depth... (Sidescan)
 
The Set Sensor Depth... command in the Sidescan Branch Context Menu opens the Set Sensor Depth
window and is used to set a single depth value for the towfish over the entire file. See Set Sensor Depth for
more information.



Offset Sensor Depth... (Sidescan)
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Offset Sensor Depth... (Sidescan)
 
The Offset Sensor Depth... command in the Sidescan Branch Context Menu opens the Offset Sensor Depth
window and is used to apply a static offset to existing towfish depth values in a sonar file. See Offset Sensor
Depth for more information.



Set Antenna Height... (Sidescan)
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Set Antenna Height... (Sidescan)
 
The Set Antenna Height... command in the Sidescan Branch Context Menu opens the Set Antenna Height
window and is used to set an antenna height value for the position reference point (GPS Antenna) which will
set the vertical datum of the survey. See Set Antenna Height for more information.



Sheave Offset... (Sidescan)
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Sheave Offset... (Sidescan)
 
The Sheave Offset... command in the Sidescan Branch Context Menu opens the Sheave Offset window and
is used to batch offset the tow point (sheave) position in post-processing layback calculations. See Sheave
Offset for more information.



Batch Bottom Track... (Sidescan)
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Batch Bottom Track... (Sidescan)
 
The Batch Bottom Track... command in the Sidescan Branch Context Menu opens the Batch Bottom Track
window and is used to apply automatic bottom tracking to a set of files without opening each file individually in
the Sidescan digitizer view. See Batch Bottom Track for more information.



Monitor SSS 1/2 in waterfall... 

238

Monitor SSS 1/2 in waterfall...
 
The Monitor SSS 1/2 in waterfall... command in the Sidescan Branch Context Menu opens the real-time
waterfall digitizer and is used to see incoming CH1&2 sidescan data during real-time data collection, ping-by-
ping. See Monitoring real-time sidescan data in the waterfall digitizer for more information.



Monitor SSS 3/4 in waterfall... 
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Monitor SSS 3/4 in waterfall...
 
The Monitor SSS 1/2 in waterfall... command in the Sidescan Branch Context Menu opens the real-time
waterfall digitizer and is used to see incoming CH3&4 sidescan data during real-time data collection, ping-by-
ping. See Monitoring real-time sidescan data in the waterfall digitizer for more information.



Import Settings (Sidescan)
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Import Settings (Sidescan)
 
The Import Settings command in the Sidescan Branch Context Menu opens the Sidescan Import Settings
window and is used to adjust sidescan specific import settings including File Type Specific Options, channel
selection, and sample compression. See Importing Sidescan Data Sets for more information.



Sidescan Context Menu
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Sidescan Context Menu
 
The Sidescan File Context Menu is opened by right-clicking on one or more Sidescan file(s) in the Project
Explorer or by right-clicking a sidescan file in the main display window. When a single data set is selected,
the Sidescan File Context Menu provides commands for working with a single sidescan data set, when two or
more sidescan files are selected, the menu provides only those commands that can function on two or more
data sets at once.
 
Sidescan Context Menu when a single file is selected:
 

 
Sidescan Context Menu when two or more files are selected:
 



Sidescan Context Menu

242



Sonar File Manager
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Sonar File Manager
 
The Sonar File Manager... command in the Sidescan Context Menu opens the Sonar File Manager window
and is used to access the commands that apply to Sidescan and Sub-bottom Sonar data sets. See Sonar File
Manager for more information. This command can also be executed by selecting the desired file and using
hotkey F11.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Zoom To (Sidescan)
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Zoom To (Sidescan)
 
The Zoom To command in the Sidescan Context Menu is used to zoom and pan the main SonarWiz map
window to center the selected sidescan data set. See Zoom To for more information. This command can also
be executed by selecting the desired file and using hotkey Z.



Settings... (Sidescan) 
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Settings... (Sidescan)
The Settings... command in the Sidescan Context Menu opens the Sidescan Settings window and is used to
adjust gain and sonar project settings for the sidescan files in your project. See Sidescan Gain and Projection
Settings for more information.



Use Heading from Towfish (Sidescan)
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Use Heading from Towfish (Sidescan)
 
The Use Heading from Towfish command in the Sidescan Context Menu when checked, uses the towfish
heading to project sidescan beams instead of the course made good. See the Settings | Beam Stearing for
more information. This command will indicate in the context menu with it is applied with a checkmark.



Use Map Corrections (Sidescan)
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Use Map Corrections (Sidescan)
 
The Use Map Corrections command in the Sidescan Context Menu when checked, applies map corrections
to the navigation of this file. See Map Corrections for more information. This command will indicate in the
context menu with it is applied with a checkmark.



Bottom and Far Field Track... (Sidescan)
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Bottom and Far Field Track... (Sidescan)
 
The Bottom and Far Field Track... command in the Sidecan Context Menu opens the Sidecan Bottom and
Far Field Tracking Window and is used to digitize and modify the fish altitude above the seabed or the far
field of the range. See Bottom Tracking Sidescan Data Sets for more information. This command can also be
executed by selecting the desired file and using hotkey CTRL + B.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Digitize New Features... (Sidescan)
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Digitize New Features... (Sidescan)
 
The Digitize New Features... command in the Sidescan Context Menu opens the Sidescan Digitizing View
and is used to digitize and modify the features and contacts for the selected file. See Sidescan Analysis
Window for more information. This command can also be executed by selecting the desired file and using
hotkey CTRL + D.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Hide (Sidescan)
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Hide (Sidescan)
 
The Hide command in the Sidescan Context Menu hides or toggles off the selected sidescan file(s). See Hide
for more information.



Isolate (Sidescan)
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Isolate (Sidescan)
 
The Isolate command in the Sidescan Context Menu hides or toggles off all other sidescan files except the
one(s) selected. See Isolate for more information.



Aggregate (Sidescan)
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Aggregate (Sidescan)
 
The Aggregate command in the Sidescan Context Menu displays when two or more files are selected and
is used to join two or more data sets into a single data set. See Aggregating Sidescan Data Sets for more
information.



Fix small inter-file gaps...
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Fix small inter-file gaps...
 
The Fix small inter-file gaps command in the Sidescan Context Menu displays when two or more sidescan
files are selected and is used to remove small gaps from adjacent sidescan files. See Fix Small Inter-File Gaps
Between Adjacent Sidescan Data Sets for more information.



Export Image of Selected Section... (Sidescan)
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Export Image of Selected Section... (Sidescan)
 
The Export Image of Selected Section... command in the Sidescan Context Menu opens the Select Section
to Export as Image window and  allows the user to select a portion of a sidescan file to export as a waterfall
image. See Export Image of Selected Section for more information.



Flip (Sidescan)
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Flip (Sidescan)
 
The Flip command in the Sidescan Context Menu will flip the sidescan waterfall display top to bottom. This
command can also be activated in the Annotation/Display Option window.



Move (Sidescan)
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Move (Sidescan)
 
The Move submenu in the Sidescan Context Menu provides commands for offsetting the position of sidescan
files by a static X,Y value. See Applying Static Position Offsets to Sidescan Data and Sub-Bottom Data Sets
for more information.



Navigation... (Sidescan)
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Navigation... (Sidescan)
 
The Navigation... command in the Sidescan Context Menu opens the ZEdit window and is used for editing,
filtering and smoothing navigation, heading, magnetometer, water depth and other values contained in a CSF
file. See ZEdit Navitation Editor for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Mosaic Channels...
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Mosaic Channels...
 
The Mosaic Channels submenu in the Sidescan File Context Menu provides commands for selecting which
sidescan channels to display in the plan view mosaic. See Selecting Sidescan Channels To Display for more
information.



Trim (Sidescan)
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Trim (Sidescan)
 
The Trim submenu in the Sidescan Context Menu provides commands for temporarily hiding the ends of
sidescan sonar files from mosaics and image exports. See Trim Ends of Sidescan and Sub-Bottom Files with
Mouse for more information.



Transparency
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Transparency
 
The Transparency submenu in the Sidescan Context Menu provides commands for temporarily hiding the
nadir region of sidescan sonar files from mosaics and image exports. See Hiding the Nadir Region of Sidescan
Files for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Order (Sidescan)
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Order (Sidescan)
 
The Order submenu in the Sidescan Context Menu provides commands for specifying the drawing order
of sidescan sonar files in the plan view and sidescan mosaics. See Specifying Sidescan and Sub-Bottom
Drawing Order for more information.



Contact Hiding (Sidescan)
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Contact Hiding (Sidescan)
 
The Contact Hiding submenu in the Sidescan Context Menu provides commands for temporarily hiding
features in raw sidescan data that you do not want to display in mosaics or waterfall views such as
archeological artifacts or other sensitive structures. See Hiding Sections of Sidescan and Sub-Bottom Data
Sets for more information.



Properties... (Sidescan)
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Properties... (Sidescan)
 
The Properties... command in the Sidescan Context Menu opens a dialog reporting many properties of the
sidescan file including the file metadata, projection properties, gain settings and offsets. See Sidescan and
Sub-bottom Data Set Property Report for more information.



Adjust Displayed Range...
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Adjust Displayed Range...
 
The Adjust Displayed Range... command in the Sidescan Context Menu opens the Adjust Displayed Range
window and is used to temporarily trim the outer edges of raw sidescan data that you do not want to display in
mosaics. See Trim the Outer Edge of Sidescan and Sub-Bottom Data Sets for more information.



Split (Sidescan)
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Split (Sidescan)
 
The Split submenu in the Sidescan Context Menu provides commands used to divide an existing sidescan
dataset into two or more independent files which can then be treated differently. See Spliting Data Sets for
more information.



Rename... (Sidescan)
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Rename... (Sidescan)
 
The Rename command in the Sidescan Context Menu opens the Rename CSF File tool as is used to rename
an imported CSF file and the accompanying contacts, features, intersections, and cores. Note: The file name
will be updated in the related data items. There is no undo for this action.
 



Make Others Like This... (Sidescan)
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Make Others Like This... (Sidescan)
 
The Make Others Like This... command in the Sidescan Context Menu opens the Make Others Like This
window and is used for copying settings from a reference data set to other similar data sets in the project. See
Batch Copy Settings Between Sidescan and Sub-Bottom Data Sets for more information.



Delete Selected Sonar File (Sidescan)
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Delete Selected Sonar File (Sidescan)
 
The Delete Selected Sonar File command in the Sidescan Context Menu removes the selected sidescan
sonar data set from the project. The user will be given the option to remove the associated .CSF files as
well as the items (contacts, features, etc.) but it does not affect in any way the original source data file. This
command can also be executed by selecting the desired file and using hotkey DEL.
 



Apply Time Offset... (Sidescan)
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Apply Time Offset... (Sidescan)
 
The Apply Time Offset... command in the Sidescan Context Menu opens the CSF Time Offset window and is
used to add a time offset by from days to milliseconds to batch groups of CSF files in your project. See CSF
Time Offset for more information.



Contacts Branch Context Menu
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Contacts Branch Context Menu
 

The Contact Branch Context Menu is opened by right-clicking on the Contact branch in the Project Explorer.
The Contact Branch Context Menu provides commands for working with groups of contacts.
 

 
Note that the list of contacts displayed in the the Contact branch can be filtered using a Contact Filter. If a
contact filter is active, the label on the Contact Branch will say "Filtered" and indicate the number of contacts
that have been selected by the filter.
 
 
 
 
 
 
 
 



Open Contact Manager...
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Open Contact Manager...
 
The Open Contact Manager... command in the Contacts Branch Context Menu opens the Contact Manager
and is used to perform operations on contacts. See Contact Manager for more information. This command can
also be executed by selecting the desired file and using hotkey SHIFT + F8.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Contact Report Generator...
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Contact Report Generator...
 
The Contact Report Generator... command in the Contacts Branch Context Menu opens the Contact Report
Generator and is used to build customized contact reports. See Creating Contact Reports for more information.



Preferences... (Contacts)
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Preferences... (Contacts)
 
The Preferences... command in the Contact Branch Context Menu opens the Contacts Options window and
is used to configure sonar contact file formats, naming and related attributes. See Contact Options Menu for
more information.



Capture Contact...
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Capture Contact...
 
The Capture Contact... command in the Contacts Branch Context Menu puts SonarWiz into contact capture
mode where you can click on the Main Display to capture a new contact. See Offline Contact Capture for more
information.
 

This command can also executed by selecting the  icon in the Post Processing Menu or the  icon
in the Mapping Toolbar.



New SubGroup (Contacts)
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New SubGroup (Contacts)
 
The New SubGroup... command in the Contacts Branch Context Menu creates a new SubGroup in the
Contacts branch of the Project Explorer. See New SubGroup for more information.



Import... (Contacts)
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Import... (Contacts)
 
The Import... command in the Contacts Branch Context Menu opens Windows Explorer and is used for
importing contacts from an existing SonarWiz contact database into the current project. See Importing
Contacts From Existing SonarWiz Projects for more information.



Create from XY file...
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Create from XY file...
 
The Create from XY file... command in the Contacts Branch Context Menu opens the Batch Contact
Import window and is used to create contacts from a list of coordinates in a text file or a list of point features
previously loaded into the project (See Import Features). See Creating Contacts From a List of Positions or
Features for more information.



Export... (Contacts)
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Export... (Contacts)
 
The Export... command in the Contacts Branch Context Menu exports contact positions and metadata to a file.
See Exporting Contacts for more information.



S-57 Export...
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S-57 Export...
 
The S-57 Export... command in the Contacts Branch Context Menu opens the Export Contacts to NOAA S-57
Format window and us used for NOAA S-57 target generation from SonarWiz target files using the Obstruction
S-57 feature. See Exporting Contacts to S-57 Format for more information.



Export to GeoTiff (Contacts)
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Export to GeoTiff (Contacts)
 
The Export to GeoTiff command in the Contacts Branch Context Menu creates georeferenced target images
for each enabled contact in the project. See Exporting Contacts to GeoTiff for more information.



Export to Google Earth (Contacts)
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Export to Google Earth (Contacts)
 
The Export to Google Earth command in the Contacts Branch Context Menu creates a Google KMZ file for
each enabled contact in the project. See Exporting Contacts to Google Earth for more information.



Sort Contacts...
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Sort Contacts...
 
The Sort Contacts... command in the Contacts Branch Context Menu opens the Contact Sorting Options
window and is used to sort contacts in the project according to the specified geographic or alphanumeric
criteria. The Sort Contacts command can optionally rename the contacts using the new sorting order. See
Sorting and Renaming Contacts for more information.



Backup Contacts
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Backup Contacts
 
The Backup Contacts command in the Contacts Branch Context Menu opens the Contact Backup window
and is used to create a backup of the contact database and contact target images into the specified directory.
See Backup Contact Database for more information.



Recompute All (Contacts)
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Recompute All (Contacts)
 
The Recompute All command in the Contacts Branch Context Menu is used to update contact capture
positions, computed contact heights and computed contact scour values after changes have been made to the
source data navigation. The Recompute All command will update the position stored in the contact database to
reflect any changes made to the target position after the contact was captured. This command is also available
in the Contact Manager window.



Contacts Context Menu
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Contacts Context Menu
 
The Contacts Context Menu is opened by right-clicking on one or more Contacts in the Project Explorer, by
right-clicking a contact in the main display window. When a single contact is select, the Contacts Context Menu
provides commands for working with a single contact and greys out menu options that operate on two or more
contacts. Likewise, when two or more contacts are selected, the menu provides only those commands that can
function on two or more contacts at once.
 

 
 
 
 



Open Contact Manager...
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Open Contact Manager...
 
The Open Contact Manager... command in the Contacts Context Menu opens the Contact Manager and is
used to perform operations on contacts. See Contact Manager for more information. This command can also
be executed by selecting the desired file and using hotkey SHIFT + F8.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Contact Report Generator...
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Contact Report Generator...
 

The Contact Report Generator... command in the Contacts Context Menu opens the Contact Report
Generator and is used to build customized contact reports. See Creating Contact Reports for more information.



Zoom To (Contacts)
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Zoom To (Contacts)
 
The Zoom To command in the Contacts Context Menu is used to zoom and pan the main SonarWiz map
window to center the selected contact. See Zoom To for more information. This command can also be
executed by selecting the desired file and using hotkey Z.



Capture Contact
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Capture Contact
 
The Capture Contact command in the Contacts Context Menu puts SonarWiz into contact capture mode
where you can click on the Main Display to capture a new contact. See Offline Contact Capture for more
information.
 

This command can also executed by selecting the  icon in the Post Processing Menu or the  icon
in the Mapping Toolbar.



Edit Selected Contact...
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Edit Selected Contact...
 
The Edit Selected Contact... command in the Contacts Context Menu opens the Contact Editor and is used to
view and enhance the contact image, move the contact location, make and record contact measurements, and
classify the contact by adding text attributes and a description. See Contact Editor for more information. This
command can also be executed by selecting the desired file and using hotkey ENTER.



Rotate Contact Label
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Rotate Contact Label
 
The Rotate Contact Label command in the Contacts Context Menu when activated, toggles the rotation of
the selected contact label by 90-degrees. See Rotate Contact Label for more information. This command will
indicate in the context menu with it is applied with a checkmark.



View Selected Contact In Waterfall...
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View Selected Contact In Waterfall...
 
The View Selected Contact in Waterfall... command in the Contacts Context Menu allows you to select a
contact in the Main Display and open the same contact in the appropriate waterfall Analysis Window.



Build Line Set Around Contact
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Build Line Set Around Contact
 
The Build Line Set Around Contact command in the Contacts Context Menu opens the Build Contact
Location Line Set window is used to quickly build a survey pattern around a selected contact. See Build Line
Set Around Contact for more information.



Rationalize Selected Contacts...
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Rationalize Selected Contacts...
 
The Rationalize Selected Contacts command in the Contacts Context Menu displays when two or more
contacts are selected and is used to provide a means to combine multiple contacts into a single ‘rationalized’
new contact. See Rationalizing Contacts for more information.



Set Processing Status
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Set Processing Status
 
The Set Processing Status submenu in the Contacts Context Menu provides commands for specifying status
states: Draft or Final. The meaning of these status flags is up to the user. See Set Contact Processing Status
for more information.



Recompute Position (Contacts)
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Recompute Position (Contacts)
 
The Recompute Position command in the Contacts Context Menu is used to update contact capture
positions, computed contact heights and computed contact scour values after changes have been made to the
source data navigation. The Recompute All command will update the position stored in the contact database to
reflect any changes made to the target position after the contact was captured. This command is also available
in the Contact Manager window.



Recapture Image (Contacts)
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Recapture Image (Contacts)
 
The Recapture Image command in the Contacts Context Menu is used to recapture (update) images for all
selected contacts. For example, if you modify the color scheme for the project or adjust the gain settings for a
line, the existing contact images in the contact database will no longer match the current state of the project.
Issuing the Recapture Contact Image command on the desired contacts will replace the old images with a
fresh capture using the current color and gain settings. This command is also available in the Contact Manager
window.



Delete Selected Contacts
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Delete Selected Contacts
 
The Delete Selected Contacts command in the Contacts Context Menu is used to remove the selected
contacts from the contact database. Whether the contact is actually deleted permanently from the database
or simply hidden from view depends on the setting of the Enable contact un-delete flag found in the Contact
Options Menu. This command can also be executed by selecting the desired file and using hotkey Z.



Features Branch Context Menu
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Features Branch Context Menu
 
The Features Branch Context Menu is opened by right-clicking on the Features branch in the Project
Explorer. The Features Branch Context Menu provides commands for working with groups of features.
 



Digitized Feature Manager
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Digitized Feature Manager
 
The Digitized Feature Manager command in the Features Branch Context Menu opens the Feature Manger
window and provides access to commands that apply to Features. See Feature Manager for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Preferences... (Features)
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Preferences... (Features)
 
The Preferences... command in the Features Branch Context Menu opens the Digitized Features Preferences
and Settings window and is used to configure digitized feature attributes and settings. See Digitized Feature
Options menu for more information.



New SubGroup... (Features)
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New SubGroup... (Features)
 
The New SubGroup... command in the Features Branch Context Menu creates a new SubGroup in the
Features branch of the Project Explorer. See New SubGroup for more information.



Import... (Features)
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Import... (Features)
 
The Import... command in the Features Branch Context Menu opens the Feature Import window and is used
to import points, lines, and polygons as features provided they are stored in one of the supported import
formats. See Importing Features for more information.



Export... (Features)
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Export... (Features)
 
The Export... command in the Features Branch Context Menu opens the Feature Export window and is used
to export features in 18 different formats including text files, 2D and 3D vector files and grid surfaces. See
Exporting Features for more information.



Export SBP DXF Profile 
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Export SBP DXF Profile
The Export SBP DXF Profile command in the Features Branch Context menu is used to export a DXF vector
file of each SBP dataset in the project into the project DXF folder. See Exporting SBP DXF Profiles for more
information.



Sort... (Features)
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Sort... (Features)
 
The Sort... command in the Features Branch Context Menu opens the Sort Features window and is used to
sort the display of features in the Project Explorer based on the feature name, the feature description, or the
acoustic file name of associated features. See Sorting Features for more information.



Backup (Features)
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Backup (Features)
 
The Backup command in the Features Branch Context Menu is used to create a backup of the feature
database in the project Backup folder. See Backup the Feature Database for more information.



Recompute All (Features)
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Recompute All (Features)
 
The Recompute All command in the Features Branch Context Menu is used to update the position of vertices
in features that have a linkage established to an acoustic file, such as features digitized in the sidescan
waterfall display, sidescan contact image window or sub-bottom reflectors. See Recompute All Feature
Positions for more information.



Features Context Menu
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Features Context Menu
 
The Features Context Menu is opened by right-clicking on a Feature in the Project Explorer or the Main
window. The Features Context Menu provides commands for working with a single feature.
 



Zoom To (Features)
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Zoom To (Features)
 
The Zoom To command in the Features Context Menu is used to zoom and pan the main SonarWiz map
window to center the selected feature. See Zoom To for more information. This command can also be
executed by selecting the desired file and using hotkey Z.



Digitized Feature Manager
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Digitized Feature Manager
 
The Digitized Feature Manager command in the Features Context Menu opens the Feature Manger window
and provides access to commands that apply to Features. See Feature Manager for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Edit Selected Feature
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Edit Selected Feature
 
The Edit Selected Feature command in the Features Context Menu opens the Edit Text Feature window
and is used to adjust settings that pertain to the selected feature's type. See Editing Features for more
information. This command can also be executed by selecting the desired file and using hotkey ENTER.



View Selected Feature in Digitizer
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View Selected Feature in Digitizer
 
The View Selected Feature in Digitizer command in the the Features Context Menu will open the selected
feature in the sidescan or sub-bottom digitizing window as appropriate. Note that features digitized directly in
the Main Display are not associated with acoustic files and therefore have no associated digitizer view.



Build Survey Lines in Selected Feature...
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Build Survey Lines in Selected Feature...
 
The Build Survey Lines in Selected Feature command in the Features Context Menu is used to build a
set of survey lines inside any closed polygon feature. See Build Survey Lines in Selected Feature for more
information.



Display Selected Feature on Map
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Display Selected Feature on Map
 
The Display Selected Feature on Map command in the Features Context Menu ensures that the feature
is visible in the Main Display. The command is equivalent to toggling on the display check box to the left of
the feature in the Project Explorer. This command will indicate in the context menu with it is applied with a
checkmark.



Trim the Magnetometer Data to Feature Extents
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Trim the Magnetometer Data to Feature Extents
 
The Trim the Magnetometer Data to Feature Extents command in the Features Context Menu is used to clip
magnetometer data sets that fall outside of the selected polygon feature. See Trim the Magnetometer Data to
Feature Extents for more information.



Enable Only the Magnetometer Lines inside the Feature Extents
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Enable Only the Magnetometer
Lines inside the Feature Extents

 
The Enable Only Magnetometer Lines Inside Feature Extents command in the Features Context Menu is
used to enable magnetometer data sets that fall completely within the selected polygon feature. See Enable
Only the Magnetometer Lines inside the Feature Extents for more information.



Fix Navigation Spikes inside Feature Extents
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Fix Navigation Spikes inside Feature Extents
 
The Fix Navigation Spikes Inside Feature Extents command in the Features Context Menu automatically
detects any navigation spikes that fall outside of a polygon feature and interpolates the navigation data across
the spike. Note: this command is available for Magnetometer data sets only.



Trim the Sonar Data to Feature Extents
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Trim the Sonar Data to Feature Extents
 
The Trim the Sonar Data to Feature Extents command in the Features Context Menu opens the Trim Sonar
Files to Polygon window and has two actions: (1) it will trim sidescan data sets that fall within the boundary of
a polygon feature to the edges of the polygon; and, (2) for data sets that fall completely outside the polygon
feature it will take further action as defined by the user. See Trim the Sonar Data to Feature Extents for more
information.



Delete Selected Feature(s)
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Delete Selected Feature(s)
 
The Delete Selected Feature(s) command in the Features Context Menu hides the selected feature from the
user interface but does not purge it from the feature data base. It is possible to restore "deleted" features from
the Feature Manager. This command can also be executed by selecting the desired file and using hotkey DEL.



Sub-bottom Branch Context Menu
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Sub-bottom Branch Context Menu
 
The Sub-bottom Branch Context Menu is opened by right-clicking on the sub-bottom branch in the Project
Explorer. The Sub-bottom Branch Context Menu provides commands for working with groups of sub-bottom
profile data sets.
 



File Manager (Sub-bottom)
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File Manager (Sub-bottom)
 
The Sonar File Manager... command in the Sub-bottom Branch Context Menu opens the Sonar File Manager
window and is used to access the commands that apply to Sidescan and Sub-bottom Sonar data sets. See
Sonar File Manager for more information. This command can also be executed by selecting the desired file
and using hotkey F11.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Import (Sub-bottom)
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Import (Sub-bottom)
 
The Import... command in the Sub-Bottom Branch Context Menu opens the Sub-bottom Import window and is
used to bring in raw sub-bottom data sets into SonarWiz. See Import Sub-bottom Data for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Add CSF Files (Sub-bottom)
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Add CSF Files (Sub-bottom)
 
The Add CSF File(s)... command in the Sub-bottom Branch Context Menu opens Windows Explorer and is
used to bring in .CSF files into your project. See Add CSF Files Window for more information.



New SubGroup (Sub-bottom)
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New SubGroup (Sub-bottom)
 
The New SubGroup... command in the Sub-bottom Branch Context Menu creates a new SubGroup in the
Sub-bottom branch of the Project Explorer. See New SubGroup for more information.



Rescan Limits (Sub-bottom)
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Rescan Limits (Sub-bottom)
 
The Rescan Limits command in the Sub-bottom Branch Context Menu recalculates the map extent of the
sonar data displayed in the Map View.



Project Summary Report... (Sub-bottom)
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Project Summary Report... (Sub-bottom)
 
The Project Summary Report... command in the Sub-bottom Branch Context menu exports a excel
spreadsheet with an outline of the sub-bottom files in your project with various settings applied including
position, gain settings, and map adjustments. See Project Summary Report for more information.
 

This command can also executed in the  icon in the Post Processing Menu.



Batch Image Export (Sub-bottom)
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Batch Image Export (Sub-bottom)
 
The Batch Image Export... command in the Sub-bottom Branch Context Menu opens the Batch Image Export
window and is used to capture and export the entire waterfall image of a sonar file as a bitmap, JPEG or Tiff
image. See Batch Image Export for more information.
 

This command can also executed in the  icon in the Post Processing Menu.



Set Cable Out (Sub-bottom)
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Set Cable Out (Sub-bottom)
 

The Set Cable Out... command in the Sub-bottom Branch Context Menu opens the Set Cable Out window and
is used to set a single cable out value for the entire file. See Set Cable Out for more information.



Offset Cable Out (Sub-bottom)
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Offset Cable Out (Sub-bottom)
 
The Offset Cable Out... command in the Sub-bottom Branch Context Menu opens the Offset Cable Out
window and is used to apply a static offset to existing cable out values in a sonar file. See Offset Cable Out for
more information.



Set Sensor Depth (Sub-bottom)
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Set Sensor Depth (Sub-bottom)
 
The Set Sensor Depth... command in the Sub-bottom Branch Context Menu opens the Set Sensor Depth
window and is used to set a single depth value for the towfish over the entire file. See Set Sensor Depth for
more information.



Offset Sensor Depth (Sub-bottom)
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Offset Sensor Depth (Sub-bottom)
 
The Offset Sensor Depth... command in the Sub-bottom Branch Context Menu opens the Offset Sensor
Depth window and is used to apply a static offset to existing towfish depth values in a sonar file. See Offset
Sensor Depth for more information.



Set Antenna Height (Sub-bottom)
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Set Antenna Height (Sub-bottom)
 
The Set Antenna Height... command in the Sub-bottom Branch Context Menu opens the Set Antenna Height
window and is used to set an antenna height value for the position reference point (GPS Antenna) which will
set the vertical datum of the survey. See Set Antenna Height for more information.



Set Tides and Vertical Offsets (Sub-bottom)
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Set Tides and Vertical Offsets (Sub-bottom)
 
The Set Tides and Vertical Offsets... command in the Sub-bottom Branch Context Menu opens the SBP
Tides and Vertical Offsets window and is used to adjust the starting elevation, tide height, and bath grid
separation of the SBP files in the project. See SBP Tides and Vertical Offsets for more information.



Sheave Offset (Sub-bottom)
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Sheave Offset (Sub-bottom)
 
The Sheave Offset... command in the Sub-bottom Branch Context Menu opens the Sheave Offset window
and is used to batch offset the tow point (sheave) position in post-processing layback calculations. See
Sheave Offset for more information.



Batch Bottom Track (Sub-bottom)
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Batch Bottom Track (Sub-bottom)
 
The Batch Bottom Track... command in the Sub-bottom Branch Context Menu opens the Batch Bottom Track
window and is used to apply automatic bottom tracking to a set of files without opening each file individually in
the sub-bottom digitizer view. See Batch Bottom Track for more information.



Sub-bottom Context Menu
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Sub-bottom Context Menu
 
The Sub-bottom Context Menu is opened by right-clicking on one or more sub-bottom files in the Project
Explorer or by right-clicking a sub-bottom file in the main display window. When a single data set is select, the
Sub-bottom Context Menu provides commands for working with a single sub-bottom data set, when two or
more sub-bottom files are selected, the menu provides only those commands that can function on two or more
data sets at once.
 



Sub-bottom Context Menu

338



Sonar File Manager (Sub-bottom)
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Sonar File Manager (Sub-bottom)
 
The Sonar File Manager... command in the Sub-bottom Context Menu opens the Sonar File Manager window
and is used to access the commands that apply to Sidescan and Sub-bottom Sonar data sets. See Sonar File
Manager for more information. This command can also be executed by selecting the desired file and using
hotkey F11.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Zoom To (Sub-bottom)
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Zoom To (Sub-bottom)
 
The Zoom To command in the Sub-bottom Context Menu is used to zoom and pan the main SonarWiz map
window to center the selected sidescan data set. See Zoom To for more information. This command can also
be executed by selecting the desired file and using hotkey Z.



Settings... (Sub-bottom)
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Settings... (Sub-bottom)
 
The Settings... command in the Sub-bottom Context Menu opens the Sub-bottom Settings window and is
used to adjust gain and sonar project settings for the sub-bottom files in your project. See Sub-Bottom Gain
Settings for more information.
 
 



AGC (Sub-bottom)
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AGC (Sub-bottom)
 
The AGC command in the Sub-bottom Context Menu enables AGC gains using the default settings. See
Automatic Gain Control (AGC) for more information.
 

This command can also executed by selecting the  icons in the Post Processing Menu.



BAC (Sub-bottom)
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BAC (Sub-bottom)
 
The BAC command in the Sub-bottom Context Menu enables Beam Angle Correction (BAC) on this sonar
data set using the default settings. See Beam Angle Correction for more information.
 

This command can also executed by selecting the  icons in the Post Processing Menu.



UGC (Sub-bottom)
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UGC (Sub-bottom)
 
The UGC command in the Sub-bottom Context Menu enables User-Defined Gain on the selected sonar data
set. See User-Defined Gain Controls for more information.
 

This command can also executed by selecting the  icons in the Post Processing Menu.



Use Heading From Towfish (Sub-bottom)
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Use Heading From Towfish (Sub-bottom)
 
The Use Heading from Towfish command in the Sub-bottom Context Menu when checked, uses the towfish
heading to project sub-bottom beams instead of the course made good. See the Settings | Projection Options
for more information. This command will indicate in the context menu with it is applied with a checkmark



Bottom Track... (Sub-bottom)
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Bottom Track... (Sub-bottom)
 
The Bottom Track... command in the Sub-bottom Context Menu opens the Sub-bottom Bottom Tracking
Window and is used to digitize and modify the fish altitude above the seabed. See Bottom Tracking Sub-
bottom Data Sets for more information. This command can also be executed by selecting the desired file and
using hotkey CTRL + B.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Digitize New Features (Sub-bottom)
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Digitize New Features (Sub-bottom)
 
The Digitize New Features... command in the Sub-bottom Context Menu opens the Sub-bottom Digitizing
View and is used to digitize and modify the features and contacts for the selected file. See Sub-Bottom
Analysis Window for more information. This command can also be executed by selecting the desired file and
using hotkey CTRL + D.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Open in 3D View... (Sub-bottom)
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Open in 3D View... (Sub-bottom)
 
The Open in 3D View... command in the Sub-Bottom Context Menu opens the selected sub-bottom profile in
the 3D Viewer and is used to visualize data in 3D. See 3D Viewer for more information.



Make Reflector From Bottom Track
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Make Reflector From Bottom Track
 
The Make Reflector From Bottom Track command in the Sub-bottom Context Menu opens the Convert
Bottom Track to Seafloor Reflector window and is used to convert a sub-bottom bottom track to an exportable
seafloor reflector, with the ability to downsample. See Convert Bottom Track to Seafloor Reflector for more
information.



Hide (Sub-bottom)
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Hide (Sub-bottom)
 
The Hide command in the Sub-bottom Context Menu hides or toggles off the selected sub-bottom file(s). See
Hide for more information.



Isolate (Sub-bottom)
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Isolate (Sub-bottom)
 
The Isolate command in the Sub-bottom Context Menu hides or toggles off all other sub-bottom files except
the one(s) selected. See Isolate for more information.



Export Image of Selected Section... (Sub-bottom)
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Export Image of Selected Section... (Sub-bottom)
 
The Export Image of Selected Section... command in the Sub-bottom Context Menu opens the Select
Section to Export as Image window and is an interactive tool that allows the user to select a portion of a sub-
bottom file to export as a waterfall image. 
 
To Export an Image of a Selected Section:
 
1. Set the Sub-Bottom Drawing Mode to Draft or High Resolution. This will allow you to see the profile data in
the Main Display.
 

 
2. Select Export Image of Selected Section from the Sub-Bottom Context Menu.
 
3. In the main SonarWiz window, use the Left mouse button to drag a selection over the portion of the data set
you want to export
 



Export Image of Selected Section... (Sub-bottom)

353

 
The Select Section to Export an Image window will open to display the starting and ending ping information for
the highlighted selection.
 
4. If desired, click the Options button on the Select Section to Export an Image window to modify the waterfall
annotations.
 
5. Click Save to save the selected section as a waterfall image with annotation.
 
 
 
 
 



Flip (Sub-bottom)
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Flip (Sub-bottom)
 
The Flip command found in the Sub-bottom Context Menu is used to flip the sub-bottom waterfall display from
the top to the bottom of the navigation line when the profile is displayed in the map view window. To see any
effect from Flip, you must display the line in the Main Window using View > Drawing Mode > Sub-Bottom
Drawing Modes > Draft Mode (or High Resolution Mode).
 
Before Flip:
 

After Flip:

 
 
If you are interested in reversing the line direction of profiles see the Annotation/Display Option Window where
there is an option to flip from end-to-end.
 



Move (Sub-bottom)
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Move (Sub-bottom)
 

The Move submenu in the Sub-bottom Context menu provides commands for offsetting the position of sub-
bottom files by a static X,Y value. See Applying Static Position Offsets to Sidescan Data and Sub-Bottom Data
Sets for more information.



Navigation... (Sub-bottom)
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Navigation... (Sub-bottom)
 
The Navigation... command in the Sub-bottom Context Menu opens the ZEdit window and is used for editing,
filtering and smoothing navigation, heading, magnetometer, water depth and other values contained in a CSF
file. See ZEdit Navitation Editor for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Order (Sub-bottom)
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Order (Sub-bottom)
 
The Order submenu in the Sub-bottom Context Menu provides commands for specifying the drawing order
of sub-bottom sonar files in the plan view and sub-bottom mosaics (when in Draft Mode). See Specifying
Sidescan and Sub-Bottom Drawing Order for more information.



Contact Hiding (Sub-bottom)
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Contact Hiding (Sub-bottom)
 
The Contact Hiding submenu in the Sub-bottom Context Menu provides commands for temporarily hiding
features in sub-bottom data that you do not want to display in mosaics or waterfall views such as archeological
artifacts or other sensitive structures. See Hiding Sections of Sidescan and Sub-Bottom Data Sets for more
information.



Properties... (Sub-bottom)
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Properties... (Sub-bottom)
 
The Properties... command in the Sub-bottom Context Menu opens a dialog reporting many properties of the
sub-bottom file including the file metadata, projection properties, gain settings and offsets. See Sidescan and
Sub-Bottom Data Set Property Report for more information.



Split (Sub-bottom)
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Split (Sub-bottom)
 
The Split submenu in the Sub-bottom Context Menu provides commands used to divide an existing sub-
bottom dataset into two or more independent files which can then be treated differently. See Spliting Data Sets
for more information.



Rename... (Sub-bottom)

361

Rename... (Sub-bottom)
 
The Rename... command in the Sub-bottom Context Menu opens the Rename CSF File tool as is used to
rename an imported CSF file and the accompanying contacts, features, intersections, and cores. Note: The file
name will be updated in the related data items. There is no undo for this action.
 



Trim (Sub-bottom)
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Trim (Sub-bottom)
 
The Trim submenu in the Sub-bottom Context Menu provides commands for temporarily hiding the ends of
sub-bottom sonar files from mosaics and image exports. See Trim Ends of Sidescan and Sub-Bottom Files
with Mouse for more information.



Make Others Like This (Sub-bottom)
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Make Others Like This (Sub-bottom)
 
The Make Others Like This... command in the Sub-bottom Context Menu opens the Make Others Like This
window and is used for copying settings from a reference data set to other similar data sets in the project. See
Batch Copy Settings Between Sidescan and Sub-Bottom Data Sets for more information.



Delete Selected Sonar File (Sub-Bottom)
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Delete Selected Sonar File (Sub-Bottom)
 
The Delete Selected Sonar File command in the Sub-bottom Context Menu removes the selected sub-
bottom sonar data set from the project. The user will be given the option to remove the associated .CSF files
as well as the items (contacts, features, etc.) but it does not affect in any way the original source data file. This
command can also be executed by selecting the desired file and using hotkey DEL.
 



Apply Time Offset... (Sub-bottom)
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Apply Time Offset... (Sub-bottom)
 
The Apply Time Offset... command in the Sub-bottom Context Menu opens the CSF Time Offset window and
is used to add a time offset by from days to milliseconds to batch groups of CSF files in your project. See CSF
Time Offset for more information.



Aggregate (Sub-bottom)
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Aggregate (Sub-bottom)
 
The Aggregate command in the Sub-bottom Context Menu displays when two or more files are selected and
is used to join two or more data sets into a single data set. See Aggregating Sidescan Data Sets for more
information.



Sub-bottom Intersections and Feature Crossings Context Menu
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Sub-bottom Intersections and
Feature Crossings Context Menu

 
The Sub-bottom Intersections and Feature Crossings Context Menus are opened by first expanding the
sub-bottom branch in the Project Explorer and then right-clicking on Intersections or Feature Crossings. The
Sub-bottom Intersections and Feature Crossings Context Menus provide commands for working with groups of
intersecting sub-bottom data and features in the project.



Intersections Manager
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Intersections Manager
 
The Intersections Manger... command in the Sub-bottom Intersections Context Menu opens the Intersections
Manger window and is used to compute intersections and export reports. See Intersections Manager for more
information.
 



Delete Selected Intersections
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Delete Selected Intersections
 
The Delete Selected Intersection(s) command in the Sub-Bottom Intersections Context Menu removes the
selected intersections from the project. This command can also be executed by selecting the desired file and
using hotkey DEL.



Quick View 3D (Intersections)

370

Quick View 3D (Intersections)
 
The Quick View 3D command in the Sub-Bottom Intersections Context Menu opens the selected intersection
into the 3D Viewer. This option will take 300 pings on either side of the intersection point from each
intersecting file and export them to be immediately viewed in the default 3D viewer. See Quick View 3D for
more information.



Properties... (Intersections)
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Properties... (Intersections)
 
The Properties... command in the Sub-Bottom Intersections Context Menu opens a dialog reporting the
two sub-bottom files used when computing the intersections and the position of the intersection in latitude/
longitude and easting/ northing.



Forward Looking Sonar Branch Context Menu
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Forward Looking Sonar Branch Context Menu
 
The Forward Looking Sonar Branch Context Menu is opened by right-clicking on the Forward Looking
Sonar branch in the Project Explorer. The Forward Looking Sonar Branch Context Menu provides commands
for working with groups of FLS data sets.
 



File Manager... (Forward Looking Sonar)
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File Manager... (Forward Looking Sonar)
 
The File Manager... command in the Forward Looking Sonar Branch Context Menu opens the Sonar File
Manager for your project and provides access to commands that apply to Sonar data sets. See Sonar File
Manager for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Import... (Forward Looking Sonar)
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Import... (Forward Looking Sonar)
 
The Import... command in the Forward Looking Sonar Branch Context Menu opens the Forward Looking
Sonar Import window and is used to bring in raw FLS data sets into SonarWiz. See Import (Forward Looking
Sonar) for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Add CSF File(s)... (Forward Looking Sonar)
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Add CSF File(s)... (Forward Looking Sonar)
 
The Add CSF File(s)... command in the Forward Looking Sonar Branch Context Menu opens Windows
Explorer and is used to bring in .CSF files into your project. See Add CSF Files Window for more information.



New SubGroup... (Forward Looking Sonar)
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New SubGroup... (Forward Looking Sonar)
 
The New SubGroup... command in the Forward Looking Sonar Branch Context Menu creates a new
SubGroup in the Sidescan branch of the Project Explorer. See New SubGroup for more information.



Rescan Limits (Forward Looking Sonar)
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Rescan Limits (Forward Looking Sonar)
 
The Rescan Limits command in the Forward Looking Sonar Branch Context Menu recalculates the map
extent of the sonar data displayed in the Map View.



Project Summary Report (Forward Looking Sonar)
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Project Summary Report (Forward Looking Sonar)
 
The Project Summary Report... command in the Forward Looking Sonar Branch Context menu exports
a excel spreadsheet with an outline of the FLS files in your project with various settings applied including
position, gain settings, and map adjustments. See Project Summary Report for more information.
 

This command can also executed in the  icon in the Post Processing Menu.



Coverage Report... (Forward Looking Sonar)
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Coverage Report... (Forward Looking Sonar)
 
The Coverage Report... command in the Forward Looking Sonar Branch Context menu opens the Sonar
Coverage Report window for enabled sidescan files and is used to create a coverage map. See Coverage
Report for more information.
 

This command can also executed in the  icon in the Post Processing Menu.



Forward Looking Sonar Files Context Menu
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Forward Looking Sonar Files Context Menu
 
The Forward Looking Sonar File Context Menu is opened by right-clicking on one or more FLS file(s) in the
Project Explorer or by right-clicking a FLS file in the main display window. When a single data set is selected,
the FLS File Context Menu provides commands for working with a FLS data set, when two or more FLS files
are selected, the menu provides only those commands that can function on two or more data sets at once.
 
Forward Looking Context Menu when a single file is selected:
 



Sonar File Manager (Forward Looking Sonar)

381

Sonar File Manager (Forward Looking Sonar)
 
The Sonar File Manager... command in the Forward Looking Sonar Context Menu opens the Sonar File
Manager window and is used to access the commands that apply to Sonar data sets. See Sonar File Manager
for more information. This command can also be executed by selecting the desired file and using hotkey F11.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Zoom To (Forward Looking Sonar)
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Zoom To (Forward Looking Sonar)
 
The Zoom To command in the Forward Looking Sonar Context Menu is used to zoom and pan the main
SonarWiz map window to center the selected FLS data set. See Zoom To for more information. This command
can also be executed by selecting the desired file and using hotkey Z.



Use Heading (Forward Looking Sonar)
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Use Heading (Forward Looking Sonar)
 
The Use Heading command in the Forward Looking Context Menu when checked, uses the sensor heading to
project FLS frames instead of the course made good. See the Settings | Beam Stearing for more information.
This command will be checked in the context menu when it is applied.



Use Map Corrections (Forward Looking Sonar)
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Use Map Corrections (Forward Looking Sonar)
 
The Use Map Corrections command in the Forward Looking Sonar Context Menu when checked, applies
map corrections to the navigation of this file. See Map Corrections for more information. This command will
indicate in the context menu with it is applied with a checkmark.



Hide (Forward Looking Sonar)
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Hide (Forward Looking Sonar)
 
The Hide command in the Forward Looking Sonar Context Menu hides or toggles off the selected sidescan
file(s). See Hide for more information.



Isolate (Forward Looking Sonar)
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Isolate (Forward Looking Sonar)
 
The Isolate command in the Forward Looking Sonar Context Menu hides or toggles off all other sidescan files
except the one(s) selected. See Isolate for more information.



Move (Forward Looking Sonar)
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Move (Forward Looking Sonar)
 
The Move submenu in the Forward Looking Sonar Context Menu provides commands for offsetting the
position of sidescan files by a static X,Y value. See Applying Static Position Offsets to Sidescan Data and Sub-
Bottom Data Sets for more information.



Navigation (Forward Looking Sonar)
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Navigation (Forward Looking Sonar)
 
The Navigation... command in the Forward Looking Sonar Context Menu opens the ZEdit window and is used
for editing, filtering and smoothing navigation, heading, magnetometer, water depth and other values contained
in a CSF file. See ZEdit Navitation Editor for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Trim (Forward Looking Sonar)
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Trim (Forward Looking Sonar)
The Trim submenu in the Forward Looking Sonar Context Menu provides commands for temporarily hiding
the ends of sidescan sonar files from mosaics and image exports. See Trim Ends of Sidescan and Sub-Bottom
Files with Mouse for more information.



Order (Forward Looking Sonar)
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Order (Forward Looking Sonar)
 
The Order submenu in the Forward Looking Sonar Context Menu provides commands for specifying the
drawing order of sidescan sonar files in the plan view and sidescan mosaics. See Specifying Sidescan and
Sub-Bottom Drawing Order for more information.



Properties (Forward Looking Sonar)
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Properties (Forward Looking Sonar)
 
The Properties... command in the Forward Looking Sonar Context Menu opens a dialog reporting many
properties of the sidescan file including the file metadata, projection properties, gain settings and offsets. See
Sidescan and Sub-bottom Data Set Property Report for more information.



Apply Time Offset (Forward Looking Sonar)
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Apply Time Offset (Forward Looking Sonar)
 
The Apply Time Offset... command in the Forward Looking Sonar Context Menu opens the CSF Time Offset
window and is used to add a time offset by from days to milliseconds to batch groups of CSF files in your
project. See CSF Time Offset for more information.



Make Others Like This (Forward Looking Sonar)
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Make Others Like This (Forward Looking Sonar)
 
The Make Others Like This... command in the Forward Looking Sonar Context Menu opens the Make Others
Like This window and is used for copying settings from a reference data set to other similar data sets in the
project. See Batch Copy Settings Between Sidescan and Sub-Bottom Data Sets for more information.



Delete Selected Sonar File... (Forward Looking Sonar)
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Delete Selected Sonar File...
(Forward Looking Sonar)

 
The Delete Selected Sonar File command in the Forward Looking Sonar Context Menu removes the selected
sidescan sonar data set from the project. It does not delete the associated CSF file from the project folder, nor
does it affect in any way the original source data file. This command can also be executed by selecting the
desired file and using hotkey DEL.



Magnetometer Branch Context Menu

395

Magnetometer Branch Context Menu
 
The Magnetometer Branch Context Menu is opened by right-clicking on the magnetometer branch in the
Project Explorer. The Magnetometer Branch Context Menu provides commands for working with groups of
magnetometer profile data sets.
 



File Manager... (Magnetometer)
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File Manager... (Magnetometer)
 
The File Manger... command in the Magnetometer Branch Context Menu opens the Magnetometer File
Manager and provides access to commands that apply to Magnetometer sonar data sets. See Magnetometer
File Manager for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.
 
 



Magnetometer Anomaly List...
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Magnetometer Anomaly List...
 
The Magnetometer Anomalies List... command in the Magnetometer Branch Context Menu opens the
Anomaly Management Window and is used to apply various settings to anomalies in the project. See
Magnetometer Anomaly List for more information.
 

This command can also executed by selecting the icon in the Post Processing Menu.
 



Magnetometer Settings and Preferences...
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Magnetometer Settings and Preferences...
 
The Magnetometer Settings and Preferences... command in the Magnetometer Branch Context Menu opens
the Preferences and Settings | Magnetometer dialog and is used to configure magnetometer post-processing
options. See Magnetometer Options Menu for more information.
 

This command can also executed by selecting the icon in the Post Processing Menu.
 



Import... (Magnetometer)
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Import... (Magnetometer)
 
The Import... command in the Magnetometer Branch Context Menu opens the Magnetometer Import Window
and is used bring in magnetometer data sets into SonarWiz. See Importing Magnetometer Data for more
information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.
 



Export... (Magnetometer)
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Export... (Magnetometer)
 
The Export... command in the Magnetometer Branch Context Menu opens the Magnetometer Export Window
and is used to export raw magnetometer files from the .CMF files (internally stored imported files) in the
project. See Exporting Magnetometer Data for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Add Files... (Magnetometer)
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Add Files... (Magnetometer)
 
The Add Files... command in the Magnetometer Branch Context Menu opens the Windows Explorer and is
used bring in magnetometer data sets as .CMF files that have been previously imported into SonarWiz.

This command can also executed by selecting the icon in the Post Processing Menu.
 



Set Cable Out... (Magnetometer)
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Set Cable Out... (Magnetometer)
 
The Set Cable Out.. command in the Magnetometer Branch Context Menu is used to enter the distance from
the position refrence point to the sensor for magnetometer files imported into the project. Using this option will
show all of the available magnetometer files in the project. See Cable Out for more information.
 

This command can also executed by selecting the icon in the Post Processing Menu.
 

post_processing_menu.htm


Offset Cable Out... (Magnetometer)
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Offset Cable Out... (Magnetometer)
 
The Offset Cable Out.. command in the Magnetometer Branch Context Menu is used to enter an offset from
the previously entered distance from the position refrence point to the sensor for magnetometer files imported
into the project.
 
Positive Values = Offset Towards Stern (Aft)
Negative Values = Offset Towards Bow (Fore)
 
Using this option will show all of the available magnetometer files in the project. See Cable Out for more
information.
 

This command can also executed by selecting the icon in the Post Processing Menu.
 



New SubGroup (Magnetometer)
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New SubGroup (Magnetometer)
 
The New SubGroup... command in the Magnetometer Branch Context Menu creates a new SubGroup in the
Magnetometer branch of the Project Explorer. See New SubGroup for more information..



Anomalies Branch Context Menu
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Anomalies Branch Context Menu
 

The Magnetometer Branch Context Menu is opened by right-clicking on the magnetometer branch in the
Project Explorer. The Magnetometer Branch Context Menu provides commands for working with groups of
magnetometer profile data sets.
 



File Manager... (Magnetometer)
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File Manager... (Magnetometer)
 
The File Manger... command in the Anomalies Branch Context Menu opens the Magnetometer File Manager
and provides access to commands that apply to Magnetometer sonar data sets. See Magnetometer File
Manager for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Magnetometer Anomaly List...
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Magnetometer Anomaly List...
 
The Magnetometer Anomalies List... command in the Anomalies Branch Context Menu opens the Anomaly
Management Window and is used to apply various settings to anomalies in the project. See Magnetometer
Anomaly List for more information.
 

This command can also executed by selecting the icon in the Post Processing Menu.



Magnetometer Settings and Preferences...
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Magnetometer Settings and Preferences...
 
The Magnetometer Settings and Preferences... command in the Anomalies Branch Context Menu opens
the Preferences and Settings | Magnetometer dialog and is used to configure magnetometer post-processing
options. See Magnetometer Options Menu for more information.
 

This command can also executed by selecting the icon in the Post Processing Menu.
 



Sort Anomalies...
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Sort Anomalies...
 
The Sort Anomalies... command in the Anomalies Branch Context Menu opens the Anomaly Sorting Options
window and is used to sort anomalies in the project according to the specified geographic or alphanumeric
criteria. The Sort Anomalies command can optionally rename the anomalies using the new sorting order. See
Sorting and Renaming Anomalies for more information.
 



Anomalies Context Menu
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Anomalies Context Menu
 
The Anomalies Context Menu is opened by first expanding the Magnetometer Branch Context Menu in
the Project Explorer and then right-clicking on Anomalies. The Anomalies Branch Context Menu provides
commands for working with groups of anomalies and is the same as the commands for individual anomalies.
 



Magnetometer File Manager (Anomalies)
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Magnetometer File Manager (Anomalies)
 
The Magnetometer File Manger... command in the Anomalies Context Menu opens the Magnetometer File
Manager and provides access to commands that apply to Magnetometer sonar data sets. See Magnetometer
File Manager for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.
 
 
 



Magnetometer Anomalies List...
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Magnetometer Anomalies List...
 
The Magnetometer Anomalies List... command in the Anomalies Context Menu opens the Anomaly
Management Window and is used to apply various settings to anomalies in the project. See
Magnetometer Anomaly List for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Zoom To (Anomalies)
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Zoom To (Anomalies)
 
The Zoom To command in the Anomalies Context Menu is used to zoom and pan the main SonarWiz map
window to center the selected anomaly. See Zoom To for more information. This command can also be
executed by selecting the desired file and using hotkey Z.



Hide (Anomalies)
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Hide (Anomalies)
 
The Hide command in the Anomalies Context Menu hides or toggles off the selected anomalie(s). See Hide for
more information.



Isolate (Anomalies)
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Isolate (Anomalies)
 
The Isolate command in the Anomalies Context Menu hides or toggles off all other anomalies except the
one(s) selected. See Isolate for more information.



Edit Selected Mag Anomalies...
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Edit Selected Mag Anomalies...
 
The Edit Selected Mag Anomalies... command in the Anomalies Context Menu either opens the
Magnetometer File Editor if one anomaly is selected or opens the Edit Multiple Mag Anomalies window if
multiple anomalies are selected. The Edit Multiple Mag Anomalies window is used to batch change metadata
in a group of anomalies like type, cause, and notes.
 

 
This command can also be executed by selecting the desired file and using hotkey ENTER.



Delete Selected Anomalies
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Delete Selected Anomalies
 
The Delete Selected Anomalies command in the Anomalies Context Menu removes the selected anomalies
from the project. This command can also be executed by selecting the desired file and using hotkey DEL.



Export Selected Anomalies
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Export Selected Anomalies
 
The Export Selected Anomalies... command in the Anomalies Context Menu opens Windows Explorer and is
used to export a .CSV of the anomalies in the current project. The user has the option to choose to export the
Selected, the Debris only, or All of the anomalies.
 
The output CSV file will be located in the MAG folder of the SonarWiz project and contain the following
columns...
 
• SeqNum
• LineNum
• RecShot
• CorShot
• Gamma
• Duration
• Type
• Depth
• Description
• Northing
• Easting
• RefGamma
• MinAvoidDist
• AnomNum
• SensorDepth
• HeightOffBottom
• Altimeter
• Name
 



Report Selected Anomalies
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Report Selected Anomalies
 
The Report Selected Anomalies... command in the Anomalies Context Menu opens the Mag Anomaly Report
Generator and is used to export a report of the anomalies stored in the current project.
 

 
 



Recompute Selected Anomalies
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Recompute Selected Anomalies
 
The Recompute Selected Anomalies... command in the Anomalies Context Menu works similarly to the
recompute function for contacts is used to correct the position of the stored anomalies after a change has
been made to the files navigation. This can include map corrections, edited navigation in the ZEdit window, or
adding a layback.
 
The output message log will indicate how many anomalies had recomputed positions after the command has
run.
 



Magnetometer Context Menu
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Magnetometer Context Menu
 
The Magnetometer Context Menu is opened by right-clicking on one or more magnetometer files in the
Project Explorer or by right-clicking a magnetometer file in the main display window. When a single file is
selected, the Magnetometer Context Menu provides commands for working with a single data set and when
two or more files are selected, the menu provides only those commands that can function on two or more data
sets at once.
 



Magnetometer File Manager
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Magnetometer File Manager
 
The File Manger... command in the Magnetometer Context Menu opens the Magnetometer File Manager and
provides access to commands that apply to Magnetometer sonar data sets. See Magnetometer File Manager
for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.
 



Zoom To (Magnetometer)
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Zoom To (Magnetometer)
 
The Zoom To command in the Magnetometer Context Menu is used to zoom and pan the main SonarWiz map
window to center the selected magnetometer data set. See Zoom To for more information. This command can
also be executed by selecting the desired file and using hotkey Z.



Magnetometer Anomalies List...
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Magnetometer Anomalies List...
 
The Magnetometer Anomalies List... command in the Magnetometer Context Menu opens the Anomaly
Management Window and is used to apply various settings to anomalies in the project. See
Magnetometer Anomaly List for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Magnetometer Settings and Preferences...
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Magnetometer Settings and Preferences...
 
The Magnetometer Settings and Preferences... command in the Magnetometer Context Menu opens the
Preferences and Settings | Magnetometer dialog and is used to configure magnetometer post-processing options.
See Magnetometer Options Menu for more information.
 

This command can also executed by selecting the icon in the Post Processing Menu.



Hide (Magnetometer)
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Hide (Magnetometer)
 
The Hide command in the Magnetometer Context Menu hides or toggles off the selected magnetometer file(s).
See Hide for more information.



Isolate (Magnetometer)
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Isolate (Magnetometer)
 
The Isolate command in the Magnetometer Context Menu hides or toggles off all other magnetometer files
except the one(s) selected. See Isolate for more information.



Edit Selected Mag File...
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Edit Selected Mag File...
 
The Edit Selected Mag File... command in the Magnetometer Context Menu opens the Magnetometer File
Editor for the currently selected file and is used to pick anomalies and apply filters to magnetometer data in the
project. See Magnetometer File Editor for more information. This command can also be executed by selecting
the desired file and using hotkey ENTER.
 

This command can also executed by selecting the  icon in the Post Processing Menu.
 
 



Edit Magnetometer File Navigation

429

Edit Magnetometer File Navigation
 
The Edit Magnetometer File Navigation command in the Magnetometer Context Menu will open the selected
file in the ZEdit Editor. See ZEdit Editor for more information.
 

This command can also executed by selecting the  icon in the Post Processing Menu.
 
 



Reload Mag File(s)
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Reload Mag File(s)
 
The Reload Mag File(s)... command in the Magnetometer Context Menu will attempt to reload the
magnetometer data from the raw file(s) selected which will revert changes made including ZEdit, map
corrections, and cable out.
 

This command can also executed by selecting the  icon in the Post Processing Menu.



Export Selected Mag File(s)
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Export Selected Mag File(s)
 
The Export Selected Mag File(s)... command in the Magnetometer Context Menu opens the Magnetometer
Export Window and is used to export the selected raw magnetometer files from the .CMF files (internally stored
imported files) in the project. See Exporting Magnetometer Data for more information.
 

This command can also executed by selecting the icon in the Post Processing Menu.
 



Set File(s) Cable Out... (Magnetometer)
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Set File(s) Cable Out... (Magnetometer)
 
The Set File(s) Cable Out.. command in the Magnetometer Context Menu is used to enter the distance from
the position refrence point to the sensor for the selected magnetometer files imported into the project. See
Cable Out for more information.
 

This command can also executed by selecting the icon in the Post Processing Menu.
 



Offset File(s) Cable Out... (Magnetometer)
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Offset File(s) Cable Out... (Magnetometer)
 
The Offset File(s) Cable Out.. command in the Magnetometer Context Menu is used to enter an offset from
the previously entered distance from the position refrence point to the sensor for the selected magnetometer
files imported into the project.
 
Positive Values = Offset Towards Stern (Aft)
Negative Values = Offset Towards Bow (Fore)
 
See Cable Out for more information.

This command can also executed by selecting the icon in the Post Processing Menu.
 



Properties... (Magnetometer)
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Properties... (Magnetometer)
 
The Properties... command in the Magnetometer Context Menu will open a properties window of the currently
selected Magnetometer file inlcuding the layback values, navigation range, and smoothing values.
 



Split... (Magnetometer)
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Split... (Magnetometer)
 
 
The Split submenu in the Magnetometer Context Menu provides commands used to divide an existing
magnetometer dataset into two or more independent files which can then be treated differently. See Spliting
Data Sets for more information.



Rename... (Magnetometer)
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Rename... (Magnetometer)
 
The Rename... command in the Magnetometer Context Menu will open the Rename CMF file window and is
used to rename imported magnetometer files in your project. This function will also update related data files
including Anomalies captured on the renamed files.
 

 
 



Make Others Like This... (Magnetometer)
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Make Others Like This... (Magnetometer)
 
The Make Others Like This... command in the Magnetometer Context Menu will open the Make Others Like
This window for magnetometer files and is used to batch copy settings from the selected source file to the rest
of the files in the project.
 
These options are currently available for copying from one magnetometer file to another:
 
- Display options
- Color
- Layback Percent
- Ambient Smoothing Constant
- Observed Smoothing Constant
 



Delete Selected Mag File(s)
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Delete Selected Mag File(s)
 
The Delete Selected Mag File(s) command in the Magnetometer Context Menu removes the selected
magnetometer data set from the project. This command can also be executed by selecting the desired file and
using hotkey DEL.



Tide Files Branch Context Menu
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Tide Files Branch Context Menu
 
The Tide Files Branch Context Menu is opened by right-clicking on the Tide Files branch in the Project
Explorer. The Tide Files Branch Context Menu provides commands for bringing in tide files into the project
either by adding an existing file or importing and editing a new one.
 



Add Existing Tide File(s)...
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Add Existing Tide File(s)...
 
The Add Existing Tide File(s)... command in the Tide Files Branch Context Menu opens the Add Tide Files
dialog and is used to import tide files into the current project in .xml format. Imported tide files will appear in the
Tide Files Menu in the Project Explorer. Even though tide files have been brought into the project, bathymetry
files will not have the associated tide data applied until the tide selection is chosen in the Tide and Sound
Velocity Manager and the bathymetry data is remerged and sub-bottom files will not have associated tide data
until it is chosen in the SBP Tides and Vertical Offsets window.



Edit/Import Tide Files...
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Edit/Import Tide Files...
 
The Edit/Import Tide Files... command in the Tide Files Branch Context Menu opens the CTI Tide Editor
application and is used to import tide records and configure them into SonarWiz format. See Tide Editor for
more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Tide Files Context Menu
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Tide Files Context Menu
 
The Tide Files Context Menu is opened by right-clicking on an individual tide file in the Project Explorer. The
Tide Files Context Menu provides commands for editing tide files in the project.
 



Edit (Tide Files)
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Edit (Tide Files)
 
The Edit command in the Tide Files Context Menu opens the selected tide file in the Tide Editor. See Tide
Editor for more information. This command can also be executed by selecting the desired file and using hotkey
ENTER.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.
 
 



Properties (Tide Files)
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Properties (Tide Files)
 
The Properties command in the Tide Files Context Menu opens the SonarWiz Tide Info window and is used to
display metadata from the imported tide file including time, position, and number of readings.



Remove Selected Tide Table(s)
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Remove Selected Tide Table(s)
 
The Remove Selected Tide Table(s) command in the Tide Files Context Menu removes the selected tide
tables from the project. This command can also be executed by selecting the desired file and using hotkey
DEL.



Sound Velocity Files Branch Context Menu
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Sound Velocity Files Branch Context Menu
 
The Sound Velocity Files Branch Context Menu is opened by right-clicking on the Sound Velocity Files
branch in the Project Explorer. The Sound Velocity Files Branch Context Menu provides commands for
bringing in SVP files into the project either by adding an existing file or importing and editing a new one.
 



Add Existing Sound Velocity File(s)...
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Add Existing Sound Velocity File(s)...
 
The Add Existing Sound Velocity File(s)... command in the Sound Velocity Files Branch Context Menu
opens Windows Explorer and is used to import SVP files into the current project in .xml format. Imported SVP
files will appear in the Sound Velocity Files Menu in the Project Explorer. Even though SVP files have been
brought into the project, bathymetry files will not have the associated SVP data applied until the Use SV Profile
selection is chosen in the Tide and Sound Velocity Manager and the bathymetry data is remerged. See Tide
and Sound Velocity Manager for more information.



Edit/ Import Sound Velocity Files...
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Edit/ Import Sound Velocity Files...
 
The Edit/Import Sound Velocity Files... command in the Sound Velocity Files Branch Context Menu opens
the CTI Sound Velocity Editor application and is used to import SVP records and configure them into SonarWiz
format. See Sound Velocity Editor for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Sound Velocity Files Context Menu
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Sound Velocity Files Context Menu
 
The Sound Velocity Files Context Menu is opened by right-clicking on an individual SVP file in the Project
Explorer. The Sound Velocity Files Context Menu provides commands for editing SVP files in the project.
 



Edit (Sound Velocity)
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Edit (Sound Velocity)
 
The Edit command in the Sound Velocity Files Context Menu opens the selected SVP file in the Sound
Velocity Editor. See Sound Velocity Editor for more information. This command can also be executed by
selecting the desired file and using hotkey ENTER.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Properties (Sound Velocity)
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Properties (Sound Velocity)
 
The Properties command in the Sound Velocity Files Context Menu opens the SonarWiz Sound Velocity File
Info window and is used to display metadata from the imported SVP file including time, position, and number of
readings.



Remove Selected SVP File(s)
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Remove Selected SVP File(s)
 
The Remove Selected SVP File(s) command in the Sound Velocity Files Context Menu removes the selected
SVP files from the project. This command can also be executed by selecting the desired file and using hotkey
DEL.



External Navigation Files Context Menu
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External Navigation Files Context Menu
 
The External Navigation Files Context Menu is opened by right-clicking on either the External Navigation
Files branch or an already imported external navigation file in the Project Explorer. The External Navigation
Files Context Menu provides commands for bringing in external navigation files into the project either by
importing via the templates provided.
 
Note: Currently SonarWiz only supports external navigation files for Bathymetry, navigation brought into
Sidescan or Sub-bottom files needs to be injected via NavInjectorPro.
 



Add/ Import External Navigation Files...
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Add/ Import External Navigation Files...
 
The Add/ Import External Navigation Files... command in the External Navigation Files Context Menu is
used to import supported navigation files for bathymetry processing. Imported navigation files will appear
in the External Navigation Files branch in the Project Explorer and can be selected as "External" files in the
bathymetry Merge - Auxiliary Data Selection window.
 

This command can also be executed by selecting the  icon in the Bathymetry menu.
 



Add/ Import External Navigation Files...
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Navigation File Picker

Select one or more navigation files to import

File Name and Type

The file names of the selected navigation files will be listed in the file name box. Use the Files of type
drop down to filter the displayed files to the selected types.

File Template

SonarWiz can only import navigation files that match a preconfigured template, including support for
some binary navigation formats such as Applanix SBET and Kongsberg Navlab. For more flexibility in
file format support, please use NavInjectorPro.

Import Geodesy

Specify the input coordinate reference system (CRS) of your navigation file. You must indicate the
CRS of data stored using eastings and northings (X,Y) and also if you need to perform a datum
transformation. Otherwise, SonarWiz will assume that the input data is in the same CRS as the
project.



Navigation and Attitude Editor... (External Navigation)
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Navigation and Attitude
Editor... (External Navigation)

 
The Navigation and Attitude Editor... command in the External Navigation Files Context Menu opens
the Navigation and Attitude Editor and is used to view, edit and filter navigation and attitude data stored in
bathymetry datasets. See Navigation and Attitude Editor for more information.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Edit (External Navigation)
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Edit (External Navigation)
 
The Edit command in the External Navigation Files Context Menu opens the Edit External Nav/ Attitude File
window and is used to add a time offset in seconds to the imported external navigation files in the project. This
command can also be executed by selecting the desired file and using hotkey ENTER.
 

 



Properties (External Navigation)
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Properties (External Navigation)
 
The Properties command in the External Navigation Files Context Menu opens the External Navigation and
Attitude File Properties window and is used to display metadata in your imported navigation file including time,
number of records, and time offsets.
 

This command can also executed by selecting the  icon in the Bathymetry Menu.



Remove Selected External Nav File(s) 
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Remove Selected External Nav File(s)
 
The Remove Selected External Nav File(s) command in the External Navigation Files Context Menu
removes the selected navigation files from the project. This command can also be executed by selecting the
desired file and using hotkey DEL.



Survey Lines Branch Context Menu
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Survey Lines Branch Context Menu
 
The Survey Lines Branch Context Menu is opened by right-clicking on the Survey Lines branch in the
Project Explorer. The Survey Lines Branch Context Menu provides commands for drawing and managing
survey lines in the project.
 



Survey Line Manager
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Survey Line Manager
 
The Survey Line Manager command in the Survey Lines Branch Context Menu opens the Survey Line
Manager and is used to edit the survey plan, tools for exporting and importing survey plans, tools for
controlling how the survey lines will look in SonarWiz, and commands for communicating with the Helm
Display. See Survey Line Manager for more information. This command can also be executed by selecting the
desired file and using hotkey F12.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.
 



Build Line Set Around Contact
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Build Line Set Around Contact
 
The Build Line Set Around Contact command in the Survey Lines Branch Context Menu opens the Build
Contact Location Line Set window is used to quickly build a survey pattern around a selected contact. See
Build Line Set Around Contact for more information.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Draw Survey Route Using Mouse...
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Draw Survey Route Using Mouse...
 
The Draw Survey Route Using Mouse... command in the Survey Lines Branch Context Menu changes the
cursor to drawing survey line points and is used to create a polyline survey line in the plan view.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Lock Survey Lines
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Lock Survey Lines
 
The Lock Survey Lines command in the Survey Lines Branch Context Menu is toggle command that is used
to lock drawn survey lines in their current location. This command will indicate in the context menu with it is
applied with a checkmark.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Survey Lines Context Menu
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Survey Lines Context Menu
 
The Survey Lines Context Menu is opened by right-clicking on one or more survey lines in the Project
Explorer. The Survey Lines Context Menu provides commands for drawing and managing survey lines in the
project.
 



Survey Line Manager
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Survey Line Manager
 
The Survey Line Manager command in the Survey Lines Context Menu opens the Survey Line Manager and
is used to edit the survey plan, tools for exporting and importing survey plans, tools for controlling how the
survey lines will look in SonarWiz, and commands for communicating with the Helm Display. See Survey Line
Manager for more information. This command can also be executed by selecting the desired file and using
hotkey F12.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Cut Selected Line
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Cut Selected Line
 
The Cut Selected Line command in the Survey Lines Context Menu is used to cut the selected line from the
plan view and project explorer. This line will stay in the commands and can be returned at a new location by
right-clicking the plan view and using Paste Selected Line.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Copy Selected Line
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Copy Selected Line
 
The Copy Selected Line command in the Survey Lines Context Menu is used to copy the selected line from
the plan view and project explorer. This line will stay in the commands and can be placed at a new location by
right-clicking the plan view and using Paste Selected Line.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Paste Selected Line
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Paste Selected Line
 
The Paste Selected Line command in the Survey Lines Context Menu is used to paste the previously copied
or cut survey line into your plan view and project explorer.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Edit Selected Line...
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Edit Selected Line...
 
The Edit Selected Line... command in the Survey Lines Context Menu opens the Survey Line Editor window
and is used to adjust settings in the selected survey line including start/ end position, range, name, and color.
This command can also be executed by selecting the desired file and using hotkey ENTER.

 

This command can also executed by selecting the  icon in the Data Acquisition Menu.
 



Delete Selected Line
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Delete Selected Line
 
The Delete Selected Line command in the Survey Lines Context Menu is used to delete the currently selected
line(s) from the project.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.
 
 



Build Line Set Around Contact
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Build Line Set Around Contact
 
The Build Line Set Around Contact command in the Survey Lines Context Menu opens the Build Contact
Location Line Set window is used to quickly build a survey pattern around a selected contact. See Build Line
Set Around Contact for more information.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Draw Survey Route Using Mouse...
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Draw Survey Route Using Mouse...
 
The Draw Survey Route Using Mouse... command in the Survey Lines Context Menu is used to change the
cursor to drawing survey line points and is used to create a polyline survey line in the plan view.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Generate Lines Parallel to Selected Line...
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Generate Lines Parallel to Selected Line...
 
The Generate Lines Parallel to Selected Line... command in the Survey Lines Context Menu opens the
Cloning Survey Lines window and is used to quickly create additional survey lines based on the one selected
with configurable base names and at spaced at a user editable length. See Generate Parallel Lines for more
information.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.
 
 



Reverse Current Survey Line
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Reverse Current Survey Line
 
The Reverse Current Survey Line command in the Survey Line Context Menu is used to flip the bearing 180
degrees for the currently selected survey line.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.
 
 



Lock Survey Lines
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Lock Survey Lines
 
The Lock Survey Lines command in the Survey Lines Context Menu is a toggle command that is used to lock
drawn survey lines in their current location. This command will indicate in the context menu with it is applied
with a checkmark.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Steer the Selected Line
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Steer the Selected Line
 
The Steer the Selected Line command in the Survey Line Context Menu is used to send the selected survey
line to the helms display to be tracked by the helmsmen.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Select Next Survey Line
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Select Next Survey Line
 
The Select Next Survey Line command in the Survey Line Context Menu is used to select the next survey
line in the Project Explorer. This can be used in conjunction with Steer the Selected Line to send the next
survey line in your project to the helms display.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Select Previous Survey Line
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Select Previous Survey Line
 
The Select Previous Survey Line command in the Survey Line Context Menu is used to select the previous
survey line in the Project Explorer. This can be used in conjunction with Steer the Selected Line to send the
previous survey line in your project to the helms display.
 

This command can also executed by selecting the  icon in the Data Acquisition Menu.



Ribbon Menus
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Ribbon Menus
 
The Command Ribbon occupies the top portion of the SonarWiz user interface and contains buttons and
interactive controls that give access to most of the features of the program. The Ribbon is divided into groups
of related functionality called Ribbon Menus. Some menus may or may not be available depending on your
SonarWiz license.
 

Ribbon Menu (Active Tab)

Only one tab on the Ribbon can be active at a time. This tab is highlighted to look like it has been
brought to the front. The Tabs in SonarWiz are organized into tasks such as Data Acquisition and Post
Processing. The idea is that all of the commands you would need to perform a task are easy to access
from the same menu. To make a Tab active click on it's name with the mouse.

Command Group

Groups of related commands are collected into command groups. Each command group is
surrounded by a then border and given a small label beneath. Groups contain commands that are
closely related. Note that when the user interface is made too narrow to display the group horizontally,
the group will collapse into a single icon representing the group. You can access the commands in a
collapsed group by clicking once on the small icon to reveal a vertical list of the commands available in
that group.



Ribbon Menus
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Button Control

Commands in the ribbon are often simply buttons that can be left clicked.  If a button has a small
downward pointing arrow  this indicates that clicking the button will offer a menu of choices to
choose from.



Data Acquisition Menu
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Data Acquisition Menu
 
The Data Acquisition Menu is opened by selecting the Data Acquisition tab in the Ribbon Menus. The Data
Acquisition Menu contains controls useful for planning and executing real-time surveys. This menu is available
only if you have a real-time license.
 



Configure Sensors Group
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Configure Sensors Group
 
The Configure Sensors command group in the Data Acquisition Menu provides access to the dialogs that
connect SonarWiz to your navigation and mapping sensor feeds.
 

 
Command Description

Data
Acquisition

Views

Opens the Data Acquisition Views drop down menu.

Vessel Opens the Select Vessel... window or opens the Vessel Editor
Sonar Select and Configure Sidescan or Sub-Bottom Sonar

Devices (Opens the Select Sonar Interface window)
Navigation Configure Navigation Sensors connected through serial or

Ethernet ports (Opens the Navigation Input Setup window)
Single Beam Configure single beam echo sounder device.

(Opens the Select Sonar Interface window)
Magnetometer Configure and select real-time magnetometer sensor

device. (Opens the Magnetometer Setup window)
Motion Sensor Configure and select real-time heave compensation

device. (Opens the Motion Sensor Setup window)
Cable Payout Configure and Select Cable Payout Sensor and Layback

Settings (Opens the Sonar Layback Configuration window)
Outputs Configure serial or Ethernet output of selected system

parameters. (Opens the Output Device Setup window)



Survey Lines Group
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Survey Lines Group
 
The Survey Lines command group in the Data Acquisition Menu gives access to the tools needed to layout
and plan a survey. For more information about laying out a survey see Line Manager – Planning Your Survey
Lines.

 

 
Command Description
Add Line Add survey line by drawing it with your mouse.

(See Line Manager – Planning Your Survey Lines)
Line

Manager...
Display the Manage Survey Lines window which supports

batch operations on your project's Survey Line set.
Line Tools Additional survey line-related tools and

functions (See Line Tools for more information)



Data Recording Group
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Data Recording Group
 
The Data Recording command group in the Data Acquisition Menu provides buttons to start and stop data
recording as well as to manage how the real time mosaic will be displayed.
 

 
Command Description
Record... Use the Record button to start recording data by using the

standard windows file dialog.  This function is disabled when an
external Navigation system is controlling data recording. Use

the arrow drop down menu to select which data type to record.
Record

Turn
Close current file if any and then start a new file during

a turn. This function is disabled when an external
Navigation system is controlling data recording.

Stop
Recording

Stop data recording and close the active file. This function is disabled
when an external Navigation system is controlling data recording.

Auto
Record

See Auto Record for more information.

Real-time
Mosaic

Open the Configure Real-time Mosaic Options window.



Control Group
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Control Group
 
The Control command group in the Data Acquisition Menu contains various dialogs that control how the real-
time behavior of the system as well as event and logbook entry buttons.
 

 
Command Description
Sidescan... Configure Real-Time Sidescan Sonar Gains window. 

These gains do NOT affect the XTF file being recorded.
Sub-bottom... Configure Real-Time Sub-bottom Sonar Gains window.

These gains do NOT affect the SEG-Y file being recorded.
Bottom Tracker... Display the Real-time Altitude Tracker

window and tune the tracking settings.
Event Setup... Open the Eventing Setup window

Event Now! Generate an Event Mark Now
Add Logbook

Entry...
Open the Make a Logbook Entry window

Reset RT
Coloring

When selected, will reset the amplitudes currently stored in the
color window streaming from the real time waterfall displays.



Post Processing Menu
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Post Processing Menu
 
The Post Processing Menu is opened by selecting the Post Processing tab in the Ribbon Menus. The Post
Processing Menu contains commands for processing and interpreting data after it has been collected.
 



Sonar File Tasks Group
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Sonar File Tasks Group
 
The Sonar File Tasks command group in the Post Processing Menu provides controls for importing, exporting
and managing sonar files.
 

 
Command Description

Vessel Opens the Select Vessel... window or the Vessel Editor

Settings Opens the Import and Processing Settings Menus
 
SSS Import Settings
SSS Auto Processing Settings
Bathy Import Settings
Bathy Auto Merge Settings

Import Imports data into SonarWiz (see Importing Files)
Playback Playback sonar files (see File Playback)
File Manager Open the File Manager (see Sonar File Manager)
Export Exports various reports (see Exporting Data)



Sonar File Processing Group
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Sonar File Processing Group
 
The Sonar File Processing command group in the Post Processing Menu provides tools for processing sonar
files.
 

 
Command Description

Bottom Track Open the bottom tracking
window on the selected file. The
dialog that opens depends on
the type of sonar file selected.

 
For more information:

Sidescan Bottom Tracking
SBP Bottom Tracker

Digitizing
View...

Open the digitizing window on the
selected file. The dialog that opens

depends on the type of file selected.
 

For more information:
Sidescan: Waterfall
Digitizing Window

Sub-Bottom: Sub-bottom
Offline Contact Capture

Nadir
Transparency

Toggle nadir transparency on the
selected file. See Transparency

Order The Order tool is used to change
the drawing order of sidescan
files in the project. See Order

Navigation Open ZEdit Editor
on the selected file.



Contacts Group
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Contacts Group
 
The Contacts command group in the Post Processing Menu provides access to Contact picking tools in
SonarWiz.
 

 
Command Description

Contact
Manager

Open the Contact Manager

Capture Contact Opens a Waterfall Digitizing
window beneath the cursor so

that you can pick a Contact
Contact Tools Provides access to Contact Tools



Digitized Features Group
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Digitized Features Group
 
The Digitized Features command group in the Post Processing Menu provides access to Feature picking
tools.
 

 
Command Description

Feature
Manager

Opens the Feature Manager

Add Feature Add a Feature. See
Digitizing in the Map Window

Feature Tools Provides access to
Feature Tools below

Edit Selected
Feature

Opens the Editing Feature dialog
for the specific feature format

View Selected
Feature in
Digitizer...

Opens selected Feature
in Digitizing View

Build Survey
Lines in
Selected
Feature...

See Building Survey Lines

Display
Selected
Feature
on Map

Enables selected Feature and
zooms to location in Map View

Trim the
Magnetometer

Data to
Feature
Extents

See Trim Magnetometer Data

Enable Only
Magnetometer

Data in
Feature
Extents

Turns off all Magnetometer Files
that no located in the polygon

feature currently selected

Fix Navigation
Spikes inside

Feature
Extents

See Fix Navigation Spikes

Trim Sonar
Data to

See Trim Data to Feature



Digitized Features Group
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Feature
Extents



Sub-bottom Group
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Sub-bottom Group
 
The Sub-bottom command group in the Post Processing Menu provides access to sub-bottom tools.
 

 
Command Description

Intersections Access tools for working
with Intersections

Cores Access tools for
working with Cores

SBP Tides and
Vertical Offsets

Opens the SBP Tides and
Vertical Offsets window.



Magnetometer Group
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Magnetometer Group
 
The Magnetometer command group in the Post Processing Menu provides access to Magnetometer tools.
 



Characterization Group
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Characterization Group
 
The Characterization command group in the Post Processing Menu provides access to the Seabed
Characterization tools. See Overview of the Seabed Classification Function for more information.
 

 
Command Description

Classification Opens the Seabed
Characterization
Manager window

Build Classification Grids Opens the Create
a Topographic

Properties Grid window



Bathymetry Menu
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Bathymetry Menu
 
The Bathymetry Menu is opened by selecting the Bathymetry tab in the Ribbon Menus. The Bathymetry
Menu provides access to tools for processing bathymetry and topographic data sets. This menu is only
available if you have a SonarWiz Bathymetry License.
 



Settings/Merge Group
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Settings/Merge Group
 
The Settings/Merge command group in the Bathymetry Menu provides access to tools for computing
bathymetry and topography from bathymetric data files. There are also command for automatic filtering and
backscatter processing.
 

 
Command Description

Bathymetry Views Opens the Bathymetry Views drop down menu.
Settings Opens the bathymetry Bathymetry Settings window

Tide + SV Manager Opens the Tide and Sound
Velocity Manager window

Merge Opens the Merge -- File Selection window
Filter Opens the Filter -- File Selection window

Process Backscatter... Opens the Backscatter Processing
-- File Selection window



Editors Group
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Editors Group
 
The Editors command group in the Bathymetry Menu provides access to various data editor tools useful while
processing bathymetry and elevation data.
 

 
Command Description
Patch Test Provides access to the Patch Test Tools (See Patch Test)

Swath Editor Opens the Swath Editor
Area Editor Opens the Area Editor

Plan View Editor Provides access to the Plan View
Editor (See Plan View Editor)

Navigation and
Attitude Editor

Opens the Navigation and Attitude Editor

Tide Editor Opens the Tide Editor
Sound Velocity Editor Opens the Sound Velocity Editor



Viewers Group
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Viewers Group
 
The Viewers command group in the Bathymetry Menu opens the Cross Section tool and the 3D Viewer. See
Cross Section tool and the External 3D Viewer for more information.
 



External Sensors Group
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External Sensors Group
 
The External Sensors command group in the Bathymetry Menu provides access for working with external
navigation and attitude files. See Import External Navigation for more information.
 



Maps Menu
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Maps Menu
 
The Maps Menu is opened by selecting the Maps tab in the Ribbon Menus. The Maps Menu is used for
displaying raster and vector maps and overlays.
 



Add Basemap
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Add Basemap
 
The Add Basemap command in the Maps Menu under the Basemaps command group opens Windows
Explorer and is used to import basemaps to display underneath the sonar mosaic. See Add a Basemap for
more information.
 

 



Add GeoImage
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Add GeoImage
 
The Add GeoImage command in the Maps Menu under the Basemaps command group opens Windows
Explorer and is used to import geoimages (optimized basemaps) underneath the sonar mosaic. See Add a
GeoImage for more information.
 

 
In the Basemaps command group there is a checkbox in order to toggle drawing GeoImages first before
basemaps when both are enabled.



Add Overlay

504

Add Overlay
 
The Add Overlay command in the Maps Menu under the Overlays command group opens Windows Explorer
and is used to import an image or vector over the sonar mosaic. See Add a Overlay for more information.
 



Add Legacy Shapefile
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Add Legacy Shapefile
 
The Add Legacy Shapefile command in the Maps Menu under the Overlays command group opens Windows
Explorer and is used to import a ESRI Shapefile over the sonar mosaic. See Add Legacy Shapefile for more
information.
 

 



Vector Map Controls Group
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Vector Map Controls Group
 
The Vector Map Controls command group in the Maps Menu determine the feature types that are displayed
when a vector file (e.g. a Shapefile) is loaded. Check or clear the boxes as required. These check boxes only
affect files loaded by clicking the Add Overlays button. They have no effect on Shapefiles added with the Add
Legacy Shapefile button. The Styles drop down allows you to modify the drawing style of S57 format vector
files. See Vector Styles and Vector Drawing Options for more information.
 



Map Manager
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Map Manager
 
The Map Manager command in the Maps Menu under the Map List command group opens the Map Manager
window which is used to list all loaded maps and overlays such that they can be enabled or disabled for map
display. See Map Manager for more information.
 



Map Corrections
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Map Corrections
 
The Map Corrections command in the Maps Menu under the Corrections command group opens the Map
Corrections window which is used to correct sidescan sonar data using a basemap. See Map Corrections for
more information.
 



View Menu
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View Menu
 
The View Menu is opened by selecting the View tab in the Ribbon Menus. The View Menu is used to control
the look of SonarWiz which includes the User Interface itself as well as various internal windows.
 

 
 



Data Acquisition Views

510

Data Acquisition Views
 
The Data Acquisition Views submenu in the View Menu under the Data Displays command group provides
functions to turn on/off various displays and windows in SonarWiz related to data acquisition.
 

View Description

Opens the primary Waterfall Display

Opens the secondary Waterfall Display

Opens the Depth Plotter.

Opens the Towfish Altitude display.

Opens the System Information display.

Opens the Survey
Line Controls Tool Bar.

Opens the Sensor Status display.

Opens the Scope Display.

Opens the Real-time
Altitude Tracker window.

Opens the Left Right
Steering Indicator display.

Opens the Event Setup window.

Opens the Disk Monitor display.

Opens Sensor Graphs display



Post-processing Views
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Post-processing Views
 
The Post-processing Views submenu in the View Menu under the Data Displays command group provides
functions to turn on/off various displays and windows in SonarWiz related to post processing sonar files.
 
 

View Description

Opens the Project Explorer

Opens the Properties Window

Opens the Color window

Opens the Target Strip

Opens the Output Message Log

Opens the Map Toolbar.

 



Bathymetry Views
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Bathymetry Views
 
The Bathymetry Views submenu in the View Menu under the Data Displays command group provides
functions to turn on/off various displays and windows in SonarWiz related to post processing sonar files.
 

View Description
Bathymetry Settings Opens the Bathymetry Settings window
Cross Track Profile Opens the Cross Track window

Real-time Bathy
Swath View...

Opens Swath Editor in real-time mode.

3D Viewer... Opens the 3D Map Display for real-time plotting
Real time

Helm display
Opens Helm Display for real-time survey management.

Post-Processing
Toolbar

Opens the Bathy Post-Processing toolbar

Show Bathy
Area Selections

When enabled, SonarWiz will plot previous selection polygons in
the map window. These polygons can be selected. The context

(right-click) menu for selection polygons will allow the user
to re-open tools such as editors, the gridder and the cross-

section tool in exactly the same area as was used previously.
Shaded Relief

Settings...
Opens the Shaded Relief Image Settings window.
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Layout Manager...
 
The Layout Manager... command in the View Menu under the Data Displays command group opens the
Layout Manager and allows users to save their preferred window layouts and recall them whenever they want.
 

 
The tool allows you to save your current layout, load previously saved layouts into the current project, delete
saved layouts, and select preferred layouts for startup.
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SSS Overlap Mode
 
The SSS Overlap Mode submenu in the View Menu under the 2D Map Display command group provides
functions to control the way the areas of overlapping sidescan sonar data are displayed in the Map Window.
 

Mode Description
Shine Through The brightest pixel in the stack is displayed

Average The average value of the stack of pixels is displayed
Cover Up Sidescan files are drawn in the order listed in the Project

Explorer. The last-drawn (top-most) sonar file is displayed.
Root Mean Square The RMS of the stack of pixels is displayed

Combine Lines When enabled, will blend (if Cover Up mode
is not being used) all sidescan data channels

together and not just by individual frequencies.
Recommended when using Gap Filler data.
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Drawing Mode
 
The Drawing Mode submenu in the View Menu under the 2D Map Display command group provides functions
for determining how each data type is drawn to the Map View. Note that for sidescan and sub-bottom the Draft
Mode option is only a performance enhancement for the display purposes, it does not affect image exports. All
images are always generated from the highest resolution data available.
 

Sidescan Drawing Modes:
Mode Description

Draft Mode Provides a compromise between rapid
refresh rate and mosaic resolution

High Resolution
Mode

Provides the best screen resolution
at the expense of drawing speed.

Coverage Mode Displays a solid color of the coverage of each
sonar file without drawing the actual data.
See Coverage Mode for more information.

Navigation Mode Displays lines representing the vessel
positions during the recording process.

Navigation
Plot Color

The navigation plot color opens a color picker
where you can choose a color for the line

Navigation
Plot Thickness

The navigation plot size slider allows you to
increase or decrease the width of the plot line.

 
Sub-Bottom Drawing Modes:

Mode Description

Draft Mode Provides a compromise between rapid
refresh rate and mosaic resolution

High Resolution
Mode

Provides the best screen resolution
at the expense of drawing speed.

Navigation Mode Displays lines representing the vessel
positions during the recording process.

Navigation
Plot Color

The navigation plot color opens a color picker
where you can choose a color for the line

Navigation
Plot Thickness

The navigation plot size slider allows you to
increase or decrease the width of the plot line.
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FLS Drawing Modes:

Mode Description

High Resolution
Mode

Provides the best screen resolution
at the expense of drawing speed.

Navigation Mode Displays lines representing the vessel
positions during the recording process.

Navigation
Plot Color

The navigation plot color opens a color picker
where you can choose a color for the line

Navigation
Plot Thickness

The navigation plot size slider allows you to
increase or decrease the width of the plot line.

 
Magnetometer Drawing Modes:

Mode Description

Raw Trace Draws the raw magnetometer value in the plan view.

Residual Trace Draws the computed residual
magnetometer value in the plan view.

Navigation Mode Displays lines representing the vessel
positions during the recording process.

Navigation
Plot Color

The navigation plot color opens a color picker
where you can choose a color for the line

Navigation
Plot Thickness

The navigation plot size slider allows you to
increase or decrease the width of the plot line.

 
Bathymetry Drawing Modes:

Mode Description

Draw Raw
Bathymetry

Draw bathymetry points colored by depth

Draw Backscatter Draw bathymetry points colored by backscatter
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Navigation Mode Displays lines representing the vessel
positions during the recording process.

Navigation
Plot Color

The navigation plot color opens a color picker
where you can choose a color for the line

Plot Thickness The Plot Thickness slider controls the size of
bathymetry points plotted in Raw Bathymetry or
Backscatter Mode and it controls the thickness
of the navigation line when in Navigation Mode.

Show Only
Accepted

Bathymetry Points

When checked, SonarWiz will only
plot unflagged data in the Map View.

Show Accepted
and Rejected

Bathymetry Points

When checked, SonarWiz will plot all data in the Map View.

Show Only
Rejected

Bathymetry Points

When checked, SonarWiz will only
plot flagged data in the Map View.

 
Lidar Drawing Modes:

Mode Description

Raw Lidar Draw Lidar points colored by depth

Navigation Mode Displays lines representing the vessel
positions during the recording process.

Navigation
Plot Color

The navigation plot color opens a color picker
where you can choose a color for the line

Navigation
Plot Thickness

The navigation plot size slider allows you to
increase or decrease the width of the plot line.
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Coverage Mode
 
The Coverage Mode option in the View Menu under the Drawing Mode drop down menu is used to display
a solid color of the coverage of each sonar file without drawing the actual data. When the option is enabled,
the coverage percentage areas will be represented by the color values set in the Sonar Coverage Plot Color
menu...
 

 
In the Sonar Coverage Plot Color window, use the 100%, 200%, or 300% coverage drop down menus to set
the colors.
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2D Map Display Group
 
The 2D Map Display command group in the View Menu allow users to toggle various main view map settings
in your project.
 

 
The Lat/ Lon Grid adds a geographic (latitude and longitude) graticule to the Map Window.
 
The X/Y Grid adds a projection (easting and northing) graticule to the Map Window.
 
The Map Scale adds a scale bar to the Map Window.
 
The Color Legend adds a color legend to the map display window. Color legends, like other map decorations
will be exported to saved images of the dataset if they are enabled. Right click on the enabled color legend in
the main view to adjust its location, data type, and range annotations.
 
The Opacity Slider controls the transparency of the raw bathymetry and sidescan data allowing the underlying
grids and basemaps to show through. The slider ranges from fully transparent (invisible) to completely opaque.
When a sonar file is fully transparent, it can still be selected by the mouse and it is still enabled for processing
commands it just isn’t visible in the map window.
 
The Orientation controls allow the user to reorient the main display to a specified degree. By default, the main
display is North Up and the Orientation drop down menu has options to make degree changes based on an
active navigation stream, a survey line, or a user specificed ship. The Compass Rose will show a compass
on the main display to indicate if a orientation change has been made. This option is only used as a map
decoration and all exports and geoimages made will be reoriented to North Up.
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Background Color
 
The Background Color drop down in the View Menu under the 2D Map Display command group allows users
to select the background color of the main view in your project.
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3D Map Display Group
 
The 3D Map Display command group in the View Menu allow users to toggle various 3D settings in your
project. The SonarWiz 3D view can display grids, geo-images, sub-bottom profiles, point clouds and sidescan
files in 3-dimensions. In addition, the 3D view can be enabled during real-time bathymetry and sidescan data
collection to see a 3-dimensional rendering of the sonar data as it is being acquired.
 
NOTE: The 3D Viewer requires more computer resources than the traditional 2D Main View to display and
render 3D objects.
 

 
The Enable 3D View checkbox toggles the internal 3D Viewer. See 3D Visualization for more information.
 
The Set North Up button resets the scene to a north-up, top-down plan view.
 
The Clear Scene button removes all objects from the 3D Scene.
 
The Export 3D PDF allows the user to create a 3D PDF of the data in your project. See 3D Viewer Reports for
more information.
 
The 3D Scene submenu controls menu contains various settings for adjusting the display in the 3D viewer.
See 3D View Tools for more information.
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Shaded Relief Group
 
The Shaded Relief command group in the View Menu allows for interactive control of the shaded relief used
for grids, bathymetry waterfall displays, and bathymetry contacts. See Shaded Relief Image Settings window
for more information.
 

 
The On checkbox toggles to enable the shaded relief effect on grids, bathymetry waterfall displays and
bathymetry contacts.
 
From the Type drop down menu, you can choose between two options. Horn and Zevenbergen and Thorne
are alternative algorithms for computing the slope and aspect of a surface. Horn works better for rough
surfaces while Zevenbergen and Thorne tends to work better for smooth surfaces.
 
Apply a slope correction to the shaded relief effect will emphasize changes in slope and makes the relief
effect less sensitive to light azimuth and elevation. It is usually helpful to increase the vertical exaggeration
when this correction is applied.

 
The three sliders are used to change vertical exaggeration, light azimuth, and light elevation.
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Tools Menu
 
The Tools Menu is opened by selecting the Tools tab in the Ribbon Menus. The Tools Menu provides
commands for opening various applications within SonarWiz and accessing all of the file type specific utilities.
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Geodesy Utility...
 
The Geodesy Utility... command in the Tools Menu under the Coordinates and Datums command group
opens the CTI Geodesy Tool and is used to add, edit, import, and export coordinate systems into SonarWiz.
 

 
This tool has a comprehensive user guide that can be accessed in either the Docs folder installed with
SonarWiz labeled CTIGeodesyTool.PDF or by selecting the icon in the top-left of the tool and selecting User
Guide...
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NavInjectorPro...
 
The NavInjectorPro... command in the Tools Menu under the Coordinates and Datums command group
opens the NavInjectorPro tool and is used to inject navigation from an external ASCII data file into a standard
sonar data files types such as CSF, JSF, SDF, SEG-Y,  or XTF. The utility will only create a file when both sonar
data and navigation data are available for the time of the ping. If gaps occur in the navigation data, the same
gaps will occur in the sonar data.
 

 
This tool has a comprehensive user guide that can be accessed in either the Docs folder installed with
SonarWiz labeled NavInjectorPro.PDF or by selecting Help... in the bottom right of the tool.



XTF (File Utilities)

526

XTF (File Utilities)
 
The XTF submenu in the Tools Menu under the File Utilities command group provides commands for
extracting and changing data inside XTF files.
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XTF to SEG-Y Converter...
 

The XTF to SEG-Y Converter... command in the Tools Menu located in the  File Utilities opens the XTF
to SEG-Y Converter and is used to extract the first sub-bottom data channel from either an 8 or 16-bit XTF
data file and create a SEG-Y file.
 

 
The program allows for the selection of an input folder containing XTF files and an separate output folder
where SEG-Y files will be written. All XTF files found in the XTF folder that contains at least one channel
marked as a sub-bottom data channel will be processed. Note that only the first sub-bottom channel found in
the file will be processed.
 
To select input and output folders, simply browse for the folders by pressing the Browse... button.
 
When the Start button is pressed, the utility will begin processing the XTF files found in the XTF input folder
and will write each SEG-Y file until it completes or an error occurs. If an error occurs, processing will continue
with the next data file. Two progress bars indicate the overall progress as well as the individual file progress.
 
The navigation and time stamp data are carried over from the XTF file to the SEG-Y file as follows...
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•  If the XTF file contains geodetic coordinates then by default, the output SEG-Y file will also contain geodetic
coordinates properly scaled and converted to arc seconds according to the SEGY specification.
Note, the geodetic coordinates may be converted to project X/Y coordinates by checking the Convert to...
checkbox.
 
•  If the XTF file contains X/Y coordinates, the utility will scale the coordinates and apply no other unit
conversion.
 
If any CTI software license key (dongle) is detected on the local machine the program will convert any XTF file
regardless of the program used to record the original XTF file. If no dongle is found, the utility will operate on
files that have been collected with SonarWiz only.
 
The program may also be run standalone by selecting the file XtfToSegy.exe from within Windows Explorer.
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Extract Navigation from XTF Files...
 

The Extract Navigation from XTF Files... command in the Tools Menu located in the  File Utilities
opens Windows Explorer and is used to select and extract the navigation data within an XTF file.
 
The output Comma Separated Value (CSV) file will be located in the Misc folder of the SonarWiz project and
contain the following columns...
 
•  Date
•  Time
•  Ping
•  Fish Latitude
•  Fish Longitude
•  Vessel Latitude
•  Vessel Longitude
•  Vessel Gyro
•  Bearing to Fish
•  Range to Fish
•  Fish Speed
•  Fish Heading
•  Event
•  Ship Speed
•  Cable Out
•  Distance off preplotted Track line
•  Ship Depth
•  Auxiliary 1
•  Sensor Depth
•  Mag X
•  Mag Y
•  Mag Z
•  Altitude
•  Roll
•  Pitch
•  Water Temperature
•  NavTimeStamp
•  Sound Velocity
•  PortMin
•  PortMean
•  PortMedian
•  PortMax
•  StbdMin
•  StbdMean
•  StbdMedian
•  StbdMax
•  Port Slant Range
•  Stbd Slant Range
•  Heading Quality
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Extract XTF Record Types Into Text File
 

The Extract XTF Record Types Into Text File... command in the Tools Menu located in the  File Utilities
opens Windows Explorer and is used to select and extract a list of all the datagram headers within an XTF file.
 
The output Comma Separated Value (CSV) file will be located in the Misc folder of the SonarWiz project and
contain the following columns...
 
•  HeaderType
•  Description
•  SubChannel
•  NumChannel
•  NumBytes
•  Details
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Build XTF Record Summary CSV
 

The Build XTF Record Summary CSV... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and extract a summary of the datagram headers within an XTF file.
 
The output Comma Separated Value (CSV) file will be located in the Misc folder of the SonarWiz project and
contain the following columns...
 
•  RecordCode
•  Description
•  Count
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Extract XTF Header Info...
 

The Extract XTF Header Info... command in the Tools Menu located in the  File Utilities opens Windows
Explorer and is used to select and extract the header contents within an XTF file.
 
The text (TXT) file will be located in the Misc folder of the SonarWiz project and contain the following columns
and more...
 
•  File Format
•  Sonar Name
•  Number of Sonar Channels
•  Nav Offsets

 
 



Rewrite XTF Ping Times...

534

Rewrite XTF Ping Times...
 

The Rewrite XTF Ping Times... command in the Tools Menu located in the  File Utilities opens Windows
Explorer and is used to rewrite ping times by using the start time of the first ping and increments the ping time
by the ping period value in the XTF channel header.
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Extract Notes from XTF File...
 

The Extract XTF Header Info... command in the Tools Menu located in the  File Utilities opens Windows
Explorer and is used to read any electronic notes entered by the operator during the survey and stored within
an XTF file.
 
The text (TXT) file will be located in the Misc folder of the SonarWiz project and will prompt the user with an
error message if no notes are found.
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Update Parameters in XTF File...
 

The Update Parameters in XTF File... command in the Tools Menu located in the  File Utilities opens
the Update XTF Files from CSF window and is used to update the Fish Position, Cable Out, and/or Altitude of
the raw XTF files from the CSF files in your project.
 

 
Note: This utility edits the original XTF file and once edits are saved they cannot be “undone”. It is highly
recommended that a backup of the original XTF files be made prior to using this utility.
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XTF Datum Shifter...
 

The XTF Datum Shifter... command in the Tools Menu located in the  File Utilities opens the XTF Datum
Shifter window and is used to convert the coordinate system of a group of XTF files.
 

 
 To convert the coordinate system of an XTF file:
1.     Select XTF Datum Shifter... in the XTF File Utilities drop down menu.
2.     In the Input dialog box navigate to the folder where the XTF files are located.
3.     Select if you want the utility to recurse into any other folders.
4.     Select the input coordinate system.
5.     In the Static dialog box select the folder where the new XTF files will be created.
6.     Select the output coordinate system.
7.     Left click on Start . Any error messages will be displayed in the Message Window.
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XTF Frequency Splitter...
 

The XTF Frequency Splitter... command in the Tools Menu located in the  File Utilities opens the XTF
Frequency Splitter window and is used to split the frequency of a group of XTF files with 4 channels.
 

 
To split a dual frequency XTF file into two:
1.     Select XTF Frequency Splitter... in the XTF File Utilities drop down menu.
2.     In the Folder to Convert dialog box navigate to the folder where the XTF files are located.
3.     In the Folder to Write dialog box select the folder where the new XTF files will be created.
4.     Left click on Start . Any error messages will be displayed in the Message Window.
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Extract XTF Laser Packets to Text File...
 

The Extract XTF Laser Packets to Text File... command in the Tools Menu located in the  File Utilities
opens Windows Explorer and is used to select and extract the laser data contents within an XTF file.
 
The text (TXT) file will be located in the Misc folder of the SonarWiz project and contain the following
columns...
 
•  BytesThisRec
•  NumChannels
•  Time
•  GPSTime
•  Mode
•  Sensor
•  VR
•  VA
•  VI
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Split by Sonar Type
 

The Spliy by Sonar Type... command in the Tools Menu located in the  File Utilities opens Windows
Explorer and is used to select and separate XTF files by their sonar type.
 
Each new file will have the same name as the original file with a suffix as follows:
•  Lidar  "_Lidar"
•  Sidescan "_SS"
•  Bathy   "_Bathy"
•  Subbottom  "_SBP"
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XTF Utilities
 

The XTF Utilities command in the Tools Menu located in the  File Utilities opens the XTF Utilties Menu
and is used to apply various settings and offsets to .XTF files.
 

File Selection
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Use the Select XTF Files... button to open Windows Explorer and select a group of XTF files to be
edited.

Static Navigation Offset

When enabled, will allow the user to add static offsets to either the latitude/ longitude or easting/
northing stored in the XTF files.

Swap Heading and Navigation

When enabled, will swap the heading or position stored from the fish to the ship inside the XTF file.

Reduce File Size

When enabled, will break down the input XTF files into smaller individual files based on the set file size
limit.

Copy Heading and Navigation

When enabled, will copy the heading or position stored from the fish to the ship inside the XTF file.

Process Files

Used to process the files selected with the options enabled above.
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CSF (File Utilities)
 
The CSF submenu in the Tools Menu under File Utilities command group provides commands for extracting
and changing data inside SonarWiz CSF files.
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Convert CSF File to CSV...
 

The Convert CSF File to CSV... command in the in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to extract data from CSF files, usually located in the CSF folder of your
SonarWiz project. The user has the option to sample the number of records exported using the Export Every
Nth Record option.
 
The output CSV, GPX, or Trackplot (TXT) file will be located in the CSF folder of the SonarWiz project and
contain the following columns...
 
•  Ping
•  Date
•  Time
•  Flags
•  Altitude
•  ShipLat
•  ShipLon
•  ShipX
•  ShipY
•  FishLat
•  FishLon
•  AntennaHeight
•  NadirX
•  NadirY
•  PortX
•  PortY
•  StbdX
•  StbdY
•  RNG
•  HDG
•  CMG
•  SPD
•  CBL
•  LBK_X
•  LBK_Y
•  EVT
•  MAG
•  MAG_S
•  SENSOR_DEP
•  DEP
•  DistToPrevMeters
•  Roll
•  Pitch
•  Heave
•  Swell
•  KP
•  Corrected Fish X
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•  Corrected Fish Y
•  Corrected Fish Latitude
•  Corrected Fish Longitude
•  SV Water
•  SV Sediment
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Convert CSF Navigation to SEGP1...
 

The Convert CSF Navigation to SEGP1... command in the in the Tools Menu located in the  File
Utilities opens Windows Explorer and is used to extract navigation data from CSF files, usually located in the
CSF folder of your SonarWiz project, and convert into a SEGP1 file. The user has the option to sample the
number of records exported using the Export Every Nth Record option.
 
The output SP1 file will be located in the CSF folder of the SonarWiz project and will be in standard SP1
format...
 

H Source File: D:\Sample_Data\Sample_XTF_KleinSS+SB\Colocated-Klein-SS-SB
\sonar_data090512111200.xtf

H Lat/Lon CoordSys: WGS-84
H X/Y CoordSys: UTM84-19N
H Columns 67-80: YYDDDHHMMSS
 sonar_data090512   36465A42494479N070381503W  366159 4743138  0.009132150726
 sonar_data090512   36466A42494479N070381503W  366159 4743138  0.009132150726
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Convert CSF Files to XTF...
 

The Convert CSF Files to XTF... command in the Tools Menu located in the  File Utilities opens the
Convert CSF to XTF window and is used to convert sidescan CSF files to XTF. Note: Any positional offsets
that have been applied to the CSF position will be included in the final output position.
 

 
 

Output Folder to Store XTF Files

When started will contain the default directory to store the generated XTF files.  The user may
change the location of this directory.

Sample Type

The XTF Sample Type drop down menu is used to choose between an 8-bit, 16-bit, or floating
point sample format for the output XTF file.
 
The CSF Sample Source drop down menu is used to choose between exporting the processed
samples that have been adjusted by any gain options applied in SonarWiz or the raw samples.
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Apply Heading Offset

The Resample Using Heading Offsets checkbox will resample the pings of the output XTF files
using the applied heading offset while maintaining the orginal heading stored in the files. See
image below for an example.

 
The Only Process Files with Heading Offsets checkbox will skip any CSF files that do not have
a Heading Offset applied in the Settings dialog.

Scale Samples

When enabled, if using the 8-bit samples option the output XTFs will be scaled out so that they fill
the 0-255 range and 16-bit samples will fill the 0-32,767 range.

Files Selection

Allows the user to select which CSF files will be converted to XTF.

Coordinate Format

     The user has the choice of outputting the coordinates in either Lat/Lon or X/Y.
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Datum Format

      The user has the choice of outputting the coordinates in either WGS84 or the local project datum.

Crop to Selected Feature

To crop the generated XTF files to an area a closed polygon feature present in the project may be
specified.

Start Button

When selected, will start the CSF to XTF export process with the files selected.

Help Button

Opens this document.
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Convert CSF Files to SEGY...
 

The Convert CSF Files to SEGY... command in the Tools Menu located in the  File Utilities opens the
Convert CSF to SEGY window and is used to convert sub-bottom CSF files to SEGY. This export function will
convert any of the imported SBP files regardless of the source file type (JSF, SEGY, KEB, ODC, etc) to a full
resolution SEGY file that contains all of the gain settings, navigation adjustments, layback, and vertical offsets
stored in the CSF file. Note that this function will split the SEGY into multiple files when the input file contains a
variable number of samples per channel.
 
Note: As of SonarWiz 7.08 the CSF to SEGY converter will export the file exactly as it is displayed in the
digitizer view in regards to vertical offsets. Use the Annotation Settings option to toggle the vertical offsets
under the SBP Image Options.

 

 
 
 

Output Folder to Store SEGY Files
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When started will contain the default directory to store the generated SEGY files.  The user may
change the location of this directory.

Custom EBCDIC Header

If a custom EBCDIC header is to be used the location of a TXT file can be specified here. A online
document that discusses this workflow is available from the Chesapeake Technology Support
website here .

File Selection

Allows the user to select which CSF files will be converted to SEGY.

SEGY Sample Format

Allows the user to choose between 16-bit or 32-bit sample format. When choosing the 16-bit
format, the minimum and maximum intensity values are rescaled to fill the available 16-bit range.
When choosing the 32-bit format the data is exported as-is with no rescaling.

Coordinate Format

Either X/Y Coordinates or Latitude/Longitude Coordinates can be selected for the exported SEGY
file.

Data Fields Table

The Data Fields table allows the user to map CSF data fields to exported SEGY byte locations in
the trace header. Beside each CSF data field name is a drop down that lists the possible SEG-
Y field to use as an output. You can optionally apply a scalar (multiplier) and/or offset to the input
values as necessary.

http://www.chestech-support.com/download/ctisupport/SonarWiz_5/UserDocs/SonarWiz5_SEG_CustomEBCDIC_Headers.pdf
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When Topo Corrections is turned OFF the fields that can be exported include:
 
Sonar Depth = Sensor Depth - Tide Offset - Heave - Swell - Antenna Offset + Bathy Grid
Separation
Sonar Altitude = Bottom Tracked altitude stored in the CSF file.
Total Water Depth = Sonar Depth + Sonar Altitude
Starting Elevation = Starting Elevation stored in the CSF file.
Surface Elevation = Tide Offset + Heave + Swell + Antenna Offset – Bathy Grid Separation +
Starting Elevation
 
When Topo Corrections is turned ON the fields that can be exported include:
 
Depth Above Image = Depth of the top of the image below the surface.
Depth Below Image = Depth of the seafloor below the top of the image.
Total Water Depth = Sonar Depth + Sonar Altitude
Starting Elevation = Starting Elevation stored in the CSF file.
Surface Elevation = Elevation of the surface above the top of the image
 
The fields of the CSF Data will change based on if Topo Corrections are currently enabled. For
more information on each of the depth and elevation fields and how they adjust the image, see
Topographic Corrections.

Save/ Load SEGY Profile

Once a particular SEG-Y format has been configured into the file preferences the format may be
saved in order to load it at a later date for the same sonar/format. Use the Load Profile option to
load a SEG-Y format that has previously been saved.

Crop to Selected Feature

To crop the generated SEGY files to an area a closed polygon present in the project may be
specified.

Annotation Settings

Used to access the Annotation/ Display Options. The CSF to SEGY export option will export the
SEGY files with whatever vertical offsets have been applied in the digitizer view (topo correction,
bathy grid separation, tides, etc.) so the user will need to toggle these options on/off depending
on the desired output. See SBP Tides and Vertical Offsets and Topograhpic Corrections for more
information.
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SEGY Time Field Scalar

The SEGY Time Field Scalar is applied to times specified in Trace Header bytes 95-114 (Lag
time A, Lag time B, and Delay recording time) to give the true time value in milliseconds. Scalar =
1, 10, 100, 1000, or 10,000. If positive, scalar is used as a multiplier; if negative, scalar is used as
divisor. A value of zero is assumed to be a scalar value of 1.
 
Recommended value: -100. This setting can handle shot delays up to 655.36 ms (491 m) with
0.01 ms (1 cm) resolution.
 
Time Field
Scalar

Resolution
(ms)

Resolution

(m)1
Maximum
Delay Length
(ms)

Maximum

Depth (m)1

+10,000 10000 7500 655360000 491520000

+1,000 1000 750 65536000 49152000
+100 100 75 6553600 4915200
+10 10 7.5 655360 491520
+1 1 0.75 65536 49152
0 1 0.75 65536 49152
-1 1 0.75 65536 49152
-10 0.1 0.075 6553.6 4915.2
-100 0.01 0.0075 655.36 491.52
-1,000 0.001 0.00075 65.536 49.152
-10,000 0.0001 0.000075 6.5536 4.9152
1Assumes a sound velocity of 1500 m/s
 

Seismic Domain

Use the drop down menu to choose between exporting a SEGY file in Depth or Time domain.
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- Trace header bytes 29-30 will indicate the trace identification code (1 for time domain seismic
data or 25 for depth domain seismic data)
- Trace header bytes 117-118 will indicate sample interval for this trace. Microseconds (μs) for time
data, Hertz (Hz) for frequency data, meters (m) or feet (ft) for depth data.

Profile Selection

Use the drop down menu to quickly adjust the Data Fields table to conform to one of the pre-
configured SEGY profiles.  Currently SonarWiz supports the following formats:
 
- Standard SEGY V1
- SonarWiz Real Time (the current format for recorded SGY files inside of SonarWiz)
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Extract CSF Navigation to Text File...
 

The Extract CSF Navigation to Text File... command in the Tools Menu located in the  File Utilities
opens Windows Explorer and is used to select and extract the navigation data within a CSF file. The user has
the option to sample the number of records exported using the Export Every Nth Record option.
 
The output CSV, GPX, or Trackplot (TXT) file will be located in the CSF folder of the SonarWiz project and
contain the following columns...
 
•  Date
•   
•  X Coordinate
•  Y Coordinate
•  Latitude
•  Longitude
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Extract Water Column Data...
 

The Extract Water Column Data... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and extract the water column data within a CSF file.
 
The output XYZA file will be located in the CSF folder of the SonarWiz project and contain the following
columns...
 
•  X Coordinate
•  Y Coordinate
•  Depth Below Transducer
•  Amplitude
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Extract SBP Amplitude...
 

The Extract SBP Amplitude... command in the Tools Menu located in the  File Utilities opens Windows
Explorer and is used to select and extract the SBP amplitude data from a CSF within the time ranges specified
by the user.
 
The output Comma Separated Value (CSV) file will be located in the CSF folder of the SonarWiz project and
contain the following columns...
 
•  Date
•  Time
•  Ping
•  FishX
•  FishY
•  Channel
•  NumSamples
•  SampleIntervalMs
•  FirstSampleMs
•  LastSampleMs
•  Samples...
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Extract SBP Hardness...
 

The Extract SBP Hardness... command in the Tools Menu located in the  File Utilities opens Windows
Explorer and is used to select and extract the SBP hardness data from a CSF in either bottom sample or
bottom sample plus extra range in (m) specified by the user.
 
The output Comma Separated Value (CSV) file will be located in the CSF folder of the SonarWiz project and
contain the following columns...
 
•  Ping
•  Latitude
•  Longitude
•  Depth
•  Amplitude
•  Range
•  Number of Samples
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Copy Processing Results Between Projects...
 

The Copy Processing Results Between Projects... command in the Tools Menu located in the  File
Utilities opens the Copy Processing Results window and is used to copy settings such as bottom tracking,
cable out, navigation, layback etc. from one set of CSF files to another. This copy operation may be done
within a single project or using two different projects.
 

Current Project Files

Lists the current CSF files in the destination project as well as frequency found, data source, records,
and if a match has been found from the source project via Source Count.

CSF Filename Settings

The CSF Filename section is used in conjunction with the Match Filenames button to set up a file match pattern. The
Find What section is used to identify a portion of file name which can then be replaced with what is entered in the
Replace With section when attempting to match files from the Source to Destination project.
 
For example if your Source Project has a .CSF named "Example01_LF_xtf-CH12.csf" and you are attempting to
match it with a file in the Destination project with the name "Example01_HF_xtf-CH34.csf" then entering "LF_xtf-
CH12" in the Find What and "HF_xtf-CH34" in the Replace With will succesfully match the two items.
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Settings

Opens the Settings window and is used to select which processing results will be transferred from the
source project to the destination project.

Source Project Selection

Allows the user to select the project where the processing results will be copied from.

Source Project Frequency Found

Visual indicator for what frequency has been found in the source project files.

Source Project Files

Lists the current CSF files in the source project as well as frequency found, data source, and records.

Match Options

Allows the user to match the source project files to the destination project files by using either match
selected, just HF to LF, just LF to HF, or match filenames.

Process Command

When selected, will copy the processing results of the matched and selected CSF files from the source
project to the destination project. See the Output Message Log for more information on the success or
failure of the selected files.
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Swap CSF Sidescan Channels...
 

The Swap CSF Sidescan Channels... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and swap the port and starboard channel data in a CSF file, and
can handle such cases as when the wiring between the sensor (towfish) and top-side unit was accidentally
reversed.  
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Extract SSS Amplitude into Text File...
 

The Extract SBP Amplitude... command in the Tools Menu located in the  File Utilities opens the
Extract Sidescan Amplitude window and is used to select and extract the amplitude data from a sidescan CSF.
 

 
The program allows for the selection of output folder where the file will be exported, be default the selection will
be the Misc folder in your project files.
 
To select the output folder, simply browse for the folders by pressing the Browse... button.
 
The tool offers three export file formats: Ping Per Line CSV, XYA CSV, and XYA Binary. There is also an
option to write the processed data of the CSF file instead of the raw data from the originally imported sidescan
file.
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The output message log will notify with errors if the tool was unable to extract any data. The progress of the
extraction will be indicated through the File Progress bar for each CSF file and the Overall Progress bar for
the start to finish progress.
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Create Alternate Frequency Project
 

The Create Alternate Frequency Project... command in the Tools Menu located in the  File Utilities
is used to create an identical copy of the selected SonarWiz project but will import the additional frequency
stored in the orginal source sonar files. For example if the Source Project has all of the low frequency sidescan
data imported the utility will create a new project, import the high frequency, and copy the processing settings
used.
 
This tool currently supports sidescan, sub-bottom, and FLS datasets.
 

Source Project

Used to select the SonarWiz project .MML file from the source project where the settings are going to
be copied from.

Source Files

Used to navigate to the folder that stores the original raw data.

New Project Name

Used to enter the name of the newly created SonarWiz project.

New Project Location
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Used to select the file path where the new SonarWiz project folder will be located.

Copy Process Settings

When enabled, will not copy the processing settings that are currently enabled on the Source Project.
Use the Settings option to toggle on/off processing settings that will be copied to the newly created
project from the source project.

Find and Replace File Name Settings

When the utility creates the new .CSF files that contain the different frequency in the new project,
this tool can be used to find and replace a part of the name coming from the orginal source data. For
example if the orginal .XTF file is named "Example001_HF.XTF" but contains both frequencies of data,
by entering "_HF" into the Find What section and "_LF" in the Replace With section the output .CSF
in the new project will be named "Example001_LF_xtf-CH12.CSF"

Tool Buttons

Select Process to run the tool and create the new project.
 
Select Close to close the window.
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CDF (File Utilities)
 
The CDF submenu in the Tools Menu under File Utilities command group provides commands for extracting
and changing data inside SonarWiz Bathy CDF files.
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Convert CDF File to CSV...
 

The Convert CDF File to CSV... command in the in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to extract data from Bathymetry CDF files, usually located in the Bathy folder
of your SonarWiz project. The user has the option to sample the number of records exported using the Export
Every Nth Record option.
 
The output CSV file will be located in the Bathy folder of the SonarWiz project and contain the following
columns...
 
•  Record
•  Date / Time (ISO 8601 format)
•  Raw Position X
•  Raw Position Y
•  Raw Roll
•  Raw Pitch
•  Raw Heading
•  Heave
•  Surface SV
•  Antenna Height
•  Ping Number
•  Channel
•  Time Delay
•  Raw Number of Samples
•  Beam Data Flags
•  Salinity
•  Pressure
•  Water Temp
•  Conductivity
•  Depth
•  Yaw
•  Tide Height (from Tide File)
•  User Entered Height Offset (from the merge settings)
•  Processed Slant Range
•  Processed Heading
•  Processed Transducer X
•  Processed Transducer Y
•  Processed Transducer Z
•  Processed Number of Samples
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Split CDF by Channel...
 

The Split CDF by Channel... command in the Tools Menu located in the  File Utilities opens the Split
CDF by Channel window and is used to split bathymetry files in the project by channel. The CDF file format is
the internal stored data of imported Bathymetric files. The list of files available to split will be all the currently
imported files in the project.
 

 
Once the selected files are split, you should see the orginal bathymetry files still loaded into the Project
Explorer as well as new files annotated with the Channel and Frequency.
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SEG-Y (File Utilities)
 
The SEG-Y submenu in the Tools Menu under File Utilities command group provides commands for extracting
and changing data inside SEG-Y files.
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ODC to SEG-Y Converter...
 

The ODC to SEG-Y Converter... command in the Tools Menu located in the  File Utilities opens the
ODC to SEG-Y Converter and is used to extract the sub-bottom packets from any StrataBox ODC data file and
creates a second 16-bit fixed point SEG-Y file.
 

 
The program allows for the selection of an input folder containing ODC files and an separate output folder
where SEG-Y files will be written. All ODC files found in the ODC folder that contains at least one channel
marked as a sub-bottom data channel will be processed. Note that only the first sub-bottom channel found in
the file will be processed.
 
To select input and output folders, simply browse for the folders by pressing the Browse... button.
 
When the Start button is pressed, the utility will begin processing the ODC files found in the ODC input folder
and will write each SEG-Y file until it completes or an error occurs. If an error occurs, processing will continue
with the next data file. Two progress bars indicate the overall progress as well as the individual file progress.
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If the sub-bottom data packet contains navigation, that navigation data is also extracted and formatted into the
SEG-Y trace header in conformance with the SEG standards, for map units and scale. The navigation and time
stamp data are carried over from the XTF file to the SEGY file as follows...
 
If the original ODC file contained geodetic coordinates then the output SEG-Y file will also contain geodetic
coordinates properly scaled and converted to arc seconds according to the SEGY specification. The geodetic
coordinates may be converted to project X/Y coordinates by checking he Convert to... check-box.
 
If the XTF file contains X/Y coordinates, the utility will scale the coordinates and apply no other unit conversion.
 
The ODC Sub-bottom packet may include a depth offset value if the StrataBox software was set to delay the
data recording. ODC To SEGY reads the depth in units and converts it to depth in milliseconds using the
sound velocity value in the main window combined with the units flag from the ODC 105 configuration record.
The depth in milliseconds is stored in bytes 105-106 of the SEGY trace header. The speed of sound in water
used for converting between distance and time may be specified by the user. This Sound Velocity is also
written to bytes 91-92 in the trace header.
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Extract Navigation from SEG-Y Files...
 

The Extract Navigation from SEG-Y Files... command in the Tools Menu located in the  File Utilities
opens Windows Explorer and is used to select and extract the navigation data within an SEG-Y file.
 
The output Comma Separated Value (CSV) file will be located in the Misc folder of the SonarWiz project and
contain the following columns...
 
•  Date
•  Time
•  Ping
•  Source Y
•  Source X
•  Receiver Y
•  Receiver X
•  Map Scale
•  Map Units
•  Unscaled Source Y
•  Unscaled Source X
•  Unscaled Source Y
•  Unscaled Source X
•  Num Samples
•  Sample Interval
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Extract SEGY V2 Extension Data...
 

The Extract SEGY V2 Extension Data... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and extract the navigation data within V2 trace extension headers for
SEGY V2 files.
 
The output Comma Separated Value (CSV) file will be located in the Misc folder of the SonarWiz project and
contain the following columns...
 
•   PingNumThisLine
•   PingNumThisReel
•   OrigFieldRecNum
•   cdpno
•  elev_at_rcv
•  rcv_dep_below_surface
•  elev_at_src
•  src_dep_below_surface
•  seis_datum_elev_rcv
•  seis_datum_elev_src
•  watercol_height_at_src
•  watercol_height_at_rcv
•  src_coord_x
•  src_coord_y
•  rcv_coord_x
•  rcv_oord_y
•  dist_src_to_rcv
•  samples_this_trace
•  nanoseconds
•  usec_sample_interval
•  cable_number
•  num_ext_trace_hdrs
•  last_trace_flag
•  cdp_x
•  cdp_y



Geostar to SEG-Y...

575

Geostar to SEG-Y...
 

The Geostar to SEG-Y Converter... command in the Tools Menu located in the  File Utilities opens the
Geostar to SEG-Y Converter and is used to convert older EdgeTech GeoStar data to full form SEGY files.
 

 
To select input and output folders, simply browse for the folders by pressing the Browse... button.
 
If Latitude and Longitude should be converted to X/Y coordinates, use the Convert LL to UTM checkbox.
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XTF to SEG-Y Converter...
 

The XTF to SEG-Y Converter... command in the Tools Menu located in the  File Utilities opens the XTF
to SEG-Y Converter and is used to extract the first sub-bottom data channel from either an 8 or 16-bit XTF
data file and create a SEG-Y file.
 

 
The program allows for the selection of an input folder containing XTF files and an separate output folder
where SEG-Y files will be written. All XTF files found in the XTF folder that contains at least one channel
marked as a sub-bottom data channel will be processed. Note that only the first sub-bottom channel found in
the file will be processed.
 
To select input and output folders, simply browse for the folders by pressing the Browse... button.
 
When the Start button is pressed, the utility will begin processing the XTF files found in the XTF input folder
and will write each SEG-Y file until it completes or an error occurs. If an error occurs, processing will continue
with the next data file. Two progress bars indicate the overall progress as well as the individual file progress.
 
The navigation and time stamp data are carried over from the XTF file to the SEG-Y file as follows...
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•  If the XTF file contains geodetic coordinates then by default, the output SEG-Y file will also contain geodetic
coordinates properly scaled and converted to arc seconds according to the SEGY specification.
Note, the geodetic coordinates may be converted to project X/Y coordinates by checking the Convert to...
checkbox.
 
•  If the XTF file contains X/Y coordinates, the utility will scale the coordinates and apply no other unit
conversion.
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SEG-Y Datum Shifter...
 

The SEG-Y Datum Shifter... command in the Tools Menu located in the  File Utilities opens the SEG-Y
Datum Shifter window and is used to convert the coordinate system of a group of SEG-Y files.
 

 
 
To convert the coordinate system of an SEG-Y file:
1.     Select SEG-Y Datum Shifter... in the SEG-Y File Utilities drop down menu.
2.     In the Input dialog box navigate to the folder where the SEG-Y files are located.
3.     Select if you want the utility to recurse into any other folders.
4.     Select the input coordinate system.
5.     In the Static dialog box select the folder where the new SEG-Y files will be created.
6.     Select the output coordinate system.
7.     Left click on Start . Any error messages will be displayed in the Message Window.
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SEG-Y Channel Splitter...
 

The SEG-Y Channel Splitter... command in the Tools Menu located in the  File Utilities opens the SEG-
Y Channel Splitter window and will take a single SEG-Y file containing 2 channels of data and create two
separate single-channel SEG-Y files.
 

 
Simply designate the directory containing the original 2-channel SEG-Y files and the output directory of the
single-channel SEG-Y files to be created and click on Start.
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SEG-Y File Splitter...
 

The SEG-Y  File Splitter... command in the Tools Menu located in the  File Utilities opens the SEG-Y
File Splitter window and is a utility program that will batch- split large SEG-Y files into smaller SEG-Y files of
the size specified by the user.
 

 
The program allows the user to select an input folder where large input SEG-Y files are stored and an output
folder where the smaller split SEG-Y files will be written. Any SEG-Y file in the input folder that is larger than
the Maximum Size of Split Files (MB) will be processed.
 
The EBCDIC and binary headers are copied from the original to the split files without change. The trace
header navigation, time stamp and raw samples for each channel are copied from the source file without
change.
When the start button is pressed, the utility will begin processing the SEGY files found in the input folder and
will write each split file until the size of the split file is larger than the maximum file size specified by the user or
an error occurs. If an error occurs, processing will continue with the next data file. Two progress bars indicate
the overall progress as well as the individual file progress.
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SEG-Y File Aggregator...
 

The SEG-Y  File Aggregator... command in the Tools Menu located in the  File Utilities opens the SEG-
Y File Aggregator window and is a utility for combining multiple, adjacent smaller SEGY files into a single
aggregated SEG-Y file.
 

 
 
It should be used to combine only adjacent files, and should be used to create files of 10k, 20k or 30k pings
as a maximum. This limit is intended to allow SonarWiz7 to properly bottom-track, digitize, and post-process
the aggregated SEGY file (a file-size limitation requirement only of earlier SonarWiz versions).
 
The main dialog is shown, presented below, with a description of the control buttons and options for the user.
The basic operation is to concatenate every file found within the source folder, creating a single output SEGY
file in the designated output folder.
 
JPG files were used in early SonarWiz bottom-track and digitizer view displays, and they can display up to 32k
pings, so SonarWiz7 needed this ping count as a maximum limit for SEGY file sizes, originally. To this end,
we provided three limits – 10k, 20k and 30k, to allow the user to select a maximum ping count to result from
the aggregation process. The default is 20k but the user may select 30k if a larger maximum output file size is
desired.
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SEG-Y File Re-Time...
 

The SEG-Y  File Re-Time... command in the Tools Menu located in the  File Utilities opens the SEG-Y
File Re-Time window and is a utility to re-encode time in the SEG-Y file. This tool is helpful if you want to have
SEG-Y files in a new time zone or if there was an offset problem during acquisition.
 

 
The Additional Overhead function is critical for this tool to work properly. The SEG-Y file format specifies a
start time for each trace and the length of the trace when recorded.  However some recording systems have a
delay between the end of the trace and triggering the next trace.  The additional overhead allows SonarWiz to
make this adjustment.
 
SonarWiz has the ability to determine what the additional overhead is from your recording system if it is given
a file with the correct time.
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SEG-Y File Re-Ping...
 

The SEG-Y  File Re-Ping... command in the Tools Menu located in the  File Utilities opens the SEG-Y
File Re-Time window and is an application that can reassign ping numbers (also known as trace numbers or
shot numbers) in a conforming SEG-Y file.
 

 
The First Shot Number indicates the first ping number that is desired.  The program will increment the ping
number by one for each trace.
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JSF (File Utilites)
 
The JSF submenu in the Tools Menu under File Utilities command group provides commands for extracting
and changing data inside EdgeTech JSF files.
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JSF Navigation Extractor...
 

The JSF Navigation Extractor... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and extract the navigation data within an EdgeTech JSF file.
 
The output Comma Separated Value (CSV) file will be located in the Misc folder of the SonarWiz project and
contain the following columns...
 
Date
Time
Record Type
Samples
Data Format
Sample Interval (uS)
Ping
SubSystem
Channel
Start Freq
End Freq
latitude
Longitude
Event
Heading (deg)
Altitude (deg)
Cable Out (m)
Depth (m)
Roll (deg)
Pitch (deg)
Temperature (deg C)
Pressure Depth (m)
NMEA Latitude
NMEA Longitude
NMEA Heading
Weighting Factor
ADC Gain
KP
SV
Minimum
Mean
Median
Maxium
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JSF NMEA Message Extractor...
 

The JSF NMEA Message Extractor... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and extract the NMEA string within an EdgeTech JSF file.
 
The output Comma Separated Value (CSV) file will be located in the Misc folder of the SonarWiz project and
contain the following columns...
 
•  JSF Time
•  NMEA Time
•  Delta
•  NMEA String
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JSF Bathymetry Records...
 

The JSF Bathymetry Records... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and extract the bathymetry record type and channel within an
EdgeTech JSF file.
 
The output Comma Separated Value (CSV) file will be located in the Misc folder of the SonarWiz project and
contain the following columns...
 
•  Record Type
•  SubSystem
•  Channel
•  Time Stamp
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JSF Packet Info...
 

The JSF Packet Info... command in the Tools Menu located in the  File Utilities opens Windows Explorer
and is used to select and extract the record packet information within an EdgeTech JSF file.
 
The output Comma Separated Value (CSV) file will be located in the Misc folder of the SonarWiz project and
contain the following columns...
 
•  Record ID
•  Record Name
•  Count
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Split SBP JSF Files...
 

The Split SBP JSF Files... command in the Tools Menu located in the  File Utilities opens Windows
Explorer and is used to select and split SBP EdgeTech JSF files into separate files based on range.
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Split JSF Files into Sidescan and Sub-Bottom...
 

The Split SBP JSF Files... command in the Tools Menu located in the  File Utilities opens Windows
Explorer and is used to select and split dual frequency SS+SB EdgeTech JSF files into separate files.
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Filp Port/ Starboard Sidescan Channels...
 

The Flip Port/ Starboard Sidescan Channels... command in the Tools Menu located in the  File Utilities
opens Windows Explorer and is used to select and flip the sidescan channels of EdgeTech JSF files in case
they were recorded backwards.
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JSF File Configuration Report...
 

The JSF File Configuration Report... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and extract a configuration report within an EdgeTech JSF file.
 
The output text (TXT) file will be located in the Misc folder of the SonarWiz project and contain the following
columns and more...
 
JSF Configuration Report: D:\Sample_Data\Sample_JSF_6205Bathy
\EdgeTech-6205\20140224171906__Binned.jsf
System Type: (38): 2205 (SAIB / COMSON) SSL IS C10BATHY 
Low Rate IO Enabled: 0
Software Version: 741
Number of SubSystems: 2
Number of Serial Ports: 3
System Serial Number: 48259
Flags and Options: 1
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JSF Extract Marks to CSV
 

The JSF Extract Marks to CSV... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and convert the Mark numbers (bytes 184-185) and Nav locations
from a JSF Message Type 80 into a Name, X, Y type CSV file that can be imported as contacts.
 
The output Comma Separated Value (CSV) file will be located in the Misc folder of the SonarWiz project and
contain the following columns...
 
•  Easting (X)
•  Northing (Y)
•  Mark Number
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JSF Extract Reflectivity to XYZ...
 

The JSF Extract Reflectivity to XYZ... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select JSF files and extracts the position and RC constant from each ping
and dumps it into a XYZ file. The output XYZ file can be used to build grids and testing the usefulness of the
RC constant.
 
Users have the option to set a smoothing constant for the output XYZ file. A default value of 0 means no
smoothing.  Anything greater than 1 will smooth the data using the entered window width. The smoothing
is a simple averaging of the samples half the window width to both sides of each data point. The default X
and Y will be Geographic Latitude and Longitude but can be converted to export standard UTM or the project
coordinate system.
 

 
The output text (TXT) file will be located in the Misc folder of the SonarWiz project and contain the following
columns...
 
•  Latitude
•  Longitude
•  RC
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SDF (File Utilities)
 
The SDF submenu in the Tools Menu under File Utilities command group provides commands for extracting
and changing data inside Klein SDF files.
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SDF Navigation Extractor
 

The SDF Navigation Extractor command in the Tools Menu located in the  File Utilities opens Windows
Explorer and is used to select and extract the navigation data from Klein SDF files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Date
•  Time
•  Ping
•  Ship Latitude
•  Ship Longitude
•  Fish Latitude
•  Fish Longitude
•  Layback Latitude
•  Layback Longitude
•  Speed
•  Heading
•  Altitude (m)
•  Cable Out (m)
•  Roll (deg)
•  Pitch (deg)
•  Pressure Depth (m)
•  Range (m)
•  Sheave Offset X
•  Sheave Offset Y
•  Sheave Offset Z
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Build SDF Page Summary...
 

The Build SDF Page Summary... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and extract a summary of packets from Klein SDF files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Page Version
•  Description
•  Count
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Create filtered SDF file(s)
 

The Create filtered SDF file(s) command in the Tools Menu located in the  File Utilities opens Windows
Explorer and is used to select and create new filtered SDF files from RAW data so that these packets are
removed, creating a leaner, faster-to-import file.



Process SDF Files for Import...

599

Process SDF Files for Import...
 

The Process SDF Files for Import utility is found on the the Tools > SDF  ribbon menu. The utility is
used to pre-process raw Angle Look Sonar (ALS) packets in SDF files into a format suitable for import into
SonarWiz. The utility is a batch processor, working on a folder of raw SDF files at a time.
 

Input/Output

Specify the Input folder from which the SDF files will be read. All of the SDF files in the folder will be
processed.
Specify the Output folder where the processed SDF files will be written.



Process SDF Files for Import...
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Start Processing

After the Input and Output folders are specified, click the Start button to process the SDF files in the
Input folder

Apply Gain

Check to enable adaptive gain to level the brightness over the data range.

Progress Monitor

The progress monitor will show you the processing status of each SDF file in the input folder.
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ALL (File Utilities)
 
The ALL submenu in the Tools Menu under File Utilities command group provides commands for extracting
data inside Kongsberg ALL files.
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Extract Navigation Data from ALL File(s)...
 

The Extract Navigation Data from ALL File(s)... command in the Tools Menu located in the  File
Utilities opens Windows Explorer and is used to select and extract the navigation data from Kongsberg ALL
files.
 
The text (TXT) file will be located in the Misc folder of the SonarWiz project and will contain the following
columns...
 
•  Date
•  Time
•  Latitude
•  Longitude
•  Course
•  Heading
•  Speed
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Extract Record Type Summary from ALL File(s)...
 

The Extract Record Type Summary from ALL File(s)... command in the Tools Menu located in the  File
Utilities opens Windows Explorer and is used to select and extract a summary of record types from Kongsberg
ALL files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Model
•  Record ID (hex)
•  Record ID (dec)
•  Description
•  Count
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Extract Record Type Detail from ALL File(s)...
 

The Extract Record Type Detail from ALL File(s)... command in the Tools Menu located in the  File
Utilities opens Windows Explorer and is used to select and extract line for line record types from Kongsberg
ALL files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Date
•  Time
•  PackedID
•  Packet Description
•  Length
•  Details
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Extract Sonar Head and Offset
Information from Kongsberg ALL File(s)...

 
The Extract Sonar Head and Offset Information from Kongsberg ALL File(s)... command in the Tools

Menu located in the  File Utilities opens Windows Explorer and is used to select and extract line for line
record types from Kongsberg ALL files.
 
The text (TXT) file will be located in the Misc folder of the SonarWiz project and will contain the following
columns and more...
 
Installation Info for: C:\Users\Patrick Zynda\XXX.ALL
Start Time: XX/XX/XXXX XX:XX:XX.XXX
Model: 3020
Number of transducers: 2
Transducer #1 Serial Number: XXX
Transducer #2 Serial Number: XXX
Waterline vertical location: -0.110000 (m)
Transducer #1 Z: 0.570000 (m)
Transducer #1 Y: 0.000000 (m)
Transducer #1 X: -0.530000 (m)
Transducer #1 Heading: 359.710000 deg
Transducer #1 Roll: 39.930000 deg
Transducer #1 Pitch: 3.180000 deg
Motion Sensor Z: 0.000000 (m)
Motion Sensor Y: 0.000000 (m)
Motion Sensor X: 0.000000 (m)
Motion Sensor Heading: 0.000000 deg
Motion Sensor Roll: 0.000000 deg
Motion Sensor Pitch: 0.000000 deg
Motion Sensor Delay: 0.000000 ms
Position System 1 Z: -3.950000 (m)
Position System 1 Y: -0.530000 (m)
Position System 1 X: -0.050000 (m)
Position System 1 Delay: 0.000000 ms
Position System 1 Geodetic Datum: WGS84
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COD (File Utilities)
 
The COD submenu in the Tools Menu under File Utilities command group provides a command for extracting
data inside CODA COD files.
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Extract Navigation Data from CODA file
 

The Extract Navigation Data from CODA file command in the Tools Menu located in the  File Utilities
opens Windows Explorer and is used to select and extract the navigation data from CODA COD files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  PingDate
•  PingTime
•  PingNumber
•  ChannelType
•  InputChannel
•  Easting
•  Northing
•  Speed
•  Heading
•  Course
•  WaterDepth
•  Event
•  KP
•  CorrectedNavFlags(hex)
•  Corrected Easting
•  Corrected Northing
•  Altitude
•  Channel
•  Channel Count
•  Corrected Layback
•  Roll
•  Pitch
•  Sonar Frequency
•  Sound Velocity
•  A/D Zero Offset
•  tx_power_db
•  input_gain_db
•  voltage_range
•  ss_flags
•  ss_flags2
•  sync_with
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R2S (File Utilities)
 
The R2S submenu in the Tools Menu under File Utilities command group provides commands for extracting
and changing data inside R2Sonic R2S files.
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Extract Packet Information from R2Sonic Files...
 

The Extract Packet Information from R2Sonic Files... command in the Tools Menu located in the  File
Utilities opens Windows Explorer and is used to select and extract the packet information from R2Sonic R2S
files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Record Code
•  Description
•  Head 1 Count
•  Head 2 Count
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Split multispectral R2Sonic files into
multiple files with a single frequency

 
The Split multispectral R2Sonic files into multiple files with a single frequency command in the Tools

Menu located in the  File Utilities opens Windows Explorer and is used to select and separate a single
R2Sonic file into multiple files labeled with their single frequency.
 
For example, file 0001_2019.R2S will be split into 0001_2019_FREQ_200kHz.R2S,
0001_2019_FREQ_300kHz.R2S, and 0001_2019_FREQ_400kHz.R2S.
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S7K (File Utilities)
 
The S7K submenu in the Tools Menu under File Utilities command group provides commands for extracting
data inside Reson S7K files.
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Extract Packet Information from Reson S7K Files...
 

The Extract Packet Information from Reson S7K Files... command in the Tools Menu located in the 
File Utilities opens Windows Explorer and is used to select and extract the packet information from Reson S7K
files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Record Code
•  Record Type
•  Count
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Extract Sonar Installation
Parameters from S7K Files...

 
The Extract Sonar Installation Parameters from S7K Files... command in the Tools Menu located in the

 File Utilities opens Windows Explorer and is used to select and extract the installation parameters from
Reson S7K files.
 
The text (TXT) file will be located in the Misc folder of the SonarWiz project and will contain the following
columns...
 
Packet 7200 - 7k File Header
     File identifier:                 
     File format version:            
     Reserved:                        
     Session identifier:              
     Record data size:                
     Number of devices:               
     Recording name:                  
     Recording program version number:
     User defined name:             
     Notes:                           
     Device identifier:
     7000 System enumerator:
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83P (File Utilities)
 
The 83P submenu in the Tools Menu under File Utilities command group provides a command for extracting
data inside Imagenex 83P files.
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Extract Packet Information
from Imagenex 83P Files...

 
The Extract Packet Information from Imagenex 83P Files... command in the Tools Menu located in the

 File Utilities opens Windows Explorer and is used to select and extract the packet information from
Imagenex 83P files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Date Time
•  Ping
•  Latitude
•  Longitude
•  Altitude
•  Speed
•  Num Beams
•  Sector Size
•  Start Angle
•  Angle Increment
•  Have Intensity
•  Sample Rate
•  Version
•  Sonar Offset X
•  Sonar Offset Y
•  Sonar Offset Z
•  Sample Interval (s)
•  Sound Velocity
•  Center Ping Time Offset
•  Heading
•  Heave
•  Pitch
•  Roll
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POS (File Utilities)
 
The POS submenu in the Tools Menu under File Utilities command group provides commands for extracting
data inside Applanix files.
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Extract Packet Information
from Applanix Raw Files...

 
The Extract Packet Information from Applanix Raw Files... command in the Tools Menu located in the

 File Utilities opens Windows Explorer and is used to select and extract the packet information from
Applanix Raw files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Record ID
•  Record Name
•  Count
•  First Time
•  Last Time
•  Rate Hz
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Extract Navigation Data from Applanix Raw Files...
 

The Extract Navigation Data from Applanix Raw Files... command in the Tools Menu located in the 
File Utilities opens Windows Explorer and is used to select and extract the navigation data from Applanix Raw
files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Date-Time
•  Latitude
•  Longitude
•  Geoid Height (m)
•  Speed (kts)
•  Heading (deg)
•  Roll (deg)
•  Pitch (deg)
•  Heave (m)
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Extract NMEA Data from Applanix Raw Files...
 

The Extract NMEA Data from Applanix Raw Files... command in the Tools Menu located in the  File
Utilities opens Windows Explorer and is used to select and extract the NMEA data from Applanix Raw files.
 
The text (TXT) file will be located in the Misc folder of the SonarWiz project and will contain the column data
for the specific NMEA string in the Applanix files.
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Extract TrueHeave Data from Applanix Raw Files..
 

The Extract TrueHeave Data from Applanix Raw Files... command in the Tools Menu located in the 
File Utilities opens Windows Explorer and is used to select and extract the TrueHeave data from Applanix Raw
files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Date-Time
•  Heave (m)
•  True Heave (m)
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ODC (File Utilities)
 
The ODC submenu in the Tools Menu under File Utilities command group provides commands for extracting
data inside Syqwest ODC files.
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Extract Packet Information
from Syqwest ODC Files...

 
The Extract Packet Information from Syqwest ODC Files... command in the Tools Menu located in the

 File Utilities opens Windows Explorer and is used to select and extract the packet information from
Syqwest ODC files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Record ID
•  Record Name
•  Count



Extract Navigation Data from Syqwest ODC Files...
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Extract Navigation Data from Syqwest ODC Files...
 

The Extract Navigation Data from Syqwest ODC Files... command in the Tools Menu located in the 
File Utilities opens Windows Explorer and is used to select and extract the navigation data from Syqwest ODC
files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Date - Time
•  Latitude
•  Longitude
•  Speed
•  Heading
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SMB (File Utilities)
 
The SMB submenu in the Tools Menu under File Utilities command group provides a command for extracting
data inside Kongsberg SMB files.
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Extract Packet Information
from Kongsberg SMB Files...

 
The Extract Packet Information from Kongsberg SMB Files... command in the Tools Menu located in the

 File Utilities opens Windows Explorer and is used to select and extract the packet information from
Kongsberg SMB files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Record Code
•  Description
•  Count
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GSF (File Utilities)
 
The GSF submenu in the Tools Menu under File Utilities command group provides commands for extracting
data inside Generic Sensor Format files.
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Extract Packet Information from
Generic Sensor Format (GSF) Files...

 
The Extract Packet Information from Generic Sensor Format (GSF) Files... command in the Tools Menu

located in the  File Utilities opens Windows Explorer and is used to select and extract the packet
information from Generic Sensor Format (GSF) files.
 
The comma separated value (CSV) file will be located in the Misc folder of the SonarWiz project and will
contain the following columns...
 
•  Record Code
•  Record Type
•  Count
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Extract Processing Notes from
Generic Sensor Format (GSF) Files...

 
The Extract Processing Notes from Generic Sensor Format (GSF) Files... command in the Tools Menu

located in the  File Utilities opens Windows Explorer and is used to select and extract a summary of
processing notes from Generic Sensor Format (GSF) files.
 
The text (TXT) file will be located in the Misc folder of the SonarWiz project and will contain processing notes
in the following format...
 
SF Header - GSF-v03.07
GSF Processing Parameters at: 1970-01-01 00:00:00.000 numParams: 63
    REFERENCE TIME=1970/001 00:00:00
    PLATFORM_TYPE=SURFACE_SHIP
    FULL_RAW_DATA=FALSE
    ROLL_COMPENSATED=YES
    PITCH_COMPENSATED=YES
    HEAVE_COMPENSATED=YES
    TIDE_COMPENSATED=YES
    NUMBER_OF_RECEIVERS=1
    NUMBER_OF_TRANSMITTERS=1
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629

TIL (File Utilities)
 
The TIL submenu in the Tools Menu under File Utilities command group provides a command for extracting
data inside Kraken TIL files.
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Extract Packet Information from Kraken TIL files...
 

The Extract Packet Information from Kraken TIL Files... command in the Tools Menu located in the 
File Utilities opens Windows Explorer and is used to select and extract the packet information within Kraken
TIL files.
 
The output text (TXT) file will be located in the Misc folder of the SonarWiz project and will contain packet
information in the following format...
 
Filename: 2014-04-03T14-09-07.002.01806.267.89062-15259
     Contains data for Port/Stbd.
     Nadir Latitude: 44.6842965003.
     Nadir Longitude: -63.6209361392.
     Average Heading: 319.493.
     System Type: MINSAS120 (4).
     Number of Data Segments: 6.
     Nominal Altitude (m): 0.00.
     Speed of Sound (m/s): 1450.00.
     Nominal Latitude: 0.0000000000.
     Nominal Heading: 90.00.
     Nominal Speed (m/s): 1.50.
     SR FFrequency (Hz): 337000.
     LR FFrequency (Hz): 240000.
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QPS (File Utilities)
 
The QPS submenu in the Tools Menu under File Utilities command group provides a command for extracting
data inside QINSy files.
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Extract Packet Information from QPS DB/QPD files...
 
The Extract Packet Information from QPS DB/QPD Files... command in the Tools Menu located in the

 File Utilities opens Windows Explorer and is used to select and extract the packet information within
QPS files.
 
The output text (TXT) file will be located in the Misc folder of the SonarWiz project and will contain packet
information in the following format...
 
Filename:
Sidescan Systems:
Sidescan Channels:



LOGDOC (File Utilities)
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LOGDOC (File Utilities)
 
The LOGDOC submenu in the Tools Menu provides utilities for working with Tritech logdoc files.
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Set Initial Position (LOGDOC files)
 
 
 
The Set Initial Position... (of LOGDOC file) command inserts dummy navigation into a logdoc file so that files
collected without navigation can be viewed in SonarWiz.
 
To use the utility:
 
1. Select Tools | LOGDOC | Set Initial Position...
2. Select the LOGDOC file to insert dummy navigation data.
 
The utility will create a new logdoc file. Add this to your project. It should load and display fine.
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Set Begin and End Positions... (LOGDOC files)
 
The Set Begin and End Positions... (of LOGDOC file) command opens the Enter Start and End Positions
window and is used to manually set positions for inserting dummy navigation so that .LogDoc files collected
without navigation can be viewed in SonarWiz.
 
To use the utility:
 
1. Select Tools | LOGDOC | Se Begin and End Positions...
 

Latitude/ Longitude Positions

Used to insert the Latitude and Longitude of the start and end positions of the new .LogDoc file.



Set Begin and End Positions... (LOGDOC files)
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Northing/ Easting Positions

Used to insert the Northing and Easting of the start and end positions of the new .LogDoc file.

Interactive Mode

The Interactive Mode allows the user to use the map view of the current SonarWiz project to set the
start and end positions of the dummy navigation inserted into the new .LogDoc file. Once either the
Start Position or End Position checkbox is checked, the window will prompt the user to select the
position using the left mouse button. Once both the Start and End position has been set, select OK to
open Windows Explorer and select the .LogDoc file that will have the navigation injected into.
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XSE (File Utilities)
 
The XSE submenu in the Tools Menu provides utilities for working with Elac XSE files.
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Extract Group Information... (XSE files)
 

The Extract Group Information... command in the Tools Menu located in the  File Utilities opens
Windows Explorer and is used to select and extract the group information within Elac XSE files.
 
The output CSV file will be located in the Misc folder of the SonarWiz project and will contain packet
information in the following format...
 
•  Frame Code
•  Group Code
•  Description
•  Count
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Extract Sonar Installation Parameters... (XSE files)
 

The Extract Sonar Installation Parameters... command in the Tools Menu located in the  File Utilities
opens Windows Explorer and is used to select and extract the install parameters within Elac XSE files.
 
The output text (.TXT) file will be located in the Misc folder of the SonarWiz project and will contain packet
information in the following format...
 
Ship Groups:
    General Group
                Name:
              Length:
                Beam:
               Draft:
              Height:
        Displacement:
              Weight:
 
    Sensors Group
               Sensor ID: 1
             Sensor Type: SB3000
        Sensor Frequency: 20000
 
    Navigation and Motion Group
               HRP sensor roll offset: 0
              HRP sensor pitch offset: 0
              HRP sensor heave offset: 0
                   Gyro sensor offset: 0
                Navigation time delay: 0
        Navigation antenna x position: -2.9
        Navigation antenna y position: 1.52
        Navigation antenna z position: 20.72
                HRP sensor x position: -0.64
                HRP sensor y position: -9.92
                HRP sensor z position: 2.67
 
    Transducer Group
        Transducer Number: 0
          SensorID: 1
          Frequency: 20000 (Hz)
          Kind of Transducer: 0 - Hydrophone
          Transducer Side: 3 - midship
          Array mounting angle (Roll): 0 (deg)
          Array mounting angle (Pitch): 0 (deg)
          Array mounting angle (Azimuth): 0 (deg)
          Across track offset (transducer center): 0 (m)
          Along track offset (transducer center): -3.4 (m)
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          Vertical offset (transducer center): 4.5 (m)
          Roll bias value (port positive up): 0.03 (deg)
          Pitch bias value (bow up positive): 0 (deg)
          Compass bias value (clockwise positive): 0 (deg)
          Horizontal distance between transducer and ship center: 0 (m)
 
        Transducer Number: 1
          SensorID: 1
          Frequency: 20000 (Hz)
          Kind of Transducer: 1 - Projector
          Transducer Side: 3 - midship
          Array mounting angle (Roll): 0 (deg)
          Array mounting angle (Pitch): 0 (deg)
          Array mounting angle (Azimuth): 0 (deg)
          Across track offset (transducer center): 0 (m)
          Along track offset (transducer center): 0 (m)
          Vertical offset (transducer center): 4.5 (m)
          Roll bias value (port positive up): 0 (deg)
          Pitch bias value (bow up positive): 0.08 (deg)
          Compass bias value (clockwise positive): -0.1 (deg)
          Horizontal distance between transducer and ship center: 0 (m)
 
    Transducer Extended Group
        Transducer Number: 0
          Mounting Roll Mode: 0 - Auto Mode
          Mounting Pitch Mode: 2 - System Parameter Mode
          Mounting Azimuth Mode: 0 - Auto Mode
 
        Transducer Number: 1
          Mounting Roll Mode: 2 - System Parameter Mode
          Mounting Pitch Mode: 0 - Auto Mode
          Mounting Azimuth Mode: 0 - Auto Mode
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Open Project Folder
 
The Open Project Folder command in the Tools Menu under the Miscellaneous command group opens
Windows Explorer in the main folder of your current project.
 



Open LogFile Folder
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Open LogFile Folder
 
The Open LogFile Folder command in the Tools Menu under the Miscellaneous command group opens
Windows Explorer in the Logs folder of your SonarWiz application files. In this folder, users can pull logs for
troubleshooting from the SonarWiz application as well as some of the external applications inside SonarWiz
like the 3D Viewer, Swath Editor, and Vessel Editor.
 



3D Viewer...
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3D Viewer...
 
The 3D Viewer... command in the Tools Menu under the Miscellaneous command group opens the external
Chesapeake 3D Viewer and is used for visualizing sidescan, sub-bottom, bathymetry, and more in 3
dimensions.
 

 
See 3D Visualization for more information.
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Grid and Contour...
 
The Grid and Contour... command in the Tools Menu under the Miscellaneous command group opens the
Grid and Contour Sonar Variable window and is used to grid and contour sensor variables into an ESRI shape
file.
 

 
See Grid and Contour for more information.
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Shapefiles...
 
The Shapefiles... command in the Tools Menu under the Miscellaneous command group opens the Build
Shapefiles window and is used to create ESRI Shape Files (*.SHP type) from the navigation track of sonar
data files in one of three formats.
 

 
The user has the option to create a multiple polyline file of unique navigation points with attributes every
Nth ping. Since the ping rate is higher than navigation update rate many pings will have same position. This
function only exports pings with non-repeating locations.
 
The user can also create a single polyline per file with limited attributes every Nth ping and is a
lightweight version of the Polyline version above.
 
Finally, users can create a point file of Event Numbers and is a file of unique points representing Event
Numbers.
 



Shapefiles...
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Both of the output types that allow the user to write attributes every Nth ping can so in the Use every Nth Ping
box. A value of “1” will take every node from EVERY point in the feature whereas a vale of “50” will only take
every 50th point thus reducing the size of the data object making up the feature. A good rule-of-thumb is to use
a low number (10 or less) for dynamic features.
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Dongle Info...
 
The Dongle Info... command in the Tools Menu under the Miscellaneous command group opens the Dongle
Info window and is used to see information on your dongle including user ID, EMA expiration date, and what
software components and options that have been purchased from CTI.
 



Locate project files...
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Locate project files...
 
The Locate project files... command in the Tools Menu under the Miscellaneous command group opens the
Change Project Path/ File Refrences window and is used to change or reconnect file paths in your project.
 

 
See Locate Project Files for more information.
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Help Menu
 
The Help Menu is opened by selecting the Help tab in the Ribbon Menus. The Help Menu provides commands
for accessing documentation and restoring factory default settings.
 



User Manual...
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User Manual...
 
The User Manual...  command in the Help Menu under the Resources command group opens the SonarWiz
User Guide in either PDF or Windows Help format and is used to find detailed instruction on any command in
the program. This command can also be executed by using hotkey F1.
 



Bathymetry Processing Guide...
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Bathymetry Processing Guide...
 
The Bathymetry Processing Guide... command in the Help Menu under the Resources command group
opens the Bathymetry Post Processing User Guide PDF and is used to find detailed instructions for processing
bathymetric data sets in SonarWiz. It assumes that you are familiar with the main SonarWiz user interface and
conventions.
 



Quick Reference Workbook...
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Quick Reference Workbook...
 
The Quick Reference Workbook... command in the Help Menu under the Resources command group opens
the Quick Reference Workbook PDF and is used as a check-list of recommended steps to follow while using
SonarWiz. This is a great document to follow while in the field or if you just need a refresher on how the
program works. You can refer back to the User Manual if you need more detailed explanations. This command
can also be executed by using hotkey ALT + F1.
 



Show Hot Keys...
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Show Hot Keys...
 
The Show Hot Keys... command in the Help Menu under the Resources command group opens the SonarWiz
Hot Keys PDF and is used to learn about the dozens of keyboard shortcuts used to make the program faster.
This cheat sheet lists the most commonly used shortcuts throughout the program. This command can also be
executed by using hotkey SHIFT + F1.
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Restore Factory Defaults...
 
The Restore Factory Defaults... command in the Help Menu under the Resources command group is used to
restore all program settings and configurations to their default state when the software was installed.
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Restore Window Locations...
 
The Restore Window Locations... command in the Help Menu under the Resources command group is
used to bring all windows back onto the main screen if SonarWiz windows or menus become “lost” due to a
hardware change such as the removal or relocation of a second monitor.
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My Support Info...
 
The My Support Info... command in the Help Menu under the Resources command group opens the My
Support Info window and is used to see program information and user licensing status.
 



Browse Help Docs...
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Browse Help Docs...
 
The Browse Help Docs... command in the Help Menu under the Resources command group opens the Docs
folder in Windows Explorer and contains all of the provided documentation that is installed with the software.
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Chesapeake Support Site
 
The Chesapeake Support Site command in the Help Menu under the Resources command group opens
the Chesapeake Tech Support Desk and is used to write up new bug reports, feature requests, and technical
support tickets or monitor existing tickets.
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Chesapeake Main Web Site
 
The Chesapeake Main Web Site command in the Help Menu under the Resources command group opens
https://chesapeaketech.com into your default browser. This is CTI's main website and is used for downloading
SonarWiz, contacting our support and sales team, and learning about upcoming events.
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SonarWiz Projects
 

A SonarWiz Project is the container or context in which all data collection and post-processing is performed.
 
Physically, it is a collection of folders and files on the hard disk. Together, these folders and files store the
settings and parameters for the projects (e.g. the geographic location and coordinate system) as well as the
processed sonar data and other ancillary data such as targets, digitized features and reports. All project files
and folders are located under a root folder – the Project folder.
 

The primary SonarWiz functions such as Data
Acquisition, Post Processing and Map will not
work unless a project (new or existing) is open.

 
 
When SonarWiz first starts it will either open the last edited project (if this has been specified in Advanced
Settings window) in or it will start with the Open Existing Project dialog. From this menu, the user may select
an existing project for editing.
 

 
If the user wishes to create a new project click the Cancel button to close the Open Existing Project dialog
and show the SonarWiz interface that has no current project. From this dialog the user may Create a New
Project, Open and Existing Project or simply use the Tools Menu functions.
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When a new project is created, SonarWiz will create the project folder with the name you specify and will then
create all necessary sub-folders and files. You should not delete or rename any of these folders or files.
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Creating a New Project
 

To create a new SonarWiz project, use the Create a New Project... command. The Create a New Project...
window can be opened in several ways:
 

1. Click the  icon in the Quick Access toolbar.
2. From the Project Level Context Menu in the Project Explorer.
3. When Creating a Project with Drag and Drop.
 
 
Fill in the fields as necessary for the project and then press OK. The project will be created in the folder
specified using the specified coordinate system. If the Project Folder does not exist, it will be created.
 

 
CAUTION: The Project Name and Project Folder must be valid Windows file names. In addition, please do
not use an apostrophe ‘ character in any filename or folder name, as it will subvert any SQL queries using
such a name. In case your version of SonarWiz is not protected against this – use this precaution, even if no
error message occurs when trying to use such a name. For example, the project name: “St. John’s Survey” will
cause you trouble later, even if allowed now. The apostrophe ‘ should not be used. Instead, use a name like
“St. Johns Survey” (No apostrophe).

 

Project Name

Enter a name for the new project. This will be used, among other things, to name the main
project definition file (<projectname>.MML).
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Project Folder

Specify the root folder for the project. All project related files will be stored in this folder or its
sub-folders. SonarWiz requires that a unique folder be used for each new project. If an attempt is
made to put a new project in an existing folder SonarWiz will instruct the user to select a new folder.

Approximate Position

If the Automatically Select Coordinate System option is being used then SonarWiz requires
an initial approximate position to set up the geodesy library correctly. There are several ways to do
this:
 
•  Manually enter the approximate position of your work area in the Latitude and Longitude fields.
•  Select a major city near the project area by pressing the Select From World Cities button.
•  Read the position from an existing acoustic data file (e.g. XTF or SEG-Y) by pressing the Get From
File button.
•  Use the current GPS position from the live GPS feed by pressing the Use GPS Position button.

Coordinate Source

Sidescan, Sub-bottom and Magnetometer sensors are typically towed behind the vessel. Depending
on the configuration of the acquisition system and the data fields available in the data record, a sonar
file may contain position values for both the ship and the tow fish. If you are satisfied with the tow
fish position in your raw data records use the Always Use Fish Position option, if you intend to
recompute the tow fish positions using the layback tools in SonarWiz, you should select the Always
Use Ship Position option. The Auto button will use the fish coordinates if they are available and the
ship coordinates otherwise.

Course Smoothing

By default, SonarWiz will smooth the navigation of towed data types (Sidescan, Sub-bottom and
Magnetometer). The Time Constant for Course Smoothing value controls the amount of smoothing
applied to the input navigation. Higher values correspond to more smoothing. A value of 300 is the
default. Set the value to 0 to turn off smoothing. See Course Smoothing and Interpolation for more
information.
The Time Constant for Course Smoothing may be set on individual sidescan files in the Advanced
Sidescan Import settings of the import open dialog.
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Coordinate System

A SonarWiz Project uses a projected coordinate system to convert the Earth's three-dimensional
space onto a two-dimensional planar surface. A Coordinate System in SonarWiz consists of:
 
• Datum: the relationship of the reference spheroid to the Earth's surface
• Projection: the mathematical transformation from spherical to planar coordinates
• Units: the unit of measure for the planar coordinates (typically meters or US Survey Feet)
 
Click Automatically Select CRS button for SonarWiz to select an appropriate Universal Transverse
Mercator (UTM) coordinate system based on your Approximate Project Position.
 
Click the Browse Coordinate Systems... button to manually select the coordinte system or to define a
custom coordinate system.
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Select a Coordinate System
 

To select or change the coordinate system of a SonarWiz project, use the Select a Coordinate System
window. The Select a Coordinate System window is opened by clicking the Browse Coordinate Systems...
button found on both the Create a New Project... window and the Configure an Existing Project window.
 
SonarWiz uses the PROJ coordinate system engine. Out of the box, SonarWiz supports thousands of spatial
reference ID (SRID) defined in the PROJ library by authorities such as the EPSG, ESRI and others. You can
also define custom SRID using the PROJ command syntax. Use the Defined tab to select a built-in SRID, use
the Custom tab to define a new SRID for your project (see Define and Select a Custom Coordinate System for
more information).
 
WARNING: Coordinate Systems defined in SonarWiz 7.10.0 are not compatible with previous versions of
SonarWiz.

 

SRID Type

Select the spatial reference id (SRID) list to display.
The Defined tab displays a searchable list of built-in coordinate systems.

https://proj.org/
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The Custom tab displays a list of user-defined custom coordinate systems. See Define and Select a
Custom Coordinate System for more information.

Search Filters

Use the Filter box to type in search keywords to help find the SRID of your choice. Use the Authority
drop down to further reduce the search space to only those SRID defined by the specified mapping
authority. The Show Deprecated check box will add obsolete SRID definitions to the search results.

Search Results

The search results box lists the SRID that pass the search filters. Select the project SRID by clicking
on the row listing your desired system. Note that search results only list built-in SRID definitions. To
select a custom coordinate system, see Defining and Selecting a Custom Coordinate System.

Transformations

If the selected project SRID is not using the WGS84 datum (EPSG:4326), a datum transformation will
be selected by SonarWiz and displayed here. If more than one published transformation is known,
SonarWiz will select the transformation with the highest published accuracy.
 
Click the Customize button to override the built-in transformation selection by creating a Custom
Coordinate System.

 



Select a Coordinate System

667

SRID Definition

This window shows the Well Known Text (WKT) definition for the selected spatial reference id.

Coordinate Calculator

Open the Coordinate Calculator to convert coordinates between coordinate reference systems.
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Define and Select a Custom Coordinate System
 
The Custom coordinate system tab is found on the Select a Coordinate System dialog. Use the Custom
coordinate system tab to define and select new spatial reference ID (SRID).
 
A custom spatial reference system consists of 5 fields: a Name, a Description, a Well Known Text (WKT)
definition and transformation pipelines from WGS84 (EPSG:4326) and the selected datum.
The Name is used by SonarWiz to identify the SRID throughout the program. It is limited to 23 characters and
must be unique.
The Description is a longer, less cryptic description of the SRID which is displayed in the browse dialogs.
The WKT is the formal definition of the SRID used by SonarWiz and its underlying libraries.
If the custom SRID is not based on WGS84 (EPSG:4325) then the transformation pipeline you select TO
WGS84 will be applied to imported data and the transformation pipeline you select FROM WGS84 will be
applied to stored data before converting it to the project coordinate system.
 
NOTE: SonarWiz uses WGS84 as a pivot datum.
 
Custom SRID are saved in the SonarWiz database for future use and also stored in any SonarWiz project
that uses them. If a project using a custom SRID is opened on another computer, the custom SRID will be
automatically imported and added to their custom database.
 
WARNING: The coordinate system engine used in SonarWiz Version 7.10.0 and newer is NOT compatible with
earlier versions.
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SRID List

The CRS List shows previously defined custom SRID in the drop down box. Use the drop down box to
select a previously defined SRID. The list may be empty if you have not previously created any custom
coordinate systems.
To create a new SRID: Click the New button and fill in the form.
To edit an existing SRID: Use the drop down box to select the SRID. Make any changes to the
definition. Click the Save button to store your changes.
To delete an existing SRID: Use the drop down box to select the SRID. Click the Delete button to
remove it.

Name

Use up to 23 characters to uniquely identify the SRID in the SonarWiz database. Built-in systems are
named with a Spatial Reference ID (SRID). For example EPSG:4326. A good choice would be your
company or project name followed by a code ACME:1 for example.
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Description

This is a one-line description of the SRID intended for display in SRID listings such as the browse
dialogs. It should be a brief, but complete description of the CRS. The current limit is 63 characters.

Definition

The definition area is used to initialize the spatial reference ID (SRID) using one of the three methods
that the PROJ engine understands:
1. You can use an existing Well Known Text (WKT) definition
2. You can specify a Spatial Reference ID (SRID) such as an EPSG code.
3. You can use PROJ strings.
 
Generally, WKT or SRID’s are preferred over PROJ strings as they can contain more information
about a given coordinate system. PROJ strings will in most cases cause a loss of information,
potentially leading to erroneous transformations. Still, PROJ strings are the easiest choice if you are
starting from scratch.
 
Once the definition is complete, click the Create WKT From Definition button to generate the WKT
text that will be used to create the CRS.
 
An example CRS definition using WKT (recommended):
PROJCS["NAD83(CSRS) / UTM zone 23N",
    GEOGCS["NAD83(CSRS)",
        DATUM["NAD83_Canadian_Spatial_Reference_System",
            SPHEROID["GRS 1980",6378137,298.257222101,
                AUTHORITY["EPSG","7019"]],
           
TOWGS84[-1.0141,1.9159,0.5576,0.027523,-0.008845,0.010361,0.000432]],
        PRIMEM["Greenwich",0,
            AUTHORITY["EPSG","8901"]],
        UNIT["degree",0.0174532925199433,
            AUTHORITY["EPSG","9122"]]],
    PROJECTION["Transverse_Mercator"],
    PARAMETER["latitude_of_origin",0],
    PARAMETER["central_meridian",-45],
    PARAMETER["scale_factor",0.9996],
    PARAMETER["false_easting",500000],
    PARAMETER["false_northing",0],
    UNIT["metre",1,
        AUTHORITY["EPSG","9001"]],
    AXIS["Easting",EAST],
    AXIS["Northing",NORTH]]
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An example CRS definition using PROJ strings:
 
+proj=utm
+zone=23
+ellps=GRS80
+towgs84=-1.0141,1.9159,0.5576,0.027523,-0.008845,0.010361,0.000432
+units=m
+type=crs
 
For more information on the PROJ strings formatting commands see (Cartographic projection —
PROJ 9.1.0 documentation).
 
An example Spatial Reference ID (SRID):
 
EPSG:9709
 
All of the built-in coordinate systems in the SonarWiz library can used to initialize your custom CRS
using the appropriate SRID.
 
TIP: Use the Defined tab and filter boxes to identify a CRS that is close to what you want and note the
SRID to use.
 

Datum Transformation

Specify the datum transformation used by SonarWiz when converting to and from WGS84
(EPSG:4326) and the datum used by the SRID you are defining. Note that SonarWiz uses WGS84 as
a pivot datum between your raw data datum and the project datum.
 
The PROJ library contains hundreds of published transformations between internationally recognized
datum. If SonarWiz recognizes the datum used by the SRID you are defining, it will automatically
populate the two drop down lists with all of the published transformations between the SRID and
EPSG:4326. Click the '...' icon to the right of the drop-down list to see the Datum Transformation List in
more detail.
 
NOTE: It you are using a built-in SRID, you can override the default datum transformation selected
by SonarWiz by defining a custom SRID and selecting your preferred datum transformation pipleline
here.
 

https://proj.org/usage/projections.html
https://proj.org/usage/projections.html
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Well Known Text

The Well Known Text (WKT) box displays the WKT that will be used by SonarWiz to define your CRS
throughout the program. This includes geo-referenced exports such as Grids, GeoTiffs and others.
 
Use the Create WKT From Definition button to generate a WKT from the your CRS definition. This
is useful if you used the SRID or PROJ strings definition options described above. The automatically
generated WKT can then be modified as necessary to meet your specifications.
NOTE: Not all valid WKT definitions supported by PROJ can be used in SonarWiz. The WKT
standards have evolved over time and some obscure options technically supported by the PROJ
engine are not supported by the 3rd party libraries that SonarWiz relies on for import and exporting
images, grids and vectors. The verification step described below will indicate if a WKT is suitable for
SonarWiz. Please contact technical support if you run into any difficulties. 

Verification

To verify that your custom coordinate system is working properly, the coordinate system must satisfy
two conditions:
 
1. It must be a valid definition that SonarWiz and its supporting libraries fully support.
2. It should transform a known point in WGS84 into the destination spatial reference to acceptable
accuracy
SonarWiz will automatically check that the SRID definition is valid and fully supported. If so, the Result
panel will display "Verified" in green. If any errors are found, they will be indicated in red.
 
To test that the coordinate system is correct for your project, enter the WGS84 coordinates of a known
point in the latitude and longitude boxes. SonarWiz will display the transformed coordinates in your
destination SRID. If the transformed coordinates are not the expected result, go back to the SRID
definition and carefully review the specifications you have entered.
NOTE: the test coordinate must be in the valid region of built-in projections. For example, if you are
creating a coordinate system based on the UTM system, you must pick a test coordinate inside the
zone of your projection.
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Coordinate Calculator

Open the Coordinate Calculator to convert coordinates between coordinate reference systems.

Import / Export

Use the Export and Import buttons to save a text file with a custom coordinate system definition. This
file can be shared with other users of SonarWiz to add the Custom CRS definition to their copy of
SonarWiz.

GM Projection Override

The GM Projection button is used to override the SRID selected for use by the embedded Global
Mapper library. It is critical that SonarWiz and the Global Mapper Library transform the coordinates
exactly the same.
 
The button indicates two modes:
 
(default) - SonarWiz has automatically selected a matching SRID from those available in Global
Mapper.
(custom) - The user has manually selected a SRID from the Global Mapper library.
 
Clicking the button will open the Global Mapper Projection Selection dialog:
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In this dialog you can select (or define) a projection, datum and units that match the custom coordinate
system you are defining in SonarWiz.

 
 
 



Datum Transformation List

675

Datum Transformation List
 
The datum transformation list is accessed from the Custom panel of the Select a Coordinate System dialog.
This dialog lists all of the published datum transformations between the custom defined Spatial Reference ID
and WGS84 (EPSG:4326) which is used internally by SonarWiz as a pivot datum.
 

 

Transformation Datum

The transformation datum lists the Spatial Reference ID (SRID) of the source datum and the SRID of
the destination datum.

Transformations List
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The transformations list shows all of the known transformations between the source datum and
destination datum, the published accuracy of the transformation in meters, and the PROJ definition
of the transformation pipeline. Select the transformation you want to use. A full description of the
selected transformation is shown in the Description area.

Description

The Description section shows the full name of the selected datum transformation, the published
accuracy of the transformation and the pipeline that will be used for converting from the source datum
to the destination datum.
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Coordinate System Test Dialog
 

The Coordinate System Test Dialog or Coordinate Calculator is found on the Select a Coordinate System
dialog. The Coordinate System Test Dialog is used to convert coordinates between two known coordinate
systems.

 

Input SRID

Enter the Spatial Reference ID if the input coordinates. Use the "B" button to browse the built-in SRID
database.

Input Datum Transformation

Select the transformation (if any) from the Input SRID datum to WGS84 (EPSG:4326).

Input Coordinates

Enter the input coordinates to convert. If the SRID uses units: degrees, then enter the latitude and
longitude. If the input SRID uses units: meters or us feet, then enter the easting and northing. The
Z Height can also be entered for 3D transformations, however, SonarWiz does not support 3D
transformations outside of this dialog.
 
The grid scale and grid convergence angle will be shown when the selected SRID is using projected
coordinates.
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Input Ellipsoid and Ground Unit

This is a read-only field that shows the ellipsoid and ground units used by the selected Input SRID.

Output SRID

Enter the Spatial Reference ID if the output coordinates. Use the "B" button to browse the built-in
SRID database.

Output Datum Transformation

Select the transformation (if any) from WGS84 (EPSG:4326) to the output SRID datum.

Output Coordinate

The output coordinate display shows the transformed coordinates in the output SRID. If the output
SRID uses units: degrees, then the output will display latitude and longitude results. If the output SRID
uses units: meters or us feet, then the output will display grid easting (X) and grid northing (Y) results.
The transformed Z Height will also be shown for 3D transformations, however, SonarWiz does not
support 3D transformations outside of this dialog.
 
The grid scale and grid convergence angle will be shown for the selected position when the output
SRID is using projected coordinates.

Output Ellipsoid and Ground Units

This is a read-only field that shows the ellipsoid and ground units used by the selected output SRID.

Output Options

Select output options:
 
Decimal degrees - show the input and output coordinates using decimal degrees, otherwise, use
Degrees Minutes Seconds.
High Precision Coordinate Display - Increases the precision (decimal places) in the output results.
3D Conversion - Display height conversion results, otherwise zero out height.
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Calculate

Perform the transformation from the input coordinates to the output coordinates.

Reverse

The Reverse button switches the input SRID and output SRID.
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Creating a Project With Drag-and-Drop
 
A SonarWiz Project may be automatically created by “Dragging and Dropping” sonar files into the Map
Window of SonarWiz. This method is recommended for users whose project settings change infrequently or for
those users that simply wish to see a quick overview of a data set.
 
Only supported Sonar File types are can be dragged and dropped. See Supported Sensor Data Formats
(Offline Processing) for a complete list of support Sonar File Types.
 
To Create a New Project With Drag and Drop
 
Start by opening SonarWiz, then open Windows Explorer and navigate to the directory containing the new
files. The user may then select the files that are to be added to the new project and drag them to the SonarWiz
Map Window; or select the folder containing the files and drag it to the SonarWiz Map Window. When a folder
is added, SonarWiz will recursively detect all supported acoustic files types and add them to the import list.
 
SonarWiz will open the File Drop Action window and prompt the user to either create a new project or add the
new files to the current project (if applicable).
 

 
In some cases, file types support a combination of sidescan, bathymetry and subbottom (etc.) data. Only one
data type can be imported at a time. The user can override the automatically selected data type to import by
adjusting the Import Files(s) as... radio buttons.
 
At this point, Project Creation will proceed in much the same way as Create a Project Manually. However, after
the SonarWiz Project folder is created, SonarWiz will immediately import your selected sonar files.
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Dragging and Dropping Files into a
project (new or existing) does not allow
the user to select File Type Specific
Options (See File Type Specific
Options) meaning  the most recent
previous settings used by the program
will be assigned to these new files.

 
Users should manually import files into
an existing project if File Type Specific
Options need to be configured.
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File Drop Action window
 

When sonar files are dropped on the SonarWiz Map Window, the File Drop Action dialog will open to allow
the user to either create a new project from the selected files or to add the selected files to the existing project.
In some cases, the file format supports more than a single data type. Use the Import File(s) as... button to
specify whether to import sidescan, sub-bottom, bathymetry, single beam or LiDAR data.

 

Action to Take...

Indicate whether to add the imported files to a new project or add the files to the current project.

Import File(s) as...

Many file formats contain multiple data types (sidescan and subbottom, or bathymetry and LiDAR,
etc.), however, you can only import one data type at a time into the program.  To indicate the type of
data you want to import, select the appropriate radio button.
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Check All check

Select all the files to import.    

Data Set List

Use the Data Set List to refine the selection of files you want to import. Checked files will be imported.

Cancel button

Cancel the import process (do not import the selected files) and close the dialog.

OK button

Import the files using the indicated settings.
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Open an Existing Project
 

To open an existing SonarWiz project, use the Open Existing Project window. The Open Existing Project...
window can be opened in several ways:
 

1. Click the  icon in the Quick Access Toolbar.
2. Select Open Existing Project... from the Project Level Context Menu in the Project Explorer.
3. Click CTRL+O anywhere in the main window.
 
To open an existing project, browse to the directory where the project MML file is located.

 
As well, the Quick Access Toolbar displays the most recently opened projects when the button is left clicked.
Select the desired project listed on the right to open it.
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Saving a Project
 
The Save Project Settings tool is used to record changes to Application settings in the Windows registry (see
Preferences and Settings) and to save Project settings (see Configure an Existing Project) in the project MML
file. The Save Project Settings command can be activated in several ways:
 

1. Click the  icon on the Quick Access toolbar.
2. Select Save Project Settings from the Project Level Context Menu in the Project Explorer.
3. Automatically, when the main SonarWiz window is closed.
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Configuring an Existing Project
 

To reconfigure a SonarWiz project, use the Configure an Existing Project... window. The Configure an
Existing Project... window can be opened in several ways:
 

1. Click the  icon in the Quick Access toolbar.
2. Select Configure Project Settings... from the Project Level Context Menu in the Project Explorer.
 
Adjust the values of the fields as necessary for the project and then press OK. The Project Name and the
Project Folder cannot be modified by SonarWiz.

 

 
CAUTION: Modifying the project properties does not apply settings retroactively to work that has already been
completed using the original project settings. Existing files and products in the project will continue to reflect
the project settings (coordinate source and coordinate system settings) that were in effect when they were
imported.
 

Project Name

READ-ONLY. The project name cannot be modified while SonarWiz is open.

Project Folder

READ-ONLY. The project folder cannot be modified while SonarWiz is open.
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Approximate Position

If the Automatically Select Coordinate System option is being used then modifying the approximate
position may change the project coordinate system. If this is desired, there are several ways to do this:
 
•  Manually enter the approximate position of your work area in the Latitude and Longitude fields.
•  Select a major city near the project area by pressing the Select From World Cities button.
•  Read the position from an existing acoustic data file (e.g. XTF or SEG-Y) by pressing the Get From
File button.
•  Use the current GPS position from the live GPS feed by pressing the Use GPS Position button.
 
Please see the note in the Coordinate System section.

Coordinate Source

Sidescan, Sub-bottom and Magnetometer sensors are typically towed behind the vessel. Depending
on the configuration of the acquisition system and the data fields available in the data record, a sonar
file may contain position values for both the ship and the tow fish. If you are satisfied with the tow
fish position in your raw data records use the Always Use Fish Position option, if you intend to
compute the tow fish positions using the layback tools in SonarWiz, you should select the Always Use
Ship Position option. The Auto button will use the fish coordinates if they are available and the ship
coordinates otherwise.
 
NOTE: Changing the Coordinate Source will only affect newly imported files, it does not apply
retroactively to files previously imported into the project.

Course Smoothing

By default, SonarWiz will smooth the navigation of towed data types (Sidescan, Sub-bottom and
Magnetometer). The Time Constant for Course Smoothing value controls the amount of smoothing
applied to the input navigation. Higher values correspond to more smoothing. A value of 300 is the
default. Set the value to 0 to turn off smoothing.
The Time Constant for course smoothing may be set on individual sidescan files in the Advanced
Sidescan Import settings of the import open dialog.
 
NOTE: Changing the Course Smoothing value will only affect newly imported files, it does not apply
retroactively to files previously imported into the project.
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Coordinate System

A SonarWiz Project uses a projected coordinate system to convert the Earth's three-dimensional
space onto a two-dimensional planar surface. A Coordinate System in SonarWiz consists of:
 
• Datum: the relationship of the reference spheroid to the Earth's surface
• Projection; the mathematical transformation from spherical to planar coordinates
• Units: the unit of measure for the planar coordinates (typically meters or US Survey Feet)
 
Select Automatically Select CRS button for SonarWiz to select an appropriate Universal Transverse
Mercator (UTM) coordinate system. Otherwise, the user can select the appropriate coordinate system
using the Browse Coordinate Systems... button.
 
CAUTION: It is critical that raw data be imported using the correct SRID. Data imported using the
wrong datum cannot be fixed by changing the SRID of the project.
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How to Copy a Project
 
In most cases, a SonarWiz Project is self contained. It is safe to move or copy a SonarWiz Project Folder from
one computer or drive to another so long as the internal structure remains unmodified. In particular, sonar
files, contacts and features are all stored within the project folder structure automatically and should transfer
locations without problems.
 
In some cases, a project may utilize data sources external to the project folder structure. If you attempt to open
a project that links to an external data source and this source is no longer available to SonarWiz, you will see a
warning dialog similar to this:
 

 
SonarWiz will skip this resource and continue loading the project. The best way to ensure that all charts and
base maps are kept with the project is to copy them into the  SonarWiz Project folder directly before loading
them into SonarWiz. Then, if the project is moved or archived, the resources are kept with the sonar data.
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SonarWiz Project Folder
 

Your SonarWiz Project Folder can be opened in the Project Context Menu by clicking the  icon in
the Tools Menu. This command open the Windows Project Explorer to the root directory of the current project
folder.
 
The following tables list the important sub-folders and files stored under the project folder. Those folders “Not
currently used by SonarWiz” are there either for future planned software modifications or due to specific client
requests.
 
Folders created by SonarWiz:
 

Folder Description

Project
folder -User

specified name

The root folder for the project. Also contains important project
definition and data files (see next table)

3DView The default location of the files created in the 3D export process
Backup  Contains backup files of project data that are automatically created

by SonarWiz
Bathy Contains SonarWiz CDF files that are created when recording or

importing bathymetry data files into the program
Classify Contains products and intermediate files created during seabed

classification operations
CSF Contains SonarWiz “Common Sensor Format” (CSF) files that are

created either in recording raw data or when importing sidescan
data files into the program

ExternalNavFiles Storage location for imported navigation data
GeoTiff Contains GeoTiff image files generated by the “ Save Project as

GeoTiff ” function
Grids Import and created grid (GRD) files are stored here

Images Default directory for Batch Image Export from Sonar File Manager .
Logs Project-level logging folder
MAG Contains CMF Magnetometer files
Misc Not currently used by SonarWiz
NAV Not currently used by SonarWiz

Rasters Not currently used by SonarWiz
SBP Sub-bottom Raw data

Sensors Not currently used by SonarWiz
SHP Default directory for exported .shp files from the Grid and Contour

Utility.
SingleBeam Single-beam data files are recorded into this folder
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SSS Contains sidescan files created by SonarWiz
SVP Imported sound velocity profiles are stored here

Targets Contains data and image files for all digitized targets.
Tide Imported tide files are stored here
Tmp Used by some of the utility programs to store temporary files

Vessels Vessel files are stored here
Web Contains the html and associated image files generated by the “

Save Project as Website ” function
XYZ Not currently used by SonarWiz

 
Files Created by SonarWiz
 

Option Result
Auxdata01.CDF Auxiliary info – bathymetry database

Bathydata01.CDF Bathymetry database
ContactAttributes.txt Contains a user-editable list of Secondary contact

attributes used to describe a contact in the Contact
Editor . See Section 2.7.4

ContactAttributes2.txt Contains a user-editable list of Primary contact attributes
used to describe a contact in the Contact Editor . See
Section 2.7.4

ContactDBR001.db3 SQL DB3 type contact database file, pointing to targets
and CSF folders, and every individual target image file
captured

ContactLocationAreas.txt Contains a user-editable list of Gulf of Mexico Block areas
used to describe a contacts location in the Contact Editor .
See Section 2.7.4 on page 148

FeatureData01.CDF Contains all digitized features – coordinates and
attributes. SQL database format (DB3)

FeatureDescriptions.txt A user-editable list of feature descriptions used to
describe a feature. See Section 2.7.5 on page 157

FeatureNames.txt A user-editable list of feature names used to describe a
feature. See Section 2.7.5 on page 157

<projectname>.COR A non-editable binary file containing Core information See
Section 5.18 for more information on Sub-bottom Cores

<projectname>.CSV A comma Separated Value file with...
<projectname>.EGN Empirical Gain Normalization table
<projectname>.MML The MAIN project definition file. Contains information

related to the current state of the project. This file is an
XML file that can be opened and viewed in any browser,
or a text editor such as NOTEPAD. Please send this file in
with any HELP request to support@chesapeaketech.com.

UnknowMagAnomalyList.txt A user-editable list of Mag Anomaly descriptions used to
describe a magnetic anomaly. See Section 2.7.7 on page
164
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A Note About Units
 
 
SonarWiz will use the Project Geodetic Units for the following tools:
 
•  Measuring Tool
•  Helm L/R indicator
•  A-Scan ranges
•  Waterfall Range Lines
•  Target Image Scale Bars in the Contact Editing Window
•  Towfish Altitude Display
•  Survey Line Status Boxes
 
Project units are specified at the time of project creation (See SonarWiz Projects) or in the Project Settings
dialog (See Modifying a Project) and are displayed in the System Information Window.
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Basemaps and Overlays
 

SonarWiz provides the ability to display multiple reference maps and images in the main view in addition to the
sonar mosaic and other geographically referenced items (targets, survey lines and digitized features). These
maps can be used to provide a visual  reference during and after a survey, and also to enhance the quality of
the data prior to incorporation into reports and presentations. Basically a basemap is typically a nautical chart,
and goes UNDER (behind) the sonar data display layer. Overlays, would typically be presented OVER (on top
of) the sonar data display layer.
 
Map Data Types
 
Compatible map data types fall into two broad categories:
 
Raster Maps
 
A raster map is a file structure in which the map or image is stored as a rectangular grid of cells or “pixels”. The
numeric value of each pixel represents the color, intensity, amplitude or some other attribute value of the area
covered by the pixel.
 
Examples of raster maps are: JPG satellite images, Nautical charts and GeoTiffs.
 
Vector Maps
 
A vector map is a file structure in which map elements (lines, points, and polygons) are stored as discrete
geometric points and vectors defined by one or more coordinate pairs. Examples of vector maps are S-57
Charts, ESRI Shapefiles (SHP) and USGS Digital Line Graphs.
 
A partial list of supported map file formats can be found in Section 6.10 on page 770 .
 
Map Display Types
 
Reference maps can be displayed as either base maps or overlays. The difference between these two display
types has to do with the display order relative to the sonar mosaic.
 
Basemaps
 
Reference maps displayed as basemaps are drawn “under” the sonar mosaic. Thus, the sonar data will
obscure the basemap in areas where there is overlap. Basemaps are typically raster images – for example
aerial photos, satellite images or nautical charts.
 
Overlays
 
Overlays are reference maps or drawings that are displayed “over” the sonar mosaic. Since the elements in an
overlay will obscure the parts of the mosaic that they cover, it is usual for an overlay to be a vector file. In most
cases, a raster image overlay would completely cover up the underlying mosaic.
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Georeferencing
 
In order for a reference map (basemap or overlay) to correctly register or “line up” with other spatial data on
the display (primarily the sonar mosaic), the coordinates of the reference map must be in the same coordinate
system as the sonar data, or information must be provided to enable SonarWiz to translate the reference map
coordinates.
Moreover, if the reference map is a raster image, real world reference data must be provided to show how the
pixels in the image are translated to coordinates on the display. These data include the size of a pixel in real-
world units, and the location of a reference pixel in real-world coordinates.
 
There are several methods by which world reference parameters and coordinate system and projection data
are supplied to SonarWiz. These methods will be discussed in the following section. The exact method used
for a particular file depends on:
 
•  The reference map data type (raster or vector).
•  The method used to import the map.
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Specifying Coordinate System and Projection
 
When required, the coordinate system of a reference map is specified either manually, or with a PRJ file.
 
PRJ File
 
A PRJ file is an structured text file that defines the datum and projection of a map. An example is shown below:
 

 
 
By convention, a PRJ file has the following name: <mapfilename>.PRJ where mapfilename is the filename of
the map that the PRJ describes.
 
In situations where coordinate system and projection information is required by SonarWiz, the PRJ file will be
used if it exists. Otherwise, the user will be prompted for the projection.
 
PRJ files are often provided with digital maps. If you need to create one to accompany a map file, this can be
done in several ways, including:
 
•  Copying, renaming and editing an existing PRJ file that specifies the correct coordinate system. If there is
already a map data file in the project that is displaying correctly and that has a PRJ file, then this file can most
likely be cloned without modifying it's contents. Simply copy and rename to match it's parent map file.
•  Create a new PRJ file using the Coordinate System selection dialog described in the following section.
 
Manual Coordinate System Selection
 
If SonarWiz requires a PRJ file for in order to display a map reference map file, and the file cannot be found,
then a dialog will be displayed so that the coordinate system information can be entered manually.
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If a reference map is to be displayed often, then the coordinate system parameters should be stored in a PRJ
file so that the dialog is not displayed every time the map file is opened.
 
To do this, left-click the Save To File button before dismissing the dialog. A “ Save As ” dialog will be
presented. Make sure that the PRJ filename matches the file name of the map file and that it is in same folder.
Then press the Save button to create the PRJ file.
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Map Files that use Custom Coordinate Systems
 

Some map files such as DXF or ESRI shapefiles are based on a user defined or custom coordinate system
that is not part of the SonarWiz mapping library. SonarWiz is very flexible in creating custom coordinate
systems and datums. The basemap drawing library however uses a different geodesy encoding scheme than
SonarWiz. Therefore a translation between the SonarWiz geodesy and the map drawing library is required.
 
When a SonarWiz project is opened or created it tries to work out the translation between the selected
coordinate system of the project and the map drawing library. For standard projections on standard datums
this happens without the user being involved because everything is well defined. “Standard projections” are
considered to be UTM and State Plane on WGS-84, NAD-27 and NAD-83 datums. When a user defined
projection or datum is involved the user will be prompted to enter the parameters for the map drawing library.
 
Example:
 
The following project uses a custom coordinate system and a custom datum that have been defined using
the SonarWiz Add/Edit Coordinate System and Add/Edit Datum buttons (See Sections 6.1.1 and 6.1.1.2 on
pages 555and 563 respectively) . This case is for a project in Libya that used a Transverse Mercator Projection
based on a custom datum. When the new project is created, SonarWiz will display the following dialog which is
basically asking for the definition.
 

 
The yellow highlighted areas define the projection parameters. The user enters the projection parameters
clicks on any numeric values required to be edited and types in the new value.
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The blue highlighted area however shows a custom Datum named “Libya-ED50”. The source of this custom
datum is from a file that must be manually edited and created with the specific file name: “custom_datums.txt”.
This file must reside in the folder: “C:\Program Files\Chesapeake Technology, Inc\SonarWizMAP” or the path in
which SonarWiz is installed.
 
The content of the custom_datums.txt file is as shown in the example below.
 

 
This custom datum contains a 3-parameter datum definition (Libya-ED50) and a 7-parameter datum definition
(TEST).
 
“Libya-ED50”, “Libya-ED50”, “International 1909 (Hayford/Intl 1924)”, -87.00000000000000000,
-98.00000000000000000, -121.00000000000000000 “TEST”, “TEST”, “Clarke 1866”, 1.00000000000000000,
2.00000000000000000, 3.00000000000000000, 0.00001939254724438, 0.00002424068405548,
0.00002908882086657, 0.00000700000000000
 
This is a simple text file that can be edited in Notepad. The fields are comma separated and are:
 
1.  Datum Name
2.  Datum abbreviated name
3.  Reference Ellipsoid name
4.  Shift to WGS84 X (meters)
5.  Shift to WGS84 Y (meters)
6.  Shift to WGS84 Z (meters)
7.  Rotation to WGS-84 X (radians) Only used for 7-parameter shift
8.  Rotation to WGS-84 Y (radians) Only used for 7-parameter shift
9.  Rotation to WGS-84 Z (radians) Only used for 7-parameter shift
10.  Scale Correction to WGS84 (parts per million) Only used for 7-parameter shift
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Specifying World Reference Parameters
 
In order to correctly display a raster image below other spatial data, SonarWiz must have information that
relates the image to its geographic location in the real world. This information tells SonarWiz how pixels in the
image translate to coordinates in the real world, and thus allows the image to be drawn in the correct place on
the display. This section describes the two ways that world reference parameters are obtained by SonarWiz.
 
World File
 
A world file is a small text file that accompanies a file containing a raster map image. It contains six numeric
parameters, one per line.
 

Line 1  (A) Pixel size in the X direction in map units

Line 2:  (D) Rotation about Y axis

Line 3:  (B) Rotation about X axis

Line 4:  (E) Pixel size in the Y direction in map unit.

Line 5:  (C) X coordinate of center of upper left pixel

Line 6:  (F) Y coordinate of center of upper left pixel

 
An example of a world file:

 
 
Using these parameter values, the coordinates of any pixel in the image can be calculated as follows:
 

x' = Ax + By + C
y' = Dx + Ey + F

 
Where:
 
     x' = calculated Easting coordinate of the pixel on the map
     y' = calculated Northing coordinate of the pixel on the map
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     x = column number of a pixel in the image counting from left
     y = row number of a pixel in the image counting from top
     A = x-scale; dimension of a pixel in map units in x direction
     B,D = rotation terms
     C,F = x,y map coordinates of the center of the upper-left pixel

E = negative of y-scale; dimension of a pixel in map units in y direction
 
By convention, the name of a world file is the same as the name of it's accompanying image file with the
extension changed a follows: the second letter of the original filename extension is replaced with the third
letter, and the third letter is replaced with the letter "w."
 

Image Filename
Extension

World Filename
Extension

.JPG .JGW
.TIF: .TFW
.BMP .BPW

 
 
Embedded World Reference Parameters
 
Some raster image file formats, most notably the TIFF format, allow for special purpose records or “tags” to
be embedded into the file. These records can be used to store world reference parameters. If a file contains
embedded parameters, a world file may not be necessary, depending on the method used to import the file.
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Basemaps and GeoImages
 
Basemaps and GeoImages are displayed beneath project data. Currently displayed files are shown in the
Project Explorer under the Maps branch. Any number of maps may be displayed simultaneously. Use the
commands in the Basemaps group of the Maps Menu to add Basemaps and Geoimages to the Map Window.
 

 
Basemaps are usually raster images, but can also be vector files. GeoImages are raster images in BMP,
JPEG, or TIF format. The difference between the a Basemap and a GeoImage relates to drawing performance
as explained below.
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Basemaps
 
Any supported map format (raster or vector) can be displayed as a Basemap.  Coordinate system and
projection parameters are expected in a PRJ file. If no PRJ file is found, then program will prompt via the
dialog shown (see Specifying Coordinate System and Projection). If the file is a raster image, embedded world
reference parameters will be used if they exist. If not, the world file will be used. If there is no world file or
embedded tags, then the file will fail to load.
 
Basemaps offer the widest possible format compatibility. Maps will be projected into the project coordinate
system on the fly and vector layers will be rendered dynamically at the appropriate resolution. The flexibility of
basemaps comes with a performance cost, however, as it is slow to render screen updates, particularly if the
source map is a vector file or the source projection does not match the project projection.
 
The Add Basemap command is very flexible in that it will accept raster map images in a wide variety of file
formats that have been generated in coordinate systems that are not the same as the working coordinate
system of the SonarWiz project. However, the price paid for this flexibility, especially the handling of images in
different coordinate systems, is slower drawing speed. This is because the map must be reprojected each time
it is redrawn, thus making performance much slower than a map file that is in the same coordinate system as
the SonarWiz project.
 

The use of BSB raster charts
is especially susceptible to a
slower drawing speed. It is highly
recommended that when using BSBs
the solution presented below be used.
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GeoImages
 
GeoImages are rasters in TIF, JPG and BMP format only.  Coordinates in the file must be in the same
coordinate system as the current project. No attempt is made to read a PRJ file or to translate the coordinates.
This means that any necessary coordinate translation must be done before the file is loaded as a GeoImage
by SonarWiz. If the file is a raster image, only the world file is used to obtain world reference coordinates.
Embedded tags are not used. If the world file does not exist then the file will fail to load.
 
GeoImages can be very efficiently rendered in SonarWiz, even during real time operations.
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Convert a Basemap into a GeoImage
 
Basemaps can be converted into GeoImages to speed drawing performance. This is especially useful for
rendering vector charts more efficiently.
 
To convert a Basemap into a GeoImage: 
 
1. Use Maps | Add Basemap to add the map SonarWiz.
 
2. Center the display on the area of the map desired to be saved. The full extents of the map can be displayed
using the Ctrl+Shift+F key sequence. Any sonar data or other map objects should be disabled so that they are
not exported as part of the new map image. 
 
3. Use the Post Processing | Export | Save Project as Geo Image command to export the map as a
GeoImage. The image can be saved at any resolution but the map should be exported close to the original
map resolution for best results
 
4. Remove the Basemap by right-clicking the map in the Project Explorer and selecting Remove selected
map from project.
 
5. Use Maps | Add GeoImage to add the newly created GeoTiff.
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Overlays and Shapefiles
 

Overlays are drawn on top of (overlaying) project data. Currently displayed overlays are shown in the Project
Explorer. Any number of Vector Overlays may be displayed simultaneously, they are usually listed below
Basemaps in the Project Explorer to indicate that they are drawn after basemaps.
 

 
Overlays are usually vector files, but can also be raster images. The difference between an Overlay and a
Shapefile relates to file format support and drawing performance.
 
 



Overlays

709

Overlays
 
A wide variety of raster and vector file types are supported as Overlays including DXF, S-57 and Shapefiles
(SHP). Coordinate system/projection parameters are expected in a PRJ file. If no PRJ file is found, then
program will prompt for this information (see Specifying Coordinate System and Projection).  If the file is a
raster image, embedded world reference parameters will be used if they exist. If not, the world file will be used.
If there is no world file or embedded tags, then the file will fail to load.
 
Note that a raster image overlay will obscure all data beneath it, including the sonar mosaic and basemaps.
 
SPECIAL NOTE: Vector files may come in INVISIBLE. This happens when your DEFAULT color matches the
background. If you have imported an overlay and it shows in the MAP MANAGER, but has DEFAULT for the
color, please try changing the color to a different value like RED, to see if your SHP file import appears. (See
Change Vector Colors)
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Legacy Shapefile
 
Old-format Shapefiles can be added as a vector overlay. Coordinates in the file can be in any coordinate
system. SonarWiz will prompt for the coordinate system if necessary.
 
When a Legacy Shapefile is added to the project using the Add Legacy Shapefile button on the Maps Menu,
SonarWiz will prompt for the display characteristics of features in the file (line style, color, etc).
 

 
 
SPECIAL NOTE: Shapefiles may come in INVISIBLE. This happens when your DEFAULT color matches the
background. If you have imported a Shapefile and it shows in the MAP MANAGER, but has DEFAULT for the
color, please try changing the color to a different value like RED, to see if your SHP file import appears. (See
Change Vector Colors)
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Vector Drawing
 
In general, SonarWiz will render all points, lines and areas from a vector map using the same style (color, line
width, font, etc.).  However, some formats such as S-57 electronic navigation charts (ENC) contain a large
number of vector types in a single collection which taken together render all the symbology of a traditional
nautical chart. SonarWiz provides special style controls for rendering this format.
 

 
 
 



Change Vector Colors

712

Change Vector Colors
 
To change the color of a vector layer:
 
1.  Right-click the layer in the Project Explorer
2.  Select Map Manager... from the context menu
3.  Change the Color from Default to Red (for example) using the color selector drop-down

 
 

 
 

 
 
 
·     
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Vector Drawing Options
 
The Map | Vector Map Controls group on the Maps Menu contains check boxes for enabling and disabling
the drawing of all points, lines, areas and labels in the display.
 

 
For example, a large scale ENC Nautical chart can contain an overwhelming number of point features when
zoomed out as shown below:
 

 
 
Unchecking the Draw Point Features in the Vector Map Controls group removes the critical soundings point
objects and reduces the clutter on the chart.
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Vector Styles
 
Vector styles control how points, lines, areas and labels will be rendered on the display. SonarWiz support for
styles is based on rendering S57 nautical charts. In this format, every point, line or area is classified by type
(for example, city, island, pipeline, etc.). Each type of point, line or area can have its own drawing style.
 
Vector maps that are not in S57 format will not have an associated type for each object. Use the Unclassified
Point Features type, Unclassified Line Features type or Unclassified Area Features type to modify the
drawing style of these objects.
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Point Styles
 
The command Maps | Styles | Points... opens the Point Styles dialog
 

 
You can modify the symbol, color and label font for each point type in the map. Use the Unclassified Point
Feature type to modify points that are not stored in S57 format (for example points stored in Shapefiles).
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Line Styles
 
The command Maps | Styles | Lines... opens the Line Styles dialog
 
 

 
Lines styles consist of line width, color and a number of line styles (solid, dots, dashes, etc). An example line is
drawn using the selected style settings. Use the Unclassified Line Feature type to modify the drawing style of
lines that are not stored in S57 format (for example lines stored in Shapefiles).
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Area Styles
 
The command Maps | Styles | Areas... opens the Area Styles dialog
 

 
Area styles consist of both a border line and the area pattern. Use the Unclassified Area Feature type to
modify the drawing style of areas that are not stored in S57 format (for example lines stored in Shapefiles).
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Network Map Servers
 
SonarWiz supports the downloading and caching of vector and raster data available via network map servers.
  SonarWiz can connect to the map server, download the requested map layer, project the layer into the project
coordinate system and display the layer like a local map.
 
To add online data as a Basemap or Overlay:
 

1. 

 

Open the Map Manger using Maps | Map Manager  button.
In the Reference Map Manager dialog, click the Add Online Map... in the BASEMAPS group to add the data
as a Basemap or click Add Online Map... in the OVERLAYS group to add the layer as an Overlay (Basemaps
are best for raster data, Overlays are best used for vector data).

 
2.  In the Select Online Data Source to Download dialog, select a previously defined data source or click the
Add New Source button to add a new map server.
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3.  If Adding a New Source, Select the Online Source Type. SonarWiz currently supports WMTS, REST, OSM,
TMS, WCS, WFS, WMS, and WMTS map server formats.

 
4.  Enter the Server URL, the Server Name and click to Get List of Available Data Layers to ensure that the
connection is working. You should see the list of available data layers displayed if the connection is working.
When you are satisfied the connection is working, click OK to add the new data source to SonarWiz.
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5.  Back in the Select Online Data Source to Download dialog, you should see the newly added data source
at the end of the Data Sources list. Left-click the source to select it.

 
6.  Use the Select Area to Download section to define the geographic region SonarWiz will use to request
data from the map server. The default behavior is to request data sufficient to cover the current map window.
Other options are to specify an address (if the server supports address lookup), a radius of data about a point,
or simply enter the geographic bounding box directly.
 
7.  The display options group controls the Resampling Method used when rasters need to be reprojected
into the project coordinate system. The Level of Detail control prevents SonarWiz from downloading high-
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resolution tiles of the data if these are not needed. Finally, the Restrict Source to Select Bounds will prevent
SonarWiz from re-querying the map server if the map is panned beyond the original data bounds.
 
8.  Click Connect to add the new map server layer to the project. From this point forward, the layer will be
treated like a local basemap.

 
9.  Click OK to close the Reference Map Manager and begin loading the data
You should now see the new online map server data source listed as a Map in the Project Explorer. 
SonarWiz will begin downloading the data to the map cache and display the map tiles as they are made
available.
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NOTE: That live connections to network map servers can dramatically slow the update speed of the Map
Window as SonarWiz communicates with the server over the network. You can avoid this overhead by
converting the down loaded data into a GeoImage by using Post Processing | Export | Save Project As
GeoImage tool and then reloading the GeoImage instead of the live data connection.
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Map Manager
 

The Reference Map Manager can be opened by selecting  from the Maps Ribbon Menu, by using
the hot keys CTRL+SHIFT+B, or Right-Clicking anywhere in the Maps section of the Project Explorer and
selecting Map Manager ... from the context menu. The Map Manager is used primarily to list all loaded maps
and overlays such that they can be enabled or disabled for map display. Notice that the Map Manager has all
the map controls within it that are also in the Maps Ribbon Menu with the exception of Create S-63 Permit
File.
 

 
 

Maps List
The maps list section displays all of the loaded basemaps and overlays in the project. The list displays
the layer filename, the map type, and the selected drawing color for vector maps. You can also control
whether the layer is enabled (visible) or hidden. The user can change the drawing color of vector
layers by clicking the color name to open the color list drop-down.
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Basemaps Section

The basemaps section allows you to add Basemaps, GeoImages and Online maps that will draw
underneath project data (see Basemap Command Group and Online Maps for more information).

Overlays Section

The overlays section allows you to add vector and raster overlays that will draw on top of project data
(see Overlays Command Group and Online Maps for more information). In addition, you can create
an S-63 Permit File needed when ordering restricted ENC charts sold by some vendors in Japan and
other locations.

Vector File Controls Section

The vector file controls section controls the display of vector points, lines, areas. You can control
whether a feature type is drawn or not and the drawing style used for display.
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Remove Layer

This button will remove a layer from the SonarWiz project but does not delete it from disk.
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Add a Basemap
 
The Add Basemap command opens a dialog for importing a basemap into the SonarWiz project. Basemaps
are drawn beneath the sonar data in the project. See Basemaps and Geoimages for more information.
 
The Add Basemap dialog can be opened in several ways:
 

1. Clicking the  icon in the Maps Menu.
2. Selecting Add Basemap(s) from the Maps Context Menu in the Project Explorer
3. Clicking the Add Basemap... button in the Map Manager.
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Add a GeoImage
 
The Add Geoimage command opens a dialog for importing a geoimage into the SonarWiz project. GeoImages
are drawn beneath the sonar data in the project. See Basemaps and Geoimages for more information.
 
The Add GeoImage dialog can be opened in several ways:
 

1. Clicking the  icon in the Maps Menu.
2. Selecting Add Geoimage from the Maps Context Menu in the Project Explorer
3. Clicking the Add Geo Image... button in the Map Manager.
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Add a Overlay
 
The Add Overlay command opens a dialog for importing an Overlay into the SonarWiz project. Overlays are
drawn on top of the sonar data in the project and are usually vector files, though raster formats are supported.
See Overlays and Shapefiles for more information.
 
The Add Overlay dialog can be opened in several ways:
 

1. Clicking the  icon in the Maps Menu.
2. Selecting Add Overlay from the Maps Context Menu in the Project Explorer
3. Clicking the Add Overlay... button in the Map Manager.
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Add Legacy Shapefile
 

The Add Legacy Shapefile command adds an ESRI Shapefile vector overlay to the project. Coordinates in
the file can be in any coordinate system. SonarWiz will prompt for the coordinate system if necessary. The Add
Legacy Shapefile command can be opened in several ways:
 

1. Click the  icon in the Maps menu.
2. Select Add Legacy Shapefile from the Maps Context Menu in the Project Explorer.
3. Click the Legacy Files... button in the Map Manager.

 

Input Shape File

Enter the full path the shapefile to import

Coordinate System

Specify the coordinate system of the shapefile.
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File Bounds

Once a file is selected, The shapefile extent will be displayed in this dialog

Color

Set the line color for drawing the shapefile

Labels

Toggle check box to label the shapefile using the specified field.

Line Width

Set the line width for display.
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Data Acquisition
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Select Sonar Interface
 

The Select Sonar Interface... window is opened by clicking on Data Acquisition | Sonar.
 
In order to connect SonarWiz to a sonar, the specific Sonar Server must be started. Launching a local server
or connecting to a remote server is accomplished in the Select Sonar Interface window.
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Current Servers

The Current Servers section displays the currently connected Sidescan, Subbottom and Bathymetry
servers (you can connect to one of each). To disconnect from the server, click the Disconnect button
next to the server you want to remove.

Local Servers

The Local Servers section will allow you to select and launch servers installed on the local computer
(See Installing SonarWiz Server Modules for more information). Although you can be licensed for
many servers of each type, you can only activate one Sidescan, one SubBottom and one Bathymetry
server at a time.

 
To activate a Sidescan, SubBottom or Bathymetry server, select its name from the appropriate list so
that it populates the top row and click Start/Configure.  SonarWiz will launch the indicated server in
another process.
 
If you wish to automatically start the selected server every time SonarWiz is opened (for example after
a power drop), check the AutoStart button next to the server you want to relaunch.

Remote Servers
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If the servers are not located on the local machine but are accessible via the network. You can
connect to the remote servers using Connect button

Write raw sonar data

In real-time mode, SonarWiz will record data directly into its own intermediate formats (See What
Happens When a File is Imported?). In some cases, SonarWiz servers support recording the
manufacturer's format in addition. Use this check box to turn on this capability. You will need to consult
with the Server-specific documentation to see if your server supports raw sonar data recording.
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Navigation Input Setup
 

The Navigation Input Setup window is opened by selecting Data Acquisition | Navigation. This interface is
used to set up a serial or UDP (Ethernet) port to receive position fixes via the worldwide standard NMEA-0183
protocol or other protocols listed below.

 

Source and Port Selection

 
Enable Nav IO
A check in this box enables incoming navigation messages to be received and parsed either via serial
or Ethernet communications.

 
Navigation Source
SonarWiz accepts navigation in 26 message formats (See Supported Navigation Formats)
Serial Port
Select the serial input and identify the COM port for communication
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UDP Port
Select Ethernet input via User Datagram Protocol (UDP) and identify the port for communication

Serial Port Configuration

Configure the serial port communication protocol. The NMEA-0183 interface standard is 4800 baud,
eight (8) data bits, no parity, and one (1) stop bit; "4800,8,None & 1" for RS-232 experts. Refer to the
user guide of your Navigation Unit in order to determine/configure the navigation data being passed to
SonarWiz via the serial cable.

Fish Position

When checked, SonarWiz will compute and record the position of the towfish in the raw XTF file based
on the layback configured in the Sonar Layback Configuration window.

Navigation Coordinate System

Configure the navigation coordinate system.

NMEA Record Types

Select the NMEA Position and Heading sentence. Only the listed messages are supported.
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Miscellaneous Output Files

When checked, SonarWiz can record the navigation data stream in Raw Navigation format (NAV) and/
or Formatted Navigation File format (FNV)  See Supported Navigation Formats for details).
 
The files will be stored in the project Sensors sub-directory. By default this is the XTF folder of the
SonarWiz project but maybe customized by the user.  Recorded file names automatically use the
same name as the active XTF or SEG-Y file if sonar recording is active. If sonar recording is not active
but a survey line is currently active for steering, the files will be named with the survey line name. If
neither of the above are true, then the file will be named named ddMMMYYYY.FNV, where dd is 2-digit
day of month, MMM is 3 letter month abbrev like "JAN", "FEB", etc and YYYY is 4 digit year. 

Miscellaneous Settings

Use SonarWiz Computed Speed/Course
When checked, SonarWiz will use the speed calculated and passed by the Navigation Source.
Only available with the following source messages:
NMEA-0183, GeoWork/Trimble, GeoWork/Trimble PRO, Capital Signal – Eiva Lat/Lon, Capital Signal
– Eiva X/Y, C and C Technologies, C and C Technologies Klein 5000, GeoNav
 
Validate NMEA Checksums
When unchecked allows the user to ignore NMEA checksum values and still attempt to parse the
payload of the NMEA sentence even if the checksum is invalid. If your messages are not being
accepted, give it a try with validation turned OFF, and it may work just as well.

Navigation Sensor Offset

Not currently implemented.
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Magnetometer Setup
 

The Magnetometer Setup window is opened by selecting Data Acquisition | Magnetometer. This interface
is used to set up a serial connection to receive magnetometer data .

 

Magnetometer Type and Port Selection

Enable Serial IO
Enable the Magnetometer input by left-clicking and populating this check-box with a check-mark.
Select the COM port where the the navigation device has been connected to the PC.
 
Magnetometer Type/Data Format
Select the type of magnetometer connected to the SonarWiz PC and the data format being output
from that magnetometer
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Serial Port Configuration

Serial Port Configuration
Serial Port setup for the Magnetometer is the same process as for the serial port setup for the
Navigation Input Setup window. Refer to the user guide of your Magnetometer in order to determine/
configure the data being passed to SonarWiz via the serial cable.

Output File Format

A separate data file containing the raw magnetometer data may be saved to the project XTF folder.
The format of the .MAG data file may be in one of three formats:
•  Comma Delimited
•  Space Delimited
•  C&C MAG format

Navigation Sensor Offset

Currently not implemented.

Time stamp recorded data with...

Allows the user to time stamp local time or UTC time to the raw data files.
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Motion Sensor Setup
 

The Motion Sensor Setup window is opened by selecting Data Acquisition | Motion Sensor. This interface
is used to set up a serial connection to receive motion data.

 

 

Enable Serial IO

Enable the Motion Sensor Serial input by left-clicking and populating the check-box with as check-
mark.
Select the COM port where the the navigation device has been connected to the PC.

Serial Setup
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Serial Port setup for the Motion Sensor is the same process as for the Navigation Input Setup window.
Refer to the user guide of your Motion Sensor in order to determine/configure the data being passed to
SonarWiz via the serial cable.

Motion Sensor Format

Select the type of Motion Sensor connected to the SonarWiz PC or the data format being output from
that Motion Sensor. SonarWiz is able to interface and record the following motion sensors:
•  All serial motion sensors sending TSS01 Datagrams
•  iXsea Octans installed in the Teledyne Benthos C3D
•  Any device outputting the NMEA VTG message 

Output Files

Separate data files containing the raw motion sensor data may be saved to the root project folder.
Record Motion Sensor Data in Separate File
A single file with the name <xxMonyyyy.IMU> will be created where xx is the date, Mon is the first
three characters of the Month and yyyy is the year. This single file will be appended with whenever a
sonar file is being written 
 
The format of the file is ASCII with each row representing one record. Columns are are follows:
 
Date Time Ship Latitude Ship Longitude Raw message
 
Record Time, Pos, Motion Data
A file with the name <name.IMU> will be created where name is the same as the sonar file name
being recorded. i.e. there is a separate IMU file for each sonar data file.
The file format is the same as that discussed in the preceding paragraph 

Heading override

When selected the heading from the motion sensor will be used instead of the heading from the
Navigation message.
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Sonar Layback Configuration
 

The Sonar Layback Configuration window is opened by selecting Data Acquisition | Cable Payout.
This interface is used to set up a serial connection to receive motion data. This section discusses how to
configuring SonarWiz to log the values required to calculate layback. The actual layback calculation will be
discussed in Layback & Offsets.

 

Compute Towfish Position

When the check-box is populated it tells SonarWiz to use the values from this dialog to calculate
layback. This check-box is a repeat of the same option located in the Navigation Input Setup window.

Sheave Offset

Record the X (positive to starboard) and Y (positive forward) offset from the GPS antenna to the
sheave.

Sheave Height

Record the height of the sheave above the sea surface.



Sonar Layback Configuration

744

Cable Out Source

           Select the cable meter source.
            Manual Entry Selecting this option requires the operator to manually input the cable out value in the
Manual Entry Box.

 
Cable out From Nav Interface
Navigation interfaces such as HYPACK and FGSI contain the cable out information which SonarWiz is
instructed to observe with this selection.
 
Payout Meter
Open the Payout Meter Configuration window

Sensor Depth Source

Select the sensor depth source.
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Payout Meter Configuration
 

The Payout Meter Configuration window is opened by selecting Data Acquisition | Cable Payout | Payout
Meter Select/Configure. This interface is used to set up a serial or UDP connection to receive the Payout
Meter data.

 

Meter Type

Select the cable meter type. SonarWiz supports.

Cable Offset

A fixed amount of cable to add or subtract from the Payout Meter reading. The most likely scenario
where this field would be populated would be where the tow fish is at the waterline but the meter does
not read zero. The Cable Offset would be added to the meter reading to make the resultant cable out
value zero.

Scalar

The Counter Scalar is the product of two variables:
 
Variable A: Conversion to meters: For example, if the counter outputs its values in feet then the first
variable would be 0.3048
 
Variable B: Cable Diameter correction: The diameter of the cable used on the sheave may be such
that it does not sit completely in the well of the sheave. In order to verify this value, pay out a (hand)
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measured amount of cable (100 meters) and read the counter value. If the value is anything other than
the measured value a scalar must be applied.
 
For example of the measured amount was 100 meters but the counter read 110 meters the second
variable would be 1.1
Scalar = A * B In this example the scalar would be product of 0.3048 and 1.1, namely 0.33528

Caternary Coefficient

An estimate of the along-track distance correction factor due to the depression angle of the tow cable
and the curvature. The figure below illustrates the effect that the curvature in the tow cable (centenary)
can have on the estimate of the towfish along-track offset.
 

 
Estimating the catenary coefficient is a matter of experience for a particular cable, towfish, speed
and area and best derived through layback corrections applied in post-processing. If the catenary
coefficient is not known, leave the default value of “1” and adjust for catenary effects in post-
processing (see Layback Percentage).
 
The catenary coefficient does not affect the recorded cable-out value i.e. regardless of the catenary
coefficient value if there are x meters of cable out then x will be stored in the raw data file.
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Communications Configuration

Cable meter data can be received via Serial or UDP.  Select the appropriate setting here and configure
the port settings as required.

SSI Layback

Enter the sheave circumference and the number of magnets.
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Output Device Setup
 

The Output Device Setup window is opened by clicking on Data Acquisition | Outputs. The Output Device
Setup window is used to configure the sending of ASCII information over serial or UDP ports. You can select
either a standard NMEA datagram message or you can create a custom message using only the fields you
need to receive. It is possible to add as many output devices as you need and to send the messages at
specified intervals.

 

Output Devices

Add a new output device, delete a device or copy the settings from an existing device.

Device Name

Set the name of the output device.
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Device Settings

Set and configure the output device to use either Serial or UDP. Set the Transmit interval and
optional Starting condition.  Toggle the Enable Output check box to start message transmission.

Standard Datagram

Set the output message datagram to one of the provided options or Custom.
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Custom Datagram

You can create a custom output message by adding  or removing  the required fields to the
Output Fields window. Change the output order of the fields with the  keys.

Example Output String

After selecting standard or custom datagram, an example string will be presented in the Output String
window.
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Survey Line Manager
 

The Manage Survey Lines window (Line Manager) can be opened from the Data Acquisition Menu | Line
Manager.... The Line Manager provides tools for editing the survey plan, tools for exporting and importing
survey plans, tools for controlling how the survey lines will look in SonarWiz and commands for communicating
with the Helm Display.
 

 

 

Survey Line Summary

The Line Summary displays the number of lines and total linear distance of lines in the project.

Survey Line Table

The survey line table shows the Name, location, length and bearing of lines in the survey plan. You
can enable or disable lines with the toggle check box.
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Drawing

Controls the color and labeling of survey lines in the 2D plan view drawing. Optionally add a lane
tolerance indicator around the lines with a specified distance in meters. Lines can be labeled at the
Start of Line (SOL) or end of line (EOL) using the selected font size.

Line Groups

Survey lines can be grouped where they can be managed more easily.

File Options

The survey plan can be exported as a text file from SonarWiz and imported into another instance of
the program.

Helm Display

The survey plan can be transmitted to the Helm Display over a network connection.

New Line

Add a new line and open the Survey Line Editor window.
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Edit Line

Edit a selected lines and open the Survey Line Editor window.

Delete Line

Delete the selected lines.

Reverse Line

Reverse the bearing of the selected lines.

Steer Line

Steer the selected line.

Survey Time

Open the Survey Time Estimator window.

Select All

Select all of the lines in the project.

Cancel

Close the window without performing the current operation.

OK

Accept the results and close the window.
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Survey Line Editor
 

The Survey Line Editor window can be opened from the Line Manager window by selecting a survey line and
clicking Edit Line(s)... button. The Survey Line Editor window allows the user to control the starting and ending
point of the line and how the line will be displayed in the main SonarWiz window.
 

 

Line Name

Enter the survey line name (must be unique).

Starting Y

Enter the starting Y coordinate (X/Y Mode) or the starting latitude (Lat/Lon Mode).

Ending Y

Enter the ending Y coordinate (X/Y Mode) or the starting latitude (Lat/Lon Mode).
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Starting X

Enter the starting X coordinate (X/Y Mode) or the starting longitude (Lat/Lon Mode).

Ending X

Enter the starting X coordinate (X/Y Mode) or the starting longtude (Lat/Lon Mode)

Range

Enter the line length in survey units.

Bearing

Enter the line bearing in degrees east of north.

Run-in

Extend the line beginning a sufficient amount for the vessel to line up before the actual start of the line
(SOL).

Run-out

Extend the end of the line a sufficient amount for the tow fish to pass beyond the end of the actual end
of line (EOL) before the vessel turns.

Line Style

Select the line style.

Line Color

Select the line color.
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Line Thickness

Select the line thickness.

Edit Mode

Select the edit mode between X/Y (grid easting and grid northing) or Lat/Lon (geographic latitude
and longitude). Changing this setting will change also convert the starting and ending position from
(easting, northing) to (latitude, longitude).

OK

Accept the changes and close the window.

Cancel

Close the window without making changes.

Reverse

Reverse the direction of the line.

Clone...

Make a copy of the line.
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Survey Time Estimator
 

The Survey Time Estimator window is opened from the Line Manger by clicking the Survey Time button.
The Survey Time Estimator computes the total time needed to run a survey plan at a given ship speed and
reports the results to the display pane. Alternatively, it can report the results to a CSV file.

 

Survey Speed

Enter the estimated survey speed in knots.

Turn Time

Enter the estimated time for turns in seconds.

Select All

Select all survey lines in the project.
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Survey Line List

Toggle the individual lines to include in the time estimate.

Survey Time Results

The estimated survey time is reported including a break down of how much time is spent on line and in
turns.

Cancel

Close the dialog.

OK

Close the dialog.

Report...

Generate a CSV report of the survey time estimate. The report makes one record entry per line.
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Line Tools
 

The Line Tools drop down menu can be opened from the Data Acquisition Menu | Line Tools  button.
The Line Tools menu provides access to a list of tools for working with survey lines. SonarWiz can assist you in
planning and conducting your sonar survey using several tools for laying out preplanned track-lines or survey
lines. Survey lines constructed using these tools are stored as part of the project. During the survey, the Left-
Right Steering Indicator bar can be used to help steer a consistent course along the survey lines.
 

 
Command Description

Cut selected lines Cut the selected survey line to the
clipboard

Copy selected
lines

Copy the selected survey line to the
clipboard

Paste selected
lines

Paste the survey line in the clipboard
to the Map Window

Build Line Set
Around Contact

Automatically create a set of offset
survey lines around a contact in the
Map Window. See Build Line Set
Around Contact for more information.

Draw Survey
Route Using
Mouse...

Used to draw a group of connected
lines with zero or more lines parallel
to the center track-line. See Survey
Route for more information.
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Edit Selected
Line...

Opens the Survey Line Editor dialog
for the line(s) currently selected line
in the Line List.

Delete Selected
Line

Delete the selected survey line

Steer the
Selected Line

Activates a survey line that is desired
to be followed by the helmsman with
assistance from the program.

Generate Lines
Parallel to
Selected Line...

See Generate Parallel Lines for more
information.

Lock Survey
Lines

Prevents on-screen (graphical
editing).

Reverse Survey
Lines

Switches the Starting and Ending
points of the line which is equivalent
to adding/subtracting 180 degrees to/
from the Bearing value.

Select Next
Survey Line

Makes the next sequential survey
line active in order to be the the
reference line for the Steering Left
Right Indicator.

Select Previous
Survey Line

Makes the previous sequential
survey line active in order to be the
the reference line for the Steering
Left Right Indicator.

 



Build Line Set Around Contact

761

Build Line Set Around Contact
 

During a survey it may occur that a contact of interest requires further investigation. SonarWiz allows the user
to automatically create a set of offset survey lines around a contact in the Map Window .
 
To open the Build Line Set Around Contact dialog the user may:
 
1.     Left-click the Build Line Set Around Contact selection in the Line Tools Drop Down Menu
 
2.     Right-click the selected target in the Map Window and select Build Line Set Around Contact
 

 
3.     Pressing the Hot-keys Ctrl+Shift+A

 
The user is presented with the name of the currently selected contact. The lateral Distance Off Target and the
Line Length (in meters) is entered by the user. For the example above the result is shown below.
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Draw Survey Route Using Mouse
 
 
A route is a group of connected lines with zero or more lines parallel to the center track-line. Routes are useful
for harbor surveys where multiple parallel lines are required for harbor clearance.
 
1.     To begin drawing a route, select the Draw Route Using Mouse option from the Line Tools context menu.
2.     Left click on the map where the route should start and continue to add left click points at the endpoints of
each segment of the route. It is not necessary to hold the mouse button down while drawing a route.
3.     When you have drawn all of the segments press the right mouse button and the dialog below will be
displayed. Note as well that the Group Icon appears (See Grouping Lines)
 

 
4.     Use this dialog to specify how many lines to construct parallel to the line just drawn (the root line).
5.     You may also specify distance between lines, and the location of the constructed lines relative to the root
line.
6.     The constructed lines will be given names consisting of the base name specified followed by a sequence
number, Followed by the letter R or L to indicate whether the line if left of right of the root line.
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Generate Parallel Lines
 
The Generate Parallel Lines option is used to select a line to be “cloned” with parallel survey lines.
 

Root Line

The name, range, and bearing of the selected line to be cloned.

Base Name

User-entered line name which serves as a prefix to the new lines and their numbers to be generated.

Number of Lines to Generate

User-entered value indicating the number of new lines to be created parallel to the Root Line.
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Spacing Between Lines

Spacing (in project units) between lines.

Use Efficient Survey Pattern (MCM)

      SonarWiz uses an efficient survey line pattern that reduces the time required to cover the same area
by over 40% by using the Efficient Survey Pattern formula, which can be found by simply calculating the
interline distance          required base on the sonar range, maximum planned altitude and the overlap
(helmsman's accuracy) and enter that number in the Spacing Between Lines fields.
     
      For example, Minor Distance = 75m – (10m + 10m) = 55m Major Distance = 2 x 75m – 10m =
140m will result in this survey pattern.

      

     

Efficient Survey Pattern Line Spacing

      User-entered fields which need to be calculated by the interline distance required base on the sonar
range, maximum planned altitude and the overlap (helmsman's accuracy). See Efficient Survey Pattern
above for more         information.
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Direction of Generated Lines

Set the direction where X (number of lines) will be generated.

Perpendicular Line Spacing

If the Perpendicular option is selected in the direction of generated lines section, these user-entered
fields adjusting the port and starboard side length in project units is enabled.
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Line Hotkeys
 
The <CTRL> and <SHIFT> keys assist the user to create and modify survey lines in an efficient and intuitive
manner. Pressing and holding the <SHIFT> key while creating or modifying a survey line or group of lines
causes the line to snap to bearings in 15 degree increments based on 000 as the starting point. Pressing and
holding the <CTRL> key while the cursor is hovering over the end-point of a line, or pivot point in a group of
lines causes the line or group of lines to rotate about the center point.
 
Pressing and holding the <CTRL> and <SHIFT> keys together while the cursor is hovering over the end-point
of a line, or pivot point in a group of lines causes the line or group of lines to rotate about the center point in 15
degree increments.
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Grouping Survey Lines
 
Survey Lines may be grouped together in order to perform line edits to more than one line at a time.
 
To group 2 or more lines, left-click and select the first line of the desired group and then hold the <CTRL> key
while left-click selecting one or more additional lines. The Group Icon will appear as soon as a second line is
selected ( see digure below). The Group Line Context Menu will appear if multiple survey lines are selected
and the user right-clicks the Map View.
 

 
To modify groups of survey lines:
 
#       To move the entire group, without changing any line rages or bearings, left-click and drag the group while
the 4-headed arrow cursor is visible
#       To stretch or compress in either the X or Y axis, without affecting the other axis, left-click and drag either of
the two X axis nodes or either of two Y Axis Nodes.
#       To stretch or compress in the X and Y axis left-click and drag any one of the four X/Y Axis nodes. Holding
the <SHIFT> key on any of the corner nodes scales the lines equally in the X and Y directions
#       To rotate the entire group left-click and drag the rotate node. Holding the <SHIFT> key while rotating the
group constrains the line group bearings to 15 degree increments.
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Build Line in Selected Feature
 
The Build Survey Lines in Selected Feature tool is used if a closed Feature or Rectangle has been created
(See Polygon Feature), survey lines may be generated inside that feature. This is useful for automatically
creating survey line within an irregular area such as a marina or harbor.
 

 
To create survey lines within a Feature:
 
1.     Center on the feature in the Map Window
2.     Right click on the Feature border to open the Feature Context Menu.
3.     Select Build Survey Lines in Selected Feature to open in the dialog.
4.     Fill in the boxes in the dialog with the appropriate information. See Generate Parallel Lines for more
Information.
5.     Click OK and results similar to those shown in the figure below.
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Configure Real-time Mosaic Options
 

The Configure Real-time Mosaic Options window is opened by clicking on the Real-time Mosaic icon

 in the Data Acquisition Menu. The Configure Real-time Mosaic Options window is used to control
how sidescan and bathymetry data will appear on the Map Window during data acquisition.

 

Sidescan Mosaic Options

Select to turn on mosaicing of sidescan data. You have the option to display ALL lines collected or
select the number of previous lines to display in the real-time mosaic. The recommended setting of 2
previous lines works well for most computers. More powerful computers can display more lines.

Sidescan Channel to Mosaic
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Select the channels to mosaic. Single frequency systems and the low frequency for dual-frequency
sidescan systems are usually mapped to Channels 1 and 2, while the high frequency data of dual-
channel systems is mapped to chanels 3 and 4.

Project Sidescan Beams Using...

Sidescan beams are projected perpendicular to sonar bearing. You can determine the sonar bearing
using the Course Made Good or use the internal heading sensor on the fish (if installed).

Bathymetry Mosaic Options

Select to turn on mosaicing of bathymetric data. You have the option to display ALL lines collected or
select the number of previous lines to display in the real-time mosaic. The recommended setting of 2
previous lines works well for most computers. More powerful computers can display more lines.

Real-time Bathymetry Grid

Set the cell size of the real-time mosaic grid. The cell size should be appropriate to the beam-to-beam
spacing of your data and the capabilities of your computer system to display large data sets.
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Real-Time Sidescan Sonar Gains
 

The Real-time Sidescan Sonar Gains window is opened from the Sidescan... icon  on the
Data Acquisition Menu. Real-time Sidescan gains are exactly the same as post processing gains with one
exception: if the user has a dual-frequency sonar the user must specify via radio button which channels are
being adjusted.
 

Select Sidescan Channels

Select the sidescan channels you wish to adjust. Single-frequency and the low frequency of dual-
frequency sidescan sonars are usually mapped to Channels 1 & 2 by SonarWiz; the high frequency of
a dual-frequency system is usually mapped to Channels 3 & 4.

AGC
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Enable AGC signal processing. See Automatic Gain Control (AGC) for more information.

Auto TVG

Enable Auto TVG signal processing. See Automatic Time-Varying Gain (TVG) for more information.

EGN

Enable EGN signal processing. See Empirical Gain Normalization (EGN) for more information.

UGC

Enable UGC signal processing. See User-Defined Gain Controls (UGC) for more information.

Project Sonar Beams Using...

Sidescan beams are projected perpendicular to the sonar heading. You can determine the sonar
heading from the course made good or by using the internal heading sensor if installed. See Beam
Angle Correction for more information.

OK button

Accept the current settings and close the dialog

Save... button

Save the current settings to a settings configuration file

Apply button

Apply the current settings to the real-time data without closing the window

Load... button
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Load a settings configuration file.
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Real-Time Subbottom Sonar Gains
 

The Real-time Sub-bottom Sonar Gains window is opened from the Sub-bottom... icon  on
the Data Acquisition Menu. Real-time Sub-bottom gains are exactly the same as post processing gains with
one exception: if the user has a dual-frequency sonar the user must specify via radio button which channel is
being adjusted.
 

Select SBP Channel

Select the SBP channel you wish to adjust. Single-frequency and the low frequency of dual-frequency
sub-bottom profilers are usually mapped to Channels 1 by SonarWiz; the high frequency of a dual-
frequency system is usually mapped to Channels 2.

Open Band Pass Filter

Open the Bandpass Filter



Real-Time Subbottom Sonar Gains

779

AGC

Enable AGC. See SBP Gain Settings

Auto TVG

Enable Auto TVG. See SBP Gain Settings.

Blank Water Column

Enable blanking of the water column. See SBP Gain Settings

Enable Stacking

Enable trace stacking. See Stacking for more information.

Enable User Defined Gain

Enable user gain controls (UGC). See SBP Gain Settings.
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Real-time Altitude Tracker
 

The Real-time Altitude Tracker window is opened from the Bottom Tracker... icon  on the Data
Acquisition Menu. Real-time. Activating this control allows the user to select whether or not and how Bottom
Tracking on the Waterfall display is performed.

 

Enable Auto Tracker

Check to enable real-time bottom tracking.

Select Channel

 
Select Sidescan (SSS) or sub-bottom profiler (SBP) and then select the appropriate channel to track
(port or starboard for sidescan, channel 1 or channel 2 for sub-bottom).
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Tracking Algorithm

Select either the threshold detect algorithm (see Sidescan Bottom Tracking) or use the Homomorphic
algorithm.

Tracker Settings

   
There are three parameters available for the Threshold Detect algorithm:
 

Parameter Description
Theshold Ranges from 0 to 100. How much brighter must the bottom

pixels be than the water column? If this setting is too low,
you may find the bottom track floats above the seabed. If this
setting is too high, the bottom track will appear to penetrate
the seabed

Blanking Meters Do not start the search for the bottom inside the blanking
distance from the sonar.

Duration The number of pixels that must exceed the threshold for a
bottom pick to succeed. Higher numbers here can reduce the
effects of noise and false-targets in the water column.

 
There is only one parameter for the Homomorphic algorithm:
 

Parameter Description
Blanking Meters Do not start the search for the bottom inside the blanking

distance from the sonar.

Smoothing

Apply a low-pass filter to the bottom track. This can remove small jumps in the bottom track due to
noisy data.

Manual Controls

Shows the current setting of the manual bottom tracker (see Waterfall Display). A set value of the
towfish altitude may be entered in this box. Holding the Shift Key while left-clicking the waterfall at the
range where the user wishes to mark the first bottom return will result in an altitude value being set.
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Apply button

Apply the current settings to the real-time waterfall windows. A small asterisk will indicate that the
settings need to be applied before closing the window.

Altitude Source

Select the altitude source for bottom tracking. Telemetered (from the sonar system), altitude from file
(play back only) or trace detected bottom (uses the settings in this window).

Trace Color

Select a contrasting color for the bottom trace line.
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Eventing Setup
 

The Real-time Eventing window is opened from the Event Setup... icon  on the Data Acquisition
Menu. The Eventing Setup dialog is used to determine how events are generated and what is to be annotated
when an event occurs (if desired).
 

Event Trigger

Events are triggered via the navigation system (see Navigation Input Setup window) or they can be
generated at a specified time interval.

Next Event Number

Events are numbered sequentially starting from the supplied number.

Print Event Interval

By default every event is marked on screen, if you wish to skip printing events, set an interval here.
Regardless, all events are logged.
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Annotate Events

If checked, events will be displayed and printed. They are always logged.

Event Source

This read-only window indicates where SonarWiz is looking for events triggered by the navigation
system. See Navigation Input Setup window.

Annotation Options

If event printing is enabled, select the fields you want displayed.

Beep on Event

If checked, beep on event.
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Add Logbook Entry
 

The Add Logbook Entry window is opened from the Add Logbook Entry... icon  on the Data
Acquisition Menu. The logbook is a simple text file stored in your project folder that annotates each text entries
with time, position and other ships' information. Each log entry indicates the time and position of the start of the
entry and a time and position of the end of the entry, thus it is possible to log events that span time or distance.
 

Current Entry Values

The current entry value bar will show the current date, time and vessel position. When you click Add, the
current values shown here will be added to the logbook in the End of Entry fields.
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Text Entry Box

A free-form text entry box which to type your log entry.

Add a logbook entry

When you click Add, the Start of Entry and End of Entry times and positions are recorded along with
heading, course, speed and the text log entry.

Cancel logbook entry

Close the window without making a log entry.

Edit Logbook File

The logbook file is a simple text file with the name <Project Name>-logbook.txt and located in the
root of your project folder. Clicking this button will open the log file in your default text editor.
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Waterfall Display
 
The Waterfall Display is opened by clicking View | Data Acquisition Views | Waterfall from the View Menu.
The Waterfall Display is a stand-alone window that presents real-time or playback sonar information in a
waterfall display. This window allows the user to see all sonar channels simultaneously in either Horizontal or
Vertical View Modes. 
 

 
The Waterfall Display in Floating Mode is especially useful where two or more monitors are in use, thus
allowing the Main Window to show the Mosaic on one monitor and the Waterfall Display to display the full
resolution sonar imagery in the other.
 
To open a file or files for playback open the File Playback window. 
 

Waterfall Toolbar

See Waterfall Display toolbar for more information.

Replay File Information
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Replay file information section indicates the starting ping and time, the ending ping and time and the
current position in the file. The Slider can be used to slide the data to the desired location. (See File
Playback for more opening a file for playback)

Channel Indicator

The channel indicator bar identifies the sidescan and sub-bottom channels being displayed. The sub-
bottom bar has a small percentage bar that displays the peak sample value in the latest incoming ping
as a percentage of 32768. It will turn blue if the value < 10%, green if the value < 95% and red otherwise.
Red bar indicates your data is close to clipping and you may be losing information.

Amplitude Trace

Analog scans for each pair of channels.

Waterfall Display

Waterfall display of ping data.
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Waterfall Display Toolbar
 
The Waterfall Display toolbar is located at the top of the Waterfall Display. The toolbar allows for controlling
the display. Note that SonarWiz disables the use of the rewind and fast forward controls when an XTF file is
being replayed into a mosaic (see File Playback)
 

 
 

Command Description

Play the active (open) file

Pause the active file

Stop the active file

Rewind to Start of active file

Rewind 10% of active file

Rewind 1% of active file

Fast Forward 1% of active file

Fast Forward 10% of active file

Opens the Jump Playback to Location window

Save a screen-shot of the current Waterfall Image to
the project folder.

Opens the Waterfall Settings window

Left-clicking this button turns the cursor into cross-
hair and allows the user to left-click to create a new
contact. Double-clicking in the Waterfall window has
the same effect as selecting the Capture Contact
button and left-clicking to create a new contact.

Open the Real-time Altitude Tracker window

Display Information Dialog
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Waterfall Display Context Menus
 
The Waterfall Display has two context sensitive menus accessed by right-clicking the mouse in the upper
information section, or in the waterfall data section.
 
Waterfall Context Menu
 
The right-click context sensitive menu dialog is opened by right-clicking the Waterfall window in the top portion
(above the amplitude scan). The context menu opened in this way shows the same commands as found in the
tool bar of the Waterfall Window.
 

 
Waterfall Settings Context Menu
 
The Waterfall Settings context menu is opened by right-clicking the in the main portion of the Waterfall window
(i.e. on the data). The following functions are opened from this window:
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Command Description

Towfish Altitude
window

Opens the Towfish Altitude window

Adjust SSS Gains... Opens the Sidescan Gain Controls
Real-time Bottom
Tracker

Opens the Real-time Altitude Tracker window

Scope Bar Opens the Scope Display
Event Parameter
Setup

Opens the Eventing Setup window

Capture Contact Performs a Real-time Contact Capture
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Jump Playback to Location window
 

The Jump Playback to Location window is opened by clicking the  icon in the Waterfall Display toolbar.
 

Jump to Ping

Enter a ping number and click the Jump to Ping button to move the waterfall to the selected ping
number. The minimum and maximum ping numbers in the file are displayed for reference.

Jump to Time
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Enter a date and time and click Jump to Time button to move the waterfall to the selected time. The
minimum and maximum time values stored in the file are displayed for reference.
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Waterfall Settings window
 

The Waterfall Settings window is opened by clicking the  icon in the in the Waterfall Display toolbar. The
Waterfall Settings Dialog is used to control the layout of the Sonar Channels as well as which channels are
displayed.

 

Horizontal option

Channels are placed side-by-side in the Horizontal View and Stacked on-top of each other in the
Vertical view.

Sidescan Channels

Select the sidescan channels you want visible in the waterfall display. Up to 4 channels can be
viewed at once.
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The Display Processed Data check box controls if raw or processed data is displayed in the waterfall.
Raw data (unchecked) is completely uncorrected. Processed data (checked) has gains applied and is
slant-range corrected.
 

Sub-bottom Channels

Select the sub-bottom channels you want visible in the waterfall display. Optionally, set heave and
swell compensation.

Heave Compensation

In real-time or playback mode, the sub-bottom profile waterfall can be heave compensated. There are
two options:
Apply Heave Compensation: if motion sensor data is available, this setting will compensate for the
measured heave.
Apply Swell Filter: this option will apply a low-pass filter to the bottom trace to remove short-period
vertical movement of the bottom track. The Swell Period setting controls the length of the filter.
Note that these options are for display of the waterfall only and do not permanently affect the data
records.  To apply swell filtering in post-processing see Swell Filter Configuration in the Sub-Bottom
Bottom Tracking Window.
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Depth Plotter
 
The Depth Plotter is opened by clicking View | Data Acquisition Views | Depth Plotter from the View Menu.
The Depth Plotter shows a real time representation of the water depth in a traditional side-scroll display.
 

High and Low Frequency Depth

Current depth value from High and Low frequency channels.

Side-scrolling Depth Chart

Bottom trace of depth scrolls to the left. Newest data is on the right.
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Towfish Altitude
 
The Towfish Altitude Window is opened by clicking View | Data Acquisition Views | Towfish Altitude in
the View Menu. The Towfish Altitude display is a real-time tool that provides a large text window for displaying
the real-time towfish altitude for the Sidescan Sonar and/or Sub-bottom profiler in project units. The altitude
window may be re-sized by left-click and dragging any edge or corner of the window to show large font for
easy viewing from a distance.
 

   
 
The Altitude Alarm Settings can be viewed by right-clicking the Towfish Altitude window.
 
- Enable Altitude Alarm: when enabled, blinks red when the upper or lower extents are met.
- Enable Audible Alarm: when enabled, makes an audible noise when the upper or lower extents are met.
Use the Alarm File drop down menu to choose the alarm noise.
- Upper and Lower Altitude Alarm: user entered minimum and maximum altitude that determines when the
alarm is triggered.
- Display Altitude Option: checkboxes to determine which Altitude value to display in the Towfish Altitude
window.
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System Information
 

The System Information Window is opened by clicking View | Data Acquisition Views | System
Information in the View Menu. The System Information window is primarily intended for real-time operations
as it displays textual information on just about every aspect of ship, towfish and sensor values.
 

 
 

Header

Header section displays static information about the project.

Toolbar

The Sensor Information window toolbar allows for enabling or disabling the header and various sensor
fields.
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Icon Description

Opens the System
Information Settings
window.
Toggles the display of
the Header section.

Displays a tool tip
explaining the purpose
of the dialog.

Sensor Readout Panel

    
The Sensor Readout Panel displays the current (real-time) value of various fields. The user can
configure which fields are displayed and the order in which the fileds are listed by clicking the settings 

 icon in the Sensor Information toolbar to open the System Information Settings window.
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System Information Settings window
 

The Sensor Information Settings window is opened by clicking the Settings  icon on the System
Information toolbar. The Sensor Information window is highly configurable.
 

Elements List
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The elements list contains all of the fields available for display in the Information Window. If a field has
a check next to its name, the field will be displayed; unchecked fields will not be displayed. You can
change the order of the fields by dragging and dropping the fields into the order desired.

Expand Advanced Options

Click this button to display the advanced options described below.

Field Style

The field style window allows you to change the display style of the selected field. First, select the
field you wish to modify in the element list and then edit the HTML <font> tag as desired. The variable
%DATA% will be replaced by the real-time data value for the selected field.

Panel Background

Use the drop-down color box to change the background of the information window.

Saved Configurations

Save and Load the information display configuration to a file.

Hide Advanced Options

Hide the advanced display options.
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Survey Line Controls Tool Bar
 

The Survey Line Controls tool bar is opened by clicking View | Data Acquisition Views | Survey Line
Toolbar in the View Menu. The Survey Line Controls Tool Bar  is used in real time to assist the user in quickly
managing predefined survey lines.
 

 
The functionality of each button is as follows:
 

Icon Description

Select Previous Survey Line

Select Next Survey Line

Steer Currently Selected Line

Toggle Left Right Steering Indicator On/Off

Reverse Currently Selected Survey Line

Delete Currently Selected Survey Line

Resize Survey Line Controls Tool Bar
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Sensor Status
 

The Sensor Status window is opened by clicking View | Data Acquisition Views | Sensor Status in the
View Menu. The Sensor Status window reports on the status of all external sensors. Sensors are listed in
the first column, whether or not they are enabled as well as their connection information (UDP/Serial) in the
second column, the age of the last received message (in msec) and the source of the sensor.
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Scope Display
 
The Scope Display window is opened by clicking View | Data Acquisition Views | Scope Display in the
View Menu. The Scope Display provides an oscilloscope-type view of a single channel of data. 
 

 
 

Channel Selector

Use the drop down menu to select the data type and channel to display.

Chart Settings

The Auto Scale checkbox automatically adjusts the range of the Y-Axis so that the signal trace chart
will always display the entire pings waveform. When Auto Scale is unchecked, you may enter your
own y-axis scaling values in the edit fields provided. The Auto Scale function has no effect on the
histogram chart.
 
The Data is Bipolar checkbox controls the interpretation of the amplitude trace data. When checked,
the signal trace chart will interpret 8-bit input values as ranging from -128 to + 127 and 16-bit input
values as ranging from -32768 to +32767. When unchecked, SonarWiz interprets 8-bit values as
ranging from 0-255 and 16-bit values as ranging from 0-65535.
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The Show Raw Data and Show Processed Data checkboxes select the point in the processing stream
at which data is charted. The Show Raw Data displays the ping as it is recorded before any TVG,
Automatic Contrast Control or other signal processing functions have been applied. Show Processed
Data displays the ping after all processing has been completed.
 
Display Bottom Tracker Values shows a vertical line in the top graph at the first return representing the
Bottom Tracker altitude value. 

Signal Trace

The Signal Trace graph shows the amplitude vs time (range).

Intensity Histogram

The Intensity Histogram shows amplitude vs occurance (frequency).
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Left Right Steering Indicator
 

The Left Right Steering Indicator is opened by clicking View | Data Acquisition Views |  Left Right
Steering Indicator in the View Menu.
 

 
The Left Right Steering Indicator is a graphical tool that indicates the vessel distance traveled ALONG the
active survey line, the active survey LINE name, and the distance TO END of the active line. The value of the
teal vertical hash marks and the outer extents adjust automatically in order to keep the red vertical hash mark
with the graphic itself. All values displayed are in Project units.
 
The Left Right Steering Indicator right-click pop-up menu allows user to select the position source of the line
tracker computation. The two current selections are ship position and sidescan position.
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Disk Monitor
 

The Disk Monitor is opened by clicking View | Data Acquisition Views |  Disk Monitor in the View Menu.
 

 
The Disk Monitor is a real-time tool that displays the currently recording file length, the currently recording file
size, and a disk space remaining indicator.
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Sensor Graphs
 

The Sensor Graphs is opened by clicking View | Data Acquisition Views |  Sensor Graphs in the View
Menu. This window is used to show ancillary sensors in a strip chart style control during data acquisition and
playback.
 

 
 

Settings

Open the Sensor Graphs Settings window.

Information

Display a short tool tip about the purpose of this window.
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Strip Chart

The Sensor Graph may be used to display:
 
•  Altitude
•  Cable Out
•  Heading Fish
•  Heading Ship
•  Magnetometer
•  Mag Field Strength
•  Mag Depth
•  Mag Altitude
•  Pitch
•  Pressure
•  Roll
•  Water Depth
•  Water Temp
 
The sensor displayed as well as the colors and scale of the graph are controlled in the Sensor Graph
Settings window.
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Sensor Graphs Settings window
 

The Sensor Graph Settings window is opened from the Settings icon in the Sensor Graphs toolbar. The Sensor
Graphs Settings window controls the field to display in the sensor graph as well as the color and scale of the
graph.
 

Sensor Field

Select the field to display.

Grid Color

Select the grid line color.

Plot Color

Select the plot line color.



Sensor Graphs Settings window

811

Background Color

Select the plot background color.

Auto Scale check

If checked, the graph will automatically scale the x-axis (horizontal) to fit the displayed data, if
unchecked, the graph will use the specified x-axis minimum and maximum values.

X-axis minimum

Set the minimum x-axis value (only used if auto scale is not selected).

X-axis maximum

Set the maximum x-axis value (only used if auto scale is not selected).
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Sidescan and Sub-Bottom Processing
 
This section describes aspects of the post processing data that applies to all data types. Most of the functions
covered in this section are found in the Post Processing Ribbon Menu.
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Importing Files
 
When an data file (an XTF file for example) is imported into SonarWiz, a new intermediate file is created in the
appropriate sub-directory of SonarWiz for that data type. These files have the same names as the original raw
data files but with a new extension.
 

Raw Data Type Intermediate
File Format

SonarWiz
Project Folder

Sidescan CSF CSF
Subbottom CSF CSF
Forward Looking
Sonar

CSF CSF

Magnetometer CMF CMF
Bathymetry CDF Bathy
Lidar CDF Bathy
Singlebeam CDF Bathy

 
The intermediate files contain data structured in a way that facilitates efficient processing and rapid display.
When data are modified or adjusted in any way by SonarWiz, it is the intermediate file that is modified, not the
original raw data file.
 
Immediately after a raw data file has been imported, its resultant intermediate file will appear in the list of
project files in the Project Explorer and its “Enabled ” flag will be checked, meaning that it will be displayed in
the map view.
 
An intermediate file may be deleted from the project by using the Project Explorer or the pop-up context
menu. Note that this action does not remove the original file from the hard disk. Rather, it just removes it's
intermediate file from the project.
 

It is important (and reassuring) to remember that with the exception
of File Utilities (See File Utilities) SonarWiz never modifies, deletes
or moves original acoustic files. Only the CSF files are modified,
and these can be re-created at any time from the original acoustic
files.

 
 

 The Post Processing | Import tool  is found on the Post Processing Menu allows you to import data
into a SonarWiz project.
 

Import Options  
See Importing Sidescan Sonar Data
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See Importing Sub-bottom Sonar Data

See Importing Forward Looking Sonar Data

See Importing Magnetometer Data

See Importing Bathymetry Data

See Importing Laser Scanner Data

See Importing Single Beam Data

See Importing Tide Files

See Importing Sound Velocity Files

See Importing External Navigation Files

See Auto Import
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Course Smoothing and Interpolation
 
The Time Constant For Course Smoothing settings found on the Create a New Project... window and also
found on the Advanced Sidescan Import Settings window control how SonarWiz computes the position of the
navigation reference point for each ping. When enabled, this feature performs two related functions:
 
1. It smoothes the received navigation positions.
2. It interpolates the filtered navigation onto the pings so that each ping in the data set receives a unique,
smoothly progressing position.
 
The user controls the ping step size, which is used during the smoothing portion of the filter. If the step size is
set to 0, the filter is disabled and the original navigation in the file is used.
 
Smoothing and Interpolation happen at the same time when course smoothing is enabled. The following
sections describe how the filter works in detail.
 
Smoothing
 
Without advanced navigation processing, conventional navigation fixes have an inherent uncertainty of around
2 meters.  This imprecision in position can result in undesired jumps or jitter in the navigation track of the
vessel which introduces unsightly artifacts in the sonar imagery. When enabled (pings step > 0), the time
constant for course smoothing, will down-sample the input navigation and fit a smooth spline through the
remaining navigation fixes.
 
The down-sampling works by selecting an array of valid navigation samples. A valid navigation sample meets
both of the following criteria:
 
1. It is a minimum of STEP pings away from the previously selected value. The ping step is set by the user.
2. It is a unique position, different than the previously selected value (see Interpolation section for why this
condition is necessary). If the current ping is not a unique position, the filter will search forward in the file until a
unique position is found.
 
Once the array of valid navigation samples is selected, then a spline is fit to the data and re-interpolated onto
the original pings.
 
The following plot shows about 650 consecutive pings plotted before and after applying course smoothing
with a ping step of 50 pings. The blue dots indicate the pings plotted at their original navigation positions (note
that without interpolation, most pings plot on top of each other) and the red dots indicate their position after
smoothing and interpolation.
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Interpolation
 
In most cases, the ping rate of the sonar is as much as 20 times faster than the navigation system updates.
Most sidescan formats stamp each ping using the last known navigation position, so a stale position repeats
ping-after-ping until an updated position is received. For example, in the following table are shown 41
consecutive pings from a typical sidescan data set:
 

Ping ShipX ShipY

162756 553518.8 4186434.18
162757 553518.8 4186434.18
162758 553518.8 4186434.18
162759 553518.8 4186434.18
162760 553518.8 4186434.18
162761 553518.8 4186434.18
162762 553518.8 4186434.18
162763 553518.8 4186434.18
162764 553518.8 4186434.18
162765 553518.8 4186434.18
162766 553518.8 4186434.18
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162767 553518.8 4186434.18
162768 553518.8 4186434.18
162769 553518.8 4186434.18
162770 553518.8 4186434.18
162771 553518.8 4186434.18
162772 553518.8 4186434.18
162773 553518.8 4186434.18
162774 553518.8 4186434.18
162775 553518.8 4186434.18
162776 553518.8 4186434.18
162777 553515.85 4186436.01
162778 553515.85 4186436.01
162779 553515.85 4186436.01
162780 553515.85 4186436.01
162781 553515.85 4186436.01
162782 553515.85 4186436.01
162783 553515.85 4186436.01
162784 553515.85 4186436.01
162785 553515.85 4186436.01
162786 553515.85 4186436.01
162787 553515.85 4186436.01
162788 553515.85 4186436.01
162789 553515.85 4186436.01
162790 553515.85 4186436.01
162791 553515.85 4186436.01
162792 553515.85 4186436.01
162793 553515.85 4186436.01
162794 553515.85 4186436.01
162795 553515.85 4186436.01
162796 553515.85 4186436.01
162797 553514.37 4186437.85

 
Starting at ping 162756, an updated X,Y position is received from the GPS (highlighted in red). The next 20
pings receive the same position stamp even though the vessel and fish have actually been moving forward.
At ping 162777 an updated X,Y position is received (highlighted in red) and the cycle repeats. If Course
Smoothing is turned off (Ping step set to zero) the first 21 pings will plot on top of each other, then there is a 2
meter jump and the next 19 pings plot on top of each other. This is indicated by the blue dots in the following
plot:
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With course smoothing turned on (Ping step > 0), SonarWiz will smooth the navigation (see Smoothing above)
and interpolate the resulting track navigation back to each ping. The results of this operation for the 41 pings
listed in the table above are shown as gray dots (red arrows) in the figure above.
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Layback & Offsets
 

Towed sensors' (towfish) positions are normally determined via acoustic positioning or by layback. Even
if layback or cable-out information is stored in your sonar file, if it was not added to the sonar position in
the recording software (typically it is not), then you can re-position sonar data during post-processing with
SonarWiz, by explicitly applying layback/cable-out during post-processing. The sections below explain how.
Note that the support site http://www.chesapeaketech.com, also has a tutorial video on layback, as well as a
consolidated, simplified tutorial PDF on the same topic, to supplement the User Guide sections below.

 
Acoustic positioning is the preferred method of determining a towfish position as it is more accurate than
layback however it requires specialized equipment and software. Acoustic positioning systems determine the
location of the towfish and pass the geographical or X/Y position to the sonar recording software.

 
Layback is an estimate of the towfish position using a various assumptions, depending on the specific layback
method being used; however, all share one critical Achilles Heel: The assumption that the towfish travels
directly behind the towing vessel i.e. no effect from turns, shear or hydroplane tow-off.

 
Examples of layback calculation methods include:

 

Method Assumptions Required information

Pythagoras Theorem Towfish directly behind vessel Towfish Depth
Cable Out

Look-up Tables
Towfish directly behind vessel

No (along track)
effect from currents

Tow Cable type
Depressor type (if any)

Cable Out
Vessel speed

Horse & Cart Towfish directly behind vessel Cable Out
 
 

http://www.chesapeaketech.com
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Layback in SonarWiz
 

SonarWiz uses Pythagoras Theorem exclusively in Real-time Mode but offers two choices in post processing:
1.     Pythagoras Theorem; or
2.     Horse & Cart
 
Regardless of which method is chosen in the LBK Algorithm column of the Sonar File Manager, SonarWiz
then uses a percentage of cable out value to apply as an along-track offset in order to correct for the catenary
effect; this percentage is entered by the user (See Layback Percentage ).
 
The offset calculated in the Layback Algorthim will be applied in a different direction based on the Heading
Source currently being used in the file. It can either be set to Sensor Heading which will use the direction of the
sensor recorded in the CSF file or Course Made Good which uses an interpolated heading value based on the
direction of travel. See Course Smoothing and Interpolation for more information.
 

Prior to applying layback the position of the towpoint (sheave)
must be spatially correct, which is covered in the following section.

 
In the Sonar File Manager the second last column (red box) allows the user to select the desired Layback
Algorithm (see figure below).
 
1.      If only Cable out was recorded and correct then use Cable-Percent.
2.     However if the towfish had a depth sensor and it was accurately recorded then select Cable – Sensor
Depth, and the Pythagorean Theorem will be used in this case. SonarWiz will compute the distance back,
along-track, to the sea surface point directly above the towfish, using the Pythagorean theorem to solve for it,
knowing the Cable Out (hypotenuse) and leg of the triangle (depth from sensor), which form a right-triangle
with the surface of the sea.
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Lever Arm a.k.a. Sheave Offsets
 

The Lever Arm (or Sheave Offset) is the 3-D offset (see figure below) from the GPS antenna to the towpoint.
 
This information is normally entered prior to recording sonar data (See Section 4.2.7 on page 264) but if the
data that is being post-processed does not have these values entered, or they are incorrect, then Sheave
Offsets must be corrected prior to applying layback.
 
The offsets defined in the Sheave Offsets dialog will be applied in a different direction based on the Heading
Source currently being used in the file. It can either be set to Sensor Heading which will use the direction of the
sensor recorded in the CSF file or Course Made Good which uses an interpolated heading value based on the
direction of travel. See Course Smoothing and Interpolation for more information.
 

 
 
The Primary method to set the Sheave Offset in post processing is to open the Sonar File Manager and
select the Sheave Offset button (see Sheave Offset for more information) that will open the dialog below.
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Using this dialog allows for the possibility of multiple (ship) configurations as the desired Sheave Offset may
be applied to specific lines rather than the entire project.
 
To use this function:
 
1.  Select the checkbox beside Apply Sheave Offset to Layback Calculations
 
2.  Enter the sheave offset from the GPS Antenna (or the position reference point) where:
•  X is athwartships with positive values to Starboard of the GPS Antenna
•  Y is fore-and-aft with positive values forward of the GPS Antenna; and
•  Z is sheave height above waterline, and only positive values should be used
 
3. Select individual or all sonar files to apply the offsets.
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Cable Out
 

Setting-up SonarWiz to record cable out is discussed in Sonar Layback Configuration. This section discusses
the two post processing methods of applying cable out, namely Per-file settings and Cable node entry.
 

When setting cable out in SonarWiz the total distance from the
positioning reference (GPS antenna) to the towfish must be

included not just the cable out from the tow-point to the towfish.

Setting Per-file Cable Out:
 
Setting a “global” cable out value for an entire file is done within the Sonar File Manager. In the Sonar File
Manager (see figure below) select the Set Cable Out button (highlighted with the red arrow) in order to set
every ping in each selected file to the same cable out value. Use this method when the cable out is fairly
constant over the entire length of the line.
 
The Offset Cable Out button (highlighted with the purple arrow) is used when a file is encountered where the
cable counter was not zeroed out when the towfish entered the water. The result of applying in a global offset
to individuals Cable Out values within a file.

 
If, during the survey, the cable out value was changed frequently and an independent external record of when
the cable was paid in or out was maintained then this method should be used. The cable out value may be
set on a per ping basis via the Bottom Tracking Menu. When using the Cable Node Entry method in the
Bottom Trackerwindow the individual locations (moments in time) in the data file where the cable out value
was changed will be edited.
 
The Bottom Tracker dialog provides a Cable Out editing function for sonar data files in the form of replacing
any existing cable out values with inserted values. The process for adding cable out values consists of
inserting nodes where the cable out value is known. The object is to create nodes at the locations where the
cable out values change. SonarWiz will then compute an interpolated value for cable out over the entire length
of the file based on the values in the node positions.
 
To add a cable out node to a sonar record, scroll to a position in the record where the cable out is known to
have changed. Right click at that position and select Add Cable Out Node from the context menu. Enter the
cable out value in feet or meters. Continue this process for all of the cable changes in the record.
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Previously entered nodes may be edited or deleted by moving the cursor over the node, right-clicking and
selected the Edit Selected Cable Out Node or Delete Selected Cable Out Node from the pop-up context
menu.
When all cable out values have been entered, left-click the Save button. SonarWiz will then display a dialog
containing a chart that summarizes the interpolated cable out values that have been computed. At this point,
the user may either Accept these values, at which time they will be applied to the sonar record, or they may
may reject them by pressing the Cancel button and continue the editing process.
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Layback Percentage
 

When Cable Out values are correct and the Layback Algorithm is chosen, the percentage of cable out to apply
must be set in the Sonar File Manager dialog.  This is a way of estimating the along-track distance to the sea
surface point directly above the towfish, estimating from cable-out. Since the cable goes down at an angle, the
actual along-track distance back is LESS than cable-out, to the point directly above the towfish. A number like
80% is typical to apply.
 
The cable out value and the layback are multiplied to work out the along track distance behind the vessel
which will be assigned to the towfish position. Many factors may affect the layback percentage to be applied
however if vessel speed is maintained as close to constant as possible, layback percentages between survey
lines should not change significantly.
 
One factor that affects layback percentage between lines is water current. Running with the current will cause
the towfish to go deeper whereas running against the current increases drag and causes the towfish to rise. If
a survey involved current, two layback percentages may be required: one for up-current lines and the other for
down-current lines.
 
This section provides some good techniques for empirically enhancing the accuracy of your layback estimates.
 
Sidescan & Charted Objects:
 
1.     Find a charted object that was ensonified by the sonar. In this example we will use a jetty (see figure
below). Warning: Ensure the object you are using for a reference is well charted. Do not assume the position
for a charted wreck (or any other submerged object) is accurate.
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2.     Ensure the bottom tracking for the sonar file to be used is accurate (see Bottom Tracking) in order to
ensure slant range corrections are correct.
 
3.     Ensure that Cable Out has been set for the file (see Cable Out).
 
4.     Ensure Layback Percentage is set to 0 in Sonar File Manager.
 
5.     Hide (see Hide) or adjust the Opacity (see Opacity slider) of the file such that the corners of the jetty may
be seen. In this example we have three prominent corners.
 
6.     Use the Add Text button to create labels on the corners ( Labeled Corners with Temporarily "Offset" File )
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7.     Display or adjust the Opacity of the sonar file such that it can be seen.
 
8.     Measure the along-track distance between the corner(s) of the charted object and its ensonified image. If
you have more than one point measure all and use the computed average (see figure below). In this particular
example the average is 15 meters.
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9.     Layback percentage may be calculated using the following formula:
Layback % = ((Along-track dist) / Cable out) * 10
 
10. Select the calculated Layback Percentage for this file to the file in Sonar File Manager.
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11. Verify that the Layback Percentage is correct (see figure below). If it is not, measure the new along track
distance and recompute the Layback Percentage .

 
Sidescan & Reciprocal Lines:
 
1.     Find a distinct object that was ensonified in reciprocal lines. In this example we will use what appears to be
a large steel object (see figure below).
 
2.     Ensure the bottom tracking for the sonar files to be used is accurate in order to ensure slant range
corrections are correct (see Bottom Tracking).
 
3.     Ensure that Cable Out has been set for the two files (see Cable Out).
 
4.     Ensure Layback Percentage is set to Zero in Sonar File Manager.
 
5.     Set Overlap Mode (See Overlap Mode) to Cover Up.
 
6.     Use the Capture Target Utility to create a contact on the center of the position of the target in the line “on
top” (see figure below).
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7.     Send “on top” line to back and create a contact on the center of the position of the contact in the second
line (see figure below).
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8.     Measure the along-track distance between the two contacts (see figure below), remember that lateral
offsets cannot be corrected for in layback.
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9.     Divide the measured distance in half and use this value to infer Layback percentage using the following
formula:
Layback % = (0.5 * (Along-track dist) / Cable out) * 10
 
10. Apply calculated Layback Percentage to the two lines in Sonar File Manager.
 
11. Delete the original contacts and repeat Steps 7 and 8, The Red line with arrowheads in the figure above
represents the along-track direction and the yellow line is a perpendicular reference line to determine if layback
percentage is correct. If it is not correct, repeat from Step 9 onwards with the new contacts.

 
12. Optional: Set Overlap Mode (see Overlap Mode) to Shine Through. Both objects should appear if the
gain levels on the two lines are equally matched. In this the layback is correct (along track) and the correction
for the lateral offset observed between A and B can be found.
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Sub-bottom & Reciprocal Lines:
 
Using sub-bottom only to determine Layback Percentage is possible but requires to reciprocal lines that must
have been navigated with only the smallest of helmsman off-track error as the across track swath of the SBP is
very narrow.
 
1.     Find a distinct object that was ensonified in reciprocal lines.
 
2.     Ensure the Bottom Tracking for the sonar files to be used is accurate (see Bottom Tracking).
 
3.     Ensure that Cable Out has been set for the two files (see Cable Out).
 
4.     Ensure Layback Percentage is set to 0 in Sonar File Manager.
 
5.     Use Digitize New Features to create a feature on the center of the position of the target in the line “on
top”.
 
6.     Send “on top” line to back and create a new feature on the center of the position of the contact in the
second line.
 
7.     Measure the along-track distance between the two contacts.
 
8.     Divide the measured distance in half and use this value to infer Layback percentage.
 
9.     Apply calculated layback percentage to the two lines in Sonar File Manager.
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10. Delete the original contacts and repeat Steps 5 and 6. If it is not correct, repeat from Step 7 onwards with
the new contacts.
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Source File Location for Best Project Performance
 

Our staff recommends that source files be moved or copied the to a local hard drive, or even a Project sub-
folder, such as the MAG (for magnetometer) or SBP (for sub-bottom), or XTF (for sidescan) folders. These are
the default "save to" folders when recording data with SonarWiz7. The benefits of following this practice are felt
more as project size (source file count) increases.
 
SonarWiz frequently reads and writes data to the storage drive. For this reason, you will achieve the best
performance when the data is stored locally on your system. Attempt to work over a slow network drive or USB
connection may result in unacceptable performace.
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Sonar File Manager
 

The Sonar File Manager window is opened by clicking the File Manager icon  on the Post
Processing Menu. The Sonar File Manager provides access to commands that apply to Sidescan and Sub-
bottom Sonar data sets. Note that many of the functions found on the Sonar File Manager are also available in
the Project Explorer.

 

Project Information

The project information section provides a summary of the project, including the project name, the
number of data sets loaded, and the geographic extent of the project data.

Sonar File List
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The Sonar File List lists the sidescan and sub-bottom files in the project and allows for some file
properties to be changed. Each sonar file in the project is listed on a separate row within the Sonar file
section.
 

Column Description

Order Displays the current drawing order of the file with the highest
number being the file on top.

Enabled Toggles the display of the sonar file in Map View (Checked =
displayed)

Type Data type (SSS = Sidescan, SBP = sub-bottom)
Group Displays the subgroup the file is in, if any.
File Name Displays the full path and file name of the sonar file.
Size Size of the (CSF) sonar file in KB.
AGC Toggles Automatic Gain Control for the sonar file (Checked =

enabled). See Automatic Gain Control for more information.
UGC Toggles User Gain Control for the sonar file (Checked =

enabled). See User Gain Control for more information.
BAC Toggle Beam Angle correction for the sonar file (Checked =

enabled). See Beam Angle Correction for more information.
Channel Lists which channel (Port/Starboard/Both) of the sonar file is

actively displayed and
also allows the user to change the channel(s).

Map Corrected Indicates if map corrections are being applied to the navigation
of this file. See Map Corrections for more information.

LBK Algorithm Select one of the two possible layback algorithms is applied to
the Sonar File. See Layback Algorithms for more information.

Layback Select the layback percentage applied to the file.

Batch Processing Tools

This section provides tools that will perform the same function on any number of project sonar files.
 

Tool Description
Sheave
Offset...

Allows for batch offsetting the towpoint (sheave) position in post-
processing layback
calculations. (See Sheave Offset Window)

Batch Image
Export...

The entire waterfall of a sonar file may be captured and
exported to a single image
file using this function. (See Batch Image Export window)

Batch Bottom
Track...

Apply bottom tracking to all selected files. (See Batch Bottom
Track window)
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Make Like
Selected...

Apply settings from a reference file to all selected files. (See
Apply Settings to Selected Files window)

Command Tools

The Sonar File Manager provides access to tools that can be applied to sidescan and sub-bottom
sonar files. Note that some tools require one or more files to be selected in the file list before the
button becomes active.
 

Tool Description
Add Files(s)... Add an existing CSF file to the Project. See Add CSF Files for

more information
Delete Files(s) Remove CSF files from the project. See Remove CSF Files for

more information
Rescan Limits Recompute the map extent of the project files.  See Rescan

Limits for more information
Select All Select all files in the File Manager
Aggregate Activate the Aggregate command on the selected files
Bottom Track... Open the Bottom Track window on the selected file
Digitizer View Open the Digitizing Window on the selected file
Navigation... Open the Navigation Editor (Z-Edit) on the selected file
Properties... Activate the Properties (Sidescan File) command for the select

file
Gain Settings... Open the Gain Settings window for the selected file
Report... Runs a Project Summary Report on the selected files
Coverage... Runs a Survey Coverage Report on the selected files
Set Cable
Out...

Set the Cable Out value on the selected files

Offset Cable
Out...

Offset the Cable Out value on the selected files

Set Sensor
Depth...

Set Sensor depth on the selected files

Offset Sensor
Depth...

Offset Sensor Depth on the selected files

Set Antenna
Ht...

Set Antenna Height on the selected files

Import Bottom
Track

Imports the bottom track  from a previously determined tracking
iteration
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Set Draw
Order

Activate the Order command to change the drawing order
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Add CSF Files Window
 
The Add CSF FIle(s)... command is located on the Sonar File Manager, the Sidescan Branch Context Menu, and
the Sub-Bottom Branch Context Menu. Use the Add CSF Files command to add CSF files created in SonarWiz
to the current project. Multiple CSF files can be opened at once.

 
In addition to using the Add Files Button; the Drag-and-Drop process may be used where Individual CSF files,
multiple CSF files or even entire directories of CSF files may be selected from Windows Explorer and left-
dragged and dropped to the Sonar File Manager window. When an entire directory is dropped onto the Sonar
File Manager non-CSF files are ignored.
 
Note: files not in CSF format must be imported using the Import command.



Remove CSF Files Using Project Explorer

841

Remove CSF Files Using Project Explorer
 
To remove CSF Files from a SonarWiz project using the Project Explorer:
 
 1. Select the CSF files you wish to remove from the project in the Project Explorer.
 

 
 

2. Right-click the group of files and select Delete Selected Sonar Files from the Context Menu or tap the
Delete key.

 
3. SonarWiz will confirm that you wish to delete the selected files:
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Note that the CSF files are removed from the project but not deleted from storage.
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Remove CSF Files Using Sonar File Manager
 
To remove CSF Files from a SonarWiz project using the Sonar File Manager:
 
 1. Select the CSF files you wish to remove from the project in the Sonar File Manager.
 

 
 

2. Click the Delete Files button or tap the Delete key.
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3. SonarWiz will confirm that you wish to delete the selected files:
 

 
 

Note that the CSF files are removed from the project but not deleted from storage.
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Set Cable Out
 

The Set Cable Out... command allows for setting a single cable out value for the entire file. The value can be
applied to multiple files at a time.
 
To Open the Set Cable Out command:
 
1. Select the Set Cable Out... command from the Sidescan Branch Context Menu in the Project Explorer
2. Click the Set Cable Out button in the Sonar File Manager.
 

 

Offset Value

Set cable out value for the entire file. Positive values offset towards the stern, Negative values offset
towards the bow. This value replaces any layback and cable out values already applied. For this
reason, the distance specified should be from the position reference (GPS Antenna) to the towfish,
including the offset from the position reference to the towpoint. Specify the distance units in meters or
feet.
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File List

Select the files to apply the cable out setting.

Check All

Toggle to select all files in the project.
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Offset Cable Out
 

The Offset Cable Out... command allows for applying a static offset to existing cable out values in a sonar file.
The value can be applied to multiple files at a time.
 
To Open the Offset Cable Out command:
 
1. Select the Offset Cable Out... command from the Sidescan Branch Context Menu in the Project Explorer
2. Click the Offset Cable Out button in the Sonar File Manager.

 

Offset Value

Set the offset to apply to existing cable out values in the file. Positive values offset towards the stern,
Negative values offset towards the bow. This value is added to any layback and cable out values
already applied. Specify the distance units in meters or feet.
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File List

Select the files to apply the cable out setting.

Check All

Toggle to select all files in the project.
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Set Sensor Depth
 

The Set Sensor Depth... command allows for setting a single depth value for the towfish over the entire file.
The value can be applied to multiple files at a time.
 
To Open the Set Sensor Depth command:
 
1. Select the Set Sensor Depth... command from the Sidescan Branch Context Menu in the Project Explorer
2. Click the Set Sensor Depth button in the Sonar File Manager.

 

Depth Value

Set the sensor depth to apply to the towfish for the entire file. The value will replace any existing depth
information in the file. Depth is always a positive number. Specify depth units in meters or feet.

File List
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Select one or more files to apply the depth value.

Check All check

Toggle to select all files in the project.
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Offset Sensor Depth
 

The Offset Sensor Depth... command allows for applying a static offset to existing towfish depth values in a
sonar file. The value can be applied to multiple files at a time.
 
To Open the Offset Sensor Depth command:
 
1. Select the Offset Sensor Depth... command from the Sidescan Branch Context Menu in the Project
Explorer
2. Click the Offset Sensor Depth button in the Sonar File Manager.

 

Depth Offset Value

Specify the depth offset to apply to the existing towfish depth values. Positive numbers offset towards
the seabed, negative numbers offset towards the sea surface. Specify the distance units in meters or
feet.
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File List

Select one or more files to apply the depth offset value.    

Check All check

Toggle to select all files in the project
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Set Antenna Height
 

The Set Antenna Height... command allows for setting an antenna height value for the position reference
point (GPS Antenna) which will set the vertical datum of the survey. The value can be applied to multiple files
at a time.
 
To Open the Set Antenna Height command:
 
1. Select the Set Antenna Height... command from the Sidescan Branch Context Menu in the Project Explorer
2. Click the Set Antenna Ht button in the Sonar File Manager.

 

Antenna Height Value

Set the antenna height value. The Antenna Height value may be positive or negative and represents
the geoid height of the antenna as provided by the GPS. Specify the elevation units in meters or feet.
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File List

Select one or more files to apply the antenna height

Check All check

Toggle to select all files in the project.
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Sheave Offset
 

The Sheave Offset tool allows for batch offsetting the tow point (sheave) position in post-processing layback
calculations. See the Layback & Offsets discussion for more information on applying this correction.
 
To Open the Sheave Offset command:
 
1. Select the Sheave Offset command from the Sidescan Branch Context Menu in the Project Explorer
2. Click the Set Datum Separation... button in the Sonar File Manager.

 
 

Apply

Toggles the sheave offset computation
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Starboard Offset

X is the athwartships offset from the position reference point (usually the GPS antenna) to the tow
point. Positive values are to starboard of the position reference point. See Lever Arm for more
information.

Forward Offset

Y is the fore-and-aft offset from the position reference point (usually the GPS Antenna) to the tow
point. Positive values are forward of the position reference point. See Lever Arm for more information.

Height Offset

Z is the height of the tow point above the waterline. Only positive values should be used. See Lever
Arm for more information.

Select All

Toggle to select all listed files.

File List

Selected (checked) files will have sheave offsets applied.
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Batch Bottom/Far Field Track
 

The Batch Bottom/ Far Field Track command allows for applying automatic bottom or far field tracking to a
set of files without opening each file individually in the Sidescan Bottom Tracker window.
 
To Open the Batch Bottom Track command:
 
1. Select the Batch Bottom command from the Sidescan Branch Context Menu in the Project Explorer
2. Click the Bath Bottom Track... button in the Sonar File Manager.

Bottom / Far Field Track Settings

The tracking settings are identical to those found on the Bottom/ Far Field Track window. See Bottom
Track Settings for details.
 



Batch Bottom/Far Field Track

858

Use the tabs to toggle between batch tracking the bottom for sidescan and subbottom datasets to the
far field for just sidescan.
 

Batch Check Options

Use the checkboxes to batch select a group of files in the list below.

Sonar File List

Check (enable) the files you wish to bottom track or offset.

Apply Offset...

This applies the offset only to the selected files but does not otherwise change the existing bottom
track in the files.

Track Selected Files

This applies both the track and offset to the selected files. The batch process will replace any existing
bottom tracks in the selected files.
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File Playback
 

The Post Processing | Playback tool  is found on the Post Processing Menu. The Playback tool
allows you to replay XTF and SEG-Y sonar files in the Waterfall Display.
 

 
 
Once the files have been selected, SonarWiz will open the Waterfall Display to display them.
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File Selection List

SonarWiz has the ability to playback XTF and SEG-Y sonar files such that the data may be viewed in
the Waterfall Display.

File Information

Clicking on a file in the File Selection List will cause file information to be displayed in this window.

Playback All in Folder

 Checking this box will cause the program to play back all files sequentially starting from the selected
file.

Auto TVG

Apply Auto TVG during playback

Add File to Mosaic

Only when this box is checked will the “played” files be added to the current mosaic (i.e. imported into
the CSF Format.)
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Map Corrections
 

The Map Corrections window is opened using the Map Corrections... button  on the
Maps Menu. The Map Corrections tool is used to calculate offsets from a visible target in a sidescan or
magnetometer dataset to the same object seen in a Basemap. See Map Corrections for more information.
 

Map Corrections Group

The Map Corrections Group displays a table of all map corrections in the project. The table of Map
Corrections has 6 fields:
 

Field Description
Id Automatic Identification Number
Enable When checked, the correction will be applied to the datasets added to

this map correction.
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Show When checked, show the map correction marker symbols in the
SonarWiz Map Window

Lines The number of points in the map correction
Assumed
X

The "true" easting coordinate of the map correction.

Assumed
Y

The "true" northing coordinate of the map correction.

 
Use the Add button to add a new map correction. Use the Delete button to remove a map correction.
Use the Locate button to pan and zoom the main SonarWiz window to the coordinates of the map
correction.

Points in Selected Map Correction

Each map correction is composed of a number of points. The Points in Selected Map Correction table
has 4 fields:
 

Field Description
Type Indicates the type of point (Map or CSF)

A point is selected on a Basemap on the SonarWiz window.
It represents the "true" position of the target. The Assumed X and
Assumed Y position of the map correction target is the average
position of all Map points in the correction.
 

A point is selected on a Sidescan file on the SonarWiz
window. It represents the same target as the Map point, but it is
assumed to be in the wrong location. When this map correction
is enabled, the dataset navigation will be adjusted so that the
CSF Point matches the Assumed X and Assumed Y of the Map
Correction.
 

A point is selected using the  icon in the Magnetometer
File Editor. It represents the same target as the Map point, but it
is assumed to be in the wrong location. When this map correction
is enabled, the dataset navigation will be adjusted so that the
MAG Point matches the Assumed X and Assumed Y of the Map
Correction.

File The source dataset of this point.
X The easting position of this point.
Y The northing position of this point.
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Sidescan Files in Project

Sidescan Files in Project lists all of the sidescan datasets loaded into SonarWiz. The table has 3
fields:
 

Field Description
Correct When checked, SonarWiz will apply map corrections to this file.

When selecting map correction points, this check box should be
UNCHECKED so that the CSF points pick up the original (bad)
coordinates. When all of the map correction points have been
picked. Then, check this box to apply the corrections and review if
they are performing as expected. You should leave them checked
when you close the dialog.

Show Display or Hide this file in the Main View (this is useful when picking
Map Correction points) as you probably only want to display 1 file at
a time.

Name The name of the affected dataset.
 
The Update Corrected button will apply the navigation corrections to the enabled CSF files. The
Export... button will export a table of correction offsets that have been applied to the selected CSF
files.
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Magnetometer Files in Project

Magnetometer Files in Project lists all of the magnetometer datasets loaded into SonarWiz. The table
has 3 fields:
 

Field Description
Correct When checked, SonarWiz will apply map corrections to this file.

When selecting map correction points, this check box should be
UNCHECKED so that the MAG points pick up the original (bad)
coordinates. When all of the map correction points have been
picked. Then, check this box to apply the corrections and review if
they are performing as expected. You should leave them checked
when you close the dialog.

Show Display or Hide this file in the Main View (this is useful when picking
Map Correction points) as you probably only want to display 1 file at
a time.

Name The name of the affected dataset.
 
The Update Corrected button will apply the navigation corrections to the enabled mag files. The
Copy Sonar Corrections... button will copy correction offsets from sidescan data into the related
magnetometer files. The Export... button will export a table of correction offsets that have been
applied to the selected mag files.

Advanced Settings...

Open the Advanced Map Correction Settings window.

Close

Close the Map Corrections dialog.
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Advanced Map Correction Settings window
 

The Advanced Map Correction Settings window is opened from the Map Corrections window. The Advanced
Map Corrections Settings control how map corrections are applied to files in the SonarWiz project.
 

Use map correction points from all lines
This option combines all map corrections into a single easting and northing offset that is applied
identically to all files in the project. This option should not be used when lines were collected in
opposite directions as the offset bias changes with line orientation.
 

Use Only corrections from lines with the same line direction option
This option will combine all map corrections into a single easting and northing offset for groups of lines
that are collected in the same general direction. For example, if you surveyed a north-to-south
pattern. All the lines collected while heading north will receive the same bias correction; all the lines
collected while heading south will receive the same bias correction. The Line direction tolerance
determines how close, in degrees, two survey line bearings need to be to be considered traveling in
the "same" direction.
 

Use only map corrections from same lines option

This option restricts map corrections to only the files with map correction points picked on them. Files
that do not have a map correction point will not be corrected.
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Target Strip
 

The Target Strip can be opened by clicking Post-Processing Views | Target Strip from the View Menu.
The Target Strip displays all the sonar contacts identified in the Real Time Waterfall Display or in the Waterfall
Digitizing Window.
 

Settings

Open the Sonar Contact Strip Settings window.
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Contact Strip

The contact strip displays the image associated with each captured contact. Left-clicking on an
image will cause sonarwiz to highlight the selected contact in the map view window. Double-clicking
an image will open the Contact Editor on the selected contact. Right-clicking the contact will open the
Contact Context menu.
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Sonar Contact Strip Settings
 

The Sonar Contact Strip Settings window is opened by clicking the Settings  icon on the Target Strip
toolbar. The Sonar Contact Strip Settings window provides controls for the display of contacts in the contact
strip.

 

Image Order

Select the drawing order of the contact images in the contact strip.

Image Label

Show or hide the contact name in the contact strip.

Outline Color

Select the highlight color in the contact strip.
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ZEdit Editor
 

SonarWiz includes ZEdit that allows for editing, filtering and smoothing navigation, heading, magnetometer,
water depth and other values contained in a CSF file.
 
The ZEdit window is invoked by doing one of the following:
1.     Left-clicking the Navigation button (left) within the Sonar File Processing Group of the Post
Processing Ribbon Menu.
2.     Selecting a line and subsequently right-clicking and selecting Navigation from the pop-up menu.
3.     Left-clicking on the Navigation button within the Sonar File Manager.
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ZEdit Anatomy
 

The ZEdit tool  is found on the Post Processing Menu. The ZEdit tool allows for editing, filtering
and smoothing navigation, heading, magnetometer, water depth and other values contained in a CSF file.
 

 

Menu Bar

Contains text pull-down menus for program actions.
 

Menu Functions
File Used to open files into ZEdit.
Edit Standard windows commands (cut/ copy/ paste) as well as tools to edit headers.
View Toggle on/off menus and data, zoom functions.
Graph Toggle on/off data in bottom graph.
Map Functions for editing and displaying data in the main graph.
Smooth Interpolation tools in both graphs.
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Compute Save changes to acoustic file.
Help Opens About ZEdit window.

Button Bar

Quick tools for program actions in ZEdit window.
 

Button Function Button Function
New Document: Creates an
“Untitled” CSF file using the
current file as the template.

Update XY from Lat/Lon : Updates XY
values in the CSF file when the MAP
graph axes are Latitude and Longitude

Open CSF File: Brings up the
“Open” dialog allowing the
selection of a CSF file to be
opened for editing.

Point Raw: Allows the user to select
a raw sonar record (ping) in the active
window (Map or Graph). The CSF
Record Information window will
automatically open when a record is
selected.

Save: Saves the edits to the
current CSF file.

Point Filtered: Allows the user to select
an filtered sonar record (ping) in the
active window (Map or Graph) providing
one has been created by the user. The
CSF Record Information window will
automatically open when a record is
selected.

Cut: Not yet implemented. Zoom Window (Shift+Z): Left-Click
and hold to drag a box over a specific
area in either window to be zoomed.

Copy: Not yet implemented. Interpolate in Box: This is the most
efficient method to interpolate data in a
straight line between two raw data
points. The raw data in a “left-clicked
and held drag box” will be interpolated
from the top most raw data point in the
box to the bottom most raw data point
in the box. If the desired interpolation is
not in a straight line use Enter Curve
Fit Points. Note: The function can be
performed in the Map Window (rather
than using ZEdit). See Fix Navigation
Spikes Inside Feature Extent

Paste: Not yet implemented. Enter Curve Fit Points: Allows user
to left-click a series of points upon
which the raw data will be filtered.

Print: Not yet implemented. Fit Data To Curve Points: Moves
raw data from current path to curve
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created by user. Can be undone if the
result is not satisfactory.

Show Grid (Ctrl+G): Turns
on/off the Overlay Grid in the
active window (Map or Graph).

Finalize Curve Fit : Removes the
user entered curve to be fitted.

Fit To View (Ctrl+F) : Left-click
to the toolbar button have all
visible data within the active
window (Map or Graph).

Show Curve Points in Plot: Shows
the series of points upon which the
raw data will be filtered. This button
is “on” by default when the Enter
Curve Fit Points button is selected.

Zoom Out 10% (PgUp): Left-
click the toolbar button to zoom
the active window out by 10%
of current resolution.

Undo: Removes most recent edit
such as Interpolate or Fit Curve.

Zoom In 10% (PgDn): Left-
click the toolbar button to zoom
the active window in by 10% of
current resolution.

Execute Smoothing Filter:
Opens the Filter Settings dialog.

Plot Layback Position: Plots
ZEdit calculated layback
positions in the Map Window.

Pan (Ctrl+A): When the display is
zoomed in, the mouse cursor may be
used as a Pan tool. To Pan, drag the
image using the left mouse button in
the direction you wish to move the view
area. Release the left mouse button and
the display will be updated, centered at
the new location.

Measure (Ctrl+M) :
In the Map Window it
measures distance (in Project
Units) and true bearing
between two points. Range
and bearing is displayed in
the Status Bar. In the Graph
Window it measures the value
in the Y (vertical) axis and
displays the result in the Status
Bar. In either window left click
at first point and drag cursor to
second point.

Limit Raw Range : Used in the Graph
Window only. Left-click and drag the
upper and lower limits of the Y (vertical )
axis. All data falling outside the new
limits will be constrained to the max/min
value.
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Map Window

Displays the Navigation for the current CSF line. Tis is the area where Navigation may be edited
and smoothed.

Graph Window

Displays Navigation or Sensor data along the Y (vertical) axis versus the Ping Number along the X
(horizontal) axis.

Status Bar

Displays program status, Range & Bearing, cursor location as well as Num lock and Caps Lock.
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The ZEdit Map Window
 

The Map Window displays a number of different pieces of information including:
1.     Source of Data
2.     Ship or Fish
3.     Grid
4.     Data – Raw & Filtered
5.     Color-coded boxes represent each individual record (ping)
6.     Line – Raw & Filtered
7.     Color-coded lines represent each individual record (ping)
8.     Range – Raw and Filtered
 
The figures below show the Map Window with the various data displayed. The data can be toggled on or off
via right-clicking inside the Map Window or the clicking the Map pull-down menu and selecting the option to
be displayed.
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Choose Map Data:
 
CSF Files have only one set of position data in them with layback variables stored and applied on screen. XTF
files however can contain either ship or fish navigation data and may even contain both.  When editing XTF
files the Map Window can display either Ship or Fish (Sensor) navigation data subject to the data fields being
populated in the CSF file. Depending on how the data was recorded during the survey one of these vales may
be absent.
 
To switch between Ship and Fish position select Map>Choose Map Data or Choose Map Data from the
right-click pop-up menu in the Map Window. Once selected the Choose Map Data dialog will open and the
user may select either Fish or Ship position if those field are populated in the XTF file. The words Fish or
Ship will appear in the bottom right-hand corner of the Map Window in order to indicate to the user which data
are displayed.
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The ZEdit Graph Window
 

The Graph Window displays Navigation or Sensor data along the Y (vertical) axis versus the Ping Number
along the X (horizontal) axis. Specifically it displays the following data:

#       Altitude
#       Cable Meters
#       Cable Percent
#       Course Made Good
#       Water Depth
#       Distance to Prev
#       Event Number
#       Fish X
#       Fish Y
#       Heading
#       Layback
#       Layback X
#       Layback Y
#       Magnetic Field
#       Magnetic Strength
#       Orig Lat 84
#       Orig Lon 84
#       Port X
#       Port Y
#       Range
#       Reflectivity
#       Speed
#       Sound Velocity
#       Stbd X
#       Stbd Y
 

Like the Map Window the Graph Window has the following functions which may be accessed via the Menu
bar “Graph” selection or right-clicking in the Graph Window itself.
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In order to select which data to be plotted on the Y Axis select Graph | Choose Graph data from the Menu bar
or select Choose Graph Data from the right-click pop-up context menu. Once selected the the Choose Graph
Data Menu will appear. Simply choose which data are to be displayed using the pull-down menu provided.
After specifically choosing the data to be graphed the Y Axis is labeled with the type of data being graphed.
 

 
Information on Raw & Filtered Data Points:

In order to view information associated with a specific ping select
View | Point Raw or click on the (blue pointer). Point Raw tool
bar button for a raw record.

or select View | Point Filtered or click on the (green pointer)
Point Filtered tool bar button. Once selected the cursor will
change to either the blue or green cursor.
 

Using either cursor left-click on the desired record and a dialog similar to that in the below figure will appear.
Note that this dialog was opened using the Point Raw cursor.
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Smoothing Data
 
Data, whether Navigation data displayed in the Map Window, or navigation and sensor data displayed in the
Graph Window may be smoothed via a boxcar filter, which is type of weighted moving average filter. This tool
can be accessed by these commands:
1.     With either window active select Smooth | Execute Smoothing Filter
2.     Right-click in the desired window and select Execute Smoothing Filter

3.     Click the Execute Smoothing Filtertool bar button 
 
Once selected the Filter Settings dialog will appear.

 
Filter Settings:
 
Filter Size: The number of records/ seconds to use to create a weighted moving average at the current node.
The higher the number the smoother the resultant line will be. The Filter Size may be typed in or the More or
Less buttons may also be used.
 
Delete Filtered: Deletes current (green) filtered line result.
 
Apply: Applies the current filter and Outlier Removal settings.
 
Outlier Removal: An option to have outliers removed by factors.
1.     Entering 0 does not remove any outliers from the data and the smoothing function is the Mean.
2.     Entering 0.1 removes the 5 percent highest and 5 percent lowest values, leaving only 90 percent of the
original data set.
3.     Entering 0.5 it removes 25 pct highest and 25 pct lowest.
4.     Entering 1.0 removes (almost) 100 percent of the data points, leaving only 1 point remaining. The number
of points higher and lower than this point are equal so the remaining point is the median of the data. In this
case it is a Median        
 
Filter. The median filter preserves edges better than the mean.
Checking the Trimmed check box removes outliers from the set of data used to compute the smoothed curve -
it does not remove them from the raw data plot.
The Apply to CSFs... option is used to open Windows Explorer and batch apply the smooth filter settings to a
group of CSF files.
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Limiting Raw Ranges
 

If the overall range of the data in the Graph Window exceeds user defined acceptable parameters it may be
restricted or constrained within a user-set range. This function would likely be used in a case where a sensor
recorded data with a large number of gross outliers. An example of the need for this function would be a depth
sensor that was recording bad sensor values that were numerous in their appearance.
 
This tool can can be accessed by these commands:
1.      In order to Limit the raw ranges Select Graph | Limit Raw Range from the Menu bar or click the Limit

Raw Range  button. When selected the button will appear depressed and the cursor will turn in to the 
Limit Raw Range cursor.
2.     Select View | Point Filtered or click on the Point Filtered tool bar button. Once selected the cursor will
change to either the blue or green cursor.
3.     Clicking OK on the Range Filter dialog applies the limits.
4.     The new user-imposed limits will remain until Graph | Limit Raw Range from the Menu bar is selected or
the Limit Raw Range Tool bar button is clicked.
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Calculating and Applying Layback in ZEdit
 

ZEdit offers users the ability to add layback to navigation data separately from SonarWiz for any of the three
file formats it reads, namely CSF, XTF, and CMF. To apply layback to the current navigation data open in ZEdit
select Map | Layback Setup and the Layback Setup Dialog will open.
 

 
 
The Layback Setup dialog offers three possible algorithms to calculate layback:
 
1.     Manual Layback: The simplest of the three algorithms, Manual Layback is best used when the cable
scope and fish depth do not change during the entire period the data was recorded. Speed changes normally
change the sensor depth for towed sensors so carefully consider if speed changed (including speed through
the water i.e. current) prior to using this algorithm.
2.     Percent of Cable Out: This algorithm is normally used for towed sensor whose cable scope changed
during the period the data was recorded and the sensor had no fitted depth sensor. As discussed above the
depth of a towed sensor changes with speed through the water so data files at different speeds (including
current) may require different values of percent cable out.
3.     Pythagorus (Cable Out and Sensor Depth): This algorithm is the most accurate estimate of layback
however cable out and sensor depth must have been accurately recorded.
 
Checking Foward Layback reverses the sign of the applied layback such that the offset distance is applied
forward of the raw position rather than aft.
 
Once the Layback Algorithm has been chosen the calculation may made automatically or manually by
choosing Map | Compute Layback Automatically or Map | Compute Layback Positions respectively. The

navigation data with calculated layback applied is viewed by either selecting the Plot Layback Position 
button or selecting Map | Plot Layback Position. When Layback Positions are applied the Plot Layback
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Position button appears as “pressed-in” the button bar and the Map | Plot Layback Position selection has a
check-mark beside it.
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Editing Navigation Data
 

In order to edit the navigation data two choices are available depending on whether the edit is a straight line
(two points) or a curve (multiple points).
 
Interpolate In Box:
If the raw navigation is incorrect due to a (number of) incorrect position calculations within a discreet time
period and a the correct path is a straight line between the two good positions then Interpolate in box is the
best method to correct the navigation. To use this function:

 

1.     Select the Interpolate in Box tool bar   button or select Smooth | Interpolate in Box from the pull-
down menu to bring up the Interpolate in box cursor.

2.     Left-click and drag a box encompassing the bad positional data.

3.     ZEdit will automatically interpolate between the extreme navigational pints eliminating those points in
between.
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Fitting Points to a Curve:
If the raw navigation must be corrected along a number of discrete nodes (curve) rather than a straight line
then the following procedure should be used. To use this function:
 

1.     Select the Enter Curve Fit Points tool bar  button or select Smooth | Enter Curve Fit Points from
the menu bar. The Show Curve Points in Plot button will be activated by default when the Enter Curve Fit
Points button is selected.
2.     Enter the new curve nodes by left-clicking at the desired location. If a point is misplaced (other than the
first point) select Smooth | Remove End Curve Point to remove it. Multiple selections of Remove End Curve
Point will eliminate the next most recent up to and including node number 2. If the first node is incorrect then
the Finalize Curve Fit button or selecting Smooth | Finalize Curve Fit from the menu bar.
 

 
3.     In order to smooth the raw pings on to the entered curve select the Fit Data to Curve Points tool bar
button or select Smooth | Fit Data to Curve Points  from the menu bar. Notice in that two separate things will
happen after clicking:
- The raw (black) data line is now fitted to the drawn curve
 - A new (green) smoothed line will be created. The smoothing factor will be set to the most recently used
Filter setting or if the Filter has not yet been used in the current session, the default setting will be used.
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After the the Fit Data to Curve Points stage the user may either Undo the curve fit by left clicking the Undo

 button or selecting Smooth | Undo. The user may copy the changes to the loaded CSF File by Clicking

the Finalize Curve Fit  button or selecting Smooth | Finalize Curve Fit from the menu bar.
 

Note that the navigation changes are not written to
the CSF until the Save button in the tool bar is left-
clicked or File | Save is selected from the menu bar.

 
If during the Fitting Points to a Curve operation the dialog below appears this indicates that the end points of
the user generated curve was too far from the raw data.
 
When this dialog appear two actions are taken by the program:
1.     The raw data is fitted to the user created curve; and
2.     The smoothing filtered window appears prompting the user to smooth the newly created line.
 
If this was not the intended result simply click the Undo button and remove the curve by clicking the Finalize
Curve Fit button.
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Applying Static Position Offsets to
Sidescan and Sub-Bottom Data Sets

 
The Move submenu available on both the Sidescan File context menu and the Sub-Bottom Context Menu
provides commands for offsetting the position of data sets by a static X,Y value. Where X is the easting offset
in the project coordinate system and Y is the northing offset in the project coordinate system. Offsets can be
applied manually with the mouse (see Move Selected Sonar File) or specified explicitly (See Enter X/Y Offsets
to Selected Sonar File). In either case, the offsets can be cleared and the file returned to its normal navigation
position.
 
The Move command is also handy way to temporarily display two overlapping sidescan lines side-by-side in
plan view for comparison purposes, or for making comparative figures for reports, since the offsets can be
easily removed when you are done capturing the screen. Applying an offset or removing an offset, does not
affect cable layback or sheave computations.
 

 
 
The Clear Offsets on Selected Sonar File command will remove the X,Y offsets currently applied to
navigation on the selected sonar file.
 
The Clear Offsets on All Sonar Files command will remove the X,Y offsets currently applied to navigation on
all sonar files in the project.
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Move Selected Sonar File
 
The Move Selected Sonar File command is used to apply an X,Y offset to a sidescan or sub-bottom data set
manually with the mouse. Note sidescan data sets are illustrated below, but you can select a sub-bottom track
line in a similar way.
 
To Move a sidescan (or sub-bottom) data set:
 
1. Select the Move | Move Selected Sonar File command from the Sonar File Context menu.
 

 

2. The mouse cursor will change to . Left-click and drag the sonar data set to a new location and release
the mouse button to drop the data set into place.
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3. The data set will draw in the new location
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Enter X/Y Offset to Selected Sonar File
 
The Enter X/Y Offset to Selected Sonar File command is used to offset the position of a sonar data set by a
static easting and a static northing value. A single X,Y offset value is applied to the entire file simultaneously.
The offset values are applied cumulatively, the total X and Y offset for the file is displayed to the right of the
entry text boxes.
 

Absolute Offsets

Absolute offsets option will adjust the X and Y offset of the file by adding an easting value and a
northing value to the current X,Y offset of the file. The current value of the file X,Y offset is displayed in
the black boxes.
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Relative Offsets

Relative offsets option will adjust the X and Y offset of the file by adding an easting and northing
value computed relative to the mean direction of travel of the line. The mean direction of travel is
computed by extending a vector from the starting point to the ending point of the line. The port/
starboard offset and the aft/forward offset are computed relative to the drawn vector. A single X and Y
offset is computed and added to the existing X,Y offset value currently applied to the file. The current
value of the file X,Y offset is displayed in the black boxes.
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Specifying Sidescan and Sub-Bottom Drawing Order
 
The Order commands are used to specify the drawing order of sidescan and sub-bottom sonar files in the plan
view and mosaics. The drawing order is particularly important when the sidescan overlap mode is set to Cover
Up (See View Menu | 2D Map Display for more information). The last sonar file drawn will be at the top of the
stack and cover previously drawn data sets. The Order commands are found on the Sidescan Context Menu
and the Sub-Bottom Context Menu.
 

 
The Order submenu is divided into 5 commands. The first 4 commands will change the drawing order of the
selected file, the final command Specify Drawing Order... will open a dialog where you can arrange the drawing
order of all the files in the project at one time. The files are drawn in order from the bottom of the drawing stack
to the top of the drawing stack. The last file to draw (the top of the stack) covers up the previous files drawn.
 
Note: The drawing order is only visible in the sidescan mosaic if the SSS Overlap Mode is set to Cover Up.
The other overlap modes are not affected by the drawing order.
 

Command Description
Bring to Front (Shift+F) The selected file will be moved to the top of the drawing

stack and be drawn on top of all other sonar files
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Send to Back (Shft+B) The selected file will be moved to the bottom of the drawing
stack and be drawn beneath all other sonar files

Bring Forward (Alt+F) Move the selected file towards the top of the drawing stack
Send Backward (Alt+B) Move the selected file towards the bottom of the drawing

stack
Specify Drawing Order... Open the Mosaic File Order dialog.
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Specify Drawing Order
 
The Specify Drawing Order command is used to open the Mosaic File Order dialog where you can rearrange
the drawing order of sidescan and sub-bottom files in the project. See Specifying Sidescan and Sub-Bottom
Drawing Order for more information.
 

 
The Mosaic File Order dialog lists all of the sidescan and subbottom data sets in the project. The data sets will
be drawn in the order listed with the top-most file drawn first and then covered by subsequent files. The last file
listed will be the last file drawn on top of all of the other files.
 
To rearrange the drawing order:
 
1. Open the Mosaic File Order dialog by selecting the Order | Specify Drawing Order command from the
Order sub-menu in the Sidescan File Context Menu.
 
2. Select the file (left click) or files (Ctrl+Left Click) you wish to move and hold the mouse button down.
 
3. While holding the left mouse button, drag the files to the new position. The dialog will indicate where the files
will be dropped with a horizontal line. Files at the top of the list are drawn first and will be covered up by files at
the bottom of the list which are draw last.
 
4. Release the mouse button and the files will be arranged in the new position.
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Hiding Sections of Sidescan
and Sub-Bottom Data Sets

 
The Contact Hiding command is used to temporarily hide features in raw sonar data that you do not want
to display in mosaics or waterfall views such as archeological artifacts or other sensitive structures. Contact
Hiding works by clipping out a section of a sonar file and filling the gap with surrounding data. The Contact
Hiding command is found on the Sidescan Context Menu (for hiding sidescan sections) and on the Sub-Bottom
Context Menu (for hiding sub-bottom profiler data).
 
Note: To apply contact hiding to sub-bottom data, you must switch the Sub-Bottom Display Mode to Draft or
High Resolution. This way, you can select the appropriate sub-bottom data in the main view.
 
Select the Use Mouse to Hide Target command to start the contact hiding process. Use the Un-hide Targets on
Selected Line command or the Un-hide Targets on All Lines command to remove contact hiding.
 
Before and after contact hiding operation:
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Use Mouse to Hide Target
The Use Mouse to Hide Target command is used to hide the selected region of a sidescan data set. The Use
Mouse to Hide Target command is found on the Contact Hiding sub-menu of the Sidescan File Context Menu.
You can restore the hidden sections of the file to view by using the Un-hide Targets commands also found on
the Contact Hiding menu.
 
To Hide a Contact on a sidescan file:
 
1. Select Use Mouse to Hide Target... command from the Sidescan File Context menu:
 

 

2. The mouse cursor will change to a cross-hair indicating that SonarWiz is waiting for you to make a
selection in the main window.
 
3. Left-click and drag the mouse cursor over the target to hide. The selected section will turn grey.
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4. The portion of the data set highlighted in step 3 will be hidden and will not be shown in exported mosaics,
waterfalls or the plan view.
 

 
The Un-hide Targets on Selected Line command will make visible again any portion of the data set hidden
from view by the Use Mouse to Hide Target command. The Un-hide Targets on Selected Line command is
found on the Contact Hiding sub-menu of the Sidescan File Context Menu. The Un-hide Targets on All Lines
command will un-hide all targets on all data sets in the SonarWiz project.
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Sidescan and Sub-Bottom Data Set Property Report
 
The Properties command found on the Sidescan Context Menu and the Sub-Bottom Context Menu opens
a dialog reporting many properties of the sonar file including the file metadata, projection properties, gain
settings and offsets.
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Trim the Outer Edge (Far Range) of
Sidescan and Sub-Bottom Data Sets

 
The Adjust Displayed Range command is used to temporarily trim the outer edges of raw sidescan and sub-
bottom data that you do not want to display in mosaics. The Adjust Displayed Range command is found on the
Sidescan Context Menu and the Sub-Bottom Context menu.
 
NOTE: this command only applies to data displayed in the plan view mosaic, not to the waterfall displays.
 

 
NOTE: The displayed range settings here only apply to the plan view drawing. They do not affect the waterfall
display.
 

Full Range

Defaults to sonar range setting at the time of collection. The box indicates the maximum range setting
available in the file.

User-Specified Range

Set the port and starboard range to display value to less than or equal to sonar range setting at time of
collection. Use the Port box to set the port range. Use the Starboard box to set the starboard range.

Far Field Limits

If the sidescan data has been far field tracked to remove erroneus data, it can be clipped in the main
display using this option. See Bottom and Far Field Tracking for more information.
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NOAA Guidelines

Set the displayed range to meet NOAA guidelines for altitude versus range. If the ratio of altitude-
to-sonar slant range drops below 8 percent then the displayed range is limited to the sonar altitude
multiplied by 12.5.

Multiple of Altitude

Set the displayed range to a user entered multiple of the altitude.
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Spliting Data Sets
 
The Split command is used to divide an existing sidescan, sub-bottom, or bathymetry dataset into two or more
independent files which can then be treated differently. The Split command is found on the Sidescan Context
Menu, Sub-Bottom Context Menu, Magnetometer Context Menu, and Bathymetry Context Menu.
 
NOTE: Sidescan files must be in the draft or high-resolution drawing mode to split the file with the mouse.
 
The most common reasons to split a file include:
 
•  the original file is too large to be manipulated easily
•  the original file overlaps itself with multiple passes over the same sea floor
•  an abrupt change in sea floor reflectivity affecting gain settings
 
The Split command has three options for breaking a file into parts:
 

Split Option Description
Auto Split... Automatically divides the file into turns and

straight sections.
Split File With Mouse... Manually split the file at the indicated position
Split File by Time, Ping, or Event
Number...

Split the file at the specified time, ping or event
number.

 
NOTE: A sonar file that has been Trimmed must first be un-trimmed prior to performing the Split operation.
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Auto Split
 
The Auto Split function analyzes the selected sidescan and sub-bottom data sets and determines where
the turns occur in the file. Once the turns are identified the file will be broken up into separate sub-files, each
comprising of either a straight-away or a turn. See Splitting Sidescan and Sub-Bottom Data Sets for more
information.
 

 
SonarWiz uses default variables to aid the program in determining where to split the selected file which
is suitable for about 90% of all possible situations. If however Auto Split does not work as desired the
default values may be adjusted by selecting the >> button and adjusting the Advanced Setting variables as
described below:
 

Clip Turns

When selected, all sub-files determined to be turns will be deleted

Heading Computation

(Advanced Setting) The number of pings over which the average heading will be determined. The
heading deviation between consecutive heading computations will be used to determine when a turn
starts and when it is ended.

Heading Deviation (Start Turn)

(Advanced Setting) The size of the heading deviation between consecutive heading computations (in
degrees) that indicates a turn has started. See Heading Computation setting.

Reveal Advanced Settings

Click to reveal or hide advanced settings
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Turn Length

(Advanced Setting) This value determines the maximum length in pings that the function will go before
splitting the file.

Heading Deviation (Stop Turn)

(Advanced Setting) The size of the heading deviation between consecutive heading computations (in
degrees) indicating a turn has stopped. See Heading Computation setting.
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Split Sonar File With Mouse
 
The Split Sonar File with Mouse... function allows the user to divide a sidescan or sub-bottom file into two
independent files at the ping selected interactively with the mouse cursor. See Splitting Sidescan and Sub-
Bottom Data Sets for more information.
 
NOTE: The both sidescan and sub-bottom data must be in Draft or High Resolution drawing mode to split files
with the mouse.
 
To Split a sonar file with the mouse:
 
1. Select Split Sonar File With Mouse... command from the Sidescan File Context menu or the Sub-Bottom
Context Menu:
 

 

2. The mouse cursor will change to a cross-hair  indicating that SonarWiz is waiting for you to make a
selection in the main window.
 
3. Left-click the mouse cursor over the ping where you want to split the file.
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4. A dialog will open indicating the ping where the file split will occur. If this selection is correct, click YES to
split the file, if the you want to select a different ping, click NO and re-select the split point.
 

 
5. After accepting the split ping, SonarWiz will take a minute to divide the existing sonar file into two. Both files
will be added to the Project Explorer.
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Split File by Time, Ping, or Event Number
 
The Split File by Time, Ping or Event Number function allows the user to divide a sidescan file into two
independent files at the specified time, ping or event number. See Splitting Sidescan and Sub-Bottom Data
Sets for more information.
 

 

Time Stamp

When Split File at Time is selected, the file will be split at the user-specified date and time. The user
can specify the exact time stamp for the split by manipulating the individual data and time elements in
the dialog box. The time span of the selected file is indicated above the selection box and the dialog
will not allow you to chose a date or time outside of this range.  

Ping Number

When Split File at Ping is selected, the file will be split at the user-specified ping number. The user
can specify the exact ping number for the split by entering the ping number in the dialog box. The
range of ping numbers of the selected file is indicated below the selection box and the dialog will not
allow you to chose a ping number outside of this range.

Event Number
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When Split File where Event Numbers are 0 is selected, the file will be split into two sections, one
with valid event numbers, and one where the event numbers are 0. The user selects to start the
search at the beginning of the file or the end of the file. Optionally, the section of the file with 0 event
numbers can be deleted.
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Trim Ends of Sidescan and
Sub-Bottom Files with Mouse

 
The Trim command is used to temporarily hide the ends of sonar files from mosaics and image exports
(this command does not effect the waterfall digitizers). The trim command is found on the Sidescan Context
Menu and the Sub-Bottom Context Menu. To trim (hide) the end of a sonar sonar file, select the Trim Ends
of Sonar File with Mouse command from the Trim menu. To clear the trimming on the selected file, use the
Clear Trimming on Selected File command, or to clear trimming on all files, select Clear Trimming on All Files
command.
 
An alternative to manually trimming lines is to create a Polygon Feature that represents the area of interest
and use the Trim the Sonar Data to Feature Extents command.
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Trim Ends of Sonar File with Mouse
 
The Trim Ends of Sonar File with Mouse command is used to select the leading or trailing portion of a
sidescan and sub-bottom data set and hide it from view. The Trim Ends of Sonar File with Mouse command is
found on the Trim sub-menu of the Sidescan File Context Menu. You can restore the hidden section to view by
using the Clear Trimming commands also found on the Trim menu.
 
To Trim the end of a sonar file with the mouse:
 
1. Select the Trim Ends of Sonar File with Mouse command from the Sidescan File Context Menu.
 

 

2. The mouse cursor will change to a cross-hair  indicating that SonarWiz is waiting for you to make a
selection in the main window.
 
3. Left-click and drag the mouse cursor along the track line. The selected section will turn grey.
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4. When you release the mouse button, an information message will pop up to display the portion of the
selected line that will be hidden. If this is acceptable, click Yes, if you want to reselect, click No.
 

 
5. When you accept the selection, the portion of the data set highlighted in step 3 will become hidden from
view and will not be shown in exported mosaics, waterfalls or the plan view.
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The Clear Trimming on Selected File command will make visible again any portion of the data set hidden
from view by the Trim Ends of Sonar File with Mouse command. The Clear Trimming on Selected File
command is found on the Trim sub-menu of the Sidescan File Context Menu. The Clear Trimming on All
Files command will remove all trimming on all data sets in the SonarWiz project.
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Batch Copy Settings Between
Sidescan and Sub-Bottom Data Sets

 
The Make Others Like This... command is a batch processing tool for copying settings from a reference data
set to other similar data sets in the project. The Make Others Like This command is found on the Sidescan File
Context menu and the Sub-Bottom Context Menu.
 

Reference Data Set

The selected data set will be displayed by name and serves as the source from which settings will be
copied to other data sets.

Apply All Settings

Check this box to copy all settings in the reference data set to the target files

Settings to Copy

Select the individual settings in the reference data set that you want to copy. Only settings with
a check in the box will be copied unless the Apply All Settings check box is selected. The dialog
indicates the current value of the setting in the reference file to the right of the setting name. After the
copy operation, the target files will have matching settings.

Quick Target Selection
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Quickly select the target data sets in the project that match the checked boxes:
Quick Selection Description
Check All All target data sets in the project will be selected
Check SSS Only sidescan data sets in the project will be selected
Check LF SSS Only low frequency sidescan data sets in the project will be

selected
Check HF SSS Only high frequency sidescan data sets in the project will be

selected
Check SBP Only sub-bottom profile data sets in the project will be selected

Individual Target Selection

Select individual target data sets for processing, only checked data sets will receive the reference
settings.

Sort List by Time

Sort the target data set list by start time.
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CSF Time Offset
 
The CSF Time Offset window is used to add a static time offset to a single or group of CSF files in the project.
The CSF Time Offset window is found in the Sidescan Context Menu and the Sub-Bottom Context Menu.
 

 

Time Offset

Manually enter static time offset in Days, Hours, Minutes, Seconds, and Milliseconds.

Offset Checkox
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Used to choose which files will recieve the time offset entered above.

Check All Functions

Used to batch select either all of the LF or HF SS files in the project or all of the SBP files.

Current and New Start/End Times

Shows the current times in all of the files in the project and once the time offset is applied using Offset
Checked Files, will update with the new start and end time.

Offset Checked Files

Used to apply the offset to the selected files.
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Locate Project Files
 
The Locate Project Files command is used to reconnect or change file paths for items in your project. The
Locate Project Files command is found on the Tools menu.
 

Path/ File References Selection

Used to select the project item or collection that you can reconnect or change file paths for the project.
Currently the following items are supported in this tool:
 

Project Item File Path to Reconnect

CSF Acoustic Files Acoustic File
Contact Paths/Files Target File

Image

Feature Paths/Files Acoustic File
Image

Map Correction Targets Map Corrections

SBP Intersection Locations SBP Intersections
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Item Menu

Lists the current items in the project for the project item selected above and its specifications.
 

Column Description
Item Name Name of the project item
Index Links currently found

Path File path for item link to file
File File currently linked to item
Status Status of the link in the project, can either be green or

red indicating if a link has been made
Size Data size of the item in MB

Replacement Folder/ File Path

Used to select the folder or file of the new desired file path of the project item. Once selected, will
display the contents of the folder in the directory below.

Folder Directory

Displays all of the files currently stored in the selected folder.

Project Folder

When selected, will change the current folder path to the location of the project.



Locate Project Files

919

Set Folder for Selected Item(s)

Displays the currently selected folder, use the Set Path button to link the currently selected item(s) to
this folder.

Set File for Selected Item(s)

Displays the currently selected file, use the Set Path button to link the currently selected item(s) to this
file.

Save

Used to save changes made to file paths.
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Automatic Import
 

The Automatic Import tool  is found on the Post Processing Tab under the Import drop
down menu. Once enabled, SonarWiz will import and process any files in a monitored folder.
 
See Sidescan Auto Processing Settings for configuring automatic import of sidescan files.
See Bathymetry Auto Merge Settings for configuring automatic import and processing of bathymetry files.
 

Enable Auto Import

Once enabled, SonarWiz will begin monitoring the selected folder. When enabled, the tool will import
any files matching the Import File(s) criteria.
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Folder to Monitor

Used to select the folder that SonarWiz will monitor for raw sonar files.

Pattern to Monitor

Used to identify a specific annotation or file format to monitor in the selected folder. Leave this dialog
blank to attempt to import every file that is written into the folder. For example, *.xtf* will only import
XTF files written into the monitored folder.

Folder Options

The Include Monitoring Subfolders option when enabled will also monitor all subfolders in the
currently selected Folder to Monitor.
 
The Export Files to Monitor Directory option when enabled will export the entire contents of the
created Geotiff directory to the main monitored folder when the windows "lock" is disabled.
 
The Open Export Folder option when enabled will open the Geotiff folder in Windows explorer when
the windows "lock" is disabled.

Detected Files List

Will give a current list of files found in the monitored folder as well as a status that indicates if
SonarWiz was able to import the sonar file into the project.
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Statistics in Folder

Lists current statistics of the auto import process.

Process Files on Import

When enabled, will look at the pre-configured settings and apply them to the imported sonar files.
See Sidescan Auto Processing Settings for configuring automatic import of sidescan files
See Bathymetry Auto Merge Settings for configuring automatic import and processing of bathymetry
files.

Finalize Project

When Process Files on Import is enabled, selecting this option will run the configured settings in the
Finalize Project tab of the Automatic Processing dialog. See Finalize Project for more information.

Import File(s) as...

Drop down list of data type being imported from the monitored folder. Currently only sidescan and
bathymetry file types are supported.

Clear Detected Files

Clears the current files in the detected window.

Export Work Log

When selected, will export a CSV report of the files automatically imported. The file will be saved to
the Misc folder of the SonarWiz project and will have the following columns:
 
•  File Name
•  Path
•  Time Discovered
•  Time Imported
•  Import Flag
•  Total Files Discovered
•  Total Files Imported
•  Total Files Failed
•  Total Files Skipped
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Rename CSF Files
 
The Rename CSF Files window is used to rename an imported sidescan or sub-bottom file. The Rename
CSF Files window is found in the Sidescan Context Menu and the Sub-Bottom Context Menu. Users can also
rename the CSF file in the General tab of the Properties window.
 



Sidescan Sonar Data

924

Sidescan Sonar Data
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Importing Sidescan Data Sets
 
The Import... command is used to import raw sidescan data sets into SonarWiz. The import process reads the
native sonar files and converts them into Common Sensor Format (CSF). If the import process is successful,
the CSF files are stored in the CSF directory in the SonarWiz project folder.
 
NOTE: All SonarWiz sidescan processing occurs on the the CSF versions of the files, the original sonar files
are never modified.
 

Search Folder

Select the directory to look for sonar files.
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Sonar File List

The Sonar File List will display a filtered list of supported sonar files. One or more files can be selected
at once for import.

Selected Sonar Files

A list of the files selected for import

Supported Files Filter

The drop down provides filters for all supported sonar file types. Only the files that meet the filter
criteria are listed in the Sonar File List.

Properties...

Opens the Acoustic File Properties Report window for the selected file.
 

Sidescan Import Settings
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See Sidescan Import Settings for more information.

Open

Import the raw sonar file and create a CSF file in the CSF directory of the project.    

Cancel

Close the dialog without importing data.

Preview...

Opens a waterfall display showing a preview of the selected file.
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Sidescan Import Settings
 
The Sidesan Import Settings are used to control how sonar files are interpreted in SonarWiz. The sidescan
import settings are located on the Post Processing | Settings | SSS Import Settings... dialog and also found
at the bottom of the Import Sidescan Dialog (see Importing Sidescan Data Sets).
 
 

Process Files on Import

When enabled, will automatically process imported data based on the parameters set in the Configure
Auto Processing dialog. See Sidescan Auto Processing for more information.

Configure Auto Processing

Used to open the Configure Auto Processing dialog. See Sidescan Auto Processing for more
information.

File Type Specific Options..

Open the File Type Specific Options window. Here you can control settings unique to the particular file
format or sonar system you are importing.

Advanced Settings...

Opens the Advanced Sidescan Import Settings window.
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Channel Selection

Select the channels to import. SonarWiz can detect up to 6 channels of data in a sonar file, only 2 can
be imported (one for the port-side, one for the starbaord side). This setting allows you to choose which
channels to import and offers the option to swap channels if necessary.
 

SonarWiz
Channel Mapping

Description

1 Port-channel, low-frequency
2 Starboard-channel, low-frequency
3 (for dual-
frequency systems
only)

Port-channel, high-frequency

4 (for dual-
frequency systems
only)

Starboard-channel, high-frequency

5 (for tri-frequency
systems only)

Port-channel, very high frequency, motion tolerant data,
gap filler data

6 (for tri-frequency
systems only)

Starboard-channel, very high frequency, motion tolerant
data, gap filler data

Browse Coordinate Systems...

Some sonar file formats store position information in grid coordinates and do not contain latitude and
longitude information. For these file formats, you must indicate to SonarWiz the coordinate system in
use so that the navigation is properly interpreted. Click the Browse Coordinate Systems... button to
select the appropriate coordinate system in use by the files to be imported. (See Select a Coordinate
System Window).

Navigation data in XY or grid format

Some sonar file formats store position information in grid coordinates and do not contain latitude and
longitude information. For these file formats, you must indicate to SonarWiz the coordinate system in
use so that the navigation is properly interpreted. Toggle to automatically convert grid coordinates in
the sonar file.
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Advanced Sidescan Import Settings
 
The Advanced Sidescan Import Settings window is opened by clicking the Advanced Settings... button in the
sidescan import dialog.  The Advanced Settings allow the user to override project default settings for displayed
range, image resolution, and sonar projection.
 

Vessel Selection

This drop down allows you to select the appropriate vessel configuration to apply. The Vessel in the
project is currently utilitized for sidescan projects in 2 situations:
 
- When custom sidescan transducer separations are in use (this is uncommon)
- To set the heading source for the imported files, between Sensor Heading and Course Made Good.
 
See Vessel Editor for more information.

Sonar Range to Map

By default, SonarWiz will display all data out to the maximum range (100%). Reduce the displayed
range on import by adjusting this value.

Split Files if Time Gaps Occur check

When toggled, this option will create separate files if a time gap is detected during import based on the
value used in seconds between navigation updates.

Allow Far-Field Transparency check
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Toggle to blank far-field values that match the specified amplitude setting. This is helpful for
file formats that do not adjust the image width when the sonar range changes, leaving dark
borders around the actual data.

Course Smoothing

Navigation filtering is helpful for producing good sidescan mosaics. This setting controls the width
of the navigation filter in position updates. A value of 0 turns off navigation filtering, the default value
is 300 is recommended for straight-line surveying. Reduce the value for pole mounted systems
navigating in ports, harbors and rivers. See Course Smoothing and Interpolation for details.

Apply Pitch (if available) check

When available, apply pitch corrections. This is usually only available from sidescan data collected by
swath bathymetry systems.

Override Sound Velocity

Use SonarWiz Default Water Column Sound Velocity instead of sound velocity stored in the acoustic
file.

 

Samples per Channel

Set the across-track resolution of sonar imagery. Imported sonar traces are either down-sampled to
the selected across-track resolution (per channel) or can retain the resolution of the raw file. Use the
drop down menu to select between the following options:
 
- Manual (when enabled, will allow the user to enter the samples per channel in the text field with a
maximum of 32k)
- Actual (will retain the across track resolution of the raw file being imported)
- 1024
- 2048
- 4096
- 8192

Sample Compression

Set the compression algorithm for intensity values in CSF files. Users can set the compression
separately for raw and processed samples.
 
Algorithm Description
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Floating Point - None No compression, millions of values. (Note: All CSF files in
SonarWiz 7 prior to 7.04.001 used this setting)

8-Bit Log - 4x Reduces intensity to 256 values distributed logarithmically
with more values at the lower end of the distribution (Note:
This setting is a good default for most sonar data).

16-Bit Scaled - 2x Reduces intensity to 65,000 values distributed evenly
between the minimum and maximum value.

8-Bit Scaled - 4x Reduces intensity to 256 values distributed evenly
between the minimum and maximum value.
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Sidescan Auto Processing Settings
 
The Sidescan Automatic Processing tool is found on the Post Processing Tab under the Settings drop down
menu or in the Sidescan Import dialog. Once selected, will open the Auto Processing window which will allow
you to have SonarWiz automatically process, bottom track, apply gain options, and export various files from
imported sonar files.
 

Group Tabs

Used to navigate through the various groups of settings available in automatic processing.
 
See each section for more information:
- Import Settings
- Bottom Tracking
- Gain/ Signal Processing
- Finalize File
- Finalize Project
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Save / Load Settings

 
The buttons in this section allow you to save and load your settings configuration.
Button Description
Load Load a settings INI file from disk
Save Save a settings INI file to disk
Copy from
File

Configure processing settings to match a CSF file. SonarWiz will
import the bottom tracking settings and gain settings from the
selected CSF file.

Load From
App

Load previously stored settings from this project.

Save To
App

Save settings for future use in this project.

 

Settings Panels

Used to configure the various options that will be applied to the files when imported into SonarWiz.
See the Group Tabs section for more information on each of the options available.
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Ok

Click the finish button to save the current settings and close the dialog.

Cancel

Click the cancel button to close the settings dialog without saving the settings.
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Automatic Processing - Import Settings
 
The first tab in the Sidescan Auto Processing Settings is to review the import and general processing settings
and make any necessary adjustments. This section includes options for adjusting the following items:
 
•  Import settings (see Sidescan Import settings for more information)
•  Navigation and heading smoothing (see Course Smoothing and Interpolation for more information)
•  Water column sound velocity
•  Layback and sheave offsets (see Layback & Offsets for more information)
•  Nadir and range transparency (see Transparency and Displayed Range for more information)
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Automatic Processing - Bottom Tracking
 
The second tab in the Sidescan Auto Processing Settings is to review the bottom tracking settings and make
any necessary adjustments. The Bottom Tracking Settings control what algorthim is used and the blanking,
duration, and threshold values used to compute the altitude. See Bottom Tracking Sidescan Data for more
information.
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Automatic Processing - Gain/Signal Processing
 
The third tab in the Sidescan Auto Processing Settings is to review the gain and signal processing settings and
make any necessary adjustments. The Gain/ Signal Processing Settings control what algorthim is applied
upon import. See Sidescan Gain settings for more information.
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Automatic Processing - Finalize File
 
The fourth tab in the Sidescan Auto Processing Settings is to choose export options for each individual file

imported. Use the  to open the available settings for each of the export options. This section includes
options for exporting the following items:
 
•  Save Files as Tiles (see Save Mosaic as Tiles for more information)
•  Save Individual Geoimages (see Save Individual Geoimages for more information)
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Automatic Processing - Finalize Project
 
The fifth tab in the Sidescan Auto Processing Settings is to choose export options for all of the imported data.

Use the  to open the available settings for each of the export options. This section includes options for
exporting the following items:
 
•  Save Project as Geoimage (see Save Project as Geoimage for more information)
•  Save Project as Tiles (see Save Mosaic as Tiles for more information)
•  Sonar Coverage Report (see Sonar Coverage Report for more information)
•  Project Summary (see Project Summary for more information)
•  Navigation and Offset Report (see Navigation and Offset Report for more information)
•  Sonar File Summary (see File Summary for more information)
•  Sonar Altitude Summary (see Altitude Summary for more information)
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Sidescan Gain and Projection Settings
 

The Settings command on the Sidescan Context Menu control controls all sidescan signal processing
functions within SonarWiz. Each Gain control is discussed in detail below.
 

 
 

BAC Settings

(see Beam Angle Correction)

AGC Settings

See Automatic Gain Control (AGC) for more information
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TVG Settings

See Automatic Time-Varying Gain (TVG) for more information

EGN Settings

See Empirical Gain Normalization (EGN) for more information

Nadir Filter Settings

See Nadir Filter for more information

UGC Settings

See User-Defined Gain Controls (UGC) for more information

Beam Steering

Sonar data is plotted at right angles to the sensor's track; therefore, SonarWiz must be instructed
which heading to use for plotting data. Two possible choices exist: Course Made Good and Sensor
Heading.
 
Course Made Good
Navigation filtering is helpful for producing good sidescan mosaics. This setting controls the width
of the navigation filter in position updates. A value of 0 turns off navigation filtering, the default value
is 300 is recommended for straight-line surveying. Reduce the value for pole mounted systems
navigating in ports, harbors and rivers. See Course Smoothing and Interpolation for details.
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Sensor Heading
Taken from a Heading sensor inside the towfish. Sensors such as fluxgate compasses are not
normally accurate enough for projecting sonar data as they are subject to magnetic variations and
local deviation. Unless the heading sensor being used is a very accurate, such as an inertial gyro, this
setting should not be used.
 
If the file selected is computing a fish position using a layback algorthim and sheave offsets it will be
applied in a different direction based on the Heading Source currently selected above. See Layback
for more information.
 
Rotate Port/Stbd
These offsets should be used when a known bias is affecting the heading sensor in either channel.
 
Apply Pitch and Roll
If pitch and roll information is available for the towfish, SonarWiz can adjust the beam trajectory to
reflect the orientation of the fish. This tends to work best with pole mounted systems using high-end
motion sensors.

Destripe Filter Settings

See De-Striping for more information

Apply button

Applies the current gain settings to the sonar file and re-draws it without closing the dialog. This allows
you to immediately view the effect of a gain setting on the rendering of the sonar image.

OK button

Applies the current gain settings to the sonar file and closes the dialog.

Save button

Saves the current gain settings to a file so that they can be recalled in the future, used in another
project or sent to another user.

Load button

Loads gain settings from an existing file.
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Beam Angle Correction
 
The Beam Angle Correction function (BAC) attempts to compensate for non-linear response characteristics
of the sonar transducers. It was developed by Bill Danforth, U.S. Geological Survey:
 
“Data records collected from any sonar system generally have artifacts that are related to the non-linear
response of the transducers for that system. This results in areas that may be darker or lighter in the data
record as you look in the along track direction. Time varied gains applied by the system attempt to compensate
for this, however many times this is inadequate depending on the system and bottom type. For example, older
analog Klein systems usually have very high backscatter values at nadir unless the operator finely tunes the
system prior to launching the towfish. If the data file were to be mapped without correcting for this effect, the
result would be a “stripy” data file that would detract from the overall backscatter variations as seen in the
mapped image and hinder interpretation.”
 
Danforth, William W., 1997 Xsonar/ShowImage: A Complete System for Rapid Side Scan Sonar Processing
and Display, U.S. Geological Survey Open File Report 97-686, 77 p.
 
There are two BAC settings available in the dialog:
 
Pings: The number of sonar pings on which the averaging function will work. This setting should usually be in
the 100-200 range.
 
Average: The “ Average ” slider controls the amount of overlap between adjacent processing blocks.
Averaging helps to smooth the transition from one processing block to the next.

 
Note : The BAC function is computationally intensive. In

general, it is best to process the mosaic with this option turned
off initially. Enable the function when the mosaic is setup the

way you want it and bottom tracking has been performed.
Tip : Adjust the Intensity value to a suitable level first and keep
the Resolution setting as high as possible reducing it only to

normalize images with highly varying intensities across track..
 
Example:
 
Before BAC Applied
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After BAC Applied
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Automatic Gain Control (AGC)
 

For most sidescan sonar applications, the amplitude of a reflected signal should imply small-scale “local”
relief on the ocean floor such as ridges, rock formations or man-made objects. To achieve this, the large-
scale effects of the incidence angle and propagation distance on the amplitude of a signal’s reflection must be
eliminated. This is the purpose of the Automatic Gain Control (AGC).
 
Incidence angle: A reflected signal that has an incidence angle of 0° from the normal (for example, one
reflected by a horizontal floor directly beneath the signal source) will be much stronger than the reflection of
a signal with a high incidence angle (a signal that was propagated nearly parallel to the floor) and therefore
which reflects very little towards the receiver. This means that remote terrain will reflect a “quiet” background,
whereas close terrain will reflect a “loud” background. This disparity in background adversely affects how
objects of interest are highlighted.
N.B. Incidence Angle = 90° – Grazing Angle
 
Propagation distance: A reflection that is received at a distance of 5 yards will be proportionally stronger
(by the inverse square of the distance) than one that is received at 50 yards. For this reason also, proximate
terrains will reflect more loudly than remote terrains.
 
The AGC Algorithm: The AGC algorithm used by SonarWiz measures a local average signal strength, and
then rescales all the data so that the local average is shifted to some chosen global average that determines
on the large-scale how quiet or loud the data will be after rescaling. More specifically, the local average at a
given ordinate is computed by averaging some number of samples (amplitudes) to the left and right of this
ordinate.
 
The number of nearby samples that are used in this average can be varied. In one extreme, if zero samples
are used on either side, then the local average at a given ordinate is its original amplitude. Then the rescaling
essentially shifts all of the local averages, and hence the original data, to some constant, the global average. In
this case, the rescaled data is a constant, and all information is lost. In the other extreme, the entire domain of
samples is averaged, so that there is one (constant) local average. The rescaling in this case will move all the
data roughly uniformly, so that the single local average is shifted to the chosen global average. In either case,
the large-scale effects are not canceled at all. Rather the entire set of data becomes either uniformly louder or
quieter. Thus, an intermediate window of samples that will most effectively strengthen the quiet regions and
diminish the loud regions must be chosen.
 
After a local average is computed at each ordinate, the data is rescaled so that the local average is shifted
to some chosen global average. Additionally, the rescaling function fixes silent signals (zero amplitude) and
signals that are as loud as the range allows. This preserves the contrast of the data so that the extremely quiet
and extremely loud reflections remain such. Also, for aesthetic reasons, the function is differentiable (smooth)
and symmetric, so that data that is shifted downward (meaning the local average at that ordinate was greater
than the global average) is treated exactly oppositely to the data that is shifted upward.
 
AGC Settings: The AGC Gain control offers two settings for adjusting both the darkness (Intensity) of the
gain as well as the aggressiveness of the smoothing (Resolution) applied by the function.
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All sonar data should be be bottom-tracked prior to applying AGC.

 
Intensity: This slider setting determines the overall brightness of the processed image. The greater the
Intensity setting the greater the brightness of the processed image.
 
Resolution: This slider sets the size of the gain sampling window as a percentage of the full swath width. A
value of 1 would result in a smoothing window 1% of the across-track swath width. A resolution setting of 100
would result in a smoothing window stretching 100% across the entire swath.  Users will notice that a lower
slider value number results in the image developing an “embossed” look and the resolution decreasing. A
higher slider value leaves resolution intact, but reduces the effect of the normalizing filter.
 
 
Example:
 
Before AGC
 

 
After AGC
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Automatic Time-Varying Gain (TVG)
 

The Auto TVG function operates by dividing the data into many parallel swaths, attempting to equalize the
backscatter of each swath. The Root Mean Square (RMS) power of each swath is compared to a desired
power level. The error signal is fed back to an IIR filter [2] and the gain for that swath is adjusted in the
opposite direction.
 
The Auto TVG function can be envisioned like a large graphic equalizer where the sliders automatically adjust
to keep the power in each band (swath) constant over time.
The final gain curve applied to the data is a filtered version of the swatch coefficients. This prevents banding
due to discontinuities at the swath edges.
 
Using Auto TVG
 
The port and starboard gain/attenuation controls can be used independently to balance two channels whose
overall reflectivity differ significantly from each other.
 
The sliders operate from -100 to +100:  Negative values (0 to -100) produce attenuation by multiplying the
Auto TVG result by (1.0 to .01), respectively. Positive values (0 to +100) will multiply the result of the Auto TVG
function by 1.0 to 2.0, respectively.
 
Example:
 
Before TVG
 

 
After TVG
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Empirical Gain Normalization (EGN)
 
Empirical Gain Normalization (EGN) works extremely well in most situations and can be considered a
replacement for BAC. EGN is a function that sums and averages up all of the sonar amplitudes in all pings in
a set of sonar files by altitude and range. The amplitude values are summed and averaged by transducer (port
and starboard) so there are actually two tables. A given sonar amplitude sample is placed in a grid location
based on the geometry of a ping. On the x-axis of the grid is range. On the y-axis of the grid is altitude. The
resulting table is used to work out the beam pattern of a sonar by empirically looking at millions of samples of
data.
 

A note from a CTI client on EGN:
“I have found that EGN is far superior in its results than BAC.
It brings up the contrast ratio of the imagery extremely well
with less "washout" of the data thus preserving resolution.
The key with EGN however is lots of coverage in your mosaic
with the more data the better.

 
 
Multiple EGN Tables: EGN works best when all data from a given sonar are processed together. The more
datasets entered into the EGN table the better the statistical model of the sonar becomes. However, there are
some situations that where it becomes necessary to use multiple EGN Tables.
 
For a given EGN Table:
 
1. All datasets in a table must be collected from the same sonar system
2. All datasets in a table should be collected at the same frequency, pulse width and power
 
Basically, if anything about the sonar system is changed during the survey, you should separate those files into
a new group and create a separate EGN table to handle the new conditions this change has brought into the
data.
 
For example, if you have a dual-frequency sidescan sonar, you should process the low-frequency data using
a low-frequency EGN Table and the high-frequency data using a high-frequency EGN Table. A new feature of
SonarWiz 7.1 is the ability to have multiple named EGN Tables in a project
 
Example:
 
Before EGN
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After EGN
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Building EGN Tables
 
 
How to build an EGN Table for a set of files
 
1. Open the settings dialog for a sidescan file (Right-click a sidescan file and select Settings... from the
context menu)
 
2. Select Enable EGN. Make sure you have choosen the correct Smooth option in the dialog before creating
the EGN table, this will effect the smoothing kernel used in the table creation. The default value is 3.
 

 
3. Select the Rebuild EGN Table... button to open the Build Empirical Gain Normalization (EGN) Table window
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4. Give the EGN table a name.
 
5. Select the files that will be added to the table. You can use the checkboxes to automatically select all of the
LF (CH12) or HF (CH34) files in the list below OR use the Create 1 Table Per File to have SonarWiz create an
individual EGN table for every file loaded into the project.
 
5. Click Start to build the EGN Table.
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Build Empirical Gain
Normalization (EGN) Table window

 
The Build Empirical Gain Normalization (EGN) Table window is opened from the Sidescan Sonar Gain
Settings dialog. This dialog controls the creation of new EGN tables for use in EGN processing.

 

EGN Table Name

Give the EGN table a name to help identify it. A SonarWiz project can have several EGN tables
available for use. If you use an existing name SonarWiz will silently overwrite the previous table.
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File Selection Check Boxes

The File Selection Check Boxes can quickly pick all of the files in the project or only files from a
particular frequency.

File Selection List

You can individually select which files will be added to the EGN table (more is usually better).

Show Full File Path

When enabled, will show the entire file path of the CSF files in the File Selection List.

Start Button

Start building the EGN table.

Abort Button

Close the dialog without building an EGN table.
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Apply EGN Table to a Dataset
 
To apply a named EGN table to a dataset:
 
1. Select a sidescan file in the set of files you want to apply EGN.
2. Right click and open the Settings dialog from the sidescan dataset context menu.
3. Select Enable EGN.
 

 
4. Select the EGN Table you wish to use from the EGN Table drop down list.
 

 
5. Make sure to set the proper Smooth value to apply to the files using this EGN table. This setting is a
smoothing kernel used when APPLYING EGN, not when creating the table. The default value is 3, 0 will turn it
OFF.
 

 
6. Click OK to apply the changes.
 
7. Right click the selected file and select Make Others Like This... to open the Apply Settings to Selected
Files dialog
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8. Select EGN in the Settings to Apply group and then check the files you want to normalize in the Files to
Modify group.
You should see next to EGN in the Settings to Apply group something like this: [on; Low Frequency; Smooth:
3] which indicates that the Reference line has EGN turned on and that it is using the table named "Low
Frequency" with a smoothing kernel of 3.
 
9. Click OK to apply the EGN using the selected table to the remainder of the files.
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Nadir Filter
 

The Nadir filter is a special version of the AGC filter that runs only along the nadir stripe. It is designed to
reduce the difference between the nadir pixel values and the values immediately outside the nadir. The user
controls the angular width of the filtered zone in degrees.
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De-Striping
 

The De-Striping function can be used to reduce the effects of a ‘pitching’ sonar that is characterized by a
pattern perpendicular to the direction of travel. A sample of a section of data before and after the de-striping
function has been applied is displayed below.
 

 
The destripe filter processes each ping by comparing the current ping brightness to a filtered version of the
sonar file that has smoothed out the stripes. If the current ping is too bright or too dark compared to the filtered
record, an appropriate adjustment is made.
 
The user controls the length of the smoothing filter in number of pings. The best way to estimate the
appropriate ping settings is to open up the digitizer on one of your files and count the number of pings between
the start and end of a typical stripe you want to remove (look at the ping number in the cursor info section).
The smallest number that works is the best one to use.
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To set the destripe filter ping lengh, open the digitizer and count the number of pings between the start and end
of a typical stripe you want to remove.
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User-Defined Gain Controls (UGC)
 
Two types of user-defined gain functions are provided by SonarWiz. Time Varying Gain and Manual Gain
Control. Both options create a gain function (curve) as a function of range. The curves are logarithmic
(decibels) in the gain setting displays, but the curve values are converted back to linear multipliers and
normalized before applying the data to keep the processed intensity data in the same range as the input data.
 
The algorithm works like this:
 

1. Compute the logarithmic gain curve (in dB) as a function of range
 
2. Convert the logarithmic gain curve to linear units using the following formula:

Linear Gain = 10( Logarithmic Gain / 20 )

 
3. Find the maximum gain to be applied to the track line and compute a normalizing scalar
scalar = 1 / max gain
 
4. Compute the output intensity:
output = input intensity * gain * scalar.

 
 
Time Varying Gain (TVG) Control
 
Time Varied Gain attempts to create an even display of sonar data from the near ranges to the far by
compensating for geometric spreading losses and absorption losses using a conventional propagation loss
formula.
 
See Time Varying Gain for details.
 
Manual Gain Control
 
In Linear Gain Control the user has a series of nodes that can be manipulated in pairs (port and starboard) or
independently. The nodes are adjusted by a left-click and drag such that an overall gain curve is created and
then applied to the selected file. The user will likely adjust nodes, apply the new curves and repeat until the
sonar file is at level where the user may see the features that are being investigated.
 
See Linear Gain Control for details.
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Time Varying Gain (TVG) Control
 

The Time Varying Gain (TVG) control panel is available from the Sidescan Settings window when Enable
UGC is enabled, and UGC mode is set to TVG.

 

 
 
 

Enable UGC

 Toggle to Enable UGC gain operations.

TVG Graph

 The TVG Curve Graphs display the current value of the TVG gain in dB as a function of time. You can
manipulate the curve with the mouse and the formula settings will be adjusted accordingly.
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TVG Starting Point

The TVG curve can start at time zero (transmit) or at first bottom detection.

Synchronize Port/Starboard Gains

When checked, the same gain formula will be applied to both port and starboard channels. When
unchecked, you can specify the port and starboard gain formula separately.

Initialize User Gain Curve with TVG

  Transfer the computed TVG curve to the Linear Gain Mode panel where it can be manipulated by hand.
SonarWiz will ask for the number of nodes used to define the curve. The default is 16.        
 

  
 

TVG Mode

  Select TVG Mode to display the TVG panel.

TVG Curve Settings

Set the transmission loss equation used for applying time varying gain to sonar samples:
 
The transmission loss (TL) due to spherical spreading, corrected for attenuation is:
TL = 20 log(R+1) + #(R) + b
where:
R is the range in meters
# is the attenuation coefficient in dB/m
b is a static offset in dB
 
The dialog allows you to change the first coefficient, the attenuation coefficient and the static offset.
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Estimate Attenuation

The attenuation coefficient in the TVG term can be estimated by SonarWiz if you know the salinity of
the water. SonarWiz will use the salinity along with the sonar frequency to compute an approximate
attenuation coefficient that is a suitable starting point for most TVG computations. Set the salinity of the
water and click Auto Fill TVG button to fill the attenuation value in the TVG Curve Settings formula.

Info at Cursor

Displays a current Info at Cursor in the TVG curve window.
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Linear Gain Control
 
The Linear Gain Control control panel is available from the Sidescan Settings window when Enable UGC is
enabled, and UGC mode is set to Linear Mode.
 

 

Enable UGC

Toggle to enable UGC gain operations.

Linear Gain Graphs

The gain curve displayed in this panel is designed to be adjusted by the mouse. You can initialize the
curve using the TVG panel or start from a flat line. The following table shows you how to add nodes to
the curve and manipulate the curve as desired.
 

Action Command
Add a node Double-click the graph
Move a node Left-click and drag the node
Remove a node Select the node and hit the Delete Key
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Synchronize Port and Starboard Curves

When checked, the port and starboard gains will by synchronized.

Reset UGC

Reset the Manual Gain Graphs to their default values.

Linear Mode

Select Linear Mode to display the linear gain panel.

Open Vertex Table

Rather than moving the graph verticies with the mouse, click this icon to open a table where you can
edit the verticy values directly. See Edit UGC Vertices Table.

Time vs Range

Click the box to change the graph from displaying gain vs time to gain vs range.

TVG Starting Point

Select Time Zero to start TVG at the transducer, select Detected Sea floor to start the TVG gain at the
seafloor (bottom track).
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Edit Vertices (UGC)
 
The Edit Vertices (UGC) dialog is used to manually key in the vertices of the User Gain Control graph. The

table is opened by clicking on the table icon  in the UGC linear graph.
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UGC Vertex Table

The vertex table lists the vertices in the UGC graph. You can select and edit any vertex in the table
by clicking on the vertex row and using the Selected Vertices text box below the graph to change the
time, distance or gain values.

Add, Delete and Save

The + button will add a vertex to the graph
The - button will delete the selected vertex from the graph
The ^ button will save the selected vertex to the graph

Edit Vertex

Edit the selected vertex. You can change the time (ms), distance (m) or gain (dB) value

Bulk Selection

Bulk selection buttons. Select all vertices, Select no vertices, Invert (reverse) selection.

Sound Velocity

Edit the sound velocity used to convert time to range in the table.
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OK / Cancel button

Click OK to save changes. Click Cancel to abandon any changes to the table.
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Sidescan Analysis Window
 

The Sidescan Analysis window is the primary interface for working with sidescan profiles. It can be opened
from the Sidescan Context Menu or the Post Processing Menu by selecting a sidescan profile and clicking
on the Bottom Track or Digitize View commands. The Sidescan Analysis window uses a tabbed interface to
organize sidescan profile commands into five categories: bottom tracking, features, contacts, playback, and
appearance. When a tab is selected, the ribbon command bar will change to reflect the selected category.
 
This page describes the features of the sidescan analysis window that are common to all five command
categories. Subsequent pages will describe each command category (tab) in detail.
 

Tab Bar

The Tab Bar organizes sidescan commands into five command categories described in the table
below.

 
Category

(Tab)
Description

Tracking Manual and Automatic tools for determining the
altitude of the profiler above the seabed or far

field. See Bottom Tracking for more information.
Features Tools for drawing features. See Features for more information.
Contacts Tools for placing and editing sidescan

contacts. See Contacts for more information.
Playback Tools for playing back data in the analysis

window. See Playback for more information.
Appearance Tools for controlling how sidescan profiles will

appear in the analysis window and other profile
exports. See Appearance for more information.
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Ribbon Command Bar

The Ribbon Command Bar contains the buttons and widgets for activating the various commands
available for working with sidescan data in the analysis window. The specific commands available
depend on the tab selected in the Tab Bar.

Sidescan Toolbar

The Sidescan Tool bar is a dockable window that is enabled in the Appearance tab. The tool bar can
be detached and positioned wherever is convenient for your work. See Sidescan Analysis Window Tool
Bar for more information.

Signal Trace

The Signal Trace displays a relative amplitude trace for the ping currently under the cursor. The
signal trace will appear directly to the right of the sidescan profile display when enabled. See Sidescan
Signal Trace for more information.

Profile Display

The Profile Display window shows the sidescan data in a waterfall display. The display also shows
annotations, contacts, and features. The native unit of the vertical axis of the profile window represents
ping time, although it is usually converted to approximate range using a constant sound velocity. The
horizontal axis of the plot is ping number.
 
Each ping will occupy a single row of pixels in the waterfall, this usually results in the along-track
resolution of the image being greatly compressed. The Speed Correction option in the Annotations/
Display Options will scale the ping-to-ping distance so that the horizontal and vertical scale of the
image are approximately the same.
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Horizontal Scroll

Use the horizontal scroll bar to pan through the file by ping number.

Vertical Scroll

Use the vertical scroll bar to pan through the data by time (range) from the source.

(Right Click) Cable Out Node/ Split

To manually insert a cable out node, locate the desired ping or time stamp using the cursor information
window, then Right-Click and select Add Cable Out Node. The Set Cable Out window will open to
allow you to add the desired cable out distance in meters or feet.
 

 
Once the node is inserted, it will be displayed as a horizontal line across the waterfall.
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You can delete a cable out node by Right-Clicking the node and selecting Delete Selected Cable Out
Node. You can edit a node by Right-clicking the node and selected Edit Selected Cable Out Node.
 
When you are finished inserting cable out nodes, click the Save button to save your work. A graph of
the cable out nodes you have inserted will be displayed for your inspection:
 

 
You can accept the or cancel the save operation at this point.

 
To manually split a sidescan file in the analysis window, locate the desired ping or time stamp using
the cursor information window, then right-click and select Split This File into Two Separate CSFs.
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Tracking (Sidescan Analysis Window)
 
The Sidescan Tracker is the first Tab of the Sidescan Analysis Window. It can be opened in several ways:
 

1. Select the Bottom Track  icon from the Post Processing Menu.
2. Select the Bottom and Far Field Track... command from the Sidescan Context Menu.
3. Select the Tracking tab from anywhere in the Sidescan Analysis Window.
 
The purpose of the Tracker is to identify the first acoustic return from the seabed thereby setting the altitude of
the sidescan head above the seafloor. SonarWiz includes an integrated manual and automatic bottom tracker
for sidescan data.
 
Sonar files that have been bottom tracked in post-processing will have their file names shown in bold in both
the Project Explorer and the Sonar File Manager.
 

Tracking Settings

Use the Track drop down menu to select either to track the bottom (first return) to the far field (last
desired return) on the sidescan dataset. By default, the entire range of the data will be displayed until
a new far field track is drawn.
 
The user has the option to use the same above mentioned manual or automatic tracking options as
you can for the bottom track. Once the desired erroneus data is tracked in the far field tracker, it can
be removed from display using the Adjust Displayed Range option.
 
Use the Channel drop down menu to select the channel to bottom or far field track. By default,
SonarWiz synchronizes the port and starboard track so they will have identical bottom or far field
tracks. The user can select whichever channel provides the best view of the seabed and it is safe to
change channels as you progress down the file and conditions change. This is the recommended
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mode for all conventional sidescan towfish for bottom tracking but should be turned off when far field
tracking if the erroneus data is not consistent on both the port and starboard of the data.
 
Some uncommon sidescan systems (typically mounted on AUV platforms) have a very large
separation between the port and starboard staves where the bottom track is likely to differ substantially
between the port and starboard channel.  In this case, you can uncheck the Sync port and starboard
check box and track each channel separately.

Tracking Algorithm

Use the Algorthim drop down menu to select the bottom tracking algorithm used for Automatic
Bottom Detection. There are two algorithms available:
 

Name Description
Edge Detection This algorithm uses image processing techniques to

identify the line representing the border between the water
column and the seafloor. Robust against noise in the water
column so long as the seabed topography changes gently.

Threshold
Detection

This algorithm works a ping-at-a-time to find the seabed
by identifying the first sample that exceeds the average

ping intensity by the specified threshold. This algorithm is
sensitive to noise in the water column but works better than
Edge Detection when the seabed has a lot of topography.

 
The Smoothing Filter toggle is used to enable bottom track smoothing.  Applies a box-car filter to the
bottom-track line to remove high frequency noise. Note: disable this before bottom-tracking, then apply
after bottom-tracking. 

Auto Tracking Settings

The auto tracker is used to automatically track a sonar file. There is one tracker for the port channel
and one for the starboard channel, the channel setting determines which one (or both) are active.
There are three parameters:
 
Blanking: The blanking distance sets the minimum distance away from the sonar head the bottom
tracker will search for the seabed or the distance from the outer extents of the range. Any pixels closer
to the sonar head or outer range than the blanking distance are assumed to be in the water column or
errnoeus data in the far field. You should examine a file for the minimum distance in the watercolumn
or far field and set the blanking distance somewhat above this value.
 



Tracking (Sidescan Analysis Window)

977

Duration: If there is a lot of debris or fish in the water column or consistent erroneus data in the far
field, increasing the duration will help the bottom and far field tracker to skip over bright pixels that are
relatively small compated to valid data.
 
Threshold:The threshold determines how bright the bottom or far field pixels must be compared to the
water column or erroneus data. If the bottom tracker is a floating a line above the seabed or the far field
tracker isnt skipping over the erroneus data, increase the threshold; if the bottom tracker is penetrating
the seabed too far or the far field tracker is penetrating good data, decrease the threshold.
 

Operations

To erase the existing bottom or far field track, click the Clear button.
 
 Click Track All button to bottom of far field track the file using the parameters set in the Auto Tracking
Settings.
 
The Track from Ping button runs the Threshold Detection bottom tracking algorithm starting at the
specific ping number and either tracking forward or backward through the data set. See Track from
Ping for more information.

Manual Tracking

Manual bottom or far field tracking consists of using the mouse to trace the interface between the
seabed and the water column or the far field.
 
To insert nodes into the bottom or far field track, click the Insert Points button and use the Left mouse
button. The cursor will change to a plus symbol and you can insert nodes into the bottom or far field
track anywhere along the line.
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To remove nodes from the bottom or far field track, click the Remove Points button and hold down the
Left mouse button to drag a rectangle over the nodes you want to delete. The cursor will change into a
no symbol and remove all of the nodes in the selection.
 

 
You can also activate the Remove Points command while still in Insert Mode by right-clicking and
draging a box.
 
When the Auto Scroll options is checked, this will automatically scroll the waterfall window down if
you insert a bottom or far field track node near the bottom of the display.
 
The Color drop down menu is used to select the Line Color of the bottom track or far field.
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Track from Ping (Sidescan)

The Track From Ping command is available by clicking the  icon on the Bottom Tracking tab of the
Sidescan Analysis Window. This command runs the Threshold Detection bottom tracking algorithm starting at
the specific ping number and either tracking forward or backward through the data set.
 

Tracking Parameters

Set the blanking, theshold and duration used by the Threshold Detection bottom tracking algorithm.
See the description in the Bottom Tracking Algorithm section of the Bottom Tracking tab for more
information.

Starting Ping Number

Specify the starting ping number. The tracker will proceed forward or backward from this point to the
end of the data set.

Tracking Direction

Specify the tracking direction. Click the Track Backward button to proceed from the specified ping
backward to the beginning of the data set. Click the Track Forward button to proceed from the
specified ping forward to the end of the data set.
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Offset Bottom Track (Sidescan)
 

The Offset Bottom Tracked Solution window is opened by clicking the  Offset Bottom icon from the
Bottom Tracking Tab of the Sidescan Analysis Window. This command allows you to apply a static offset to the
bottom track.
 

Current Offset

The current value of the static offset. This value is applied to both the port and starboard channels.

Adjust Offset

Apply addition offsets in meters. Negative values move the towfish altitude closer to the sea surface.
Positive values move the altitude towards the sea floor. Values are applied cumulatively.
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Features (Sidescan Analysis Window)
 
The Features Window is the second Tab of the Sidescan Analysis Window. It can be opened in several ways:
 

1. Select the Digitizing View  icon from the Post Processing Menu.
2. Select the Digitize New Features... command from the Sidescan Context Menu.
3. Select the Features tab from anywhere in the Sidescan Analysis Window.
 
The purpose of the Features tab is to allow the user to create and edit features in the sidescan data.
 

Current Features

The Current Features drop down menu is used to visualize and select features that have been drawn
on the currently opened sidescan file.

Feature Display Options

The Show Contact Based Features checkbox when enabled will display map features created in the
Contact Editor.
 
The Show Features from Other Files checkbox when enabled will display map features from all files
or drawn on the map display.
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Feature Buttons

The New button will create a new feature linked to the current sidescan file. You will first specify the
name of the feature and its attributes in the Create New Feature dialog. Then, you begin to digitize the
reflector using the mouse. Use the  drop down menu to select between any of the support feature
shapes.
 
The Edit button will open the Edit Feature window on the selected feature. There you can modify or
adjust the feature name and attributes.
 
The Delete Feature button will remove the selected feature from the project. It is possible to restore
deleted features in the Feature Manager.

Preferences

The Preferences button opens the Preferences/ Settings dialog to the Features section.
 



Contacts (Sidescan Analysis Window)

983

Contacts (Sidescan Analysis Window)
 
The Contacts panel is the third tab of the Sidsescan Analysis Window. It can be opened in several ways:
 

1. Select a Sidescan Dataset and click the Capture Contact  icon on the Post Processing Menu.

2. Select the Capture Contact  button on the Sidescan Analysis Window Toolbar.
3. Select the Contact tab from anywhere in the Sidescan Analysis Window.
 
The purpose of contacts panel is to provide tools for capturing and editing contacts (targets) from the sidescan
profile display. Note that contacts are listed in the Contact Manager  where they can be filtered, exported, and
archived.
 

Current Contacts

The Current Contacts drop down menu is used to visualize and select features that have been drawn
on the currently opened sidescan file.

Contact Buttons

The New button will create a new contact linked to the current sidescan file. Use the  drop down
menu to select between any of the supported contact types.
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The Edit button will open the Contact Editor window on the selected contact. There you can modify or
adjust the contact name and attributes as well as mensurate.
 
The Delete button will remove the selected contact from the project.

Preferences

The Preferences button opens the Preferences/ Settings dialog to the Contacts section.

Contact Icon

Created contacts will display on the digitizer view based on settings applied in the Contact Editor.
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Playback (Sidescan Analysis Window)
 

The Playback panel is the fourth tab of the Sidsescan Analysis Window. It can be opened by selecting the
Playback tab from anywhere in the Sidescan Analysis Window.
 
The purpose of Playback panel is to provide tools for playing back the sidescan data to recreate it being
streamed in real time.
 

Playback Controls

The Playback Controls are used to play/ pause, move forward or backward, or jump to the start or
end of the line.

Speed

 The Speed Slider is used to adjust the speed of playback.
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Go to Ping

The Go to Ping button opens the Jump Playback to Location menu and is used to quickly jump the
playback to a specific time or ping.
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Appearance (Sidescan Analysis Window)
 
The Appearance tab of the Sidescan Analsysis Window provides controls for modifying the appearance
of the sidescan data including gains, annotations, scaling, and some basic image processing options.
The Appearance tab also has controls for enabling and disabling various widgets in the sidescan analysis
environment such as the toolbar and signal trace. It can be opened by selecting the Appearance tab from
anywhere in the Sidescan Analysis Window.

Gain Settings

The Gain Settings button opens the Sidescan Gain and Projection Settings window.

Image Appearance

The Annotation button opens the Annotation/ Display Options window.
 
The Slant Correct button will toggle the image between slant range and non-slant range corrected
imagery which will remove the watercolumnn based on the altitude currently stored in the file. To
adjust the altitude (bottom track) see Bottom Tracking.
 
The Fit Width button zooms the waterfall display to match the window width.
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Digitizer Windows

The Show Toolbar button toggles the Sidescan Analysis Toolbar.
 
The Show Info at Cursor button toggles the Sidescan Info at Cursor window.
 
The Show Signal Trace button toggles the Sidescan Signal Trace.
 
The Full Screen button opens the window in Full Screen mode. Use the ESC button to turn off Full
Screen mode.
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Sidescan Analysis Toolbar
 

The Sidescan Analysis Toolbar is available by clicking the Show Toolbar  button on the Appearance
tab of the Sidescan Analysis Window. The toolbar provides quick access to zoom and pan the display as well
as buttons for digitizing new features and contacts.
 

Save

Saves the current edits to the bottom and far field track.

Copy

Copies the current display in the waterfall to the clipboard.

Next/ Previous File

Moves to the new or previous file in the Project Explorer.

Measure

Changes the cursor to Measure mode and can be used to draw line features on the digitizer view
which are annotated with the distance.
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Add Point Feature

Opens the Add Point Feature creation dialog.

Add Polyline Feature

Opens the Add Polyline Feature creation dialog.

Capture Contact

The Capture Contact button will put the cursor into Contact Insert mode . Left-click on the
profile display to enter a new contact at the cursor location. You may enter as many contacts as
desired. Right-Click the mouse to Exit Contact Insert mode.

Capture Freespan Contact

Opens the Freespan Contact creation dialog.

Capture Linear Contact

The Capture Linear Contact button will put the cursor into Linear Contact Insert mode . Left-
click on the profile display to enter a new contact at the cursor location. You may enter as many
contacts as desired. Right-Click the mouse to Exit Contact Insert mode.

Sync Scroll

Enables syncronized scrolling between opened digitizing views.
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Sidescan Signal Trace
 

The Sidescan Signal Trace is displayed by clicking the Show Signal Trace button  located on the
Appearance Tab of the Sidescan Analysis Window. The Signal Trace displays a relative amplitude trace for
the ping currently under the cursor. The signal trace will appear directly above of the sidescan display when
enabled.
 

Amplitude Trace

The ping amplitude is represented by a red (port) and green (starboard) line. Vertical units will match
the sidescan display panel, horizontal units are relative, with the maximum amplitude value to the right
of the plot.

Bottom Track Marker

The vertical time/depth of the bottom track for the ping under the cursor is marked with a yellow
horizontal line.
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Auto Hide/ Close

Use the  icon to Auto Hide the Signal Trace window which means that when another section of the
screen is made active (by a left or right-click for example) the window will slide closed against the side
to which it is docked.
 
Use the  icon to close the Signal Trace window.
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Sidescan Info At Cursor Window
 

The Sidescan Info At Cursor window is opened by clicking the Info At Cursor button  on the
Appearance Tab of the Sidescan Analysis Window. The Info At Cursor display is dynamically updated to show
file and ping properties and attributes of the samples directly beneath the mouse pointer when panned over the
sidescan data.
 

 
The following table describes the cursor information displays:

Ping Date and Time
Ping Number Water (WD) and Sensor (SD) Depth

Latitude Northing
Longitude Easting
Heading Course Made Good

Slant (S) and Ground (G) Range Speed
Sensor Altitude Event Number

Kilometer Point Cable Out
Image Record (Column) Image Pixel (Row) Pixel Amplitude
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Monitoring Real-Time Sidescan
Data in the Analysis Window

 
The Sidescan Analysis Window can be opened in monitoring mode during real-time data collection (See
Monitoring SSS 1/2 in waterfall or Monitoring SSS 3/4 in waterfall). In this mode, sidescan data from the
selected channels is displayed as it is received, ping-by-ping. The Monitor real-time data in Waterfall command
requires an acquisition license to be active. To open the sidescan analysis window in this mode:
 
1. Select the Monitor SSS 1/2 in waterfall (or Monitor SSS 3/4 in waterfall) command from the Sidescan
Branch Context Menu in the Project Explorer.
 
See Sidescan Analysis Window for more information.
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Exporting Images of Selected
Sections of Sidescan Data Sets

 
The Export Image of Selected Section is an interactive tool that allows the user to select a portion of a
sidescan file to export as a waterfall image.
 
To Export an Image of a Selected Section:
 
1. Select Export Image of Selected Section from the Sidescan Context Menu.
 
2. In the main SonarWiz window, use the Left mouse button to drag a selection over the portion of the data
set you want to export
 

 
The Select Section to Export an Image window will open to display the starting and ending ping information
for the highlighted selection.
 
3. If desired, click the Options button on the Select Section to Export an Image window to modify the waterfall
annotations.
 
4. Click Save to save the selected section as a waterfall image with annotation.
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Selecting Sidescan Channels To Display
 

 
The Mosaic Channels menu in the Sidescan File Context Menu allows the user to select which sidescan
channels to display in the plan view mosaic. The user can select to display both port and starboard channels,
port channel only, or starboard channel only.
 

 
Mosaic Channels | Both: Both port and starboard channels are displayed in the plan view
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Mosaic Channels | Port Only: The port channel is displayed the starboard channel is hidden in the plan view.
 

 
Mosaic Channels | Starboard Only: The starboard channel is displayed, the Port channel is hidden in the
plan view.
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Hiding the Nadir Region of Sidescan Files
 
The Transparency command is used to temporarily hide the nadir region of sidescan sonar files from mosaics
and image exports. The transparency command is found on the Sidescan File Context Menu. To make
the nadir of a sidescan file transparent, select the Set Transparency on Selected File... command from the
Transparency menu. To clear the transparency on the selected file, use the Clear Transparency on Selected
File... command, or to clear transparency on all files, select Clear Transparency on All Files command.
 

 
Example of a file with nadir transparency enabled:
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The Clear Transparency on Selected File command will make visible again any portion of the data set
hidden from view by the Set Transparency on Selected File command. The Clear Transparency on Selected
File command is found on the Transparency sub-menu of the Sidescan File Context Menu. The Clear
Transparency on All Files command will remove all nadir transparency on all data sets in the SonarWiz
project.
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Set Transparency on Selected File
 
The Set Transparency on Selected File command is used to hide the nadir region of a sidescan data set.
The Set Transparency from Selected File command is found on the Transparency sub-menu of the Sidescan
File Context Menu. You can restore the nadir to view by using the Clear Transparency commands also found
on the Transparency menu.
 
The nadir region of the file is assumed to start directly below the sidescan and extend outwards to the limits
specified by the user. The outer limit of the nadir zone to be hidden can be specified in two ways:
 

Specify Nadir by Absolute Distance

When selected, the limit of the nadir region to be made transparent is specified as an absolute
distance in meters.

Specify Nadir as Percent of Sonar Altitude

When selected, the limit of the nadir region is specified as a percentage of the sonar altitude above the
seabed.
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Aggregating Sidescan Data Sets
 
The Aggregate command joins two or more data sets into a single data set. It is intended to join adjacent files
so they can be managed as a single unit. The Aggregate command is found on the Sidescan Context Menu
when two or more sidescan datasets are selected. Once the aggregate command is used, the user will be
prompted to name the new .CSF file.
 

 
Restrictions can be set on affregation where a new file will not be created if certain conditions are met. The
user can set this condition based on a distance in time or project units.
 
NOTE: If you attempt to aggregate two sonar files using different vessel configurations, the vessel from the first
sonar file in the set is used by default. You can change the assigned vessel in the Project Explorer after the
aggregation is competed.
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Fix Small Inter-File Gaps Between
Adjacent Sidescan Data Sets

 
The Fix small inter-file gaps command removes small gaps from adjacent sidescan files. The command
works by sorting the selected data sets by time and then inserting the ending position, heading and course
made good (CMG) of the older file into the starting position, heading, and CMG of the newer file. If the position
gap is more than 25 meters, the algorithm will automatically skip this pair and a warning message will be
issued to the output window. The Fix small inter-file gaps command is found on the Sidescan File Context
Menu when two or more files are selected.
 
To remove small inter-file gaps:
 
1. Select two or more adjacent sidescan files and right click to open the Sidescan Context Menu.  Then choose
the Fix small inter-file gaps command.
 

 
2. The start and end point of the adjacent files will be adjusted to match without a gap.
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Map Corrections
 
This section describes the operation and use of the Map Corrections tool. This tool has the capability to
calculate offsets from a visible target in a sidescan file to the same object seen in another dataset. The Map
Corrections tool then applies the offset to the sidescan file and rectifies it using a weighted algorithm. The
Map Corrections tool is typically used on towed sidescan surveys where a persistent but variable error is
present in the navigation data – for instance error related to cable out errors. The end result is a mosaic that
has sidescan targets that align with known positions. 
 
The Map Corrections tool also has the capability to rectify different sidescan files to each other if a shared
target is visible. The average position will be calculated and the sidescan files will be rectified to that position.
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Correcting Sonar Using a Basemap
 
In the following example, sidescan files are corrected to targets seen on a more navigationally accurate MBES
dataset. Any layer that can be opened as a basemap in SonarWiz can be used to rectify sidescan data. Some
examples include: National Oceanic and Atmospheric Administration (NOAA) charts, an AutoCAD DXF file
with position of objects, or even another sidescan survey.
 

For best results the basemap needs to be of higher positional
quality than the sidescan data.

 
Please refer to section Basemaps Command Group instructions on how to insert a basemap.
 
Use the following steps to correct sonar data using the Map Corrections tool:
 
1. Load sidescan data normally and process it through the Navigation post processing step. The example
dataset is shown below.
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2. Click the Maps | Map Corrections  command. The Map Corrections dialog box appears like
below, there are several fields inside.
 

 
The Sidescan Files field displays the currently loaded sidescan files. 
 
The Map Corrections field displays the individual corrections. Each correction is a single point on the
basemap but may have several sidescan lines that are associated with it. There are also options to show the
correction on the mosaic window or to disable the correction.
 
The Points in the Selected Map Correction field displays the points that have been selected on the various
layers for each individual Map Correction. Information on the selected points will be displayed in this field
including the X and Y position and the layer it was selected on.
·        

It is a good idea to thoroughly scan a dataset for targets that show
up on multiple sonar lines and are seen easily in your basemap.
  Choose targets that have a clearly defined shape on several
sidescan lines.

 
4. Select a target to rectify. Select one sidescan line that contains the target and the basemap. In the
presented case, there is a clear location of the target from a MBES basemap and the same target located on
three different sidescan lines.
 



Correcting Sonar Using a Basemap

1009

 
In this case there is no clear part of the object that can be selected – for example, a mast or a wellhead. In this
example the center of the target is selected on all four lines.
 
5. Use the Show checkbox to disable all the sidescan files to show only the basemap. This can be done
by either selecting all the sidescan files individually or by checking and unchecking the Show checkbox as
highlighted by the arrow. The basemap should be the only layer displayed in the mosaic window at this point.
 

 
6. In the Map Corrections field click the Add button. The Map Corrections box is populated with a blank map
correction. Note the Assumed X and Assumed Y are zero.
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7. In the Points in the Selected Map Correction box click the Add button. A blank correction appears in the
Points in the Selected Map Correction box. If the cursor is placed above the basemap in the mosaic window
a target cursor will appear. This indicates the system is ready for the user to choose the point on the basemap.
 

 
8. Select the target on the basemap and left click. In this case, the center of the target was selected. A blue
drop pin indicates where the target was chosen.
SonarWiz detects that the user has selected a position on the basemap, as indicated with a blue drop pin.  The
Map Corrections dialog box populates with the position and the filename of the basemap.
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 9. Select a sonar file to view by selecting the appropriate Show checkbox in the Sidescan Files in Project
field. Then click the Add button in the Points in the Selected Map Correction field.
 

 
A sonar file and a crosshair icon will become visible in the SonarWiz mosaic window.
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10. Click the point to be rectified on the sidescan file. In this case, the center of the target is selected. A green
drop pin is displayed to indicate this point on the SonarWiz mosaic window. A green line represents the offset
that the sonar line will be shifted.
 

 
The Points in the Selected Map Correction field also becomes populated with the .CSF file name and the
position of the chosen point.
 

 
11. At this point it is possible to check the rectification by clicking the Correct checkbox in the Sidescan Files
box.
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This results in the sonar file being rectified to the position selected on the basemap. Be sure to turn off the
correct function if you are still picking other points on that sidescan file.

 

Deselect the Correct checkbox if more corrected points will be
chosen on the sonar file.  It will result in unexpected behavior as
SonarWiz is selecting positions off the non-shifted file and the user
is choosing them off a shifted file.

 
12. Continue selecting the other shared targets on the other sonar lines by repeating Step 9 through Step
11. Be sure to deselect the show checkbox on sonar files that are not being used. Each new selection will be
displayed as a green drop pin on the mosaic window.
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In the Maps Corrections windows the additional points are visible in the Selected Map Correction box. Each
selected point is populated with the X and Y position and the name of the sonar line.
 

 
13. Click the Correct checkbox for each of the rectified files. This initiates the rectification of each file so that
the position matches the base-map position. The following figure shows that the three sonar files have been
shifted into their rectified position.
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14. The user can disable the drawing of the drop pins on the mosaic window by deselecting the Show
checkbox under the Map Corrections field. The corrections will still be active but the pins won’t be visible. 
 

 
The user can experiment with SonarWiz’s different shine through commands.  In this example the SSS
Overlap Mode has been set to Average. See SSS Overlap Mode for more details.
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Correcting Sonar Using Sidescan Files
 
SonarWiz can rectify the mosaic by using the positions of a shared target seen in separate sonar lines.  In this
example a target is seen in two sonar lines and the Maps Corrections function will be used to rectify the targets
to an average location.
 

Please note that the mosaic is the only part of the project that is
moved. Targets and other digitized features will not be shifted from
their original picked positions.

 
1. Follow instructions 1-4 in the Correcting Sonar Using a Basemap.
 
2. Find a target that is seen on several lines. In the following example case, a shipwreck is seen on two
independent sidescan files.
 

3. Use the Show checkbox to disable all the sidescan files to show only a single sidescan line. This can be
done by either selecting all the sidescan files individually or by checking and unchecking the Show checkbox
as highlightedbelow. There should only be a single sidescan file displayed on the screen at this time.
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4. In the Map Corrections field click the Add button.  Then, in the Points in the Selected Map Correction
field. The mouse cursor becomes a crosshair.

 
 
5. Select the target on the sidescan file and left click. In this example case, the bow of the observed shipwreck
was selected. A green drop pin indicates where the target was chosen.
 

 
6. After selecting a map correction point, the Map Corrections dialog box becomes populated with the
positions of the pick and indicates which sidescan file was chosen.
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7. Select the next sidescan file that contains the target. Check the Show checkbox to display the new sidescan
file and deselect the Show checkbox on the previous sidescan file.  There should be only one sidescan file
displayed in the mosaic window.  Next click Add in the Points in the selected Map Corrections dialog box.
The mouse cursor becomes a crosshair.
 

 
8. Pick the required location on the sonar mosaic using a left click of the mouse.  In this case, the bow of the
shipwreck was selected. 
 



Correcting Sonar Using Sidescan Files

1019

 
A green drop pin will appear in the location where the user selected the map correction point.  A green line
will also be drawn to illustrate the difference between the two selected points.  The Map Corrections dialog will
also be populated with the positions and file names of the sonar file that was used.
 

SonarWiz uses the average position of the map correction points
to shift the sidescan lines.  You can use several positions from
different sidescan lines.

 
9. Correct the sonar files by selecting the Correct checkbox and the Show checkbox for the files that need to
be rectified.
 

 
The result will be sonar files that have been shifted to the average position of the picked points.
 
 
9.     Deselect the Show checkboxes in the Map Corrections field to disable the drawing of the drop pins and
the green line.
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Please note that the mosaic is the only part of the project that is
moved. Targets and other digitized features will not be shifted from
their original picked positions.
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Map Corrections using Magnetometer data
 
SonarWiz can rectify magnetometer data to targets seen in sidescan. The process is very similar to the other
methods described above.
 
1. Open a magnetometer file to edit. This will open the Magnetometer File Editor.  
 

 
2. Select an anomaly that is caused by an object visible in the sidescan mosaic. Once determined click
the Add Correction Point button and left click in the middle of the anomaly. This will drop an orange map
correction pin on the Map view.
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3. Open the Map Corrections dialog by clicking Maps | Map Corrections.
 

 
4. Under Map Corrections highlight the Map Correction that was automatically generated in step 2. Then click
Add in the Points in the Selected Map Correction. The cursor will change to a crosshair in the Map View.
Click on the sidescan object that corresponds with the magnetometer anomaly. A green pin will drop on the
Map View and the Points in the Map Correction will be populated with a CSF type correction.
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5. To apply the correction select the corresponding correct checkbox and select Update Corrections. The
magnetometer line and sidescan data will move to the average position between the two correction points.
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Seabed Classification
 
The Seabed Classification tool in SonarWiz is used to delineate image classes as vector polygons in acoustic
imagery from bathymetry (backscatter) and sidescan sonar data. The tool can be found under the Post
Processing tab.
 
The SonarWiz Seabed Characterization function works on sidescan imagery and acoustic backscatter from
swath mapping sonars. The characterization tool can also incorporate non-acoustic properties of the seabed
such as bathymetric slope or roughness. The characterization tool will then generate classes of similar texture
in the acoustic imagery and from that, it produces a classified polygon layer that can be useful in a seabed
characterization analyses.
 
For a complete step-by-step guide for the Seabed Classification tool, see the
SeabedClassificationUserGuide.PDF stored in the DOCs folder of your SonarWiz 7 installation.
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Sub-Bottom Profiler Data
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Import Sub-Bottom Data
 
The Import... command is used to import raw sub-bottom data sets into SonarWiz. The import process
reads the native sonar files and converts them into Common Sensor Format (CSF). If the import process is
successful, the CSF files are stored in the CSF directory in the SonarWiz project folder.
 
NOTE: All SonarWiz sub-bottom processing occurs on the the CSF versions of the files, the original sonar files
are never modified.
 

Search Folder

Select the directory to look for sonar files.

Sonar File List
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The Sonar File List will display a filtered list of supported sonar files. One or more files can be selected
at once for import.

Selected Files

A list of the files selected for import

Supported Files Filter

The drop down provides filters for all supported sonar file types. Only the files that meet the filter
criteria are listed in the Sonar File List    

File Type Specific Options

Open the File Type Specific Options window. Here you can control settings unique to the particular file
format or sonar system you are importing.

Channel Selection

Select the channel to import. SonarWiz can detect up to 3 channels of sub-bottom data in a sonar file,
only 1 can be imported. This setting allows you to choose which channel to import.

Properties

Opens the Acoustic File Properties Report window for the selected file.
 

Split File on Time Gaps
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Split a file if a time gap of more than 30 seconds is detected. A time gap is usually defined as no
navigation updates for more than 11 seconds. For SEGY, StrataBox, Innomar SES and SES3 in SBP
mode, a time gap is defined as no navigation update for more than 30 seconds.

Range Limiter

Specifies the duration of the sonar record desired to be used. This feature is particularly useful for
trimming off the far field data from high frequency sonars that do not provide good returns at long
range.
 

Band Pass Filter

Click to apply band pass filtering on Import. The button opens the Band-Pass Filter window.

Browse Coordinate Systems

Some sonar file formats store position information in grid coordinates and do not contain latitude and
longitude information. For these file formats, you must indicate to SonarWiz the coordinate system in
use so that the navigation is properly interpreted. Click the Browse Coordinate Systems... button to
select the appropriate coordinate system in use by the files to be imported. (See Select a Coordinate
System Window).

Grid Format Check

Some sonar file formats store position information in grid coordinates and do not contain latitude and
longitude information. For these file formats, you must indicate to SonarWiz the coordinate system in
use so that the navigation is properly interpreted. Toggle to automatically convert grid coordinates in
the sonar file.
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Sub-Bottom Settings Window
 
The Sub-Bottom Settings window provides controls for all sub-bottom signal processing functions within
SonarWiz. Each Gain control is discussed in detail below.
 
You can open the sub-bottom settings window by:
 
1. Selecting the Settings command located on the Sub-Bottom Context Menu.

2. Clicking the Gain Settings...    icon in the Appearance Menu of the Sub-Bottom Analysis Window.
 

Band Pass Filter

Click to open the Band-Pass Filter window. The button indicates whether the band pass filter is
enabled.
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AGC

Toggle the check box to enable Automatic Gain Control (AGC) processing. The sliders control the
AGC kernal window size as a percentage of the ping range and the target intensity as a percentage of
the maximum intensity for the file. See Automatic Gain Control (AGC) for more information.

Auto TVG

Toggle the check box to enable Automatic Time Varying Gain (TVG) processing. The slider controls
the target intensity as a percentage of the maximum intensity for the file. See Automatic Time-Varying
Gain (TVG) for more information.

Stacking

Toggle to enable shot stacking. Set the number of shots to stack. For each pixel in the stack, the
display value will be either the maximum value in the stack or the average value of the stack.

User Defined Gain

See User-Defined Gain Controls (UGC) for more information

User Defined TVG

When User Defined Gain is enabled in TVG Mode, use these controls to set the TVG constants. See
Time Varying Gain Control for more information.
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Static Gain Options

Used to add a static additive gain scalar and offset to the sub-bottom profile. To calculate the new
effective amplulitude use (amplitude * scalar) + offset with the default values being scalar = 1 and
offset = 0.

Apply Settings

The Apply button allows you to apply the selected settings to the sub-bottom profile without closing the
settings window.

OK/Cancel

OK applies the current settings and closes the Settings window. Cancel will close the settings without
applying the current settings.

Save/Load

Save the current gain settings to a file so that they can be recalled in the future, used in another
project or sent to another user. Load the settings from the saved file.

Gain Start Time

Gains are applied from time zero (shot time) or from the detected sea floor.

Blank Water Column

Toggle to blank the water column. All data above the bottom track will not be displayed.

Sonar Projection Options

  
Adjust the sensor heading using course made good or sensor values. Note that this value is for use in
information displays and indicator arrows since sub-bottom profile positioning does not use and is not
affected by platform heading.
 
Course Made Good
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This setting controls the width of the navigation filter in position updates. A value of 0 turns off
navigation filtering, the default value is 300 is recommended for straight-line surveying. Reduce the
value for pole mounted systems navigating in ports, harbors and rivers. See Course Smoothing and
Interpolation for details.
 
Sensor Heading
Taken from a Heading sensor inside the towfish. Sensors such as fluxgate compasses are not
normally accurate enough for projecting sonar data as they are subject to magnetic variations and
local deviation. Unless the heading sensor being used is a very accurate, such as an inertial gyro, this
setting should not be used.
 
If the file selected is computing a fish position using a layback algorthim and sheave offsets it will be
applied in a different direction based on the Heading Source currently selected above. See Layback
for more information.
 
Rotate Angle
This offset should be used when a known bias is affecting the heading sensor.
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Band-Pass Filter
 

The Bandpass Filter Window is found on the Sub-Bottom Settings Window and can also be accessed from
the Sub-Bottom Import command. SonarWiz uses a windowed-sinc bandpass filter. The user can set the
window shape and the number of points or taps in the window. See also the Sub-Bottom Spectrograph for an
interactive method to setting the Band-Pass filter parameters.

 

 
 

Enable Bandpass Filter

Toggle to enable the bandpass filter

Filter Parameters

  
Define the passband by specifying the low frequency cutoff and high frequency cutoff. The low-
frequency cutoff must be greater than 0.
Define the number of taps (order) of the filter. Taps can range from 1 to 37767.  Taps control: 1) the
amount of memory required to implement the filter, 2) the number of calculations required, and 3)
the amount of “filtering” the filter can do; in effect, more taps means more stopband attenuation, less
ripple, narrower filters, etc.

Window Shape

  
Define the window used to multiply the truncated-sinc filter kernal. Four windows are available for
completeness, however only the Blackman and Hamming are worth using. The Hamming window
results in about 20% faster roll-off than the Blackman window. However, the Blackman window
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has better stopband attenuation (Blackman: 0.02%, Hamming: 0.2%), and a lower passband ripple
(Blackman: 0.02%, Hamming 0.2%).
 

Window
Shape

Notes

Bartlett A triangle, uses straight lines for the taper,
about the same speed as Hamming,
but worse stop band than Hamming.

Blackman Better stopband attenuation than Hamming,
slow rolloff. This should be your first choice.

Hamming Hamming is about 20% faster than Blackman, some
passband ripple. This should be second choice.

Hanning The raised cosine window, about the same speed
as Hamming, but worse stop band than Hamming.

Rectangular Equivalent to no window at all, just a truncation
of the sinc tails. Significant passband ripple.
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SBP Tides and Vertical Offsets
 

The SBP Tides and Vertical Offsets window is used to set all of the possible vertical offsets that can be
applied to SBP files in the project.
 

 
 
The Starting Elevation field is one value per file and is used to set the elevation that the survey starts at or
the starting surface elevation.
 
The Tide Height field is the offset above/ below the starting elevation that is caused by an introduced tide
value. This can either be set at 0.0 if none are applied or use the drop down menu to apply a tide file that has
been already loaded into the project. For more information on how to import a tide file in .TXT format into the
project, see Importing Tide Files.
 
The Bathy Grid Separation field replaces the older Datum Separation and is the offset above/ below the
starting elevation calculated by taking the difference between the bottom track (altitude) and a bathymetry grid.
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This can either be set at 0.0 if none are applied or use the drop down menu to apply a grid file that has been
already loaded into the project. For more information on how to import a grid file, see Create New Grids.
 
These fields and a few others are combined to get the Total Vertical Offset from Sea Level in the following
calculation (expressed as an elevation value above sea level):
 
Total Vertical Offset = Starting Elevation +Tide Offset + Heave + Swell + Antenna Height - Bathy Grid
Separation - Sensor Depth
 
This can also be expressed as the Surface Elevation (elevation of the water surface above sea level):
 
Surface Elevation = Starting Elevation + Tide Offset + Heave + Swell + Antenna Height - Bathy Grid
Separation
 

 
These values can be toggled on/ off in the Annotation menu in the SBP digitizing view. For more information on
how SonarWiz applies the Topographic Correction, see Topographic Correction.
 



SBP Tides and Vertical Offsets

1037

 



Topographic Correction

1038

Topographic Correction
 

The Topographic Correction option is applied in the Annotations Window and is used to correct imported
subbottom data using the applied vertical offsets. By design, SEGY files do not contain locations to store all
of the possible various offsets and delays that can be used to adjust the trace data during post processing. In
order to preserve these offsets when using the CSF to SEGY conversion utility the Topographic Correction will
need to be enabled.
 
When Topo Corrections are turned OFF, the following events happen in the Subbottom Digitizer View:
 
- The Trace Data is drawn as it was imported where the top of the image is Time = 0. The Sensor Depth as
well as any of the vertical offsets are not represented in the trace data.
- No blank padding is added to the image.
 

 
When Topo Corrections are turned ON, the following events happen in the Subbottom Digitizer View:
 
- The Time = 0 is adjusted and the Trace data is drawn at the proper vertical offset.  The Sonar Depth (which is
calculated by adding the vertical offsets to the sensor depth) is now represented in the trace data.
- Blank padding is added to the image by first calculating the vertical offsets delta value and then taking the
shallowest part of the actual image data and filling in all the space below it.
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In order to export a SEGY file that contains Topographic Corrections, verify that the option is enabled in the
Annotations window.
 
In order to export a SEGY file that does not contain Topographic Corrections but still stores the various
vertical offsets applied during post processing (which is required in a program like Kingdom Suite), verify that
the option is disabled in the Annotations window. A program like Kingdom Suite is looking for a Start Time
value which can be stored in the exported SEGY using the Sonar Depth field (which is calculated by adding
the vertical offsets to the sensor depth). Kingdom Suite requires this field to be stored in time which can be
obtained by using the Write Byte Location in Trace Header 109-110 (ms) + 181-182 (us).
 
Starting Elevation: elevation that the survey starts at.  Think of it as the elevation of the boat sitting at the
dock or in other words the starting surface elevation.  As the boat moves around the surface elevation will go
above and below this level.
Surface Elevation: distance from the starting elevation to the sonar.
Total Water Depth: distance from the surface to the seafloor.
Tide Offset: offset above/below the starting elevation that is caused by the tide.
Bathy Grid Separation: offset above/below the starting elevation calculated by taking the difference between
the bottom track and a bathymetry grid.
Heave: offset above/below the starting elevation measured by a heave sensor.
Swell: offset above/below the starting elevation as calculated by a low pass filter on the bottom track.
Antenna Offset: offset above/below the starting elevation as measured by a GPS.
Sensor Depth: offset below the surface of the water as measured by a depth sensor (usually based on
pressure).
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Note: Elevation Values are positive in the UP direction. Sea level is at 0m elevation. Depth Values are positive
in the DOWN direction. The surface is at 0m depth.
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Intersections
 

SonarWiz offers the ability to identify and work with intersecting Sub-bottom profile navigation lines and
features.
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Calculating Intersections
 

In order to display intersecting Sub-bottom profile lines of navigation the points of intersecting themselves must

first be calculated. Left-click the Intersections  button located in the Post Processing Ribbon
Menu in order to bring up the drop-down menu.
 

To open the Intersection Manager:
−  Select Intersection Manager from the Intersections Button drop-down list; or
−  Select and right-click an existing Intersection from the Map Window and select Intersections Manager
from the pop-up menu.
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When opened for the first time the Intersections Manager list will be blank. The Intersections Manager
offers the following options:
 
Compute: Will populate the list with any/all intersecting points between all Sub-bottom lines in the project,
regardless of whether or not they are being displayed.
Delete: Deletes all highlighted (selected) intersections. The Delete key on your keyboard may also be used.
Select All: Selects all intersections in the list.
Export: Exports an ASCII text file for each intersection with ID, Latitude, Longitude,  X, Y, Coordinate System,
Line 1 Name, and Line 2 Name.
 
Compute Feature Crossings: Computes each crossing of a map feature (see Features in the Map Window
for more information) to a Sub-bottom file and adds them to the Feature Crossing context menu.
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Displaying Intersections
 

In order to view the calculated intersections, the Drawing Mode in the Map Window must be in Navigation
Plot Mode. See Drawing Mode for more information.
 
Once in Navigation Plot Mode the intersections will be displayed. Right-clicking on an intersection open the
context pop-up menu shown below.
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QuickView 3D
 

The Quick View 3D option will take 300 pings on either side of the intersection point from each intersecting file
and export them to be immediately viewed in the default 3D viewer. The Default 3D viewer may be either the
CTI 3D Viewer (installed with SonarWiz) or the Fledermaus.
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Feature Crossings
 
The Feature Crossings tool is used to compute positions where features and sub-bottom files
intersect. These calculated positions can be displayed and managed under the Feature Crossings
sections of the Sub-bottom Files Context Menu. The name of the Feature Crossings will follow a (#):
(NameofFeature)_(IncrementingNumberofCrossingsperFeature) for example 1:Feature0000_1.
 

 
To calculate the positions of Feature Crossings, select the Compute Feature Crossings... button in the
Intersection Manager.
 
Once the Feature Crossings are computed, they can be displayed in the Sub-bottom Analysis Window using
the Annotations window. See Annotation/ Display Options for more information.
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Sub-Bottom Analysis Window
 

The Sub-Bottom Analysis window is the primary interface for working with sub-bottom profiles. It can be
opened from the Sub-Bottom Context Menu or the Post Processing Menu by selecting a sub-bottom profile
and clicking on the Bottom Track or Digitize View commands. The Sub-Bottom Analysis window uses a tabbed
interface to organize sub-bottom profile commands into five categories: bottom tracking, acoustic reflectors,
contacts, cores and appearance. When a tab is selected, the ribbon command bar will change to reflect the
selected category.
 
This page describes the features of the sub-bottom analysis window that are common to all five command
categories. Subsequent pages will describe each command category (tab) in detail.

 

Tab Bar

 
           The Tab Bar organizes sub-bottom commands into five command categories described in the table
below.
 

Category
(Tab)

Description

Bottom
Tracking

Manual and Automatic tools for determining the altitude of the profiler
above the seabed. See Bottom Tracking for more information.

Acoustic
Reflectors

Tools for tracing and editing acoustic reflectors.
See Acoustic Reflectors for more information.

Contacts Tools for placing and editing sub-bottom profile
contacts. See Contacts for more information.
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Cores Tools for adding core decorations to the sub-bottom
profile display. See Cores for more information.

Appearance Tools for controlling how sub-bottom profiles will
appear in the analysis window and other profile
exports. See Appearance for more information.

Ribbon Command Bar

 
           The Ribbon Command Bar contains the buttons and widgets for activating the various commands

available for working with sub-bottom profiles. The specific commands available depend on the tab
selected in the Tab Bar.

Sub-Bottom Toolbar

  
   The Sub-Bottom Tool bar is a dockable window that is enabled in the Appearance tab. The tool bar can

be detached and positioned wherever is convenient for your work. See Sub-Bottom Analysis Window
Tool Bar for more information.

Profile Display

The Profile Display window shows the sub-bottom profile data. The display also shows annotations,
core decorations, reflectors and intersecting profile lines. The native unit of the vertical axis of the profile
window represents ping time, although it is usually converted to approximate range using a constant
sound velocity. The horizontal axis of the plot is ping number. Both the horizontal and the vertical axis of
the profile can be scaled.

Horizontal Scroll

 
           Use the horizontal scroll bar to pan through the file by ping number.
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Vertical Scroll

 
          Use the vertical scroll bar to pan through the data by time (range) from the source.
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Bottom Tracking (Sub-Bottom Analysis Window)
 

The Sub-Bottom Bottom Tracker is the first Tab of the Sub-Bottom Analysis Window. It can be opened in
several ways:
 

1. Select the Bottom Track  icon from the Post Processing Menu.
2. Select the Bottom Track... command from the Sub-Bottom Context Menu.
3. Select the Bottom Tracking tab from anywhere in the Sub-Bottom Analysis Window.
 
The purpose of the Bottom Tracker is to identify the first acoustic return from the seabed thereby setting the
altitude of the SBP head above the seafloor. SonarWiz includes an integrated manual and automatic bottom
tracker for sub-bottom data.
 
Sonar files that have been bottom tracked in post-processing will have their file names shown in bold in both
the Project Explorer and the Sonar File Manager
 
SPECIAL NOTE: Bottom-track with the following 4 functions NOT in effect:
 
1.  Swell filter
2.  Smoothing
3.  Heave compensation
4.  Datum Alignment
 
It works best to bottom-track first, then choose any or all of these 4 functions to apply, and apply them in the
indicated order.
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Bottom Tracking Algorithm

Select the bottom tracking algorithm used for Automatic Bottom Detection. There are two algorithms
available:
 

Name Description
Edge Detection This algorithm uses image processing techniques to

identify the line representing the border between the water
column and the seafloor. Robust against noise in the water
column so long as the seabed topography changes gently.

Threshold
Detection

This algorithm works a ping-at-a-time to find the seabed
by identifying the first sample that exceeds the average

ping intensity by the specified threshold. This algorithm is
sensitive to noise in the water column but works better than
Edge Detection when the seabed has a lot of topography.

Tracking Parameters

Set the parameters used to tune the bottom tracking algorithms.
 
Edge Detection:
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Parameter Notes
Blanking The Blanking parameter is used to set the point in the acoustic signal

at which SonarWiz will begin to detect the bottom. Simply stated it
is the distance along the ping record that the user does want the

tracking algorithms to consider as containing a valid bottom return.
Duration Not used

Threshold Not used
 
Threshold Detection:
 

Parameter Notes
Blanking The Blanking parameter is used to set the point in the acoustic signal

at which SonarWiz will begin to detect the bottom. Simply stated it
is the distance along the ping record that the user does want the

tracking algorithms to consider as containing a valid bottom return.
Duration Specifies the number of consecutive samples that must exceed the

threshold computation below. Typical values for duration are 3-12.
Threshold Coefficient is used as a multiplier to the median intensity value

of the ping and is compared to the incoming sonar values. If the
sonar value exceeds the product of the median and the threshold
coefficient, that sample will be a candidate for the tracked bottom
sample. In general, if the detected seabed appears in the water

column, increase the threshold value. If the detected seabed
occurs too deep in the seafloor, decrease the threshold value.

Swell Filter

The Swell Filter in SonarWiz can be used to used to remove the effects of ship heave caused by swell
on the first return of the sonar pulse. See Swell Filter Configuration for more information.

Smoothing Filter

Toggle to enable bottom track smoothing.  Applies a box-car filter to the Bottom-track line to remove
high frequency noise. Note: disable this before bottom-tracking, then apply after bottom-tracking.

Clear bottom track

Click to clear the existing bottom track values from all pings in the profile.
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Track All

Click to apply the automatic bottom tracking algorithm from the first ping the profile.

Track from Ping

This command runs the Threshold Detection bottom tracking algorithm starting at the specific ping
number and either tracking forward or backward through the data set. See Track from Ping for more
information.

Offset Bottom Track

Apply a static offset to the current bottom track. See Offset Bottom Track for more information.

Make Reflector

Convert the current bottom track into an Acoustic Reflector feature representing the seabed. See
Convert Bottom Track to Seafloor Reflector for more information.

Manual Bottom Tracking

The manual bottom tracking tools allows the user to define the location of the bottom along the sonar
record by adding and, if necessary, removing points using the mouse. As well, manual bottom tracking
allows the user to “clean up” any automatic tracking or sensor telemetered tracking.
 

Selecting Insert Points  causes the left-mouse button to insert points with a single click, the
right-mouse button to delete points within a rectangle that is right-click dragged to size.  Within the
waterfall area insert inflection points with a single mouse left-click along the trace where the bottom is
varying. As you insert points you will see the bottom profile redrawn to reflect the newly added data
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point. The data points are sorted according to their along track position so that you can insert data
points anywhere along the file in any order To manually insert points you may also left-click-and-drag
the cursor along the reflector and points are dropped automatically.
 

Selecting Remove Points  is the opposite of the above, it causes the right mouse button to
insert points with a single click, and the left-mouse button to delete points within a rectangle that is
right-click dragged to size. The line defining the bottom will be adjusted accordingly.
 
If the bottom tracker is responding favorably to your particular data but is not quite tracking the entire
line you may use the manual and automatic tools together. First, press the Track All or Track from Ping
button to auto-track the line. Next, use the Remove Points button to eliminate the areas where the
auto-tracker failed. New points can be manually inserted as needed.
 

Selecting Auto-Fill Points  enables the Smart Reflector Tracking algorthims and allow the user
to pick the bottom track on a sub-bottom profile with a semi-automatic process. Based on the settings
used, the user will select where they see the seafloor starts, continues, and stops and the algorthim
will attempt to track it.
 
The option can be enabled (highlighted in yellow) and disabled by selecting the button and the settings
used can be accessed using the Setup option in the drop down menu. See Auto-Fill Points for more
information.

Profile Display Panel

The Profile Display Panel indicates the position of the bottom track line with a thin red line. You can
annotate the panel as necessary using the tools in the Appearance tab. When manual bottom tracking,
use the mouse in the Profile Display to pick and remove bottom track points.
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Swell Filter Configuration

The Swell Filter Configuration window is opened by clicking on the  icon in the Bottom Tracking
tab of the Sub-Bottom Analysis Window. The Swell Filter is used to used to remove the effects of ship heave
caused by swell on the first return of the sonar pulse.
 
The seafloor must be bottom-tracked before applying the swell filter, so that the Swell Filter has a reference
line. The period of the swell must be estimated (in seconds). This period is used to generate a low pass filter
set of bottom tracked points. The sonar data is adjusted at each shot by comparing the low-pass filtered
altitude to the original raw altitude. This process moves each ping up or down depending on the relationship
of the filtered surface to the uncorrected surface thereby flattening the acoustic data. It may take several
iterations of applying different swell periods to find the best result in removing swell effects.
 
Note that If the period chosen is too long for the actual condition at the time of the survey, then actual seafloor
features such as small mounds and debris might be made to appear flat. The best approach is to enter the
smallest wave period value that removes just the sea state motion without affecting the bottom topography.
 
Once the Swell Filter is enabled the Swell Filter button in the Bottom Tracking window will change from “ Swell
Filter: Off ” to “ Swell Filter:On:X.x ” where “ X.x ” is the specified period of the swell.
 

Enable Swell Filter

Toggle to enable swell filtering

Filter Period

Set the swell period in seconds.
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Track from Ping (Sub-Bottom)

The Track From Ping command is available by clicking the  icon on the Bottom Tracking tab of the
Sub-Bottom Analysis Window. This command runs the Threshold Detection bottom tracking algorithm starting
at the specific ping number and either tracking forward or backward through the data set.
 

Tracking Parameters

Set the blanking, theshold and duration used by the Threshold Detection bottom tracking algorithm.
See the description in the Bottom Tracking Algorithm section of the Bottom Tracking tab for more
information.

Starting Ping Number

Specify the starting ping number. The tracker will proceed forward or backward from this point to the
end of the data set.

Tracking Direction

Specify the tracking direction. Click the Track Backward button to proceed from the specified ping
backward to the beginning of the data set. Click the Track Forward button to proceed from the
specified ping forward to the end of the data set.
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Offset Bottom Track (Sub-Bottom)
 

The Offset Bottom Tracked Solution window is opened by clicking the  Offset Bottom icon from the
Bottom Tracking Tab of the Sub-Bottom Analysis Window. This command allows you to apply a static offset to
the bottom track.
 

Current Offset

The current value of the static offset.

Adjust Offset

Apply addition offsets in meters. Negative values move the towfish altitude closer to the sea surface.
Positive values move the altitude towards the sea floor. Values are applied cumulatively.
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Convert Bottom Track to Seafloor Reflector
 
The Convert Bottom Track to Seafloor Reflector command is opened by:
 
1. Selecting Make Reflector From Bottom Track command from the Sub-Bottom Context Menu.

2. Clicking the Make Reflector   icon on the Bottom Tracking tab of the Sub-Bottom Analysis Window.
 
This command will convert the bottom track of the selected sub-bottom profile into an Acoustic Reflector
Feature which can be used for seabed thickness calculations or exported for other purposes.
 

Down Sample Points

This value controls how often to place vertices in the converted acoustic reflector. If the value is equal
to 1, then the acoustic reflector will have a vertex on each ping, if the value is greater than 1, then the
reflector will skip the specified number of pings before placing verticies.
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Acoustic Reflectors (Sub-Bottom Analysis Window)
 
The Sub-Bottom Acoustic Reflector is the second tab of the Sub-Bottom Analysis Window. It can be opened
in several ways:
 

1. Select the Digitizing View  icon from the Post Processing Menu.
2. Select the Digitize New Features... command from the Sub-Bottom Context Menu.
3. Select the Acoustic Reflectors tab from anywhere in the Sub-Bottom Analysis Window.
 
The purpose of the Acoustic Reflectors tab is to allow the user to create and edit reflector features which
represent vertical horizons of interest identifiable in the sub-bottom profile data.
 

Current Selected Reflector

The drop down list shows all of the acoustic reflector features digitized on this sub-bottom profile or
optionally, all of the acoustic reflector features digitized in the project. Use the drop down to select a
feature for editing or deletion.

Show Reflectors From All Lines

When checked, the Current Selected Reflector drop down  will list all features in the project, when
unchecked, the drop down will list only features digitized on this track line. This option will allow you to
select a previously digitized feature on a different profile line and copy its attributes into a new acoustic
reflector on the current profile using the Add Fragment button.
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New Feature

The New Feature button will create a new feature linked to the current sub-bottom profile. You will first
specify the name of the feature and its attributes in the Create New Reflector Feature dialog. Then,
you begin to digitize the reflector using the mouse.

Edit Feature

The Edit Feature button will open the Edit Reflector Feature window on the selected feature. There
you can modify or adjust the feature name and attributes.

Delete Feature

The Delete Feature button will remove the selected reflector feature from the project. It is possible to
restore deleted features in the Feature Manager.

Multiples

The Multiples button will open the Multiples Window and is used to help identify multiples and
harmonic reflections in SBP data.

Selected Feature Information

The Selected Feature Information display shows information about the selected feature. Information
includes, the minimum and maximum ping number, the minimum and maximum depth, the number of
vertices in the feature and the sub-bottom profile data set associated with the feature.

Compute Thickness

The Compute Thickness button executes a thickness computation between two reflectors on the
current profile. See Compute Reflector Thickness for more information.
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Auto-Fill Points

The Auto-Fill Points button enables the Smart Reflector Tracking option and adds a semi automatic
option to picking reflectors on sub-bottom profiles. The drop-down menu is used to open the settings
for the algorthims used in the tool.

Split Reflector

The Split Reflector button will break a reflector into two fragments, each having the same name and
attributes. To split a reflector, click the Split button. The cursor will change to a line marker indicating
on which ping the split will occur. Left click the mouse to split the reflector.

Delete Points in Rectangle

The Delete Points in Rectangle button will allow you to remove a group of vertices from the selected
feature by drawing a box around them. To delete a group of vertices, click the Delete Points in
Rectangle button. Left-click and drag the mouse to create a box around the vertices you want to
delete. Repeat as necessary. To exit delete mode, right-click the mouse.

Delete Points

The Delete Points button will allow you to remove vertices from the selected feature. To delete a
vertices, select Delete points, then left-click on the vertices you want to remove. Repeat as necessary.
To exit delete points mode, right click the mouse.

Insert Points

The Insert Points button will allow you to insert vertices into the selected feature. It is ok to insert
points between existing vertices and it is ok to insert points beyond the current limit of the selected
feature. Repeat as necessary. To exit insert mode, right-click one time.  The drop-down menu is used
to open the settings for the algorthims used in the tool. See Reflector Point Interpolation for more
information.
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Add Fragment

The Add Fragment button allows you to copy the name and attributes of the currently selected
feature into a new reflector feature and immediately puts the cursor into digitize mode without opening
the Create New Reflector Feature window. When two or more reflector features share the same
name they are implicitly considered "fragments" of a larger overlying structure. Some commands in
SonarWiz can operate on a collection of identically-named fragments simultaneously.

Selected Reflector Feature

Selected Reflector Features (fragments) are identified by highlighting the reflector vertices with bold
boxes.

Intersection Marker

Intersection Markers will appear on sub-bottom profiles as bold vertical lines. This line represents
the intersection of the current profile with another profile in the project. Intersection markers identify
the name of the crossing profile. Small colored and labeled segments on the intersection marker will
appear to indicate the vertical location of reflector features digitized on the crossing profile. Double-
clicking the intersection marker with the left mouse button will open the intersecting sub-bottom profile
in a new Sub-Bottom Analysis Window allowing you to compare the structure in both profiles at once.
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Note: In order to see intersection markers in the Sub-Bottom Analysis Window you must first calculate
intersections. See Calculating Intersections for more information.
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Create New Reflector Feature
 

The Create New Reflector Feature window is available by clicking the New icon   in the Acoustic
Reflectors tab of the Sub-Bottom Analysis Window. SonarWiz will open the Create New Reflector Feature
window allowing you to set the Name, Description and Display Properties of the new feature and then the
cursor will change to allow you to mark the feature vertex positions on the sub-bottom profile display. 
 

Sub-Bottom Profile Name

Reflector features store the name of the sub-bottom profile data set on which they were digitized. This
facilitates advanced reporting options and allows the position of the reflector feature to be recomputed
should this be necessary.

Feature Name

Manually enter or select the feature name from the drop down list. Feature naming options are
controlled by the settings in the Digitized Feature Options Menu. When two or more reflector features
share the same name, SonarWiz will implicitly assume that they are "fragments" of a larger overlying
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structure. Some commands in SonarWiz can operate on the collection of reflector "fragments" such as
feature exporting and feature reporting.

Description

Manually enter a feature description or select the description from the drop down list. Feature
description options are controlled by the settings in the Digitized Feature Options Menu.

Display Options

Toggle to display the feature on the map.
Toggle to display the Feature label on the map (uses the Name field)
Polygons are not supported by reflector features

Position

Reflector features do not have a single position, so the position dialog is not available. Instead, each
vertex in the reflector feature takes its horizontal position from the position of the underlying ping and
the vertical position is based the depth in the profile where the feature was marked.

Sound Velocity

Set the default sound velocity used to convert 2-way travel time to depth for a reflector feature. The
specified sound velocity applies from the reflector depth upwards to the next intercepted reflector
(which may change the speed of sound) or the sensor depth. Setting the sound velocity on a reflector
can affect the depth of reflectors located below. The total depth of a reflector reported by SonarWiz
accounts for the speed of sound changes of overlying reflectors, if present.
 
The sound velocity value is stored with each vertex in the reflector feature and it is possible to edit
these values after the feature has been digitized (See Edit Reflector Vertices for more information).
 
Note: The Sub-Bottom Analysis window uses a constant sound velocity to convert 2-way travel time to
depths for display purposes. So the changes to sound velocity set in the reflector sound velocity box
will not be reflected in the sub-bottom profile imagery, these values are only applied to computations,
reports and thickness calculations. You can specify the sound velocity used in the SBP window for
display by adjusting the Default Water Column Sound Velocity found in the Advanced menu of the
SonarWiz program Preferences and Settings.
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Drawing Attributes

 
You can modify the way the feature appears on the sub-bottom display and main window. You can
Save and later Load the specified attributes to a text file for use in quickly setting attributes across
projects.
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font

size of text labels
Line Style Set the Line Type (not

applicable to Point Features)
Thickness Set the Line Thickness (not

applicable to Point Features)
Save Save drawing attributes

to a named file
Load Load drawing attributes

from a named file
Line Color Set the Line color (not

applicable to Point Features)
Color by
Depth in
Mosaic

(not applicable to
Point Features)
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Edit Reflector Feature
 

The Edit Reflector Feature window is available by clicking the Edit icon    in the Acoustic Reflectors
tab of the Sub-Bottom Analysis Window. SonarWiz will open the Edit Reflector Feature window allowing you to
modify the Name, Description and Display Properties of the selected feature. 
 

Sub-Bottom Profile Name

Reflector features store the name of the sub-bottom profile data set on which they were digitized. This
facilitates advanced reporting options and allows the position of the reflector feature to be recomputed
should this be necessary.

Feature Name

Manually enter or select the feature name from the drop down list. Feature naming options are
controlled by the settings in the Digitized Feature Options Menu. When two or more reflector features
share the same name, SonarWiz will implicitly assume that they are "fragments" of a larger overlying
structure. Some commands in SonarWiz can operate on the collection of reflector "fragments" such as
feature exporting and feature reporting.
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Description

Manually enter a feature description or select the description from the drop down list. Feature
description options are controlled by the settings in the Digitized Feature Options Menu.

Display Options

Toggle to display the feature on the map.
Toggle to display the Feature label on the map (uses the Name field)
Polygons are not supported by reflector features

Position

Reflector features do not have a single position, so the position dialog is not available. Instead, each
vertex in the reflector feature takes its horizontal position from the position of the underlying ping and
the vertical position is based the depth in the profile where the feature was marked.

Edit Sound Velocities

Click Edit Vertex Sound Velocities button to modify the sound velocity values stored with each vertex
in the reflector. See Edit Reflector Vertices for more information.
 
Note: The Sub-Bottom Analysis window uses a constant sound velocity to convert 2-way travel time
to depths for display purposes. So the sound velocity set in the reflector will not be reflected in the
sub-bottom profile imagery, these values are only applied to computations, reports and thickness
calculations. You can specify the sound velocity used in the SBP window for display by adjusting
the Default Water Column Sound Velocity found in the Advanced menu of the SonarWiz program
Preferences and Settings.

Drawing Attributes
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You can modify the way the feature appears on the sub-bottom display and main window. You can
Save and later Load the specified attributes to a text file for use in quickly setting attributes across
projects.
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font

size of text labels
Line Style Set the Line Type (not

applicable to Point Features)
Thickness Set the Line Thickness (not

applicable to Point Features)
Save Save drawing attributes

to a named file
Load Load drawing attributes

from a named file
Line Color Set the Line color (not

applicable to Point Features)
Color by
Depth in
Mosaic

(not applicable to
Point Features)
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Edit Vertex Sound Velocities
 
The Edit Vertex Sound Velocities window is available by clicking the Edit Vertex Sound Velocities button on
the Edit Reflector Feature dialog. This window allows you to edit the sound velocity value of each vertex in the
selected reflector feature.
 
The specified sound velocity on a vertex applies from the vertex depth upwards to the next intercepted
reflector (which may change the speed of sound) or the sensor depth. Setting the sound velocity on a vertex
can affect the depth of reflectors located below. The total depth of a reflector reported by SonarWiz accounts
for the speed of sound changes of overlying reflectors, if present. 
 

Vertex Table

The Reflector Vertex Table lists every vertex making up the reflector. The table consists of ping and
position information as well as the 1-way travel time (ms), the current sound velocity (m/s) and the
computed depth of the vertex (m).
 
You can select rows of vertices to modify by Left clicking, SHIFT + Left clicking, and or CTRL + Left
Clicking.
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Quick Selection

The quick selection buttons help to select and deselect multiple rows of verticies at once.

Sound Velocity

To change the sound velocity of one or more vertices:
 
1. Select the desired rows containing the vertices you want to modify in the Vertex Table.
2. Enter the new sound Velocity in the Sound Velocity box
3. Click the Apply button.
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Compute Reflector Thickness
 

The Compute Reflector Thickness command is available by clicking the Compute Thickness 
button in the Acoustic Reflectors tab of the Sub-Bottom Analysis Window. The Compute Thickness command
creates a Thickness Feature representing the vertical difference between two reflector features digitized on the
same sub-bottom profile. Thickness features can be displayed visually in sub-bottom profiles and they can be
exported from SonarWiz as reports indicating the position and thickness values at each computation point.
 
Note that you can convert the bottom track into a reflector feature using the Convert Bottom Track to Seafloor
Reflector command, this allows for computing the thickness between the seabed and selected reflectors.
 

Top Reflector

Select the upper reflector in the thickness computation.

Single Mode - Select Bottom Reflector

In Single Mode, select the bottom reflector from the drop down list. A single thickness object will be
created between the Top Reflector and the selected Bottom Reflector.
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Batch Mode (This File Only)

Select this mode to compute thickness objects between the Top Reflector and all intersecting bottom
reflectors on the same profile.

Batch Mode (All Files)

Select this mode to compute thickness objects between the Top Reflector and all intersecting bottom
reflectors on all files. Fragments of the Top Reflector (that is, reflector features with the same name)
must be present in more than one profile for this command to work on more than the current profile.
Selecting a seafloor reflector created by the Convert Bottom Track to Seafloor Reflector  command as
the Top Reflector will cause thickness objects to be created between the seafloor and all reflectors on
all lines.

Sample Points

The thickness calculation will be performed down the track line at the specified locations. There are
three spacing options:
 
1. Only compute the thickenss at the vertices of the top and bottom reflectors. Enter 1 to use every
vertex, or enter a value to skip points down the line.
2. Only compute the thickness at Event marks.
3. Only compute the thickness at the specified down-track spacing (for example, every 1 meter).

Execute Computation

Click the Compute Thickness button to execute the thickness computation.
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Multiples
 

The Multiples tool is available by clicking the Multiples  button in the Acoustic Reflectors tab of the
Sub-Bottom Analysis Window. The Multiples tool is used to help identify multiples and harmonic reflections in
SBP data.
 

 Once the Tracking Mutiple Reflectors window is open the users cursor will change to an  and when
hovering over the sub-bottom profile, will display computed harmonic reflections based on the type setup.
When the user selects a possible multiple on the profile, the annotation will be drawn. Use the RESET button
to clear the profile of annotations.
 

Multiple Types

Used to select which algorthim of mutliples to track in the profile. Only one option can be selected at a
time.

Add Surface and/or Seafloor

The checkboxes can be used to add annotations where the surface and seafloor are located when
selecting a multiple. Use the drop down menu to select the color of the annotated locations.

User Defined Offset
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When checked, will add a user defined offset in the current project unit to apply to the multiple
tracking.

Multiple Color

Use the drop down menu to select the color of the annotated multiples.

Fish Info at Cursor

Readout of the fish altitude and depth at the current location of the cursor.

Multiple Annotations

When enabled, the cursor will actively track the multiples based on the type selected. Right-click a
location on the sub-bottom profile to annotate.
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Auto-Fill Points
 

The Auto-Fill Points option is available by selecting the Auto-Fill Points  button in the Acoustic
Reflectors tab and Bottom Tracking tab of the Sub-Bottom Analysis Window. The option can be enabled
(highlighted in yellow) and disabled by selecting the button and the settings used can be accessed using the
Setup option in the drop down menu.
 
The Smart Reflector Tracking algorthims allow the user to pick acoustic reflectors or the seafloor on a sub-
bottom profile with a semi-automatic process. Based on the settings used, the user will select where they see
the reflector or bottom track starts, continues, and stops and the algorthim will attempt to track it.
 

Smooth Reflector

This option applies a simple averaging to the time value at each ping of the reflector averaging the
adjacent width / 2 points to each side to determine the smoothed value for the ping. Using the smooth
reflector, set the width in pings for a continuous line of points based on the smoothing amount.

Point Spacing

This option starts with a time value for every ping but will only keep a subset of those pings for the
reflector. Starting from the ping the user clicked on it picks pings in a forward direction separated by
the user specified number of pings as the pings to keep. What time value to assign to each of the kept
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pings is calculated as a weighted average of the pings leading up to each kept ping. The last ping the
user clicked on is always a kept ping also and thus might have fewer previous pings averaged to find
its reflector time value. Using the point spacing algorthim, set the ping point spacing of the automatic
reflector trace.

Snap Range Options

The snap range (samples) field is used to set the amount of samples the algorthim will jump to
calculate the continuous line. The time in ms will be displayed.
 
The Auto search snap range option is checked ON by default and means that from the user entered
snap range an automatically determined range will be tried and the "best" one will be used. If the user
wants to ONLY use the entered snap range, uncheck that box.

Bipolar Options

If the currently opened sub-bottom file is bipolar, these options will allow the user to have the smart
reflector algorthims track on the positive or negative data. If the file does not contain both positive and
negaitve data, the options will be disabled.
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Reflector Point Interpolation
 

The Reflector Point Interpolation option is available by selecting the Insert Points  button in the
Bottom Tracking tab of the Sub-Bottom Analysis Window. The option can be enabled (highlighted in yellow)
and disabled by selecting the button and the settings used can be accessed using the Setup option in the drop
down menu.
 
When this feature is turned ON, manually inserting points will do straight linear interpolation between mouse
clicks to place the desired number of additional points between the two points clicked on. The first mouse click
will of course only put in one point. Subsequent mouse clicks will insert the additional points.
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Contacts Commands (Sub-Bottom Analysis Window)
 
The Contacts panel is the third tab of the Sub-Bottom Analysis Window. It can be opened in several ways:
 

1. Select a Sub-Bottom Dataset and click the Capture Contact  icon on the Post Processing Menu.

2. Select the Capture Contact  button on the Sub-Bottom Analysis Window Toolbar.
3. Select the Contact tab from anywhere in the Sub-Bottom Analysis Window.
 
The purpose of contacts panel is to provide tools for capturing and editing sub-bottom contacts (targets) from
the sub-bottom profile display. Note that sub-bottom contacts are listed in the Contact Manager along with
sidescan contacts, where they can be filtered, exported, and archived using the same tools as are available for
sidescan contacts.
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Current Contact List

The Current contact list displays the currently selected contact (if any). The drop down lists all contacts
in the profile.

New Contact

The New Contact button will put the cursor into Contact Insert mode . Left-click on the profile
display to enter a new contact at the cursor location. You may enter as many contacts as desired.
Right-Click the mouse to Exit Contact Insert mode.

Edit Contact

The Edit contact button will open the Sub-Bottom Contact Editor on the selected contact. You can
select a contact by either Left-Clicking on the Contact Marker in the Profile Display or select the
contact by name in the Current Contact List drop down.

Delete Contact

The Delete contact button will remove the selected contact from the project. You can select a contact
by either Left-Clicking on the Contact Marker in the Profile Display or select the contact by name in the
Current Contact List drop down.

Contact Marker

By default, sub-bottom contacts are visible as a circle marker directly in the profile display. Contact
marker and labels can be edited individually in the Sub-Bottom Contact Editor or globally in the
Contact Options Menu page of the program Preferences and Settings.



Sub-Bottom Contact Editor

1082

Sub-Bottom Contact Editor
 
The Sub-Bottom Contact Editor enables the user to view and enhance contact images, move contact
locations, make and record contact measurements, and classify the contact by adding text attributes and a
description. The Sub-Bottom Contact Editor can be opened by:
 
1. Selecting the Contact Editor command from the Contact File Context Menu.
2. Selecting the Edit Contacts command from the Contact Manager.
3. Selecting the Edit Contact button from the Contacts tab of the Sub-Bottom Analysis Window.
 
NOTE: Prior to editing contacts it is important that navigation, layback and bottom tracking operations be
completed, including datum alignment and other vertical offsets, such that positioning and altitude are
correct. Once a contact is created and edited, any subsequent changes in towfish position or altitude will
not be automatically applied to existing contacts. (See Recompute Contact Positions to manually recompute
positions, and Recapture Contact Image to manually recapture the contact image)
 

Capture Information

The Capture Information window displays the the date, time and position of the sonar data at the
selected contact position.
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Contact Image

The Contact Image (also known as the Target Image) is a clip from the sub-bottom profile display
centered on the contact position. The user can pan the contact image using the horizontal and vertical
scroll bars. The approximate dimensions of the displayed image are shown in meters (or feet).

Contact Image Adjustments

The Contact Image Adjustment buttons allow for adjusting the displayed colors of the contact image.
 

Command Description
Histogram
Equalize

Linearizes the number of pixels per gray
level in a bitmap which can be used to

bring out the detail in dark areas of an image
Invert All colors are inverted – strong reflectors

are dark and nil reflectors are light and
vice versa.

Stretch
Intensity

Increases the contrast in an image by
centering, maximizing, and proportioning the

range of intensity values.
Gamma
Correct...

Adjusts the intensity of colors in a bitmap
by changing the gamma constant that is

used to map the intensity values.
Contrast Pixel values on the lighter (higher) half of

the tonal scale are made lighter, and the
pixel values on the darker (lower) half of
the tonal scale are made darker which
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results in a larger difference between the
two ends of the scale giving the image an

appearance of greater depth.
Brightness Overall intensity of the image. Too much

brightness can cause the loss of shadows
in an image.

Restore All image enhancements are removed and
the image is returned to its original state.

 

Move Contact Position

The Move Contact command is not available on sub-bottom contacts

Next / Previous Contact

Images of the Previous and Next Contacts in the target queue are shown. The images and
associated buttons will make the next or previous contact active in the Contact Editor

Contact Name

Displays the name of the current contact in the Contact Editor. Use the ellipses button to select a new
contact. The current contact name can be edited in the text box.
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Info at Cursor

The Information at Cursor fields display navigation and sonar information for the pixel beneath the
cursor when the cursor is in the Contact Image window.
 

Date and Time
Ping Number Depth

(Fathometer)
Latitude Northing

Longitude Easting
Heading Course

Made Good
Sonar Altitude Ship Speed
Cursor Range

from Sonar
Cable Out

Event Number Magnetometer
Reading

Kilometer
Point (KP)

 

Sonar File Name

Contact Labeling

The contact labeling check boxes control how contacts will be labeled in SonarWiz displays and
exports.

Command Description
Draw
Label

Draws the contact
label when checked

Rotate
Label

Rotates the label 90
degrees when checked

Draw
Symbol

Draws the contact
marker when checked
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Zoom Contact Image

Zoom the contact image up to 5 times using the slider control

Reset Image Zoom

Resets Variable Zoom to 1x such that the original bounding image is equal to the sonar range is visible
in the image area.

Target Measurement

  
Contacts may be measured in order to assist with their classification and identification. For sub-bottom
contacts, width and height are the possible measurements. In order to measure width or height, click
on the box associated with the measurement desired, then left-click and drag the mouse from the start
of the measurement to the end.
 

Button Hot
Key

Description

Length ALT+L Allows the user to measure the
longitudinal axis of the contact.

Width ALT+W Allows the user to measure
the width of the contact.

Clear  Clears all measurements and
returns Target Height to zero.

 
NOTES:
1. Holding the shift key down while making a Length or Width measurement locks the cursor to the
nearest 45 degree angle.
2. See Select Draw Contact Measurements in Editor and Waterfall Views found in Contact Options
Menu to display the measurements as solid lines in the contact editor.

Target Symbol

Select the vector symbol and color to mark the contact target location.

Contact Class
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Contacts can be classified and annotated by adding classification text strings into the Class 1 and
Class 2 text boxes. The user can select a predefined classification from the drop-down list, or enter a
new classification by typing into the text field.
 
The predefined classification lists are contained in the ContactAttributes.txt and
ContactAttributes2.txt files stored in the project folder. These files are derived from master list
files in the SonarWiz application folder at the time the project is created. The lists can be edited using
any text editor such as Notepad. These lists and the master default lists from which they are derived
can be edited from within the Contact Preferences Menu.

Contact Block

The block field is a user-defined free form text field.

Contact User Entry Boxes

The Avoid, Magnetic Anomaly and Target Description fields are user-defined free form text fields.

Contact Area

The Area drop down list allows the user to classify the contact using a pre-defined area description.
The predefined area list is contained in the ContactLocationAreas.txt file stored in the project
folder. This file is derived from a master list files in the SonarWiz application folder at the time the
project is created. The Area list can be edited using any text editor such as Notepad. See the Contact
Options Menu for more information.

Delete Contact

The Delete command will remove the current target from the database.
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Cores (Sub-Bottom Analysis Window)
 
The Cores panel is the fourth tab of the Sub-Bottom Analysis Window. It can be opened in two ways:
 

1. Select the Add Core  button on the Sub-Bottom Analysis Window Toolbar.
2. Select the Cores tab from anywhere in the Sub-Bottom Analysis Window.
 
The purpose of Cores Panel is to provide tools for adding sediment core markers to the sub-bottom profile
display. Cores are not stand-alone objects in SonarWiz. Instead they are an annotation that can be applied to
individual sub-bottom profiles to aid interpretation and enhance image exports.
 

Current Core List

The Current core list displays the currently selected core (if any). The drop down lists all cores in the
profile.
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New Core

The New button will open the Create New Coring Location window where you can define the name
and attributes of a new core. When you are done, SonarWiz will put up an information message
informing you to click on the profile at the appropriate horizontal and vertical position to place the core:
 

 

The cursor will change  allowing you to mark the location on the sub-bottom profile where you
want to place the core.

Edit Core

The Edit button will open the Edit Coring Location window where you can modify the selected core
name and attributes.

Delete Core

The Delete button will remove the selected core from the profile.

Import Cores

The Import button will open the Import Cores window where you can batch import cores into the
profile.
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Core Marker

The core marker is an annotation or decoration displayed on the sub-bottom profile to help aid in layer
interpretation.
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Create New Coring Location
 
The Create New Coring Location window is opened in two ways:
 

1. Selecting the Add Core  button in the Sub-Bottom Analysis Window Toolbar.

2. Selecting the New  button in the Cores Tab of the Sub-Bottom Analysis Window.
 
The Create New Coring Location window allow for defining the name, description and display properties of
new core annotations. After the Create New Coring Location window is closed, the user will be prompted to
place the core on the open sub-bottom profile window with the mouse.
 

Name

Enter the core name. This string will be used for labeling the core in the Main View and the sub-bottom
profile if labels are enabled.

Description

Enter a description for the core
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Width

Enter the width of the core graphic marker in pixels.

Depth to Top

Specify the depth to the start of the core record. Note: when the core is placed with the mouse, the
depth of the cursor will override this value.

Display Toggle

Toggle to enable displaying the core graphic.

Band Controls

Use the Add Band..., Remove Band... and Edit Band... buttons to construct the vertical layers that
make up the core.
 

Name Description
Add Band... The Add Band button is used to add a new layer to the core. It opens

the Core Band Editor. New Layers are added to the bottom of the core.
Remove Band... The Remove Band button is used to

delete the selected layer from the core.
Edit Band... The Edit Band button is used to edit an existing layer in the core.

It opens the Core Band Editor with the existing properties filled in.

Band List

The Band List shows the current core layers from top to bottom. Each row represents a layer in the
core graphic. The layers can be edited by selecting the row with the mouse and clicking the Edit
Band... button.

Copy Core

The Copy Core... drop down list allows for copying the attributes and layers from an existing core into
the current core. Click the Copy Core... button and select from the list of cores.
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Label Properties

Toggle the Draw Core Label check box to enable core labels on this core. You can also set the text
color and font.
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Edit Coring Location
 

The Edit Coring Location window is opened by selecting the Edit Core  on the Cores Tab of the Sub-
Bottom Analysis Window. The Edit Coring Location window allow for modifying the name, description or
display properties of the selected core annotations.
 

Name

Enter the core name. This string will be used for labeling the core in the Main View and the sub-bottom
profile if labels are enabled.

Description

Enter a description for the core

Width

Enter the width of the core graphic marker in pixels.
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Depth to Top

Specify the depth to the start of the core record. Note: when the core is placed with the mouse, the
depth of the cursor will override this value.

Display Toggle

Toggle to enable displaying the core graphic.

Band Controls

Use the Add Band..., Remove Band... and Edit Band... buttons to construct the vertical layers that
make up the core.
 

Name Description
Add Band... The Add Band button is used to add a new layer to the core. It opens

the Core Band Editor. New Layers are added to the bottom of the core.
Remove Band... The Remove Band button is used to

delete the selected layer from the core.
Edit Band... The Edit Band button is used to edit an existing layer in the core.

It opens the Core Band Editor with the existing properties filled in.

Band List

The Band List shows the current core layers from top to bottom. Each row represents a layer in the
core graphic. The layers can be edited by selecting the row with the mouse and clicking the Edit
Band... button.

Sub-Bottom Profile

This information field lists the sub-bottom profile data set this core is attached to.

Label Properties

Toggle the Draw Core Label check box to enable core labels on this core. You can also set the text
color and font.
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Core Band Editor Window
 
The Core Band Editor window is open by selecting Add Band button or Edit Band buttons found on both the
Create New Coring Location window and the Edit Coring Location window. The Core Band Editor allows you to
name, describe and set attributes on an individual band or layer of a sediment core annotation.
 

Name

Enter the name of the layer.

Description

Enter a description of the layer.

Color

Set the color of the layer using the color drop-down list.

Thickness

Set the thickness of the layer in meters or feet.
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Import Cores Window
 
The Import Cores window is opened in two ways:
 

1. Selecting the Cores | Import Cores  command on the Post Processing Menu.
 

2. Selecting the Import...  button in the Cores Tab of the Sub-Bottom Analysis Window.
 
The Import Cores window allows for importing cores stored in an existing COR database file or in a special
text file format used for importing core data into SonarWiz (see Sub-Bottom Core TXT File Format for more
information).
 

Import File

The Choose button allows you to select the core import file. You can choose to import an existing COR
database file from a different SonarWiz project or you can import a text file in the Sub-Bottom Core
TXT File Format. COR database files are created automatically by SonarWiz after cores have been
added to the project and the project is saved. COR database files are also backed up in an existing
project in the project BACKUP folder.

Display Options

Before importing the new cores, toggle the Display and Label check boxes to set the visibility of the
new cores and their lables.
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Import Option

The import column lists which cores will be imported. Only cores with a check will be imported.

Core List

The Core List shows all of the cores identified in the import file.
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Appearance (Sub-Bottom Analysis Window)
 
The Appearance tab of the Sub-Bottom Analsysis window provides controls for modifying the appearance of
the sub-bottom profile data including gains, annotations, vertical and horizontal scaling, and some basic image
processing options. The Appearance tab also has controls for enabling and disabling various widgets in the
sub-bottom analysis environment such as the toolbar, signal trace and spectrograph.
 

Gain Settings

The Gain Settings button opens the Sub-Bottom Settings Window which provides controls for all sub-
bottom signal processing functions within SonarWiz.

Histogram Equalize

The Histo Equalize button temporarily increases the global contrast of the current sub-bottom profile
display. Through this adjustment, the sonar intensities can be better distributed on the histogram. This
allows for areas of lower local contrast to gain a higher contrast. Histogram equalization accomplishes
this by effectively spreading out the most frequent intensity values. This adjustment is temporary and
is not saved when switching to a new profile.
 
The Invert button temporarily inverts the color map of the current sub-bottom profile display. This
adjustment is temporary and is not saved when switching to a new profile.
 
The Normalize button temporarily applies an image normalization algorithm to the sub-bottom profile
display to ensure that the range of pixel intensity values fills the available color map. This adjustment
is temporary and is not saved when switching to a new profile.
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The Restore button returns the sub-bottom profile display restores the sub-bottom profile display
image back to its value before the effects of Histogram Equalize, Invert, and Normalize functions were
applied.

Annotation

The Annotation button opens the Annotation/Display Options window which provides controls for
annotating and labeling the Sub-bottom Analysis Window.

Preferences

The Preferences button opens the Sub-Bottom Options Menu.

Show Toolbar

The Show Toolbar button toggles the display of the Sub-Bottom Analysis Toolbar.

Show Info At Cursor

The Show Info At Cursor button toggles the display of the Info At Cursor floating window.

Show Spectrograph

The Show Spectrograph button toggles the display of the Sub-Bottom Spectrograph floating window.

Export Image
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The Export Image button is used to quickly create an image file of the current view in the digitizer.
Use the drop down  to select between a .JPG, .BMP, or .TIF.

Show Signal Trace

The Show Signal Trace button toggles the display of the Sub-Bottom Signal Trace.

Full Screen

The Full Screen button expands the sub-bottom analysis window to fill the entire screen. Hit ESC to
exit full screen mode.

Vertical Exaggeration

The Vertical Percentage value is used to set the percentage of vertical exaggeration of the sub-

bottom profile. Use the  and  buttons to increment the percentage by +/- 10 percent. The
Vertical Exaggeration field will indicate the calculated ratio of across track pixels per meter and along
track pixels per meter.
 
This option will set the vertical exaggeration for a single file in the digitizer. To syncronize the amount
of exaggeration between waterfall displays and with subsequently opened profiles in the digitizer,

select the  button in the Sub-Bottom Analysis Toolbar.
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Sub-Bottom Analysis Toolbar
 

The Sub-Bottom Analysis Toolbar is available by clicking the Show Toolbar  button on the
Appearance tab of the Sub-Bottom Analysis Window. The toolbar provides quick access to zoom and pan the
display as well as buttons for digitizing new features and contacts.
 

 

Save and Previous button

Save digitized features and open the previous sub-bottom data set in the project.

Save Features button

Save Digitized Features

Save and Next button

Save digitized features and open the next sub-bottom data set in the project.

Copy button

Copy the selection and put it on the Clipboard
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Measure button

Measure horizontal and Vertical Distances on Image

Zoom In (PgDn) button

Zoom In by 10%

Zoom Out (PgUp) button

Zoom Out by 10%

Zoom Normal button

Show Normal Zoom

Zoom to Fit Height button

Zoom the image to fit the height of the window

Insert Polyline or Polygon Feature button

Add line, polyline or polygon feature by drawing the feature with the mouse.  Right click to end the
digitizing session.

Add Quick Thickness button

Add a Quick Thickness Feature

Reflector Thickness button

Opens the Compute Reflector Thickness window.
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Add Core button

Opens the Create New Coring Location window.

Core List button

Opens the Core List window.

Capture Contact button

The Capture Contact button will put the cursor into Contact Insert mode . Left-click on the
profile display to enter a new contact at the cursor location. You may enter as many contacts as
desired. Right-Click the mouse to Exit Contact Insert mode.

Undo button

Undo the last action

Redo button

Redo the previously undone action

Sync Waterfall Displays

Syncronizes the waterfall displays zoom level and vertical exaggeration.
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Sub-Bottom Info At Cursor Window
 

The Info At Cursor window is opened by clicking the Info At Cursor button  on the Appearance Tab
of the Sub-Bottom Analysis Window. The Info At Cursor display is dynamically updated to show file and ping
properties and attributes of the samples directly beneath the mouse pointer when panned over the sub-bottom
profile panel.
 

 
The following table describes the cursor information displays:

Ping Date and Time
Ping Number Latitude
Slant Range Longitude
Cursor Depth Northing

Cursor Elevation Easting
Depth Below Seafloor Heading

Total Water Depth Course Made Good

Sensor Depth Speed
Sensor Altitude Event Number

Surface Elevation Kilometer Point
Bathy Grid Separation  

Tide Height  
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Swell  
Heave  

Antenna Height  

Starting Elevation  
Image Record (Column) Image Pixel (Row) Pixel Amplitude
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Sub-Bottom Signal Trace
 

The Sub-Bottom Signal Trace is displayed by clicking the Show Signal Trace button  located on
the Appearance Tab of the Sub-Bottom Analysis Window. The Signal Trace displays a relative amplitude trace
for the ping currently under the cursor. The signal trace will appear directly to the right of the sub-bottom profile
display when enabled.
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Amplitude Trace

The ping amplitude is represented by a white line. Vertical units will match the sub-bottom profile
display panel, Horizontal units are relative, with the maximum amplitude value to the right of the plot.

Bottom Track Marker

The vertical time/depth of the bottom track for the ping under the cursor is marked with a red horizontal
line.

Cursor Marker

The vertical time/depth of the cursor is marked with a yellow line.
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Sub-Bottom Spectrograph
 

The Sub-Bottom Spectrograph is opened by clicking the Show Spectrograph Button  found on
the Appearance Tab of the Sub-Bottom Analysis Window. The Sub-Bottom Spectrograph provides a graphical
display of the frequency spectrograph of the ping currently under the cursor. The Spectrograph also provides a
visual tool for adjusting the Band Pass Filter.
 

Enable Band-Pass Filter

Toggle to enable the interactive band-pass filter tools. Set the taps, passband and window shape
and then pan the cursor over the sub-bottom profile display to see the effect of the changes on the
spectrograph.

Taps
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Define the number of taps (order) of the filter. Taps can range from 1 to 37767.  Taps control: 1) the
amount of memory required to implement the filter, 2) the number of calculations required, and 3)
the amount of “filtering” the filter can do; in effect, more taps means more stopband attenuation, less
ripple, narrower filters, etc.

Window Shape

SonarWiz uses a windowed-sinc bandpass filter. Here you can define the window used to multiply the
truncated-sinc filter kernal. Four windows are available for completeness, however only the Blackman
and Hamming are worth using. The Hamming window results in about 20% faster roll-off than the
Blackman window. However, the Blackman window has better stopband attenuation (Blackman:
0.02%, Hamming: 0.2%), and a lower passband ripple (Blackman: 0.02%, Hamming 0.2%).
 

Window
Shape

Notes

Bartlett A triangle, uses straight lines for the taper, about the
same speed as Hamming, but worse stop band than
Hamming.

Blackman Better stopband attenuation than Hamming, slow
rolloff. This should be your first choice.

Hamming Hamming is about 20% faster than Blackman, some
passband ripple. This should be second choice.

Hanning The raised cosine window, about the same speed as
Hamming, but worse stop band than Hamming.

Rectangular Equivalent to no window at all, just a truncation of
the sinc tails. Significant passband ripple.

Passband Settings

Define the passband by specifying the low frequency cutoff and high frequency cutoff. The low-
frequency cutoff must be greater than 0. As you adjust the passband boundaries, you will see a
hatched overlay on the spectrograph to identify where the passband falls on the frequency spectrum.
You can grab the edges of the passband overlay with the mouse and adjust the limits visually.

Apply To File

The Apply To File button sets the Band Pass Filter settings for the file to match.

Appearance
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Opens the Graph Appearance dialog where you set color preferences and control the graphic style
and scale.

Stopband Indicator

When the bandpass filter is enabled, the stopband area will be shaded with a hatch pattern to indicate
that the underlying frequencies are being filtered.

Spectrograph



Sub-Bottom Spectrograph

1112

The frequency spectrograph of the amplitude values for the ping under the cursor are shown
by default. The vertical scale indicates the magnitude, the horizontal scale is the frequency. If the
bandpass filter is enabled, a filtered version of the same ping data is shown in an alternate color.
Colored hatching will indicate where the stopbands have been placed. Moving the cursor over the sub-
bottom profile display will cause the Spectrograph to update so you can examine data from different
pings interactively.

Vertical Scale

Use the vertical slider to interactively change the vertical scale of the spectrograph.

Horizontal Scale

Use the horizontal slider to interactively change the horizontal scale of the spectrograph. You can
also switch from a linear display to a logorithmic display by clicking the Appearance button.
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Bathymetry and Lidar Data
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Vessel Editor
 

The Vessel Editor is opened by clicking Data Acquisition | Vessel | Open Vessel Editor. The vessel editor
General Information section is used to control the vessel appearance in the 2D map view during real-time
data collection. The vessel editor is also used to configure the platform for Bathymetry, Singlebeam and
LiDAR surveys. The vessel editor is not currently used to configure Sidescan, Subbottom or Magnetometer
surveys.

 

Program Menu

The program menu provides access to additional commands that are not exposed on the main
window.
 
File Menu

Command Description
Open Project Open the vessel database for another

project
Close Project Close the vessel database
Create Vessel Create a new vessel in the database
Delete Vessel Delete the selected vessel from the

database
Import Vessel Import vessel offset from an XML

vessel definition file (See Select
Vessel... window for more information)

Import Sensors Import sensors from bathymetry files.
Kongsberg ALL, Hypack HSX, and
Reson S7K, Imagenix d1p file formats
are currently supported.

Exit Exit the program
 
Settings Menu
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Command Description
Application Settings Launch the Applications settings

window to control vessel editor colors
and appearance.

Graphic Settings Launch the Graphics quality and
performance settings window to control
the graphical performance of the 3D
view

Reset window layout Restore the factory default window
layout

 
View Menu
 

Command Description
3D Viewer Toggle the display of the 3D vessel

display
Vessel Properties Toggle the display of the vessel

properties pane
Sensor list Toggle the display of the sensor list
 
Help Menu
 

Command Description
About Launch the About dialog to see the

Vessel editor version and licensing
information

User Manual Open the Vessel Editor user manual in
you system PDF viewer
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Vessel Properties

Define the approximate shape and size of the vessel and position the vessel reference point. The
waterline height is the distance from the vessel reference point to the still waterline of the vessel.

General Information

Vessel Name and Description
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Specify the vessel definition name here. Multiple vessel definitions can be stored in the project
database so long as they have a unique name. All projects are created with a Default vessel definition
(see Select Vessel... window for more information). You can choose the type of platform Surface
Vessel or AUV which will change the schematic diagram appropriately.
 
New vessel definition files may be created for you when you import sonar data into a project for the
first time. These vessel definitions will indicate which file was used to populate the sensor list in the
vessel description box.
 
Vessel appearance
The settings in the vessel appearance section control how the vessel icon will be displayed in the main
SonarWiz application during real-time operations. You can control the color, drawing mode and size of
the icon as well as the heading source.
 
The Heading Angle Source will determine which determine if a raw or interpolated heading is used
to project the data and which will change the direction that offsets are applied when computing a fish
postion by applying layback and sheave offsets. See Layback for more information.

3D View

The 3D View is an interactive schematic of the survey platform with icons representing the various
sensors you have configured in the Sensor list. You can control the appearance of the display in the
Application settings window

Sensors List

The Sensors list contains a table of sensors configured on the platform. Each row of the table lists a
sensor or sensor channel along with its name, description and offsets. You can Add or Edit existing
sensors (see Edit sensor window) or Delete a sensor from the list.
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Application Settings Window
 

The CTI Vessel Editor Application Settings window can be opened from the CTI Vessel Editor Settings
| Application Settings menu. The Application Settings dialog controls how the objects in the 3D vessel
schematic of the editor are displayed. 

 

Scene Background Color

Set the 3D scene background color

Scene Label Color

Set the 3D scene foreground color for text and line decorations

Show bounding Box

Toggle the display of a bounding box around the vessel schematic

Show Coordinate Axes

Toggle the display of the coordinate axes lines on the vessel schematic

Show Rotation Rings
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Toggle the display of rotation rings about the vessel schematic

Measurement Unit

Set the measurement unit for dimensions in the vessel editor.

Center View on Selected Sensor

Toggle center on selected sensor

Status messages

Modify the communication port to SonarWiz from the Vessel Editor Application. The default port is
9505.

Vessel Color and Transparency

Set the vessel color and transparency in the 3D scene

Vessel Model

Choose how the vessel model will be drawn (solid, lines or both)

Fan Display Width

Set the angular width of the swath fan display (in degrees)

Fan Display Thickness

Set the angular thickness of the swath fan display (in degrees)

Waterline Color

Set the waterline color in the 3D scene
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Advanced configuration controls

FOR CTI USE ONLY.
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Graphics Quality and Performance Settings window
 

The CTI Vessel Editor Graphics Quality and Performance Settings window can be opened from the Settings
| Graphics Settings menu command. If you are experiencing difficulty rendering the 3D scene in the vessel
editor, you can try different antialiasing rendering options here.
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Edit sensor window
 

The CTI Vessel Editor Edit Sensor window can be opened from the Add sensor button or Edit sensor button
on the Vessel Editor main window. The Edit sensor window is used to add and modify sensors to the platform
definition. Sensors are grouped by class and model. The user should edit the Configuration Table directly to
modify the X, Y and Z offsets from the vessel reference point (VRP) and the angular rotations (Roll, Pitch and
Heading) for mapping systems if required.
 
Some mapping systems have multiple channels of data, such as dual head sonars. In this case, both
channels will be shown in the configuration table and both channels will need to be configured.  SonarWiz will
automatically suggest offsets for systems that typically require them, such as many interferometeric sonars.
When entering offsets or angles into the Configuration Table, pay attention to the coordinate system used
by SonarWiz as this may be different from your sonar manufacturer or acquisition software. The coordinate
system used by SonarWiz is displayed on the right-hand side of the window.

 

Name

The sensor name. This field is for display purposes and the user is welcome to change the suggested
name, However, it must be unique from all other sensors configured on the platform.

Description

The sensor description. This is a display-only field and the user is welcome to change it.
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Sensor Class

SonarWiz organizes sensors into classes. The complete list of supported classes is listed in the
table below. Note that at this time, only swath bathy and laser scanner projects are supported
using this interface. To configure towed surveys such as you must use the Sidescan, Subbottom or
Magnetometer Setup windows.

 
Class Description

Sidescan Not Used
Subbottom Not Used
Swath Bathy Multibeam

echosounders and
  phase measuring
bathymetric sidescan

Position Navigation sensors
Fathometer Singlebeam

echosounders
Magnetometer Not Used
Motion Sensor Heading, pitch and roll

sensors
Cable Meter Not Used
Laser Scanner Terrestrial laser

scanning systems
Sidescan Sonar Position Not Used
Subbottom Sonar
Position

Not Used

Bathy Sonar Position Not Used

Sensor Model

Select the sensor model.

Towed by

Not yet supported.

Sensor Priority

Set sensor priority. If multiple sensors of the same class are defined, the sensor with the highest
priority will be processed.
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Coordinate System

The SonarWiz vessel coordinate system. Please pay attention to the conventions list here, as these
may be different from your sonar installation manual or your acquisition software.

Data Channels

(READ ONLY) lists the number of supported channels of data for the selected sensor model.

Configuration Table

The Configuration Table can be edited by the user to enter the X,Y and Z offsets of this sensor
from the vessel reference point (VRP). You can also enter Roll, Pitch and Heading angular offsets if
required. The Color setting controls the color of the channel in the 3D vessel display. The units used
(meters or US Survey Feet as selected in the Application Settings Window).

OK button

Accept the settings and close the window.

Cancel button

Close the window without changing the vessel.
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Select Vessel...
 

The Select Vessel.. window is opened by clicking on Data Acquisition | Vessel | Select Vessel for
Project.... The Vessel selected for a project contains information needed for the processing of Bathymetry,
Singlebeam and LiDAR data. The Vessel also contains the instructions for how to render the vessel icon in the
2D Map display during real-time data acquisition. The Vessel is not currently used to configure towed systems
(sidescan, subbottom or magnetometer).
 
More than one Vessel can be configured in a project at one time. The Select Vessel window provides the
controls for selecting the active vessel, creating or editing new vessels, and importing or exporting vessel to
other projects. 
 
 

Currently Selected Vessel

All vessels configured for the project will be listed in the Currently Selected Vessel drop down. If no
vessel has been configured for a project, SonarWiz will provide a Default vessel. Use this drop-down
to select the active vessel to be used for all commands that require vessel information.

Add/Edit Vessel...

Click the Add/Edit Vessel... button to open the Vessel Editor where you can make changes to the
currently selected vessel or create a new vessel.

Delete Vessel...

Delete the currently selected vessel. You must have at least one vessel configured for a project.
SonarWiz will not allow you to delete the last vessel in the project.
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Export Vessel...

Export the currently selected vessel as an XML definition file which you can share with other users of
SonarWiz.

Import Vessel...

Import an XML definition file created by SonarWiz.

Set as Default Vessel

All SonarWiz projects must have a vessel defined. If no vessel is defined by the user, a Default vessel
is provided. You can make the currently selected vessel the default vessel for future projects. This
will save you time configuring a new vessel for each survey if you tend to use the same configuration
repeatedly.

Clear Default Vessel

Clear the previously defined default vessel and set it back to the factory-default configuration.

OK

Accept the changes and close the dialog.

Cancel

Cancel without making changes to the current vessel.
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Import (Bathymetry)
 

The Import Bathymetry Files... command opens a dialog where you can select 1 or more bathymetry files for
importing into a SonarWiz project. The Import Bathymetry Files command can be activated by:
 

1. Clicking the Import | Bathymetry Files...   button in the Post Processing Menu
2. Clicking the Import... command from the context menu in the Project Explorer.
 
NOTE: You can also import bathymetry files into a project by drag-and-drop onto the main SonarWiz window.
 

Program Folder

Select the windows directory where you bathymetry files are located.
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File Display List

One or more files can be selected for import by holding down the SHIFT or CONTROL keys while left
clicking with the mouse.

File Name

The files to import will be listed in the File Name box.

File Type filter

The Files of type drop down provides a filter that is used to restrict the file list to only those bathymetry
file types supported by SonarWiz. Use the drop down to filter for specific file types.

Bathymetry Import Settings

 
See Bathymetry Import Settings for more information.
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Import (Lidar)
 

The Import Laser Scanner Files... command opens a dialog where you can select 1 or more LiDAR files for
importing into a SonarWiz project. The Import Laser Scanner Files command can be activated by:
 

1. Clicking the Import | Laser Scanner Files...   button in the Post Processing Menu
2. Clicking the Import... command from the context menu in the Project Explorer.
 
NOTE: You can also import lidar files into a project by drag-and-drop onto the main SonarWiz window.
 

Program Folder

Select the windows directory where you bathymetry files are located
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File Display List

One or more files can be selected for import by holding down the SHIFT or CONTROL keys while left
clicking with the mouse.

File Name

The files to import will be listed in the File Name box.

File Type filter

The Files of type drop down provides a filter that is used to restrict the file list to only those bathymetry
file types supported by SonarWiz. Use the drop down to filter for specific file types.

File Type Specific Options

Open the File Type Specific Options window where settings unique to each sonar file type can be
specified.

Import Geodesy

Some bathymetry file formats do not record geodetic coordinates and instead only record grid
(projected) coordinates. Use this dialog to specify the coordinate system used by the file so that
SonarWiz can decode the XY coordinates used by the raw bathymetry. SonarWiz will convert the
XY coordinates back to WGS84 geodetic coordinates and then re-project the data into the project
coordinate system (if necessary).
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Bathymetry Import Settings
 
The Bathymetry Import Settings are used to control how bathymetric files are interpreted in SonarWiz. The
bathymetric import settings are located on the Post Processing > Settings > Bathy Import Settings... dialog
and also found at the bottom of the Import Bathymetry Files... dialog (see Importing Bathymetry ).
 
 

File Type Specific Options...

Open the File Type Specific Options window. Here you can control settings unique to the particular file
format or sonar system you are importing.

Browse Coordinate Systems...

Some bathymetry file formats do not record geodetic coordinates and instead only record grid
(projected) coordinates. Use this dialog to specify the coordinate system used by the file so that
SonarWiz can decode the XY coordinates used by the raw bathymetry. SonarWiz will convert the
XY coordinates back to WGS84 geodetic coordinates and then re-project the data into the project
coordinate system (if necessary).

Navigation data in XY or grid format. check

Some sonar file formats store position information in grid coordinates and do not contain latitude and
longitude information. For these file formats, you must indicate to SonarWiz the coordinate system in
use so that the navigation is properly interpreted. Toggle to automatically convert grid coordinates in
the sonar file.
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Bathymetry Auto Merge Settings
 

The Bathymetry Auto Merge Settings command opens the bathymetry settings window. The Bathymetry
Settings window controls how new bathymetry files (including single beam and laser scanner) will compute
sample elevations and what, if any filters will be automatically applied.
 
To open the bathymetry settings window:
 

1. Click the Settings... icon  on the Bathymetry Menu.
2. Select Settings... from the Bathymetry File context menu.
3. Select Post Processing > Settings > Bathy Auto Merge Settings.
 
When a bathymetry data set is imported into SonarWiz (or recorded in real-time), a copy of the Current
Project Settings will be inserted into the file properties. During subsequent merge and filter operations, the
user will have an opportunity to review and override the settings that have been previously applied.
 
It is possible to save a group of settings with a name where the set can be recalled using the Current Project
Settings Group drop down list. It is also possible to change the settings on existing files by using the Make
Others Like This... button. Note, however, that the settings won't be applied until you re-Merge or re-Filter the
affected data sets.
 
For detailed descriptions of the various setting properties see the Merge Settings and Filter Settings topics.
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Settings Group

This drop down list allows you to switch between named project settings groups.
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Settings Table

The Settings Table is a list of Property and Values that control various aspects of the bathymetry
(elevation) computation and filtering. The properties are divided into groups which are indicated with a

bold green title. The groups can be collapsed by clicking on the  icon. You can change a property by
clicking in the Value box.
 
For detailed information on the Position, Attitude and Height Computations settings groups see Merge
Settings topic.
For detailed information on the various filter settings see Filter Settings topic.

Make Project Settings

Use the Make Project Settings button to apply the currently selected Settings Group to the SonarWiz
project.

Save As...

If you need more than one group of default settings for a project (for example, you have multiple
vessels with different configurations) you can name a group of settings and save them using the Save
As... button. Once the collection is saved, it will be available in the Current Project Settings group
drop down.

Make Others Like This...

The settings in this dialog are only applied to newly imported or newly recorded files. If you want to
apply these settings to previously imported files, you can use the Make Others Like This... dialog to
override the previously used settings. This will change the status icon on the bathymetry and laser files
to yellow, indicating that they need to be re-Merged and/or re-Filtered to apply the updated settings. 
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OK

Accept the changes to the default settings and close the dialog

Cancel

Close the dialog without applying the settings.

Load/ Save File

Use the Save to File... button to save the configured settings to a .ini file. Use the Load from File... to
open saved .ini files into a SonarWiz project.



Merge Settings

1137

Merge Settings
 
Merge settings are found in the Bathymetry Settings dialog and also in the Merge -- Auxiliary Data Selection
window of the Merge wizard. The merge settings control how information from the platform position sensor,
motion sensor and sonar or laser scanner will be combined to produce sample elevations. Initially the settings
are set to default values found in the Bathymetry Settings window. During the merge process, the user will be
presented with the last-used settings which can overridden if necessary.
 
There are three groups of properties needed to control the merge process: Position, Attitude and Height
Computation. See the following sections for details on each of these settings groups.
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Position Settings
 
The Position Settings group is found in the Bathymetry Settings window and also in Merge -- Auxiliary Data
Selection window. The Position Settings group assigns the vessel definition which contains a description of
the sensors mounted on the survey platform as well as offsets of each sensor relative to the Vessel Reference
Point (VRP). The Position Settings group also indicates the conversion ratio from the survey units to meters
(internally, SonarWiz uses SI units) and allows the user to select the Position Source.
 

Meters to Units

The ratio of survey units to meters. This value is set by SonarWiz when you select a coordinate
system for the project (see Create a Project Manually). For US Survey Feet the value should be
approximately 3.2808 (US Survey Foot to meters). The user can override these default values if
necessary.

Position Source

Position source can be set to either Internal or External. Internal means to take the position from the
records stored in the data file itself. External means that an external navigation file has been loaded
and the position records should come from that external source. See Import External Navigation for
more information.

Position Altitude Scalar and Offset

Altitudes taken from the internal or external position source can be altered before use by means of a
scalar and offset in the following manner: working value = (stored value * scalar) + offset.  The default
values of 1.0 for the scalar and 0.0 for the offset use the stored value as-is.
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Attitude Settings
 
The Attitude Settings group is found in the Bathymetry Settings window and also in Merge -- Auxiliary Data
Selection window. The Attitude Settings group determines how the platform orientation will be computed.
 

Attitude Source

The Attitude Source can be either Internal or External. Internal means use the attitude records stored
in the raw file. External means that a separate attitude file has been loaded into the project using
Import External Navigation feature. Usually, the attitude record in the file is a "real-time" record which
can be improved with post-processing. If you import a post-processed attitude record, select External
source here.

Apply Roll, Pitch and Heading

The application of roll, pitch and heading can be toggled here. In most cases, you should leave these
all turned on, but there are debugging scenarios where it is handy to turn these corrections off.

Reverse the sign of Roll, Pitch and Heading

SonarWiz assumes that the sign of the motion sensor follows a right-hand rule: Roll is positive port-
side up; Pitch is positive bow up; Heading is positive clockwise (east of north). If this is not the case,
you can reverse the sign here. Note that this may be an indication that your motion sensor is not
oriented correctly in the vessel definition file (See Vessel Editor).
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Height Computation Settings
 
The Height Computation Settings group is found in the Bathymetry Settings window and also in Merge --
Auxiliary Data Selection window. The Height Computation Settings group determines how the elevation value
of samples will be computed.
 

Apply Heave

Apply heave from the motion sensor, yes or no? You may wish to turn this off if the antenna position
height is going to be used, as both the motion sensor and the GPS will record heave changes.
Post-processed navigation data (Applanix SBET files, for example) incorporate the heave sensor
information in the final antenna position so you should turn heave correction off in this situation.

Heave Source

The Heave Source can be either Internal or External. Internal source means to use the heave
information stored with the motion sensor records in the imported data file. External source should
be used if you have used the Import External Navigation feature to import post-processed heave
information.

Reverse Heave Sign

Heave is assumed to be positive up in the data record. If this is not the case, you can reverse the
heave sign here.
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Datum Grid

If Apply vertical datum offset is set to YES, use the  icon in the Vertical Datum Grid File line
to select and import a datum grid. SonarWiz supports a wide number of grid formats and will
automatically re-project the grid to the project projection, if necessary.
During sample elevation computations, SonarWiz will use the position of the vessel to interpolate a
value from the datum grid. This value will be added to the final elevation computed for each sample.
This feature is intended to apply Geoid corrections to survey data collected on a GPS ellipsoid.
However, it can be used by the user to perform other spatially variable vertical offsets.

Height Offset

If Apply user entered height offset is set to YES, the user can enter a static height offset on the
following line.

 

Antenna Heights

If Apply antenna heights is set to YES, SonarWiz will compute sample elevations relative to the
antenna elevation; if the Apply antenna heights is set to NO, SonarWiz will compute sample elevations
relative to the tide level which is assumed to be zero if tides are not loaded.
 
Care should be taken that the Antenna Heights and Heave are not both correcting for short-period
elevation changes on the vessel.

Pressure Depth

If Apply pressure depth is set to YES, SonarWiz will compute sample elevations relative to the
pressure sensor depth reading (For ROV and AUV operations).
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Filter Settings
 
Filter settings are found in the Bathymetry Settings dialog and also in the Filter -- Settings window of the Merge
wizard. The filter settings control a number of filters that can be applied to elevation data after merging. Initially
the settings are set to default values found in the Bathymetry Settings window. During the merge process
or during a filter operation, the user will be presented with the last-used settings which can overridden if
necessary.
 
There are 12 filters available for use. Please see the following sections for detailed information on their
application.
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Reset Filter Flags
 
The default Reset Filter Flags settings are set on Bathymetry Settings table and can be overridden during the
merge process on the Filter -- Settings window page of the merge wizard. You can also run the Reset Filter
Flags filter without merging by clicking the Filter button on the Bathymetry Menu.
 
Once a sounding has been flagged it will no longer be used for bathymetry and amplitude computations or
visualizations. The reset filter flags option will clear flagged samples by flag class during subsequent merge or
filter operations so that these samples can be used again.
 

Enable Filter Flag Reset

When set to YES, the selected filter flags will be reset (samples will be turned back on)

Automatic Flags

When set to YES, samples removed by the automatic filters will be restored.

Downsample Filter Flags

When set to YES, samples removed by the Downsample Filter will be restored.

Manual Filter Flags

When set to YES, samples removed by the user in the various editors will be restored.

Manufacturer Filter Flags

When set to YES, samples flagged by the sonar system (or 3rd party acquisition software) will be
restored (if possible)
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Channel Filter
 
The default Channel Filter settings are set on Bathymetry Settings table and can be overridden during the
merge process on the Filter -- Settings window page of the merge wizard. You can also run the Channel Filter
filter without merging by clicking the Filter button on the Bathymetry Menu.
 
The purpose of the channel filter is to turn on or off, particular sonar channels for processing. SonarWiz
assigns channel 0 to all single channel systems and port-facing transducers in dual-head systems. Channel 1
is reserved for starboard-facing transducers in dual-head systems. Up to 4 channels are supported.
 

 

Enable Channel Filter

To enable the channel filter set to YES.

Use Channel?

Set the Use Channel value to NO to remove all data from the selected channel, set the Use Channel
value to YES to display data from the channel.
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Manufacturer Flag Filter
 
The default Manufacturer Flag Filter settings are set on Bathymetry Settings table and can be overridden
during the merge process on the Filter -- Settings window page of the merge wizard. You can also run the
Manufacturer Flag Filter filter without merging by clicking the Filter button on the Bathymetry Menu.
 
The purpose of the Manufacturer Flag filter is to remove samples that were identified by the sonar (or laser
scanner) manufacturer as low quality.
 

 

Enable Filter

Set to YES to remove samples flagged by the sonar manufacturer as low quality.
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Amplitude Filter
 
The default Amplitude Filter settings are set on Bathymetry Settings table and can be overridden during the
merge process on the Filter -- Settings window page of the merge wizard. You can also run the Amplitude Filter
filter without merging by clicking the Filter button on the Bathymetry Menu.
 
The purpose of the amplitude filter is to remove samples with low-amplitude.
 

How it Works
 
The Amplitude Filter calculates the mean sample amplitude of each ping and flags all samples that fall below
the specified ratio of the mean. The ratio is called the Amplitude Filter Bias. For example, in the figure that
follows the filter bias is set to 0.8 and all samples that fall below 0.8 x mean amplitude (the red zone) are
flagged and removed from display.
 

 
 

Amplitude Filter Settings
 

Enable Amplitude Filter

When set to YES, the amplitude filter will remove points.

Amplitude Filter Bias
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The mean amplitude of the ping is multiplied by the filter bias. All samples with amplitude less than the
resultant value are flagged.
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Range Filter
 
The default Range Filter settings are set on Bathymetry Settings table and can be overridden during the
merge process on the Filter -- Settings window page of the merge wizard. You can also run the Range Filter
without merging by clicking the Filter button on the Bathymetry Menu.
 
The purpose of the Range Filter is to remove points that are too close to the sonar system or too far away from
the system.
 

 
How it Works
 
The Range filter flags all soundings closer to the transducer than Filter Near Range, and flags all sounding
beyond Filter Far Range.
 

 
 

Range Filter Settings
 

Enable Filter

When set to YES, the range filter will remove points.
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Minimum Range

Set the minimum acceptable range. All points closer to the source than Filter Near Range will be
removed.

Maximum Range

Set the maximum acceptable range, All points further from the source than Filter Far Range will be
removed.
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Cutoff Angle Filter
 
The default Cutoff Angle Filter settings are set on Bathymetry Settings table and can be overridden during
the merge process on the Filter -- Settings window page of the merge wizard. You can also run the Cutoff
Angle Filter without merging by clicking the Filter button on the Bathymetry Menu.
 
The purpose of the Cutoff Angle Filter is to remove samples close to the nadir and to remove samples from the
outer beams.
 
How it Works
 
The Cutoff Angle Filter flags all soundings between the Inner Minimum Cutoff Angle and the Inner
Maximum Cutoff Angle (the nadir region). Also, it flags all soundings beyond the Outer Minimum Cutoff
Angle and beyond the Outer Maximum Cutoff Angle (the outside beams).
 

 
Note that angles are measured negative to port and positive to starboard in degrees.
 
Cutoff Angle Filter Settings
 

 

Enable Filter

Set to YES to use the Cufoff Angle filter
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Inner Cutoff Filter

The Inner Cutoff Filter is used to remove points from the nadir region. Select Use Inner Cutoff Angle
Filter to YES to turn the filter on. Then set the Inner Minimum Cutoff Angle to the port side of nadir,
(negative angle) and the Inner Maximum Cutoff Angle to the starboard side of nadir (positive angle).
The angles are measured in degrees.
 
For example, setting the Inner Minimum to -5.0 degrees and the Inner Maximum to +5.0 degrees as
shown above will remove all soundings within 5 degrees of nadir.

Outer Cutoff Filter

The Outer Cutoff Filter is used to remove samples from the outer beams of a dataset. Select Use
Outer Cutoff Angle Filter to YES to turn the filter on. Then set the Outer Minimum Cutoff Angle to
the furthest angle to port you will accept (negative angle) and the Outer Maximum Cutoff Angle to
the furthest angle to starboard you will accept (positive angle). The angles are measured in degrees.



Sample Density Filter

1152

Sample Density Filter
 
The default Sample Density Filter settings are set on Bathymetry Settings table and can be overridden during
the merge process on the Filter -- Settings window page of the merge wizard. You can also run the Sample
Density Filter without merging by clicking the Filter button on the Bathymetry Menu.
 
The purpose of the Sample Density Filter is to remove outlier samples that fall far from neighboring samples,
that is, areas of low sample density such as the water column or below the seabed.
 
How it Works
 
The Sample Density Filter divides the swath cross-section into bins. The filter flags all soundings in bins that
do not have the minimum number of samples in them. There are two types of bins equidistant and equiangular:
 
Equidistant bins
 
Equidistant bins are defined by horizontal and vertical bin size.
 
 

 
Equiangular Bins
 
Equiangular bins are defined by angle and range.
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Note that angles are measured negative to port and positive to starboard in degrees.
 
Sample Density Filter Settings
 

Enable Filter

Set to YES to enable the Sample Density Filter

Bin Type

Choose from Equidistant or Equiangular

Bin Dimensions
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Set the bin dimension. In Equidistant mode, the width and height refer to across-track width of the bin
and vertical height of the bin in survey units (meters or feet). In Equiangular mode, the width of the bin
is in degrees and the height is in distance from the transducer (slant range).

Required samples

In each bin, the minimum number of samples. If less than this number of samples are found in the bin,
all samples in the bin are flagged.
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Static Box Filter
 
The default Static Box Filter settings are set on Bathymetry Settings table and can be overridden during the
merge process on the Filter -- Settings window page of the merge wizard. You can also run the Static Box
Filter without merging by clicking the Filter button on the Bathymetry Menu.
 
The purpose of the Static Box Filter is to remove points that fall outside the defined box based on minimum
and maximum depth and minimum and maximum horizontal range. The static box filter is fixed and does not
change with water depth. See the Dynamic Box Filter for a similar filter that adapts to the seabed.
 
How it Works
 
The Static Box Filter optionally flags soundings that are shoal of the Minimum depth or deeper than the
Maximum depth. The filter can also flag soundings that are to the port of the Minimum Horizontal Range
or to starboard of the Maximum Horizontal Range. Horizontal Ranges are negative to port and positive to
starboard.

 

Static Box Filter Settings
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Enable Filter

Set the value to YES to enable the Static Box Filter.

Turn on limits filters

The user can select which of the 4 bounding limit filter to apply (set the filter to YES to apply, NO to
skip):
Minimum Depth - filter all soundings shoal of the minimum depth
Maximum Depth - filter all soundings deeper than the maximum depth
Minimum Horizontal Range - filter all soundings to port of the minimum horizontal range
Maximum Horizontal Range - filter all sounding to starboard of the maximum horizontal range

Set the bounding limits

The user can enter the minimum and maximum depth limits (depths are positive down) and the
minimum and maximum horizontal ranges. Negative horizontal ranges are to port of the nadir, positive
horizontal ranges are to starboard of nadir
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Dynamic Box Filter
 
The default Dynamic Box Filter settings are set on Bathymetry Settings table and can be overridden during
the merge process on the Filter -- Settings window page of the merge wizard. You can also run the Dynamic
Box Filter without merging by clicking the Filter button on the Bathymetry Menu.
 
The purpose of the Dynamic Box Filter is to remove points from each ping that are far from the seabed and are
beyond the acceptable range.
 
How it Works
 
The Dynamic Box Filter is similar to the Static Box Filter, except that box is centered on the mean depth of the
ping and the width and height of the box are defined as multiples of the mean depth. This allows the box to
change size proportionally with water depth.
 

 
Dynamic Box Filter Settings
 

Enable Filter

Set to YES to enable the Dynamic Box Filter
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Filter Dimensions

Set the horizontal water depth multiple, that is, the mean water depth x the horizontal water depth
multiple will be the width of the filter to port and starboard.
Set the vertical water depth multiple, that is, the mean water depth x the vertical water depth multiple
will be the height of the filter above and below the seabed.
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Along Track Filter
 
The default Along Track Filter settings are set on Bathymetry Settings table and can be overridden during the
merge process on the Filter -- Settings window page of the merge wizard. You can also run the Along Track
Filter without merging by clicking the Filter button on the Bathymetry Menu.
 
The purpose of the Along Track Filter is to remove points that fall outside the recent location of the seabed built
up from previous pings.
 
How it Works
 
The Along Track filter divides the ping cross-section into horizontal bins. For each bin, it calculates the mean
depth. Points which fall beyond the threshold distance from the mean depth are flagged. The bins in the along-
track filter are updated over successive pings with greater weight placed on the most recent pings.
 

 
Along Track Filter Settings
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Enable Filter

Set to YES to enable the Along Track filter

Ping History

The number of pings to store in the ping history

Vertical Threshold

The vertical threshold above or below the mean bin elevation beyond which a sample is rejected

Bin Size    

The across-track bin size
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Downsampling Filter
 
The default Downsampling Filter settings are set on Bathymetry Settings table and can be overridden during
the merge process on the Merge -- Auxiliary Data Selection window page of the merge wizard.
 
The purpose of the Downsampling Filter is to reduce the number of soundings in the dataset. It is intended for
sonars that produce excessively high-volume data. The downsampling filter bins the data and replaces the raw
samples that fall in each bin with the median value of the bin. Thus, the filter reduces the sounding density to
manageable levels while typically improving the bottom detection results.
 
How it Works
 
1.  The downsampling filter divides the ping into either equidistant or equiangular bins.
2.  Every sounding the ping is placed into the appropriate bin.
3.  Each bin returns the median elevation sample.
4.  All of the remaining samples are removed from the ping.
 
The choice of bin type is important:
 
1. Equidistant bins are evenly distributed across-track, but cannot represent vertical objects since only 1
sample is returned per bin.
2. Equiangular bins can represent vertical surfaces, but the bins are not equally distributed across the seabed.
 
Downsampling Filter Settings
 

Enable Filter?

Set the value to YES to enable the fitler

Bin Type

Choose between Equidistant or Equiangular bins

Bin Size

When the bin type is Equidistant, the bin size is the across-track width of the bins in survey units
(meters or feet)
When the bin type is Equiangular, the bin size is the angular width of the bin in degrees.
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Frequency Selection Filter
 
The default Frequency Selection Filter settings are set on Bathymetry Settings table and can be overridden
during the merge process on the Filter -- Settings window page of the merge wizard. You can also run the
Dynamic Box Filter without merging by clicking the Filter button on the Bathymetry Menu.
 
The purpose of the Frequency Selection Filter is to remove pings outside the target frequency range.
 
How it Works
 
Some multi-frequency sonar systems cycle through a series of frequency settings on each ping. If you want to
isolate data from a particular frequency range, you can use this filter to set upper and lower frequency limits
and the filter will flag the pings (hide) data collected outside of the specified range.
 
Frequency Selection Filter Settings
 

Enable Filter

Set the value to YES to enable the frequency filter

Frequency Range

Specify the Minimum and Maximum frequency window in Hz. Sounds that fall outside of this frequency
window will be flagged.
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Tide and Sound Velocity Manager
 

The Tide and Sound Velocity Manager command... opens the Tide and Sound Velocity Manager. The
purpose of the Tide and Sound Velocity Manager is to assign tide and sound velocity settings for each
bathymetry file in the project. You can manipulate individual items in the list or you can Shift+Select multiple
rows in the table at once and change all of their values simultaneously. The Auto tides and Auto sound velocity
buttons can assign tide and sound velocity profiles based on time or distance and you can override the results
if required.
 
The Tide and Sound Velocity Manager command can be opened by:
 

1. Selecting the Tide + SV Manager...   icon from the Bathymetry menu. 
2. Selecting Tide and Sound Velocity Manager... from the Bathymetry Branch context menu in the Project
Explorer.
3. Selecting Tide and Sound Velocity Manager... from the Bathymetry File context menu in the Project
Explorer.
 
The manager makes available only the tide and sound velocity profiles you have previously loaded and
enabled in the project.
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Dataset

Each bathymetric dataset loaded into the project is assigned a row in the table. All of the settings in
the columns to the right of this label apply to the named file.

Tide Selection

Use the drop down to assign a tide table to this file. The table must be previously loaded into
SonarWiz before you open the Manager. The manager will warn if the tide table does not overlap in
time with the bathymetry data.
 
If you assign a tide file to a dataset where the times do not overlap, you will see a red marker over the
name of the tide indicating that this tide file cannot be used.

Surface SV

Use the drop down to set the source of the Surface Sound velocity used to correct the takeoff angle of
beams as they leave the transducer and enter the water column. Your choices are:
 
Surface SV Selection Description
Off No takeoff angle correction will be

applied
Sensor Value Use the sound velocity recorded by

a surface sound velocity sensor to
adjust takeoff angles (best option)

Profile Use the sound velocity recorded
at the sonar depth in the assigned
sound velocity profile to adjust take
off angles

Fixed Value Use the Fixed Value speed of
sound entered in the table to adjust
take off angles.

 

Ray Trace Method

Use the drop down to set the source of sound velocity in the water column. This is used by the ray
tracer to compute the range and trajectory of the sounding through to the seabed. Your choices are:
 

Ray Trace
Method Selection

Description

Profile Trace the sound through a sound
velocity profile. This will account
for sound refraction in the water
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column as the sound propagates
through different velocity layers
(best option)

Sensor Value Assume that the sound velocity
in the water column is uniform to
the seabed and use the surface
sound velocity sensor to estimate
its value. (often a good choice in
very shallow water)

Mean Value Assume that the sound velocity
in the water column is uniform to
the seabed and use the geometric
mean of the sound velocity profile
to estimate its value.

Fixed Value Assume that the sound velocity in
the water column is uniform to the
seabed and use the Fixed Value
entered by the user to estimate its
value.

Fixed Value

READ ONLY field that shows the fixed sound velocity profile setting assigned to this line. Use the
Fixed Sound Velocity entry to the right to change this value.

Use SV Profile

Use the drop down to set the Sound Velocity Profile (SVP) to assign to this data set. Only previously
loaded and enabled SVPs will be listed to choose from. You can use the Auto SV... button to quickly
assign SVPs to a large data set.
 
Note that if you assign a sound velocity profile to a dataset but it is not the nearest in time or the
nearest in distance, the SVP name will be highlighted in Yellow to indicate that a potentially better
profile is available.

OK

Accept the changes and apply them to the datasets. Note that if you make changes to a file here.

Cancel

Close the Tide and Sound Velocity Manager without making changes.
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Select All

Select All the displayed files in the project. When multiple files are selected, the changes you make to
one of the selected files will be applied to all of them.

Report...

Generate an HTML report that shows the results of the tide and sound velocity selections. The report
will highlight bad tide (red) and sound velocity profiles that do not meet the nearest in time or nearest
in distance criteria (yellow).

Automatic Selection

The Manager can quickly assign tide and sound velocity profiles based on the start time of the dataset
or the starting location of the dataset.
 
To automatically assign the sound velocity profiles closest in time to each dataset:
 
1. Click the Nearest Time radio button
2. Click Auto SV....
 
To assign the nearest tide station to each dataset:
 
1. Select the Nearest Distance radio button
2. Select Auto Tides.

Fixed Sound Velocity

To change the Fixed sound velocity:
 
1. Highlight the datasets you want to change
2. Enter the new Fixed Sound velocity in the Fixed Sound Velocity text entry
3. Click Apply
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Show Files Options

Select Show All to show all sonar files including those that are disabled in the Project Explorer. Select
Show Enabled to only display files that are enabled in the Project Explorer

Real-time Settings

Set the Tide, Surface SV, Ray Trace Method, Fixed Velocity and SV Profile for use in real-time data
acquisition mode here. The settings are described above.
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Merge
 
The Merge Command opens the Merge wizard where the user can specify how to process raw bathymetry
soundings into final processed elevations. The Merge wizard can be opened by:
 

1. Selecting the Merge...   icon from the Bathymetry menu. 
2. Selecting Merge... from the Bathymetry Branch context menu in the Project Explorer.
3. Selecting Merge... from the Bathymetry File context menu in the Project Explorer.
 
The merge wizard consists of four steps:
 
1. Select the datasets for merging
2. Review and modify the merge settings
3. Select an error model for estimating sounding uncertainty
4. Review and modify the filter settings.
 
The following sections describe each step in detail.
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Merge - File Selection window
 

The first step in the Merge Wizard is to select the dataset that the merge operation will affect.
 

Check All

Toggle the Check All check box to select all the bathymetry datasets in the project

File Selection List

Select individual datasets in the File Selection List.

Back button

The Back button allows you to return to the previous step in the Merge wizard

Next button

The Next button advances to the Merge -- Auxiliary Data Selection window
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Finish button

Press the Finish button at any time to execute the Merge process with the current settings.

Cancel button

Close the Merge wizard without executing the Merge process.
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Merge - Auxiliary Data Selection window
 

The second step in the Merge Wizard is to review the Merge Settings and make any necessary adjustments.
The Merge Settings control how Position, Attitude and Height will be computed.
 
On the first merge, the Merge Settings will be set to match the project default values found in
. On subsequent merges this dialog will show the settings that were applied previously.
 
 
 

Merge Properties
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The Merge Properties section is presented for review. Initially, it shows the settings that were applied
on the previous merge. You can change any of the settings necessary directly in this dialog and they
will be applied to all of the selected files during the merge operation. For more information on the
Position, Attitude and Height Computation values, see Merge Settings.
 
The Downsampling Filter is listed in the Merge settings because this filter will remove data from further
processing. It is an optimization needed only for sonar systems that produce thousands of samples
per ping.

Back button

Return to the Merge -- File Selection window

Next button

Accept the current settings and advance to the Merge -- Error Model Data window

Finish button

Accept the current settings and begin the Merge process.

Cancel button

Exit the Merge Wizard without executing the Merge process.



Merge - Error Model Data window

1173

Merge - Error Model Data window
 

The third step in the Merge Wizard is to review the Error Model and make any necessary adjustments.
The Error Model determines how SonarWiz will compute the positional uncertainty of each sounding. The
positional uncertainty is used during C.U.B.E. gridding to help automatically clean bathymetric data.
 
 

 

Error Model Selection

Select the error model from the drop down. SonarWiz supports four Error Model options:
 

Error Model Description
No Error Model Positional uncertainty is set to zero for

all samples
Sonar Provided
Model

Positional uncertainty recorded in the
raw sonar files is used
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Simple IHO Model Approximate positional uncertainty
based on the IHO order of the survey
(See Simple IHO Error Model)

Full Error Model Comprehensive error model (See Full
Error Model )

Back button

Return to the Merge -- Auxiliary Data Selection window

Next button

Advance to the Filter -- Settings window

Finish button

Accept the Merge Wizard settings and begin the merge process.

Cancel button

Exit the Merge Wizard without performing the merge operation.
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Simple IHO Error Model
 

The Simple IHO Error model is selected from the Merge -- Error Model Data window page of the Merge
Wizard. The Simple IHO Error model estimates the uncertainty of each sounding based on the maximum
allowable Total Vertical Uncertainty (TVU) specified in Table 1 of the IHO S-44 (4th Edition).
 
Total Vertical Uncertainty
 
According the IHO S-44 (Section 3.2 Vertical Uncertainty):
 
Recognizing that there are both depth independent and depth dependent errors that affect the
uncertainty of the depths, the formula below is to be used to compute, at the 95% confidence
level, the maximum allowable TVU. The parameters “a” and “b” for each order, as given in
Table 1, together with the depth “d” have to be introduced into the formula in order to
calculate the maximum allowable TVU for a specific depth:
 

 
Where:

a represents that portion of the uncertainty that does not vary with depth
b is a coefficient which represents that portion of the uncertainty that varies with depth
d is the depth
b x d represents that portion of the uncertainty that varies with depth
 

The relevant portion of Table 1 is reproduced below:
 

 Special 1A 1B 2

Description Areas where under-keel
clearance is critical

Areas shallower than
100
metres where under-
keel clearance is less
critical but features
of concern to surface
shipping may exist.

Areas shallower
than 100 metres
where under-keel
clearance is not
considered to be
an issue for the
type of surface
shipping expected
to transit the area.

Areas generally
deeper than 100
metres where a
general description
of the sea floor
is considered
adequate.

Maximum
allowable TVU
95% Confidence
level

a = 0.25 metre
b = 0.0075

a = 0.5 metre
b = 0.013

a = 0.5 metre
b = 0.013
 

a = 1.0 metre
b = 0.023

 
Simple IHO Error Model Options
 
The only user-defined selection is to pick the IHO Order of the survey. SonarWiz will then look up the values of
the TVU coefficients from Table 1 based on the IHO Order and the apply them, along with the sounding depth,
to determine the TVU of the sounding.
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Select IHO Order

The Simple IHO Order Error Model has only a single option. Select the IHO Order of the survey. This
determines the coefficients used in the TVU computation as shown in Table 1.
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Full Error Model
 

The Full Error model is selected from the Merge -- Error Model Data window page of the Merge Wizard. The
Full Error model is an implementation of the Hare-Godin-Mayer MBES Model described in the CUBE User
Manual Section B.2.1 (Calder, B. and Wells, D., 2007).
 
The Hare-Godin-Mayer MBES Error Model
 
A complete description of the The Hare-Godin-Mayer model (HGM) parameters is beyond the scope of this
document (see the CUBE User Manual Section B). The model is split into two parts: one which deals with
uncertainties that are specific to the sonar sensor (the device model) and one that deals with integration of
all of the components of the survey system (the system model). SonarWiz will supply the appropriate device
model based on the sonar system installed in the vessel definition file. The User must supply the parameters
needed to compute the system model.
 
Due to the detailed nature of the model, there are many parameters that are required to drive the computation.
Most, however, represent the uncertainties of fundamental measurements, which make them simpler to
estimate. This applies to measurement uncertainties for the GPS
device, the Inertial Motion Sensor unit (IMU) instantaneous angular measurements of roll, pitch and yaw, and
of heave, and uncertainty of offset measurements for positioning of the components of the survey system with
respect to the body frame of the survey platform. Typically, these can be estimated either from manufacturer’s
specifications, or from normal
survey methodologies.
 
Full Error Model Settings
 
There are a large number of parameters that need to be filled in by the user to set up the Full Error Model.
In the tables below, each parameter occupies a row in the table. The name of the parameter is in the left-
most column and a short description of the parameter is in the right-most column. The user should supply the
numeric values as accurately as possible.
 
SonarWiz has divided the model parameters into two groups: Those dealing with the sensor offsets and those
dealing with the sensor measurement uncertainties.
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Offsets Parameters

The Offsets Parameters tell the model the true lever arm between the GPS, IMU (Motion Sensor) and
the Transducers. Single-channel systems should use the Port Channel column, dual channel systems
should use the port and starboard columns as appropriate.
 
Note that these offsets are the real-world lever arms and are not necessarily the same as the offsets
entered into the vessel editor which is typically configured to the virtual position of the navigation and
motion sensors.

Measurement Uncertainty

The Measurement Uncertainty group of parameters asks for the uncertainty in the lever arms entered
above in units of 1 standard deviation (SDev). It will also ask for the standard deviation in all of the
sensor output measurements such as the uncertainty in GPS position, speed of sound sensor, etc.
Refer to the diagnostic output of your equipment to make these estimates or contact the sensor
manufacturer.
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Filter - Settings window
 

The fourth and final step in the Merge Wizard is to review the Filter Settings and make any necessary
adjustments. The Filter Settings configure the filters that are to be automatically run after the merge process
completes.
 
On the first merge, the Filter Settings will be set to match the project default values found in Bathymetry
Settings. On subsequent merges this dialog will show the settings that were applied previously.
 
By default, the Reset Filter Flags filter is set so that any manual edits you have made since the last merge will
remain flagged, if you want to clear all flagging, including manual edits, to start from a clean slate, you should
reset all of the filter flags (or re-import the dataset from the raw data).

 

Filter Settings Table
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The Filter Settings table allows the user to review the settings that were last used on this dataset. If
this is the first merge, the Filter Settings are copied into the dialog from the project defaults found in
the Bathymetry Settings table.

Back button

Return the Merge -- Error Model Data window

Next button

Disabled, this is the last page of the wizard.

Finish button

Accept the current settings and execute the Merge process.

Cancel button

Close the Merge Wizard without executing the Merge process.
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Filter
 
The Filter Command opens the Filter wizard. The Filter wizard will guide the user through the steps of
applying filters to previously processed bathymetric data. The Filter command can be opened by:
 

1. Selecting the Filter...   icon from the Bathymetry menu. 
2. Selecting Filter... from the Bathymetry Branch context menu in the Project Explorer.
3. Selecting Filter... from the Bathymetry File context menu in the Project Explorer.
 
The filter wizard consists of two steps:
 
1. Select the datasets for merging
2. Review and modify the filter settings
 
The following sections describe each step in detail.
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Filter - File Selection window
 

The first step in the Filter Wizard is to select the dataset that the filter operation will affect.
 

Check All box

Toggle the Check All check box to select all the bathymetry datasets in the project.

File Selection List

Select individual datasets in the File Selection List.

Back button

Disabled (this is the first page of the wizard).

Next button

Advance to the Filter -- Settings window
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Finish button

Accept the current settings and execute the filter process.

Cancel button

Close the Filte wizard without executing the filter operation.
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Filter - Settings window
 

The second step in the Filter Wizard is to review the Filter Settings and make any necessary adjustments. The
Filter Settings control which automatic filters will be executed and various properties of the filters themselves.
 
On the first merge, the Filter Settings will be set to match the project default values found in Bathymetry
Settings. On subsequent merges this dialog will show the settings that were applied previously.
 
By default, the Reset Filter Flags filter is set so that any manual edits you have made since the last merge will
remain flagged, if you want to clear all flagging, including manual edits, to start from a clean slate, you should
reset all of the filter flags (or re-import the dataset from the raw data).

 

Filter Settings Table
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The Filter Settings table allows the user to review the settings that were last used on this dataset. If
this is the first merge, the Filter Settings are copied into the dialog from the project defaults found in
the Bathymetry Settings table.

Back button

Return to the Filter -- File Selection window

Next button

Disabled, this is the last page of the filter.

Finish button

Accept the current filter settings and execute the filter operation.

Cancel button

Close the Filter Wizard without executing the filter operation.
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Process Backscatter
 
The Process Backscatter command opens the Backscatter Processing wizard. The Backscatter Processing
wizard will guide the user through the steps of processing backscatter in bathymetry files. The Process
Backscatter command can be opened by:
 

1. Selecting the Process Backscatter...   icon from the Bathymetry menu. 
2. Selecting Process Backscatter... from the Bathymetry Branch context menu in the Project Explorer.
3. Selecting Process Backscatter... from the Bathymetry File context menu in the Project Explorer.
 
The Backscatter Processing Wizard consists of two steps:
 
1. Select the datasets for processing
2. Set the processing options
 
The following sections describe each step in detail.
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Backscatter Processing -- File Selection window
 

The first step in the Backscatter Processing Wizard is to select the dataset that the operation will affect.
 

Check All

Toggle the Check All check box to select all the bathymetry datasets in the project.

File Selection List

Select individual datasets in the File Selection List.

Back button

Disabled (this is the first page of the wizard).

Next button

Advance to the Backscatter -- Settings window
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Finish button

Accept the current settings and execute the Backscatter Processing operation.

Cancel button

Exit the Backscatter Processing Wizard without executing the Backscatter Processing operation.
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Backscatter -- Settings window
 

The second step in the Backscatter Processing Wizard is to configure the processing options.
 
 

 

EGN Processing

EGN is the primary backscatter normalization algorithm for bathymetry datasets. Set the value to YES
to enable Empirical Gain Normalization (EGN)

Nadir Filter

The Nadir Filter helps reduce noise in the nadir area of the swath by adjusting the amplitude of
the nadir samples so that they more closely match the rest of the swale. Set the value to YES to
enable the nadir filter and then set the edge angle, in degrees that the nadir filter should work on. The
strength of the filter tapers gradually at the edges so that the transition zone is usually very subtle.
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Automatic Gain Compensation

Automatic Gain Compensation is a strong filter that can remove local gain differences between
pings improving target detection. However, it will remove regional amplitude variations and should not
be used for seabed characterization studies. Set the filter to YES to enable AGC, then set the across-
track window size as a percentage of the full swale width (0 to 100 percent) and the target amplitude.

Destripe Filter

The Destripe Filter is a band-pass type filter that will attempt to preserve the regional variations
in amplitude while filtering out strips caused by excessive pitch or roll during the survey. Set the
enable destripe filter value to YES to enable the filter and then set the number of pings to average for
smoothing.

Static Gain Offset

Apply a gain offset to the resulting data to brighten or darken the swaths.

Back button

Return to the Backscatter Processing -- File Selection window

Next button

Disabled, this is the last page in the Backscatter Wizard.

Finish button

Execute the Backscatter Processing operation with the current settings.
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Cancel button

Exit the Backscatter Processing wizard without starting the Backscatter Processing operation.
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Export Bathymetry Raw Sonar Values
 

The Export Raw Sonar values command is a trouble-shooting tool that allows the user (and SonarWiz
support) to visualize the raw beam data being imported into SonarWiz. This information is not normally visible
by opening the Navigation and Attitude Editor.
 
The Export Bathymetry Raw Sonar Values command is opened by:
 
1. Selecting the Export Raw Bathy Values... command from the Bathymetry Branch context menu in the
Project Explorer.
2. Selecting Export Raw Bathy Values... from the Bathymetry File context menu in the Project Explorer.

 

Write Raw Sample Values

Toggle to include raw beam data with the ping headers.

Limit the number of pings

Toggle to limit the output to a set number of pings.

Export Options

Select the type of data records to export.

Output Folder

Select the output folder for the exported data.
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Properties (Bathymetry Projects)
 

The Bathymetry Project Properties Command opens a report window which indicates the X,Y,Z limits of all
enabled bathymetry files in the project. The Bathymetry Project Properties window is opened by:
 
1. Selecting Properties... from the Bathymetry Branch context menu in the Project Explorer.

 

Limits Section

The Limits Section lists the overall x (east - west), y (north-south) and z (depth) limits of the enabled
files in the project.

Bathy Datasets Section

The Bathy Datasets Section lists the x (east - west), y (north-south), and z (depth) limits of individual
files. Only enabled files are shown.
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Monitoring Bathymetry in Waterfall
 

The Monitor Bathymetry in Waterfall command opens the Sidescan Analysis Window in real-time mode for
bathymetry. In this mode, bathymetry data is displayed as it is received, ping-by-ping. The Monitor Bathymetry
in Waterfall command requires an acquisition license to be active. To open the analysis window in real-time
bathymetry mode:
 
1. Select the Monitor Bathymetry in Waterfall command from the Bathymetry Branch context menu in the
Project Explorer.
 
See Sidescan Analysis Window for more information.
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Monitoring Backscatter in Waterfall
 

The Monitor Backscatter in Waterfall command opens the Sidescan Analysis Window in real-time mode
for backscatter. In this mode, backscatter data is displayed as it is received, ping-by-ping. The Monitor
Backscatter in Waterfall command requires an acquisition license to be active. To open the analysis window in
real-time backscatter mode:
 
1. Select the Monitor Backscatter in Waterfall command from the Bathymetry Branch context menu in the
Project Explorer.
 
See Sidescan Analysis Window for more information.
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Navigation and Attitude Editor
 
The Navigation and Attitude Editor command opens the Chesapeake Bathymetry Navigation and Attitude
Editor. The Navigation and Attitude Editor allows the user to view, edit and filter navigation and attitude data
stored in bathymetry datasets. The Navigation and Attitude Editor can be opened by:
 

1. Clicking the Bathymetry | Navigation & Attitude Editor icon  from the Bathymetry Menu.
2. Selecting the Navigation and Attitude Editor... command from the Bathymetry File context menu.
 

Quick Access Toolbar

The Quick Access Toolbar is the “starting point” for most commands that a user would traditionally
find under the “File” menu of predominant Windows-based applications. Clicking on the icon opens the
Quick Access Toolbar to reveal the (enabled) main functions available.
 
The following table shows the default Quick Access Toolbar Command icons and links to the
appropriate section of the manual for more information.

Command Description
Open Bathymetry
Database

Opens Windows Explorer and is used to open bathymetry
sqlite database files (.CDF)

Open Overlay Opens Windows Explorer and is used to open Vector Map
files (.SHP, .DXF, .KML)

Reset Window Layout Resets the windows to their default locations
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About... Shows version number and build date.
Settings... Opens Application settings.

Settings

The Graphic Settings button opens the Quality & Performance Settings menu and is used to adjust
antialiasing values and options for the program.
 
The Application Settings menu contains options for changing the coloring and draw scheme for the
various graphs and sections in the editor as well as how mouse controls function and what UDP port
to transfer status messages to SonarWiz.
 
The Graph Selection window is used to change the navigation values displayed in the graph views.

Use the  buttons to move values options back and forth. The Add Tide Files section is used to
add imported tide files to the list to be displayed in the editors graph views.
 
Use the selection options (rectangle, polygonal, or lasso) to adjust how to draw sections of data in the
plan view.
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Tabular View

Table view of the following columns for the currently loaded bathymetry points. Use the arrow buttons

(  and ) to cycle through the pages of points. The drop down menu allows the user to
choose between displaying data based on the position, pressure, attitude, or raw data of the currently
select file.

Dataset List

The Dataset List is used to toggle navigation files loaded into the editor and contains a details list with
the dataset dimensions, depth range, and position/ altitude count.
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Path Editor

The Enter New Navigation Path button will change your cursor into a + and is used to select points in
the plan view to set a new path for the navigation data. Press ESC to clear path points. Press ENTER
to apply changes.

Editing Options

The Accept and Reject buttons are used to flag selected points in the editor to either be kept or
removed.
 
The Interpolate function uses the currently selected section of data and interpolates between the two
ends creating a straight spline.
The Low-pass Filter is used to run an average or median filter on any of the navigation or altitude

values stored in the currently loaded dataset. Use the  buttons to move files over from
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available lines to ones selected to be filtered and then choose the filter, value, and smoothing kernel.

Selecting  will run the filter.

The Undo and Redo buttons are used to cycle back and forth through previous edits.
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Plan View

Displays current navigation file in a plan view. The yellow indicator box will follow the current section
displayed in the graph view.

Graph View

Various graph views can be displayed for the curently loaded navigation data. Use the Graph
Selection menu to change the displayed graphs values.
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Swath Editor
 
The Swath Editor command opens the Chesapeake Swath Bathymetry Editor. The CTI Swath Editor allows
the user to step a view window down through a dataset where the soundings can be edited in various 2D and
3D windows. The Swath Editor can be opened by:
 

1. Clicking the Bathymetry | Swath Editor icon  from the Bathymetry Menu.
2. Selecting the Swath Editor... command from the Bathymetry File context menu.
 

Quick Access Toolbar

The Quick Access Toolbar is the “starting point” for most commands that a user would traditionally
find under the “File” menu of predominant Windows-based applications. Clicking on the icon opens the
Quick Access Toolbar to reveal the (enabled) main functions available.
 
The following table shows the default Quick Access Toolbar Command icons and links to the
appropriate section of the manual for more information.

Command Description
Open Bathymetry
Database

Opens Windows Explorer and is used to open bathymetry
sqlite database files (.CDF)

Open Colormap Opens Windows Explorer and is used to open
GlobalMapper color map files (.CLR)

Reset Window Layout Resets the windows to their default locations
About... Shows version number and build date.
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Settings... Opens Application settings.

Color Maps

Used to select the color map preset for the currently loaded bathymetry points. Will display current
elevation scale based on color map choosen.

Subset Manager

Drop down menus used to adjust settings of the bathymetry points.
 
The General drop down menu is used to toggle the following settings for the bathymetry points.

Settings Description
Show rejected samples Toggle displaying rejected points in the

2D and 3D view.
Replicate pings in top view Toggle displaying pings in top view

Replicate pings in side view Toggle displaying pings in side view

Show bathy points Toggle displaying bathy points
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Show ping lines Toggle displaying ping lines

Point Size Used to adjust the point size in the 2D
and 3D view.

Sweep length Length in pings that are displayed in all
of the viewers in the editor

Vertical scale (cross-track
view)

Adjust the vertical depth scale in the
cross track and side view

 
The Subset Details drop down menu lists the current dimensions of the area being edited as well as
the range of depths, total sample count, and a percentage look at filterd points in the area.
 
The Colors drop down menu is used to adjust the attribute the data set is colored with (options include
ping, survey line, amplitude, and elevation) as well as adjust the type, scale, and color map.

Subset Editors

The Subset Editors section is used to toggle the various windows in the editor as well as choose the
cursor drawing option for editing points in the point subset views.

Real-Time Acquisiton

The Real-Time Acqusition menu is used to listen to the currently recording bathymetry p[oints
coming into the project and display them in the Swath Editor. Selecting Exit will stop the real-time
display.

Filter Status Change

The Accept and Reject buttons are used to flag selected points in the editor to either be kept or
removed.
 
The Min/Max Filter is used to flag points inside or outside of a selected depth or amplitude range.
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The Density Filter is used to create bin sections in the whole profile of your points and flagging all the
points in a specific section that doesnt contain a minimum number of points. This filter works well in
removing outliers and fliers.
 

The Polyline Filter is used to select all of the points below or above the drawn polyline.
 

The Polygon Filter is used to select all of the points inside or outside the drawn polygon.
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The Undo and Redo buttons are used to cycle back and forth through previous edits.
 
Auto Mode allows all selected points to be automatically rejected or accepted without the need of the
Accept and Reject buttons. Use Auto Mode Off to turn of this function.

Application Settings

The Application Settings contain all of the settings for the Swath Editor.
 
The General section contains various settings to adjust the background and label color, to toggle on cursor
tracking between the swath editor and SonarWiz, the maximum number of points, and the UDP port to
configure status messages.

 
The Miscellanous tab in the Application Settings window is used to adjust colormap scaling and settings in
the swath editor.
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The Advanced Subset Editors tab in the Application Settings window contains various checkboxes for
general settings.

Graphics Settings

The Graphic Settings button opens the Quality & Performance Settings menu and is used to adjust
antialiasing values and options for the program.
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3D View

Displays current point subset in 3D view. Use the settings dialog to adjust displayed points and axes.

Cross-Track View

Displays current point subset in cross-track view. Use the settings dialog to adjust displayed points
and axes.
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Top-Down View

Displays current point subset in top-down view. Use the settings dialog to adjust displayed points and
axes.

Side View

Displays current point subset in side view. Use the settings dialog to adjust displayed points and axes.
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Digitize New Bathymetric Features
 

The Digitize New Bathymetric Features command opens the Sidescan Analysis Window in bathymetry
mode. In this mode, the window is used to add, edit and delete Contacts and Features based on the elevation
data of a bathymetric data set. Some options in the Sidescan Analysis Window will be disabled in bathymetry
mode that do not pertain to bathymetry data (bottom tracking, slant range correction, etc.)
 
The bathymetry mode of the analysis window can be opened by:
 

1. Selecting the Digitizing View... icon  from the Post Processing menu when bathymetry data is
selected.
2. Select the Digitize New Bathymetric Features... command from the Bathymetry Branch context menu in
the Project Explorer.

 
See Sidescan Analysis Window for more information.
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Digitize New Backscatter Features
 

The Digitize New Backscatter Features command opens the Sidescan Analysis Window in backscatter
mode. In this mode, the window is used to add, edit and delete Contacts and Features based on the intensity
data of a bathymetric data set. Some options in the Sidescan Analysis Window will be disabled in backscatter
mode that do not pertain to backscatter data (bottom tracking, slant range correction, etc.)
 
The backscatter mode of the analysis window can be opened by:
 

1. Selecting the Digitizing View... icon  from the Post Processing menu when bathymetry data is
selected.
2. Select the Digitize New Backscatter Features... command from the Bathymetry Branch context menu in
the Project Explorer.

 
See Sidescan Analysis Window for more information.
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Bathymetry File Processing Status Report
 

The Status... command opens the Bathymetry Processing Status Report window. The Processing Status
Report window indicates the success or failure of a merge process to convert raw sonar soundings into
bathymetric elevation. In the event that a data set cannot be merged, the Bathymetry Processing Status
Report window can indicate if the auxiliary data is being read properly and that the timing of the packets
overlap.
 
To open the Bathymetry FIle Processing Status window:
 
1. Select Status... from the Bathymetry File Context menu in the Project Explorer.

 

Data Set Name

This line indicates which data set the report is for.

Processing Status Report

The status report indicates a successful merge. If the data set is out of date or not able to merge,
a message will indicate what failure was detected. Warning conditions will turn the report yellow,
this usually results from updating the vessel offsets after a patch test. Critical conditions will turn the
status display red. This is usually a result of one of the required packet types not being present in the
imported data. If a data set is not able to merge due to a critical condition, read the status message
and review the individual records reports that follow to make sure that the required number of packets
were detected and that the times of all of the packets overlap.
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Raw Sonar Records

The raw sonar records line indicates how many sonar packets were received and the time stamp of
the first and last sonar record in the series.

Raw Position Records

The raw position packets line indicates how many position packets were received and the time stamp
of the first and last position packet in the series. It is critical that the position packets overlap with the
Raw Sonar records in time for a successful merge.

Raw Attitude Records

The raw attitude packets line indicates how many attitude packets were received and the time stamp
of the first and last attitude packet in the series. It is critical that the attitude packets overlap with the
Raw Sonar records in time for a successful merge.

Raw Pressure Records

The raw pressure packets line indicates how many pressure packets were received and the time
stamp of the first and last pressure packet in the series. If sonar data is being merged using pressure
sensor values, it is critical that the pressure packets overlap with the Raw Sonar records in time for a
successful merge.
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Bathymetry File Properties Report
 
The Properties... command opens the Bathymetry Properties Report window. The Properties Report window
provides a detailed report on all of status and settings currently applied to a merged bathymetry file.
 
To open the Bathymetry FIle Properties Report window:
 
1. Select Properties... from the Bathymetry File Context menu in the Project Explorer.
 

 
A detailed description of the Properties Report follows:
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Bathymetry Data set

Lists the bathymetry data set for which the report was run.

Data Packet Section

The Data Packet Section is similar to the Status Report. For each of the required record types (Sonar,
Position, Attitude, and Pressure) this section lists the first record observed, the last record observed,
the duration of the records, the sample rate (how often the particular record type was observed) and in
the Details section, a range of values observed.

Sounding Statistics Section

The Sounding Statistics section of the report describes statistics about the actual soundings that were
processed. These values may differ from the Sonar Records section due to time stamp overlap issues
and merge settings.

Vessel and Sensor Configuration

The vessel and Sensor Configuration section lists the current vessel name and all of the configured
sensors on that vessel along with the offsets that were used. The offsets are always listed in the
following order: X, Y, Z, roll, pitch, heading (just like in the Vessel Editor)
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Merge Settings Section

The Merge Settings Section indicates which merge settings were used to compute the soundings in
this data set.
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View Point Cloud in 3D Viewer
 

The View Point Cloud in 3D Viewer... command will export the selected bathymetry data set as a point cloud
into the External 3D Viewer.
 
To view a bathymetry data set in the 3D Viewer:
 
1. Select View Point Cloud in 3D Viewer from the Bathymetry File context menu in the Project Explorer.
 

 
Note that the Chesapeake 3D Viewer Application is a stand-alone application and it may take a few moments
to transfer the data.
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Patch Test Calibration Tool
 

The “Patch” test is a field calibration procedure designed to identify and correct for constant orientation and
timing biases between the sonar system and the integrated motion sensor as installed on the survey vessel.
The tool can be used to calibrate pitch, heading, roll, and time. See the CTI Patch Test User Guide stored in
the Docs folder of every SonarWiz 7 installation for more information.
 
 
To open the CTI Patch Test Calibration tool:
 
1. Enable the bathymetry dataset you will use for the calibration
2. Choose the calibration value from the drop down menu.
3. Use the mouse to draw a profile over the bathymetry dataset you want to use for the patch test.

 

Calibration Items

The Calibration Items section shows the current data type, vessel, system, and calibration value
for the currently opened data set. Use the channel selection to swap between the port and starboard
values of the profile.

Settings...

The Patch Test Settings window contains settings to adjust the colors of the profiles and window,
the style and size of the data in the cross section view, the viewer scaling, and the min/max pings and
samples for processing.
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Calibration Controls

The Calibration Settings panel controls how the values will change in the selected calibration
procedure.
 
To perform a manual calibration:
1. Set the mini mum value to test
2. Set the maximum value to test.
3. Set the calibration step size.
4. Use the blue slider to test values between the minimum and maximum value.

 
During manual calibration, the New box will indicate the current value being tested, the cross-section
view will update to show how the selected value changes the overlapping profiles.
 
To perform an automatic calibration:
1. Set the minimum value to test
2. Set the maximum value to test.
3. Set the calibration step size.
4. Click the Recalculate button in the toolbar. The best value among those tested is displayed in the
New text box.
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Test Results Graph

During automatic calibration, SonarWiz will test each value from the minimum to the maximum using
the step size. When the calibration is finished, SonarWiz will display a V-graph in the Test and
Results panel. The V-graph shows the difference beween overlapping profile lines resulting from test
values. The best value is when the difference between the profiles is minimized, that is, the point of
the V-graph. SonarWiz will automatically select this value and display it in the New value text box.

Calibration Values

The Calibration Values table shows the current Roll, Pitch, Heading and Latency values stored in the
vessel configuration file for each channel of the sensor being calibrated. The New column shows the
results of the calibration tests you have performed. The Save toggle will include the selected value
when updating the vessel.

Survey Lines Panel

The Select Survey Lines panel allows for toggling the display of data sets in the cross-section.
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Cross Section View

The Cross Section View displays the raw bathymetry and profile lines for each of the datasets in
the profile. The profile colors correspond to the data set colors in the Settings menu. The profiles are
linked to the calibration values shown in the calibration pane and are updated dynamically as the
calibration values are changed.

Output Message Log

The Output Message log displays status messages from the calibration actions in the Patch Test
Calibration tool.
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Area Editor
 
The Chesapeake 2D/3D Editor can be opened by selecting Bathymetry | Area Editor from the Bathymetry
Menu. The Area Editor allows the user to draw a polygon over the map and open all of the bathymetry
datasets in that view for editing at once.
 

Quick Access Toolbar

The Quick Access Toolbar is the “starting point” for most commands that a user would traditionally
find under the “File” menu of predominant Windows-based applications. Clicking on the icon opens the
Quick Access Toolbar to reveal the (enabled) main functions available.
 
The following table shows the default Quick Access Toolbar Command icons and links to the
appropriate section of the manual for more information.

Command Description
Open Colormap Opens Windows Explorer and is used to open

GlobalMapper color map files (.CLR)
Reset Window Layout Resets the windows to their default locations

About... Shows version number and build date
Settings... Opens Application settings.
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Colormaps

Used to select the color map preset for the currently loaded bathymetry points. Will display current
elevation scale based on color map choosen.

Bathy Sample List

Table view of the following columns for the currently loaded bathymetry points. Use the arrow buttons

(  and ) to cycle through the pages of points.
Column Description

X Easting
Y Northing
Z Depth
Amplitude Amplitude
Quality Not currently used in customer facing operations
FilterStatus Not currently used in customer facing operations
Dataset ID Not currently used in customer facing operations
Ping ID Not currently used in customer facing operations
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Sample ID Not currently used in customer facing operations

Subset Manager

Drop down menus used to adjust settings of the bathymetry points.
 
The General drop down menu is used to toggle the following settings for the bathymetry points.

Settings Description
Show rejected samples Toggle displaying rejected points in the 2D

and 3D view.
Reload plan view after edit Toggle automatically reloading the plan

view in SonarWiz after editing points.
Show coordinate axes Toggle N and E compass axes in the

display views.
Show bounding box Toggle bounding box in the display views.
Show rotation indicators Toggle rotation degree indicators on the

coordinate axes.
Point Size Used to adjust the point size in the 2D

and 3D view.
File checkboxes Toggle bathymetry datasets that were

present in the area being edited.
Show/ Hide commands Used to quickly turn on or off data sets.
 
The Subset Details drop down menu lists the current dimensions of the area being edited as well as
the range of depths, total sample count, and a percentage look at filterd points in the area.
 
The Colors drop down menu is used to adjust the attribute the data set is colored with (options include
ping, survey line, amplitude, and elevation) as well as adjust the type, scale, and color map.

Subset Editors

The Subset Editors section is used to toggle the various windows in the editor as well as choose the
cursor drawing option for editing points in the point subset views as well as the graph axes for the 2D
editor.

Edit Grid

The Edit Grid tool opens the Grid Editing tab and is used to select, edit, and reject areas in the grid
view of the currently loaded dataset.
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Use the selection  options to change how your cursor draws sections in the grid view, hold
the SHIFT key and draw to select areas. Once a section has been selected it by default will highlight it
in RED.
 

The  button will flag all of the currently selected section in the grid view to be removed. The

 button opens the Interpolate Blank Cells menu and is used to fill holes in the grid by

selecting an area, radius, and the min number of cells needed to interpolate. The  button opens
the Spike Removal menu and is used to flag outliers and spikes in the grid. Use the settings to adjust
the kernel size, median value, and flagging action.
 
Once the grid has been edited, use the Update and Save buttons to accept the changes and update
the grid file.

Filter Status Change

The Accept and Reject buttons are used to flag selected points in the editor to either be kept or
removed.
 
The Min/Max Filter is used to flag points inside or outside of a selected depth or amplitude range.
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The Density Filter is used to create bin sections in the whole profile of your points and flagging all the
points in a specific section that doesnt contain a minimum number of points. This filter works well in
removing outliers and fliers.
 

The Median Filter is used to compute a median Z value based on a specific sections and then will flag
all points that are out of X% of the Z range. Set either the percentage or meter value of tolerance in
the filter menu.
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The Grid Surface Filter is another median filter but uses a computed grid surface as the median. Set
either the percentage or meter value of tolerance in the filter menu.
 

The Undo and Redo buttons are used to cycle back and forth through previous edits.
 
Auto Mode allows all selected points to be automatically rejected or accepted without the need of the
Accept and Reject buttons. Use Auto Mode Off to turn of this function.

Settings Menu

The Graphic Settings button opens the Quality & Performance Settings menu and is used to adjust
antialiasing values and options for the program.
 
The Application Settings contain all of the settings for the Swath Editor.
 
The General section contains various settings to adjust the background and label color, to toggle on
cursor tracking between the swath editor and SonarWiz, options for the 3D view, and the UDP port to
configure status messages.
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The Advanced Subset Editors tab in the Application Settings window contains various checkboxes for
general settings.

Subset Selection

Used to select individual subset sections or cross section profiles from the current profile.



Area Editor

1231

Grid View

Displays current point subset in a grid. Use the vertical exagertation and settings dialog to adjust
displayed points and axes.

3D View

Displays current point subset in 3D. Use the vertical exagertation and settings dialog to adjust
displayed points and axes.
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2D View

Displays current point subset in 2D. Use the vertical exagertation and settings dialog to adjust
displayed points and axes.
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Tide Editor
 
The CTI Tide Editor can be opened by selecting Bathymetry | Tide Editor from the Bathymetry Menu. The
Tide editor is used to import tide records into SonarWiz format. It has a nice template system reading a custom
tide records from almost any tabular text file.
 

Drop Down Menus

The File drop-down menu offers options for tide files including import, new, save, and exit.
 
The Edit drop-down menu offers options for duplicating a row of data in the table.
 
The Tools drop-down menu offers an interpolation tool as well as a window to adjust settings. The
Interoplate Values tool generates a complete (linearly interpolated) tide table
at a specified depth interval using only data that has been entered to the Data List.

The Settings window allows the user to change the geographic coordinates format used in the station
information window as well as the UDP port which the Tide Editor and SonarWiz will send status
messages.
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Tide Editor Toolbar

Setting: Button: Description:

New Creates a new tide file

Open Opens Windows Explorer and is used to open parsed SonarWiz tide
files.

Import SVP File Opens Windows Explorer and is used to import text files that can be
parsed into SonarWiz tide files. See Importing Tide Files for more
information.

Save Used to save configured tide files.

Copy Used to copy a row of data in the table.

Paste Used to paste a row of data in the table.

Zoom to Fit Rezooms the graph window to encompass the entire tide profile.

Interpolate Values Opens the Interpolate Values window and is used to generate a
complete (linearly interpolated) tide table at a specified depth interval
using only data that has been entered to the Data List.

Bin SV Data into
Depth Slices

When checked, will compare the depth values of the input tide file. If
the difference between the first value and the next exceeds the average
value specified in the "meters" field, then only the value closest to
the average will be imported. Further, the same logic applieds for the
remaining values.

Cycle Commands Used to cycle through tide casts in the editor. Text readout will say
current file out of total number loaded into the editor.
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Tide Graphic Area

Used for graphic presentation of the entered data. To change the scale of the chart use the mouse wheel, to change
the scale of one axis, you need to place the mouse cursor on the selected axis, and also to use the wheel.

Data Table Commands

Create and delete operations are available through buttons on the box header. To create one or more

rows of values use button  or , the  button removes selected rows. Edit value in the cell
can be opened with double-click on it.

Tide Data Table

This block shows a table of tide casts, height reading, and date/time.

Help Button

Offers links to the User Guide and About... information.

Station Information
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This block is used to store additional tide station information. The name of the file you save is equal
to the value inserted to the Name field. If the value in this field will be changed while editing the saved
file, then the
current file will be saved as a new one.
 
For Lat. and Lon. fields you can set up an automatic conversion of inserted coordinate to the one
of the following: #DD.DDDDDDD, #DD MM.MMM, #or DD MM SS.SSS. The format used can be
changed in the Tools | Settings window.
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Importing Tide Files
 
To import a tide table profile into your SonarWiz project, open the Tide Editor and either select the Import Tide

File  button or use the File drop down menu and select Import... Before importing a file, you need to
create a template for the current data structure or use one of the predefined.
 

Preview Window

Shows a preview of how the currently loaded tide file will be parsed in the Tide Editor. The BLUE
represents a specified field and the RED represents a delimeter.
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Source File

Displays the current file path of the tide file imported into the editor. Use the  icon to select a new
file.

Define Station Information

Not currently developed.

Template Window

Used to select previously saved import templates. Each line will list the template name, description,
fields number, and delimeter used.

Template Commands

Commands used to managed templates in the Tide Editor. Templates created in the editor can
be exported from one installation of SonarWiz and imported into another using the Import/ Export
commands.

Template Properties

Used to name a template in the Tide Editor as well as add a meta data description, set how many
header rows to ignore before valid data is parsed, and what delimeter is used in the file.
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Template Fields

Lists the configured fields that will be used when parsing the imported tide file.

Template Fields Commands

Used to Add, Delete, or Edit a field in the currently selected template.

Import Tide File

When selected, will save the edits made to the current template and attempt to import the current file
into the Tide Editor.
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Sound Velocity Editor
 
The CTI Sound Velocity Editor can be opened by selecting Bathymetry | Sound Velocity Editor from the
Bathymetry Menu. The Sound Velocity Editor application is designed to create and modify the acoustic path
data of the sonar beam and correct for angular changes of sound through water as the sound velocity changes
with water depth, as well as provide 2D visualization of dependency.
 

 

Drop Down Menus

The File drop-down menu offers options for SVP files including import, new, save, and exit.
 
The Edit drop-down menu offers options for duplicating a row of data in the table.
 
The Tools drop-down menu offers an interpolation tool as well as a window to adjust settings. The
Interoplate Values tool generates a complete (linearly interpolated) sound velocity table
at a specified depth interval using only data that has been entered to the Data List.

 
The Settings window allows the user to change the geogrphic coordinates format used in the station
information window as well as the UDP port which the Sound Veloity Editor and SonarWiz will send
status messages.
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Sound Velocity Toolbar

Setting: Button: Description:

New Creates a new SVP file

Open Opens Windows Explorer and is used to open parsed SonarWiz SVP
files.

Import SVP File Opens Windows Explorer and is used to import text files that can be
parsed into SonarWiz SVP files. See Importing SVP Files for more
information.

Save Used to save configured sound velocity files.

Copy Used to copy a row of data in the table.

Paste Used to paste a row of data in the table.

Zoom to Fit Rezooms the graph window to encompass the entire sound velocity
profile.

Interpolate Values Opens the Interpolate Values window and is used to generate a
complete (linearly interpolated) sound velocity table at a specified depth
interval using only data that has been entered to the Data List.

Bin SV Data into
Depth Slices

When checked, will compare the depth values of the input SVP file. If
the difference between the first value and the next exceeds the average
value specified in the "meters" field, then only the value closest to
the average will be imported. Further, the same logic applieds for the
remaining values.

Cycle Commands Used to cycle through SVP casts in the editor. Text readout will say
current file out of total number loaded into the editor.
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SVP Graphic Area

Used for graphic presentation of the entered data. To change the scale of the chart use the mouse wheel, to change the scale of one axis, you need to
place the mouse cursor on the selected axis, and also to use the wheel.

Data Table Commands

Create and delete operations are available through buttons on the box header. To create one or more

rows of values use button  or , the  button removes selected rows. Edit value in the cell
can be opened with double-click on it.

SVP Data Table

This block shows a table of SVP casts, depth reading, and velocity (in m per sec).

Station Information

This block is used to store additional tide station information. The name of the file you save is equal
to the value inserted to the Name field. If the value in this field will be changed while editing the saved
file, then the
current file will be saved as a new one.
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For Lat. and Lon. fields you can set up an automatic conversion of inserted coordinate to the one
of the following: #DD.DDDDDDD, #DD MM.MMM, #or DD MM SS.SSS. The format used can be
changed in the Tools | Settings window.

Help Button

Offers links to the User Guide and About... information.
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Importing SVP Files
 
To import a sound velocity profile into your SonarWiz project, open the Sound Velocity Editor and either select

the Import SVP File  button or use the File drop down menu and select Import... Before importing a file,
you need to create a template for the current data structure or use one of the predefined.
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Preview Window

Shows a preview of how the currently loaded SVP file will be parsed in the Sound Velocity Editor. The
BLUE represents a specified field and the RED represents a delimeter.

Accept Only First Down Cast

 
           When checked, will compare the previous depth value with the current during the import process. If
the current value is less than what is specified in the field "meters", the import process will terminate. All data
which was            processed successfully when importing will be added to the output SVP file.

Bin SV Profile into Depth Slices

When checked, will compare the depth values of the input SVP file. If the difference between the
first value and the next exceeds the average value specified in the "meters" field, then only the value
closest to the average will be imported. Further, the same logic applieds for the remaining values.

Source File

Displays the current file path of the SVP file imported into the editor. Use the  icon to select a new
file.
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Define Station Information

Not currently developed.

Template Window

Used to select previously saved import templates. Each line will list the template name, description,
fields number, and delimeter used.

Template Commands

Commands used to managed templates in the Sound Velocity Editor. Templates created in the editor
can be exported from one installation of SonarWiz and imported into another using the Import/ Export
commands.

Template Properties

Used to name a template in the Sound Velocity Editor as well as add a meta data description, set how
many header rows to ignore before valid data is parsed, and what delimeter is used in the file.

Template Fields

Lists the configured fields that will be used when parsing the imported SVP file.
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Template Fields Commands

Used to Add, Delete, or Edit a field in the currently selected template.

Import SVP File

When selected, will save the edits made to the current template and attempt to import the current file
into the Sound Velocity Editor.
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Cross Section
 
The Cross Section tool will quickly draw a profile across bathymetry datasets.
 
To open the bathymetry cross section window:
 
1. Enable the bathymetry datasets you want profile in the Project Explorer
2. Select Bathymetry | Cross Section from the Bathymetry Menu
3. Use the LEFT+Drag with the mouse to draw a profile across the 2D Map View
 
 

Profile Appearance

The profile appearance section controls how the profile window will look. The Show As button drop
down controls whether the profile will be drawn with points or lines or a combination of both. The
Color by drop down determines how the point colors will be selected. The point and line sizes can be
changed as well as the graph text and background colors.

Cursor Position

When Draw Cursor in Plan view is checked a cross-hair will show the position of the mouse cursor in
the main SonarWiz window.
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Cross Section Window

The Cross section window displays the bathymetry points that fall under the selected profile along with
vertical and horizontal scale lines.
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Add/Import External Navigation
 
To Import External Navigation files into SonarWiz for bathymetry processing:
 
1. Select Bathymetry | Import from the Bathymetry Menu to open the External Navigation Open dialog
2. Select the File Template of your navigation file (Contact CTI if your format is not yet supported)

 
3. Select the files to import
4. Click Open
5. Set the Date Reference for each selected file (Applanix SBET only)
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6. SonarWiz will Import the files and add them to the Project Explorer under the External Navigation Files
branch
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Bathy Post-Processing Toolbar
 

The Bathy Post-Processing Toolbar can be opened by clicking Bathymetry Views | Post-Processing
Toolbar... from the View Menu.

 

 

Bathymetry Settings

Open Bathymetry Settings window

3D Patch Test Utility

Select a polygonal area of bathymetry to load into Chesapeake Technology Patch Test Calibration Tool
utility.  Create the polygon with a series of left clicks and right-click to finish.

Export Navigation and Attitude

Export bathymetry navigation and attitude data to text file.

Edit Bathymetry Polygon

Use the mouse to select a polygon of bathymetry data to edit in the Area Editor

Edit Bathymetry Rectangle

Select rectangular area to edit with Area Editor.
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Grid Area

Select an area to grid with Gridding utility.

Cross Section

Use the mouse to define a cross section of bathymetry data to examine in the Cross Section utility.

Open Vessel

Open the Vessel Editor

Run Tide Editor

Launch the Tide Editor to import or edit tide files.

Run Sound Velocity Editor

Run the Sound Velocity editor to import or edit sound velocity files.

Run Navigation and Attitude Editor

Run the bathy navigation and attitude editor to view and edit raw navigation and attitude data.
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Beam Performance Utility
 
The Beam Performance Utility performs a cross-check between a known-good bathymetric surface and one
or more selected bathymetry data sets. The utility summarizes the vertical residuals or "deltas" between the
soundings and the reference grid to give a quantitative measure of the vertical accuracy and precision of each
beam.
 
A sounding residual or "delta" is computed as follows:
 

delta = reference surface depth - sounding depth
 
If delta is positive, the sounding was above the reference surface depth (too shallow); if delta is negative, the
sounding was deeper than the reference surface (too deep).
 
We make thousands of comparisons of the soundings to the reference surface to develop a statistical estimate
of the range of deltas we can expect to observe from the sonar system at each beam angle. The estimated
95% confidence interval of these deltas can be compared to IHO standards for total vertical uncertainty (TVU),
so that the user knows how much, if any, of the swath can be used to meet the specified survey requirements.
 
NOTE: The reference surface should be of the highest possible quality and should not include the bathymetry
data sets used for the cross-check calculations.
 
To Perform a Beam Performance Cross-Check:
 
1.  Select one Reference Bathymetry Grid in the Project Explorer. Uncheck the remaining grids.
2.  Select one or more Bathymetric Data Sets in the Project Explorer. Uncheck all of the remaining
bathymetric data sets.
3.  Open the Bathymetry Branch Context Menu and select the Performance Utility... command.
4.  Review the selected reference grid and bathymetry data set, if correct, Click OK to continue.
 
The Performance Utility results are reported as three text files of statistics which can be used to evaluate the
performance of the system against IHO standards. If Microsoft Excel is installed on the computer, the output
data will also be inserted into an Excel Spreadsheet with helpful diagnostic graphs. The output files will be
stored in the \Bathy\PerformanceTest\ folder of the SonarWiz project folder.
 
Explanation of Output Files
 
BathyPerformAngles_5.csv
 
The BathyPerformAngles_5.csv file holds the residual (delta) statistics between the soundings and the
reference surface as a function of beam angle. These data can be used to create a plot of the cross section of
how the delta statistics change as a function of beam angle across the swath.
 
BathyPerformAngles_5.csv consists of the following value columns:
 
Value Description
Angle Beam angle in degrees relative to plum vertical
Mean Mean residual between the reference grid depth and the sounding depths. (survey units)
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Median Median residual between the reference grid depth and the sounding depths (survey
units)

Minimum Minimum residual between the reference grid depth and the sounding depths (survey
units)

Maximum Maximum residual between the reference grid depth and the sounding depths (survey
units)

Count Number of soundings in this angular bin
StdDev The standard deviation of all the residuals in this angular bin
95% Conf 1.96 x the standard deviation of the residuals in this angular bin
Upper bound The mean + the 95% confidence interval

Lower bound The mean - the 95% confidence interval

 
If Excel is installed, these data are added to the Bathy Performance Angles sheet and the cross section plot is
generated automatically.
 

 
BathyPerformAngleRanges_5.csv
 
The BathyPerformAngleRanges_5.csv file holds a series of tables that examine if data meet IHO standards
for total vertical uncertainty (TVU) across a given swath width. The IHO Standards are specified in Chapter 3
of IHO S-44 Standard (2008) as follows:
 
Recognizing that there are both constant and depth dependent uncertainties that affect the uncertainty of the depths, the
formula below is to be used to compute, at the 95% confidence level, the maximum allowable TVU. The parameters “a”
and “b” for each Order, as given in the Table 1, together with the depth “d” have to be introduced into the formula in
order to calculate the maximum allowable TVU for a specific depth:
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Where:
 
a          represents that portion of the uncertainty that does not vary with depth
b           is a coefficient which represents that portion of the uncertainty that varies with depth
d           is the depth
b x d      represents that portion of the uncertainty that varies with depth
 
In SonarWiz, coefficients a and b are encoded as described in Table 1 of the S-44 standard for each survey
order. The depth, d, used to compute the limits is the mean depth of the reference grid supplied by the user.
 
The first table in the report is a summary of the results of all of the tests. Each row shows the results for
increasing swath widths and consists of the following value columns:
 
Value Description
Angle Range Swath width of test (degrees from plum vertical). The analysis is limited to this

section of the swath.
Beam Count Number of soundings observed in this restricted swath.
95% Conf. Int. The 95% Confidence Interval of the residuals between the soundings and the

reference surface. (survey units)
Special Order Error
Limit

The maximum total vertical uncertainty allowed to meet Special Order (survey units)

#Rejected The number of soundings whose depth differed from the reference grid by more
than the allowed vertical limit set for IHO Special Order surveys.

Reject Rate The number of rejected soundings divided by the total number of soundings.
Special Order Test Did the restricted swath width meet IHO Special Order Limits? (Accepted or

Rejected)
Order 1a, 1b Error Limit The maximum total vertical uncertainty allowed to meet Order 1a, 1b (survey units)
#Rejected The number of soundings whose depth differed from the reference grid by more

than the allowed vertical limit set for IHO Order 1 surveys.
Rejection Rate The number of rejected soundings divided by the total number of soundings.
Order 1a, 1b Test Did the restricted swath width meet IHO Order 1a,1b Limits? (Accepted or Rejected)
Order 2 Error Limit The maximum total vertical uncertainty allowed to meet Order 2 (survey units)
#Rejected The number of soundings whose depth differed from the reference grid by more

than the allowed vertical limit set for IHO Order 2 surveys.
Reject Rate The number of rejected soundings divided by the total number of soundings.
Order 2 Test Did the restricted swath width meet IHO Order 2 Limits? (Accepted or Rejected)
 
After the summary table, a detailed table is presented for each swath widths tested. The first table looks at
beam angles from -15-degrees to +15-degrees and compares the observed sounding data to the reference
grid. The table indicates if the data in this part of the swath meet or exceed IHO Special Order, Order 1 and
Order 2 standards. The table also contains a histogram of the residuals so that you can review bias and
spread in the measurements in this restricted swath. Subsequent tables in the file increase the swath width by
5 degree increments (+/- 20-degrees, +/- 25-degrees, and so on).
 
The detailed report in the BathyPerformAngleRange_5.csv consists of a header with the following value rows:
 
Value Description
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Beam Count The number of soundings observed in this restricted swath
Grid Cell Size The cell size of the reference surface (survey units)
Delta Mean The mean residual of the reference surface - sounding. (survey units)

Delta Median The median residual of the reference surface - sounding. (survey units)
StdDev The standard deviation of the residuals. (survey units)
Delta range The minimum to maximum residual range. (survey units)
Mean + 1.96*StdDev The upper bound of the 95% confidence interval relative to the mean (survey units)
Median + 1.96*StdDev The upper bound of the 95% confidence interval relative to the median (survey

units)
Data Mean The mean sounding depth (survey units)
Reference Mean The mean depth of the reference surface (survey units)

Data Z-Range The range of sounding depths (survey units)

Reference Z-Range The range of reference surface depths (survey units)
Special Order Error
Limit

The maximum total vertical uncertainty allowed to meet Special Order (survey units)

#Rejected The number of soundings rejected for IHO Special Order
Rate The rejection rate (#Rejected / Beam Count)
Special Order Test Did the restricted swath width meet IHO Special Order Limits? (Accepted or

Rejected)
Order 1a, 1b Error Limit The maximum total vertical uncertainty allowed to meet Order 1a, 1b (survey units)
#Rejected The number of soundings rejected for IHO Order 1a, 1b
Rate The rejection rate (#Rejected / Beam Count)
Order 1a, 1b Test Did the restricted swath width meet IHO Order 1a,1b Limits? (Accepted or Rejected)
Order 2 Error Limit The maximum total vertical uncertainty allowed to meet Order 2 (survey units)
#Rejected The number of soundings rejected for IHO Order 2
Rate The rejection rate (#Rejected / Beam Count)
Order 2 Test Did the restricted swath width meet IHO Order 2 Limits? (Accepted or Rejected)
 
Following the summary table, is the histogram of deltas observed in this restricted swath width. The data value
columns are as follows:
 
Value Description
Normalized Delta The delta observation bin label normalized from -1 to +1
Count The count of deltas that fell into this bin

Actual Delta The delta observation bin label actual observed values
 

If Excel is installed, these data are added to the Histograms at Angle Ranges
sheet and the residual histogram of deltas are plotted for each swath width tested.
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BathyPerformBeamData_5.csv
 
The BathyPerformBeamData_5.csv file holds the residual (delta) statistics organized by increasing beam
number.
 
NOTE: This plot is only useful for multibeam systems with consistent beam numbers from ping to ping. It
should not be used for interferometers because the sample numbers on these systems change from ping to
ping.
 
The BathyPerformBeamData_5.csv table consists of the following value columns:
 
Value Description
Beam Beam number
Angle Beam angle measured from plum vertical (degrees)
Mean Mean residual (delta) of reference surface - sounding depth (survey units)
Median Median residual (delta) of reference surface - sounding depth (survey units)
Minimum Minimum observed residual (delta) (survey units)
Maximum Maximum observed residual (delta) (survey units)
Count The number of observations of this beam.
StdDev The standard deviation of residuals (deltas) (survey units)
95% Conf The 95% confidence interval of the residuals (deltas) (survey units)
Upper bound The mean residual + the 95% confidence interval (survey units)
Lower bound The mean residual - the 95% confidence interval (survey units)
 
If Excel is installed, these data are added to the Beam Statistics sheet.
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Bathymetry Plan View Editor
 
The Bathymetry Plan View Editor drop down options are used to accept or reject samples in merged
bathymetry data in the plan view of SonarWiz instead of one of the external editors.
 

 

Using the  drop down menu, the user can set the following options that will affect how the tool is used:
 
Accept/ Reject Soundings: When an area is selected in the plan view, will the points be rejected or enabled
when merged.
Selection Shape: Choose whether a rectangular or polygon area is drawn with the mouse.
Undo/ Redo Last Edits: Quickly undo the last edit done in the plan view or redo it if just undone.
 

1. Selecting the  button will turn the cursor in the map view to a editing tool which allows areas to be
drawn and either automatically rejected or accepted.
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2. After merge, the data should be set to new flag (accepted or rejected) and displayed in the plan view.
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Forward Looking Sonar
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Import (Forward Looking Sonar)
 
The Import... command opens a dialog where you can select one or more forward looking sonar files for
importing into a SonarWiz project. The Import Forward Looking Sonar command can be activated by:
 

1. Clicking the Import | Forward Looking Sonar...   button in the Post Processing
Menu
2. Clicking the Import... command from the context menu in the Project Explorer.
 

Program Folder

Select the Windows directory where you bathymetry files are located.
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File Selection List

One or more files can be selected for import by holding down the SHIFT or CONTROL keys while left
clicking with the mouse.

File Name and File Filter

The files to import will be listed in the File Name box. The Files of type drop down provides a filter that
is used to restrict the file list to only those Forward Looking file types supported by SonarWiz. Use the
drop down to filter for specific file types.

File Type Specific Options

Not currently used for FLS data.

Properties

 
Opens the Acoustic File Properties Report window for the selected file.

Advanced Settings

Opens the Advanced Forward Looking Sonar Import Settings window where you can modify the import
settings for this file.
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Import Options

Opens the FLS Sampling Area Chooser dialog where you control the portion of the FLS frame to
map to the seabed. Optionally, to reduce file size, you can down-sample the number of FLS frames
imported. There tends to be a lot of overlap between frames and it is not usually necessary to import
every frame to create a seamless mosaic.

File Coordinate System

Some file formats do not record geodetic coordinates and instead only record grid (projected)
coordinates. Use this dialog to specify the coordinate system used by the file so that SonarWiz can
decode the XY coordinates used by the raw data. SonarWiz will convert the XY coordinates back
to WGS84 geodetic coordinates and then re-project the data into the project coordinate system (if
necessary).
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Advanced Forward Looking Sonar Import Settings
 
The Advanced Forward Looking Sonar Import Settings window is opened by clicking the Advanced
Settings... button in the Forward Looking Sonar Import dialog.  The Advanced Settings allow the user to
override project default settings for image across-track resolution, compression and sonar projection.
 

 

Vessel Selection

This drop down allows you to select the appropriate vessel configuration to apply. (Not currently used
for FLS systems)

Import Samples

The number of across-track samples to use to draw the forward looking sonar.

Compression Settings

 
Set the compression algorithm for intensity values in CSF files. Users can set the compression
separately for raw and processed samples.
 
Algorithm Description
Floating Point - None No compression, millions of values. (Note: All CSF files in

SonarWiz 7 prior to 7.04.001 used this setting)
8-Bit Log - 4x Reduces intensity to 256 values distributed logarithmically

with more values at the lower end of the distribution (Note:
This setting is a good default for most sonar data).
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16-Bit Scaled - 2x Reduces intensity to 65,000 values distributed evenly
between the minimum and maximum value.

8-Bit Scaled - 4x Reduces intensity to 256 values distributed evenly
between the minimum and maximum value.

Course Smoothing

Navigation filtering is helpful for producing good sidescan mosaics. This setting controls the width
of the navigation filter in position updates. A value of 0 turns off navigation filtering, the default value
is 300 is recommended for straight-line surveying. Reduce the value for pole mounted systems
navigating in ports, harbors and rivers. See Course Smoothing and Interpolation for details.

Sound Velocity Override

Use SonarWiz default water column sound velocity instead of sound velocity stored in the acoustic file.
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FLS Sampling Area Chooser
 
The FLS Sampling Area Chooser window is opened by clicking the Choose Sampling Area... button in the
Forward Looking Sonar Import dialog. The FLS Sampling Area Chooser allows the user to set the sampling
window of the FLS frames that are imported by SonarWiz.
 

Frame Controls

The Frame Controls allow you to step through a FLS file one frame (ping) at a time using the Next
Frame and Prev. Frame (Previous) buttons. You can also play the FLS file using the Play and Stop
buttons. The First Frame button returns to the start of the file. The Frame Display will show the image
formed from the selected ping.

Frame Information

This read-only display lists the current frame number and the maximum observed range.
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Sampling Window

The sampling window defines the region of each FLS frame that will be extracted and assembled
into the CSF file for mosaicing. Define the minimum and maximum width of the sample window and
the minimum and maximum height of the sampling window as a percentage of the frame size. Note
that the sampling window is identified on the Frame Display by a green rectangle. You can also
manipulate the size of the sampling window with the mouse directly in the Frame Display.
 
We recommend experimenting with the width and height of the sampling window. The goal is to
choose a portion of the FLS frame that has minimum distortion of the seabed. Each FLS frame will
be clipped and extracted as a small image. Optimize the height of the sample window so there is a
minimum of along-track overlap between the sample clips but sufficient height so that there are no
along-track gaps between pings. It is helpful to advance (play) the FLS data frame by frame until
features of interest are showing. These can help aid in choosing the optimal sampling window.  Most
notably they will show where the beams have the best focus and lowest distortion.

Frame Display

The Frame Display shows each frame in the selected FLS file as selected by the Frame Controls. A
green rectangle indicates the sampling window. This is the portion of each frame that will be clipped
out from the raw data and mosaic'ed on the seabed by SonarWiz. The green sampling window width
and height can be manipulated with the mouse.
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Singlebeam Data
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Import (Singlebeam)
 
The Import Single Beam Bathymetry Files... command opens a dialog where you can select 1 or more
SBES files for importing into a SonarWiz project. The Import Single Beam Bathymetry Files command can be
activated by:
 

1. Clicking the Import | Single Beam Bathymetry Files...   button in the Post
Processing Menu
2. Clicking the Import... command from the context menu in the Project Explorer.
 

 

Program Folder

Select the Windows directory where you bathymetry files are located.
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File Selection List

One or more files can be selected for import by holding down the SHIFT or CONTROL keys while left
clicking with the mouse.

File Name and File Filter

The files to import will be listed in the File Name box. The Files of type drop down provides a filter that
is used to restrict the file list to only those SBES file types supported by SonarWiz. Use the drop down
to filter for specific file types.

File Type Specific Options

Open the File Type Specific Options window where settings unique to each sonar file type can be
specified.

File Parsing Template

Use the File Template drop down menu to select the parsing template that will be used to import your
single beam data. SonarWiz supports the following SBES formats. These templates are created by our
support staff and can be created for EMA customers upon request.

File Parser Properties

Lists the properties of the currently selected file parser template.

Adjust Soundings for Roll and Pitch

Toggle using attitude computations to the imported single beam data.

Import Geodesy
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Some file formats do not record geodetic coordinates and instead only record grid (projected)
coordinates. Use this dialog to specify the coordinate system used by the file so that SonarWiz can
decode the XY coordinates used by the raw data. SonarWiz will convert the XY coordinates back
to WGS84 geodetic coordinates and then re-project the data into the project coordinate system (if
necessary).
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Magnetometer Data
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Import (Magnetometer)
 

The Import... command opens a dialog where you can select 1 or more magnetometer files for importing into a
SonarWiz project. The Import Magnetometer command can be activated by:
 

1. Clicking the Import | Magnetometer Files...   button in the Post Processing
Menu
2. Clicking the Import... command from the context menu in the Project Explorer.
 
Magnetometer data can be imported into SonarWiz from several different file formats. Once imported, these
data may are displayed in a 2D map style with a single polyline representing the file.
 

 

Program Folder

Select the windows directory where you bathymetry files are located.
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File Display List

One or more files can be selected for import by holding down the SHIFT or CONTROL keys while left
clicking with the mouse.

File Name

The files to import will be listed in the File Name box.

File Type Filter

The Files of type drop down provides a filter that is used to restrict the file list to only those
magnetometer file types supported by SonarWiz. Use the drop down to filter for specific file types.

File Template

SonarWiz supports the following magnetometer file formats. These templates are created by our
support staff and can be created for EMA customers upon request. For a full list of the support
templates with their required CSV layout, see the Magnetometer Post Processing Refrence PDF
located in the Docs folder installed with SonarWiz.

Downsampling Options

The magnetometer import engine supports decimation to 1hz rate. For example, if you had 10000
raw mag records in the original file and it had been recorded at a 10hz rate, you would result in 1000
imported records in the MAG CMF (common mag format) file in your project. The record count is
visible beside the line name, in the mag editor view. When Downsampling is turned off, the algorithm
will still avoid repeat-duplicate records.

Import Geodesy

Some magentometer file formats do not record geodetic coordinates and instead only record grid
(projected) coordinates. Use this dialog to specify the coordinate system used by the file so that
SonarWiz can decode the XY coordinates used by the raw magnetometer data. SonarWiz will convert



Import (Magnetometer)

1277

the XY coordinates back to WGS84 geodetic coordinates and then re-project the data into the project
coordinate system (if necessary).

File Type Specific Options

Open the File Type Specific Options window where settings unique to each sonar file type can be
specified.
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Magnetometer File Management
 

The Magnetometer File Manager window is opened by clicking the Magnetometer icon  on the
Post Processing Menu and selecting Magnetometer File Manager. The Magnetometer File Manager provides
access to commands that apply to magnetometer data sets. Note that many of the functions found in this are
also available in the Project Explorer.
 

 
 

Magnetometer Project Summary

Lists the project name, number of magnetometer files in the current project, and the number of
magnetometer files currently enabled.

Magnetometer File List

 Lists the magnetometer files in the project and allows for some file properties to be changed. Each file
in the project is listed on a separate row within the file name section.
 

Column Description
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Draw Toggles the display of the magnetometer file in Map View (checked =
displayed)

File Name Displays the full path and file name of the magnetometer file.

Layback Pct Lists the current layback percentage applied to the magnetometer file
and also allows the setting to be changed.

Color Contains a drop down list of the available colors that can be used to
display the magnetometer line in the Map View.

Records Number of magnetometer records in the file.

Make Like Selected

Allows the user to copy settings applied to the selected magnetometer files to others files in the project
in batch. Settings able to be copied include display, color, and layback pct.

Command Tools

The Magnetometer File Manager provides access to tools that can be applied to magnetometer files in the project.
Note that some tools require one or more files to be selected in the file list before the button becomes active.
 

Tool Description
OK Closes the manager
Cancel Closes the manager and cancels any settings changed in the file list

Add Files... Add an existing CMF file to the project
Delete File(s)... Remove CMF files from the project
Select All Select all files in the File Manager
Editor Opens the selected file in the Magnetometer File Editor
Properties... Opens general properties regarding the selected file
Set Cable Out Set the cable out value on the selected files
Offset Cable Out Offset the cable out value on the selected files
Export... Exports the CMF files as raw magnetometer data

Settings... Opens the Preferences and Settings for magnetometer data
Anomalies... Opens the Anomaly List
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Magnetometer Anomaly List
 

The Magnetometer Anomaly window is opened by clicking the Magnetometer icon  on the Post
Processing Menu and selecting Magnetometer Anomaly List... or selecting Anomalies in the Magnetometer
File Manager. The Anomaly List contains all of the magnetometer anomalies in table format added for each
file.
 

 
 

Anomaly List

Lists the magnetometer anomalies in the project and allows for some file properties to be changed. Each file in the project
is listed on a separate row within the file name section.
 

Column Description

Display When checked, the anomaly will be displayed in the Map View
Anomaly Anomaly number in the project
Line Line name
Peak-to-peak The peak-to-peak amplitude of the anomaly
Altitude Altitude of the sensor above the seafloor at the time of observation
Duration Duration of the anomaly in meters or feet
Description The user entered information from the Notes section of the Anomaly Properties Window of the

Magnetometer File Editor.
File Name Name of the file where the anomaly was detected



Magnetometer Anomaly List

1281

Command Tools

The Magnetometer Anomaly Manager provides access to tools that can be applied to anomalies in the project. Note that
some tools require one or more files to be selected in the file list before the button becomes active.
 

Tool Description
OK Closes the manager
Cancel Closes the manager and cancels any settings changed in the file list
Delete Deletes the selected anomalies
Select All Select all anomalies in the File Manager
Editor Opens the selected anomaly in the Magnetometer File Editor
Export... Exports an .CSV file of the anomalies enabled
Settings... Opens the Preferences and Settings for magnetometer data
Sort Sorts anomalies in their proper numerical sequence
Refresh Refreshes the Map View which is used after changing display properties but without the need to

exit the dialog to see the changes
Report... Currently displayed magnetic anomalies may be exported to one of three types of reports which are

placed in the project's Mag folder. The types of reports available are HTML, MS Excel, MS Excel w/
Mag Chart, and PDF

Recompute Repositions the enabled magnetic anomalies in the project after map corrections or offsets are
applied or change in the CMF file navigation parameters such as layback
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Magnetometer File Editor
 

The Magnetometer File Editor is used to manage magnetic anomalies that are contained in the currently
selected file. Anomalies may be user defined or an Auto Detect algorithm may be used based on a user-
defined threshold.
 
The Magnetometer File Editor can be opened by:
1. Right-clicking the a selected magnetometer file in the Map View and selecting Edit Selected Mag File
2. Clicking the Editor button in the Magnetometer File Manager or Anomaly List
 
 

Info at Cursor

             The position of the cursor in the current file is tracked by the Info at Cursor Window and detailed
information about that particular position is displayed. This information includes:
 

Date and Time of Record

Record Number Northing
Latitude Easting

Longitude Course Made Good
Heading Speed
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Mag Depth Depth below Keel
Mag Altitude Event Number

Cable Out with
% Layback

Layback Offset

Map Corrections

Tool Bar Buttons

 

Copy: Not yet implemented.

Pan: When the display is zoomed in,
the mouse cursor may be used as a Pan
tool. To Pan, drag the image using the
left mouse button in the direction you
wish to move the view area. Release the
left mouse button and the display will be
updated, centered at the new location.

Zoom Window: Left-Click and hold to
drag a box over a specific area in the data
window to be zoomed.

Zoom In 10%: Left-Click the toolbar button
to zoom data window in by 10%of current
resolution.

Zoom Out 10%: Left-Click the toolbar
button to zoom data window out by 10% of
current resolution.

Zoom In X Axis: Increases zoom in X-axis.

Zoom Out X Axis: Decreases zoom in X-
axis.

Zoom In Y Axis: Increases zoom in Y-axis.

Zoom Out Y Axis: Decreases zoom in Y-
axis.

Fit To View: Left-Click to the toolbar button
have data window fit all visible sonar files.



Magnetometer File Editor

1284

Measure: Determines the horizontal
distance and difference in gamma count
between two points on a left-click-drag with
the mouse.

Delete in Box: If the raw magnetometer
data has spikes or noise that are desired
to be removed then the Delete in Box is
the best method to correct the data by
left-clicking and dragging a box around
the noise. SonarWiz will do a straight-
line interpolation between the two points
outside of the drawn box.

Previous Magnetometer File: Quick
method to edit previous file without having
to exit the editor.

Next Magnetometer File: Quick method
to edit next file without having to exit the
editor.

Add Map Corrections: Add a map
correction point in the editor window. See
Map Corrections for more information.

Data Window

Every record in the entire file is graphed in the data window with the observed mag value as the Y axis and the Record
number as the axis. The Raw Trace, Smoothed Trace, Ambient Trace as well as anomalies are displayed in this window.

Add/ Delete Anomaly



Magnetometer File Editor

1285

Used to add anomalies, clicking this button turns the cursor into a combined pen/magnet icon and
allows the user to left-click on a desired point of the graph where a new anomaly is desired on the data
window or delete selected anomalies from the project.

Auto Detect Anomalies

When selected, will scan current magnetometer file using the auto detect threshold value which is a 
numerical threshold setting that you need to decide empirically. The "base" is set to the raw data and
for an anomaly to be picked, it needs to have a peak-to-peak nT greater than the threshold value set
by the user.

Anomaly Management Window

Used to control display settings and edit anomalies for the current magnetometer file.
 

Column Description

Display When checked, the anomaly will be displayed in the Map View
Anomaly Anomaly number
Event Event number
Amplitude Amplitude of the anomaly from the ambient magnetometer

record
Duration The physical distance that the anomaly spans in the record
Cable Out Current cable out and layback percentage applied at the

anomaly
X Easting
Y Northing
Ambient Ambient magnetometer value

Data Window Draw Options

Allows users to toggle raw, smooth, ambient, and residual trace in the data window.
 
The Raw Trace will display the samples as they were read upon import into the project.
 
The Smoothed Trace will display a smoothed version of the raw samples based on the observed
smoothing constant value.
 
The Ambient Trace will attempt to display an ambient magnetometer signal based on the ambient
smoothing constant value.
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The Residual Trace will map the residual values for each sample which is calculated using the
smoothed trace subtracted by the ambient trace.

Y-Scale Gamma/Pixel

Used to set the Y-Scale Gamma/Pixel, by default this will be set to fit to data.

Smoothing Constant

Used to set the number of samples used in the high pass filter for the Ambient and Observered
Smoothing Constants.

Clip Gamma to Range

The Clip button is used to clip the current magnetometer file's gamma range to a set minimum and
maximum value. All data outside of the boundary will be set to the value of the minimum or maximum.
The Remove button will also clip the current magnetometer file's gamma range to a set minimum and
maximum value but will interpolate the gap between the neighbors.
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Editing Anomalies
 

Anomalies can be selected in the Anomaly Management Window, Data Window, or in the Project Explorer and
edited. Once seleted, the Anomaly Properties window will appear as below. 
 

 

Anomaly Information

Specific values describing the anomaly at the cursor position are displayed.

Type of Anomaly

User selected anomaly type as either Monopolar, Dipolar, or Complex.



Editing Anomalies

1288

User Editable Notes

Allows the user to write in notes regarding the anomaly as well as a minimum avoidance distance and
copies the altitude for exports.

Cause of Anomaly

The Known option can be used to select a Shapefile that has been loaded that contains possible
causes, such as stuctures, wrecks or pipelines etc or connect the anomaly to a nearby Contact in the
project. Select Identify Cause... to choose the object which you want connected to the anomaly.

 
The Unknown option can be used to add a text description if no objects are currently loaded.
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Trimming Magnetometer File with Features
 

Unlike sonar data that may be trimmed graphically, Magnetometer files cannot. If a Magnetometer file is
desired to be trimmed to a specific area then the use of a feature must be employed.
 
To trim a magnetometer file using a feature:
 
1.     Create a closed polyline or rectangular feature around the magnetometer file portions desired to be
retained. See Digitizing Features in the Map Window for more information.
In the figure below, the green magnetometer line portions that fall within the red feature (Feature0000) are to
be retained.
 

 
2.     Select the feature by left-clicking and then right-click on the feature and selecting Trim the Magnetometer
Data to Feature Extents.
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3.     The resultant image in the figure below shows how all portions of the magnetometer files outside of the
feature have been removed.
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Note: To restore all portions of a Mag file that have been trimmed the file must be re-imported.
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Automatically Identify Cause of Magnetic Anomaly
 
SonarWiz can assist in the identification of magnetic anomalies found near previously mapped objects such as
pipelines, wrecks or other features. This function requires that the known features be loaded into the program
as an Overlay. When you identify a new magnetic anomaly or edit an existing anomaly, you can use the
Identify Cause button to have SonarWiz search the overlay for nearby objects. If the object is close enough,
you can copy the object identification information into the new anomaly.
 
To Automatically Identify the Cause of a Magnetic Anomaly:
 
1. Load previously mapped objects into SonarWiz as an Overlay (see Add a Basemap or Overlay)
 

 
In this example, we want to associate the magnetic anomaly with the nearby wreck identified in the sidescan
data.
 
2. Open the Magnetometer Options Menu to configure the feature lookup
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In the Magnetometer Options Menu:
 
•  Toggle Fill Notes 1/Block Info Field from Selected Map Overlay File check box so that it is checked.
•  Use the Notes 1 Map File drop down to identify the overlay with the mapped objects
•  Use the Attribute 1 drop down to select a text field that will be used to populate the magnetometer Notes
section.
•  Click OK to accept the changes and close the Magnetometer Options Menu
 
2. From the Magnetometer File Editor, select the anomaly you want to identify in the anomaly list
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3. Click the Known radio button in the Cause of Anomaly group. Then click the Identify Cause... button
 

 
SonarWiz will search the overlay for the nearest object (or object segment for linear features) and display the
Identify Source of Known Anomaly window
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The Identify Source of Known Anomaly window identifies the Overlay Map File that was used to perform
the lookup, the type of feature found, the distance from the magnetic anomaly to the found feature and the
description of the feature listed in the Attribute 1 field of the overlay.
 
4. If the identified feature appears to be the cause of the magnetic anomaly click the OK button.
 

 
SonarWiz will copy the text from the object Description into the Notes 1 field of the anomaly.
 
5. Click OK to close the Magnetic Anomaly Edit window.
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Exporting Magnetometer Files
 
The Export Magnetometer Files tool is used to export raw magnetometer data from the imported .CMF's
inside the project. The export will include all of the navigation adjustments made to magnetometer files
in the project and will be stored by default in the MAG folder of the project. If you need to export all of the
magnetometer data in the project to a single file, you will need to use the ASCII XYZ option and check the
Export All Data to One File checkbox.
 

 
Currently the Export Magnetometer Files tool supports the following format:
 
•  ASCII XY Text
•  ASCII XYZ (This is the only export format that will store all of the magnetometer data into a single file)
•  AutoCAD DXF
•  ESRI ShapeFile
•  Enhanced ASCII CSV
•  Google Earth KML
•  MapInfo MIF/MID
•  MapInfo TAB/MAP
•  SVG
•  Simple CSV
•  WASP MAP+
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Sorting and Renaming Anomalies
 
The Sort Anomalies command will sort anomalies in the project according to the specified geographic or
alphanumeric criteria. Sort Contacts can optionally rename the anomalies using the new sorting order. Sorting
anomalies by area is useful for visually grouping anomalies by location or name for the purpose of editing or
deleting. The anomaly sort order will also determine the order in which the anomalies are exported. The Sort
Anomalies command is found on the Anomalies Branch Context Menu.
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Sorting Mode

The sorting mode allows you to change the anomalies sorting order based on the geographic position,
the name, or the distance from a specified corner or specified point  (easting, northing).

Rename Contacts

If checked, anomalies will be renamed in using the new sorting order.

Rename Scheme

When renaming anomalies, specify the root name of the anomaly and the renumbering scheme. An
anomaly number will be appended to the root name according to the starting number value and the
increment. If desired, you can pad out the numbers with leading zeros.
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Grids
 
What is a Grid?
 
A grid is a regularly spaced, rectangular array of Z values composed of evenly spaced rows and columns.
Rows contain grid nodes with the same Y coordinate and columns contain nodes with the same X coordinate.
Gridding generates a grid from irregularly spaced XYZ data by interpolating or extrapolating the data values at
each grid node.
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Adding / Importing Grids
 
The Add/Import Grids command will allow you to add an existing grid to the SonarWiz project.
 
To add an existing grid to a project:
 
1. Select Add/Import Grids from the Grid Branch Context menu in the Project Explorer.
 

 
Note that by default, SonarWiz will filter the Open grid dialog to list only SonarWiz native Surfer Grid (GRD)
format files. However, setting the file filter drop down to All Files (*.*) will allow you to import grids in many
supported formats.
 
2. If SonarWiz cannot determine the grid coordinate system, it will open the Select Projection dialog.
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Provide the grid Projection information of your grid and (optionally) save the projection information file (*PRJ)
in the same directory as the original grid.
That is, if your grid is called SurveyBathy.grd, name the projection information file SurveyBathy.prj. In the
future, SonarWiz will be able to determine the coordinate system of the grid from the companion PRJ file.
 
CAUTION: If the grid coordinate system does not match the SonarWiz project coordinate system, SonarWiz
will attempt to re-project the grid. The user has no control over the algorithm selected. If the results are not
satisfactory, please re-project your grid to match the SonarWiz project coordinate system using 3rd party GIS
software before you import the grid into the project.
 
3. The newly imported grid will be added (copied) to the Grids folder in the SonarWiz project directory and
displayed in the Grids branch of the Project Explorer.
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Create New Grid
 

The Create New Grid command will allow you to create a SonarWiz grid from existing point data and add it to
the SonarWiz project. The resulting grid will use the same coordinate system as the SonarWiz project.
 
To open the Create New Grid window:
 
1. Select Create New Grid... command from the Grid Branch context menu in the Project Explorer.

 

Data Source

Select the grid data source. Choose Internal to grid bathymetry or sidescan data sets previously
imported into the SonarWiz project, Choose External XYZ file and fill in the full path to the file to grid
data stored in a text file outside of the project. External XYZ files can be of any data type, however
SonarWiz will assume the data is depth data in some cases. See External XYZ Point Format for more
information on the external file formats accepted by the gridder.

Grid Extents

The map extents of the grid will be initialized to the SonarWiz window extents when you open the
Grid Setup dialog. You can manually adjust the extents as desired to limit the area to be gridded. The
extents are listed using the Project Coordinate System.

Select Extents on Plan View
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Click this button to set the grid extents by using the mouse to drag a rectangle around the area to grid.

Cell Size

Specify the grid cell size. Distance units are set by the Project Coordinate System.

Output Grid File Root Name

One or more grids will be generated by the gridding tool, specify the root name of all of these grids
here.

Primary Grid Surface

Select the primary grid surface to generate. When the data source is Internal (see above) there are
five options:

Primary Grid
Surface

Description

CDF Depth Grid CDF File (imported bathymetry files) Sounding Depths
CDF Amplitude Grid CDF File (imported bathymetry files) Sounding Intensity
CSF Sidescan Grid CSF File (imported sidescan files) Sample Intensity
CMF
Magnetometer
Residual

Grid CMF File (imported magnetometer file) Magnetic values
after filtering

CMF
Magnetometer
Raw

Grid CMF File (imported magnetometer file) Raw magnetic
values

Grid Algorithm

  
 
Select the gridding algorithm. The available gridding algorithms depend on the type of surface being
generated. Some of the algorithms have user-selectable parameters that can be accessed by clicking
the Advanced Grid Settings button.
 
Algorithm Interpolates Description Notes
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Blend no

Computes the weighted
mean value of samples that
fall in each cell. Weighting
is determined by distance
from the edge of track line.

Excellent for removing
artifacts between
overlapping tracklines.

CUBE no

Combined Uncertainty
Bathymetric Estimation,
uses statistical information
about the quality of the
soundings and the way the
soundings are grouping
at the seabed to try and
eliminate outliers from the
surface

Popular gridding algorithm
for bathymetic surveying.
Requires advanced
knowledge of the vessel
configuration and
equipment to work properly.

Inverse
Distance
Weighted

yes

Computes the weighted
mean value of surrounding
samples for each cell.
Weighting is determined
by distance up to the
maximum search radius.

Good for interpolating small
data gaps. Higher quadrant
requirements can be used
to control extrapolation
beyond the data limits.

Mean no
Computes the mean value
of all samples that fall in
each cell.

Most efficient use of
memory, sensitive to
outliers

Median no
Computes the median
value of all samples in
each cell

Not sensitive to outliers,
large memory requirements

Natural
Neighbor yes

Computes the weighted
mean value of surrounding
samples for each cell using
thiessen polygons.

Best algorithm for
gridding linear data into
surfaces such as SBES,
Magnetometer, SBP
reflectors etc.

Nearest
Neighbor no

Each cell takes on the
value of the closes sample
to the center of the cell

Primary use is for importing
previously gridded data
that was exported in XYZ
format.

Nearest
Range no

Each cell takes on the
mean value of the samples
from the nearest trackline. 

Best for target detection
of amplitude data. No
blending of track lines
occurs.

Preferred
Angle
Weighted

no

Each cell takes on the
weighted mean value
of soundings that fall in
the cell. Higher weight is
placed on samples close
to the preferred beam
azimuth angle.

Particularly helpful for
sidescan mosaics. This
can prevent the muddy
appearance that occurs
when you blend shadows
and bright areas over
a target shot from lines
collected in opposite
directions.
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Trimmed
Mean no

Computes the trimmed
mean value of all samples
in each cell.

Less sensitive to outliers
than Mean, large memory
requirements.

Optional Grids

In addition to the primary grid surface, the gridder can also create auxiliary grids with statistics
about the points observed in each cell. The specific optional grids available depends on the gridding
algorithm selected.
 
Optional Grid Type Description
Count The number of points observed in this cell
Min The minimum point value observed in each cell
Max The maximum point value observed in each cell
Mean The mean point value of all points in this cell
SDEV The standard deviation of all point values observed in this

cell
Uncertainty The standard deviation scaled by the specified confidence

interval (default is 95% confidence interval)
Uncertainty
(CUBE)

The CUBE uncertainty estimate

Hypothesis Count
(CUBE)

The number of hypotheses formed at this cell

Hypothesis
Strength (CUBE)

The hypothesis strength (0 is better, 5 is worse)

Advanced Grid Settings

Opens the Advanced Gridder Settings window where you can modify the default gridding parameters
for each algorithm. The following algorithms have Advanced Settings:
 
•  Amplitude Blend
•  Amplitude Median
•  CUBE
•  Inverse Distance Weighted (IDW)
•  Median
•  Preferred Angle Weighting
•  Trimmed Mean
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Depth vs Elevation

SonarWiz works with depth data where depth values are positive down. Most GIS software expects
depth data to be negative. You can toggle the sign convention used here.

Final Actions

The final actions section will perform the stated action after the grid is successfully created. The
options are:
 

Action Description
Add Grid to Project This adds the result grid to the SonarWiz project.
Open in the 3D Viewer This opens the result grid in the External 3D Viewer
Open Containing
Folder

This will open the folder where the grid was created in
Windows Explorer.
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Advanced Gridder Settings - Amplitude Blend
 

The Amplitude Blend algorithm (also available for Depth grids) weighted average gridder. The weights
are based on distance from the edge of the swath with soundings at the center of the swath having more
weight than those at the outer limits of the swath. The purpose of this algorithm is to smoothly feather (blend)
overlapping data sets together and reduce the artifact formed at the edges of overlapping lines.
 

This figure shows a single track line. From nadir to the start taper mark, the soundings in this region will
receive full weight. Between the start taper mark and the end taper mark, the sounds will receive decreasing
weight. Beyond the stop taper mark, the sounds (if any) will receive no weight and will be eliminated from the
grid.
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Start Tapering

This parameter represents where tapering should start across the swath. The parameter is a ratio that
ranges from [0 .. 1] with 0 located at the swath nadir and 1 located at the outer limits of the swath. All
soundings from 0 to Start Tapering mark receive full weight, beyond the start tapering mark, sounds
will receive decreasing weight the further they are from nadir. The default value is 0.75.

End Tapering

This parameter represents the point where sounding weight reaches 0. Beyond this point sounds will
receive no weight. The parameter is a ratio that ranges from [0 .. 1] with 0 located at swath nadir and 1
located at the outer limits of the swath. Note that Start Taper < End Taper. The default value is 0.99.
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Advanced Gridder Settings - Amplitude Median
 

The Amplitude Median algorithm is computes the median amplitude for each node.
 

Buffer Size

The maximum number of soundings each node will hold. If the sounding buffer is full, adding an
additional sounding will randomly replace one of the existing values in the buffer. This limits the total
memory used by the grid without biasing the results.
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Advanced Gridder Settings - CUBE
The CUBE Gridding Algorithm was developed by Brian Calder and David Wells. According to the CUBE
User's Manual (where most of the technical details of this help page are taken), CUBE is an algorithm that
implements computer-assisted processing (a.k.a, 'algorithmic hydrography'); it is an acronym for Combined
Uncertainty and Bathymetry Estimagor. The objective is to process bathymetric data from raw measurements
resolved in a local-level coordinate system into estimates of water depth in a particular position on the face of
the earth. The algorithm is aimed mostly at high resolution Multibeam Echosounder (MBES) data, although
other suitably dense bathymetric data could be used.
 
CUBE performs three functions: assimilation, intervention and disambiguation.
 
Assimilation is the assembling of statistically based nodal depth estimates and depth uncertainties, based
on input sounding measurements and their 3D uncertainty estimates. Three stages in CUBE assimilation
are reordering, scattering and gathering. Reordering delays the  consideration of outliers. Scattering is the
presentation by each sounding measurement of itself as a candidate for updating depth estimates at several
surrounding nodes. Gathering is the determination of which surrounding soundings will be accepted for
updating the nodal depth estimate.
 
Intervention is the decision to interrupt the assimilation process when an incoming sounding measurement is
not statistically compatible with the existing nodal estimate. Intervention results in the creation of an alternative
hypothesis concerning the “true” depth - a separate tracking of the nodal depth and depth uncertainty.
Intervention allows CUBE to respond appropriately to several failure modes: soundings from multiple
real objects (seabed and school of fish; wharf pilings and seabed beneath wharf), burst-mode blunders
(echosounder bottom  etection failures), and systematic uncertainties in the soundings.
 
Disambiguation is the selection of which of several alternative hypotheses is most likely to represent the
“true” depth. Several metrics may be used. However at present the popularity contest, and the locale metrics
are most commonly used.
 
SonarWiz implements the CUBE algorithm as written by Brian Calder with very few modifications. Some of the
parameters available on the Advanced Settings Page should never be changed without additional direction
from a CUBE expert. In a few cases, tweaking the parameters may improve your CUBE surface. These
parameters are indicated below along with recommended settings.
 
For a more detailed description of CUBE, please see:
Calder, Brian and Wells, David. 2007. CUBE User's Manual, Version 1.13. University of New Hampshire. http://
ccom.unh.edu/sites/default/files/publications/Calder_07_CUBE_User_Manual.pdf
 
 
 

http://ccom.unh.edu/sites/default/files/publications/Calder_07_CUBE_User_Manual.pdf
http://ccom.unh.edu/sites/default/files/publications/Calder_07_CUBE_User_Manual.pdf
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IHO Survey Order

User should set the desired IHO survey order. CUBE will automatically reject soundings that fall
outside the allowed uncertanty.

Standard Deviation Scale

This setting has no effect when using CUBE.

Disambiguation Method

This parameter controls how CUBE chooses the "best" hypothesis when 2 or more depth hypothesis
are available for a given node. Different disambiguation methods may perform better or worse
depending on the survey. Changing the disambiguation method is safe to do.
Method Description
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Hypothesis with
the most samples

This uses the logic that the hypothesis that has assimilated
the most soundings is most likely, and selects accordingly.
This works well in most data,
and is very fast in operation, but can fail with burst-mode
blunders. This is also known as ‘density’ mode in some
implementations, and ‘Num. Samples’ in
others.

Hypothesis with
depth closest to
neighbors

This attempts to get around the problem of burst-mode
blunders by looking out from the node of interest for another
node that has only one hypothesis. Theorizing that this
single hypothesis is likely the true depth, the node of
interest selects the hypothesis closest in depth to this
‘guide’ value. The minimum and maximum search radii can
be set to the user’s understanding of the effects of noise
in the dataset. This method is more powerful than "most
samples", but is slower due to the local searching required.
This is known as ‘locale’ mode in some implementations,
and ‘neighborhood’ mode in others.

Approximate
Bayesian posterior
distribution

This is a combination of "Most Samples" and "Closest to
Neighbors" that attempts to blend the best of both methods.
This is generally shown as the concatenation of the two
component rules in implementations.

Uses the predicted
surface depth and
variance

This attempts to avoid problems with local tests by
appealing to a reference surface (e.g., from previous
surveys or low-resolution version of the data constructed by
some other means), and selecting the hypothesis closest
in depth to this reference value. This is intermediate in
speed between "Most Samples" and likelihood methods,
but suffers from the problem that obtaining sufficiently good
predictions of depth to make it worthwhile can be quite
difficult. This is known as ‘Initialization Surface’ in some
implementations.

The default value is "Hypothesis with depth closest to neighbors".

Blunder Minimum

Soundings that deviate from the predicted depth by more than this value are rejected. For example,
if the predicted depth is 210 m and the Blunder Minimum is 10m, all sounds shoal of 200 m (210 m -
10m) will be rejected. Default value is 10 m.

Blunder Percent

Similar to Blunder Minimum, this value operates as a percentage of the predicted depth. For example,
if the predicted depth is 150 m and this value is set to 0.25, then soundings with a depth difference of
37.5 m (150 m x 0.25) will be rejected. Default value is 0.25.
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Blunder Standard Deviation Scale

Deep spikes that are more than Blunder Standard Deviation Scale x Standard Deviation will be
rejected. Default value is 3 standard deviations.

Capture Distance Scale

Sets the horizontal search radius of nodes as a factor of the predicted depth. For example, if the
predicted depth is 75 m and the Capture Distance Scale is 0.05, then all soundings within 3.75 m  (75
m x 0.05) of the node will be captured. Default value is 0.05.
When data is sparse, the default value of 5% of depth may result in capture areas containing no
soundings, leading to holes in the CUBE grid. In this case the Capture Distance Scale parameter
could be increased, to fill in these holes. Of course widening the capture area may also result in some
smoothing, as soundings from different seabed features and depths are combined. [CUBE’s goal is
NOT to do interpolation in the grid, which is properly a downstream process, after the best estimate
has been determined.]

Distance Exponent

The distance exponent is used to control the influence of soundings with distance from the target. The
further a sounding is from the target the less weight it will receive. Typical values range from 1.0 (linear
decrease) to 2.0 (exponential decrease). This inverse distance weighting is used in the following
computations:
1. When inserting points into a node, points that are closer to the node location will receive more
weight.
2. When computing the variance of sounding vertical uncertainty
The default value is 2.0.

Median Filter Queue Length

Sets the length of the median filter queue. The median filter queue is a means to delay any extreme
points (shoal or deep) until the estimator has a more firm grasp on what the likely depth is— the longer
the estimator tracks points, the less likely it is to be distracted by spikes in the data.  The simplest bet
is to turn the queue length down to 1 sample, and then don’t worry about it. If you have a node with
only one sample, it probably shouldn’t be reconstructed anyway. This parameter should always be
set to its default value of 1.

Outlier Upper Limit

If the Median Filter Queue Length is greater than 1, this parameter is used to identify outliers in the
filter queue and remove them before these values are offered to the to the estimator. This parameter
can remove valid data if set too low. This parameter should always be set to its default value of
255.
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Discount Factor

This parameter controls how soon CUBE "forgets" or discounts older measurements. This is NOT
appropriate with this version of CUBE. This parameter should always be set to its default value of
1.0.

Intervention Threshold

This value controls the sensitivity of the estimator to create a new depth hypothesis. This value can
be chosen in the range [0.1, 10.0], with default value 4.0. Setting this value smaller means that 
smaller deviations in depth from the current tracked hypothesis level will be considered significant,
and setting the value higher will allow more variability in depth before the algorithm considers an
alternative hypothesis as being required. As with other variables in this group, changing this parameter
will primarily cause more hypotheses to be generated. Setting this value too small, however, will
result in data that it is appropriate to assimilate being split into multiple hypotheses, with consequent
weakening of the robustness of the algorithm. For most users, the default value should be appropriate;
expert users might decrease this slightly to encourage hypothesis splitting when outliers hover just
above or below the true depth, or where the estimated uncertainty for the soundings is believed to be
too high and cannot be modified by any other means. The default value is 4.0.

Bayes Factor Threshold

The Bayes factor measures the odds of the current model (H0) against the alternative (H1);
conventionally, significant odds in favor of H1are indicated if and only if log Bn ≤ −2 , or Bn ≤ 0.135 ,
and this threshold is the ‘Bayes Factor Threshold’ used in CUBE. The nominal value of 0.135 should
be sufficient for most uses, although it might be revised upwards if the user wanted to construct
hypotheses for smaller magnitude outliers. An upper limit of 1.0 is mandated by theory (otherwise the
evidence is favoring the null hypothesis), although this would be inadvisable since any small difference
between soundings would be considered evidence for a new hypothesis. Generating more hypotheses
is not in itself dangerous, but it is inefficient since the operator has to inspect them all and determine
whether the algorithm picked the correct one for reconstruction. In general, more hypotheses also
makes it more likely that the algorithm will choose the incorrect one since each hypothesis will have
less evidence associated with it. The default value is 0.135.

Run-Length Threshold

The run-length threshold value is the number of sequential samples over which the evidence is
stronger for the alternative than the null hypothesis before the algorithm considers a new hypothesis is
required for subsequent data. The new hypothesis is constructed from the data point being tested for
assimilation. The default value is 5 samples on a range of [1,10]. This choice is essentially arbitrary,
and there is a trade-off between choosing a small value where many hypotheses are generated, but
each avoids any damage from outlier sequences, and a large value where fewer hypotheses will be
created (by this means) but each one may be corrupted by the soundings that are incorporated before
the algorithm detects the trend. For most users, the default value will most likely be sufficient; expert
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users might reduce this value to encourage sharper hypothesis generation with sparse data. The
default value is 5.

Minimum Search Range

When a disambiguation method is based on searching for neighbors, this is the minimum distance
between the node and the start of the search (in map units). This value should be scaled to the grid
cell size. The default value is 5.0 m.

Maximum Search Range

When a disambiguation method is based on searching for neighbors, this is the maximum distance
between the node and the end of the search (in map units). This value should be scaled to the grid cell
size. The default value is 10.0 m.
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Advanced Gridder Settings
- Inverse Distance Weighted

 
The Inverse Distance Weighting (IDS) algorithm is a weighted average interpolator. The values assigned to
each node in the grid are calculated by the weighted average of nearby XYZ points. The weighted average
applied uses the inverse of the distance to each known point when assigning weights.
 
 

 

Maximum Radius

Each input XYZ point will influence grid nodes within the specified maximum radius. This parameter
limits the distance interpolation and extrapolation will occur. It is recommended to start with a
maximum radius that is about 5 times the node spacing of the grid and make adjustments from there.
Default value is 5.0.
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Power Parameter

This parameter controls how the weighting factor drops off as distance from a grid node increases for
Shepard's original inverse distance weighting algorithm. Values greater than 2.0 put greater influence
to points close to the grid node. Values less than 2.0 put greater weight on points far away from the
grid node (up to the maximum radius). Default value is 2.0.

Minimum Quadrants

The minimum quadrants parameter is used to limit extrapolation beyond the input data bounds by
preventing a grid node from processing unless it is surrounded on all sides by XYZ points. You specify
the minimum number of quadrants that must have data (1 to 4) for computation to occur. The default
value of 3 requires that at least 3 quadrants must be occupied before the node is processed.

Weighting Method

Select the weighting method used to weight each XYZ point contributing to the node:
Algorithm Weighting Function
Shepard

where:
d(x, xi) is the distance from the node to the
XYZ point
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p is the power parameter
Modified
Shepard

where:
 
R is the Maximum Radius
d(X, Xk) is the distance from the node to the
XYZ point

The default option is to use Shepard's original formula.
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Advanced Gridder Settings - Median
 

The Median Gridding algorithm works by collecting a buffer full of soundings for each node. After the nodes
are filled, the median value of each node is returned.
 
This algorithm is good at rejecting outliers, however it requires that a large number (Maximum Size) of
soundings are stored for each node.
 

Buffer Size

The maximum number of soundings each node will hold. If the sounding buffer is full, adding an
additional sounding will randomly replace one of the existing values in the buffer. This limits the total
memory used by the grid without biasing the results.



Advanced Gridder Settings - Median

1320

Confidence Interval

This setting applies to the optional Uncertainty Grid, if requested. This setting computes the standard
deviation of all samples inserted into each node and then computes a confidence interval based on
a normal distribution. For example, if you want an estimate of the 95% Confidence Interval for each
node, the gridder will return 1.96 x Standard Deviation for each node. Options are: 68%, 90%, 95%
and 99% Confidence Intervals.
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Advanced Gridder Settings
- Preferred Angle Weighting

 
The Preferred Angle Weighting algorithm is a weighted average method that gives more weight to beams
shot with a preferred angle than those that were shot at different angles. This is particularly useful for data
containing shows such as sidescan data. The further away from the preferred angle the less weight the
samples receive.
 

In this diagram, the preferred angle is 45 degrees and the sector size is 90 degrees. Amplitude data from
beams shot at a (map) bearing of 45 degrees will receive the most weight, beams on either side of 45 degrees
will receive decreasing weight. The sector size is the total angular width of acceptable data centered on the
preferred angle. In this example, the sector size is 90 degrees starting at a bearing of 0 and sweeping to an
angle of 90 degrees. Any data from beams shot outside of these bearings will be removed.
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Preferred Angle

Set the angle (map bearing) that will be given the most weight. Beams shot at this bearing will be
given more weight than beams off the preferred angle. The parameter should be a number from [0 ..
360].

Sector Size

Specify a sector size to limit data to only those beams that have a bearing inside the sector. The
sector is centered on the preferred angle and ranges in width from [0 to 360 degrees] where a 0-
degree width sector would eliminate all data and a 360-degree sector will accept all data. The default
value is 360 (accept all data).
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Power Parameter

This parameter controls how the weighting factor drops off as angular distance from the preferred
angle increases. Values greater than 2.0 put greater influence to samples whose beam bearing is
close to the preferred angle. Values less than 2.0 put greater weight on samples whose beam bearing
is far away from the preferred node (up to the sector boundary). Default value is 2.0.
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Advanced Gridder Settings - Trimmed Mean
 

The Trimmed Mean Gridding algorithm works by collecting a buffer full of soundings for each node. After the
nodes are filled, the depth of the node is computed using the following iterative algorithm:
 
1. Compute the Mean and Standard Devation of the node using all loaded soundings
2. Remove soundings that are greater than Outlier Scalar x Standard Deviation from the Mean Value
3. Repeat steps 1 and 2 until the Mean Value and the Standard Error stop changing or the maximum number
of iterations is reached whichever happens first
 
This algorithm is good at rejecting outliers, however it requires that a large number (Maximum Buffer Size) of
soundings are stored for each node
 

Enable outlier rejection check

Check to enable outlier rejection. When this setting is off, Trimmed Mean will not remove outliers.
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Confidence Interval

This setting applies to the optional Uncertainty Grid, if requested. This setting computes the standard
deviation of all samples inserted into each node and then computes a confidence interval based on
a normal distribution. For example, if you want an estimate of the 95% Confidence Interval for each
node, the gridder will return 1.96 x Standard Deviation for each node. Options are: 68%, 90%, 95%
and 99% Confidence Intervals.

Maximum Buffer Size

Sets the maximum number of soundings each node in the grid can hold. If the buffer is full, adding
an addition sounding will randomly replace one of the soundings currently in the buffer. The optional
grid statistics will continue to be updated normally regardless of the number of samples inserted into
each node.

Outlier Scalar

The algorithm will reject soundings that are greater than Error Scalar x Standard Devation from the
mean. Recommended value is 2.0 (2 standard devations from the mean)

Mean Change Epsilon

The algorithm works by iteration. On each iteration, outliers are rejected and the mean and standard
deviation are recomputed. Iteration continues while: (new mean - old mean) / new mean > Mean
Change Epsilon or the maximum iterations is reached. Recommended value is 0.01. (that is, <1%
change in standard mean)

Standard Error Change Epsilon

The algorithm works by iteration. On each iteration, outliers are rejected and the mean and standard
deviation are recomputed. Iteration continues while: (new standard error - old standard error) /
new standard error > Standard Error Change Epsilon or the maximum iterations is reached.
Recommended value is 0.01. (that is, <1% change in standard error)

Maximum Iterations

The algorithm works by iteration. On each iteration, outliers are rejected and the mean and standard
deviation are recomputed. Iteration continues while: the new mean and the new standard error are still
changing or the maximum iterations is reached. Recommended value is 100 iterations.
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Upper Limit

Nodes with a depth value shoal of the Upper Limit will be rejected. Note that nodes are positive down,
negative up.

Cancel button

Close the Advanced Gridder Settings without making changes

OK button

Close the Advanced Gridder Settings, saving changes
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Grid Editor
 
The Grid Editor... command opens the Chesapeake 2D/3D Editor in grid editing mode. This command is
only available for grids that were generated from SonarWiz bathymetry data and is intended for editing the
underlying sounding data that supports the grid.
 
To open the Chesapeake 2D/3D Editor in grid editing mode:
 
1. Select the Edit Grid... command from the Grid File Context Menu in the Project Explorer.
 

 
See Area Editor for more information.
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Interpolate Grid
 

The Interpolate Grid... command is used to smoothly fill small data gaps in girds. The algorithm searches
for blank cells in the input grid and then uses inverse distance weighted interpolation to fill the blank values.
The search radius parameter is used to control how large a gap the interpolation can fill, while the required
quadrants setting can help to reduce unwanted extrapolation beyond the limits of the original grid. The
interpolation only affects blank cells. The Interpolate Grid command is found on the Grid File Context Menu.
 
For example:
 

Before Interpolation (blank cells in the grid are colored black):
 

 
After Interpolation:
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To open the grid interpolation tool:
 
1. Select Interpolate Grid... from the Grid File Context Menu in the Project Explorer
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Search Radius

Set the maximum search radius. If no known values are found within the search radius, the
interpolation will fail and the interpolated node will be set to a blank value.

Exponent

A positive real number, values > 2 assign greater influence to values close to the interpolated point,
values < 2 cause the interpolated values to be dominated by points far away.

Required Quadrants

Set the minimum number of quadrants that must be filled with known values before interpolation will
take place. Requiring 3 quadrants be filled usually will prevent extrapolation of data beyond the limit of
known values. (Acceptable values: 1 - 4).

Output Grid



Interpolate Grid

1331

Full path to the output grid location. The input grid is never modified.

Add Grid to Project

Add the resulting grid to the SonarWiz project.

Open in 3D Viewer

Open the resulting grid in the 3D viewer.

Open Containing Folder

Open the folder containing the output grid in Windows Explorer.
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Contour Grid
 

The Bathymetry Contouring window is opened from the Grid Context Menu or the Bathymetry Exports
Menu... The Contour Grid function allows the user to generate equally spaced contour lines from any grid.

 

Input Grid

Specify the full path to the grid to contour.

Contour Interval

Set the contour interval. The units are the same as the grid.

Contour Resolution
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The resolution affects fidelity with which contours are generated. Larger numbers result in less
detailed contour lines that take up less space.

Contour Simplification

Simplification is the process by which points that do not significantly contribute to the shape of the
feature are removed. Using a larger simplification threshold will result in a smaller data file, however,
the curves in the resulting features will be less smooth. Using a smaller simplification threshold will
result in larger data files that better maintain the integrity of the feature shapes.

Generate areas of iso-depth

Not implemented.

Output Contour Vector

Specify the full path where the output contour file will be written.

Output File Type

Select the output file type.

Add Contours as Map Overlay

When checked, the contour vector file will be added to the project as a Map Overlay.

Open in System Viewer

Not implemented.

Open Containing Folder

Open the containing folder in Windows Explorer.
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Volume Calculator
 

The Grid Difference and Volume Calculator window is opened from the Grid Context Menu command
Volume Calculator... The Grid Difference and Volume Calculator is used to compute differences between two
grids or the difference between a grid and specified depth value. The results are reported as both an output
grid and a text report. The text report contains difference and volumetric statistics resulting from subtracting the
two surfaces.
 
The resulting grid and report are based on the results of subtracting the lower surface (or depth value) from the
upper surface (or depth value). That is:
 
difference grid = upper grid - lower grid
 
The report will be stored in the output grid location and contains statistics about the upper grid, the lower grid,
the difference grid and a computation of the volume change represented by the subtracting the lower surface
from the upper surface.
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Upper Surface group

Specify the grid to use as the upper surface or specify a fixed depth value to use in place of the upper
surface.

Lower Surface group

Specify the grid to use as the lower surface or specify a fixed depth value to use in place of the lower
surface.

Output Grid

Specify the full path to an output grid where the difference (Upper - Lower) grid will be stored. The
text report will be stored with the same path and filename as a text file. The bounds of the lower grid
will represent the intersection of the two grids and the resolution of the output grid will be the higher
resolution of the upper or lower grid.

Add Grid to Project

If checked, add the output grid to the project.

Open in 3D Viewer

if checked, open the output grid in the External 3D Viewer.
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Open Containing Folder

If checked, open the folder containing the output grid and Difference.txt report in Windows Explorer.
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Shaded Relief Image
 

The Export Bathymetry Shaded Relief Image window is opened from the Grid Context Menu command
Shaded Relief Image... The Shaded Relief Image function allows the user to add a shaded relief effect to any
image that overlays a bathymetry grid. For example, to apply a shaded relief effect to a sidescan mosaic or
classified seabed image.

 

Input Elevation Grid

Specify the full path to an elevation or bathymetry grid that overlaps the input image.

Input Image

Specify the input image (for example, sidescan mosaic).

Input Colormap

Specify a colormap for the grid. Clicking browse will open the default palette directory where you can choose a color palette for the
grid shading effect. Gray palettes work best.

Output Image

Specify the full path to save the output image. The output image will combine the input image with a shaded relief effect computed
on the bathymetry surface.
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Grid Depths are Negative

SonarWiz assumes depths are positive down, if depths are negative (typical for elevation grids), check
this box.

Scale Colormap

Check to scale the color palette to the range of the input elevations.

Vertical Exaggeration

Specify the vertical exaggeration to apply before computing the shaded relief effect. Flat terrain
benefits from some vertical exaggeration.

Color Map Stretch

Specify how the colors from the palette will be stretched.

Add Image as Basemap

When checked, add the output image as a basemap layer.

Open in System Viewer

When checked, open the default viewer for TIF files on the output image.

Open Containing Folder

When checked, open the output image folder in Windows Explorer.
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Cross Section Report
 

The Cross Section Report Settings window is opened from the Grid Context Menu command Cross
Section Report...  Cross section reports produce a series of elevation profile graphs at a regular spacing
across a bathymetric surface.

 

Grid File

Specify the grid file. The profile report is generated from the grid elevations.

Restrict to Feature

Specify a polygon feature to restrict the cross-sections only to the areas inside of the polgyon.

Profile Horizontal Resolution

Specify the sample spacing along the profile lines.
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Line Duplication

Cross section profiles can be generated by Line duplication (this section) or Line Generation (next
section). Line duplication works by duplicating an existing line (root line) across the grid to be profiled.
Select an existing Survey Line, Feature Line or Survey Group in one of the provided drop downs, then
specify the number of lines to generate parallel to the selected line. The duplicated lines will be placed
to the left of, to the right of, or on both sides of the root line as selected. The profile report will generate
a profile cross-section at each of the generated lines that intersects the grid file. See also spacing
between lines.

Line Generation

Cross section profiles can be generated by Line Generation (this section) or Line duplication (previous
section). Line generation works by generating a number of parallel lines over the selected grid
file. Specify the line bearing. The profile report will generate a profile cross-section at each of the
generated lines. See also spacing between lines.

Spacing between lines

Specify the Line spacing between cross-section profiles generated by either the line duplication or line
generation options. Optionally, toggle efficient survey pattern to generate profiles with major and minor
line spacing.

Report File Type

Select the Cross Section Report format. Currently, Adobe PDF, HTML, and several Microsoft Office
formats are supported.
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Report Orientation

Select the report page orientation.

Page Size

Select the report page size.

Culture

Select the report language.

Report Title

Enter a title for the cross section report title page.

Title Page Image

Select an image to show on the title page.

Test Settings

The test button will generate a report showing how many profiles will be generated across the grid
using the current settings and how many pages the report will produce:
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Export Grid Files
 

The Export Grid Files window is opened from the Grid Context Menu command Export Grid As... SonarWiz
can export grids loaded into the project into a variety of 3rd party formats. See Export Bathymetry Grid for
more information.

 
 
 



Shaded Relief Image Settings

1343

Shaded Relief Image Settings
 

The Shaded Relief Image Settings window can be opened by clicking Bathymetry Views | Shaded Relief
Settings... from the View menu. The Shaded Relief Image Settings window can be used to control how
shading is applied to bathymetry grids and bathymetry data in the waterfall display. The shaded relief effect is
useful for visualizing elevation data.

 

Enable Shaded Relief

When checked, shading will be applied to bathymetry displays.

Slope Algorithm

Select the slope computation algorithm used for computing the shaded relief effect.
Algorithm Description

Horn After Horn, 1981. Also known as the Queen's case.
Computes the slope of a grid node from its eight
neighbors (excluding the node itself).  This algorithm
performs better on rough terrain.

Zevenbergen and
Thorne

After Zevenbergen and Thorne, 1987. Also known
as the Rook's case. Computes the slope of a grid
node from the four neighbors to North, South, East,
and West (excluding the node itself). This algorithm
performs better on smooth terrain.

Apply Slope Corrections

Combine the shaded relief effect with an aspect effect that tends to reduce noise in low-slope areas.
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Vertical Exaggeration

Set the vertical exaggeration using the slider bar between 0.1x and 10x .

Light Azimuth Angle

Set the simulated light source azimuth with 0 (north), 90 (east), 180 (south), 270 (west).

Light Elevation Angle

Set the simulated light source elevation with 0 (horizon) to 90 (zenith).
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Grid Merge
 
The Grid Merge window can be opened by clicking Merge Grids... from the Grids Context Menu when 2 or
more grids are selected. The Grid Merge tool is used to merge adjacent bathymetric grids loaded into your
project. 

 
 

To Merge Grids:
1.     Select the Merge Grids... option within the Grids Context Menu in order to open the dialog shown below.
 

 

Grid Selection

Files may be selected individually for inclusion into the output merged grid file.

Merged Grid Properties...

The window will display the cell number and size of the ouput merged grid based on the selection in
the Grid Selection window.

Output Merged Grid File Path
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The full path name as well as file name must be specified in the Output File Name field. By default the
Project Grids directory will be inserted as the full path and the file name of “merged_(name of grid
1_name of grid 2.GRD” will also be inserted. If the Output File Name is not desired then the user may
Browse to an alternate directory and/or alternate file name.

Crop Merged Grid to Polygon

Tool allows you to clip the output merged grid to a map view feature created in the project. All polygon
features created in the project will appear in the drop down menu.

Add Grid to Project

When checked, will add the output merged grid into the current project.

Open in 3D Viewer

When checked, will immediately load the output merged grid into the CTI 3DViewer.

Open Containing Folder

When checked, will open Windows Explorer to the folder where the output .GRD file is stored. By
default, the tool will store the new grid in the Grids folder of the current project.
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Grid and Contour
 

The Grid and Contour Sonar Variable window can be opened by clicking Grid and Contour... from the
Tools menu. The Grid and Contour tool can be used to control how sensor variables including Altitude, Cable
Out, Magnetometer, Reflectivity, Sensor Depth, Water Depth, or external XYZ may be gridded and contoured
in to an ESRI SHP file (and corresponding “solid’surface” view “GRD” file) , an AutoCAD DXF file or Google
Earth KML file.
 

 
To Grid and Contour Data:
1.     Select the Grid and Contour button within the Tools Ribbon Menu in order to open the dialog shown
below.
 

 
 

Output File Name

            The full path name as well as file name must be specified in the Output File Name field. By default the
Project SHP directory will be inserted as the full path and the file name of “variable_ Contours.shp” will also
be inserted. If the            Output File Name or file type default (.SHP) is not desired then the user may Browse
to an alternate directory and/or alternate file name.
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           Note that when an ESRI SHP file is created, showing the isopach-type contour lines of your variable,
so is a companion <file_name>.GRD file created and saved in the same SHP folder of your project. A GRD
file like this,                       presents as more of a solid-surface view of the same data, and may be viewed
either by importing into SonarWiz as a MAP view BASEMAP (Map Manager | Add Basemap), OR it may be
imported into the CTI3DViewer (Files |              Load Grid). Using the View | Bathymetry | Depth Scale, you
can control the USER-DEFINED depth range min/max values, and in so doing, control the colors shown in
your GRD displayed file.  These are extremely communicative            data-display options for you to try and
consider.

Grid and Contour Variable

Used to select the variable to grid and contour. Note that Altitude+Sensor Depth can really help map
a seafloor. Altitude is the sensor height ABOVE the seafloor, and is updated in the CSF file when you
bottom-track. Sensor Depth can be manually entered, or read from a depth-sensor on a towfish or
echosounder, and is the depth in meters BELOW the sea surface, of your sensor. Together they add to
the total water depth.

Contour Interval

Used to write contour interval of output file. For Altitude, Cable Out, Sensor Depth, and Water Depth
contour interval is in integer meters. For Magnetometer the contour interval is in integer gammas.

Z Scale

Allows the user to change the sign of (primarily depth) variables to create a grid that can represent
depth or elevation. Depth is a positive number, with larger positive numbers meaning DEEPER. Can
also be used as a scale multiplier for (non DTM) data whose magnitude is too small to be effectively
displayed in its current format.
 
Example 1 – METER intervals: present the contour lines in intervals of 1 METER: use contour interval
= 1.0 and Z scale = 1.0
Example 2 – US FEET intervals: present the contour lines in intervals of 1 US FOOT: use contour
interval = 1.0 and Z scale = 3.28

Grid Tightness

Controls how far from a known data point that a grid cell has to be before it is considered invalid.
Setting to 0.0 assumes all grid points are valid. Small values make the grid form more tightly around
the actual data points.

Clip to Selected Feature
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Tool allows you to clip the grid and contour output file to a map view feature created in the project. All
polygon features created in the project will appear in the drop down menu. This is an excellent tool to
avoid extrapolation of data into regions where the data is too sparse to be reliable.

File Selection

Files may be selected individually for inclusion into the grid file or all files may be selected using the
Check All box.

File Output Type

Used to select the file output type. Options include ESRI Shapefile (SHP with companion GRD file
created in the same folder), AutoCAD DXF, and Google Earth KML.

Data Source

Used to select whether to use data variables from the project or a loaded in external XYZ file. If
external data is selected as the data source, it must be in the same projection as the current project.
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A minus B Comparison Utility
 
The A minus B comparison utility is opened from the Grids Context Menu. The A minus B Comparison
Utility is designed to identify the areas of change between two overlapping grids. The utility assumes that
the two grids were generated from the same instrument. For example, you can compare two overlapping
bathymetry grids or compare two grids of backscatter data. The result is a new grid that highlights areas of
change.
 

 

Compare Surface

Specify the full path to the new surface or grid.

Reference Surface

Specify the full path to the reference surface or grid.

Difference Grid

Specify the full path for the output difference grid. The output grid will indicate which areas in the
Compare Surface have changed compared to the Reference Surface. The larger the change, the
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larger the difference grid value. You can optionally add the output grid to the project, open the output
grid in the 3D Viewer or open the folder containing the output grid.

Max Filter Cell Size

Specify the maximum filter size in meters or in grid cells. The filter helps to reduce noise in the output
difference grid results.

Ignore Threshold

The ignore threshold should contain a number between 0 and 100. The ignore threshold will blank
areas of the Difference Grid that contain change too small to be of interest. A value of 0 will show
the entire difference grid. A value of 50 will only show values that are more than 50 percent of the
maximum difference observed.
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Contacts
 

Contacts (also called Targets) provide a means by which the location and characteristics of observed objects
can be captured and saved. Contacts have several important features:
 
1.     Contacts include a portion of the sonar image immediately surrounding them.
2.     Contacts can be captured while a sonar survey is in progress (i.e. in Real-time).
3.     Contact metrics (measurements) may be determined and stored.
 
SonarWiz can capture contacts in Real-time in the Waterfall Display and in post processing in both the Map
View and the Waterfall Digitizing Window.
In all cases, SonarWiz extracts the target imagery at full resolution from the underlying acoustic data file along
with an area that is approximately square, based on the sonar range scale at the target capture point. For
example, if the sonar range is 50 meters, then SonarWiz will generate a 50m x 50m image about the target
capture point. In this process, every single digital sample in both the along track and cross track directions are
used to generate a very high resolution target image.
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How Contacts are Stored
 
When a contact is captured, the contact image file is created under the project folder in the “Targets” sub-
folder. The name of this file is identical to the contact name. The extension will depend on the type of image
selected on the Contact Preferences dialog (.bmp, ,jpg, etc).
 
The contact data are stored in the contact database file (ContactDBR001.DB3, in your project root folder)
which can be found in the root directory of project folder. This database retains a PATH name for the targets
and CSF file folders, so please review the MOVING PROJECTS tech note in the SonarWiz downloads area,
TECH NOTES section, at www.chestech-support.com , to ensure that you are still able to find target image
files, and edit targets (contacts), if you need to MOVE the project.

http://www.chestech-support.com/


Real-time Contact Capture

1354

Real-time Contact Capture
The real time Contact Capture button

 
In order to capture contacts in the Waterfall Display SonarWiz MUST be in recording (Active) mode.
Operating in Real-time implies that all sensors are configured (Configure Sensors toolbar ) and the Waterfall
Display is open.
 
To capture contacts in the Waterfall Display the user may:
 
1.     Left-click the Capture Contact button in the toolbar section of the Waterfall Display and then left-click on
the contact itself in the waterfall; or
2.     Right-click in the waterfall itself and select Capture Contact and then left-click on the contact itself in the
waterfall; or
3.     Double-click on the waterfall at the point of the target
 
After any of the above actions the contact will be created in the project contact database. Subsequently the
contact will be displayed:
 
1. In the Map Window
2. In the Project Explorer under the Contacts branch
3. In the Sonar Contact Strip
 
Below shows the resultant state of a Map Window where the Contact Strip is enabled.
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The new contacts may be edited later “offline” (see next section).
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Post Processing Contact Capture
 

To begin a contact capture session with existing (imported) data:
 

1. Left-click on the Capture Contact   button in the Mapping Toolbar.

2. The cursor will change to a cross-hair   indicating that SonarWiz is in capture mode.
 

 
3. Left-click on the contact location in the in the Map Window. This will launch the Sidescan or the Sub-Bottom
Analysis Window, and the waterfall image will scroll to the point in the waterfall that was clicked on in the Map
Window.
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4. Left-click on the exact contact location. If the contact naming preference has been set to “Prompt”, a
dialog will be displayed for entering the contact name. Otherwise, the contact will be displayed with a name
automatically generated by SonarWiz and added to the list of contacts.
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Contact Manager
 

The Contact Manager is opened by clicking the  icon in the Post Processing Menu, or by selecting
Contact Manager from the Contact Branch Context Menu. The Contact Manager is used to perform operations
on contacts.
 

Contact Display Summary

The Contact Display Summary shows the number of unfiltered contacts in the project and the number
of enabled unfiltered contacts in the project.
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Command Toolbar

The command toolbar provides commands for working with one or more contacts at a time.
Commands that operate on more than 1 contact at a time will be grayed out until you select 2 or more
contacts in the Active Contact List.
 

Command Description
Select All Selects all contacts displayed in the Active

Contact List.
Edit Contact(s) When a single contact is selected, opens the

Contact Editor.
When 2 or more contacts are selected, opens the
Set Attributes on Multiple Contacts window

Delete Contact(s) Delete selected contacts
Sort Contacts Activate the Sort Contacts command
Create from XY file or
Features...

Activate the Create Contacts From XY File
command.

Import Activate the Import Contacts command
Export Activate the Export Contacts command
S-57 Export Activate the Export Contact to S-57 command
Export to GeoTiff Activate the Export Contacts to GeoTiff command
Export to Google
Earth

Activate the Export Contacts to Google Earth
command

Report Generator... Activate the Contact Report Generator command
Backup Contacts Activate the Backup Contacts command
Recompute All Activate the Recompute All command
Recapture Activate the Recapture Contact Image Contact

Editor
Preferences... Open the Contact Options Menu

Active Contact List

The Active Contact List displays all unfiltered contacts in the project. Each contact is listed by name
and position in both geographic and grid coordinates, the source file from which the contact was
captured, whether the contact was on the port or starboard channel, and the contacts User Class 1
category label if assigned.
 
There are 4 check boxes that control how a contact will be displayed:
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Check
Box

Description

Display If checked, this contact is enabled and
will be displayed in the program and will
be provided to commands that act on all
enabled contacts.

Rotate
Label

If checked, the contact label will be rotated
90 degrees

Draw
Label

If checked, the contact label will be
displayed

Draw
Symbol

If checked, the contact symbol will be
displayed

Contact Filter

  
The Contact Filter box allows the user to define a Structured Query Language (SQL) command to
limit the display and operations on contacts to just those contacts that are selected by the command.
These Contact Filter Queries can be saved and retrieved as needed. Only 1 filter query can be active
at a time.
 
The upper box is the edit box where you can enter a new contact filter query command. You can also
use the Build button to launch the Contact Filter Builder dialog for assistance in writing filter queries.
When you are satisfied with the command, click the Apply button to filter the contact list. The query
you just entered will be displayed in the lower Current box to indicate that a filter is active.
 
The lower box shows the Currently enabled filter command (if any). If a filter is active (displayed in the
lower Current box), only the selected contacts will be available in the Active Contact List or anywhere
else in the program including for selection in commands or reports. SonarWiz will indicate that the list
of contacts has been filtered in the project explorer by putting the word (Filtered) next to the Contact
branch and indicating how many contacts were selected by the filter:
 

 
To remove the current filter, select the Remove button and all of the contacts in the project will
reappear. You can Save  and Retrieve filters that you use often using the appropriate buttons.
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Deleted Contacts

  
The Show Deleted Contacts option is a special Contact Filter that will select and display only deleted
contacts. In most ways, these deleted contacts behave just like regular contacts. Select the contacts
that you want to restore and click the UnDelete button. The "undeleted" contacts will be added back
into the project. If you are sure that you want to permanently remove the deleted contacts from the
project click the Purge button. When you are done manipulating the deleted contacts list, uncheck the
Show Deleted Contacts box to restore the Active Contact List window to its normal state.
 
Note: If you want SonarWiz to automatically purge deleted contacts, open the Contact Options Menu
(Preferences button in the Command Toolbar) and uncheck the box "Enable Contact un-Delete".
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Contact Filter Builder
 
The Contact Filter Builder is a tool to assist in creating Contact Filters in the Contact Manager. Filter Queries
are based on Structured Query Language (SQL) syntax. Only the contacts that are selected by the query will
be available in the program when a Filter Query is applied. The goal is to build a predicate (the WHERE clause
in SQL) that makes a factual assertion about the field values that will evaluate to True.
 
Valid Examples:
 
Height >= 0.5
ClickX > 553426.876963 AND ClickX < 554653.374488
 

Fields

The Fields box lists all of the available fields in the Contact Database. Selecting a field in the box
will add that field to Filter Query being built in the Current Query box and it will populate the Distinct
Values box with all values for this field used by existing contacts.
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Logic Operators

The logic operator buttons provide logical operands that are applied to the fields. Clicking an operator
button will add the operator to the Query being build in the Current Query box.

Distinct Values

After selecting a field in the Fields list, the Distinct Values list will populate with all of the unique values
used for this field in the contact database. Clicking a value here will add that value to the Filter Query
being built in the Current Query box.

Current Query

As the filter query is being built up using the Fields, Logic Operators and Distinct Values boxes,
the filter expression is displayed in the Current Query box. When you are satisfied with the query,
select the Run Query command. If you want to clear the query and start over, click the Clear Query
command.

Clear Query

Click to remove the current expression in the Current Query box and start over.

Run Query

Click to apply the current contact filter expression and close the Contact Filter Builder dialog. The
expression will be added to the Current box in the Contact Filter section of the Contact Manager.
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Save Contact Query
 

The Save Contact Query window is opened from the Contact Manager. The window allows the user to save
the active Contact Filter for use at a later time.

 

 

Query Name

Set the name of the saved contact query.

Description

Provide a short description of the contact query.



Retrieve Contact Query

1365

Retrieve Contact Query
 

The Retrieve Contact Query window is opened from the Contact Manager. The window lists previously saved
Contact Queries (see Save Contact Query) from which you may select the desired filter to retrieve.
 

 

Selected Filter

Drop down list to select a saved query.

Filter List

List of saved filters to select.

Filter Description

Description of selected filter.

Filter Predicate

The predicate or where clause of the SQL statement forming the filter.

Delete Filter

Delete the selected filter.
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Set Attributes on Multiple Contacts
 
The Set Attributes on Multiple Selected Contacts window is available from the Contact Manager when 2
or more contacts are selected and the Edit Contact command is activated in the Command Toolbar. You can
adjust labels, colors, symbology, and some user fields. All selected contacts will receive the same settings.
 
To change one or more attributes on a group of contacts:
 
1. Click the Apply check box next to the attribute, or attributes you wish to change
2. Make the setting adjustment (all selected contacts will receive the same value)
3. Click Apply or Cancel as appropriate
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Contact Editor
 
The Contact Editor enables the user to view and enhance the contact image, move the contact location,
make and record contact measurements, and classify the contact by adding text attributes and a description.
The Contact Editor can be opened by:
 
1. Selecting the Contact Editor command from the Contact File Context Menu.
2. Selecting the Edit Contacts command from the Contact Manager.
3. Selecting the Edit Contact button from the Sidescan Analysis Window.
 
NOTE: Prior to editing contacts it is important that navigation, layback and bottom tracking operations be
completed such that positioning and altitude are correct. Once a contact is created and edited, any subsequent
changes in towfish position or altitude will not be automatically applied to existing contacts. (See Recompute
Contact Positions to manually recompute positions, and Recapture Contact Image to manually recapture the
contact image)
 

Capture Information

The Capture Information window displays the the date, time and position of the sonar data at the
selected contact position.
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Contact Image

The Contact Image (also known as the Target Image) is a clip from the sidescan waterfall centered on
the contact position. The user can pan the contact image using the horizontal and vertical scroll bars.
The approximate dimensions of the displayed image are shown in meters (or feet).

Zoom Contact Image

Zoom the contact image up to 5 times using the slider control.

Features in Contact Editor

It is possible to create features directly in the Contact image window. To create a feature in the Contact
image window, select the type of feature you wish to create from the drop down selection. Options
include Point, Line, Rectangle, Polyline, and Circle. Then move the cursor over the image window and
left-click to place the feature over the image as desired. Once the feature is created, it will be listed in
the feature list drop down.
 
To delete a feature entered into the contact window, select the desired feature and click the Delete
Feature button. See Features for more information.

Contact Name

Displays the name of the current contact in the Contact Editor. Use the ellipses button to select a new
contact. The current contact name can be edited in the text box.
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Contact Image Adjustments

The Contact Image Adjustment buttons allow for adjusting the displayed colors of the contact image.
 

Command Description
Histogram
Equalize

Linearizes the number of pixels per gray level in a
bitmap which can be used to
bring out the detail in dark areas of an image

Invert All colors are inverted – strong reflectors are dark
and nil reflectors are light and
vice versa.

Stretch
Intensity

Increases the contrast in an image by centering,
maximizing, and proportioning the
range of intensity values.

Gamma
Correct...

Adjusts the intensity of colors in a bitmap by
changing the gamma constant that is
used to map the intensity values.

Contrast Pixel values on the lighter (higher) half of the tonal
scale are made lighter, and the
pixel values on the darker (lower) half of the tonal
scale are made darker which
results in a larger difference between the two ends
of the scale giving the image an
appearance of greater depth.

Brightness Overall intensity of the image. Too much brightness
can cause the loss of shadows
in an image.

Restore All image enhancements are removed and the
image is returned to its original state.
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Info at Cursor

The Information at Cursor fields display navigation and sonar information for the pixel beneath the
cursor when the cursor is in the Contact Image window.
 

Date and Time
Ping Number Depth

(Fathometer)
Latitude Northing

Longitude Easting
Heading Course

Made Good
Sonar Altitude Ship Speed
Cursor Range

from Sonar
Cable Out

Event Number Magnetometer
Reading

Sonar File Name

Move Contact Position

The Move Contact button allows for repositioning the contact marker within the current contact Image.
To reposition the contact:
1. Select the Move Contact button (or press F2 on the keyboard)
2. Left-click in the Contact Image window
NOTE: the contact editor blocks the user move function on rationalized contacts.

Contact Labeling
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The contact labeling check boxes control how contacts will be labeled in SonarWiz displays and
exports.
Command Description
Draw
Label

Draws the contact label
when checked

Rotate
Label

Rotates the label 90
degrees when checked

Draw
Symbol

Draws the contact
marker when checked

 
The drop down menus can be used to select the vector symbol and color to mark the contact target
location.

Next / Previous Contact

Images of the Previous and Next Contacts in the target queue are shown. The images and
associated buttons will make the next or previous contact active in the Contact Editor.

Target Measurement

  
Contacts may be measured in order to assist with their classification and identification. Four possible
measurements may be made, each of which is
discussed below. In order to measure any one of the four attributes click on the box associated with
the measurement desired, then left-click and drag the mouse from
the start of the measurement to the end.
 

Button Hot Key Description
Length ALT+L Allows the user to measure the longitudinal axis of the

contact.
Width ALT+W Allows the user to measure the width of the contact.
Shadow ALT+S The measurement of the shadow length. Using the

towfish altitude and range to target, the Target height
value is automatically calculated and populated.
Notes:
 
1. The user is constrained to measure shadow in the
across track direction only.
2. The user should measure the longest shadow in
order to determine the highest point of the contact.
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3. If the user decides to measure a particular shadow
of a complex object that is not necessarily the longest
then the > symbol in the Target Height box should be
selected such that readers of any subsequent reports
are aware that the target height may in fact exceed what
is displayed.

Scour ALT+U Targets in an area with current may cause a scour
(depression) to be created around themselves. The size
of the scour may be measured.

Clear  Clears all measurements and returns Target Height to
zero.

 
The F1 function key allows you to measure the length, width and shadow length in succession, without
needing to click the respective buttons between each measurement.
 
NOTES:
1. The contact editor blocks measurement functions on rationalized contacts.
2. Holding the shift key down while making a Length or Width measurement locks the cursor to the
nearest 45 degree angle.
3. See Select Draw Contact Measurements in Editor and Waterfall Views found in Contact Options
Menu to display the measurements as solid lines in the contact editor.

Search for Target

The Search Other Files for this Target command is used to find all data sets which overlap this contact
position and which might provide alternative views of the target. The overlapping data sets, if any are
found, will be opened in their own water fall displays and scrolled to the position of interest where they
can be compared side-by-side with the current contact.

Contact User Entry Boxes

Contacts can be classified and annotated by adding classification text strings into the Class 1 and
Class 2 text boxes. The user can select a predefined classification from the drop-down list, or enter a
new classification by typing into the text field.
 
The predefined classification lists are contained in the ContactAttributes.txt and
ContactAttributes2.txt files stored in the project folder. These files are derived from master list
files in the SonarWiz application folder at the time the project is created. The lists can be edited using
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any text editor such as Notepad. These lists and the master default lists from which they are derived
can be edited from within the Contact Preferences Menu.
 
The Avoid, Mag Anomaly, Block, and Target Description fields are user-defined free form text fields.
 
The Area drop down list allows the user to classify the contact using a pre-defined area description.
The predefined area list is contained in the ContactLocationAreas.txt file stored in the project
folder. This file is derived from a master list files in the SonarWiz application folder at the time the
project is created. The Area list can be edited using any text editor such as Notepad. See the Contact
Options Menu for more information.

Delete Contact

The Delete command will remove the current target from the database.

Export Geotiff

The Export Geotiff command will open the Contact Geotiff Export window and is used to export the
contact currently opened in the Contact Editor to a .TIF while retaining the current zoom level.
 

 
The window has options to choose the output resolution of the .TIF image as well as the name and file
path location where it will be stored. Use the Export button to create the .TIF file.
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Setting Contact Preferences
 
The Preferences command from the Contact Branch Context Menu opens the the Contact Options Menu.
 



Creating Contact Reports

1375

Creating Contact Reports
 
The Contact Report Generator command opens the Contact Report Generator. The Contact Report
Generator is used to build customized contact reports. Open the Contact Report Generator by Right-clicking
the Contact Branch Context Menu in the Project Explorer and selecting the Contact Report Generator...
command.
 
The Contact Report Generator will step the user through three steps:
 
1.  Selecting or Creating a Data Template
2.  Selecting the Report Format
3.  Adding custom Design elements to the report
 
 Each Step in the process is discussed in detail below.
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Contact Report: Data Template
 
The first step of the Contact Report Generator is selecting the data fields that will be exported for each contact.
The data fields are divided into two groups:
 
1. Target Information: this is information SonarWiz automatically recorded at the time the contact was
captured.
2. User Entered Information: this is information that the user entered manually in the Contact Editor.
 
The collection of data fields are stored in a Data Template. The user must select a data template from the
available list. The Default Data Template exports all data fields. If the user wants only speContact Editorthey
can create and save a new data template.
 

Data Template Page

Click the data template button to switch the the Data Template page of the Contact Report Generator.
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Create New Data Template

This button will open the Create Data Template window where you can create a custom data template
with only the desired data fields.

Select Data Template

Select the desired data template. The data template determines which contact fields will be exported.
The Default Data Template lists all available data fields, to customize the list of exported fields, use the
Create Data Template button to create a new data template using only the desired fields.

Target Info

The Target Info box will display automatically captured data fields. The list of fields is determined by
the selected Data Template.

User Entered Info

The User Entered Info box will display data fields entered by the user in the Contact Editor. The list of
fields is determined by the Data Template.

Next Button

Click Next to move onto the Format Selection page of the contact report generator.

Finish Button

Finish modifying the Contact Report and accept default settings for the remaining pages.
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Contact Report: Create Data Template
 
The Create Data Template window is used to create a list of data fields that will be exported by the Contact
Report Generator. To create a new data template, open the Data Template page of the Contact Report
Generator and select the Create New Template button.
 
A Data Template consists of a Name and a list of contact data fields. The data fields can be selected from
either the Target Info group or the User Entered Info group in any combination. Once the OK button is clicked,
the Data Template Name will be displayed in the Data Template list where it can be selected for future contact
reports.
 

Data Template Name

Enter a name for the Data Template.
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Selected Data Fields

Use the mouse to select (check) the fields you want to include in the template. The Target Info box
lists fields that are automatically captured when the contact was selected, the User Entered Info
box lists fields that must be entered manually by the user in the Contact Editor. You can select any
combination of fields to export.

Select All Fields

The Select All check box will check all available data fields.
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Contact Report: Format Selection
 
The second step of the Contact Report Generator is selecting the report format. The report format consists of a
file type and a number of page and format settings. You can select from one of the built in report formats or you
can create a new report format with custom settings.
 

 
 
 

Format Page

Click the Format button to switch the the Report Format page of the Contact Report Generator.

New Report Button
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Click the Create New Report button to save the current report format settings as a new report format.
You will be prompted to specify a name for the new report in the Report Formats List. The current
settings for File Type, Page Setup, Coordinate Format, Image Settings, Measurement Precision and
Culture will be saved so they can be easily selected again in the future.

Report Formats List

The Report Formats box lists all of the named report formats that have been created. To begin with,
there are three named formats and you are encouraged to create new formats with your favorite
selections using the Create New Report button.

File Type

Select the output file type. The Contact Report Generator currently supports 6 output file types for
sidescan, sub-bottom profile and bathymetry contacts: Adobe 2D PDF, Generic HTML, Microsoft
Excel, Microsoft MHTML, Microsoft PowerPoint, and Microsoft Word. For bathymetry contacts only,
the Adobe 3D PDF file type will create 3D point clouds of the selected targets in addition to the contact
image. Each file type contains small and large format templates which determines how many contacts
will be placed on a page. (if supported by the file type).

Page Setup

The Page Setup section determines the page size and orientation.
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Coordinate Format

Specify the output format for geographic coordinates.

Image Settings

Select to optionally draw scale bars on the contact images, and whether or not the image should be
drawn with the most recent ping at the top of the image or at the bottom of the image.

Measurement Precision

Select the output precision of measurement fields.

Language Selection

Contact reports can be generated in English or 9 other supported languages.

Report Description

Add a description of the report format.

Next
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Click the Next button to switch to the Design page of the Contact Report Generator.

Finish

Click Finish to accept the current report format settings and use the default settings for the remaining
pages of the Report Generator.
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Contact Report: Report Design
 
The third and final step of the Contact Report Generator is specifying the report design. The report can contain
an optional title page with title image, a custom background graphic, as well as custom header and footer text.
 

Design Page

Click the Design button to switch the the Design page of the Contact Report Generator.

Title Page

Check Include Title Page to include a title page in the Contact Report. The title page will include a
summary list of the contacts included in the report along with an optional image of your choice. The
image appears below the report title and you can control how wide the image is relative to the width of
the page.
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Page Background Image

If desired, the report will place a background image on each page of the report behind the actual
contact images and data fields.

Page Header Text

If desired, the report generator will add the specified header text to the top each page of the report.
Select the header alignment (left, center or right).

Page Footer Text

If desired, the report generator will add the specified footer text to the bottom of each page of the
report. Select the footer alignment (left, center or right).
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Importing Contacts From Existing SonarWiz Projects
 
The Import Contacts command is found on the Contact Context Menu. The Import Contacts command is
used for importing contacts from an existing SonarWiz contact database into the current project. Existing
contact databases are found in the root folder of SonarWiz projects (currently named ContactDBR001.db3).
Backup contact databases can also be created as a result of running the Backup Contacts command. In either
case, you will be asked to identify the contact database file (DB3 file) and then be presented with the Contact
Import List window from which you can select the contacts to import into the current project:
 

 
 
 

Contact Import List

The Contact Import List will display all of the contacts in the source data base. Contacts that are
eligible for importing into the current project are listed in bold, contacts that cannot be imported into
the current project will be listed in light gray. You will not be able to select ineligible contacts for import.
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The Status column will indicate if a contact is OK for importing or why a contact cannot be imported.
You must put a check next to each eligible contact you wish to import.
 
In order for a contact to be eligible for importing it must meet the following criteria:
 
1. The contact must have a unique name not present in the current project
2. The contact must have a target image (see Contact Image Path)
3. (optional) The contact must have the correct path to the source file. (See Source Data Linkage)

 

Contact Image Path

An contact image is required to import a contact into the current project. SonarWiz will search the
folders specified in the Contact Image Path list, in order, until it finds the associated image. That
image will be copied into the current project if the contact is imported. The user can ADD folders to
search, REMOVE folders to search, or use the UP and DOWN buttons to change the folder search
order. By default, SonarWiz will search for contact images in the following folders:
 
1. The specified folder in the contact database (typical location for contact images in projects that have
not been moved)
2. The root folder of the contact database (typical location for contact images in backuped databases)
3. The Targets folder beneath the root folder of the contact database (typical location for contact
images in projects that have been moved)
 
See the Locate Project Files tool to repair SonarWiz projects with broken image links.

Source Data Linkage

If you wish to edit imported contacts in the current project, you must maintain a link to the source data
from which the contact was captured, otherwise the contacts will be imported READ-ONLY. There are
two options controlled by the Source Data Linkage check box:
 
1. Checked - Use the path to the source file stored in the contact database. In this case, the full path
to the source data must be the same for both the source project and the new project. This is usually
the case if the source project and the new project are located on the same computer and the source
project has not been moved since the contacts were captured.
 
2. Unchecked - Try to re-link the contacts to files in the current project. In this case, SonarWiz will
look for source data with the same base name in the current project. It will be necessary to import the
source data sets into the current project BEFORE trying to import the contacts.
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If the path to the source file cannot be established, the contact will be imported READ-ONLY. Read-
only contacts are identical to regular contacts except that many functions in the Contact Editor will not
be available.
 
See the Locate Project Files tool to repair SonarWiz projects with broken source links.
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Creating Contacts From a
List of Positions or Features

 
The Create Contact From XY File command allows you to create contacts from a list of coordinates in a text
file or a list of point features previously loaded into the project (See Import Features). The Create Contact
From XY File command is found on the Contact Branch Context Menu.
 
Note that the Create Contact From XY File command can capture contacts directly from the coordinates listed
in a text file, but you may find the Import Feature command has a better selection of import file templates
including the ability to read geographic coordinates and templates that allow you to specify the name of the
feature (hence the contact name). Either way, you will return to this command to actually capture the contacts.
 

Get Coordinates From File

To capture contacts from a list of coordinates stored in a text file, click the Choose File button to open
the text file. See Create Contact From XY File Format for more information about how to format the
input file.

Get Coordinates from Point Features

To capture contacts at the location of existing point features in the project, click the Use Project
Point Features button. The feature name will be available as the contact name if it doesn't clash with
existing contacts.
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Source Coordinates List

The Source Coordinates List shows the list of coordinates from the selected file or point features.
Each row lists a single source coordinate (both grid and geographic coordinates for the point are
shown) along with the feature name if present. Only coordinates with check boxes checked will be
converted to contacts. 

Proposed Contacts List

The Proposed Contacts List shows the list of contacts that will be generated based on the enabled
source coordinates. A single source coordinate may generate multiple contacts if the position happens
to overlap with multiple sonar files. The table lists the source coordinate row, the position, the sonar
file that will be captured and the slant range of the point on the line. Only contacts with a check will be
captured during import.

Quick Selection

The quick selection buttons allow you to quickly select all of the proposed contacts or to select none of
the proposed contacts.

Import

Click Import to begin the contact capture process.



Create Contact From XY File Format

1391

Create Contact From XY File Format
 
The Create Contact From XY File command uses the Magnetic File Template engine. Your input file format
must match one of the existing magnetic templates in order to be parsed. At this time, only the grid coordinates
are used (easting, northing) for selecting the contact capture position, all other fields are ignored.
 

File Type

The File Type filter sets the column delimiter expected by the parser. Each field in the format should be
separated by a comma (CSV) or space (TXT) respectively.

File Template

The Magnetic Template Engine supports more than a dozen file formats. The easiest format to write is
the XYZ Mag format:
 
X,Y,Z
554754.4328,4185141.504,9.4861269
554634.9016,4185245.752,8.495249748
554641.3848,4185267.632,8.763933182
554653.6303,4185289.348,8.210435867
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553538.5201,4186463.567,10.95373917
553561.6437,4186464.346,9.885074615
 
The XYZ Mag format consists of 3 columns: Grid Easting (X), Grid Northing (Y), and Intensity (Z). The
header row and the Z column is required for the parser, however the Z value is ignored by the Contact
capture code, so this can be a dummy value. Create a file using the above template and save it with a
CSV extension.
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Exporting Contacts
 
The Export Contacts command will export contact positions and metadata to a file. The Export Contacts
command supports several text and vector outputs, including CAD, GIS and GPX formats. Only enabled
contacts are exported. The Export Contacts command is found on the Contact Branch Context Menu.
 

File Name

Specify the file name for the exported contact data.

File Type

Select the contact export file type from the drop down list. At a minimum, the export formats list the
contact name and position coordinates. Some formats have additional fields that support the export of
mensuration iand classification information and metadata captured with the contact, including the path
names to the target images and source files. There are currently 11 contact export formats supported:
 

Format Name

ASCII CSV Files
(*csv)
AutoCAD (*dxf)

ESRI Shapefile
(*shp)
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FGSI AutoCAD
(*pld)
C and C
AutoCAD (*tdf)
Simple Text File
(*txt)
C and C
Extended (*csv)
C and C MMS
(*csv)
MMS-2008 (*csv)
Freespan Report
(*csv)
GPS Waypoints
(*gpx)

 
NOTE: Attributes in the exported files labeled “AlsoIn_1” through “AlsoIn_5” indicate the other acoustic
files in the project in which a contact position will be found. If a contact location occurs within files
other than the one it was digitized from, an entry (up to 5) will be added for each distinct file which
contains this contact location. This feature satisfies the NOAA mapping requirement where each
reported contact must also be listed with other files that contain this contact.
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Exporting Contacts to S-57 format
 
The Export Contacts to S-57 command allows for NOAA S-57 target generation from SonarWiz target files
using the Obstruction S-57 feature. Exported targets may be combined into one file or each may have a
separate file. Only the enabled contacts are exported. The Export Contacts to S-57 command is found on the
Contacts Branch Context Menu.
 

Feature ID Format

S-57 Feature IDs can be generated using the contact time stamp or a Globally Unique ID (GUID).

Multi-File Output Folder

If generating one S-57 Object file per target, specify the output folder for the files here.

Single File Output Name

If combining all targets into a single output file, specify the output file name here.
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Exporting Contacts to GeoTiff
 
The Export Contacts to GeoTiff command creates georeferenced target images for each enabled contact in
the project. The Export Contacts to GeoTiff command is found on the Contacts Branch Context Menu.
 
Normal contact target images are captured directly from the waterfall display and are not georeferenced,
after running the Export Contacts to GeoTiff command, the Targets folder of the project will contain a GeoTiff
subdirectory where each enabled contact has been converted to a georeferenced tiff. Each image will also
have an acompanying projection file (prj) and an ESRI world file (tfw).
 
Target Image (waterfall view)
Folder: <project folder>\Targets
 

 
Georeferenced Target Image (GeoTiff)
Folder: <project folder>\Targets\Geotiff
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Exporting Contacts to Google Earth
 
The Export Contacts to Google Earth command creates a Google KMZ file for each enabled contact in the
project. The Export Contacts to Google Earth command is found on the Contacts Branch Context Menu.
 
Normal contact target images are captured directly from the waterfall display and are not georeferenced,
after running the Export Contacts to Google Earth command, the Targets folder of the project will contain a
GoogleEarth subdirectory where each enabled contact has been converted to a KMZ file. Each image will also
have an accompanying projection file (prj) and an ESRI world file (pgw).
 
Target Image (waterfall view)
Folder: <project folder>\Targets
 

 
Google Earth KMZ Image
Folder: <project folder>\Targets\GoogleEarth
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Sorting and Renaming Contacts
 
The Sort Contacts command will sort contacts in the project according to the specified geographic or
alphanumeric criteria. Sort Contacts can optionally rename the contacts using the new sorting order. Sorting
contacts by area is useful for visually grouping contacts by location or name for the purpose of editing or
deleting. The contact sort order will also determine the order in which the contacts are exported. The Sort
Contacts command is found on the Contact Branch Context Menu.
 

Sorting Mode

The sorting mode allows you to change the contact sorting order based on the contact geographic
position, the contact name, or the contact distance from a specified corner or specified point  (easting,
northing).
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Rename Contacts

If checked, contacts will be renamed in using the new sorting order.

Rename Scheme

When renaming contacts, specify the root name of the contact and the contact renumbering scheme.
A contact number will be appended to the contact root name according to the starting number value
and the increment. If desired, you can pad out the numbers with leading zeros.
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Backup Contact Database
 
The Backup Contacts command will create a backup of the contact database and contact target images into
the specified directory. This backup can be used to restore contacts into a project using the Import Contacts
command. The Backup Contacts command is found on the Contact Branch Context Menu.
 
Note that the contact database contains the absolute path to the source data set from which the contact was
captured. When the backup contacts are imported into a new project the import command will attempt to
reestablish the linkage to the source data stored in the backup database. If this fails (for example, if the source
data is no longer available), then the contacts will be imported READ ONLY and cannot be further edited.
 

Backup Location

By default, the contacts will be saved in a uniquely named folder under the projects Targets folder.
The name of this folder will be User_<mmdd>_<hhmmss>, where mmdd represent the current month
and day, and hhmmss represent the current time. In this way, successive contact backups can be
made without overwriting previous backups. If desired, you can change the backup location using the
browse button.
 
Note that the folder into which the backup is placed should be empty, both the contact database (DB3
File) and all of the associated contact images will be copied into this folder.
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Rotate Contact Label
The Rotate Contact label command is found on the Contact Context Menu. When activated, toggles the
rotation of the selected contact label by 90-degrees. Note that contact label rotation is also available from the
Contact Manager's Active Contact List.
 
Before Label Rotation:
 

 
After Label Rotation:
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View Selected Contact in Waterfall
 
The View Selected Contact in Waterfall command is found on the Contact Context Menu. This command
allows you to select a contact in the Main Display and open the same contact in the appropriate waterfall
Analysis View.
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Build Line Set Around Contact
 
The Build Line Set Around Contact command is found on the Contact Context menu. This command allows
you to quickly build a survey pattern around a selected contact.
 
To build a Line Set around a contact:
 
1.  Select the contact in the Project Explorer or in the Main Display.
2. Set the Distance Off Target and the Line Length desired in the dialog window.

 
SonarWiz will build a small Line Set around the target as shown in the example below:
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Rationalizing Contacts
 
The Rationalize Selected Contacts command is found on the Contact Context menu when two or more
contacts are selected. Contact Rationalization provides a means to combine multiple contacts into a single
‘rationalized’ new contact. The rationalized contact is assigned the average position of the user-selected input
contacts. The new rationalized contact inherits the image and attributes of the first user selected contact
except for the measurements. For measurements, the default settings assign the new is contact the maximum
height, the maximum shadow and the average width, length and scour of the input contacts. See Contact
Options in Preferences and Settings for more control on how contact measurements are rationalized.
 
Warning: Rationalized Contacts are not updated when the underlying contacts used to create the rationalized
contact are modified.
 
To Rationalize a Selected Contact:
 
1. Hold down the CTRL key to select two or more contacts in the Main Display or in the Project Explorer.

Note: the first contact selected will contribute the contact image and other user-entered attributes.
 
2. Select the Rationalize Selected Contacts command from the Contact Context Menu.
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The Rationalized or Final contact position is the average position of all selected contacts.
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Set Contact Processing Status
 
Set Processing Status command is found on the Contact Context Menu. A Contact has two status states:
Draft or Final. The meaning of these status flags is up to the user.
 

 
Contacts are created with Draft status. The user must change the status manually to Final if desired. Note that
the user can filter contacts based on the Processing Status so that, for example, only Final contacts are shown
in the map window or exported to reports. See Contact Filtering in the Contact Manager for more information.
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Digitizing Freespan Objects
 

Freespan objects are a special category of contacts created by selecting the freespan object. In SonarWiz the
selection is made as a drop-menu, since there are point targets, freespan objects, and polyline linear contacts
to be chosen:
 

 
To capture a freespan target, select the Freespan Target option in the digitizer view and Scroll down into the
waterfall until you see a freespan area – where the pipeline shadow is separated from the pipeline. Next, left-
click (e.g. at tip of red arrow), to locate the middle of the freespan. The dialog to annotate the start and end of
the freespan, and to measure the height of the freespan (as estimated from its shadow) appears:
 

 
Click on “1. Measure Freespan Shadow” then zoom into the waterfall view (left-click in the waterfall, then press
CTRL + mouse-wheel forward roll), then left-click the pipe and hold the click and drag to the shadow, and
release. The shadow height will be captured, based on the shadow length:
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Then click on “2. Pick Freespan Start Point” and do it (top-most point where shadow of freespan first separates
from the pipe). Finally, click on “3. Pick Freespan End Point” and do it (lowest point of freespan, where shadow
merges again with the pipe). As shown in the results below, the length of the freespan will be calculated for
you, once you have identified the start and end points. Click SAVE it you like the results, or CANCEL and start
over.
 

 
To get a good overview of how to capture, and summarize freespan objects with an exported ASCII CSV file
list, or an image-associated contact report, please watch our short tutorial video on the topic of how to digitize
freespan objects, here: https://www.youtube.com/watch?v=JvE3HPCisVQ
 

https://www.youtube.com/watch?v=JvE3HPCisVQ
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Features
 
A feature is a point or area of interest on the sea floor, lake-bed, or shoreline. It will usually be a physical area
or object such as an area of a specific bottom type, a pipeline, shipwreck, rock, scour mark, etc; however, it
may also represent the location of some observed phenomenon.
 
SonarWiz allows the user to digitize features on either the Map Window or the Digitizing View in
postprocessing only. Select the method most appropriate to the type of features being captured.
 
For example, a point feature may be easier to locate on a Digitizing View , but a line feature that spans more
than one sonar swath may be easier to locate on the Map Window. Regardless of which method is used,
the digitized feature will always be displayed on the map. Moreover, while locating a feature on the waterfall
display, a moving cross-hair will show the corresponding location on the map, and vice versa.
 
SonarWiz provides tools for digitizing the locations of features on the mosaic or the sonar waterfall, for tagging
the features with user defined names and descriptions, and for exporting them in a variety of formats.
 
NOTE : Feature digitizing must be done as a post-processing activity after a survey has been completed.
Features cannot be captured in Real-time as the sonar data is being acquired. For sidescan, in order to record
the locations of objects in Real-time the Target Capture tools provided by SonarWiz must be employed (see
Section 5.15 on page 561 ).
 
All digitized features are stored in a single binary file in the project folder. The file name is the same as the
project name with the extension .DIG. Since this is a binary file, it cannot be manually edited. Any attempt to
do so will most likely corrupt the file. All feature editing must be done using the tools provided in SonarWiz
such as the Feature Manager (See Section 5.16.4 on page 639 ).
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Pre-Digitizing Preparation
 

Feature Names and Description Lists
 

When a feature is digitized, it's two primary attributes may be described– name and description which may be
used to sort features, and are included in all export files. These are both character strings that can be entered
manually or selected from a pre-defined list stored in two text files in the project folder. These files are called
FeatureNames.txt and FeatureDescriptions.txt.
 
When a new project is created, default feature list files are created and, in the case of the description list,
populated with example feature descriptions. In the case of feature name, the system provides the option
of having the name generated automatically based on a user specified prefix concatenated to a sequence
number (See Digitized Feature Options Menu).
 
The name and description files can be customized at any time by opening and editing them with any text
editor (e.g. Notepad). Alternatively, they can be edited from within the Digitized Features Options Menu. This
would typically be done at the beginning of a project. Depending on the preference settings, new names and
descriptions will be appended to these files automatically if they are entered manually while digitizing.
 
Automatic Backups
 
Since feature digitizing can be a time intensive process, SonarWiz provides an automatic backup function
to prevent loss of valuable data in the event of accidental file corruption. This is done by copying the project
FeatureData01.cdf file file to a backup folder each time SonarWiz is started. The backup folder is a sub-folder
of the project folder and a unique serial number is appended to the CDF file name so as not to overwrite
previous backups.
 
The backup function is ON by default . The advantage of this is that during active digitizing work, a history
of the work is maintained and can be retrieved in the event that features are accidentally deleted, moved, or
otherwise damaged.
 
Once all features have been digitized, you may want to consider turning the automatic feature backup OFF
in order to prevent the unnecessary accumulation of files in the backup directory. This is also done in the
Digitized Feature Options Menu.
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Digitizing Features in the Map Window
 

To digitize a new feature in the Main Display click Add Feature  button in the Post Processing Menu.
 
To Digitize a New Feature in the Map Window:
 
1. Select the Add Feature from the Post Processing Men
2. Select either Point , Line/Polyline/Polygon , Rectangle or Circle feature from the drop-down list
3. The corresponding Create Feature dialog will be displayed.
4. Modify the Name, Description and Display properties of the feature and click OK
5. Use the mouse and Left click to enter the location of vertices for the feature.
6. Right-click to close the feature.
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Create New Text Feature
 

The Create New Text Features window is available by clicking the Add Feature icon   in the Post
Processing Menu and selecting Point from the drop down list. SonarWiz will open the Create New Text
Feature window allowing you to modify the Name, Description and Display Properties of the new feature and
then the cursor will change to allow you to mark the feature position on the map. Note that Point and Text
features are identical and can be treated interchangeably in SonarWiz.
 

Name

Manually enter or select the feature name from the drop down list. The Feature name is used for
display labels. Feature naming options are controlled by the settings in the Digitized Feature Options
Menu.

Description

Manually enter a feature description or select the description from the drop down list. Feature
description options are controlled by the settings in the Digitized Feature Options Menu.
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Display Options

Toggle to display the feature on the map. Toggle to display the Feature label on the map (uses the
Name field).

Position

Manually edit the position of the Feature. Note that you can also move a Point/Text Feature by
selecting the feature with the mouse and dragging it to the new location (the Edit Text Window must
first be closed).

Drawing Attributes

  
You can modify the way the feature appears on the map display:
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font size of

text labels
Line Style Set the Line Type (not

applicable to Point Features)
Thickness Set the Line Thickness (not

applicable to Point Features)
Save Save drawing attributes to a

named file
Load Load drawing attributes from a

named file
Line Color Set the Line color (not

applicable to Point Features)
Color by
Depth in
Mosaic

(not applicable to Point
Features)
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Create New Polyline Feature
 

The Create New Polyline Features window is available by clicking the Add Feature icon   in the Post
Processing Menu and selecting Line/Polyline/Polygon from the drop down list. SonarWiz will open the Create
New Polyline Feature window allowing you to modify the Name, Description and Display Properties of the new
feature and then the cursor will change to allow you to mark the polyline feature vertices on the map. Right-
click once to stop adding vertices to the feature.
 

Name

Manually enter or select the feature name from the drop down list. The Feature name is used for
display labels. Feature naming options are controlled by the settings in the Digitized Feature Options
Menu.

Description

Manually enter a feature description or select the description from the drop down list. Feature
description options are controlled by the settings in the Digitized Feature Options Menu.
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Display Options

Toggle to display the feature on the map.
Toggle to display the Feature label on the map (uses the Name field).
Toggle to close Polyline Features and turn them into polygons. The first vertex and the last vertex will
be automatically connected to close the polygon.

Position

Polygon positions cannot be edited in the Polygon Edit window. However, you can move any vertex in
a Polyline/Polygon Feature by selecting the vertex with the mouse and dragging it to the new location
(the Edit Polyline Window must first be closed).

Drawing Attributes

  
You can modify the way the feature appears on the map display:
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font size of

text labels
Line Style Set the Line Type
Thickness Set the Line Thickness
Save Save drawing attributes to a

named file
Load Load drawing attributes from a

named file
Line Color Set the Line color
Color by
Depth in
Mosaic

(not applicable to Polyline
Features)
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Create New Rectangle Feature
 

The Create New Rectangle Feature window is available by clicking the Add Feature icon   in the
Post Processing Menu and selecting Rectangle from the drop down list. SonarWiz will open the Create New
Rect Feature window allowing you to modify the Name, Description and Display Properties of the new feature
and then the cursor will change to allow you to mark the rectangle feature vertices on the map. Right-click
once to stop adding vertices to the feature.
 

Name

Manually enter or select the feature name from the drop down list. The Feature name is used for
display labels. Feature naming options are controlled by the settings in the Digitized Feature Options
Menu.

Description

Manually enter a feature description or select the description from the drop down list. Feature
description options are controlled by the settings in the Digitized Feature Options Menu.
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Display Options

Toggle to display the feature on the map.
Toggle to display the Feature label on the map (uses the Name field).

Position

Rectangle feature positions cannot be edited in the Edit Rectangle Feature window. However, you can
rescale, move and rotate the rectangle by grabbing the vertices or sides of the rectangle in the Main
Display with the mouse.

Drawing Attributes

  
You can modify the way the feature appears on the map display:
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font size of

text labels
Line Style Set the Line Type
Thickness Set the Line Thickness
Save Save drawing attributes to a

named file
Load Load drawing attributes from a

named file
Line Color Set the Line color
Color by
Depth in
Mosaic

(not applicable to Rectangle
Features)
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Create New Circle Feature
 

The Create New Circle Feature window is available by clicking the Add Feature icon   in the Post
Processing Menu and selecting Circle from the drop down list. SonarWiz will open the Create New Circle
Feature window allowing you to modify the Name, Description and Display Properties of the new feature and
then the cursor will change to allow you to mark the rectangle feature vertices on the map. Right-click once to
stop adding vertices to the feature.
 

Name

Manually enter or select the feature name from the drop down list. The Feature name is used for
display labels. Feature naming options are controlled by the settings in the Digitized Feature Options
Menu.

Description

Manually enter a feature description or select the description from the drop down list. Feature
description options are controlled by the settings in the Digitized Feature Options Menu.
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Display Options

Toggle to display the feature on the map.
Toggle to display the Feature label on the map (uses the Name field).

Position

Circle feature positions cannot be edited in the Edit Circle Feature window. However, you can rescale
and move the circle by grabbing the vertices or sides of the circle in the Main Display with the mouse.

Drawing Attributes

  
You can modify the way the feature appears on the map display:
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font size of

text labels
Line Style Set the Line Type
Thickness Set the Line Thickness
Save Save drawing attributes to a

named file
Load Load drawing attributes from a

named file
Line Color Set the Line color
Color by
Depth in
Mosaic

(not applicable to Circle
Features)
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Digitizing Features in Sidescan Waterfall Window
 

Features can be captured in the Sidescan Waterfall window which allows them to be linked to a
specific .CSF file in your project. When Features are created in this way, it allows for their postions to be
recomputed when offsets or map corrections are applied similar to contacts.
 
To open the Digitizing View the user may:
 
Select a Sonar File in the Map Window and either:

#       Left-click the Digitizing View button  within the Post processing Ribbon
#       Type Ctrl+D
#       Right-click on the selected sonar file and select Digitize New Features from the pop up menu; or
#       Open the Sonar File Manager, select a line and left-click the Digitize button
 
The options to add a Feature in the Waterfall Window are located in the windows toolbar:
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Feature Manager
 

The Digitized Feature Manager is opened from the Feature Branch Context Menu or by clicking the 
icon from the Post Processing Menu. The Digitized Feature Manager provides access to commands that apply
to Features. Note that many of the functions found on the Digitized Feature Manager are also available in the
Project Explorer.
 

Feature Information

The Feature information windows display the number of features in the project and the number of
enabled features in the project.

Feature List

The Feature List lists the features in the project and allows for some properties to be changed. Each feature in the project is listed
on a separate row within the Feature list section.
 
Column Description
Display Toggles the display of the feature in Map View (Checked

= displayed)
Label Toggles the display of the feature label in the Map View

(Checked = displayed)
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ID The unique id of this feature in the Feature database
Name The user-defined name of the feature
Description The user-provided description of the feature
Acoustic
File

The associated acoustic file for this feature. Only present
if the feature is digitized in the SSS or SBP waterfall view,
SBP Acoustic Reflector window or Contact Manager.

Pts The number of vertices or points in the feature.
 

DXF Export Options

  
DXF Export Options are used in conjunction with the Export SBP DXF Profile command. You can
select the following options:
 

Flag Description
Include Text
Labels

When checked, includes a text label
with each exported feature

Export 3D When checked, features are exported
with depth attributes

Use
Description as
DXF Layer

When checked, uses the description
as the DXF layer name, otherwise,
uses the Feature name

Depths are
Negative

When checked, use heights (positive
up) instead of depths (positive down)

Command Tools

  
The Digitized Feature Manager provides access to tools that can be applied to one or more selected
features. Note that some tools require one or more features to be selected in the Feature List before
the button becomes active.
 

Command Description
OK Accept changes and close the Digitized

Feature Manager
Cancel Close the Feature Manager without

making changes
Delete
Feature(s)

Delete the selected features. (See Deleted
Features below)

Edit
Feature(s)

Open the Edit Features window. Note that
the type of Feature Editor window that will
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open depends on the type of the selected
feature. Options include:
 

Point/Text Feature Editor
Line/Polyline/Polygon Feature Editor
Rectangle Feature Editor
Circle Feature Editor
Reflector Feature Editor

Select All Select all features
Export... Open the Export Features window
Export SBP
DXF Profile

Export SBP profile in DXF format (See
DXF Export Options above)

Import Open the Import Features window
Sort Open the Sort Features window
Backup Create a backup of the feature database.

The backup will be added to the project
Backup folder. (See Important Folders and
Files for more information).

Recompute
All

Recompute the position of feature
vertices. Note that this is only available for
features that list an associated acoustic
file in the Feature List.

Preferences Open the Digitized Feature Options Menu.
 

Deleted Features

  
Deleted Features are not removed from the database, instead they are hidden. The Display Deleted
Features command reveals the hidden "deleted" features giving the user the opportunity to undelete the
features or to purge them from the feature database.
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After toggling the Display Deleted Features check box, the hidden (deleted) features will be added to the
Feature List and highlighted in orange as shown above. Two new command buttons will appear allowing you
to undelete or restore the hidden features to the project or alternatively, to clean or purge the hidden features
from the database (you cannot recover features that have been cleaned from the database).
 

 
Uncheck the Display Deleted Features command to hide the remaining "deleted" features from view.
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Importing Features
 
The Import Features command is found on the Feature Branch Context menu. SonarWiz can import points,
lines and polygons as features provided they are stored in one of the supported import formats. This includes
formats that are easy to create in a text file such as X, Y, Feature Name.
 

 

Import File Name

Type the name of the import file.

Import Template

  
Set the template of the import file to one of the 8 supported custom formats or set the file type to
Standard Vector Files for importing common vector formats such as Shapefiles or KML files.
 

Format Windows
Extension

Description

Name,
Lat, Lon

TXT Simple text format with each
row representing a point (Name,
Latitude, Longitude).

Name, X,
Y

TXT Simple text format with each row
representing a point (Name, Grid
Easting, Grid Northing)
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Marine
Sonic

MKR Marine Sonic Marker Format
(proprietary)

C & C BDR C&C Boundary Files (proprietary)
Fugro BXF Fugro BXF files (proprietary)
Fugro FLF Fugro FLF files (proprietary)
SonarWiz CSV SonarWiz ASCII Text format (See

Export Features command)
Hypack TGT Hypack Target Files (proprietary)
Standard
Vector
Files

DXF,
KML,
SHP

Standard Vector files supported
by SonarWiz (AutoCAD, Google,
ESRI)

 
 

Import Options

For vector formats that support more than one data type, you can limit the import to points, lines or
polygons only as selected.

Import File

Select Open to import the file as a feature, Cancel to close the dialog without importing.
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Exporting Features
 
The Export Features command is found on the Feature Branch Context Menu. The Export Features
command currently supports 18 different export formats including text files, 2D and 3D vector files and
grid surfaces. The export options available depend on the feature type. Simple point, polyline and polygon
(including Circle and Rectangle) features are best exported in text formats or 2D vector files. Subbottom
acoustic reflectors (including reflectors made from the bottom track) have a depth component which can be
used to export 3D reports and formats. Finally, the thickness feature type has several reports available to
export the thickness values down track.
 
By default, SonarWiz will combine all features into a single report or vector file. If the Export Features by Name
option is selected, the user can select only the desired features to export. If more than one feature has the
same name, such as a collection of acoustic reflector fragments, these will be combined together by name. If
you want to create a surface out of a collection of reflector fragments you have digitized, select the name of
the surface and use the XYZ Text export format described below to create a text file containing the positions
and depth to reflector values of each vertex in the collection. You can then grid the file using Create New Grid
command to grid the vertex points into a surface. Similarly, if you want to create a bathymetric surface out
of seafloor reflectors, use the XYZ Text export format and the Export All Seafloor Features to the a single
file option to create a text file, then use the Create New Grid command to interpolate the values into a rough
bathymetric surface.
 
 

Export Feature by Name

Toggle to group features by name. All features with the same name will be exported to a single file.
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Destination Folder

Set the feature export destination folder.

Export Format

Set the export format. See the following chart to determine which export formats are available for each
feature type:
 
 Feature Type  

Export Format Point/Text Polyline Rectangle Circle Reflector Thickness Format Description
ASCII CSV X X X X X X Text file containing

drawing properties,
position and attributes
decimated to every
10th vertex in the
feature. Note: This
format can be
imported directly
into other SonarWiz
projects using the
Import Features
command.

ASCII Simple
Thickness

 

     X X, Y, Thickness, Line
Name

AutoCAD
DXF

 

X X X X X X 3D DXF vector file of
feature

XYZ Text
 

X X X X X X X, Y, Z (positive

down)1

XYZ Topo
Text

 

X X X X X X X, Y, Z (positive up)1

Fledermaus SD
(Ver. 7)

 

X X X X X X 3D SD vector file1

ESRI
Shapefile

 

X X X X X X 2D ESRI vector file
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XYZA
(Amplitude)

Text
 

    X  X, Y, Z, Amplitude

XYTime
(milliseconds)

 

X X X X X X X, Y, Time

(milliseconds)2

XYTime
(seconds)

 

X X X X X X X, Y, Time (seconds)2

AutoCAD DXF-High
Res

 

    X  3D DXF vector file of
feature

3D Feature
Surface

 

 X X X X X Creates Grid file from
z values. Note: If you
intend to bring the
gridder surface back
into the project and
overlay over your SB
data, you will need
to edit the features to
store water column
SV.

SMT X Y
Line Time
Amplitude

 

    X  X, Y, Line, 2-way Time

(s), Amplitude2

SBP Thickness
Detailed

     X Date, Time, Ping,
Name, Lat, Lon, X,
Y, Reflector Depth,
Seafloor Depth

AutoChart SBP
Reflectors

 

    X  Name,Type,X,Y,Depth
From Seafloor

SMT X Y Line Shot
Time Amplitude

 

    X  X, Y, Line, Shot, 2-way

Time (s), Amplitude2

HD ASCII
CSV

X X X X X X Text file containing
drawing properties,
position and all
attributes for every
vertex in the feature.
Note: This format
can be imported
directly into other
SonarWiz projects
using the Import
Features command.
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Time Below Seabed
(milliseconds) Ascii

CSV

    X  X, Y, Line, Shot, Time
Below Seabed (ms)

Time Below MSL
(milliseconds) Ascii

CSV

    X  X, Y, Line, Shot, Time
Below MSL (ms)

Depth Below Seabed
(meters) Ascii CSV

    X  X, Y, Line, Shot, Depth
Below Seabed (m)

Depth Below MSL
(meters) Ascii CSV

    X  X, Y, Line, Shot, Depth
Below MSL (m)

DXF Datum Aligned
Reflectors

    X  Apply datum
alignement before
exporting reflectors as

DXF vectors.4

Notes:
1Point, polyline, rectangle and circle features have the z-value set equal to 0.0.
2The depth of each vertex is converted to time including any vertical offsets like tides or heave.
3All reflector features are combined into 1 file regardless of the feature selection list settings.
4Export will ask for a bathymetry grid to perform datum alignment against.

Z Offsets

  
Toggle to apply offsets to reflector depths depths.

Feature Selection List

Select one or more named features to export. Multiple acoustic reflector fragments with the same
name will be combined in this way into a single export report.
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Group Seafloor Features

Toggle to combine all seafloor features into a single file regardless of their names. This is useful when
exporting bottom tracks into a single XYZ text file for gridding into a bathymetric surface.
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Exporting SBP DXF Profile
 
The Export SBP DXF Profile command is located on the Feature Branch Context menu. This command
exports a 2D DXF vector file of each SBP dataset in the project into the project DXF folder. The DXF files
include all acoustic reflectors for the dataset as well as scale lines and labels and crossing lines. This output is
designed to match up with the 2D image exported by the Batch Image Export command.
 
See Exporting Features for an option to export reflectors in 3D DXF format.
 
Example Output:
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Sorting Features
The Sort Features command is found on the Feature Branch Context Menu. The sort command allows you
to sort the display of features in the Project Explorer based on the feature name, the feature description or the
acoustic file name of associated features. Note that the sort command will remove all features from subgroups.
 

Sort Options

Select the feature property to sort by. The options include feature name, feature description or file
name. The later option is only available for features digitized in SSS or SBP digitizer windows that
have an associated acoustic file name such as acoustic reflector features.

Execute

Click OK to sort the features, Cancel to close the dialog without sorting.
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Backup Features Database
 
The Backup (Features) command is found on the Feature Branch Context Menu. This command creates
a backup of the feature database in the project Backup folder (see Important Folders and Files for more
information on the backup folder).
 
To restore a backup feature database:
 
1. Close SonarWiz.
2. Locate the backup feature database in your project backup folder. The file will be named something like
FeatureData01__BU00XX.cdf (__BU00XX is appended to the file name to differentiate sequential
backups)
3. Rename the backup file to FeatureData01.cdf.
4. Replace the existing file FeatureData01.cdf in the root folder of your project with the backup copy.
5. Re-open SonarWiz.
 
Note: You can also use the Export Features command using the SonarWiz ASCII Text formats and later
restore these features using the Import Feature command.
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Recompute Features Positions
 
The Recompute (Features) command is found on the Feature Branch Context Menu. This command will
update the position of vertices in features that have a linkage established to an acoustic file, such as features
digitized in the sidescan waterfall display, sidescan contact image window or sub-bottom reflectors. Features
digitized in the Main Display or imported from external files are not linked to any particular acoustic data sets
and therefore cannot have their vertex positions automatically recomputed with this command.
 
Note that features that have an acoustic file linkage will display the name of the acoustic file in the Feature
Manager.
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Editing Features
 

The Edit Features command is found on the Feature Context Menu. The Edit Features command opens
the Feature Editor specific to the type of feature selected. Current options include:
 
Point/Text Features open the Text Feature Editor
Line/Polyline/Polygon Features open the Polyline Feature Editor
Rectangle Features open the Rectangle Feature Editor
Circle Features open the Circle Feature Editor
Acoustic Reflector Features open the Reflector Feature Editor
 
Other features such as Seafloor features and Thickness features use the Polyline feature Editor.
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Edit Text Feature
 
The Edit Text Feature window is opened from the Edit Feature command in the Feature Context Menu
when a Text or Point feature is selected. Note that Point and Text features are identical and can be treated
interchangeably in SonarWiz. The Edit Feature window allows you to change the name, description, position
and display properties previously digitized Text and Point features.
 

Name

Change the name of the Point/Text feature. The Name field is used for Feature labels.

Description

Change the feature description.

Display Options

Toggle to display the feature on the map. Toggle to display the Feature label on the map (uses the
Name field)
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Position

Manually edit the position of the Feature. Note that you can also move a Point/Text Feature by
selecting the feature with the mouse and dragging it to the new location (the Edit Text Window must
first be closed).

Drawing Attributes

  
You can modify the way the feature appears on the map display
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font size of

text labels
Line Style Set the Line Type (not

applicable to Point Features)
Thickness Set the Line Thickness (not

applicable to Point Features)
Save Save drawing attributes to a

named file
Load Load drawing attributes from a

named file
Line Color Set the Line color (not

applicable to Point Features)
Color by
Depth in
Mosaic

(not applicable to Point
Features)
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Edit Polyline Feature
 
The Edit Polyline Features window is opened from the Edit Feature command in the Feature Context Menu
when a Polyline/Polygon feature is selected. The Edit Feature window allows you to change the name,
description, and display properties of previously digitized  Polyline and Polygon features.
 

Name

Change the name of the feature. The Name field is used for Feature labels.

Description

Change the feature description.

Display Options

Toggle to display the feature on the map.
Toggle to display the Feature label on the map (uses the Name field).
Toggle to close Polyline Feaures and turn them into polygons.The first vertex and the last vertex will
be automatically connected to close the Polygon.
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Position

Polygon positions cannot be edited in the Polygon Edit window. However, you can move any vertex in
a Polyline/Polygon Feature by selecting the vertex with the mouse and dragging it to the new location
(the Edit Polyline Window must first be closed).

Drawing Attributes

  
You can modify the way the feature appears on the map display
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font size of

text labels
Line Style Set the Line Type
Thickness Set the Line Thickness
Save Save drawing attributes to a

named file
Load Load drawing attributes from a

named file
Line Color Set the Line color
Color by
Depth in
Mosaic

(not applicable to Polyline
Features)
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Edit Rectangle Feature
 
The Edit Rectangle Features window is opened from the Edit Feature command in the Feature Context Menu
when a Rectangle feature is selected. The Edit Feature window allows you to change the name, description,
and display properties of previously digitized Rectangle features.
 

Name

Change the name of the feature. The Name field is used for Feature labels.

Description

Change the feature description.

Display Options

Toggle to display the feature on the map.
Toggle to display the Feature label on the map (uses the Name field).
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Position

Rectangle feature positions cannot be edited in the Edit Rectangle Feature window. However, you can
rescale, move and rotate the rectangle by grabbing the vertices or sides of the rectangle in the Main
Display with the mouse.

Drawing Attributes

  
You can modify the way the feature appears on the map display
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font size of

text labels
Line Style Set the Line Type
Thickness Set the Line Thickness
Save Save drawing attributes to a

named file
Load Load drawing attributes from a

named file
Line Color Set the Line color
Color by
Depth in
Mosaic

(not applicable to Rectangle
Features)
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Edit Circle Feature
 
The Edit Circle Features window is opened from the Edit Feature command in the Feature Context Menu
when a Circle feature is selected. The Edit Feature window allows you to change the name, description, and
display properties of previously digitized Circle features.
 

Name

Change the name of the feature. The Name field is used for Feature labels.

Description

Change the feature description.

Display Options

Toggle to display the feature on the map.
Toggle to display the Feature label on the map (uses the Name field).
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Position

Circle feature positions cannot be edited in the Edit Circle Feature window. However, you can rescale
and move the circle by grabbing the vertices or sides of the circle in the Main Display with the mouse.

Drawing Attributes

  
You can modify the way the feature appears on the map display
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font size of

text labels
Line Style Set the Line Type
Thickness Set the Line Thickness
Save Save drawing attributes to a

named file
Load Load drawing attributes from a

named file
Line Color Set the Line color
Color by
Depth in
Mosaic

(not applicable to Circle
Features)
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Edit Reflector Feature
 
The Edit Reflector Features window is opened from the Edit Feature command in the Feature Context Menu
when a Reflector feature is selected. The Edit Feature window allows you to change the name, description,
and display properties of previously digitized Reflector features.
 

Acoustic Source File

The source subbottom profile on which the reflector is digitized.

Name

Change the name of the reflector. The Name field is used for reflector labels and various export
reports.

Description

Change the reflector description.
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Display Options

Toggle to display the feature on the map.
Toggle to display the Feature label on the map (uses the Name field).

Position

Reflector positions are set when the reflector was digitized and cannot be edited in this dialog.
However, the reflector can be edited in the Acoustic Reflector tab of the SBP Digitizing window for the
source file.

Vertex Sound Velocities

Open the Edit Reflector Vertex Sound Velocities window to change the sound velocity of vertices in the
digitized reflector.

Drawing Attributes

  
You can modify the way the feature appears on the map display
 

Attribute Description
Text Color Set the color of text labels
Text Font Set the font and font size of

text labels
Line Style Set the Line Type
Thickness Set the Line Thickness
Save Save drawing attributes to a

named file
Load Load drawing attributes from a

named file
Line Color Set the Line color
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Color by
Depth in
Mosaic

Color the reflector vertices
using the Bathymetry depth
color scale
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Edit Reflector Vertex Sound Velocities
 
The Edit Reflector Vertex Sound Velocities window is opened from the Edit Reflector Feature window. This
window allows the user to select one or more vertices in the chosen reflector and change the sound velocity
used to compute the reflector depth. Sound velocity set on a vertex will apply to the material column above the
vertex, up to the next reflector or the sensor position. Note that altering the sound velocities on a reflector can
affect the depth of reflectors below.
 

Vertex Selection List

The Vertex Selection List displays each vertex in the reflector. Each row in the list represents a single
vertex and includes columns for the position in geographic and grid coordinates, the sound velocity
used to convert time to depth and the resulting depth of the vertex.
 
You can select one or more rows in the table to modify the sound velocity by holding down the SHFT
or CTRL keys while left clicking with the mouse.

Selection Options

Use the selection buttons here to quickly select all vertices in the reflector or to invert the selected
rows.
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Sound Velocity

Set a new sound velocity to use and hit the Apply button. All selected vertices in the Vertex Selection
List will be updated with the new sound velocity. This will change the depth computation of these
vertices.
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Building Survey Lines in Selected Feature
 
The Build Survey Line in Selected Feature Command is found on the Feature Context Menu. This
command can build a Survey Line set inside any closed polygon feature.
 

 

Base Name

Specify the base name of the Line Set. All lines in the set will begin with this root name.

Line Spacing

Specify the spacing between lines. This option is only available when using a standard line pattern.
See also Efficient Survey Pattern.

Line Bearing

Specify the line compass bearing (degrees east of north).

Efficient Survey Pattern

Toggle to use the Efficient Survey Pattern. The Efficient Survey Pattern uses a major and minor line
spacing instead of a uniform line spacing.
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Efficient Survey Pattern Line Spacing

Specify the major and minor line spacing of the Efficient Survey Pattern.
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Trimming Magnetometer Data to Feature Extents
 
The Trim the Magnetometer Data to Feature Extents command is found on the Feature Context Menu.
This command clip magnetometer data sets that fall outside of the selected polygon feature. Note that this
operation is permanent and cannot be undone.
 
To Trim Magnetometer Data to Feature Extents:
 
1. Enable the Magnetometer Data sets you wish to clip
2. Select the Feature Polygon you will use for clipping.
3. Select the Trim the Magnetometer Data to Feature Extents command from the Feature Context Menu
 
Before Trimming:
 

 
After Trimming:
 



Trimming Magnetometer Data to Feature Extents

1456



Enabling Only Magnetometer Lines Inside Feature Extents

1457

Enabling Only Magnetometer
Lines Inside Feature Extents

 
The Enable Only Magnetometer Lines Inside Feature Extents command is found on the Feature Context
Menu. This command will only enable magnetometer data sets that fall completely within the selected polygon
feature. Magnetometer datasets that fall partially or entirely outside the feature will be disabled (that is,
unchecked in the Project Explorer and hidden from view).
 
To Enable Only Magnetometer Lines Inside Feature Extents:
 
1. Select the Feature Polygon you will use for clipping.
3. Select the Enable Only Magnetometer Lines Insed Feature Extents command from the Feature Context
Menu
 
Before Command:
 

 
Note that the two northern magnetometer lines extend beyond the feature extents.
 
After Command:
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The two northern lines have been turned off in the Project Explorer.
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Trim the Sonar Data to Feature Extents
 
The Trim the Sonar Data to Feature Extents command is found on the Feature Context Menu. This
command has two actions: (1) it will trim sidescan data sets that fall within the boundary of a polygon feature
to the edges of the polygon; and, (2) for data sets that fall completely outside the polygon feature it will take
further action as defined by the user (see options below). Note that to restore data trimmed by this command,
use the Clear Trimming on All Files command.
 

 
Before Trimming:
 

 
After Trimming and hiding files outside of the polygon:
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Action Options

This setting determines what SonarWiz will do with data sets that fall completely outside the feature
polygon used for the Trim command. There are four options:
 
1. Do Nothing
2. Hide Them
3. Remove from the Project, but do not delete CSF files
4. Remove from the Project, delete the CSF files.
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3D Visualization
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Enable 3D View
 

To enable the 3D viewer, select Enable 3D Viewer check box from the View menu. The 3D View is a dockable
window and can be snapped into the main SonarWiz user interface, or it can be dragged out of the main
window and displayed undocked as desired.
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Displaying Data in the 3D View
 

The 3D Viewer can display geo-images, bathymetry, sidescan, sub-bottom profiles, grids and point clouds that
are already loaded into your SonarWiz project.
 
To Display a compatible object in the 3D Viewer:
 

1.     Select the object you want to render in 3D in the Project Explorer
2.     Select the General Tab in the Properties Window
3.     Select Display in 3D View

 
Only objects compatible with the 3D viewer will have the “Display in 3D View” property. Assuming you have
suitable memory, you can render as many objects in 3D as you want.
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3D View Properties
 

To open the 3D View properties dialog, click the options (hamburger) icon in the upper-left corner of the 3D
View window.
 

 
 

The Content section of the 3D Properties window allows you to override the default rendering options of each
object in the 3D scene. The pane is divided into two sections:
 
Manage Scene Data Files. In this section a tree control lists all of the objects selected for rendering in the
scene, grouped by file type. When an object is first added to the scene, it will show a check mark next to its
name indicating that the object is visible in the scene. If you want to temporarily hide an object, uncheck the
object and it will become invisible. You can manipulate whole groups of files by checking or unchecking the box
next to the file type name.
 
Properties. Each object in the 3D scene has associated properties that control how the object will be rendered
in the scene. The table below describes the properties common to most objects.

 
Property Description

Visible Checked if the object is visible in the scene
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Vertical Offset Offset the elevation of the object by the given amount. If the object does
not have elevation data, this value will set the elevation of the object.

Draped Image Select a GeoImage to drape over a grid surface

Transparency Set the level of transparency for an object.
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Tools in the 3D View
 

The 3D scene can be manipulated using the left mouse button to rotate the scene and the mouse wheel
to zoom into and out of the scene. Objects in the 3D View will rendered using the same color scheme and

annotation settings selected in the 2D view. Using the  drop down button opens 3 menus for accessing all of
the display and export tools inside the 3D view.
 

Display:
 

Option Description Image

North Up Moves current view to North Up
Clear Scene Clears all loaded items for the 3D

view
Bounding Box & Scales Toggles bounding box and XY scale

from display
Axes Toggles X,Y, and Z axes from display
Rotation/ Zoom Center Changes mouse/ wheel mode to

rotate and zoom on your cursor
Draw SS as Lines Toggles from a interpolated SS image

to drawing pings
Center on RT Data Moves display to new incoming real-

time data
Focus RT on Vessel Zooms display to new incoming real-

time data
RT Bathymetry Toggles incoming bathymetry data in

real-time
RT Sidescan Toggles incoming SS data in real-time
Sonar Beam Toggles active sonar beam in real-

time
Vessel Toggles vessel image
Waterline Toggles waterline image
 

Export:
 

Option Description Image

Record Video Record a video of all actions inside
the 3D viewer that is saved in
a .WMV file

Export PDF Export a 3D scene PDF with options
to add meta data (Logo, company,
surveyor, etc.)

 
Measurements & Features:
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Option Description Image

Measure Line Turn cursor to line measuring tool
Clear Measurements Clears all drawn measurements from

the 3D view
Capture Feature Turn cursor to 3D feature drawing tool
Show Measurements &
Features

Toggles drawn features and
measurements from the display

Show Annotations
(CTRL + A)

Toggles annotations for
measurements and features

Bring to Top (CTRL + T) Brings measurement and features to
top of 3D image

Annotations on Top
(ALT + T)

Brings annotations to top of 3D image

Only Show Point
Features

Only display 3D point features that
are in the current 3D view bounds

Measurement Color Change the color of measurement
annotations

Feature Background
Color

Change the color of feature
annotations

 
Use the slider to change the vertical exaggeration.
 

 
Alternatively, use the keyboard shortcuts listed in the graph below.
 

Key Description

Left (arrow) Rotate scene counter-clockwise
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Right (arrow) Rotate scene clockwise
Up (arrow) Rotate scene upward
Down (arrow) Rotate scene downward
Page Up Zoom-in
Page Down Zoom -out
Home Decrease vertical exaggeration
End Increase vertical exaggeration
A Slide scene left
W Slide scene up
D Slide scene right
Z Slide scene down
R Reset scene
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External 3D Viewer
 
SonarWiz contains a legacy External 3D Viewer that was the main 3D visualization tool prior to development
of the internal 3D viewer. Many tools in the program still send files to this External 3D Viewer but all items can
also be enabled and displayed in the newer internal 3D viewer using the Display function.
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Exporting Data
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Save Project as Geo Image
 

The Save Project as Geoimage tool will export a georefrenced image of the current data framed in the Map
Window and enabled in the Project Explorer. The exported image will be saved by default in the Geotiff folder
of your SonarWiz project. The maximum size of a standard GeoTIFF or TIFF image is 4 Giga-pixels. SonarWiz
will display a warning message to the user if a TIFF image of more than 4G pixels is to be created. Should the
size of the desired image exceed 4 Giga-pixels, the user should choose an alternate unrestricted format such
as GeoJPG or ERDAS Imagine.  A number of ancillary files specific to each output format are also created in
the export process. For example when exporting a GeoTIFF the files created include dbf, shp, shx, tfw and prj
files are created, regardless of which option is chosen.
 
To use the Save Project as Geoimage tool:
 
1. Select the Export | Save Project as Geoimage... command from the Post Processing Menu.
 

 

Output Image File Name

Enter the full path and name of the Geo Image to be created. By default the project's GeoTiff directory
will appear as the full path.

Output Image File Type

The drop down menu is used to select the output image file type. The following formats are currently
supported for this tool:
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File Type Notes

GeoTiff GeoTiffs with both the embedded georeferencing component and the
associated .tfw ASCII text file.

GeoPNG Creates .png file as well as the associated .pgw ASCII text file.
GeoJPG Creates .jpg file as well as the associated .jgw ASCII text file.
Erdas Imagine Creates .img file.
Windows BMP Creates .bmp file as well as the associated .bpw ASCII text file.
ECW Creates .ecw file as well as the associated .eww ASCII text file.

Recommended for AutoCAD users.
BIL Raster Creates .bil file as well as the associated .blw ASCII text file.
JPEG 2000 Creates .jp2 file as well as the associated .j2w ASCII text file.
National Imagery
Transmission
Format

U.S. Department of Defense (DoD) and Federal Intelligence Community
(IC) suite of standards for the exchange, storage, and transmission of
digital-imagery products and image-related products.

GeoPDF Creates .pdf file.

Output Color Resolution

Used to select the output color resolution.
 
Resolution
Option

Bands Description

8-bit
greyscale

1 band Each pixel in the mosaic is mapped to a monotonically
increasing, 256-shade greyscale color table. This option is
good for exporting amplitude intensity maps.

8-bit
optimized

1 band Each pixel in the mosaic is mapped to a 256-color table
optimized to best reproduce the original colors in the map
view. The colors are in no particular order in the table. This
option is good for exporting color charts and images while
minimizing file size.

24-bit 3 bands Each pixel in the mosaic contains red, green and blue
channels which are used to mix millions of unique colors.
This option exactly matches the colors of the map view
mosaic, but does not support background transparency.

32-bit 4 bands Each pixel in the mosaic contains red, green, blue and
alpha (transparency) channels which are used to mix
millions of unique colors. This option exactly matches
the colors of the map view mosaic, and fully supports
background transparency.

 

Background Color
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Used to select the background color of the exported geoimage. Check the box to make the
background color transparent.
NOTE: Using this option will add 1 band of data to your export to hold the transparency information
(except for the 32-bit option). That is, if you select 8-bit greyscale output and also request the
background to be transparent, you will get a 2-band image. Band 1 will be the 8-bit color palette and
Band 2 will be the alpha (transparency) channel.

Exclude Tiles

When enabled, will not create any tiles where no sonar data is present.

Build Tiles Only

When enabled, will not create the overall stitched mosaic geoimage made up from all the tiles.

Image Smoothing

This function de-speckles high-contrast images but at the cost of a loss of resolution resulting in a
more blurred image. Choices include No Smoothing resulting in no resolution loss from 2x2 up to
10x10 with the largest filter resulting in the highest loss of resolution. Note: this function can easily be
overloaded by a large mosaic.

Image Resolution in Meters/pixel

When enabled, specify image resolution of the exported image in meters per pixel. The information
window to the right of this option automatically calculates the image size and displays the file size in
megabytes.

Image Size in Pixels

When enabled, specify image size in pixels as either same size as the current map view, fit to printer,
or manually configured width and height.
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Grid Lines and Scale

If grid lines or the geographic graticule are enabled, they will be exported in the image. Here you can
specify the grid spacing and the thickness of the lines in the output image tiles.

Disable Compression

Check if you are an AutoCAD user experiencing difficulty importing a compressed GeoTiff.

Crop Image to Feature

A drop-down list of any pre-defined polygon or rectangle features on the Map Window will be available
to be used as a cropping template.

Launch Viewer after Saving

The default image viewer for the current system will be started in order to display the exported GeoTiff.

Output Image Size Window

Displays the current file size of the output geoimage based on the resolution settings selected. Note:
the maximum size of a standard GeoTIFF or TIFF image is 4 Giga-pixels.
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Save Mosaic as Tiles
 
The Save Mosaic as Tiles tool will export georefrenced tiles of the all of the sonar data enabled in the
Project Explorer. The exported images will be saved by default in the Geotiff folder of your SonarWiz project.
The maximum size of a standard GeoTIFF or TIFF image is 4 Giga-pixels. SonarWiz will display a warning
message to the user if a TIFF image of more than 4G pixels is to be created. Should the size of the desired
image exceed 4 Giga-pixels, the user should choose an alternate unrestricted format such as GeoJPG or
ERDAS Imagine.  A number of ancillary files specific to each output format are also created in the export
process. For example when exporting a GeoTIFF the files created include dbf, shp, shx, tfw and prj files are
created, regardless of which option is chosen.
 
To use the Save Mosaic as Tiles tool:
 
1. Select the Export | Save Mosaic as Tiles... command from the Post Processing Menu.
 

Output Tile Base Name

Enter the base name of the tiles exported, will be formatted as SampleRXXXX_CXXXX with rows and
columns.

Tile Map File Format

Specify a vector format for the polygon file that delineates the tile boundaries. The following formats
are currently supported for this tool:
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ESRI Shapefiles (*.shp)
AutoCAD DXF (*.dxf)
Google Earth (*.kmz)

Output Image File Type

The drop down menu is used to select the output image file type. The following formats are currently
supported for this tool:
 

File Type Notes
GeoTiff GeoTiffs with both the embedded georeferencing component and the

associated .tfw ASCII text file.
GeoPNG Creates .png file as well as the associated .pgw ASCII text file.
GeoJPG Creates .jpg file as well as the associated .jgw ASCII text file.
Erdas Imagine Creates .img file.
Windows BMP Creates .bmp file as well as the associated .bpw ASCII text file.
ECW Creates .ecw file as well as the associated .eww ASCII text file.

Recommended for AutoCAD users.
BIL Raster Creates .bil file as well as the associated .blw ASCII text file.
JPEG 2000 Creates .jp2 file as well as the associated .j2w ASCII text file.
National Imagery
Transmission
Format

U.S. Department of Defense (DoD) and Federal Intelligence Community
(IC) suite of standards for the exchange, storage, and transmission of
digital-imagery products and image-related products.

GeoPDF Creates .pdf file.

Output Color Resolution

Used to select the output color resolution.
 
Resolution
Option

Bands Description

8-bit
greyscale

1 band Each pixel in the mosaic is mapped to a monotonically
increasing, 256-shade greyscale color table. This option is
good for exporting amplitude intensity maps.

8-bit
optimized

1 band Each pixel in the mosaic is mapped to a 256-color table
optimized to best reproduce the original colors in the map
view. The colors are in no particular order in the table. This
option is good for exporting color charts and images while
minimizing file size.

24-bit 3 bands Each pixel in the mosaic contains red, green and blue
channels which are used to mix millions of unique colors.
This option exactly matches the colors of the map view
mosaic, but does not support background transparency.
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32-bit 4 bands Each pixel in the mosaic contains red, green, blue and
alpha (transparency) channels which are used to mix
millions of unique colors. This option exactly matches
the colors of the map view mosaic, and fully supports
background transparency.

Output Tile Specifications

Specify the image resolution in meters per pixel and then specify the width, height and overlap of the
tiles in meters. An overlap of 0 means the tiles touch each other but do not overlap.

Export Bounds

Used to adjust the export bounds in which the tiles will be generated. Options include all enabled
sonar data, the current map view, or a specified easting and northing. The refresh limits tool in this
window can be used to set the export bounds after the user zooms in the map window to the prefered
area.

Grid Lines and Scale

If grid lines or the geographic graticule are enabled, they will be exported in the image. Here you can
specify the grid spacing and the thickness of the lines in the output image tiles.

Export Enabled Files Individually

Used to export each enabled file individually, if checked will go file by file and generate tiles.
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Disable Compression

Check if you are an AutoCAD user experiencing difficulty importing a compressed GeoTiff.

Background Color

Used to select the background color of the exported geoimage. Check the box to make the
background color transparent.

Approximate Tile Size Window

Generates an active pixel number and tile size of the output geoimages dependent on the
specifications set in the image resolution and width/height fields. Note: the maximum size of a
standard GeoTIFF or TIFF image is 4 Giga-pixels.

Preview

The preview tiles button allows you to create the vector map boundary file and add it to the project for
inspection before actually creating the image tiles.
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Save Individual Geo Images
 

The Save Individual Geo Images tool will export an individual georefrenced image for each line of data
enabled in the project. The exported images will be saved by default in the Geotiff folder of your SonarWiz
project. The maximum size of a standard GeoTIFF or TIFF image is 4 Giga-pixels. SonarWiz will display a
warning message to the user if a TIFF image of more than 4G pixels is to be created. Should the size of the
desired image exceed 4 Giga-pixels, the user should choose an alternate unrestricted format such as GeoJPG
or ERDAS Imagine.  A number of ancillary files specific to each output format are also created in the export
process. For example when exporting a GeoTIFF the files created include dbf, shp, shx, tfw and prj files are
created, regardless of which option is chosen.
 
To use the Save Individual Geo Images tool:
 
1. Select the Export | Save Individual Geo Images... command from the Post Processing Menu.
 
 

 

Output Image File Type

The drop down menu is used to select the output image file type. The following formats are currently
supported for this tool:
 

File Type Notes
GeoTiff GeoTiffs with both the embedded georeferencing component and the

associated .tfw ASCII text file.
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GeoPNG Creates .png file as well as the associated .pgw ASCII text file.
GeoJPG Creates .jpg file as well as the associated .jgw ASCII text file.
Erdas Imagine Creates .img file.
Windows BMP Creates .bmp file as well as the associated .bpw ASCII text file.
ECW Creates .ecw file as well as the associated .eww ASCII text file.

Recommended for AutoCAD users.
BIL Raster Creates .bil file as well as the associated .blw ASCII text file.
JPEG 2000 Creates .jp2 file as well as the associated .j2w ASCII text file.
National Imagery
Transmission
Format

U.S. Department of Defense (DoD) and Federal Intelligence Community
(IC) suite of standards for the exchange, storage, and transmission of
digital-imagery products and image-related products.

GeoPDF Creates .pdf file.

Output Color Resolution

Used to select the output color resolution.
 
Resolution
Option

Bands Description

8-bit 1 band Each pixel in the mosaic is mapped to the 256-color palette
assigned to the trackline. The colors are in the order used
by the palette file

24-bit 3 bands Each pixel in the mosaic contains red, green and blue
channels which are used to mix millions of unique colors.
This option exactly matches the colors displayed in the
waterfall displays, but does not support background
transparency.

32-bit 4 bands Each pixel in the mosaic contains red, green, blue and
alpha (transparency) channels which are used to mix
millions of unique colors. This option exactly matches the
colors displayed in the waterfall displays, and fully supports
background transparency.

Specify Image Resolution

          Used to set the meters/ pixel resolution for the output geoimages.

Background Color

          Used to select the background color of the exported geoimage.
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Make Background Color Transparent

          Check the box to make the background color transparent.

Disable Compression

          Check if you are an AutoCAD user experiencing difficulty importing a compressed GeoTiff.

Grid Lines and Scale

          If grid lines or the geographic graticule are enabled, they will be exported in the image. Here you can
specify the grid spacing and the thickness of the lines in the output image tiles.
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Save Project as Website
 

The Save Project as Website tool will export the entire processed project to a website, thus allowing non-
licensed and non-technical users access to the full report through their web browsers.

 
To use the Save Project as Website tool:
 
1. Select the Export | Save Project as Website... command from the Post Processing Menu.
 

 

Output File Path

             Enter the full path (file location) of website to be created. By default the project's Web directory will
appear as the full path.

Logo Image

             A logo image (.bmp, .jpg, or .gif formats only) may be inserted into the report, will display in the top
right corner of the web page.

Logo URL
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A link to any website may be added to the report such that clicking on the inserted logo will open a
new browser window to the designated URL.
Be sure to put the full URL starting with “http://”

Company Name

Enter the company name here.

Title

Enter the title of the project here.

Description

Enter the project description and designate whether or not to include this description on every page of
the report.

Color Options

Used to select the background and text color of the output web report.

Link Target Report

If an HTML Target Report was created(see Creating Contact Reports for more information) and is
desired inserted into the website Browse to its location and select it.
Any existing contact HTML reports will from the database and their name(s) inserted here with the
option of including scales (or not) on the target images. The most recently generated contact report is
shown at the top of the list. The last item in the list is an option for not including hyperlinked contacts.

Image Resolution

Select the desired resolution of the output mosaic. The program will automatically choose the size and
number of tiles to be created in the website. The information dialog to the right of this option shows
how many tiles will be created, the total pixel size of the mosaic, the dimensions of each tile, the
dimensions of the mosaic and and the total file size. SonarWiz will limit individual tile size to 16MB.
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Waterfall Image Options

If desired, the user may insert the waterfall images of each sonar file into the website. The Waterfall
Image Annotation button opens the Image Export Options dialog as discussed in Section 5.6.3.5 .

Grid Lines and Scale

If grid lines or the geographic graticule are enabled, they will be exported in the image. Here you can
specify the grid spacing and the thickness of the lines in the output image tiles.
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Export Files to 3D Viewer
 

The Export Files to 3D Viewer tools will export data to the external 3D viewer inside of SonarWiz. Note:
developement has been moved to the newer internal 3D viewer and this external viewer will be retired in future
releases of SonarWiz. See 3D Visualization for more information.
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Export SBP Files to 3D
 

The Export SBP Files to 3D tool will export selected SBP files in the project to the external 3D viewer.
Viewing sub-bottom files in the Map Window can be difficult to conceptualize as SBP files exist in the Y/
Z plane whereas the Map Window displays the X/Y plane. In order to aid the user in “seeing” the third (Z)
dimension SonarWiz can export SBP files to 3D Viewers. See External 3D Viewer for more information.
 
To use the Export SBP Files to 3D tool:
 
1. Select the Export | Export Files to 3D Viewer | Export SBP Files to 3D... command from the Post
Processing Menu.
 

 

Output Folder

By default the project's 3DView folder is automatically inserted into this field. Users may select a
different folder if desired.

3D Output View File Format
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By default, the tool will generate an .XYZ file that is compatible with the external 3D viewer inside
of SonarWiz. The Fledermaus .SD option generates the output images in the IVS3D Fledermaus
proprietary .SD format such that they SBP files may be viewed in the Fledermaus or the freeware
iView4D application.

Fledermaus .SD File Options

Used to select options pertinent to the Fledermaus .SD file exports. Users can aggregate all data
exported into a single .SD file and choose whether v6 or v7 .SD format is exported.

Export Coordinates as Latitude/Longitude

If checked, will export coordinates as latitude/ longitude. If unchecked, will export easting and northing.

SBP Files Selected for Export

Used to select the SBP files desired to export to 3D viewer.

Annotations Options

See Annotation/ Display Options Window for more information.

Launch Application when Complete

If checked, will open the selected 3D viewer after the image is compiled.

Make Water Column Transparent

If checked, will blank all data above the bottom track of SBP files and display it transparent in the 3D
viewer.

Open Last Scene...

Opens the 3D Viewer with the last set of files that were viewed.
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Export SSS Files to 3D
 

The Export SSS Files to 3D tool will export selected SSS files in the project to the external 3D viewer. See
External 3D Viewer for more information.
 
To use the Export SSS Files to 3D tool:
 
1. Select the Export | Export Files to 3D Viewer | Export SSS Files to 3D... command from the Post
Processing Menu.
 

 

Output Folder

By default the project's 3DView folder is automatically inserted into this field. Users may select a
different folder if desired.

Optional Grid File

Grid files (.GRD format) from Surfer 7/8 or those created in the SonarWiz may be imported into the
CTI3DViewer program. For example, to see your data as a “surface” rather than a set of isopach-type
contour lines.

Optional Geo-refrenced Image File

GeoTiff images may be inserted into the output image file. As the GeoTiff exists in the X/Y plane, the
elevation where the image is to be “anchored” may be specified such that it does not interfere with
optimal viewing of the 3D files.
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Draw Map at Elevation

The GeoTiff (if selected) may be projected on to any Z-plane (single depth) in order to achieve a
separation between the SBP imagery and the map such as putting the map below the SBP imagery
rather than on top.

Annotations Options

See Annotation/ Display Options Window for more information.

Open Last Scene

Opens the 3D Viewer with the last set of files that were viewed.
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Export Mosaic to Google Earth
 

The Export Mosaic to Google Earth tool will export a georefrenced image to Google Earth. Mosaic images
may be exported to Google Earth by first exporting the image in the Map Window to a GeoTiff (See Save
Project as Geo Image) and then selecting Export Mosaic to Google Earth. In order to use the Export to Google
Earth function the Google Earth Program must be installed.
 
To use the Export Mosaic to Google Earth tool:
 
1. Select the Export | Export Mosaic to Google Earth... command from the Post Processing Menu.
 

Image File

             This is the GeoTiff that must be created prior to opening this dialog (See Save Project as Geo Image
for more information)

Refer to URL

             A link to any website may be added to the report such that clicking on the inserted logo will open a
new browser window to the designated URL.

Note: be sure to put the full URL starting with “http://”

Project Title

Enter the project title here.
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Project Desctiption

Enter the project description here.

Image Background Transparent

Used to toggle making image background transparent for Google Earth, recommended using a color
not present in color histogram. This function converts the Tiff to a Png which is a format that supports
the notion of transparency and is a useful option when you wish to see only the mosaic against the
Google Earth backdrop.

Launch Upon Completion

Once the export is complete, this function will open Google Earth installed on your machine and zoom
to the selected georefrenced image.
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Capture Screen Image
 

The Capture Screen Image tool will copy the current map view to the clipboard.
 
To use the Capture Screen Image tool:
 
1. Select the Export | Capture Screen Image... command from the Post Processing Menu.
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Bathymetry Exports
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Export Bathymetry XYZ File...
 

The Export Bathymetry XYZ File... tool will export .XYZ files for the enabled bathymetery data in the project.
 

To use the Export Bathymetry XYZ File tool:
 
1. Select the Export | Bathymetry Exports | Export Bathymetry XYZ File... command from the Post
Processing Menu.
 

Field Delimiter

Choose the delimeter option for the output XYZ files. Currently the following formats are supported:
 
<comma>
<space>
<semi-colon>
<tab>

Scale Depth

The exported Z values can be scaled by the user entered field. By default, the value is 1.

Write Datasets into Separate Files

If enabled, will write separate XYZ files for each bathymetry file in the project. User then has the option
to create individual files for each channel.

Output File Path
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Used to write the output file name and path.

Data Export Options

Select either to export all enabled bathymetry files in the project, only the data visible in the map view,
or use currently enabled survey lines to export based on.
 
When using the Use All Enabled Survey Lines option, the user can set the exported profile width in
meters or feet based on the project's coordinate system for the exported XYZ file.

Output Options

This section contains various checkboxes for changing the output format of the XYZ file.
 
- Write Column Headers
- Write Latitude and Longitude instead of Easting and Northing
- Include Amplitude into the XYZ file
- Include Time into the XYZ file
- Include distance from Nadir
- Use 3 digits past the decimal point for position and depth (if available)
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Export Bathymetry Outline...
 
The Export Bathymetry Outline... tool will export a .DXF file that creates an outline of the enabled bathymetry
files in the project.

 
To use the Export Bathymetry Outline tool:
 
1. Select the Export | Bathymetry Exports | Export Bathymetry Outline... command from the Post
Processing Menu.
 

Output File Path

Used to write the output file name and path.

Write Lat/Lon instead of X/Y

When enabled will write Latitude and Longitude instead of Easting and Northing in the output .DXF file.

File Selection
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Used to display and check all bathymetry files currently loaded in the project. Use Check All to export
all bathymetry files in the project. Use Check Enabled to export all bathymetry files currently enabled
in the project.

Export Points or Lines

Used to select either points or lines exported in the output .DXF file.
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Export Bathymetry Grid As...
 

The Export Bathymetry Grid As... tool will export
 

To use the Export Bathymetry Grid As... tool:
 
1. Select the Export | Bathymetry Exports | Export Bathymetry Grid As... command from the Post
Processing Menu.
 

Output Folder

Used to write the output file name and path.

Export File Format

Currently this tool supports exporting the following formats:
 
- Arc Info ASCII Grid
- BIL
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- DOC Mapping Pt , Y, X, Z
- DTED
- DXF 3D Point
- ESRI Geodatabase
- Erdas Imagine IMG
- Float/Grid
- Geosoft Grid
- Global Mapper Grid
- NetCDF
- STL (ASCII)
- STL (Binary)
- Surfer ASCII Grid
- Surfer Binary Grid v6
- Surfer Binary Grid v7
- TerraDepth - Floating Point GeoTIFF (Elevation)
- USGS ASCII DEM
- VRML
- Vertical Geotiff
- Vertical Mapper (MapInfo) Grid
- Vulcan .00t Triangulation
- Windsim GWS
- XYZ ASCII Grid

Export as Latitude/ Longitude

If checked, will export as WGS84 Latitude/ Longitude, unchecked uses Easting/ Northing.

Files Selected for Export

Used to display and check all grids currently loaded in the project. Use Check All to export all grids in
the project.
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Export Bathymetry to LAS File...
 

The Export Bathymetry to LAS File... tool will export the enabled bathymetry data in the project as an LAS
file, the industry-standard binary format for storing airborne lidar data.

 
To use the Export Bathymetry to LAS File tool:
 
1. Select the Export | Bathymetry Exports | Export Bathymetry to LAS File... command from the Post
Processing Menu.
 

XYZ Scaling Factors and Offsets

Used to add scales and offsets to the output XYZ data in the LAS file.

Output LAS File Version

Use the drop down menu to select the export LAS file version. See the LAS file format specifications
for more information.

Output LAS Point Format
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Use the drop down menu to select the export LAS point format. See the LAS file format specifications
for more information.

Write Datasets into Separate Files

If checked, will export individual LAS files for each of the bathymetry data sets in the project. If
unchecked, will write all files into one LAS file.

Output File Path

Used to write the output file name and path.

Record Types to Export

Used to select whether to export all enabled bathymetry files in the project or just the data visible in
the current map view.
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Export Bathymetry Contours...
 

See Contour Grid... for more information.
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Export Shaded Relief Image...
 

See Shaded Relief Image... for more information.



Export Raw Sonar Table as Text...

1504

Export Raw Sonar Table as Text...
 

The Export Raw Sonar Table as Text... tool will export the raw sonar values (or ping headers) from the
enabled bathymetery or lidar files in your project.

 
To use the Export Raw Sonar Table as Text tool:
 
1. Select the Export | Bathymetry Exports | Export Raw Sonar Table as Text... command from the Post
Processing Menu.
 

Write Raw Sample Values

If checked, will write the raw sample values to the exported .txt file. If unchecked, the exported file
writes only ping headers.

Limit Number of Pings

If checked, will limit the number of pings exported to the user entered value.

Record Types to Export

Select whether to export only bathymetry, only lidar, or all records found in the data.

Output Folder

Used to write the output file path for the exported data.
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Export Bathy into Common File Formats...
 

The Export Bathy to Common File Types... tool will export Bathymetry or Lidar files imported into your
SonarWiz project into the choosen file format.

 
To use the Export Bathy to Common File Types tool:
 
1. Select the Export | Bathymetry Exports | Export Bathy to Common File Types... command from the Post
Processing Menu.
 

Output File Type

Currently this tool supports exporting the following formats:
 
- GSF
- HSX

Output Folder

Used to write the output file path for the exported data.

Record Types to Export

Select whether to export only bathymetry, only lidar, or all records found in the data.
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Export Bathymetry Navigation...
 

The Export Bathymetry Navigation... tool will export the navigation and attitude data of all of the enabled
bathymetry data in your project.

 
To use the Export Bathymetry Navigation tool:
 
1. Select the Export | Bathymetry Exports | Export Bathymetry Navigation... command from the Post
Processing Menu.
 

Export Field Delimiter

Use the drop down menu to select the field delimeter for the exported file. Currently the following
formats are supported:
 
<comma>
<space>
<semi-colon>
<tab>

Export Options

This section contains various checkboxes for changing the output format of the navigation file.
 
- Limit the number of pings to X
- Write column headers to the output file
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- Write Latitude and Longitude data instead of Easting and Northing
- Add EOL arrow marker to indicate direction of travel

Export As...

Used to select whether the exported navigation file is separated by bathymetry points or data lines.
Use the drop down menu to select the output file format for the exported file. Currently the following
formats are supported:
 
- ASCII CSV
- AutoCAD DXF
- ESRI Shapefile
- Google Earth KML
- MapInfo MIF/MID
- MapInfo MAP/TAB
- WaSP MAP

File Content

Used to choose whether the output the navigation data into a single file or one file for each bathymetry
line.

Output Folder

Used to write the output file path for the exported data.
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Batch Image Export
 

The Batch Image Export command allows for capturing and exporting the entire waterfall image of a sonar
file as a bitmap, JPEG or Tiff image. The tool is designed to export any number of files in the project with a
single command.
 
Batch Image Export tool can be opened by:
 

1. Clicking the Export | Batch Image Export  icon in the Post Processing menu.
2. Selecting Batch Image Export from the Sidescan Branch Context Menu in the Project Explorer.
2. Clicking the Batch Image Export button in the Sonar File Manager.
 

Output Folder

Select the output folder to store images. By default the Images directory within the current project
folder will be used as the output folder.
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Output Image Type

Select the desired output image format

Export Region

Select the Export Region from the drop down list, or click Regions... to open the Export Regions
window  to define a new region.

File List

Enable (check) the files you wish to export.

Export Resolution

Switch between standard and high resolution export for sidescan images.  Standard is 1024 pixels
wide, High is the full CSF data which is set during file import. See Advanced Sidescan Import Settings
for more information.

Annotation Options

Open the Annotation/Display Options window to set up the desired annotations on the exported
images.

Check Options

Used to quickly select groups of files to export based on channel, data type, or status in the project.
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Export Regions window
 

The Export Region window is opened from the Batch Image Export window. The Export Region window is
used to define a window or region where only the portion of the dataset inside the window will be exported,
data that falls outside the region definition will be trimmed from the exported waterfall images.

 

Region Management

The Region Management portion of the dialog allows you to create New, Copy, Save and Delete region
definitions. Once a definition is created, it will be listed in the drop down here in this window as well as in the main
Batch Image Export window.
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Beginning of Line Definition

The beginning of the region is specified relative to the beginning of the file or it can be defined to begin
before the first Feature, Contact or Core. Specify the distance in units of pings, meters or feet.

End of Line Definition

The end of the region is specified relative the the end of the file or it can be defined to end after the
last feature, contact or core. Specify the distance in units of pings, meters or feet.

Left/top Definition

The left side of the region for sidescan files (the top of the region for sub-bottom files) is specified
relative to the left edge of the file or it can be specified to begin before the first feature, contact or core.
Specify the distance in units of pings, meters or feet.
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Right/Bottom Definition

The right side of the region for sidescan files (the bottom of the region for sub-bottom files) is specified
relative the right edge of the file or it can be specified to end after the last feature, contact or core.
Specify the distance in units of pings, meters or feet.
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Reports
 



Project Summary Report (Sidescan)

1514

Project Summary Report (Sidescan)
 
The Project Summary Report creates a comma separated value (CSV) text report listing metadata about the
sidescan datasets imported into a SonarWiz project. The exported report should open in your default viewer for
CSV files if configured.
 
To create a Project Summary Report:
 
1. Select the Export | Project Reports | Project Summary Report (CSV)... command from the Post
Processing Menu.
2. Select the Report command from the Sidescan Branch Context Menu in the Project Explorer.
 
The report consists of the following columns:
 

Column Description
Vessel Vessel Configuration File applied
File Name Original File
# Pings Number of pings in the file
File Size (MB) Size of file in megabytes
Bits/Sample Original intensity storage format
Recorded By Recording software
File Type Data type of file
Import Gain No longer used
AGC Is Automatic Gain Control applied?
TVG Is Time Varying Gain applied?
BAC Is BAC applied?
AutoTVG Is Automatic Time Varying Gain applied?
EGN Is Empirical Gain Normalization applied?
Layback Is layback computation on?
Min Cable Out Minimum cable out
Max Cable Out Maximum cable out
Pct Cable Out Percent cable out (factor)
Min Sensor Depth Minimum sensor depth
Max Sensor Depth Maximum sensor depth
Offset X Applied easting offset
Offset Y Applied northing offset
Heading Rotation Port Applied port heading rotation angle
Heading Rotation Stbd Applied starboard heading rotation angle
Sheave Offset X Sheave starboard offset
Sheave Offset Y Sheave forward offset
Sheave Offset Z Sheave height above waterline
MapProj Map projection key
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MinX Minimum easting coordinate
MinY Minimum northing coordinate
MaxX Maximum easting coordinate
MaxY Maximum northing coordinate
StartTime File start time
EndTime File end time
StartX Starting easting coordinate
StartY Starting northing coordinate
EndX Ending easting coordinate
EndY Ending northing coordinate
Line Length Line length
Line Bearing (deg) Line bearing in degrees
NOAA GuideLines NOAA guidelines applied?
 Altitude Offset Altitude offset
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First and Last Event Numbers Report
 
The First and Last Event Numbers Report creates a comma separated value (CSV) text report listing
metadata about the event numbers for lines imported into a SonarWiz project. The exported report should
open in your default viewer for CSV files if configured.
 
To create a First and Last Event Numbers Report:
 
1. Select the Export | Project Reports | First and Last Event Numbers Report... command from the Post
Processing Menu.
 
The report consists of the following columns:
 

Column Description
Date Date of the Line
Line Name Name of the Line
First Event Number First Event Number in the Line
Last Event Number Last Event Number in the Line
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Sonar File Summary Report
 
The Sonar File Summary Report creates a comma separated value (CSV) text report listing metadata about
the sonar files imported into a SonarWiz project. The exported report should open in your default viewer for
CSV files if configured.
 
To create a Sonar File Summary Report:
 
1. Select the Export | Project Reports | Sonar File Summary Report... command from the Post Processing
Menu.
 
The report consists of the following columns:
 

Column Description
Line Name Line Name in Project
Start Date/Time Start Date and Time in Unix
End Date/Time End Date and Time in Unix
Start Latitude Starting latitude coordinate
Start Longitude Starting longitude coordinate
End Latitude Ending latitude coordinate
End Longitude Ending longitude coordinate
Start X Starting easting coordinate
Start Y Starting northing coordinate

End X Ending easting coordinate
End Y Ending northing coordinate
Range Range of line in meters
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Sonar Altitude Summary Report
 
The Sonar Altitude Summary Report creates a comma separated value (CSV) text report listing metadata
about the altitude in the sonar files imported into a SonarWiz project. The exported report should open in your
default viewer for CSV files if configured.
 
To create a Sonar Altitude Summary Report:
 
1. Select the Export | Project Reports | Sonar Altitude Summary Report... command from the Post
Processing Menu.
 
The report consists of the following columns:
 

Column Description

Sonar File File path of CSF files in project

Minimum Altitude Minimum altitude value
Maximum Altitude Maximum altitude value
Average Altitude Average altitude value
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Sonar Coverage Report
 
The Sonar Coverage Report creates a .CSV  report listing metadata and a coverage map in .TIF format for
the sonar files imported into a SonarWiz project. The exported report should open in the selected viewer for
CSV files if configured. The coverage report will use the currently applied Nadir Transparency and Adjusted
Displayed Range when making the exported image and calculations.
 
To create a Sonar Coverage Report:
 
1. Select the Export | Project Reports | Sonar Coverage Report... command from the Post Processing
Menu.
2. Select the Coverage Report command from the Sidescan Branch Context Menu in the Project Explorer.
 
The Save Coverage Report dialog mimics the controls and settings in the Save Project as Geoimage. See
Save Project as Geoimage for more information.
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The output coverage map will be placed in the project GeoTiff folder. The default name is <Project
Name>_Coverage.tif.

 
The accompanying coverage report is in CSV format and reports the sonar coverage at 100%, 200% and
>300% for each image tile exported above:
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Magnetic Anomaly Reports
 
Currently displayed magnetic anomalies may be exported to one of three types of reports which are placed
in the project's Mag folder. The types of reports available are HTML, MS Excel, MS Excel w/ Mag Chart, and
PDF.
 
To create a Magnetic Anomaly Report:
 
1. Select the Report... command from the Magnetometer Anomaly List.
 
An example Magnetic Anomalty report with the first exported anomalies.
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Tide and Sound Velocity Report
 
The Tide and Sound Velocity Report opens a window in SonarWiz listing each bathymetry file with the Tide
and Sound Velocity settings applied for a SonarWiz project. The report will highlight bad tide (red) and sound
velocity profiles that do not meet the nearest in time or nearest in distance criteria (yellow).
 
To display a Tide and Sound Velocity Report:
 
1. Select the Report... command from the Tide and Sound Velocity Manager.
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Acoustic File Properties Report
 
The Acoustic File Properties Report opens a window in SonarWiz which lists metadata about the selected
sonar file including channel frequency, polarity, range, coordinate systems, etc.
 
To display a Acoustic File Properties Report:
 
1. Select the Properties command from the Sidescan Import Window.
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Contact Reports
 
The Contact Report Generator is used to create contact reports. Contact reports contain a 2D or 3D images
captured from the sonar data and metadata about the contact that was either automatically generated by
SonarWiz (Target Information) or was added manually in the Contact Editor (User Entered Data).
 
The Contact Report Generator uses two templates to generate a report. The first template, the Data Template
determines which metadata fields will be exported, the second template, the Report Template, controls the
report output format.
 
See Creating Contact Reports for more information.
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Adobe 2D PDF (Contact Report)
 
The Adobe 2D PDF Contact Report Type can contain contacts from sidescan, sub-bottom or bathymetry data
sets.
 
An example Contact Report showing the cover page and first page of contacts reported.
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Adobe 3D PDF (Contact Report)
 

The Adobe 3D PDF Contact Report Type can contain contacts from bathymetry data sets. Sidescan and sub-
bottom contacts are not currently supported.
 
An example Contact Report showing the first page of contacts reported.
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Generic HTML (Contact Report)
 
The Generic HTML Contact Report Type can contain contacts from sidescan, sub-bottom or bathymetry data
sets.
 
An example Contact Report showing the first page of contacts reported.
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Microsoft Excel (Contact Report)
 
The Microsoft Excel Contact Report Type can contain contacts from sidescan, sub-bottom or bathymetry
data sets.
 
An example Contact Report showing the first page of contacts reported.
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Microsoft MHTML (Contact Report)
 
The Microsoft MHTML Contact Report Type can contain contacts from sidescan, sub-bottom or bathymetry
data sets.
 
An example Contact Report showing the first page of contacts reported.
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Microsoft PowerPoint (Contact Report)
 
The Microsoft PowerPoint Contact Report Type can contain contacts from sidescan, sub-bottom or
bathymetry data sets.
 
An example Contact Report showing the first page of contacts reported.
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Microsoft Word (Contact Report)
 
The Microsoft Word Contact Report Type can contain contacts from sidescan, sub-bottom or bathymetry
data sets.
 
An example Contact Report showing the first page of contacts reported.
 



Project SSS Navigation/Offset Report

1533

Project SSS Navigation/Offset Report
 
The Project SSS Navigation/Offset Report creates a comma separated value (CSV) text report listing
metadata about the navigation and offsets of sidescan files imported into a SonarWiz project. The exported
report should open in your default viewer for CSV files if configured.
 
To create a Project SSS Navigation/Offset Report:
 
1. Select the Export | Project Reports | Project SSS Navigation/Offset Report... command from the Post
Processing Menu.
 
The report consists of the following columns:
 
•  Record
•  Ping
•  Date Time
•  Altitude P
•  Altitude S
•  Altitude Average
•  File Heading
•  Ping Heading
•  Covergence
•  Heading Rotation P
•  Heading Rotation S
•  Corrected Heading P
•  Corrected Heading S
•  Corrected Heading Average
•  Lon Start
•  Lat Start
•  Fish X
•  Fish Y
•  File Offset Type
•  File Offset X
•  File Offset Y
•  File Offset PS
•  File Offset FA
•  Layback X
•  Layback Y
•  Layback PS
•  Layback FA
•  Map Correction X
•  Map Correction Y
•  Map Correction PS
•  Map Correction FA
•  Total X
•  Total Y
•  Total PS
•  Total FA
•  Fish X + Total X
•  Fish Y + Total Y
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•  SV Water
•  SV Sediment
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Project SBP Navigation/Offset Report
 
The Project SBP Navigation/Offset Report creates a comma separated value (CSV) text report listing
metadata about the navigation and offsets of sub-bottom files imported into a SonarWiz project. The exported
report should open in your default viewer for CSV files if configured.
 
To create a Project SBP Navigation/Offset Report:
 
1. Select the Export | Project Reports | Project SBP Navigation/Offset Report... command from the Post
Processing Menu.
 
The report consists of the following columns:
 
•  Record
•  Ping
•  Date Time
•  Altitude
•  File Heading
•  Ping Heading
•  Covergence
•  Heading Rotation
•  Corrected Heading
•  Lon Start
•  Lat Start
•  Fish X
•  Fish Y
•  File Offset Type
•  File Offset X
•  File Offset Y
•  File Offset PS
•  File Offset FA
•  Layback X
•  Layback Y
•  Layback PS
•  Layback FA
•  Total X
•  Total Y
•  Total PS
•  Total FA
•  Fish X + Total X
•  Fish Y + Total Y
•  Using Datum Separation
•  File Min. Datum Separation
•  Datum Separation
•  Datum Separation From File Min.
•  Using Sensor Depth
•  File Min. Sensor Depth
•  Sensor Depth
•  Sensor Depth From File Min.
•  Using Swell
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•  Swell
•  Using Heave
•  Heave
•  ((Datum Separation + Sensor Depth)(From Minimum)) - (Swell or Heave)
•  Speed
•  SV Water
•  SV Sediment
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Preferences and Settings
 

The Program Preferences and Settings window is activated by using the Options button within the Quick
Action Toolbar. This dialog contains 10 sub-menus or tabs, each controlling a specific portion of the program
as discussed below.

 

Settings Toolbar
 
The SonarWiz program preferences are divided into 10 subject menus. The subject menus are
accessed by Left clicking the icon to activate the associated menu.
 

Subject Menu Description
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Configure general program preferences (See General Settings
Menu)

Control the file naming, storage location and other file related
settings (See File Options Menu)

Configure settings related to the display and processing of sub-
bottom profiler data (See SBP Options Menu)

Configure sonar contact file formats, naming and related
attributes (See Contact Options Menu)

Configure digitized feature attributes and settings (See Digitized
Feature Options Menu)

Configure real-time navigation plotting settings (See Navigation
Plot Options Menu)

Configure magnetometer post-processing options (See
Magnetometer Options Menu)

Configure swath bathymetry processing options (See
Bathymetry Settings Menu)

Configure default settings for sonar contacts (See Sonar Color
Settings Menu)
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Configure advanced program options. (See Advanced Settings
Menu)

 
 

Settings Controls

When activated, each sub-menu displays it's controls on the right-hand panel.

OK

Accept the changes and close the dialog.

Cancel

Close the dialog without making changes.
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General Settings Menu
 

The General Settings Menu is opened by selecting the General Settings icon  from the
Preferences and Settings window. The General Settings Menu is used to configure general program
preferences.

 

Playback controls

Scans per frame sets the number of pings that are drawn to the display during one scroll operation.
Larger numbers will produce faster scrolling speeds but jerkier appearance.  The Playback Speed
slider bar controls a timer that affects the rate at which pings are read and displayed. Range is 50
to 100 ms. When checked, the Playback file continuously check box will start a file over at the
beginning when when it reaches the end of the file. (See Waterfall Display or File Playback for more
information).

 



General Settings Menu

1541

Time Reference

Select whether UTC or Local time is to be used, as well as whether Julian day is to be used rather
than the date. (See System Information display for more information)

 

Draw File Names

Toggle to label the end of sonar files with the name of the file.

Draw Event Numbers

Label event locations in the map view. (See Events)

Coordinate Display Format

The user may choose one of the following formats for displaying geodetic coordinates:
•  Decimal Degrees: DDD.dddddd
•  Degrees Decimal Minutes: DDD MM.mmmmmm
•  Degrees Minutes Seconds: DDD MM SS.ssssss
 
When checked, the Display latitude/longitude in local datum check box will present geodetic
coordinates using your project coordinate system

otherwise, geodetic coordinates are displayed in WGS-84. The Cursor Information window (see Status Bar)
at the lower-right of the Main Window will indicate local datum projection is in effect with small asterisk marks
next to the displayed coordinates.



General Settings Menu

1542

Project Explorer Settings

Used to toggle between which options to display in the Project Explorer. You can either choose to
choose all folders available or only the ones currently licensed to the user.

Scale Lines

Toggle to enable scale lines in real-time and playback waterfall displays. You can control the scale
interval, color and units. (See  Waterfall Display or File Playback).

Highlight Color

Set the color of the outline of the polygon and Map Scale used to highlight (box-in) the currently
selected sonar file.

Grid Color

Set the color of the XY grid (easting and northing) in the Map Window.

GeoGrid Color

Set the color of the geodetic grid (latitude and longitude) in the Map Window.

Grid Font

Set the font used to label the grid coordinates the Map Window.

Show sidescan annotations

Toggle display of sidescan annotations in the plan view drawing. (See Annotation/Display Options
window)
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Show sub-bottom annotations

Toggle display of sub-bottom annotation in the plan view drawing (See Annotation/Display Options
window)

Annotation Settings

Opens the Annotation/Display Options window.
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Annotation/Display Options Window
 

The Annotations/Display Options window provides controls for annotating and labeling the Sidescan
Analysis Window and Sub-bottom Analysis Window. It can also affect the display of data in the Map Window if
sidescan or sub-bottom annotations are enabled for Map View in the General Settings Menu.
 

Enable Annotations

Toggle to enable annotations in the Sidescan Analysis Window and Sub-bottom Analysis Window

Annotate with...

Select one or more fields to display in each annotation.
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Horizontal Scale Lines Options

Select Draw Horizontal Lines to add range or scale lines to the display. You can annotate the the
range only at the Start of Line (SOL) and End of Line (EOL) or you can specify a range interval in
meters, feet or milliseconds. Range can be measured from the edges of the display or from zero.

Annotation Options

Select the annotation font, font properties, unit of interval, and the label background. Click on the Use
Font button to open the Font Properties dialog.

Draw Grid As Overlay

When enabled, will draw the selected grid file in the Subbottom Analysis window.

Annotation Interval
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SonarWiz will annotate the waterfall display at specified intervals. You can specify the annotation

to occur by ping interval (every nth ping), by event interval (every nth event), by time interval, or by
distance interval. For distance, specify if the distance should be measured from the beginning of the
line (first ping) or from the top of the image or window.

General Image Options

Toggle whether features and core locations should be annotated on the display.

SBP Image Options

A list of the image options that specifically effect SBP files in the digitizer:
 

Option Description

Flip SBP Line with Bearing When enabled, will flip SBP lines that fall in the
span of bearing set by the user. Used to set parallel
survey lines on the same direction. Only available in
the Batch Image Export dialog.

Topo Correction ON When enabled, calculates the vertical offset of the
SBP file based on the below values and applies
it to the image in the digitizer. See Topographic
Corrections for more information.

Apply Swell Filter When enabled, will apply the configured Swell Filter.
This is the offset above/ below the starting elevation
calculated by a low pass filter in the Bottom Track
tab. See Swell Filter for more information.

Apply Heave
Compensation

When enabled, will apply the Heave Compensation.
This is the offset above/ below the starting elevation
measured by a Heave Sensor and needs to be
imported from the raw data to be available.
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Apply Antenna Height When enabled, will apply the Antenna Height. This
is the offset above/ below the starting elevation
measured by a GPS. See Antenna Height for more
information.

Apply Tide Height When enabled, will apply the Tide Height. This is
the offset above/ below the starting elevation that is
caused by a imported tide file. See Importing Tide
Files for more information. NOTE: This needs to be
applied to the CSF files in the SBP Tide and Vertical
Offsets window.

Apply Bathy Grid
Separation

When enabled, will apply the Bathy Grid Separation.
This is the offset above/ below the starting elevation
calculated by taking the difference between the
bottom track and a bathymetry grid. See Bathy Grid
Separation for more information. NOTE: This needs
to be applied to the CSF files in the SBP Tide and
Vertical Offsets window.

 

SSS Image Options

A list of the image options that specifically effect SSS files in the digitizer:
 

Option Description

Speed Correct (SSS Only) SIDESCAN ONLY: If enabled, scale the ping-to-ping
distance so that the horizontal and vertical scale of
the image are approximately the same. Otherwise,
each ping will occupy a single row of pixels in the
waterfall, this usually results in the along-track
resolution of the image being greatly compressed.

Swap Port Stbd Channels
(SSS Only)

SIDESCAN ONLY: Swap the port and starboard
channels in the display

Flip SSS Waterfall images
top to bottom

SIDESCAN ONLY: This option controls whether
the newest data is at the top of the waterfall display
or the newest data is at the bottom of the waterfall
display

Average Filter (SSS Only) SIDESCAN-ONLY: Apply a smoothing window to the
imagery to reduce noise.

Slant Range Correct SIDESCAN ONLY: This option controls whether the
displayed data is slant range corrected.
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File Options Menu
 

The File Options Menu is opened by selecting the File Options icon  from the Preferences
and Settings window. The File Options Menu is used to control the file naming, storage location and other file
related settings.

 

 
 

Log Data Path

Specify the primary and (optional) secondary directory for logging real-time data files. The default
location is the XTF directory under the current protect directory.



File Options Menu

1549

Project Path

Specify where SonarWiz should initially “suggest” looking for existing projects to open and where new
projects will be created.

File Names

SonarWiz can automatically generate file names when the user clicks Record in the Data Recording
toolbar. Automatic file names consist of the Root Name plus a unique Identifier. The Root Name
is fixed for all lines and can be set to a survey identifier number or vessel name (for example). The
unique identifier changes for each line and can be set to one of the following:
•  A sequential number (specify the starting number and increment)
•  The date and time of the start of the line
•  The time at the start of the line
•  The selected survey line name.

Automatic New File

SonarWiz can automatically generate a new file if the existing recording exceeds the specified limits.
In addition, SonarWiz can issue a warning if the disk space falls below the specified alarm level.

File Specific Options

Open the File Type Specific Options window

Overwrite Existing Data Files

When unchecked, the program will fail any attempts to import a file that is already loaded into the
project and prompt the user with an error mesage.

Process Files On Import
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When checked, will process the imported files into the project based on the below Automatic
Processing import settings.

Use CSF V2

When checked, will import files using the CSF V2 format which will be compatible when opened
in versions of SonarWiz previous to 7.03. When using CSF V2, the sample compression methods
located in the Advanced Settings window will no longer be available.

Automatic Processing

When the Process Files on Import box is checked ON, newly imported file will be automatically
processed based on the settings selected. See Automatic Import for more information.



File Type Specific Options window

1551

File Type Specific Options window
 
The File Type Specific Options window can be opened from Set File Type Specific Options button on the
File Options Menu. It is also available from each of the data import tools found on the Post Processing Menu.
The File Type Specific Options window allows you to configure settings that are unique to a particular file
format and cannot be handled in a generic manner.
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Bathyswath Import Options
 

The Bathyswath Import Options are found on the Bathyswath tab of the File Type Specific Options window.
The Bathyswath (formerly Submetrix or SEA SwathPlus) Interferometric sidescan system produces three
native formats: raw (SXR), intermediate (SXI) and processed (SXP). SonarWiz can read sidescan records from
the SXR format and can read bathymetry and backscatter records from the SXI and SXP formats.
 

Select Navigation Source
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The navigation format stored in SXR files must be selected by the user. The format options are
NMEA, Custom, MCOM and POS MV. If the custom tabular format was used you can specify the field
delimiter and the field number of the easting and northing coordinates.

Examine Navigation

The Examine Navigation from SXR File... button will open an SXR file and attempt to parse the
navigation based on the navigation source selection above. If the parsing was successful, you should
see a display of easting and northing coordinates in the output window.

SXP Amplitude Source

The SXP format contains both raw and processed amplitudes. We recommend importing the RAW
amplitudes in most cases.
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CMAX CM2 Import Options
 
The CMAX CM2 Import Options are found on the CMAX CM2 tab of the File Type Specific Options window.
 

Select Position String

CM2 files may contain multiple sources of position. Ping location is assigned by the user-defined
NMEA message selected in the drop-down box.



CODA Import Options

1555

CODA Import Options
 
The CODA Import Options are found on the CODA tab of the File Type Specific Options window.
 

Peek at CODA File

Allows the user to first examine the contents of a .COD file in order to glean the navigation coordinate
system and channel content in use prior to importing.

COD file output

Shows the output of the Peek command.
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Offset Amplitude

Offset the sub-bottom amplitude by the value entered.

Auto-Scale SBP

Apply automatic scaling to SBP amplitudes.

Auto-balance SBP

Apply automatic balancing to SBP amplitudes.
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EdgeTech JSF Import Options
 
The EdgeTech JSF Import Options are found on the EdgeTech JSF tab of the File Type Specific Options
window.
 

Signal Component

JSF stores sonar samples at complex numbers. So, one can choose the real, imaginary or envelope
portion of the complex pair to use when converting to a real number when importing data.
The envelope,
 

 
where e is the envelope value, r is the real component and i is the imaginary component. The
envelope is what most users will require.

Gains

ADC gain from the recorded JSF packet is applied which assists processing Chirp 4125 JSF files (files
recorded by 4125 sonars manufactured after July 2010)



EdgeTech JSF Import Options

1558

Position Source

Select the position source.
 
Most Recent (Group) is EdgeTech stored coordinates
Interpolated (NMEA) are coordinates from the raw GPS data.
Auto picks the best available option which prioitizes the higher resolution NMEA coords.
 
Toggle swap X/Y coordinates if required.
Toggle coordinates in radians if the source does not use degrees.

Magnetometer Channel

Indicates to SonarWiz on which channel to find recorded magnetometer data.

Ping Down sampler

Along-track down-sampling function, to help reduce data volume in over-sampled (high ping rate)
survey data.

Skip First N Pings

Skips past the first N sonar pings in a JSF file. This is useful for skipping past errantly positioned pings
in a JSF file.

Scale Depth

Multiply the sensor depth values by the scale factor.

Override sonar info with NMEA values

This command finds the delta between the first NMEA ZDA or DPT message time stamp and its JSF
packet time stamp. It will add the time delta to all subsequent packets in the JSF file. This is useful if
the computer running Discover was set to a different time zone than the navigation system generating
the NMEA messages or if the packet time stamp is invalid as was the case in some older AUV JSF
files. It converts the JSF file to the same time zone as was used by the navigation system.
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Channel 5 and 6

The Sidescan Channel 5 and 6 selector allows user to tell SonarWiz how to interpret these channels if
they are present in the file
Channel Type Description
Tri-Frequency Imports channel 5 and 6 as very high frequency (VHF) sidescan

data
Gap Fill Imports channel 5 and 6 as gap fill data. The channel that is

actually displayed is controled by the Sidescan Gap Fill setting.
Motion Tolerant Imports channel 5 and 6 as motion tolerant (MT) sidescan data

Sidescan Gap Fill

When importing data from the EdgeTech SSS Gap Filler, the user needs to select which of the
overlapping channels will be brought in to the CSF file. Only applied when importing using Channel 5
and 6 and the reader detects the Gap Filler packets in the raw JSF file.

Heading Source

Select the heading source.
Sonar Ping is the default selection and in this mode, heading information is taken from the heading
value stored in the ping.
DVL, heading is taken from the recorded heading value associated with the Doppler Velocity Log
(DVL) if fitted.
NMEA HDT: heading is taken from the NMEA HDT packet.
Situation: <TODO>
Sonar Ping (unscaled): Heading information is taken from the recorded heading value where the
heading is not scaled to .01 deg (JAMSTEC)
NMEA VTG: heading is taken from the NMEA VTG packet.
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SBP Ping Time Source

Select the ping time source.

Sensor Depth Source

Select the sensor depth source.

Heave Source

Select the heave source.

Event Source

Select the event source.

Write Raw Mag Data

Extract embedded magnetometer data to a file.
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GeoAcoustic GCF Import Options
 
The GeoAcoustic GCF Import Options are found on the GeoAcoustic GCF tab of the File Type Specific
Options window.
 

Amplitude Scalar

GCF Amplitude Scalar may be adjusted in this dialogue in order to control the overall gain of the
GCF data being imported.
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Hypack Import Options
 
The Hypack Import Options are found on the Hypack tab of the File Type Specific Options window.
 

Select Device Number

Hypack files contain multiple sources of position, heading, depth, etc. Each sensor is identified by a
device ID. Use the drop down selectors to specify which device will provide each type of data. Use
the Sniff button to read the device IDs stored in a Hypack file. If necessary, you can apply a scale
multiplier to depth, magnetometer and cable out data.
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Sniff

Allows the user to open an HSX file and SonarWiz will display the HYPACK device id numbers and
text labels as they appear in the selected file:

Apply Position Offsets

Toggle to apply the device offsets (Lever Arms) recorded in the HSX file to position calculations
performed by SonarWiz.

Sound Velocity Source

Uses the sound velocity defined in the Program Preferences | Advanced Settings dialog to calculate
sidescan ranges rather than the sound velocity value contained in the HSX RSS record.

Auto Contrast

Applies a SonarWiz derived contrast to the sonar file that attempts to automatically give the best
image results.

Sidescan Backscatter

Use multibeam amplitude values (RMB) as a backscatter source for sidescan processing.

Multibeam Amplitude

Use sidescan backscatter values (RSS) as an amplitude source for multibeam processing. (Snippets
and TruePix records are stored as sidescan records)
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Humminbird SON Import Options
 

The Humminbird SON Import Options are found on the Humminbird SON tab of the File Type Specific
Options window.
 

Channel Selection

The header for Humminbird SON files does not indicate which out of the possible 5 channel locations
are the port and starboad so these will need to be selected using the channel drop down menus.



Innomar SES Import Options

1565

Innomar SES Import Options
 
The Innomar SES Import Options are found on the Innomar SES File Options tab of the File Type Specific
Options window.
 
SES files contain 8 Ship Information System (SIS) fields. The information within the fields is set by the user
with the Innomar software at data collection time. This means that the user could decide to put latitude and
longitude from an interfaced NMEA device on SIS-1 and SIS-2 or on SIS-3 and SIS-4. There are no flags that
indicate what type of data is written to each SIS field.
 
The settings on the Innomar SES Import Options dialog allow you to read an SES file, display the values in the
8 SIS fields, and assign the data type to each of the fields so that the files can be processed by SonarWiz.
 

Read SES File

Use this button to open an SES file and populate the Parsed Value windows in the dialog.

SIS Field Number

Each of the 8 ship information system (SIS) fields is labeled. There is one column for each field.
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Parsed Value

The parsed value windows show the value of their respective SIS field. It is up to the user to identify
the type of each SIS field

Field Usage

Use the drop down to identify to SonarWiz how this particular SIS field should be interpreted. The
following options are available:

Field Scalar

Multiply the Parsed value by the field scalar.

Field Offset

Add to the Parsed value the Field offset.
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Imagenex Import DeltaT
 
The Imagenex DeltaT Import Options are found on the Imagenex DeltaT tab of the File Type Specific
Options window.
 

Imagery Source

Select imagery source. Some DeltaT (.83P) files do not contain intensity or backscatter data. Some
files that do contain intensity data do not produce a good image. This option allows you to treate the
range data as intensity data and provides another way to generate an image

Flip Transducers

Reverse the port and starboard transducers.
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Klein Import SDF
 
The Klein SDF Import Options are found on the Klein SDF tab of the File Type Specific Options window.
 

Pressure Transducer

These controls configure the pressure transducer scaling from SDF files. As of vxWorks 8.0, the
header fields in the SDF file should populate all of the values necessary to compute depth. However,
for SDF files collected by older software or in situations where the user wants to manually configure
the pressure sensor, check the Override values in file check box and fill out the Full Scale Pressure,
Minimum Voltage, Maximum Voltage and Pressure Offset per the manufacturer's recommended
settings for the pressure sensor installed on your fish.
 
Fish Depth is computed as follows:
 
     depth = ((((volts - minimum voltage) / (maximum voltage - minimum voltage)) * full scale pressure)
+ pressure offset) / 1.487
 
where:
 
     volts is the measured voltage of the pressure sensor from the SDF header
     minimum voltage is the minimum voltage of the pressure sensor
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     maximum voltage is the maximum voltage of the pressure sensor
     full scale pressure is the maximum rated pressure (at maximum voltage) of the pressure sensor
(psi)
     pressure offset can be used to adjust for atmospheric pressure at the surface (nominally -14.696
psi for 1 standard atmosphere) (psi)
     1.487 is the conversion from psi to meter
 
Both the Full Scale Pressure and Pressure Offset fields should be entered in pound-force per square
inch (psi). Note that 1 psi = 68.948 millibar
 
NOTE: The pressure offset is added to the pressure value as shown in the

above equation. To zero the pressure sensor at the surface, you should
measure the pressure reading of the fish on the deck, convert this
value to PSI and enter this value as a negative number in the Pressure
Offset box. For example: one standard atmosphere (nominal sea level)
is 14.696 psi, so, to remove this from the depth sensor we would enter
-14.696 in the Pressure Offset box.

 
Some common full scale pressure values for sensors installed on Klein systems:
 
Depth
Rating

Pressure
(mbar)

Pressure
(psi)

100 m 10253 148.7
300 m 30758 446.1
1000
m

102525 1487.0

1500
m

153788 2230.5

2000
m

205050 2974.0

3000
m

307575 4461.0

 
 Users unfamiliar with this control should consult with Klein prior to adjusting these values.

Use Ship Heading

Toggle to use ship heading rather than the fish heading.

Use Auxiliary Depth

Toggle to use the auxiliary depth instead of the standard depth value.

Use Auxiliary Attitude

Toggle to use the auxiliary attitude rather than the standard attitude value.
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Quality Threshold

The Klein Quality values on each sample provide an indicator as to the quality of the bathymetry
solution. In SonarWiz, this is a value between 0 and 100. It is useful to filter samples based on their
quality value as a “data cleaning” tool in order to discard outliers. There is not firm threshold value that
can be used for all sea types and conditions. A value of 65 may be a valid default for this parameter.

Skip First N Pings

If navigation values on the first few pings are bad, use this parameter to skip processing the first
several pings.

Bathymetry Signal-to-noise thresholds...

Klein computes a SNR for each sample, this tool can be used as a filter to remove bad points that
have low SNR.

5900 Sidescan Source

Select the sidescan source packet for the 5900 system. It is useful to import the port and starboard
channels first and then import the gap filler pages separately by toggling the Process only Gap Filler
Pings check box. In this way, you can fill the nadir region of your sidescan data with the gap filler data.
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Kongsberg All Import Options
 
The Kongsberg All Import Options are found on the Kongsberg ALL Files tab of the File Type Specific
Options window.
 

Bathymetry Source

Select the bathymetry source packet. The Auto setting will select the recommended bathymetry
packet in the file (usually XYZ if present), or the user is free to override this selection. See the Tools |
All File Utilities for a way to inspect the packets stored in an All file.
 
Note that XYZ (88) and Depth (68) packets store fully processed bathymetry. If selected as the
bathymetry source, SonarWiz will not attempt to re-compute the position of these samples during
Merge operations. If necessary, you will need to perform tide, sound velocity and lever arm corrections
in SIS and regenerate the All files. The advantage of the XYZ 88 packet is that all advanced features
of the Konsberg systems are properly supported.



Kongsberg All Import Options

1572

Backscatter Source

Select the backscatter source packet. The Auto setting will select the recommended backscatter
source (usually a time series packet if present), or the user is free to override the selection. See the
Tools | All File Utilities for a way to inspect the packets stored in an All file.

Position Source

Select the Position Source packet. See the Tools | All File Utilities for a way to inspect the packets
stored in an All file.

Attitude Source

Select the Attitude Source packet. See the Tools | All File Utilities for a way to inspect the packets
stored in an All file.

Set Recommended Options

Press to set the recommended options.
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Kraken TIL Import Options
 
The Kraken TIL Import Options are found on the Kraken TIL Files tab of the File Type Specific Options
window.
 

Sidescan Source

Used to choose which sidescan packet is stored in the imported TIL files. Currently the import engine
supports the following formats:
 
- SAS dB segments
- Sidescan data segments
 
In order to discover which packet a raw TIL file has stored, run the Extract Packet Information from TIL
file option located in the Tools tab.



Marine Sonic MST Import Options

1574

Marine Sonic MST Import Options
 
The Marine Sonic MST Import Options are found on the Marine Sonic MST Files tab of the File Type
Specific Options window.
 

SDS Heading Source

Used to select the heading source in Marine Sonic SDS files. The options include the ping heading
(NAV), orientation yaw (ORNT), or AUTO.
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AUV Mode

In AUV mode the fathometer (if present) will be treated as towfish altitude
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ODC Import Options
 
The ODC Import Options are found on the ODC tab of the File Type Specific Options window.
 

Pixel Swap

Toggle pixel swap. This is used to improve imagery in ODC files collected by versions of the StrataBox
software built before September 2002. This corrects a pixel ordering problem that causes image
artifacts.

HD File Format

Activates High Definition mode for StrataBox ODC files.Regular samples per channel is 400, in HD
mode, it is 800.

ODC Data Type Detection

Syqwest stores StrataBox, HydroBox and Bathy 2K sonar data using the same file suffix “ODC”, but
these data types are quite different in their processing requirements. Auto detection of the data type
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stored in the ODC file is dependent on detecting a $PNTI,101 record. If the 101 record is not present
auto detection will fail. Some of the Bathy 2K ODC files we have encountered do not include the 101
record anywhere in the file. Syqwest, users are advised to set this flag to match the sonar type for their
ODC files.

Process only Zoom records

SonarWiz supports processing the zoom level (121) records from the Syqwest Bathy 2000, StrataBox
and HydroBox ODC files. To select the zoomed records, use the File Type Specific Options button on
the SBP import dialog and go to the ODC tab. At the bottom of the ODC window there is a checkbox
labeled "Process only zoom (121) records”. When this checkbox is set, the standard (111) records are
ignored and only the zoomed (121 code) records are processes.
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R2Sonic Import Options
 
The R2Sonic Import Options are found on the R2Sonic tab of the File Type Specific Options window.
 

Time Offset

Set time offset in seconds between the R2S packets and the navigation and attitude data. For
example, sometimes Hypack records UTC time in the position data and the R2Sonic  system is setup
in local time. Use this entry to compensate for these time differences.

R2S File Source

Set the R2S binary packet source. HYPACK wraps R2Sonic binary packets in a proprietary header
which SonarWiz must remove to process the files properly.



R2Sonic Import Options

1579

Recommended Options

Press this button to reset the dialog to the recommended options.

Backscatter Source

Set the backscatter source. Auto will use TruePix if present, then snippets and then beam averaged
backscatter from the bathymetry packet. The user is free to select the desired backscatter source.

Backscatter Plotting

Snippets and TruePix backscatter packets have more samples than the sonar has beams. There are
two options for handling this:
 
1.  SonarWiz can down sample the backscatter records and assign each beam a single backscatter
value computed from the median of nearby backscatter points, or
2.  SonarWiz can create artificial sounding positions for each backscatter sample by interpolating the
original beam positions.
 
Each option has advantages and disadvantages. Using the beam detection points only results
in better pixel positioning, even over complex structures like wrecks or debris. Also, the median
filter tends to reduce scintillation and noise in the backscatter resulting in better images. In shallow
water, the beam-to-beam spacing may already exceed survey requirements so there is no need
to unnecessarily increase the volume of data processed. However, you do reduce the backscatter
resolution to the beam spacing.
 
Using Interpolate backscatter positions will create hundreds of additional pseudo-soundings,
one for each backscatter sample, thus preserving the full resolution of the backscatter record. The
samples are linearly interpolated in space between the real sounding positions. This works well in
normal terrain with clean data but it causes problems when surveying over wrecks or other overhang
situations where the soundings are jumping quickly between the seabed and wreckage proud of the
seafloor. Significant artifacts in the water column such as fish schools or poor sonar bottom detection
can also cause problems with interpolation.
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Reson S7K Import Options
 
The Reson S7K Import Options are found on the Reson S7K tab of the File Type Specific Options window.
 

Bathymetry Source

Select the bathymetry source packet. The Auto will attempt to automatically detect the best bathymetry
packet in the file, otherwise the user can force the program to use one of the supported options. (See
Tools | S7K File Utilities for a tool to examine the packets available in a selected S7K File)

Enable Backscatter

Toggle to enable backscatter processing, otherwise no backscatter will be loaded. Note that if
backscatter processing is enabled, but no backscatter packets are present, SonarWiz will fail to load
the file.

Backscatter Plotting

Snippets backscatter packets have more samples than the sonar has beams. There are two options for
handling this:
 
1.  SonarWiz can down sample the backscatter records and assign each beam a single backscatter value
computed from the median of nearby backscatter points, or
2.  SonarWiz can create artificial sounding positions for each backscatter sample by interpolating the
original beam positions.
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Each option has advantages and disadvantages. Using the beam detection points only results in better
pixel positioning, even over complex structures like wrecks or debris. Also, the median filter tends to
reduce scintillation and noise in the backscatter resulting in better images. In shallow water, the beam-to-
beam spacing may already exceed survey requirements so there is no need to unnecessarily increase the
volume of data processed. However, you do reduce the backscatter resolution to the beam spacing.
 
Using Interpolate backscatter positions will create hundreds of additional pseudo-soundings, one
for each backscatter sample, thus preserving the full resolution of the backscatter record. The samples
are linearly interpolated in space between the real sounding positions. This works well in normal terrain
with clean data but it causes problems when surveying over wrecks or other overhang situations where
the soundings are jumping quickly between the seabed and wreckage proud of the seafloor. Significant
artifacts in the water column such as fish schools or poor sonar bottom detection can also cause problems
with interpolation.

Backscatter Source

Select the backscatter source packet. Auto will attempt to automatically detect the best backscatter
packet in the file, otherwise the user can force the program to use one of the supported options. (See
Tools | S7K File Utilities for a tool to examine the packets available in a selected S7K File)

Navigation Source

Select the navigation source packet. Auto will attempt to automatically detect the best navigtaion
packet in the file, otherwise the user can force the program to use one of the supported options. (See
Tools | S7K File Utilities for a tool to examine the packets available in a selected S7K File)

Heading Source

Select the heading source packet. Auto will attempt to automatically detect the best heading packet
in the file, otherwise the user can force the program to use one of the supported options. (See Tools |
S7K File Utilities for a tool to examine the packets available in a selected S7K File)

Attitude Source
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Select the attitude source packet. Auto will attempt to automatically detect the best attitude packet in
the file, otherwise the user can force the program to use one of the supported options. (See Tools |
S7K File Utilities for a tool to examine the packets available in a selected S7K File)

S7K Units

S7K files do not indicate the units of sound velocity or distance. You must indicate the source file units
here.
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SEG-Y Import Options
 
The SEG-Y Import Options are found on the SEG-Y tab of the File Type Specific Options window.
 

Navigation Source

Select the navigation source. The SEG-Y format specifies a position for the Receiver (fish) and the
Source (ship) of the seismic data. Some data acquisition systems use one or the other or both.

Treat IMB FP as IEEE

This option has been added specifically for those systems that use the IEEE floating point format
such as C&C's AUV. Refer to the recording device's manufacturer's specifications to determine which
settings are to be used in SonarWiz.

Topographic Correction
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Topographic Corrections may be enabled for systems where the sensor maintains a constant altitude
above the sea floor by varying the sensor depth (See Topographic Corrections for more information).

Byte Swap IEEE

Reverse the byte order of IEEE samples.

1-way Travel Time

The 1-way travel time option may be set here which is used for for very old SEG-Y files, in particular
the DataSonics Chirp II.

Always record X/Y

The user may force SonarWiz to record SEGY data in X/Y coordinates even if the input navigation
system is sending latitude/longitude. This is considered an advanced option and should be carefully
configured and tested before implementing to avoid the loss of navigation data.

Use Local Time

The user may force SonarWiz to record SEGY data in local time.

Use Little Endian

This option is used to force the SEG-Y reader to treat an imported file as Little Endian (Intel) byte
order. The SEG-Y standard specifies the byte order as big endian but some recording systems record
as Intel style ordering. When possible the software detects the byte ordering by testing selected values
but if these value are not set the automatic logic can fail. This is a manual override of the auto-detect
logic.

Use SEGY V2 Information If Available

When checked, will use ping number, sensor depth, and position in the V2 trace extension headers.
Only available for V2 SEG-Y files.

Amplitude Offset

Compensate for systems that do not store 0VDC as a digital value of zero. Some data acquisition
systems store the analog to digital converter (ADC) value that reference -5V as the ADV value of zero.
If left uncorrected, this bias will induce a strong offset to the image. This is particularly useful with
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CODA data that has been converted to SEG-Y without compensating for the ADC offset. Usually, a
value of -2048 is useful in these cases to compensate for the 12-bit ADC.

Use Time Scalar

When checked, will enable using the time scalar for fields that have the scalar stored in the SEGY V1
Standard. These are any fields between bytes 95 and 114. Unchecked will import the data as-is.
 

Data Fields Table

The Data Fields table allows the user to map SEG-Y fields to SonarWiz fields. Beside each SonarWiz
field name is a drop down that lists the possible SEG-Y field to use as input. You can optionally apply
a scalar (multiplier) and/or offset to the input values as necessary.
 
Refer to the SEG web site www.seg.org and in particular: http://www.seg.org/publications/tech-stand/
seg_y_rev1.doc as well as the recording device's manufacturer's specifications to determine which
settings are to be used in SonarWiz.
 
Special Notes:
 
Event Number
A special event option labeled Benthos Chirp II is available in addition to the standard fields, it
instructs SonarWiz to read the event numbers from the OLD Benthos Chirp II files.
 
Heave

http://www.seg.org/
http://www.seg.org/publications/tech-stand/seg_y_rev1.doc
http://www.seg.org/publications/tech-stand/seg_y_rev1.doc
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When SonarWiz records a SEGY file, the heave value is stored in the user defined area of the SEGY
trace header in bytes 189-190. The heave value is stored as centimeters X 10 in a short integer value
in big endian format. The storage location is also indicated in the SEGY file’s EBCDIC header. Since
other vendors may store the heave value in locations other than bytes 189-190, this option may be
configured. When working with SonarWiz data, this setting should always be set to bytes 189-190.
 
Other Depth/ Elevation Fields
For more information on how these fields will be used and applied to imported SBP files, see SBP
Tides and Vertical Offsets.

Profile Selection

Use the drop down menu to quickly adjust the Data Fields table to conform to one of the pre-
configured SEGY profiles.  Currently SonarWiz supports the following formats:
 
- Standard SEGY V1
- SonarWiz Real Time (the current format for recorded SGY files inside of SonarWiz)

Load Profile

Loads a saved SEG-Y format that has previously been saved.

Save Profile

Once a particular SEG-Y format has been configured into the file preferences the format may be
saved in order to load it at a later date for the same sonar/format.
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XTF Import Options
 
The XTF Import Options are found on the XTF tab of the File Type Specific Options window.
 

Cable Out Data

Select the Cable Out field. The XTF file format contains two fields that can be populated by a sonar
recoding program when surveying: Cable Out and Layback. Depending on the system used to record
data only one of these fields may be populated with a value. SonarWiz always populates the Cable
Out field. Isis for one, is configurable in how it stores cable out and the cable out value may actually be
stored in the XTF header under Layback depending on how the original survey was configured.

Event Numbers

Event numbers are recorded in an XTF file in two possible ways depending on the specific recording
programs. Normally the default option is to select the Auto Detect option; however, there may be
conditions where the auto detect method can't determine the correct location of the event numbers.
In those cases, two other options are included as a way to force a specific interpretation of events.
For SonarWiz and ISIS v4.3 or earlier choose the first radio button. For CODA XTF and post v4.3 ISIS
choose the second radio button.
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Altitude Data

This option exists primarily to support data collected by Isis. In SonarWiz, with the Klein 3K and 5K
systems that send telemetered altitude, that telemetered value is now always stored in the aux altitude
slot. If the user elects to use the manual tracker or no tracker during data collection, the telemetered
value is always available as the Auxiliary Altitude Sensor for post processing.

Weighting Factor

Use this option if you are using an EdgeTech 4200 and the recording system used XTF v18 which has
been around since ~2005. If the weighting factor is not applied then horizontal banding will occur as
shown in the figure below:

Renumber Pings

Regenerate the ping numbers when an XTF file is imported. This corrects for those XTF files recorded
by Isis where the ping numbers were reset to 0 every 4096 pings.

Record X/Y coordinates
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Forces X/Y data recording of XTF files even when the input navigation coordinates are lat/long. The X/
Y coordinate system logged will be the same X/Y coordinate system of the current project.

Dual Frequency Files

The option applies to real-time operations where the sonar in use has two separate simultaneous
frequencies i.e. Klein 3000 or EdgeTech 4200. The structure of a CSF File is such that only 2
channels (port and starboard at one frequency) are stored in the file meaning that when operating a
dual frequency sonar the R/T Channel to Mosaic option chosen in the Project Settings determines
which two channels channels get written to the CSF file. This options creates two CSF Files for dual
frequency sonars each with a single frequency. Regardless of the single-frequency limitation on CSF
Files, the XTF file recorded during Real-time operations contains both frequencies.

Local Time

This forces the program to use the PC clock’s local time

Heading Data

For XTF files that were recorded with the both ship and sensor headings the source to be used upon
import may be selected here.
As a good rule-of-thumb Ship heading (Course Made Good) should be selected unless the sensor's
gyro was an Inertial Motion Unit. Normally the flux gate compass fitted on most sidescan towfish is not
of a high enough accuracy for mosaicking.

Position Data

Select the position packet to use as well as if the position will be interpolated upon import.

Depth Data

Select the depth packet to use.
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Speed Data

Select the speed packet to use.

Down Sample pings

If the import process is too lengthy for the nature of the information desired, the data may be down-
sampled in the along-track direction in order to increase the input speed. The interval is the number of
pings to be skipped during the read process. So if the user enters a 2 it reads one, skips two. Similarly,
if interval=10, read 1 skip 10.
 
This feature helps for files which have troubled data at the start of the file, such as missing or
erroneous values in the first few pings.
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XTF Bathymetry Processing Import Options
 
The XTF Bathymetry Import Options are found on the XTF Bathymetry Processing Only tab of the File Type
Specific Options window.
 

Time Offsets

Some file (e.g., C3D) may contain a time offset between sensors and sonar data. Use the controls
here to compensate for these time differences.

Bathymetry Source

Select the Bathymetry Source packet. Auto will attempt to detect the bathymetry packet, if this fails,
the user can specify the particular packet to use.
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Amplitude Source

Select the Ampliitude (backscatter) Source packet. Auto will attempt to detect the amplitude packet, if
this fails, the user can specify the particular packet to use.

Attitude Source

Select the Attitude Source packet. Auto will attempt to detect the attitude packet, if this fails, the user
can specify the particular packet to use.

Position Source

Select the Position Source packet. Auto will attempt to detect the position packet, if this fails, the user
can specify the particular packet to use.

Downsample Laser Samples

Downsample laser data. A factor of 1 will process all samples, a factor of 2 will reduce the sample
count by 50%.

Recommended Options
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Click the button to set all options on this panel to their recommended settings.
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SBP Options Menu
 

The SBP Options Menu is opened by selecting the SBP Options icon  from the Preferences
and Settings window. The SBP Options Menu is used to configure settings related to the display and
processing of sub-bottom profiler data.

 

 

SBP Options Page

Click to open the SBP Options Page
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Horizontal Profile Resolution

Decimate: Individual pings are skipped according the number specified buy the user (1 = skip every
alternate ping, 2 = skip 2 pings between updates, etc)
Replicate: Individual pings are repeated the number times specified by the user in the available value
box. This function gives the resultant image a stretched appearance.

Vertical Profile Resolution

Width / Resolution of SBP Waterfall Display is selectable for export only.

Default 3D Viewer

Users have the choice of selecting the default 3D viewer as either the CTI 3D Viewer (installed with
SonarWiz); or Fledermaus / iView4D.The default viewer will be started for the QuickView 3D function
(see Intersections).

Auto Scroll

Causes the Digitizing Window to auto scroll ahead by 10% once the cursor click is inside 10% of the
edge of the window.

Draw Reflectors in Map View

When this option is checked, all SBP reflectors will be displayed at the top of the rotated profile image
in the Map Window. If this option in unchecked, the reflectors will be shown in their relative offset
position from the top of the profile.

Auto scale SEGY data

Auto-scales the display for floating point SEGY data. On = default setting.
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Display Polarity

Allows the SBP data to be re-built within the program after changing the polarity settings, without the
need to re-import the data.

Topographic Corrections

Click to open the Topographic Corrections dialog.
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Topographic Corrections
 
This feature is primarily used for AUV applications where the AUV is maintaining a constant height above the
seafloor and Topographic Corrections displays the actual slope of the bottom with respect to the water surface.
 
Topographic Corrections produces an SBP profile image (in post-processing) that takes into account the depth
of the SBP sensor if the SBP data contains a delay value in the lag A fields of a SEG-Y file. If Topographic
Corrections is not applied to the AUV data, the profile will appear as a flat profile as if the depth were constant.
 

 
Topo Correction Setup
 
The Topo Corrections Setup window allows the user to:
 
1.     Turn Topo Corrections On or Off;
2.     Select the amount of data (in milliseconds) to always display; and
3.     A window size control which corresponds to the height of the window or width of the paper.
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Contact Options Menu
 

The Contact Options Menu is opened by selecting the Contact Options icon  from the
Preferences and Settings window. The Contact Options Menu is used to configure sonar contact file formats,
naming and related attributes.
 

Contact Options Page

Click the Contact Options icon to display the Contact Options menu panel

Display

Set the default color and symbol for Contacts. Enable labels and control whether or not they are drawn
with a transparent background.
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Names

Control how contact names will be generated. There are four options:
 

Naming
Option

Description

Default Contacts will be named CONTACTnnnn where nnnn is a sequential
number. (CONTACT0001, CONTACT0002, etc)

User
Specified

Contacts will be named <Root Name>nnnn where the <Root Name> is
specified in the Root Name box. The sequential number, nnnn, will start
at the Start# and increment by the Increment interval.
 
If Dynamic substitution is enabled <Root Name> will be replaced by the
Class 1 User Entry in the Contact Editor when the contact is classified.
For example, if the Class 1 entry is set to "log" the contact will be
renamed log0001.

Prompt
at
capture
time

SonarWiz will prompt the user for a name for each contact as they are
placed.

NOAA
Format

Contacts will be named according to the NOAA standard. A Date /
Time / Location stamp according to the format:
ddd-HHMMSSs where:
ddd = Julian Day number
HHMMSS = UTC in 24hr format
s = “P” or “S” for Port or Starboard Swath where the contact was located

 
Auto-Sequence Number Limits Issue
The full range of auto-sequence number assignment is 0000 to 9999. So if you have specified a root-
name like Area-1 then your contacts could be named Area-10000 to Area-19999. That works fine if
you leave it that way. If you later change the root-name though, it can become a problem.
 
Suppose you have contacts AREA-10000 to Area-12445 in the project, then you change the root-
name to Area- and shorten it by a character. The next contact you try to capture will not be allowed,
because the auto-sequenced next number will be 12446 which is larger than 9999. Look-up of the
auto-sequence number takes into account the root name, so it would see 2446 as the next number, as
long as the root-name remains Area-1 since the variable part of the full name is the remaining 4 digits
(assuming leading-zeros type naming).
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So keep this in mind when combining projects where different contact root-names may have bene
used, or when even within a project, root-names change for various parts of the survey, then don’t
revert to a shorter root-name and get into this “9999 exceeded” failure to assign an auto-sequenced
number.

External Applications

Enable broadcast of contact capture message for use by external applications. The data may be
output in NMEA TLL or COMEX Subsea format (see Contact Broadcast Formats). The user may
configure either a serial or UDP port to output a data string with the contact information to a device
that can use this string to plot the contact.

Lists

Use these fields to automatically open an attribute list file for editing. The Contact Editor dialog allows
you to annotate a contact with various attributes including two classifications and an area location.
These can be typed into their respective fields on the dialog, or they can be selected from predefined
lists. The lists are stored in the following text files which are all located in the project folder:
 
•  Primary contact classification: ContactAttributes.txt
•  Secondary contact Classification: ContactAttributes2.txt
•  Location Area: ContactLocationAreas.txt
 
To extend or modify these lists, the files can be edited manually using any text editor. Alternatively,
you may automatically open one of these files in Notepad by selecting the file from the drop-down list
under Current Project and pressing the Edit button. Note that changes made to the current project
files lists will not be visible in other projects.
 
The contact attribute and Location Area list files in the current project are copied from master files in
the SonarWiz7 application folder (usually C:\Program Files \Chesapeake Technology, Inc\SonarWiz7\)
when the project is first created. You may edit these master files by selecting the file from the drop-
down list under Global Defaults and pressing the Edit button.
 
Note: Changes made under Global Defaults will be reflected in the lists for all projects created in the
future, but not in the lists for projects that already exist.

Lease Blocks

The contact capture tool can be configured to automatically search any of the map overlay layers for
the lease block containing the contact being digitized.
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To configure the automatic look up of the lease block:
 
1. Add the Lease Block map file to the project using the Add Overlay button in the Map Manager.
2. On the Contact Options dialog, check the box labeled Extract Lease Block Name from Map
Overlay
3. Select the Lease Block Overlay File from the drop down list.
4. Select the Lease Block Attribute from the map overlay layer that contains the name of the lease
block.
 
When a contact is captured, SonarWiz will use the contact click location to look up the lease block in
which the new contact is located. The name of the contact's lease block will be automatically set in the
contact file.

Rationalized Contacts

These options control the settings for rationalized contact process, which is described in a separate
PDF in your Documents folder:
.\Contact_Rationalization.pdf. The Advanced... button opens a dialog which controls how Length,
Width, Height and Scour will be rationalized

 

Miscellaneous

Option Description
Slant range correct contact
images

This setting controls how sidescan images are
generated for contacts.
Unchecked - Sidescan imagery is not slant
range corrected. Contacts picked close to nadir
will show water column data from the current
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channel only. NOTE: Use this setting if you are
trying to pick contacts in the water column.
Checked - Sidescan imagery is slant range
corrected. The water column is removed and
contacts picked close to nadir will show data
from both port and starboard channels.

Warn before deleting contacts
from project

User is given a warning pop-up prior to the
program following through on deleting a
contact when this box is checked.
 

Draw Contact Measurements in
Editor and Waterfall views

Selecting this option will display the measured
Length, Width, and Height (shadow) of a target
once these fields have been populated.

Open Digitizer when Contact is
digitized on plan view

When enabled, contacts placed in the plan
view will not save but open the digitizer to be
placed.

Open Contact Editor When
Contact is Digitized

Immediately open the contact editor after
a contact has been digitized. The default
behavior is to add the contact silently.

Retain link to source CSFs on
import or move

Generally most contacts have an associated
CSF file that can be linked to the contact
properties; however, a contact can still be
imported even if its original CSF file cannot be
found.
 
Populating this check box retains the link
(reference) to the source CSF file when a
contact is imported or moved. If this check
box is not populated SonarWiz will ignore
the source CSF file and search in the current
(destination) project for the CSF file. If the
corresponding source file is not found a
warning will be issued via the summary log but
the contact will still be imported.

Enable contact un-delete Allows deleted contacts to be restored
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Digitized Feature Options Menu
 

The Digitized Features Options Menu is opened by selecting the Digitized Feature Options icon

 from the Preferences and Settings window. The Digitized Feature Options menu is used to
configure digitized feature attributes and settings.
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Feature Naming

The user is given three choices for Feature Naming when a new feature is created:
Naming
Option

Description

Default Contacts will be named CONTACTnnnn where nnnn is a
sequential number. (CONTACT0001, CONTACT0002, etc)

User
Specified

Contacts will be named <Root Name>nnnn where the <Root
Name> is specified in the Root Name box. The sequential number,
nnnn, will start at the Start# and increment by the Increment
interval.

Pull down
list

The “Feature Name” field will be filled with the last name that was
used (i.e selected from the predefined
list or manually entered).
 
•  You may use this name, OR
•  Select a name from the drop-down list, OR
•  Manually type in a new name
 
If you type in a new name, it will be added to the list. The list of
feature names stored in the file “FeatureNames.txt” in the project
folder. This file may be edited manually, or using the method
described below.

 

Feature Descriptions

When editing a Feature, the current feature description will be displayed in the Description field. With
this check-box checked you may manually edit it, or select from the pre-defined list. If the name is
manually changed, it will be added to the pre-defined list.

Edit Pick Lists

Use these fields to automatically open a feature name or description list file for editing. The Feature
Editor dialog allows you to provide a name and description for a feature. These can be typed into their
respective fields on the dialog, or they can be selected from predefined lists. The lists are stored in the
following text files which are all located in the project folder:
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Feature Name: FeatureNames.txt
Feature Description: FeatureDescriptions.txt
 
To extend or modify these lists, the files can be edited manually using any text editor. Alternatively,
you may automatically open one of these files in Notepad by selecting the file from the drop-down list
under Current Project and pressing the Edit button. Note that changes made to the current project
files lists will not be visible in other projects. The feature name and description list files in the current
project are copied from master files in the SonarWiz7 application folder (usually C:\Program Files
\Chesapeake Technology, Inc\SonarWiz7\) when the project is first created. You may edit these master
files by selecting the file from the drop-down list under Global Defaults and pressing the Edit button.
Note that changes made will be reflected in the lists for all projects created in the future, but not in the
lists for projects that already exist.

Feature Point Density

For those users who left-click-and-drag to create reflectors using a mouse or a pen tablet, the
minimum distance in the horizontal and vertical axes (in pixels) between any two nodes may be
specified here. As well the overall minimum total distance between adjacent nodes in any direction
may be set.

Miscellaneous Settings

Draw Text Labels Transparently removes the solid box behind the text such that the imagery can be
seen under the label.
Retain link to source CSF on project move: When checked this retains the link in a feature to the
CSF file in its original location when a project is moved. If the check box is not checked then SonarWiz
will look for the CSF file in the new (moved) project location.

Auto Backup

Specify how often (after x number of new features have been created) SonarWiz is to backup digitized
features. A value of zero means no auto backup.
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Navigation Plot Options Menu
 

The Navigation Plot Options Menu is opened by selecting the Navigation Plot icon  from the
Preferences and Settings window. The Navigation Plot Options menu is used to configure digitized feature
attributes and settings.

 

 
 

Ship Recentering

The Map Window re-centers the ship based on the distance from the center to the edge of the map
window as a percentage. For example, at 100 percent the display will not recenter until the ship drives
out of the window. At 50 percent, the display will recenter when the ship travels 50 percent or more
from the center of the map window.
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Plot Navigation History

The navigation history of an individual node may be activated by the user checking the Plot
Navigation History box and then selecting the specific node from the What to plot drop down list.
Once the node has been selected, the symbol used to plot the history may be selected from the How
to plot it pull down menu.
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Magnetometer Options Menu
 

The Magnetometer Options Menu is opened by selecting the Magnetometer Options icon 
from the Preferences and Settings window. The Magnetometer Options menu is used to configure
magnetometer post-processing options.

 

 

Anomaly Naming

Control how Anomaly names will be generated. There are four options:
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Naming
Option

Description

Default Anomalies will be named Anomalynnnn where nnnn is a sequential
number. (Anomaly0001, Anomaly0002, etc)

User
Specified

Anomalies will be named <Root Name>nnnn where the <Root Name> is
specified in the Root Name box. The sequential number, nnnn, will start
at the Start# and increment by the Increment interval.
 
If Dynamic substitution is enabled <Root Name> will be replaced by
the Class 1 User Entry in the Anomaly Editor when the anomaly is
classified. For example, if the Class 1 entry is set to "log" the anomaly
will be renamed log0001.

Prompt
at
capture
time

SonarWiz will prompt the user for a name for each anomaly as they are
placed.

NOAA
Format

Anomalies will be named according to the NOAA standard. A Date /
Time / Location stamp according to the format:
ddd-HHMMSSs where:
ddd = Julian Day number
HHMMSS = UTC in 24hr format
s = “P” or “S” for Port or Starboard Swath where the contact was located

 
Auto-Sequence Number Limits Issue
The full range of auto-sequence number assignment is 0000 to 9999. So if you have specified a root-
name like Area-1 then your contacts could be named Area-10000 to Area-19999. That works fine if
you leave it that way. If you later change the root-name though, it can become a problem.
 
Suppose you have contacts AREA-10000 to Area-12445 in the project, then you change the root-
name to Area- and shorten it by a character. The next contact you try to capture will not be allowed,
because the auto-sequenced next number will be 12446 which is larger than 9999. Look-up of the
auto-sequence number takes into account the root name, so it would see 2446 as the next number, as
long as the root-name remains Area-1 since the variable part of the full name is the remaining 4 digits
(assuming leading-zeros type naming).
 
So keep this in mind when combining projects where different contact root-names may have bene
used, or when even within a project, root-names change for various parts of the survey, then don’t
revert to a shorter root-name and get into this “9999 exceeded” failure to assign an auto-sequenced
number.
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Miscellaneous Options

Toggle miscellaneous options to enable:
 

Option Description
Draw Raw mag Data in Editor Draws raw Mag data in the Magnetometer File

Editor
Draw Ambient Mag Data in
Editor

Draws ambient Mag data in the Magnetometer
File Editor

Draw Smoothed Mag Data in
Editor

Draws smoothed Mag data in the Magnetometer
File Editor

Label Mag Lines in Map View Labels the Mag lines with their names in the
Map View

Show Anomaly Numbers in
Map View

Displays anomaly numbers in the Map View

Draw Mag Event Numbers Displays the Mag Event Numbers in the Map
View

Draw Mag Anomalies in SSS
Waterfall View

Displays anomalies in the Digitizer View of any
Sonar File that coincides with the same position
as the anomalies

Draw Mag Anomalies
Transparently

Displays the anomaly in the Map View without
the symbol filled-in.

Smoothing Constants

Set the size of a moving box car filter that is used to smooth the Ambient Magnetometer trace and the
Observed Magnetometer trace. Higher values correspond to more smoothing.
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Map Overlay Options

The Notes 1 Map File drop down allows the user to specify an Overlay loaded in the project and
select up to two attributes from that overlay that will be used to populate the notes portion of the
anomaly record. When the Identify Cause... button is clicked in the Magnetometer Anomaly Editor,
SonarWiz searches the selected overlay for the nearest object and allows you to populate the Notes
1 field of the anomaly with the looked up feature value. (See Identify Source of Known Anomaly for
details).
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Bathymetry Settings Menu
 

The Bathymetry Settings Menu is opened by selecting the Bathymetry Settings icon  from
the Preferences and Settings window. The Bathymetry Settings menu is used to configure swath bathymetry
processing options.
 

Bathymetry Settings

Click to activate the Bathymetry Settings Options pane
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Merge

Start the merge process immediately after importing a new file using the default settings

Broadcast Processed Bathymetry

Toggle to send bathymetry data to Helm Display and 3D viewer in real-time

Transmit Progress and Status Messages

Toggle to send progress and status messages to Helm Display and 3D viewer in real-time

Log Diagnostics File

Toggle to record a diagnostic file for use by CTI technical support.

Record LiDAR

Toggle to record LiDAR data coming from the Multi-Beam Server.
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Sonar Color Settings Menu
 

The Sonar Color Settings Menu is opened by selecting the Sonar Color Settings icon  from
the Preferences and Settings window. The Sonar Color Settings menu is used to configure default settings for
sonar colors.
 

 

Sonar Color Settings

Click to activate the Sonar Color Settings Options pane.
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Data Type

Choose the data type for which you want to define a default color pallet.

Color Settings

Define the default color pallet settings. See Color Properties for more information.
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Preferred Language Settings Menu
 

The Preferred Language Settings Menu is opened by selecting the Preferred Language icon 
from the Preferences and Settings window. The Preferred Language Settings menu is used to configure the
language used in SonarWiz.
 
NOTE: Currently SonarWiz only supports English.
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Advanced Settings Menu
 

The Advanced Settings Menu is opened by selecting the Advanced Settings icon  from the
Preferences and Settings window. The Advanced Settings menu is used to configure advanced program
options. CTI Recommends only expert users change these settings.
 

Use Alt Server Folder

The sonar servers used by the program in Real-time are normally located under the “Servers”
directory in the SonarWiz installation directory. If a server is desired that is not in this folder the value
must be entered here.

Remote Helm Display

When checked the Broadcast Navigation on Network box broadcasts Navigation information on the
local network (UDP Port 5200) to allow a SonarWiz remote Helm Navigation program to receive
real-time navigation. You must select the helm application you have installed: NavWiz (default) or
SonarWiz.Nav (legacy).
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Miscellaneous Options

 
Check the box next to the option to enable.
Option Description
Open Last Used Project
at Start-up

When checked, the active project in use when the
program last exited will be opened. To override this
setting, hold the SHIFT key while starting SonarWiz,
and NO PROJECT will be opened. This is especially
helpful if you have trouble opening the previous
project.

Warn before deleting
files from project

When checked, user must confirm before deleting files
from the project.

Ask user to Confirm
when closing SonarWiz

When checked, user must conform before closing
SonarWiz.

Allow Negative X/Y
Coordinates

When checked, allows negative grid coordinates.
This option is useful in high latitudes where adjacent
projection zones are very close together.

Disable CSF limits check This feature is ON by default (unchecked), and
helps prevent CSF files from entering the project
with problems. If you trust the sonar file and want to
pverride this QA checkm, and allow a CSF file into the
project during import, then check this checkbox

Enable recording of
navigation data when no
sonar is present

This supports recording navigation position (and
mammal sightings survey position) when no sonar is
being recorded at the same time

Accept commands from
remote applications

Use this check-box if you want a compatible program
to be able to remotely control SonarWiz functions
such as stop and start recording and file names.
Compatible program are: HYPACK and Fugro StarFix.

Warn before deleting
survey lines from project

When checked, user must confirm before deleting
planned survey lines from the project.

Build SSS Waterfall
Images with the oldest
data at the bottom

By default, the SSS Digitizer View orders the data
from lower ping numbers at the top to higher ping
numbers at the bottom like reading a book. By
checking this check box every waterfall image viewed
in the Digitizer view will automatically be generated
with the inverted ping order.

Enable Audit File When checked, An audit file will be created for each
track line in the Audit folder of the project. The Audit
file is used to record how much of each track line
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has been examined in the digitizer and when and by
whom. These files can be used as verification that
every ping in the survey was examined for targets.

Synchronize digitizer
window scroll locations

When enabled, if two or more waterfall displays are
open on the same file, SonarWiz will attempt to keep
them synchronized so that scrolling in one window
will scroll the other. This is useful for examining multi-
frequency systems, and includes synchronization
between sidescan, bathy and SBP when possible.

 

Off-track alarm Settings

A visible alarm and Audible alarm are available based on deviation from the currently selected survey
line to steer. The alarms have an associated distance (meters or feet) away from the survey line which
will trigger the alarm. The visible alarm manifests as a brief color change in the left/right steering
indicator window, the audible alarm is a warning sound.
 

Default Sound Velocity Settings

Set the default sound velocity in the water column and sediment for the project. The default water
column sound velocity is used when sidescan or sub-bottom files do not have a sound velocity record.
The default sediment sound velocity is used when creating new acoustic reflectors in the SBP Analysis
window.
Note that the sound velocity used by individual SSS or SBP data sets can be modified in the Sound
Velocity section of the Properties window.

Compute CMG using grid bearings

This option is especially useful in high altitudes where lines of longitude converge rapidly thus affecting
heading. Using this option will cause the program to calculate Course Made Good based on the local
grid whose longitudinal line a parallel.

Sidescan Polarity

When importing sidescan files, some file formats do not indicate the polarity of 16-bit data. This setting
will assist SonarWiz in interpreting the correct data range. When set to Bipolar, the intensity will range
from -32768 to +32767; when set to Unipolar, the intensity will range from 0 to +65536.



Advanced Settings Menu

1620

Diagnostic Message Thresholds

SonarWiz messages are assigned an importance level from 0 to 5. Most user-centric messages are
assigned a level of 0, higher level messages are for debugging the program (and usually greatly
increase the log volume). SonarWiz logs messages from itself (Logfile), from remote applications
communicating with SonarWiz over UDP, and for debug-builds only (function TRACE messages). CTI
may ask you to increase the log-level for one or all of these during a debugging session.

SonarWiz Multi-Threading Options

When checked, SonarWiz will attempt to maximize performance in the specified area (signal
processing, file import, bathymetry merge) by using all of the available processors on your computer
simultaneously. Note that because SonarWiz is mostly limited by hard drive speed, these optimizations
are only effective on SSD hard drives and should be disabled on older HDD drives.
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Appendix
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Supported Sensors
 
SonarWiz supports a large number sensors for Real-time data collection as well as a large number of sensor
data formats and sensor format for Post processing (offline).
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Real-Time Sensors
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Sidescan Sonars
 

SonarWiz can acquire and process data from the following sonar models. XTF file recorded.
 
Manufacturer / Interface Model

Analog 16-bit1 Geoacoustics SS

 Klein 595, 2000 SS

 Edgetech 260/272
 C-Max 800 series
C-Max CM2 USB
Edgetech 4100 (Sonarbeam)
 4125/4200 via Ethernet
 4125 via USB/COM port
 4600/6205 sidescan
Falmouth Scientific HMS-624, Swordfish SS
Imagenix Sportscan, Yellowfin
Jetasonic SS arrays
Klein 3000, 3900, 4900
 5000, 5000V2
 5900 w/gap-fill
 DeepSled UUV3500 sidescan
Knudsen 320
Kongsberg-Geoacoustics Ltd. Digital SS
 Pulsar SS
 Geoswath sidescan
Marine Sonic (now Atlas NA) HDS and SeaScan

 ARC Explorer
PingDSP 3DSS-DX sidescan
R2Sonic 202X series w/TruePix
SyQuest Aquascan
Teledyne-Odom 1624 SS
Tritech Starfish 450/990, Seaking
 
1Analog SSS server can record from any SSS top-side unit which can accept/provide trigger I/O and analog
outputs.
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Sub-Bottom Profilers
 
SonarWiz can acquire and process data from the following sonar models. SEG-Y file is recorded.
 
Manufacturer / Interface Model

Analog SB (16-bit, 24-bit)1 Sparkers, Boomers, Bubble-guns, Pulsers

 Applied Acoustics CSP 300-P

 AAE Model AA200 Boomer Plate
 Datasonics Bubble Pulser SBP
 EG&G Uniboom 230 boomer
 Ross 4920 SBP
Edgetech 3000 (X-Star), 3100, 3200
 FSSB (e.g., SB216, SB424)
Falmouth Scientific HMS-622 ChirpCeiver
Kongsberg-Geoacoustics, Ltd. Geopulse Analog SB
 Geopulse Plus Digital SB
Innomar SES-2000 SB
Knudsen Knudsen SB
SyQuest Stratabox, Hydrobox
 Bathy2010, Bathy2010PC
Teledyne-Odom Chirp III, Echotrac CVM

 
1Either Analog SB server can record from any SB top-side unit which can accept/provide trigger I/O and
analog outputs.
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Combined Sidescan and Sub-bottom
 

SonarWiz can acquire and process data from the following combined sidescan and sub-bottom models. An XTF
file will be created for the sidescan data and a SEG-Y file is recorded for the sub-bottom data.

 
Manufacturer / Interface Model

Edgetech1 2000 SS/SB

HUGIN AUV SS/SB
Klein 3000 SS/SB
Teledyne-Odom 1625 SS/SB

 
1Edgetech 2000 SS/SB (uses Edgetech 4125-4200 server + Edgetech FSSB server – both run at once and save

XTF/SEG file pair)
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Bathymetric Sonars
 

SonarWiz can acquire and process data from the following swath bathymetry sonars. An XTF file will be created.
 

Manufacturer / Interface Model
Edgetech 4600 / 6205 SS/bathy
Klein 5900 SS/bathy
Mesotech M3
NORBIT iWBMS/iLIDAR Velodyne VLP161

PingDSP 3DSS SS/bathy
R2Sonic 202X single-headed
RESON Seabat series S7K

 
1both bathymetry and lidar data are recorded.
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Fathometers
 

All Fathometers sending NMEA DBT messages via RS232 . A text file is recorded.
 
Manufacturer / Interface Model
Various vendors NMEA-0183-compliant1

InnerSpace 400-series (meters)
Teledyne-ODOM SBT
Senbon Denki PDR series
 
1All NMEA-0183-compliant models supporting DBT / DPT messages
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Magnetometers
   

SonarWiz can acquire and process data from the following magnetometers. A text file will be created.
 
Manufacturer / Interface Model
AquaScan AX2000
GEM 19M
Marine Magnetics Standard and with Depth

Serial Text Interface1 Template-driven parser can interpret a wide
range of text formats.

 
1Please contact the Chesapeake technical support team if you need to add a type here
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Supported Sensor Data Formats (Offline Processing)
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Sidescan Sonar Data Formats
SonarWiz supports import of sidescan data in the following file formats:       
 
Manufacturer / Format Name Format Extension
C-MAX XTF, CM2
CODA COD

CSF files from SonarWiz 4, 5, or 6. CSF
Edgetech JSF
eXtended Triton Format XTF
Geoacoustics GCF, RDF, RFF
Humminbird side-view DAT
HYPACK HSX
Imagenix Sportscan 81S
Imagenix Yellowfin 872
Imagenix Delta T Backscatter 83P
Innomar SS SES
Klein SDF
Kongsberg EM backscatter ALL, KMALL
Kongsberg (Simrad) EA400/600
Backscatter

RAW

Kongsberg (ProSAS, HI SAS 1030) IMG, XTF
Kongsberg (PULSAR SS) XTF, SMB
KRAKEN TIL
Lowrance XTF, SL2, SL3
Marine Sonic MST, SDS
MCM Sensor HD H5
QMips DAT, QMP
QPS QPD, DB
R2Sonic R2S, XTF
RESON S7K
Seabeam2100 (MBSystem) MB41
Sonardyne Solstice SWF8
SwathPlus (Bathyswath) SXR, SXP
Swedish Geo Survey SEG, SGY
Tritech V4Log, LogDoc, XTF
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Sub-bottom Profiler Data Formats
 

SonarWiz supports import of sub-bottom data in the following file formats:
 
Manufacturer / Format Name Format Extension
Atlas Parasound ACF, ASD
CODA COD
Edgetech JSF
eXtended Triton Format XTF
GeoAcoustics GCF
Humminbird DAT
Innomar SB SES
Klein 3000 SDF
Knudsen KEB (including D0-D3 and B9 formats)
Kongsberg RAW
Lowrance SL2, SL3
Mala GPR RAD
SEG-Y SEG, SGY, TRA
Specialty Devices (SDI) BSS
SyQwest ODC
Tritech V4Log
Proteus DAT
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Bathymetric Import Formats
 
SonarWiz supports import of sub-bottom data in the following file formats. See Import (Bathymetry) for more
information.
 
Manufacturer / Format Name Format Extension
Edgetech JSF
eXtended Triton Format XTF

Generic Sensor Format1 GSF

GeoAcoustics RDF, RFF
HYPACK HSX, HS2, HS2X
Imagenix DeltaT and DT 100 83P, D1P
Klein SDF
Kongsberg ALL, KMALL

KRAKEN1 TIL

Lowrance StructureScan1 SL3

Marine Electronics - Dolphin FLS

MB-System1 FBT

NORBIT iWGMS HSX, XTF, S7K
R2Sonic R2S
RESON S7K
SwathPlus (BathySwath) SXI, SXP
Sonardyne Solstice SWF8
Velodyne VLP-16 / VLP-32 LiDAR HSX, XTF
WASSP NWSF, WMBF
1Processed data packets only.
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Magnetometer Data Formats
·       
SonarWiz supports import of magnetometer data in the following text file formats. The file importer is template-
driven and can be easily expanded by CTI. Please contact support if your format is not included in the list
below:
 
Supported Fields:
 
Field Formats Description
<date> DD/MM/YY

DD/MM/YYYY
DDMMYY
DDMMYYYY
MM/DD/YY
MM/DD/YYYY
MMDDYY
MMDDYYYY
YYYY/MM/DD
YYYYMMDD

Date of record. This field
requires the use of the
<time> field.

<datetime> MM/DD/YY HH:MM:SS
MM/DD/YY HH:MM:SS.sss
MM/DD/YY HHMMSS
MM/DD/YY HHMMSS.sss
MM/DD/YYYY HH:MM:SS
MM/DD/YYYY
HH:MM:SS.sss
MM/DD/YYYY HHMMSS
MM/DD/YYYY
HHMMSS.sss
MMDDYY HH:MM:SS
MMDDYY HH:MM:SS.sss
MMDDYY HHMMSS
MMDDYY HHMMSS.sss
MMDDYYYY HH:MM:SS
MMDDYYYY
HH:MM:SS.sss
MMDDYYYY HHMMSS
MMDDYYYY HHMMSS.sss
YYYY/MM/DD HH:MM:SS
YYYY/MM/DD
HH:MM:SS.sss
YYYY/MM/DD HHMMSS
YYYY/MM/DD
HHMMSS.sss
YYYYMMDD HH:MM:SS
YYYYMMDD
HH:MM:SS.sss
YYYYMMDD HHMMSS
YYYYMMDD HHMMSS.sss

Date and time of record. This
field excludes the use of the
<date> and <time> fields.
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<easting> Float value Grid X coordinate. This
requires the use of the
<northing> field. This field
will be superseded by the
<longitude> field if present.

<lat-hemisphere> N or S Indicates the latitude
hemisphere (north or south)

<latitude> DDD MM SS.sss
DDD MM.mmm
DDD.ddd
DDDMM.mmm

Position latitude of record.
This requires the use of the
<longitude> field. Positive
latitudes are in the northern
hemesphere, negative
latitudes are in the southern
hemisphere, unless the <lat-
hemisphere> field is also
present.

<linename> string For formats that contain
multiple lines in the same
file, SonarWiz will break
the line when this value
changes. The string must be
a valid windows file name.

<longitude> DDD MM SS.sss
DDD MM.mmm
DDD.ddd
DDDMM.mmm

Position longitude of record.
This requires the use of the
<latitude> field. Positive
longitudes are in the Eastern
hemisphere, negative
longitudes are in the western
hemisphere, unless the <lon-
hemisphere> field is present.

<lon-hemisphere> W or E Indicates the longitude
hemisphere (west or east)

<mag_altitude> Float value Altitude of the magnetometer
above the seabed.

<mag_amplitude> Float value Amplitude of primary
magnetic signal (nT or
Gamma).

<mag_amplitude2> Float value Amplitude of secondary
magnetic signal (nT or
Gamma) will be subtracted
from the primary on import
to support differential
magnetometers.

<mag_cableout> Float value Cable out distance used in
layback calculations.

<mag_depth> Float value Depth of magnetometer
below the surface.
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<mag_signalStrength> Float value Signal strength of
magnetometer.

<northing> Float value Grid Y coordinate. This
requires the use of the
<easting> field. This field
will be superseded by the
<latitude> field if present.

<shotnumber> String Record ID.
<time> HH:MM:SS

HH:MM:SS.sss
HHMMSS
HHMMSS.sss
HHMMSSsss
JJJHHMMSS.s

Time of record. This field
requires the use of the
<date> field.

 
Geographic Coordinate Codes:
 
DDD - degrees (000 to 180)
DDD.ddd - degrees and fractions (000.000 to 180.000)
MM - arc minutes (00 - 59)
MM.mmm - arc minutes and fractions (00.000 to 59.999)
SS - arc seconds (00 - 59)
SS.sss - arc seconds and fractions (00.000 to 59.999)
 
Date and Time Codes:
DD - 2 digit day of the month (1-31)
MM - 2 digit month of the year (1-12)
YY - 2 digit year, ranges from 1950 to 2049 (00 to 99)
YYYY - 4 digit year
HH - 2 digit hour (0-24)
MM - 2 digit minute (0 - 59)
SS - 2 digit second (0 - 59)
SSsss - 2 digit second with fractional seconds (no decimal separator) (0000 to 59999)
SS.sss - 2 digit second with fractional seconds (0.000 to 59.999)
JJJHHMMSS.s - Day of the year (001 - 365) + HHMMSS.s
 
Built-In Templates
 
AquaScan AX2000
Realtime data stream records beginning with: $AXMGD
Fields: 2
Delimited by: comma
Header Rows: 0
<skip1>
<mag_amplitude>
 
AquaScan AXL
AquaScan Magnetometer AXL file
Fields: 8
Delimited by: comma
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Header Rows: 0
<skip1>
<mag_amplitude>
<latitude> DDDMM.mmm
<lat-hemisphere>
<longitude>  DDDMM.mmm
<lon-hemisphere>
<skip2>
<skip3>
 
C&C Magnetometers
Comma delimited magnetometer file as recorded by SonarWizMAP
Fields: 11
Delimited by: comma
Header Rows: 0
<shotnumber>
<time> HH:MM:SS.sss
<date> MM/DD/YY
<latitude> DDDMM.mmm
<longitude> DDDMM.mmm
<easting>
<northing>
<mag_amplitude>
<mag_altitude>
<mag_depth>
<signal_strength>
 
CSF Magnetometers (no date)
Comma delimited magnetometer file as recorded by SonarWizMAP
Fields: 10
Delimited by: comma
Header Rows: 0
<shotnumber>
<time> HH:MM:SS.sss
<lat-hemisphere>
<longitude> DDDMM.mmm
<easting>
<northing>
<mag_amplitude>
<mag_altitude>
<mag_depth>
<signal_strength>
 
CSF Magnetometer
This is a dummy template for the purpose of giving the user something to pick when importing mag data from a
CSF file
 
G882 Type 2
Fields: 9
Delimited by: comma
Header Rows: 0
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<skip1>
<skip2>
<easting>
<northing>
<skip3>
<skip4>
<mag_amplitude>
<skip5>
<skip6>
 
G882 Type 3
PL8071 support for new G882 mag format
Fields: 10
Delimited by: comma
Header Rows: 0
<date> DD/MM/YY
<time> HH:MM:SS.sss
<latitude> DDD.ddd
<longitude> DDD.ddd
<skip1>
<skip2>
<mag_amplitude>
<skip3>
<skip4>
<skip5>
 
GEMS Gradiometer
Created by merging GEMS-INT-mag and GEMS-INT-mag2
Fields: 26
Delimited by: comma
Header Rows: 1
<mag_amplitude>
<skip1>
<mag_depth>
<mag_altitude>
<mag_amplitude2>
<skip2>
<skip3>
<skip4>
<skip5>
<date> DD/MM/YY
<time> HH:MM/SS.sss
<skip8>
<skip9>
<skip10>
<skip11>
<skip12>
<skip13>
<longitude> DDD.ddd
<latitude> DDD.ddd
<skip14>
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<skip15>
<skip16>
<skip17>
<linename>
<skip18>
<mag_cableout>
 
GEMS MagLog
Fields: 15
Delimeter: space
Header Rows: 1
<mag_amplitude>
<skip1>
<mag_depth>
<date> DD/MM/YY
<time> HH:MM:SS.sss
<skip2>
<skip3>
<longitude> DDD.ddd
<latitude> DDD.ddd
<skip4>
<skip5>
<skip6>
<skip7>
<linename>
<mag_cableout>
 
GEMS MagLog CSV
Fields: 15
Delimiter: comma
Header Rows: 1
<mag_amplitude>
<skip1>
<mag_depth>
<date> DD/MM/YY
<time> HH:MM:SS.sss
<skip2>
<skip3>
<longitude> DDD.ddd
<latitude> DDD.ddd
<skip4>
<skip5>
<skip6>
<skip7>
<linename>
<mag_cableout>
 
Geomatetrics 881/882
Fields: 4
Delimiter: comma
Header Rows: 0
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<mag_amplitude>
<skip1>
<mag_depth>
<mag_altitude>
 
Geometrics MagArrow CH1
Fields: 6
Delimiter: comma
Header Rows: 1
<skip1>
<date> YYYY/MM/DD
<time> HH:MM:SS.sss
<latitude> DDD.ddd
<longitude> DDD.ddd
<mag_amplitude>
 
Geometrics MagArrow CH2
Fields: 10
Delimiter: comma
Header Rows: 1
<skip1>
<date> YYYY/MM/DD
<time> HH:MM:SS.sss
<latitude> DDD.ddd
<longitude> DDD.ddd
<skip2>
<skip3>
<skip4>
<mag_amplitude>
 
Hypack Raw File Magnetometer
This is a dummy template for the purpose of giving the user something to pick when importing mag data from a
RAW files
 
JSF Magnetometer
When SonarWiz reads a JSF file it may optionally generate a text file containing the JSF embedded
magnetometer data. When it does, this is the format that it uses.
Fields: 8
Delimiter: comma
Header Rows: 0
<date> MM/DD/YYYY
<time> HH:MM:SS.sss
<latitude> DDD.ddd
<longitude> DDD.ddd
<mag_amplitude>
<skip>
<mag_depth>
<mag_altitude>
 
Lat Lon Mag (tab delimited)
Fields: 3
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Delimiter: tab
<latitude> DDD.ddd
<longitude> DDD.ddd
<mag_amplitude>
 
Lon Lat Mag (space delimited)
Fields: 3
Delimiter: space
Header Rows: 0
<longitude> DDD.ddd
<latitude> DDD.ddd
<mag_amplitude>
 
Mag Log Type 4
Fields: 19
Delimiter: space
Header Rows: 1
<mag_amplitude>
<skip1>
<skip2>
<mag_altitude>
<date> MM/DD/YY
<time> HH:MM:SS.sss
<skip3>
<skip4>
<skip5>
<skip6>
<skip7>
<skip8>
<longitude> DDD.ddd
<latitude> DDD.ddd
<skip9>
<skip10>
<linename>
<mag_cableout>
<skip11>
 
Mag Log Type 5
Fields: 16
Delimiter: space
Header Rows: 1
<mag_amplitude>
<skip1>
<date> MM/DD/YY
<time> HH:MM:SS.sss
<longitude> DDD.ddd
<latitude> DDD.ddd
<skip2>
<skip3>
<skip4>
<skip5>
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<skip6>
<skip7>
<skip8>
<skip9>
<linename>
<mag_cableout>
 
Mag Log Type 6
Fields: 17
Delimiter: space
Header Rows: 1
<mag_amplitude>
<skip1>
<date> MM/DD/YY
<time> HH:MM:SS.sss
<skip2>
<skip3>
<skip4>
<skip5>
<skip6>
<skip7>
<longitude> DDD.ddd
<latitude> DDD.ddd
<skip8>
<skip9>
<linename>
<skip10>
<mag_cableout>
 
Mag Log Type 7
Fields: 18
Delimiter: comma
Header Rows: 5
<date>
<time>
<mag_amplitude>
<skip1>
<mag_depth>
<linename>
<latitude>
<longitude>
<skip2>
<skip3>
<skip4>
<skip5>
<skip6>
<skip7>
<skip8>
<skip9>
<skip10>
<skip11>
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Maglog GPS-Pos w/ Altitude
Fields: 16
Delimiter: space
Header Rows: 0
<mag_amplitude>
<skip1>
<mag_depth>
<mag_altitude>
<date> MM/DD/YY
<time> HH:MM:SS.sss
<longitude> DDD.ddd
<latitude> DDD.ddd
<skip2>
<skip3>
<skip4>
<skip5>
<skip6>
<skip7>
<linename>
<mag_cableout>
 
Maglog Magnetometer
Fields: 17
Delimiter: space
Header Rows: 0
<mag_amplitude>
<skip1>
<mag_depth>
<date> MM/DD/YY
<time> HH:MM:SS.sss
<skip2>
<skip3>
<skip4>
<skip5>
<skip6>
<skip7>
<longitude> DDD.ddd
<latitude> DDD.ddd
<skip8>
<skip9>
<linename>
<mag_cableout>
 
Maglog w/ Altitude
Fields: 18
Delimiter: space
Header Rows: 0
<mag_amplitude>
<skip1>
<mag_depth>
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<date> MM/DD/YY
<time> HH:MM:SS.sss
<skip2>
<skip3>
<skip4>
<skip5>
<skip6>
<skip7>
<longitude> DDD.ddd
<latitude> DDD.ddd
<skip8>
<skip9>
<linename>
<mag_cableout>
 
PLR Magnetometer
Fields: 18
Delimiter: space
Header Rows: 0
<skip1>
<time> JJJHHMMSS.s
<linename>
<shotnumber>
<northing>
<easting>
<skip2>
<skip3>
<skip4>
<skip5>
<skip6>
<skip7>
<skip8>
<skip9>
<mag_amplitude>
<mag_depth>
<mag_cableout>
<mag_altitude>
 
PLR Magnetometer (m)
Fields: 18
Delimiter: space
Fields: 18
Header Rows: 0
<skip1>
<time> JJJHHMMSS.s
<linename>
<shotnumber>
<northing>
<easting>
<skip2>
<skip3>
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<skip4>
<skip5>
<skip6>
<skip7>
<skip8>
<skip9>
<mag_amplitude>
<mag_depth> x 3.280833
<mag_cableout> x 3.280833
<mag_altitude> x 3.280833
 
SeaSpy Type 3
Fields: 16
Delimiter: space
Header Rows: 0
<skip1>
<time> HH:MM:SS.sss
<date> MM/DD/YY
<latitude> DDD.ddd
<longitude> DDD.ddd
<northing>
<easting>
<mag_amplitude>
<skip2>
<skip3>
<mag_cableout>
<skip4>
<skip5>
<skip6>
<skip7>
<skip8>
 
SonarWiz logged Magnetometer
SonarWiz logs data this way
Fields: 10
Delimiter: comma
Header Rows: 0
<date> DD/MM/YY
<time> HH:MM:SS.sss
<latitude> DDD.ddd
<longitude> DDD.ddd
<northing>
<easting>
<mag_amplitude>
<mag_altitude>
<mag_depth>
<mag_signalStrength>
 
SonarWiz logged Magnetometer (ASCII)
This template reads the file recorded by SonarWiz when logging the MAG data to an ASCII file
Fields: 14
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Delimiter: tab
Header Rows: 0
<date> MM/DD/YYYY
<time> HH:MM:SS.sss
<latitude> DDD.ddd
<longitude> DDD.ddd
<skip1>
<mag_amplitude>
<skip2>
<mag_depth>
<skip3>
 
SonarWiz logged Magnetometer (SeaSpy)
This template reads the ASCII file recorded by SonarWiz when recording the SeaSpy MAG
Fields: 12
Delimiter: space
Header Rows: 0
<date> MM/DD/YYYY
<time> HH:MM:SS.sss
<latitude> DDD.ddd
<longitude> DDD.ddd
<skip1>
<skip2>
<mag_amplitude>
<skip3>
<skip4>
<mag_depth>
<skip5>
<mag_altitude>
 
XYZ Mag
Fields: 3
Delimiter: comma or space
Header Rows: 0
<easting>
<northing>
<mag_amplitude>
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Supported Navigation Formats
 
Input Formats
 
SonarWiz currently supports the following navigation message formats (See Navigation Input Setup window).
 
NMEA-0183
Fuqro ’ABHISOVNEh'
FGSI SonarWiz SSS
FGSI SonarWiz SBP
GeoWork/Trimble
Geowork/Trimble Pro
Hypack - Delph DLL
Seasub7 - ABDMYHISNEGOvyx?>
Hypack - Shared Memory
Watson - EGG 260
Capital Signal - Eiva Lat/Lon
Capital Signal - Eiva X/Y
C and C Technologies
C and C Technologies Klein 5000
GeoNav
Isis Ship/Fish Lat/Lon (ID Start)
Isis Ship/Fish Lat/Lon (ID End)
Link Quest USBL (LQF) - Ship/Fish Lat/Lon
Cochrane Technologies X/Y
GeoMarine Technology Nav + Events
Trimble GGK
SGU Eiva X/Y Navigation
C and C Technologies MultiNav 2012
Applanix POS MV
Novatel SPAN INSPVASA
Novatel SPAN BESTPOSA
 
NMEA-0183 Support
 
The NMEA-0183 sentences that are currently supported for position include RMC, GGA (including RTK
GGA),and GLL
The sentences supported for Heading include RMC, HDT, VHW and VTG. A GPS example of each of these
sentences is included below.
 
For more information about NMEA-0183 sentence formats, contact the National Marine Electronics Association
(http://www.nmea.org) or search the web for one of the many NMEA sentence structure references such as the
NMEA FAQ at:
 
http://www.acm.uiuc.edu/bug/projects/jason/nmeafaq.txt
 
GGA - Global Positioning System Fix Data
$GPGGA,123519,4807.038,N,01131.324,E,1,08,0.9,545.4,M,46.9,M,,*42
 
GLL - Geographic position, Latitude and Longitude

http://www.nmea.org
http://www.acm.uiuc.edu/bug/projects/jason/nmeafaq.txt
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$GPGLL,4916.45,N,12311.12,W,225444,A
 
RMC - Recommended minimum specific GPS/Transit data
$GPRMC,225446,A,4916.45,N,12311.12,W,000.5,054.7,191194,020.3,E*68
 
Should the user require assistance configuring navigation sources, please contact Help and Technical Support
 
Navigation Export Formats
 
Raw Navigation (.NAV)
(.RAW Format)
 
Date, Time, Lat, Lon, followed by the actual string that has just arrived on the serial port.
 
Example ( 2 lines of data):
 
06/04/2013 16:10:44.167 40.528797833333 -69.401566166667
$GPGGA,091043,4031.72787,N,06924.09397,W,2,6,3.5,0.0,M,0.0,M,3.0,0005*72
06/04/2013 16:10:44.186 40.528797833333 -69.401566166667 $GPHDT,136.0,T*31
 
Formatted Navigation File (.FNV)
FNV Format:
 
Date Time, Ship Lat, Ship Lon, SSS Lat, SSS Lon, SBP Lat, SBP Lon, Speed, Heading, SSS Altitude, SBP
Altitude, SSS Event, SBP Event, SSS Ping, SBP Ping
 
Example (1 line of data):
 
06/04/2013,16:10:44.170, 06/04/2013 16:10:44,40° 31.72851' N,069° 24.09478' W,40° 31.72871' N,069°
24.09602' W,00° 00.00000' N,000° 00.00000' E, 0.00,136.00,10.23, 0.00,0,0,29419,0
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Supported Motion / Heave Sensors
Input Formats
 
SonarWiz currently supports the following navigation message formats (See Motion Sensor Setup window).
 
NMEA Heading HDT
NMEA Heading VTG
Novatel SPAN PASHR
OCTANS Benthos
SSC300
TSS01
 
SSC300 Notes
 
The SSC300 produces the following messages:
 
$PMAROUT,ATT,2.5,-6.3,,,,,,*02
$IIHDG,183.5,000.0,E,,*2D
$IIHDG,183.5,000.0,E,,*2D
$IIROT,1,A*39
$IIHDG,183.5,000.0,E,,*2D
$IIHDG,183.5,000.0,E,,*2D
$IIROT,1,A*39
$IIHDG,183.5,000.0,E,,*2D
$IIHDG,183.5,000.0,E,,*2D
$IIROT,1,A*39
$IIHDG,183.5,000.0,E,,*2D
$IIHDG,183.5,000.0,E,,*2D
$IIROT,1,A*39
$IIHDG,183.5,000.0,E,,*2D
$IIHDG,183.5,000.0,E,,*2D
$IIROT,1,A*39
 
The default output of HDG is at 10Hz, ROT is at 5Hz, and the PMAROUT datafield for pitch/roll is at 1 Hz. All
of these can be adjusted up to 40Hz.
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Supported Payout Meters
 
3PS Cable Counter TPS
ADAC-P Cable Counter
C-MAX Cable Counter
MacArtney MKII
MD-TOTCO Cable Meter
MeasT echNW-LC-90_LC-100
Metrox Payout Meter
Middlebury Payout Meter
ORE-BATS-PORE
RedLion Cable Meter (Abbrev)
SSI Cable Meter
Subsea PI-5600 Cable Counter
TCount Meter
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Supported Map Formats
 

This list was provided by Global Mapper Software LLC, Olathe, KS, the makers of Global Mapper Software,
which is used by SonarWiz for importing digital maps in a diverse range of formats.
 
More information can be found at Global Mapper Software's website:
http://www.globalmapper.com/

 

ADRG Files

Arc/Info ASCII Grid

Arc/Info Binary Grid

Arc/Info Export Format (E00)

ASPRS LIDAR LAS Files

ASRP (Arc Standard Raster Product) and USRP Files

ASTER DEM and L1A/L1B Imagery and MODIS imagery

AutoCAD DWG (DraWinG) File

AutoCAD DXF (Drawing Interchange File)

BIL/BSQ/BIP Imagery

BSB Nautical Charts

BT (Binary Terrain) Elevation Grid Files

CADRG and CIB Files

Canada 3D Files

Canadian Digital Elevation Data (CDED)

CDF (GES Cartographic Data Format)

CompeGPS RTE, TRK, and WPT Formats

DBF (DBase III+) Files

DHM - Swiss DEM Files

http://www.globalmapper.com/
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DTED (Digital Terrain Elevation Data) Format

Erdas GIS Files

ERDAS Imagine Image Format

ERMapper Compressed Wavelet (ECW) Format

ESRI Shapefiles

Garmin PCX5 Format Waypoint (WPT) and Track (TRK) Files

Geodas Grid (GRD98) Format

Geosoft Binary Grid Files

GIF Files

Global 2' Elevation Data (ETOPO2)

Global 30-arc-second Digital Elevation Data (GTOPO30)

GLOBE (Global Land 1-km Base Elevation) Data

GPS TrackMaker

GPX (GPS eXchange Format) Files

GXF (Geosoft ASCII Grid) Files

Hypack Matrix Files

Idrisi Format

Intergraph COT Format

International Bathymetric Chart of
the Arctic Ocean (IBCAO) Files

Japanese DEM (JDEM) Format

JPEG Image with World File

JPEG2000 Files
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KML/KMZ Formats

Landsat 7A FAST Format

LizardTech MrSID Data

Lowrance SonarViewer Format

Lowrance USR

MapInfo MIF/MID and TAB/MAP Formats

MapTech Topo Maps and Aerial Navigation Charts

Marplot MIE Files

MicroStation DGN Format

NIMA GNS (GeoNet Names Server) Format

NITF - National Imagery Transmission Format

NOAA DSDATA Geodetic Control, SDTS Format

NOAA TerrainBase Elevation Data

NOS/GEO Chart Files

NTF Grid/Contour Format

OziExplorer Waypoint (WPT) and Track (PLT) Files

PGM Grayscale Grid Format

Platte River ASCII Digitizer Format

PNG Image with World File

S-57 Digital Chart Files

SEGP1 Seismic Shotpoint Format

SMT KINGDOM Software Planimetric Polygon Format
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SRTM (Shuttle Radar Topography Mission)

Surfer Grid (ASCII and Binary) Format Files

Terragen Terrain Format

TerraScan .bin/.ts Format

TIGER/Line Files

USGS Digital Elevation Model (DEM)

USGS Digital Elevation Model, GeoTIFF Format

USGS Digital Elevation Model, Spatial Data
Transfer Standard Format (DEM/SDTS)

USGS Digital Line Graph, Optional Format (DLG-O)

USGS Digital Line Graph, Spatial Data
Transfer Standard Format (DLG/SDTS)

USGS Digital Orthophoto Quads (DOQ), GeoTIFF Format

USGS Digital Orthophoto Quads
(DOQ), JPG w/ Native Header Format

USGS Digital Orthophoto Quads (DOQ), Native USGS Format

USGS Digital Raster Graphic (DRG)

USGS Geographic Names Information System (GNIS)

USGS Land Use and Land Cover Data (LULC)

USGS National Elevation Dataset
(NED) - ArcGrid, BIL, Grid Float Format

VPF (VMAP0, VMAP1, DNC) Files

WAsP .MAP Format

Zmap Plus Grid Files
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Sonar Servers
 
A sonar server is an application used by SonarWiz to connect to a mapping sensor or remote file that is
actively being written to by use of a sonar in real-time controlled by another program. Sonar servers are
separate extensions to the main program and must be purchased from CTI.
 
Sidescan Sonar Servers
 
Analog Side Scan Server
CMAX CM2 USB Server
EdgeTech 4100 Server
EdgeTech 4125 Server
EdgeTech 4200 Server
EdgeTech ACI server
EdgeTech DCI Server (DF-10000)
GeoAcoustics Digital Sonar Server
Klein 3K Server
Klein 3900
Klein 5K Server
Marine Sonic Server
SonarBeam S150 Server
SportScan Server
Teledyne-Benthos 16xx Server
Tritech Seaking Server
YellowFin Server
 
Sub-bottom Profiler Servers
 
EdgeTech 3100 (XStar) Server
Knudsen SBP Server
Odom CVM (EchoTrac) Server
SyQwest SBP Server
Teledyne-Benthos Chirp III Server
 
Combined Sidescan and sub-bottom
 
Klein 3K + SBP
Teledyne-Benthos 1625 Server
HUGIN AUV Server
 
Bathymetry Acquisition Servers
 
Edgetech 4600-6205 Server
PingDSP Server
Remote File Server
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Contact Broadcast Formats
 
SonarWiz can broadcast Contact information to external programs using either UDP or Serial connections. The
message format must be either NMEA TLL or COMEX Subsea format. Configure the broadcast message and
connection type in the Contact Options Menu. The following section documents the message formats.
 
NMEA TLL Format
 
The TLL string is as below with the individual fields identified in the accompanying Table
 
$GPTLL,15,4825.6778,N,12326.3652,W,Contact0000,234522,T,R1*A
 

No. Field Sample

1 String Identifier for TLL $GPTLL

2 Contact Sequence
Number

15

3 Latitude 44o 25.6778'

 
4 Hemisphere N

5 Longitude 123o 26.3652'

 
6 Hemisphere W

7 Contact Name Contact0000

8 Time of creation of
contact

23:54:22

9 unknown T

10 Checksum R1*A
 
COMEX Subsea Format
 
The COMEX Subsea string is as below with the individual fields identified in the accompanying Table
 
CD,009,10 Mar 2007,23:14:51,-73.335132, 44.233397, 108.10, 19.4,2.0,100, Main, D:
\LakeChamplain\XTF\shipwreck-pass-50m-d.xtf,1600
 
No Field Sample
1 String Identifier for Contact

Data
CD

2 Contact Sequence Number 009
3 Date 10 Mar 2007

4 Time 23:14:51

5 Longitude -73.335132

6 Latitude 44.233397

7 Heading 108.10
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8 Altitude 19.4

9 Depth 2.0

10 Sonar Range 100

11 Disk Volume Name Main

12 File Name with full path D:\Lake Champlain\XTF\shipwreck-
pass-50m-d.xtf

13 Ping Number at contact
click location

1600
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External XYZ Point Format
 
The SonarWiz gridder can import point cloud information stored in common text formats, including tab, space
or comma separated values. The X (easting) and Y (northing) coordinates are assumed to be in the same
coordinate system as the SonarWiz project. Geodetic (latitude and longitude) coordinates are not supported.
Any line that begins with a non-digit is skipped and leading spaces are ignored. So, it is generally safe to leave
comments and column headers in the file.
 
The file should be organized with one point per row. Each number in the row should be separated by a non-
numeric delimiter (tab, space or comma are suggested, but others will work). The first three numbers detected
in the row are interpreted as the X (easting), Y (northing), and Z (value), respectively. Additional columns of
data in the row are ignored.
 
Here is an example point file that can be imported into the gridder:
 
# Amplitude data exported from GIS
# Cruise ID: FGH987
# Date: 2018-09-08
Easting, Northing, Intensity
456789.0, 543234.0, -123.5
456790.0, 543234.0, -119.3
456791.0, 543234.0, -29.5
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Sub-Bottom Core TXT File Format
 
If you have a core definition data set and want to add these as digitized core features into a project, this
technique may be the best for you. TXT format means space-separated-values (SSV), so the data sentences
in this format need a space between values. SonarWiz supports CORE DEFINITION import to allow you
to pre-defined a set of CORE or BORE-HOLE locations, and import them as a single file. Please use SSV
(space-separated values) TXT format at this time, though CSV (comma-separated values) format will be
supported soon too.
 
Example TXT format (1 header line, 1 data line):
 
Name X Y Lon Lat Desc. WD No Un.1 Un.2 Un.3 Un.4 Un.5 Un.6 Un.7 Un.8
Core2 616014.44 6332816.10 -1.0837076925 57.1239759363 Core2 14.80 2 10.5 15.5
 
Field Meaning
 
Name = core name
X = location in grid units
Y = location in grid units
Lon = Longitude in WGS84 degrees
Lat = Latitude in WGS84 degrees
Desc. = description text
WD = water depth at core location in meters
No = number of bands to follow
Un.1 = unit 1 band thickness
Un.2 = unit 2 band thickness
Un.3 = unit 3 band thickness
Un.4 = unit 4 band thickness
Un.5 = unit 5 band thickness
Un.6 = unit 5 band thickness
Un.7 = unit 5 band thickness
Un.8 = unit 5 band thickness
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